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The Unitron and Cylon BACnet Building Management Systems are made up of two main types of component: 

 Hardware - the products that monitor and control a building's environment. 

 Software - the interface which allows users to configure and monitor Cylon Hardware. 

 

Hardware Components 

Unitron and Cylon BACnet use the following main hardware components: 

 Communications Controllers. 

 I/O Field Controllers. 

 Keypad 

 PC  

There may also be other supplementary hardware components such as printers, modems, pagers etc., but these are not 
essential to the basic system. 

 
 

Communications Controllers 

The UC32.netK, UCC4 and UCC4.net are programmable communications controllers, which network I/O controllers 
together. They also handle global time schedules (see page 376) for the I/O Controllers connected to them.  

Communications controllers ("Comms Controllers") can be connected together and, communicate with each other in a peer-

to-peer arrangement. For UC32.netKs this connection is over fast Ethernet (100Mbps Full Duplex by default), and for 

UCC4s and UCC4.nets it is by ARCnet. 

Comms Controllers also deal with Alarm handling and other network functions. 

A Comms Controller can be linked directly to a PC, a modem or a printer. 

 

 

I/O Field Controllers 

UC32.xx, UCxxPG-R, UCUxx, UCxx, CBM and CBT controllers take inputs from sensors and Building Control plant, and send 
output to Building Control plant in response. They are available as programmable or unitary controllers, with various 
input/output configurations. 

These I/O controllers can be programmed with strategies, which configure them to send specific outputs to connected 
devices in response to events occurring on their inputs. For example, you can create a Strategy in the Engineering Centre and 
download it to a Field Controller specifying that a valve be opened if the temperature being input to the controller rises 
above a predetermined level. 

Cylon Field controllers are networked together using RS485 by Communications Controllers, which in turn are networked by 
Ethernet (or ARCnet in legacy systems). A Field controller can also be linked directly to a PC, as well as to a modem or a 
printer. 
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PC 

The PC is connected to a Cylon network by Ethernet, RS232 or modem connection. The PC can also be connected directly to 
an I/O controller for small installations with stand-alone controllers. 

The Cylon Engineering Centre software - which is used to configure the controllers, schedule events and extract reports - is 
run on the PC. Since the Cylon software is Windows-based, the PC must have Windows 2000 or WindowsXP installed and 
running. 

The minimum specification for a PC that will be used to run the Command Centre and Engineering Centre is as follows: 

Minimum PC  Intel Core 2 Duo E6300 processor, 1Gb RAM, 80Gb hard disk  

Recommended PC  Intel Core 2 Duo E6600 processor, 2Gb RAM, 160Gb hard disk  

Operating System  Microsoft WindowsXP Professional 32 bit, Microsoft Windows7 
Professional 32 bit  

 

 

Connections between hardware components 

The following types of connections exist between the hardware components: 

 Fast Ethernet bus connecting UC32.net Communications Controllers and CBR routers. 

 An ARCnet network, connecting UCC4 Communications Controllers in a bus configuration (could also be star 
configuration if co-axial ARCnet is used). 

 An RS485 fieldbus, using shielded twisted pair cables, connecting the Communications Controllers to the I/O 
controllers. 

 An RS232 connection between the PC and a Comms Controller. 

There may also be other connections between Comms Controllers and printers, modems, pagers, etc. but these are not 
essential to the basic system. 
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Software Components 

The Cylon suite of software applications is used to set up, maintain and control the Cylon system in operation. The 

individual applications ("modules") within the suite are grouped into the Unitron Command Centre (also referred to as 

"the Command Centre" ) and the Cylon Engineering Centre (also referred to as "the Engineering Centre") as shown below. 

Each of these modules can be started from the Command Centre and Engineering Centre groups in the Windows Start 
menu. 

Engineering Centre modules 

The following applications are available from the Engineering Centre group in the Windows Start menu: 

 Database Interface 

 Database Server 

 Documentor  

 Parallel Keypad Compiler 

 Serial Keypad Compiler 

 Serial Keypad Wizard 

 Modem 

 Schedule Planner 

 Site Organiser 

 Engineering Centre 

 UC16 Modem/CCDial/Modem Interface 

 UCC4 Configuration 

 Site Backup Utility 

 Configuration 

Command Centre Modules 

The following applications are available from the Command Centre group in the Windows Start menu: 

 Alarm Handler 

 CCDraw 

 CCView 

 Database Interface 

 Database Server 

 Datalog Manager 

 Modem 

 Pager 

 Reports 

 Schedule Planner 

 Time Schedule Manager 

 UC16 Modem/CCDial/Modem Interface 

 Site Backup Utility 

 Configuration  
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Each of the Cylon Software modules is explained in detail below: 

 Configuration 

The Configuration program contains a blueprint of the system, which can be accessed by other programs as required. It is 
used to define systems, networks, sites, authorised users, modem protocols, port setups, etc. and to activate alarms. Levels 
of access for different users can also be defined here. (See also MAN-0041 Configuration User manual.) 

 Alarm Handler 

The Alarm Handler program is used to alert you to any alarm conditions within the system. The alarms can be enabled, 
disabled or filtered in the Configuration program. When they have been enabled, the Alarm handler will run automatically 
every time the Command Centre is run. If alarms are enabled, and alarm modules are included in Field Controller strategies, 
any alarm event will be sent to the Alarm handler (also known as the Alarms program) and displayed on the screen. (See 
also MAN-0047 Alarm Handler User Manual.) 

 CCDraw 

CCDraw is a graphics application, which allows you to create dynamic graphic windows to use with the CCView program. 
These are pictures of the site, through which, in CCView, you can travel around the site, viewing and altering conditions as 
necessary. (See also MAN-0040 CCDraw User manual). 

 CCView 

 CCView contains the Command Centre from which you can communicate with the controllers. By opening up the dynamic 
pictures created in CCDraw, you can travel through a site, viewing and altering conditions as necessary. Reports can be 
obtained from dynamic points created in CCDraw, and appliances can be adjusted, or switched on or off. (See also MAN-
0039 CCView User manual.) 

 Database Interface 

 The Database Interface program allows you access to the database that contains details of all the point values on each 
Field Controller in the network. You can set point values graphically in the Engineering Centre, or you can enter or delete 
them in the Database Interface program.  

 Database Server 

 The Database Server is the database where details of all the point values on each Field Controller in the network are kept. 
You cannot access the Database Server directly. The Database Interface program allows you to edit point descriptions and 
engineering units in the database manually, and the Engineering Centre allows you to edit point values in the database 
graphically.  

 Serial Keypad Wizard 

The Serial Keypad Wizard allows you to create keypad programs for use with the UC32. (See also MAN-0055 Engineering 
Centre Keypad Wizard manual. 

  



 

 

20 © American Auto-Matrix MAN00058US rev 69 

M
A

N
0

0
0

5
8

U
S rev 6

9
  Parallel Keypad Compiler 

The Parallel Keypad Compiler program allows you to create programs for use with the UCC4 or Field Controller keypad. You 
can then download these programs to the keypad. (See also MAN-0023 UCC4 Keypad User's Guide and MAN-0023 UC16 
Keypad User's Guide.) 

 Documentor 

 The Documentor is a Microsoft Excel macro package, and requires Microsoft Excel to be installed on the PC for it to work. 
When the Documentor is run, it extracts a record of the configuration of the network. These are printed out when required 
(for example, as a daily report of the state of the site). Information about specific parts of the network can also be accessed. 
The Documentor is not automatically loaded when the system is started up. You must run it when it is required. (See also 
MAN-0019 Documentor manual.  

 Serial Keypad Compiler 

The Serial Keypad Compiler program allows you to create programs for use with the UCKRA420 Serial Text keypad. You can 
then download these programs to the Comms Controller or Field Controller that the keypad is connected to. The Compiler 
can create programs for UC32.net Communications Controller, UC32 and UCxx Field controllers, and UCC4 v3.8.0 or earlier 
Communications controllers. (See also MAN-0004 Serial Text Keypad and Compiler manual) 

 Datalog Manager 

 A datalog is set-up in the Engineering Centre, and logs the value of a specified point in a Field Controller at a specified 
interval, over a period of time. So a datalog contains a record of the changes in a point value over a period of time. The 
Datalog Manager program allows you to display the contents of a datalog in either graphic or tabular form. (see also MAN-
0043 Datalog Manager User's Guide) 

 Modem 

The Modem program allows you to view the present state of any modem connected to the network (i.e. it allows you to see 
whether the modem is off-line, transmitting, starting up, etc.). Provided there is a modem in the Cylon system, the Modem 
program is run automatically when the Command or Engineering Centre is started up. 

 Pager 

 The Pager program acts as an interface between various paging services and the Command Centre. It can accept alarms 
sent from the Alarm handler and transmit them automatically to an engineer’s pager using the pager service. (See also 
MAN-0021 Pager manual.) 

 Reports 

 The Reports program allows you to collate information from the network for permanent storage. Reports can be produced 
manually or automatically and saved to a file from which they can be printed out. Automatic reports can be produced at 
regular intervals – hourly, daily, weekly, monthly, etc. The PC must be switched on permanently if the reports program is to 
run correctly. (See also MAN-0044 Reports Module User Guide.) 
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 Schedule Planner 

 The Schedule program defines the schedules for a site configured in the Configuration module and set-up in the 
Engineering Centre. Standard time schedules can be assigned for normal working days and weekends. Exceptions can be 
set-up, e.g. for holiday periods. These schedules are then downloaded to the Comms Controller and distributed throughout 
the network by the use of globals. (See also MAN-0054 Schedule Planner User Manual.) 

 Time Schedule Manager 

The Time Schedule Manager allows the creation of multiple time schedules in the supervisory PC, which can be downloaded 
simultaneously to several Comms Controllers. Logical groups of Comms Controllers can be defined, to which the Time 
Schedules can be sent, and these are called “Site Groups” 

Time Schedules can be downloaded manually when needed, or can be downloaded automatically by the Report module. 
The original settings for each schedule can be re-loaded on the site's controllers at any time by using the Schedule Planner. 
(See also MAN-0035 Time Schedule manager Manual) 

 Site Organiser 

 The Site Organiser is an easy way to configure and examine a complete site or part of a site. Instead of downloading 
strategies individually to all the controllers on a site, this can be done in one simple task. Any combination of strategies can 
be downloaded to any combination of controllers or to one type of controller in a .ins batch file. (See also MAN-0020 Site 
Organiser manual.) 

 Engineering Centre 

 The Engineering Centre is a graphical interface created for programming the Cylon range of universal controllers. In the 
Engineering Centre, strategies (which tell a controller how its outputs should respond to conditions on its inputs) can be 
designed, edited and downloaded to, or uploaded from, Field Controllers. Globals can also be assigned to Comms 
Controllers to pass values to other controllers on the network. The Engineering Centre could be described as the most 
important of all the Cylon applications, as it is the application that programs the Cylon controllers. This manual describes 
how to carry out a variety of tasks in the Engineering Centre. 

 Modem Interface 

 The Modem Interface program allows for communication between a controller and a remote supervisory PC, via modems. 
In addition to the long-established feature of the Modem Program, which allows strategies on a remote site to be examined 
by dialling the remote site from the PC, the Modem Interface program now allows Field Controllers to dial-out to a 
supervisory PC, e.g. in the event of an alarm.  

 UCC4 Configuration 

 The UCC4 Configuration program is used to configure the ports on UCC4-type Comms Controllers for communication with 
peripheral devices such as printers or modems. (See also MAN-0053 UCC4 Configuration User Manual.) 
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 Site Backup Utility 

 The Site Backup Utility automates the process of backing up a site, and can be used to move sites from one PC to another, 
for synchronizing files (if several people are working on a single site on a number of different PCs), or for making security 
copies of a Site’s files. (See also MAN-0038 Site Backup Utility User Guide) 
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The Engineering Centre – Overview 

The Engineering Centre is the application that is used to program the Cylon controllers and is therefore the key application 
of the Cylon Software suite. The Cylon Engineering Centre provides all of the tools required to design, configure, test, 
commission and maintain Cylon BACnet, UnitronUC32 and Unitron2000 systems automatically. 

The Engineering Centre switches between BACnet, UC32 and Unitron2000 modes depending on which type of controller is 
selected in the Site Tree. 

You can use the Engineering Centre to: 

 Graphically create strategies that implement solutions to conditions on site. 

 Save those strategies for future editing, testing or reference. 

 Test the operation of strategies. 

 Debug and edit strategies. 

 Download strategies to the appropriate controllers. 

 Define and assign local globals to carry data across a Fieldbus. 

 Define and assign wide globals to carry data between Fieldbusses and across the network of a site. 

 Upload existing strategies from controllers. 

 Upload analog and digital point values from controllers. 

 Upload globals from controllers and from networks. 

 Upload statistical and reference information from controllers. 

 Record changes that occur on a site as they happen and save the record to a file. 

 
 
 





 
 

 

SECTION 2 :  THE ENGINEERING 
CENTRE INTERFACE 
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Parts of the Engineering Centre  

The main Engineering Centre interface is illustrated below: 

  

 

The title bar 

The title bar contains the name of the application, followed by the name of the active file, i.e. the strategy file that is 
currently in use. In the example below, the strategy file AHU1.stg is active. 

 

The menu bar 

The menu bar contains 12 menus listing the commands necessary for designing and implementing strategies. 
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The File menu 
New Creates a new strategy.  

Open Opens an existing strategy.  

Close Closes the active strategy.  

Save Saves the active strategy under its current name.  

Save As Saves the active strategy under a new name or saves a strategy for the first time.  

Save All Saves all the open strategies under their current names  
(If there are any unnamed strategies open, the Save As dialog box will appear to allow 
you to save them under a particular name). 

Sign On Signs On to the Engineering Centre 

Sign Off Signs Off from the Engineering Centre 

Login Logs in to the target controller.  

Logout Logs out of the target controller.  

Global Editor Shows all of the globals in a site, and allows them to be edited. 

Footers Edits the footer that appears with the strategy when it is printed.  

Print Prints the current strategy. 

Print Preview Shows the strategy as it will appear when printed.  

Print Setup... Edits details relating to the printing of the strategy.  

Printer Scaling... Allows the size of the printed strategy to be adjusted. 

1....  

2....  

3....  

4.... 

Switches from the active strategy to one of the four most recently used strategies.  

Exit Closes the Engineering Centre. 
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The Edit menu 
Cut Cuts a selected item or items from the active strategy and place it on the Clipboard.  

Copy Copies selected items from the active strategy, and places it on the Clipboard.  

Paste Places the contents of the Clipboard onto the drawing area  
(by clicking the mouse over the required inset point). 

Select All Selects all of the items in the current strategy drawing 

Add Text Inserts text into the strategy. 

Find Opens the Find dialog, to locate or step through Points, Modules Macros or Globals in 

the currently-opened strategy. 

Find Next Steps to the next item in the strategy that matches the settings in the Find dialog. 

Find Previous Steps to the previous item in the strategy that matches the settings in the Find dialog. 

Add Comment Block Allows a comment block to be added to the strategy. 
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The View menu 
View   

Toolbar Displays or hides the Toolbar.  

Status Bar Displays or hides the Status bar.  

Current Target Displays or hides the Current Target bar.  

Macro Bar Displays or hides the Macro bar. 

Site List Displays or hides the Site List. 

Modules  Selects one of the six module bars (see below). 

Globals Selects a global from the Globals bar or adds a global.  

Virtuals Displays or hides the virtual modules bar. 

Managers Displays details about current resource availability.  
Information about Globals, Strategy Blocks, the controller, inputs and outputs is 
provided. 

Zoom In Zoom in - Enlarges the current view of the strategy 

Zoom Out Zoom out - Reduces the current view of the strategy 

Zoom to 100% Returns the strategy view to actual size. 

Zoom Level... Allows the zoom level to be specified by number. 

  

View    

Toolbar   

Status Bar   

Current Target   

Macro Bar   

Site List   

Modules  P Points Displays the Points module bar 

Globals L Logic Displays the Logic module bar 

Virtuals M Mathematical Displays the Mathematical module bar 

Managers C Control Displays the Control module bar 

Zoom In F Function Displays the Functions module bar 

Zoom Out S Static Displays the Statistics module bar 

Zoom to 100%   

Zoom Level...   

   

   

 

 

The Macro menu 
Macro   

Create Creates a macro using selected modules on the drawing area. 

Manager Adds or edits macro group details. 
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The Communications menu 
Communications   

Communication Setup Configures the download and scan global set-ups. 

Upload Uploads the strategy from the controller to the PC.  

Download Downloads the strategy from the PC to the controller.  

Scan Examines the strategy’s points in the controller and displays their values in 
real-time. 

Change Point Value Changes the value of a setpoint in a controller. 

Change Controller Address Changes the address of the currently targeted controller. 

Change UCU Baud Rate Changes the baud rate of the targeted controller, if it is a UCU type controller. 

Configure BACnet Device Allows BACnet device properties to be set. 

Note:   Scan option is only available when the PC is logged in to the Cylon network, and when Display points has been 
checked in the Module Setup dialog box. 

 Change UCU Baud Rate is only available if the targeted controller is a UCU. 
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The UC32 and UC menus 

If the target of a strategy is a UC32-type controller, the UC32 menu is visible in the Engineering Centre's menu bar: 

UC32   

Version Gets the version of the targeted UC32 controller. 

Setup Sends the setup to the controller and displays the current setup of the 
controller.  

Time and Date Sends the time and date to or uploads it from the controller. 

Wipe Controller Clears the memory of the targeted UC32 controller. 

Statistics Get details of the engineering, system and alarm statistics for the controller. 

Strategy Lock/Unlock Allows you to password-protect (lock) a strategy, or access a locked strategy. 

Keypad Allows you to create and download keypad programs. 

Configuration Info Opens a display panel showing the configuration of the UC32's hardware. 

Diagnostics Displays board diagnostic information. 

Terminal Setup Opens the Terminal Settings panel. 

  

 

UC32    

Version   

Setup   

Time and Date   

Wipe Controller   

Statistics   

Strategy Lock/Unlock   

Keypad  Create & Download Keypad Opens the Keypad Wizard as 'Standalone' 

Configuration Info Download Keypad Sends a saved Keypad program to the UC32 

Diagnostics Configure Keypad Allows the operating parameters of the keypad 
program and the keypad hardware to be set. 

Terminal Setup Clear Keypad Info... Deletes Keypad information from the Cylon 
Software database 

If the target of a strategy is a UC or UCU-type controller, the UC32 menu is replaced with the following UC menu: 

UC   

Version Gets the version of the targeted controller.  

Setup Sends set-up to the controller and displays the current set-up of the controller.  

Statistics Gets details of the engineering, system and alarm statistics for the controller. 

Time and Date Sends the time and date to or uploads it from the controller. 

Configuration Information Displays information (e.g. max. address) about the targeted controller. 

Wipe UC Memory Clears the memory of the targeted controller. 

DI Setup Allows the inputs on a UC16DI controller to be configured. 

Note:   DI setup option is only available when the PC is logged in to the Cylon network, and when the target of the open 
strategy is a UC16DI. 
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 The UC32.net and UCC4 menus 

If the target of a strategy is on the Fieldbus of a UC32.net Communications Controller, the UC32.net menu is visible in the 
Engineering Centre menu bar: 

UC32.net   

Version & Identification ... Gets the version of the UC32.net to which the targeted controller is attached.  

Setup ... Sends setup to the UC32.net and displays its current setup. 

Time and Date ... Sends the time and date to or upload it from the UC32.net.  

Wipe Memory ... Clears selected parts of the memory of the UC32.net to which the targeted 
controller is attached. 

Port Setup ... Allows each of the UC32.net's ports to be configured 

Alarm Setup ... Defines which alarm priorities will be scanned by multiple supervisor PCs. 

Keypad Opens the Keypad sub-menu (see below) 

Web Server Access ... Enables Web access, and defines its security settings 

Strings... Defines Alarm, Modem, and Print strings in the UC32.net 

Send Site Number ... Sets the site number in the UC32.net 

Generate Report ... Generates a report of the UC32.net's operating statistics 

 
 
 

UC32.net    

Version and Identification   

Setup   

Time and Date   

Wipe Memory   

Port Setup   

Alarm Setup   

Keypad  Keypad Configuration ... Enables the 'configuration program' in the 
UC32.net's keypad, and sets the password 

Web Server Access Create & Download Local UC32.net Keypad Program Opens the Keypad Wizard as 'Local' 

Strings... Create & Download Wide UC32.net Keypad Program Opens the Keypad Wizard as 'Wide' 

Send Site Number Download Keypad Program... Sends a saved Keypad program to the 
UC32.net 

Generate Report   

 

If the target of a strategy is on the Fieldbus of a UCC4 or UCC4.net Communications Controller, the UC32.net menu is 
replaced by the UCC4 menu: 
 

UCC4   

Version Gets the version of the UCC4 to which the targeted controller is attached.  

Setup Sends set-up to the UCC4 and displays its current set-up. 

Statistics Gets details of the engineering, system and ARCnet statistics for the UCC4.  

Time and Date Sends the time and date to or upload it from the UCC4.  

Wipe Memory Clears the memory of the UCC4 to which the targeted controller is attached. 

Remove Time Schedules Deletes UCC4 Time Schedule from the Cylon database. 

If the target of a strategy is on a BACnet Site, neither the UCC4 nor UC32.net menus will be displayed. 
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The Display menu 
Display   

Windows Setup Define the style of background desired.  

Colours  Choose the colours for the background and grid (see below).  

Module Setup Choose whether point values and constant values of modules are displayed during 
scanning, whether lines and point numbers joining modules are displayed, and 
controls routing of joined points (illustrating all connections to a selected point).  

 

Display    

Windows Setup   

Colours  Grid Choose colour for the Grid 

Module Setup Background Choose colour for the Background  

 

 

 

The LiveLog menu 
LiveLog   

Setup Determine how and what the LiveLog is to scan, i.e. all open strategies or active 
strategy only, interval between scans, and whether to log scan results to a text file.   

Log Scan the strategy’s point values and time schedules. 

View Reads the results of all previous scans logged to a text file (See Setup above). 

The Window Menu 
Window   

Cascade Arrange the strategy windows diagonally across the Engineering Centre window.  

Tile Horizontal Arrange the strategy windows horizontally.  

Tile Vertical Arrange the strategy windows vertically.  

1.... View the names of all open strategies.  

 

 

 

 

The Help Menu 
Help   

Help Use on-line help.  

About Cylon Engineering Centre... Get details of the application version number, copyright etc. 
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Menu options available only when logged in 

The menu options listed below require the PC to communicate directly with the controller and so are only available when 
you are logged in: (To log in click the login/logout button on the toolbar or choose Login from the File menu) 

 

 Upload (Communications menu ) 

 Download (Communications menu) 

 Scan (Communications menu) 

 Change point Value (Communications menu) 

 Change Controller Address (Communications menu) 

 Change Baud Rate (Communications menu) 

 

 Version (UC32 and UC menus) 

 Statistics (UC32 and UC menus) 

 Strategy Lock/Unlock (UC32 menus) 

 Time and Date (UC32 and UC menus) 

 Wipe Controller Memory (UC32 and UC menus) 

 Configuration Information (UC32 and UC menus) 

 Diagnostics (UC32 menu) 

 DI Setup (UC menu) 

 

 Version & Identification (UC32.net and UCC4 menus) 

 Statistics (UCC4 menu) 

 Setup (UC32.net menu) 

 Time and Date (UC32.net and UCC4 menus) 

 Wipe Memory (UC32.net and UCC4 menus) 

 Port Setup (UC32.net menu) 

 Alarm Setup (UC32.net menu) 

 Web Server Access (UC32.net menu) 

 Strings (UC32.net menu) 

 Send Site Number (UC32.net menu) 

 Generate Report (UC32.net menu) 
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The Toolbar 

The toolbar contains a number of buttons, which can be used as alternatives to menu options.  

  

 

File buttons 

  

Creates a new strategy file. 

  

Opens an existing strategy file. 

  

Saves the active strategy file. 

 

Edit buttons 

  

Cuts selected item or items from the active strategy and places them on the 
Clipboard. 

  

Copies the selected item or items from the active strategy, and places them on the 
Clipboard. 

  

Pastes the contents of the Clipboard onto the drawing area.  

 

  



 

 

36 © American Auto-Matrix MAN00058US rev 69 

M
A

N
0

0
0

5
8

U
S rev 6

9
 

Modules buttons 

  

Displays the Points module bar. 

  

Displays the Logic module bar. 

  

Displays the Mathematical module bar. 

  

Displays the Control module bar. 

  

Displays the Function module bar. 

  

Displays the Statistic module bar. 

  

Inserts text into a strategy. 

Macro button 

  

Creates a macro from selected modules on the drawing area. 

View Globals button 

  

Displays or hides the Globals bar. 

 

Virtuals button 

  

Displays or hides the Virtuals bar. 

Communication buttons 

  

Downloads a strategy from the PC to the controller. 

  

Uploads a strategy from the controller to the PC. 

  

Scans the values in the active strategy. 

Zoom button 

  

Zoom in - Enlarges the current view of the strategy 

  

Zoom out - Reduces the current view of the strategy 

  

Returns the strategy view to actual size. 

 



 

 
 

MAN00058US rev 69 © American Auto-Matrix 37 

Print button 

  

Prints the active strategy. 

  

Print preview - shows the strategy as it will appear when printed. 

LiveLog button 

  

Opens the LiveLog window. 

Login/Logout button 

  

Logs in to the controller. 

  

Logs out of the controller. 

Automatic Online Downloading button 

  

Uses the Engineering Centre in Automatic Online Download mode. 

Help button 

  

Opens the on-line help. 

 

 

 

 

 

 

The Modules bar 

  

When you select a module bar from the View menu or the module buttons, the module bar is displayed below the toolbar. 

The current modules bar can also be ‘undocked’ and dragged to a different position on the display using the mouse. 
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The drawing area 

The drawing area is the part of the Engineering 
Centre interface where modules are placed and 
linked to form a strategy.  

  

 

The following items can be placed on the drawing area: 

 Modules 

 Globals 

 Macros 

 Virtuals 

 Routes showing how the points of different modules are connected 

 Text 

To define the background for the drawing area, 
select Window Setup from the Display menu. 

 

  

The Window Setup dialog allows you to specify 
whether or not there is a grid in the window, 
and if so set the grid spacing and style.  

  

 

 

The drawing area can have a plain white 
background 
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or alternatively, you can choose a background 
grid to facilitate the positioning of modules in a 
strategy. The grid can consist of lines… 

  

 

 

…or dots, 

 

  

 

and the spacing within the grid can vary in size 
from 8 pixels… 

  

 

 

…to 56 pixels. 
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The current target bar 

The current target bar shows the site, and the names and addresses of the Communications Controller and the Field I/O 
Controllers that have been targeted. For example, if the controller named 001-01 ahu1 on the Fieldbus of a 
Communications Controller named 001-rooftop of the site called office block is being targeted, the current target bar will 
look like this: 

  

 

The status bar 

The status bar gives information about what is happening in the Engineering Centre It displays the page number of the 
active strategy and it also gives information on the toolbar and menu options that have been selected: 

Explanatory information on toolbar options 

If the mouse pointer is placed over buttons on the toolbar without clicking, the status bar gives some information about the 
item over which the pointer is placed. To produce the example below, the mouse pointer was placed over the macro button 
on the toolbar. 

 

Explanatory information on menu options 

If you place the mouse pointer over a menu option, similarly, the status bar gives information about the function of the 
menu option. For example, if you place the mouse pointer over Version from the UCC4 menu, the status bar displays the 
following information: 
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The Site List 

The Site List shows in an explorer-like structure all the controllers in all the sites installed on the PC. 

The site list may or may not be visible beside the strategy drawing.  

To make it visible, ensure that the Site List option in 
the View menu is ticked: 

 

 

Selecting a controller from the site list sets it as the 
target controller for the current strategy. 

 

Details of the Currently-selected Site are displayed 
below the list.  

 

 

 

Note:  When you open the Site List, it opens with the default site selected. 
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 Note:  On BACnet sites, holding the mouse over a Field Controller node causes a tooltip to be displayed, which shows 

the Device Instance Number for that Field Controller  

   

Strategy Drawings can be created or opened from a popup menu that is accessed by right-clicking on Field Controllers 
within the Site Tree.   

  

If the strategy drawing corresponding to a Field Controller is open, the a single left-click on that Field Controller will 
'activate' the corresponding Strategy Drawing - i.e. bring it to the front of the display.  

If the strategy drawing is open, the right- click popup menu changes to give options relevant to the strategy: 

 

Note:  Any tree node can be selected (not just the Field Controllers), but only Field Controller nodes will enable Top 
level menus and activate opened strategies. 

The Site Tree is automatically refreshed if changes are made in the Cylon Configuration utility.  

Note:  All opened Strategy Drawings are closed during a Cylon Configuration utility refresh, so that they are 
synchronized with any new changes. The user is prompted to save any Strategy Drawing changes.  

 Following the refresh, all of the Strategy Drawings that were open before the refresh are re-opened. 

 

 



 
 

 

SECTION 3 :  BASIC TASKS 
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Starting the Engineering Centre 

Open the Cylon Engineering Centre section on the Windows Start menu or start screen, or search for “Cylon Engineering 
Centre” in the Application search box. 

Click on the Engineering Centre icon.  

The CEC interface will open: 

 

 

The CEC is disabled until you Sign On as a user (see Signing on on page 45) 
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Signing on 

If you have not signed on the Cylon system before starting the Engineering Centre (for example, in CCView), the menus in 

the Engineering Centre will be disabled. You must sign on for the full range of menus to become enabled.  

To sign on, open the File menu and choose Sign On.  

 

 

Enter your username and password 

 

If you tick the Remember Me checkbox, the username and password will be pre-filled the next time you try to sign on. 

When you have signed on, the Toolbars will be accessible: 

 

You can also sign on by minimizing the Engineering Centre and signing on in CCView. When you return to the Engineering 

Centre, the menus will be enabled. 
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Targeting a controller 

Before creating a strategy, you should first select the site and the controller for which the strategy is designed and to which 
it will eventually be downloaded. The Engineering Centre allows you to do this by clicking on the site and controller icon in 
the Site List provided: 

  

Note:  The frame in which these icons appear can be resized by dragging it as required: 

   

If the Site List does not contain the name of your site(s) or the controllers within the site(s), check that the Database Server 
program is running. If it is not, run it and when you return to Engineering Centre, your site(s) will be available in the 
Engineering Centre site map.  

Note:  The targeted controller can be changed at any stage by clicking the site or controller to which you would like to 
change in the Engineering Centre site list. 

Logging in and out 

Work in the Engineering Centre can be done on-line or off-line. When on-line, the PC can communicate directly to the 
controller. When off-line, there is no direct link between the PC and the controller. For tasks that involve direct 
communication between the PC and the controller, e.g. uploading or downloading information, it is necessary to work on-
line.  

 To work on-line, you must Log In to the controller. 

 To work off-line, you must Log Out from the controller. 
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To work on-line (log in): 

Log in by choosing Login from the File menu  

or by clicking the login/logout button on the 
toolbar so that the gate is closed as shown below: 

  

  

 

To work off-line (log out): 

Log out by choosing Logout from the File menu  

or by clicking the login/logout button on the toolbar 
so that the gate is open as shown below: 
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Opening files 

To open a strategy file in the Engineering Centre, you can 

 Create a new strategy  

or  

 Open an existing strategy file. 

 

It is possible to open multiple files: multiple new strategies in different controllers, multiple existing files, or a mixture of 
both (see page 49) 

create a new strategy 

Create a new Strategy by clicking the 

  

button on the toolbar, or by  selecting New from the File 
menu. 

  

open an existing Strategy file 

Open an existing strategy file by clicking the  

  

button on the toolbar,  

or by selecting Open from the File menu. 

Either of these options will produce the generic Windows 
Open dialog box. 
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Navigating a multi-page strategy 

For clarity, many strategies are drawn over several print-pages. To facilitate navigation through these pages, the 

Engineering Centre provides a Page Navigation toolbar. 

Opening the Navigation Toolbar 

Select Page Navigation from the View menu. 

 

This opens the Page Navigation toolbar: 

 

Moving between pages in a strategy drawing: 

Click the Show Page Nums button to toggle the display of page numbers in the strategy drawing: 
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The navigation drop-down list box allows you to jump to a specific page: 

        

Labelling the pages within a strategy drawing 

The page numbers can be edited to act as labels. To do this, right-click on the label to open the Insert Text dialog: 

                        

 

Enter the required label: 

 

 

The label text is displayed on the strategy drawing, and alongside the page number in the navigation drop-down list: 
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Finding an element in a strategy 

The Engineering Centre’s Find dialog is a facility for locating specific objects in a strategy,  

It is opened by either pressing [Ctrl]+F, or by selecting Find from the Edit menu. 

 

This dialog contains a number of lists in which you can specify a number of filters to reduce the kinds of items that will be 
located – for example Integer Constant modules only as shown in the screenshot above.  

You can then step through all of the matching items in the strategy drawing using the << Previous and Next >> buttons. The 
current match will be highlighted in the drawing: 

 

It is also possible to use the keyboard to step through the latest Find filters even after the dialog is closed, using [Ctrl]+[Page 
Down] for next and [Ctrl]+[Page Up] for previous. 
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Opening multiple files 

The Engineering Centre allows you to have several files open at once. Each file must be opened individually as described 
above. Each file can be minimised, maximised and arranged in a number of ways in relation to the other open files.  

 

Arranging open files 

If you are working on more than one strategy at a time, you may wish to be able to see all of the strategy files 
simultaneously. The Engineering Centre allows you to arrange open files in a number of ways: cascaded windows, horizontal 
tiled windows and vertical tiled windows. 

 

Cascade 

In this arrangement, open file windows are all the same size and are placed along a diagonal line through their top left 
corners, starting from the top left corner of the screen. The active file is always on top. 

 

To arrange open strategies in a cascade arrangement, 
choose Cascade from the Window menu. 

  

 

 

Horizontal tile 
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In this arrangement, open file windows are all the same size and are arranged horizontally. 

 

To arrange open strategies in a horizontal tile 
arrangement, choose Tile Horizontal from the Window 
menu. 
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 Vertical tile 

In this arrangement, open file windows are all the same size and are arranged vertically. 

 

To arrange open strategies in a vertical tile arrangement, 
choose Tile Vertical from the Window menu. 
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Zooming in and out of the drawing area 

The drawing area can be displayed in an enlarged or reduced view. The default view is 100%, i.e. full size.  

To zoom in to the drawing area, click on the  

  

button in the toolbar, or select Zoom In from the 
View menu.  

This will zoom in steps of 100%. 

 

 

To zoom out from the drawing area, click on the  

  

button in the toolbar, or select Zoom Out from the 
View menu. 

This will zoom out in steps of 10%. 

  

 

If more precise zoom control is required, click on 
Zoom Level in the View menu: 
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This opens the Zoom Level dialog box. 

You can use this to set the scale of the 
strategy view directly, and see a preview of 
the scaled view. 

  

 

To return to the default view, click the 

  

button in the Toolbar, or select Zoom to 100% from 
the View menu: 
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Changing the display 

The following features of the Engineering Centre can be customized: 

 Module Bars. By editing the UC16int.ini file (see page 418), you can rearrange the module bars. For example, you 
can group together the modules that you require most frequently on one module bar, arrange them 
alphabetically or according to module number.  

 Drawing Area (Grid Settings). To simplify positioning modules on the drawing area, you can choose a grid of 
either lines or dots. You can also customize the size of the grid from 8-pixel to 56-pixel squares (see page 58).  

 Colours. The colour of either the background or the grid can be customized using the Colour menu option from 
the Display menu. In addition to the standard colours available, custom colours can also be defined (see page 59).  

 Macros. If the work you do in the Engineering Centre involves repetitive strategies or parts of the strategies, you 
can create macros (see page 228) to automate much of that work. You can arrange those macros in groups and, 
using an art tool, such as Microsoft Paint, you can draw icons to represent the macro groups and individual 
macros you have created.  

 Application Apearance. The colour theme of the Engineering Centre application itself can be adjusted, and the 
there is a choice of 2 Icon styles for the modules bar. 
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Modifying the Drawing Area (Grid settings) 

From the Display menu, choose Window Setup. 

  

This produces the Window Setup dialog box: 

 

By selecting either of the two buttons listed under Window 
Type, you can choose to display the drawing area of the 
Engineering Centre with or without a grid. 

  

The Type of Grid box allows you to choose a grid that is 
composed of either lines or dots. 

  

The Spacing box allows you to choose from a range of square 
sizes for the grid. The minimum possible size for a grid square is 
8-pixels while the largest is 56-pixels. 
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Modifying display colour settings 

From the Display menu, choose Colours.... 

  
 

This menu option offers a choice of Grid or Background.  

To change the colour of the drawing area’s grid, choose 
Grid. 

  
 

To change the colour of the background, choose 
Background. 

  
 

In both cases, the Colour dialog box is called. This allows 
you to select from a range of colours. You can also make 
custom colours, by clicking on the Define Custom 
Colours button. When you have selected the colour you 
require, click OK. The colour is applied immediately. 
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Modifying the Application appearance (“Theme”) 

The appearance of the Engineering Centre interface can be adjusted by selecting View menu > Application Look and 
clicking on one of the following options: 

Office 2003: 

 

Visual Studio 2005 

 

Visual Studio 2008 

 

Office 2007 Blue Style 

 

Office 2007 Black Style 

 

Office 2007 Silver Style 

 

Office 2007 Aqua Style 
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In addition, two different styles of icon are available for display in the Modules bar – the default set and the “legacy module 
toolbar” set. To replace the default set with the legacy set, open the Options dialog from the View menu and tick the Use 
legacy module toolbar icons checkbox. 

 

 

Default style: 

 

Legacy style: 

 

 

Note:  The overall interface appearance will change immediately when the selection in View menu > Application Look 

is changed, but the icon style will not change until the Engineering Centre is shut down and restarted. 
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Saving Files 

The Engineering Centre allows you store files on disc by: 

 Saving a new file  

 Saving changes to an existing file  

 Saving multiple files at once 

Files will be saved in the "strat5" folder of the relevant site directory, under a numbered directory. The number of the 
directory matches the number of the Comms Controller to which the targeted controller is attached - for example: 

C:\UnitronUC32\Lan\strat5\001\001_01FanCoil.stg 

would be a strategy in a controller on the first Comms Controller of the site called "LAN". 

Saving a new file 

If a file is being saved for the first time, click on the  

  

button on the toolbar, or select Save from the File menu 

 

This produces the Save As dialog box allowing you to specify how the file is to be saved:  
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Save in: 

Choose the directory in which you wish to save the file. 

File Name 

Enter a name for the file. 

Note:  Filenames can be up to 50 characters in length. 

Save File as Type 

Choose the correct extension for the file you are saving from the Save file as type list box (e.g. .stg for a strategy file).  

Saving changes to an existing file 

If you have made changes to an existing file and wish to save those changes, but do not wish to rename the file, nor save it 
to a different location on the PC, you can save the file in two ways: 

click on the  

  

button on the toolbar, or select Save from the File 
menu 

  

Saving more than one file 

If you have a number of files open and wish to save them all, choose Save All from the File menu. This saves each of the 
files.  

If one of the open files is being saved for the first time, the Engineering Centre will prompt you to specify a drive, directory, 
name and file extension for that file by calling the Save As dialog box. 
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Printing 

The Engineering Centre can generate a hard-copy printout of the current strategy, or display a preview of the printout on-
screen.  

Viewing a file before printing 

To see how a strategy will look on a page, choose Print Preview from the File menu.  

This shows a full page view, displaying the strategy as it will appear when printed. 

  

The Print Preview toolbar 

  

Print... 

Click to print the active strategy. 

Next Page 

Click for a preview of the next page of the strategy. 

Previous Page 

Click for a preview of the previous page of the strategy. 

One Page / Two Page 

The one page / two page toggle button allows you to view either one or two pages at a time. 

Zoom in 

Click to enlarge the preview of the strategy. 

Zoom out 

Click to reduce the preview of the strategy. 

Close 

Click to exit Print Preview and return to the Engineering Centre window. 
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Including a footer in a printed strategy 

When you print files created in the Engineering Centre, they include additional information at the end of the printed page 
in the form of a footer. The footer includes the name of the site, as well as the Communications Controller and Field Controller 
for which the strategy is designed. You can edit the footer to include your name, your company’s name, the name of the 
project to which the file belongs, the number of the drawing, if any, and the date and details of any revisions made to the 
drawing.  

How to edit the footer that will appear with the strategy when it is printed: 

Choose Footers from the File menu. 

This opens the Footers details dialog box 

 

Enter the required details and click Save. 

Altering the print set-up 

To define how the strategy is to be printed, choose Print Setup from the File menu to open the standard MSWindows Print 
Setup dialog box, where you can specify the required printer, paper, etc. 
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Printing a file 

To print a file, press the Button on the toolbar, or select Print… from the File menu. This opens the standard 

MSWindows Print dialog box to specify the required printer, pages to be printed and number of copies. 

  

Changing the size of a Printout 

If a strategy is large, it may not be possible to view enough modules on each page with a standard printout. The Engineering 
Centre has a Printer Scaling option, which allows you to decrease the printed size of the strategy so that more of it is visible 
per page.  

Also, if you have set a strategy up for printing on a particular printer, you may find that if you try printing on a different 
printer it may not fit properly on the page. The Printer Scaling option allows you to adjust the printout size to compensate 
for this. 

To resize a printout, select Printer Scaling... from the File menu  

  

This opens the Printer Scale dialog box: 

 

Enter a scaling factor between 20% and 300%. 

 Factors from 20% to 99% will decrease the size of the modules in the printout.  

 Factors from 101% to 300% will increase the size of the modules in the printout. 

Ticking the Apply to all open documents box will set all currently-open Strategies to print with the same scale. 
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Fitting a Strategy to a page size when printing. 

The Strategy drawing indicates where Modules will appear on the printed page, by drawing gray borders on the Strategy 
drawing: 

 

The Printer scale setting will change the size of modules relative to these pages: 

 

The physical page size represented by the gray borders is set by selecting Page Size from the View menu. This opens the 
Page Size dialog: 

 

Selecting Use Printer Settings will allow you to select the page size from the Print dialog at the time of printing: 
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Closing files 

You can close an open Strategy file in two ways: 

Click the Close button at the top right-hand corner of the file window, 

 

or 

Select Close from the File menu. 

 

 

If changes have been made to the file since the last save, the Engineering Centre will prompt you to save it before closing. 

If more than one file is open, selecting Close from the File menu closes the active window. 
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Modules 

Modules are the components from which strategies are designed. The complete list of modules is given in the tables below. 
By opening the UC16int.ini file you can change the preset constant values for many of these modules. Once these 
values have been changed the dialog box of the module will read the updated constant values. For details about each 
module, see Modules Reference (Sections 21 – 28) on pages 445 to 671  

Points Modules 

Module No. Module Name 

- Analog input 

- Analog output 

- Digital input 

- Digital output 

- Analog set point 

- Digital set point 

42 Real Constant 

43 Integer Constant 

48 Digital extract 

49 Digital encode 

54 Digital Constant 

61 Make linear 

 Digital Extract DI (UC24PG Digital Input module) 

 DI Module (UC16DI Digital Inputs) 

63 Meter 

89 Uniput Extract 

99 DI module 

Logic Modules 

Module No. Module Name 

37 Combination of digital inputs (Boolean) 

38 Edge triggered latch 

56 Timer with constant inputs 

36 Timer 

79 Timer with minimum off time 

57 Wide OR gate 

58 Wide AND gate 

82 Wide inverter gate 

44 Time schedule 

60 Holiday schedule 

55 Long period timer 

83 Real time clock 

84 Adjust Schedule 
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 Function Modules 

Module No. Module Name 

19 Rescale from 0 to 100 

20 Rescale to 0 and 100 

21 Limit to min and max 

31 Analog gate 

33 Comparator 

34 Window comparator 

22 Limit to 0 and 100 

 

 

 

Mathematical Modules  
Module No. Module Name 

25 Adder/Scaler 

66 Minimum of 8 inputs with minimum input indicator 

28 Minimum of 8 inputs 

65 Maximum of 8 inputs with maximum input indicator 

29 Maximum of 8 inputs 

30 Average of 8 inputs 

70 Sum of 8 inputs 

26 Multiplier/Scaler 

27 Divider/Scaler 

51 Accumulator 

71 Absolute value 

23 Log of input 

32 AntiLog of input 

68 Log to base e of input 

69 AntiLog to base e of input 

24 Square root 

87 Rounding module 
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Control Modules 
Module No. Module Name 

39 Forward PID 

80 Tuneable forward PID 

40 Reverse PID 

81 Tuneable reverse PID 

18 Hysteresis 

67 Tuneable Hysteresis 

52 Time proportional driver 

53 Raise/Lower driver 

74 Ring counter 

75 Heating curve 

76 Damping module 

64 Hx-diagram 

35 Enthalpy 

45 Optimizer A 

46 Optimizer B 

 
 

 

 

Statistic Modules 

Module No. Module Name 

17 Datalog definition 

41 Alarm record 

77 Control flags 

78 System flags 

73 Runtime module 

62 Seconds run 

72 Number of active digital inputs 

50 Counter 

25 Comment 

85 HOA POT value 

86 HOA switch state 

 

 

 

 





 
 

 

SECTION 4 :  USING MODULES 
  



 

 

74 © American Auto-Matrix MAN00058US rev 69 

M
A

N
0

0
0

5
8

U
S rev 6

9
 

Modules - Overview 

Modules are the building blocks from which strategies are constructed. They are the basic units of operation in the 
Engineering Centre.  

Modules perform tasks within a strategy such as  

 bringing controller inputs into the strategy 

 changing the values of points in the strategy according to mathematical rules 

 comparing the values of points in the strategy 

 recording the values of points in the strategy 

 sending point values to the controller’s outputs. 

Modules can be grouped and saved as in order to avoid repetitive tasks, i.e. if you use a particular strategy or part of a 
strategy frequently, you can save it as a macro and reuse it without having to repeatedly re-create it. 

Modules are represented graphically in the Engineering Centre in 3 ways: 

 as a Module button in the modules bar 

 as a Module symbol in a strategy diagram 

 as a Module dialog box. 

By default, the modules are arranged in six categories in the Engineering Centre. One of these at a time can be can be 
selected to appear in the Modules bar. 
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Module button 

Each module is represented by a button on the floating modules bar, 

 e.g.  

 

 

Module symbol 

When a module has been placed on the drawing area, it is represented by a module symbol.  

  

Most module symbols display 

 
 

 

A module number, a module name, and a block number, 

As shown in the example above. 

The inputs to the module are represented by blue circles or squares on the left of 
the module symbol: 

  

and the outputs by blue circles or squares on the right of the module symbol: 

  

Module dialog box 

To access the module dialog box, click the module symbol with the right mouse button. You will then be able to enter in the 
dialog box the parameters you require for that module. This example shows a completed dialog box for the Make Linear 
module: 
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The arrangement of modules in the Engineering Centre 

There are six categories of modules available in the Engineering Centre: 

 

 

Points 

 

 

Logic 

 

 

Mathematical 

 

 

Control 

 

 

Function 

 

 

Statistic 

Each group is represented by a button on the toolbar, and listed under the Modules command in the View menu. 

 

 

Selecting a module group 

In order to insert a module into a strategy, you must choose it from a group on the modules bar. 

You can choose the group of modules with which you want to work in two ways: 

Click the appropriate module button on the toolbar. 

Or.. 
  

Choose Modules from the View menu and select a 
group from the list. 

  

The selected group will then be displayed on the modules bar, and a specific module can be selected. 

 

 

The modules bar 
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When you choose a particular module group, the modules within that group are presented in the modules bar. 

 

The modules bar is usually docked below the Toolbar, but can be resized and moved to any location on screen. 

There are six different module bars available in the Engineering Centre by default: 

Points: 

  

Logic: 

  

Mathematical: 

 

Control: 

 

 Function: 

  

Statistical: 

 

Choosing a module from the modules bar 

To choose a module from the modules bar, click the button of the module you require.  

  

The module button will depress, to show that the module has been chosen. 

   

 

 

  



 

 

78 © American Auto-Matrix MAN00058US rev 69 

M
A

N
0

0
0

5
8

U
S rev 6

9
 

Placing a module on the drawing area 

In order to use a module in a strategy, you must place it in the strategy’s ‘drawing area’. 

To do this, click on the module in the modules bar to select it. 

  

Then move the mouse pointer to the point in drawing are where you want to place the module. 

  

When you press the mouse button, the module symbol will be placed on the drawing area, with the top left-hand corner of 
the symbol at the point where the mouse was clicked. 

  

Note:  If you have multiple strategies open at once, ensure that you select the strategy into which you would like to 
place the module before you select the module from the modules bar. 

The module can now be selected, and edited, moved, copied, cut, or joined to other modules.  
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Selecting modules on the drawing area 

Before you can move, copy, cut or delete a module, you must first select it. This can be done by: 

Double-clicking on the module symbol, 

                   

or 

Clicking and dragging from the top left to the bottom right of 
the module symbol as shown. When you release the mouse 
button, the module will be selected. 

 

  

  

A selected module is surrounded by eight small black boxes 
(place-holders) around its edges. 

  

To select more than one module on the drawing area: 

Click and drag a box around all the modules you want to select. When you release the mouse button, all the modules within 
the box will have been selected. 

or 

Press and hold down the CONTROL button while double-clicking the modules required. 

or, if you want to select every item in the drawing simultaneously, click on Select All in the Edit menu.  
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Moving modules on the drawing area 

To move a module on the drawing area: 

 Select the module. 

 Click the selected module and hold down the mouse button. 

 Drag the module to its new location on the drawing area. 

 Release the mouse button. The module will be displayed at the new location. 

To move several modules on the drawing area: 

 Select the modules. 

 Click on any one of the selected modules and hold down the mouse button. 

 Drag the modules to their new location on the drawing area. 

 Release the mouse button. The modules will be displayed at their new location.  

 

Deleting a modules from the drawing area 

To delete a module or several modules from the drawing area: 

 Select the module or modules. 

 Press the DELETE button on your keyboard. 

 

Cutting modules from the drawing area 

To cut a module or several modules from the drawing area: 

 Select the module(s). 

 Click the Cut button on the Toolbar. 

or 

 Choose Cut from the Edit menu. 

The module(s) is now removed from the drawing area and will be stored on the Clipboard until placed (pasted) elsewhere. 
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Copying modules on the drawing area 

To copy a module or several modules from the drawing area: 

 Select the module(s). 

 Click the Copy button on the Toolbar. 

or 

 Choose Copy from the Edit menu. 

A copy of the module(s) will be saved on the Clipboard until placed (pasted) elsewhere. 

 

Pasting modules from the clipboard to the drawing area 

Modules and groups of modules can be cut/copied and pasted within the same strategy, or cut/copied from one strategy 
and pasted to another strategy. 

To paste a module or several modules from the clipboard to the drawing area: 

 Make sure that the strategy into which you want to paste the module(s) is active by clicking anywhere on its 
window or by choosing it from the list of open files in the Window menu option. 

 Click the Paste button on the toolbar. 

or 

 Choose Paste from the Edit menu. 

 To place the module(s) on the drawing area, click on the drawing area with the mouse. The top left-hand corner of 
the module(s) will be positioned on the point where the mouse was clicked. 

 

Note:  Pasted hardware point modules may adapt some parameters to the destination point but retain others. For 
example, an analog input configured as PT1000 when pasted to a UniPut will change to a voltage input, but 
retain the max and min limits (in the Advanced button) which for PT1000 could be min 0 and max 0, leading to 
incorrect operation of the UniPut. 
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Joining modules in a strategy 

Modules in a strategy must be joined together to allow information to flow from input to output. The flow is from left to 
right, so that controller input connection points are on the left of the drawing area, controller outputs are on the right, and 
the modules are positioned between the inputs and outputs in the centre of the drawing area. 

Notes on joining modules 
 A connection is possible only if both the input and the output are of the same type (analog or digital). 

 An output of a module can be linked as often as required with inputs of other modules. 

 An input of a module can be linked with only one output of a module. 

 

 

Module connection points 

Connection points are marked on module symbols as blue circles or squares on the left and right edges of the module. 
When the mouse pointer is placed over a connection point, it changes to a cross-hair.  

 Circular connection points are analog.  

 Square connection points are digital 

  

If you want to connect two points, make sure they are both either digital or analog. You cannot connect analog to digital or 
vice versa. 

How to join modules 

Place the mouse pointer over the required output of the 
first module so that it changes to a cross-hair. 

  
  

Click and drag the mouse from the output to the 
required input of the other module. You will see that the 
cross-hair changes back to a mouse pointer once you 
have left the blue connection point and return to cross-
hair format when you reach the next blue connection 
point. 
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Release the mouse when you have reached the required 
input. The two modules are now joined. The connection 
between the two modules is marked by a coloured line. 
The default colour is black, but this can be customised by 
clicking on the connection line with the right mouse 
button. 

  

 

How connections are represented 

By default, the connection between 2 modules is represented by a black line with the numbers of the points at each end of 
the connection also displayed (as in the above example). You can customise the way in which connections are represented 
using the Module Setup option from the display menu or by clicking on the connection line with the right mouse button and 
completing the line dialog box. (See Editing Connections on page 84). You can also right-click on either node (the points on 
the module boxes that are connected by the line) to open the line dialog box. 

 

Module set-up 

By default, when 2 modules are joined on the drawing area, the connection between them is represented graphically by a 
black line and the numbers of the points are displayed at either end of the connection. These settings can be changed in 2 
ways: either using the Module Setup option from the Display menu or clicking the line that joins the 2 modules with the 
right mouse button and completing the Line dialog box. 

Clicking the Module Setup option from the Display menu produces the Module Setup dialog box: 
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Lines/Point Numbers 

The Display Lines and Points tab in the Module setup dialog box contains two check boxes – Display Lines and Display 
point numbers. Checking these options will display lines representing the connections between modules and print the 
numbers of the points at either end of a connection. 
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Screen Text 

The Screen Text tab in the Options dialog box features two check box options: Display Point Values and Display Constant 
Values. When ticked, these options display the values of the variable and/or constant points in the module. 
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Route Point 

  

The Route Point tab in the Options dialog box allows you trace the route of a point in the Engineering Centre. Below is a list 
of the options available in the Route Point tab: 

To route analog points only, i.e. show the connections between analog points, click on the Analog checkbox under Point 
Type. 

To route digital points only, i.e. show the connections between digital points, click on the Digital checkbox under Point 
Type. 

To turn off the Routing facility, deselect the Route Point check box. 

To route one or each connection differently from the others, enter the point number and point name in the Routing 
Information section. Then choose an individual colour for that connection from the eight colours contained in the Routing 
Colour list box. In the example above, the module output is to be routed with a white line. In this instance, the Engineering 
Centre background is coloured (using the Colours option from the Display menu - see page 59) and the result can be seen 
below. This can also be done by Editing Connections directly (see page 86).  

  

 

 

 

 

 

Editing Connections 
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Click the line that joins the 2 modules with the right mouse button to call the Line dialog box: 

  

Display Point Number check box 

To display the numbers of the points that are joined, check the Display Point Number box.  

Point Number box 

This shows the point numbers that the selected line is connecting. If you change the point number in this box, the 
connected points will mirror the change. 

Point Type box 

This states whether the line is connecting analog or digital points. 

Display Line check box 

To represent the connection between the two modules with a line, check the Display Line box. 

Display Line list box 

Select a colour for the line from the list of colours in the box underneath Display Line. The default colour is green. 

Font button 

To change the font in which the point numbers are displayed, click the Font button. This will produce the generic Windows 
Font dialog box in which you can change from the default font ( 12 point, System bold) to your own preference. 
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Scrolling through a strategy using connected modules 

You can scroll backwards or forwards through the connected modules in a strategy by clicking the scroll buttons in the 
module dialog box:  

  

The module dialog box appears when you right-click on any of the modules on the drawing area. 

Note:  If you are designing your strategy with the Automatic Download option enabled (see page 258) you can see the 
module values being retrieved from the controller and updated in real time.  
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How to add text to a strategy 

Click the  button on the toolbar, or choose Add Text from the 
Edit menu. 

  

Click the drawing area at the point where you want the text to be displayed. 

  

The Insert Text dialog box will be displayed: 

  

To select the type of font in which the text should be displayed, click Font. The standard Windows Font dialog box will be 
displayed in which you can choose a font, style, point size, etc. Once you have chosen the required font, click the OK button 
in the Font dialog box. 
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 Note:  It is recommended that you always use "True-type" fonts. When the printing is scaled, non true-type fonts do 

not scale properly. 

 

Type in the Insert Text dialog box, the text that you would like to include in the strategy:  

  

Click OK. 

The text will then be displayed on the drawing area on the point at which you clicked the mouse. 
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Virtual modules 

Virtual modules are so-called because they do not result in point values being downloaded to the Cylon controllers, i.e. they 
do not represent real points. The basic function of a virtual module is to allow for greater flexibility in connecting modules, 
e.g. backward connection of modules. Virtual modules are also used when creating macros, as they allow one external point 
of a macro to be connected, via a virtual, to many internal macro points. There are two virtual modules on a floating toolbar 
– one analog and one digital. The digital virtual is shown below: 

  

Digital virtual module symbol with values not 
shown 

Digital virtual module symbol with values shown 

Placing Virtual modules on the drawing area 

The procedure for placing virtual modules on the drawing area is similar to that for any other module.  

Call the floating virtual modules bar by clicking the 

  

button on the toolbar or by choosing Virtuals from the 
View menu. 

  

This opens the Virtuals bar: 

  
 

Click the button for whichever virtual module you 
require, either a virtual analog or a virtual digital. 
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Click the drawing area.  

 

The top left hand corner of the module’s symbol will be 
placed on the point where the mouse was clicked. 

 

 

 

Rules for connecting to virtual modules 

1. If the point being connected to the virtual module has a point number, then this becomes the number of all the 
inputs and outputs of the virtual module. Any modules that are then connected will have the same point number.  

2. If the point being connected to the virtual module does not have a point number, the Engineering Centre chooses 
a new number and this becomes the number of all the inputs and outputs of the virtual module. 

 Rules 1 and 2 describe how the inputs and outputs of the virtual module are numbered once a connection has 
been made. This is why the Engineering Centre will not allow you, once the first connection has been made, to 
connect another module that has a number. You can, however, connect a module if its point number box is blank. 

 

 

Numbering virtual modules 

Since virtual modules are not downloaded, they do not use any memory in the controller and do not need to be numbered 
in the Block Manager like other modules. 

 Virtual modules have their own numbering system. The first virtual module used in a strategy is numbered V1, the second 
V2, etc. 

 

 

 

Virtual modules in macros 

Virtual modules are useful when creating macros as they allow one input to be used several times.  

For example, to create a macro from the strategy shown, it would be necessary to include two inputs in the macro. 
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Creating the same macro with a virtual module requires just one macro input. 

   





 
 

 

SECTION 5 :  POINTS AND POINT 
VALUES 
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What are points? 

A Point is an area in a Controller where data is collected and stored. The data stored by the point is referred to as the Point’s 
“value”. Controllers in the Cylon system include input, output, set and virtual Points.  

Note;  Cylon’s Controllers are sometimes referred to as “universal controllers”, where “universal” means that they can 
contain both analog and digital Points. 

 

 

 

 

What are blocks? 

An important aspect of the Engineering Centre is the concept of blocks.  

Blocks can be seen as units of measurement for the number of modules and points used in a Strategy – one block corresponds 
to one module, one hardware input Point, one hardware output Point or one virtual point.  

The Managers dialog, accessible from the View menu, allows you to see at a glance which of the blocks in the controller are 
occupied and which are not.  

When Points or Strategies are downloaded to a Controller, the Controller must also be informed of how many blocks are needed 
to store the required information.  

 If you are using Automatic Download (see page 104), the Engineering Centre automatically recognizes how many 
blocks are required and it sends this information to the Controller.  

 If you are not using Automatic Download you must, when downloading Points and Strategies, send specific “Setup” 
information to the Controller, instructing it as to how many blocks it must service in the Strategy. This procedure is 
called Sending Setup (see page 259). 
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Block Numbers 

An important aspect of the Cylon Engineering Centre is the concept of blocks.  

Blocks can be seen as units of measurement for the number of both modules and points used in a strategy.  

 With the UCU and older controllers the Hardware Point numbers are 1 to 16 and Strategy blocks are from 17 to 255.  

 In the CBM, CBT and UC32 controllers, the Hardware Point numbers are from 1 to 1024 and Strategy blocks go from 1 to 

1024. Note however that only Hardware Points 1-24 are used on the CBM24, only Hardware points 1-16 are used on the 

UC32.16 etc. 

controller memory
(UCU, UCxxPG-R and UCxx controllers)

Strategy BlocksVirtual

Digital

Points

Virtual

Analog 

Points

Hardware 

Analog 

or 

Digital 

Points

(inputs or 

outputs)

Block Allocation 

in UCU, UCxxPG-R and UCxx controllers

In these controllers there are a total of 255 

Strategy blocks.

Blocks 1 - 16 are reserved for hardware points, 

and blocks 17 - 255 are available for strategy 

modules.

1

2

3

14

15

16

17

18

252

253

254

255

252

253

254

255

17

18

15

16

14

2

3

1

252

253

254

255

17

18

For each hardware 

point, a strategy block 

is used to bring it into 

the strategy

controller memory
(CBM, CBT and UC32 controllers)

Strategy BlocksVirtual

Digital

Points

Virtual

Analog 

Points

Hardware 

Analog 

or 

Digital 

Points

(inputs or 

outputs)

1

2

3

22

23

24

25

26

1021

1022

1023

1024

25

26

23

24

22

2

3

1

1021

1022

1023

1024

25

26

24

23

22

3

2

1

1021

1022

1023

1024

24

23

22

3

2

1

Block Allocation 

in CBM, CBT and UC32 controllers

In these controllers, there are a total of 1024 

Strategy blocks.

Hardware points in these controllers do not use 

strategy blocks, so that all 1024 blocks are available 

for strategy modules.

Point Numbering 

in UCU, UCxxPG-R and UCxx controllers

In these controllers, point numbers 1 - 16 are 

reserved for hardware points.

Point numbers 17 - 255 can refer to analog or digital 

virtual points.

There are a total of 239 digital virtual points, 

numbered 17 - 255.

There are a total of 239 analog virtual points, 

numbered 17 - 255.

Point Numbering 

in CBM, CBT and UC32 controllers

In these controllers,

There are a total of 24 hardware points (inputs or 

outputs), numbered 1 - 24.

There are a total of 1024 digital virtual points, 

numbered 1 - 1024.

There are a total of 1024 digital virtual points, 

numbered 1 - 1024.
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Point Numbers 

In the Cylon Engineering Centre, the connections between modules are referred to as ‘Points’. These Strategy Points can 

represent physical inputs and outputs on a Controller, or Analog/Binary values (referred to in the Engineering Centre as 
‘Virtual Points’).  

Each Analog Input, Analog Output, Binary Input,  Binary Output, Analog Value and Binary Value is assigned a number, and how these 
points are numbered depends on the controller type. 

 

 

 

CBM/CBT/UC32 point numbers in the Engineering Centre 

In CBM, CBT and UC32 controllers, controller terminals (i.e. inputs and outputs) - “hardware points” in the Engineering 

Centre -  are assigned numbers between 1 and 24. Each terminal can be either an input or an output, so that there cannot 
be two hardware points with the same number. For example if there is an Analog Input 3 there cannot be an Analog Output 3 
or Binary Input 3 at the same time. 

Note:  In theory, hardware Point numbers could be up to 1024, but is limited by the Controller hardware so that the 
current maximum is 24. 

 

Analog Values (“Analog virtual points”) can be numbered 1-1024, and Binary Values (“Digital virtual points”) can be numbered 1 – 
1024, so that there could be for example both Analog Value 3 and Binary Value 3. 

Note: The combined number of Analog Values and Binary Values that can be exposed on a BACnet network by a single 

CBM or CBT is 225. As a result, it is recommended to keep the total number of defined setpoints in a Strategy 
below this value. 

 However it is possible to have up to 100 additional setpoints that are not exposed on BACnet. Such setpoints in 
effect act as constants, because they cannot be changed by the Strategy nor via BACnet, but can be set using the 

Engineering Centre. 
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In Strategy drawings generated by the CEC for CBM, CBT and UC32 controllers, it is possible to identify a Strategy Point’s 
nature as follows: 

 If the number has brackets around it is a “hardware point” – Analog Input, Analog Output, Binary Input or Binary Output. 

 If the number is not bracketed, but is connected to a circular connection point, it is an Analog Value (“analog virtual 
point”). 

 If the number is not bracketed, but is connected to a square connection point, it is a Binary Value (“digital virtual 
point”). 

 

UC32 strategy
Hardware analog point Virtual analog point

Virtual digital point

Hardware digital point
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  UCU, UCxxPG-R and UCxx point numbers in the Engineering Centre 

In these controllers hardware points can be numbered 1-16, analog virtual points can be numbered 17 - 255, and digital virtual 
points can be numbered 17 - 255.  

For a particular point number in a Strategy drawing, it is possible to identify its nature as follows: 

 If the number is between 1 and 16 it is a hardware point 

 If the number is above 17, but is connected to a circular connection point, it is an analog virtual point 

 If the number is above 17, but is connected to a square connection point, it is a digital virtual point 

UCxxPG-R strategy
Hardware analog point Virtual analog point

Virtual digital point

Hardware digital point
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Defining hardware points 

Hardware points are the inputs and outputs of Field Controllers. 

To define a hardware point it is necessary to define the following features: 

 Point number 

 Point name 

 Point type (input, output, digital, analog) 

 Unit of measurement 

 Damping (for analog inputs only) 

Once the required hardware points have been defined in the Engineering Centre, they are then downloaded to the Field 
Controller for which they are intended. 

 

 

How to define hardware points 

The procedure for defining hardware points is as follows: 

 Specify (Target) the controller for which the hardware point is being defined 

 Choose the module from the modules bar 

 Place the module on the drawing area 

 Complete the module dialog box  

 Save the hardware point definition 

 Log in to the Field Controller 

 Download the hardware point definition to the Field Controller 

 

 

 

 

 

Defining Hardware points – Target the controller 

Select in the Site List the Communications Controller and Field I/O Controller that you want to target. This specifies the Field 
Controller on which the hardware point is being defined and the location in the database on the PC’s hard disk in which the 
point definition will be stored.  
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Defining Hardware points - Place the module on the drawing area 

Once you have selected a module from the modules bar, place it on the drawing area by simply clicking the drawing area. A 
dialog box will appear prompting you to enter information on the hardware point. Below is an example of an analog input 
dialog box:  

  

 

Insert the required information in the dialog box (for detailed information about filling in the Analog Input dialog, see 
Example: completing the Analog Input module dialog box on page 112) 

Click OK to accept the settings and close the dialog box. The values assigned to Point Number, Sensor Type, Point Name, 
Units and Exp. Filter Constant will be appended to the database on the PC for the selected path (site, Comms Controller, 
Field Controller, point number). 

Additionally the analog input point function module will be placed on block 4 of the edited strategy. 

The top left hand corner of the module’s symbol, i.e. the graphical symbol for the analog input point, will be placed on the 
point on the drawing area where the mouse was clicked:  
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Defining Hardware points - Save the hardware point definition 

Save the edited strategy by choosing Save or Save As… from the File menu. The Save As dialog box appears: 

  

Enter a name under which the strategy should be saved. The Engineering Centre enters a default file name that identifies 
the Communications Controller and Field I/O Controller for which the strategy has been designed, e.g. if UC #3 on Comms 
Controller #1 was connected to a VAV, its strategy might be named: "001_03VAV.stg".  

When the Save As dialog box is complete, click OK.  

After clicking OK, the name of the strategy will appear in the title bar of the Engineering Centre: 

  

 

Defining Hardware Points - Log in to the controller 

Log in to the controller by choosing Login from the File menu or by clicking the Login/Logout button on the toolbar so that 
the gate is closed:  

  

  



 

 

104 © American Auto-Matrix MAN00058US rev 69 

M
A

N
0

0
0

5
8

U
S rev 6

9
 

Defining Hardware points - Download the hardware point definition. 

You can download a strategy to a controller in just one step, provided you are using Automatic Download.  

To enable automatic download, choose Communication setup from 
the Communications menu. 

 

This will produce the Download Options dialog box, which 
allows you to enable Automatic Download by clicking the 
Automatic Download check box: 

 

Click OK to close the Options dialog box. 

Download the hardware point definition to the UC by choosing 
Download from the Communications menu. 

  

The Engineering Centre will automatically wipe the Field Controller’s memory, download the hardware point and send the 
set-up to the UC, i.e. the number of blocks it is to service. While it is doing this, it will display the Downloading window. As 
the point is being downloaded, the Downloading window displays the progress and in the System status section it shows 
which of the 3 stages (wiping memory, downloading strategy or sending set-up) the Engineering Centre is currently 
completing. If only one hardware point is being downloaded, the process will take place so quickly that the downloading 
window will appear only for a brief moment.  

It is more usual to download an entire strategy, 
with several hardware points and other 
modules. In that case, the Downloading 
window will remain visible for longer and the 
progress of the download will be measured in 
the progress bar. In the example below, the 
download is 20% complete. 

 

Summary of procedure for defining hardware points 

In practice, the procedure for defining hardware points is as follows: 

 Define all hardware points whose values are already known, in the module dialog boxes and place the 
corresponding modules somewhere on the drawing area. 

 Save the strategy. 
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 Click Communications Setup from the Communications menu and enable Automatic Download.  

 Log in 

 Choose Download from the Communications menu. 

Point numbers for inputs and outputs 

When another input module is selected, the Engineering Centre automatically assigns to it the next unused input, i.e. the 
unused input with the smallest point number. 

Defining digital and analog outputs follows the same principle. As outputs are numbered in the range 9 to 16, the 
Engineering Centre assigns point number 9 to the first output. 

A short cut to defining hardware points 

To save time when defining the hardware points you can bring the definitions directly to the database by using the 
Database Interface. 

The types (“A” for analog, “D” for digital), point names and point numbers and units can be written as comma-separated or 
tab-separated lists in a word processing application, copied and pasted via the clipboard to the Database Interface. This 
avoids unnecessary writing work and typing errors. Using external applications for text handling also saves time because of 
their Copy, Search, Replace and Pasting features. 

The point list shown below was created in Microsoft Windows Notepad. Other software applications, such as Excel and 
Word may also be used. 

A Room Temperature 1  °C 1 

A Room Temperature 2  °C 2 

A Outair Temperature South-East °C 3 

A Outair Temperature North-West °C 4 

A Supply Water Temperature 1 °C 5 

A Supply Water Temperature 2 °C 6 

A Valve 1    % 9 

A Valve 2     % 10 

D Pump 1   ON/ OFF 11 

D Pump 2   ON/ OFF 12 

When preparing a hardware point definition list you must separate the values (type, point name, unit, point number, etc.) 
by using tabs or commas, not spaces. 

Note:  This shortcut for defining hardware point values should only be used for UCs that do not already have hardware 
point definitions in the database on the PC’s hard disk, since existing database entries are not deleted. The 
Database Interface does not check for uniqueness. This means that there is a danger of defining more than one 
entry per point, which will cause a lot of confusion in later use of the point in other programs. 
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What are 'UniPuts'? 

"UniPuts" (UIO) are a new concept in software selectable flexible I/O. A "UniPut" can act as an input or an output, so that 
you can now have a controller that fits your BMS design exactly - no need to use an extra controller to gain an extra output 
while leaving an input on the original controller unused. BMS sites can now make more efficient use of a smaller number of 
controllers, saving on cost and complexity. 

A UniPut can be configured as any one of the following: 

 an Active Input, reading between 0 – 10 V at 40 KΩ, with  9-bit resolution. 

 an Active Output, outputting 0 – 10V at a maximum load of 20mA  

 a Digital Volt-Free contact.  

 a digital input detecting the presence or absence of 24Vac 

or 

 a relay switched output. 

The UC32 range of controllers has a number of different combinations of UniPuts and standard Universal Inputs. 

UniPuts are used in controller strategies through standard Analog and Digital Input and Output modules. However, before it 
is possible to add a module for a UniPut to the strategy, the UniPut must be configured using the Cylon Engineering 
Centre's "Terminal Settings" dialog box. 
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Configuring the UC32's Inputs and Outputs 

A UC32 controller has a mixture of Universal Inputs and UniPuts. The Universal Inputs are fixed as inputs, but UniPuts may 
be configured as analog or digital inputs or outputs using the "Terminal Settings" panel. 

How to open the "Terminal Settings" panel. 

The "Terminal Settings" panel opens automatically when a UC32 controller is targeted in the Cylon Engineering Centre 

 

 

If you want to open the "Terminal Settings" panel at any other time, select Terminal Settings from the UC32 menu: 
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How to configure a UniPut 

To configure a particular UniPut (UIO), double-click 
on its terminal number in the "Terminal Settings" 
panel. 

 

 

 

The "Configure IO Types" box opens 

 

Note:  Terminals marked 'Universal' are not 
UniPuts, so the 'Configure IO Types' 
dialog for these terminals does not 
allow the terminal to be changed from 
Input to Output 

 

Set whether the UniPut is to deal with Analog or Digital signals 
(the following illustrations show the UniPut being set as an 
analog output),  

 

and whether it is to be an input or an output 

 

Click on OK to close the Configure IO Type box,  
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and the relevant Point dialog for the selected point 
type opens: 

 

Fill in all of the necessary details for the point and 
click on 'OK'. 

 

and the "Terminal Settings" panel will display the 
UniPut's configuration (in the illustration, terminal 
010 has become an Analog Output) 

 

Repeat this process until all of the required UniPuts have been configured. 
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Changing the configuration of a UniPut 

If you want to change the configuration of an existing UniPut, you must 'delete' its configuration from the Terminal Settings 
panel. 

Note:  The Delete button on the Terminal Settings panel will not work if there is a module in the strategy for that 
point. If you click on Delete when a point is selected for which there is a module in the strategy, a message will 
appear to alert you of this fact. 

  

 

 

If a module exists for the 
point, select the module, 

 

and press delete. 

 

Open the Terminal Settings panel, by selecting it from the 
UC32 menu. 
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Select the terminal number  

 

and click on Delete 

 

The selected terminal has now been returned to 
the blank 'UniPut' configuration. 

 

The terminal can now be selected, 

 

and configured as detailed in How to configure a 
UniPut on page 108. 
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Example: completing the Analog Input module dialog box 

 Point number 

Note:  Point numbers 1-8 represent controller inputs 1-8. 

 Point numbers 9-16 represent controller outputs 1-8. 

In the Point Number edit box is the number of the channel of the selected input, given in the range 1-8. The Engineering 
Centre automatically enters the next available point number in this box. To assign a point a number other than the one that 
is automatically chosen by the Engineering Centre, highlight the existing number and type in the required number.  

 Point Name 

Enter a name for the point in the Point Name edit box, using no more than 24 alphanumeric characters. Spaces, commas, 
full stops may also be used. Each point in a UC must have a point name that is unique within that controller. 

 Units 

The Units list box contains a collection of text strings, one of which will be displayed together with the point value. Choose 
from the list the type of unit that corresponds to the type of input, e.g. if an analog input point represents a temperature 
reading in degrees Celsius, you may choose DegC from the Units list box. If necessary, additional units may be defined in the 
WN3000.ini file. Appendix A contains details of how this is done. 

 Sensor Types 

Choose from the list under Sensor Types, the type of input you require. Some of the inputs available are: 

 Pt1000: This configures the analog input for reading temperatures from a standard Pt1000 sensor. The UC will 
convert the measured resistance (voltage) to a temperature signal. 

 0-10 V: This converts the hardware voltage signal 0-10 V DC to a software value in the range 0… 100 %. For 
example, the voltage signal 6.7 V DC will be converted to 67.0 %. 

 0-20 mA: This converts the hardware current signal 0-20 mA to a software value in the range 0... 100 %. For 
example, a current of 15.0 mA gives the software a value of 75.0 %. 

 Pulse(V/F): This is designed for reading voltage-free contacts, which can be operated at a frequency of up to 12 
Hz. The value of the input will be incremented by 1 after each detected pulse. Evaluation and resetting of the 
counter will be done by using the Meter Module (module 63). 

Additional sensor types can be allowed for by defining extra units of measurement  Adding_units_of_measurement in the 
WN3000.ini file (see page 414). 

 Input Error  

The Input Error is a constant with the same unit as the input value. It is added to the input value to compensate for errors in 
input arising from factors such as resistance of long cables or positioning of sensors. Temperature values (sensor type 

PT1000) are corrected in mV. To compensate for 1C, the input error is 2.5mV. For example, a decrease in temperature of 

2C requires an input error of -5.0mV to be entered. This feature will only work for analog passive inputs. 

 Exp. Filter Constant 

The Exp. (Exponential) Filter Constant is an individual time constant for the analog input. The filter constant works like a 
damping filter. The measured input value will be averaged over the time specified in seconds by the exp. filter constant. 
Variations of the measured value caused by specific conditions of the site can be filtered out if the exp. filter constant is 
bigger than the sensor response time. 

 Alarm Point 

The Alarm Point field contains the number of a digital point which will be activated if an alarm event of this point occurs. It 
can be set to alarm if a temperature value is out of a certain range. This can happen, for example, if the sensor cable is 
broken or has a short circuit. For further details on setting up alarms, see Chapter 8 Alarms. 
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 Advanced 

Clicking on the Advanced button will bring up the following dialog box: 

 

The threshold setting specifies the on/off turnover point on a digital input or output. The threshold will be set by default to 
a low figure of 78 bits and a high of 120 bits. The sensor range will be set to a low of –50 and a high of 150. 

Below is an example of a completed dialog box for the 1st analog input.  

 The Point name is defined as “Outside air temperature”. 

 The Unit of measurement chosen is DegC. 

 The Sensor Type is defined as PT1000 – input for reading temperature values. 

 The Exp. Filter Constant is set at 20 seconds. 

 

Click OK to accept the settings and close the dialog box. The values assigned to Point Number, Sensor Type, Point Name, 
Units and Exp. Filter Constant will be appended to the database on the PC for the selected path (site, Comms Controller, 
Field Controller, point number). 

Additionally the analog input point function module will be placed on block 4 of the edited strategy. 

The top left hand corner of the module’s symbol, i.e. the graphical symbol for the analog input point, will be placed on the 
point on the drawing area where the mouse was clicked:  
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Viewing used blocks 

To check which blocks have been used in a strategy, click Managers in the 
View menu. 

  

This opens the Managers dialog: 
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Viewing the list of blocks 

Click on the Strategy Blocks tab to open the Strategy Blocks window 

The Strategy Blocks window displays which of the available blocks have been used in the active strategy and which have not. 

  

In the above example, the Strategy Blocks manager window indicates that the first block (block no. 001) is being used as a 
Damping module.  

Blocks 2 is an enthalpy module, block 3 is a damping module etc.  

 

Blocks 9 to 32 have not been used in the strategy.  

To view the remaining blocks (in the above example, blocks 33-1024), use the horizontal scroll bar to move across the Block 
Manager window.  

Viewing the blocks associated with each point 

The Points Manager tab allows you to examine points in a strategy, listing the strategy blocks to which each point is 
connected. 

 

In this example, Analog Point number 1 is connected to strategy blocks numbered 1 and 3. 
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Uploading strategies from a Field Controller 

Hardware points, blocks, and globals that have been downloaded to a controller can be uploaded and viewed, and if 
necessary edited and then downloaded again. 

Uploaded strategies will not look the same as they did before they were downloaded, because the strategy drawing is not 
stored in the controller. Instead, the blocks will be arranged geometrically on the drawing area (see Viewing uploaded 
strategies on page121) 

To upload strategies from a Field Controller, carry out the following steps: 

 Open a new, blank, strategy file 

 Log in to the controller 

 Open the Select Items to Upload dialog box 

 Select the type of points to upload – analog or digital  

 Close the Select Items to Upload dialog box 

 Close the Uploading window  

Uploading strategies - Open a new file 

Select from the Site List the site, Communications Controller and Field I/O Controller from which the points are to be 
uploaded. Open a new strategy file by choosing New from the File menu or by clicking the new button on the toolbar.  
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Uploading strategies - Open the Select Items to upload dialog box 

Click the  button on the toolbar, or choose Upload from 
the Communications menu. 

 

This produces the Select Items to Upload dialog box. The dialog that will be displayed depends on whether a UC32 or 
UC/UCU controller is targeted. 

UC32 Select Items to Upload dialog: 

 

UC Select Items to Upload dialog: 
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Uploading strategies - How to upload analog points 

In the Select Items to Upload dialog box, tick the Analog Points checkbox. 
The default setting uploads all of the available analog points from the 
targeted controller. 

  

If you want to specify which points to upload, click the Analog... button.  

 

This calls the Upload Analog Points dialog box: 

  

Click the Selected radio button and enter the range of points you wish to 
upload in the Range box. 

Note:  For UC/UCU controllers this option is normally used to upload 
virtual points, so the numbers in this range will usually be 
between 17 and 255. 

  

Click OK to confirm your settings. 
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Uploading strategies - How to upload digital points 

In the Select Items to Upload dialog box, tick the Digital Points 
checkbox.  

The default setting uploads all of the available digital points from the 
targeted controller. 

  

If you want to specify which points to upload, click the Digital... 
button.  

  

This calls the Upload Digital Points dialog box: 

  

Click the Selected radio button and enter the range of points you wish 
to upload in the Range box. 

  

Click OK to confirm your settings. 
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Uploading strategies - Close the Select Items dialog 

When all items to be uploaded have been ticked, click OK in the 
Select Items to Upload dialog box. 

 

The Uploading window appears.  

It shows the rate at which the information is 
uploaded by means of a progress bar.  

The progress bar in the example shows that the 
upload is 68% complete. The System Status 
section at the bottom of the Uploading window 
provides information on the upload process, 
e.g. Receiving digital points from controller: 

 

When the Engineering Centre has uploaded all 
of the requested information, System Status 
displays the message Upload Complete. 

 

Uploading strategies - Close the uploading window 

Click Close; the uploaded points are now displayed on the drawing area. 
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Viewing uploaded strategies 

When the Engineering Centre has finished uploading the desired points, it displays them on the drawing area. The 
Engineering Centre gives the points a logical layout, which may not match the layout used in the Strategy drawing when the 
strategy was first downloaded to the controller. This is because drawing information is not stored in the controller. 

For example, if the points looked like this when you defined them: 

  

they might look like this when uploaded from the controller onto a different PC: 

 

Note:  Following an upload, the system parses the strategy, and if it finds an input or output that does not have a 
source or destination point it inserts a setpoint for that connection. 
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Viewing uploaded point values 

The values of points and setpoints in a strategy can be viewed using the LiveLog feature. The last of the three menu options 
in the LiveLog menu, View, allows you to read the point values of the uploaded strategy in a text file. 

 

Select View from the LiveLog menu. This will produce an MS Notepad (or similar text editor, e.g., MS WordPad, which must 
be specified in the wn3000.ini file) window displaying the values of all the points in the active strategy that have been 
uploaded from the controller: 

  

Note:  This list of point values may be printed and stored for reference purposes. 

  



 

 
 

MAN00058US rev 69 © American Auto-Matrix 123 

Reading Live point values (LiveLog) 

To read a point value means to display the current value of a point on screen. Reading point values is only possible if the PC 
is connected to a UC (either directly, or via a Communications Controller) and the Engineering Centre is online (i.e. you have 
logged in). 

1. Select the UC from which the point value is to be read  

2. Log in to the controller  

3. Activate LiveLog  

4. Choose the update method for the LiveLog window  

5. Choose the strategies you want to view  

6. Choose the options you need from the LiveLog window  

Reading Live Point Values - Select the UC from which the point value is to be read 

Select from the Site List the site the Communications Controller and Field Controller containing the point that is to be read.  

The LiveLog Window 

Activate the LiveLog by choosing Log from the LiveLog menu. This produces the LiveLog window, also known as the “I/O 
Window”: 

  

 

Choose the update method for the LiveLog window 

As the LiveLog scans the point values in the controller, it lists them in the LiveLog window (I/O Window). As those values 
change, the list is updated by the LiveLog. There are two ways of displaying the updated values – a new list can be added to 
the previous list of values (Append) or the values in the first list can be replaced with the updated values (Overwrite).  

This can be done in the IOWindow setup dialog (see How to set up Live Log to append or overwrite its display on page 141). 

Choose which strategies you want to view 



 

 

124 © American Auto-Matrix MAN00058US rev 69 

M
A

N
0

0
0

5
8

U
S rev 6

9
 

You can choose to scan a single strategy, or all strategies currently opened in Engineering Centre.   

This can be done in the IOWindow setup dialog (see How to set up the strategies that the LiveLog will display on page 142). 

 

 

LiveLog - Scanning Definition 

In the LiveLog Window (or “I/O window”), you can view the following parameters for the LiveLog, and change them where it 
is appropriate to do so: 

 The name of the current strategy (see page 124) 

 The Mode of the LiveLog, i.e. whether the LiveLog will log points, schedules or the network status (see page 124) 

 The Target Controller for the current strategy (see page 126) 

 The type of points to be scanned (see page 126) 

 Whether or not points will be overwritten (see page 127) 

 

LiveLog Window - Strategy name tab 

 

The name of the strategy which is actively being scanned is displayed on the strategy name tab. If you chose the scan Active 
Strategy option in the IOWindow Setup dialog box (see How to set up the strategies that the LiveLog will display on page 
142), the file name tab will display the name of the active strategy. If you chose the scan All Opened Strategies option in the 
IOWindow Setup dialog box, there will be a file name tab for every open strategy. 

LiveLog Window - LiveLog mode 

  

The LiveLog interface changes, depending on the mode that is being logged: 

 Points mode 

 Time schedule mode 

 Network mode 

 

 LiveLog: Points mode 

In this view you can see points in the selected strategy, their types and values, and you can overwrite them if required. 
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 LiveLog: Time Schedule mode 

You can examine the time schedules in the selected strategy with this dialog box. 

  

 

 

 

 

 LiveLog: Network mode 

You can view the status of the ARCnet or RS485 Fieldbus with this screen, i.e. which controllers are online or offline, and 
which controllers are servicing or not servicing. 
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LiveLog Window - Strategy Target 

  

This window shows the target of the currently selected strategy. The values cannot be changed in the LiveLog dialog. 

 

LiveLog Window - Scanning definition 

  

The Scanning section of the LiveLog window allows you to decide which values to scan. To scan the values of the controller’s 
hardware points, click IOPoints.  

To scan analog points only, click Analogs in the scanning section. To scan a specific number of analog points, enter a range 
of point numbers in the edit box under Digitals. 

To scan digital points only, click Digitals in the scanning section. To scan a specific number of digital points, enter a range of 
point numbers in the edit box under Digitals. 
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LiveLog Window - Override Status 

  

When a scan has been stopped, you can change the Override status of any point listed in the LiveLog window (I/O window) 
as follows:  

 select the point from the list: 

  

 click on the Override Point button at the bottom left of the window. 

  

This opens the Change Point Value dialog (see page 128), where the current override status of the point is displayed and 
can be changed if necessary. 
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Downloading a strategy using Automatic Download 

 

Automatic Downloading - Download the strategy 

LiveLog: Change Point Value dialog 

  

The Change Point Value dialog is opened by clicking on the Override Point button in the Livelog Window, or by selecting 
Change Point Value from the Communications menu. 

 

 

For the point currently selected in the LiveLog window (I/O window), the Change Point value dialog displays the following: 

 The radio buttons labelled Analog and Digital specify whether the point is analog or digital. 

 The Point Number box displays the number of the currently selected point. 

 A value for the currently selected point can be entered in the Point Value box. The point will be set to the entered 
value if the Turn Manual Flag… On box is ticked when the Override button is pressed. 

 The Turn Manual Flag… check boxes (only available for hardware points) show whether or not the point is being 
manually overwritten. This can be changed as required by ticking the appropriate box. 

 

Note: If you want to change the override status of the point in any way, after editing the appropriate boxes you must 
press the Override button to close the dialog box and apply the changes. For instance, if you tick the Off 
checkbox for "Turn Manual Flag...", you must press the Override button again before the point will revert to 
scanning normally. 
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How to read hardware point values 

Activate the LiveLog as outlined in steps 1- 3 of Reading Live point values 
(LiveLog) on page 123. 

In the Scanning section of the Livelog window, click IOPoint. 

 

The LiveLog window will then display the numbers, names and values of the hardware inputs and outputs. 

How to scan all virtual analog points 

Activate the LiveLog as outlined in steps 1- 3 of Reading Live point values 
(LiveLog) on page 123. 

In the Scanning section of the Livelog window, Click Analogs. 

  

The LiveLog window will then display the numbers, names and values of the controller's virtual points. 

How to scan all virtual digital points 

Activate the LiveLog as outlined in steps 1- 3 of Reading Live point values 
(LiveLog) on page 123. 

In the Scanning section of the Livelog window, Click Digitals. 

  

The LiveLog window will then display the numbers, names and values of the controller's virtual points. 

How to scan a single point 

Activate the LiveLog as outlined in steps 1- 3 of Reading Live point values 
(LiveLog) on page 123 

In the Scanning section of the Livelog window, enter a point number in 
the text box. 

  

The LiveLog window will then display the numbers, names and values of the selected point. 

 

 



 

 

130 © American Auto-Matrix MAN00058US rev 69 

M
A

N
0

0
0

5
8

U
S rev 6

9
 

Manually Overriding Point Values - the Change Point Value dialog 

The Change Point Value dialog box allows you to set a point in a strategy to a particular value, regardless of conditions at a 
controllers inputs or outputs, or conditions within the strategy itself. 

When a hardware output is manually overridden (disabled), the modules and/or globals in the strategy do not affect the 
point value. 

When a hardware input is manually overridden (disabled), the hardware signal which is connected to the input (PT1000, 
transmitter, dry contact, etc.) is ignored by the input. 

In both cases, the overridden hardware point keeps the value that is assigned to it in the Change Point Value dialog box.  

The only way to change the value of a hardware point which has been manually overridden to another specified value is to 
use the Override option again, assigning a new value in place of the first. 

Removing manual override status from a hardware point (enabling) means that the point can now be influenced by the 
peripheral hardware or strategy once again. The length of time that a UC32 hardware point will remain in the overridden 
state can be set in the Engineering Centre. For UC/UCU controllers, a separate step must be carried out to remove override 
status from a point. 

It is only possible to disable and enable hardware point values if the PC is connected to a controller (either directly or via a 
COMMUNICATIONS CONTROLLER) and the Engineering Centre is on-line. 

How to open the Change Point Value dialog 

The Change Point Value dialog box allows you to  

 Override or “disable” a hardware  point, i.e. set it to a constant value regardless of conditions at the controllers 
inputs and outputs 

 “enable” a hardware point, i.e. return the point’s value to the automatic state. 

 Change the value of a setpoint 

To open the Change Point Values dialog, you can: 

 Select Change Point Value from the communications menu 

  

 Select Override Point from the LiveLog (I/O) window 

If the LiveLog window is not already open, activate the LiveLog as outlined in steps 1- 3 of Reading Live point values 
(LiveLog) on page 123 

Click on the Override Point button at the bottom left of the window. 

  

The Change Point Value dialog will change appearance depending on whether a UC32 or UCU controller has been targeted. 
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UC32 Change Point Value dialog: 

 

UC Change Point Value dialog: 

 

 

 

 

How to select a point to be changed in the Change Point Value dialog 

When changing the value of a point using the Change Point Value dialog box, you must specify the point by one of the 
methods shown below: 
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 Enter the number in the Point number box: 

Fill in the Point Number field in the dialog of the 
UC32 Change Point Value dialog 

 

Or the UC Change Point Value dialog 

 

You must specify whether or not the point is analog 
or digital, because there could be one point of each 
type for each number. 

 

 

 

In the case of hardware points on UC/UCU controllers (numbers 1-16) there can only be one point for each number. 
Whether or not that point is analog or digital is defined in the strategy. In the case of hardware points you must select the 
correct type. 
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 Select point before opening from LiveLog window: 

If the LiveLog window is not already open, activate the LiveLog as outlined in steps 1- 3 of Reading Live point values 
(LiveLog) on page 123. 

Click Stop Scan: 

  

Select the point from the list in the LiveLog window (I/O window): 

  

 

Click on the Override Point button at the bottom left of the window to open the Change Point Value dialog: 
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How to override (disable) a Hardware point 

Open the Change Point Value Dialog (see How to open the Change Point Value dialog on page 130). 

Select the point to be overridden (see How to select a point to be changed in the Change Point Value dialog on page 131).  

The procedure varies for overriding UC32 and UC hardware points. 

Overriding a CBM/CBT/UC32 Hardware point 

When overriding a hardware point on a CBM, CBT or UC32, the override facility can be set to one of the following states: 

 inactive at all times - Off 

 active until the controller time passes 00:00  - Midnight 

 active for one hour from the time at which it becomes active - 1 Hour 

 active at all times - Continuous 

 

Note:  The "On Until Midnight" and "On For 1 Hour" options are for UC32-type controllers only. These options are NOT 
available when viewing points in UC or UCU controllers 

The 'midnight' and '1 hour' options are provided to conveniently avoid problems that could arise if the override is not 
removed when it is no longer required. 

Note:  Even if 'Off' is selected in the override section, setting a value (analog) or state (digital) for the point will still 
have an effect. When the 'Override' button on the dialog is pressed, the value is sent to the point in the 
controller strategy, which stays at that value until the next time that the controller scans its strategy. 

Tick the Hardware Points checkbox in the Hardware 
Point Attributes section of the dialog.  

This will enable the Override Duration options. 

 

Enter a value for the point.  

In this instance, a value of 25 is being is being entered 
for an analog point. 

A value of 1 or 0 can be entered for digital points. 

 

Select the length of time that the value of the point will 
be changed in the Override Duration section of the 
dialog. 

 

The point will be set to the entered value when the 
Override button is pressed: 
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Clicking the OK button closes the dialog. 

Notes about overriding BACnet points 

 Inputs 

 When a CBM/CBT input is overridden via Unitron, both the “out of service” and the “override” flags are 
automatically set.   

 When an overridden input comes out of its Unitron override both the “out of service” and the “override” flags 
are reset.  It will be put into service regardless of the state it was in prior to going into override. 

 To override an input via BACnet, the “out of service” flag is manually set by writing to the “out of service” 
property.  Then the desired value is written to the present-value.  The OWS can clear any Unitron override by 
putting the point back into service and then back out again. From the Unitron side, the “override” flag will 
disappear and be replaced with an “overridden” flag.   

 Putting an input in service will clear all overrides both Unitron and BACnet and will flag the change 
appropriately on both protocols. 

 Outputs 

 When an output is overridden via Unitron, both the “out of service” and the “override” flags are set.  The 
information in the present-value property will still be delivered to the hardware layer despite being out of 
service.  

 When an overridden output comes out of its Unitron override, the point is put back in service and both the “out 
of service” and the “override” flags are reset.   

 To override an output via BACnet, it is presumed that the priority array will be used, and clear all overrides and 
flag the change appropriately on both sides. 

 All I/O blocks have an output labelled “M” which is meant to indicate the override status of the point in 
question.  This output is true any time the point is “out of service” or “overridden” via Unitron.  This way the 
point reflects the status of the data regardless of whether it is being overridden via BACnet or Unitron.    
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Overriding a UC Hardware point 

With older UCU and Ucxx controllers, the Turn Manual Flag… check boxes at the bottom of the Overwrite section specify 
whether or not a Hardware point is to be manually overridden. 

To override the currently selected Hardware point, 
select the Hardware Point checkbox and then tick the 
Turn Manual Flags… On check box. 

Note:  The Manual Flag is a ‘firmware’ feature of 
Hardware points (i.e. inputs or outputs – 
points numbered 1-16). This step is not 
relevant to virtual points (points numbered 
17-255)  

  

Enter a value for the point 

  

The point will be set to the entered value when the 
override button is pressed: 

  

To close the dialog, click on the OK button. 

 

 

To see the new value of the point, click Restart Scanning in the LiveLog window. 

  

The next time the LiveLog scans that point, its new value will be displayed. The LiveLog marks point values that have been 
overridden by displaying the symbol ¶ beside the value.  
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Tip:  Double-clicking a point number in the LiveLog window places an asterisk beside it allowing it to be monitored 
more effectively: 
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How to Enable a hardware point value (remove manual override status) 

Removing manual override status from a hardware point (enabling) means that the point can now be influenced by the 
peripheral hardware or strategy once again. If the override duration on a UC32 hardware point has been set to one hour or 
until midnight the point will be enabled when the specified period has elapsed. If the override duration on a UC32 has been 
set to continuous, or if a point on a UC or UCU controller has been overridden, the following procedure must be carried to 
enable the point: 

Open the Change Point Value Dialog (see How to open the Change Point Value dialog on page 130). 

Select the point to be overridden (see How to select a point to be changed in the Change Point Value dialog on page 131). 

If the targeted controller is a UC32,  

Select the Off option in the Override Duration section 
of the dialog, 

  

And click the Override button to apply the change. 

  

To close the dialog, click on the OK button 

If the targeted controller is a UC or UCU, 

Click the Turn Manual Flag… Off check box, 
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And click the Override button to apply the change. 

  

To close the dialog, click on the Ok button 

To see the new value of the point, click Restart Scanning in the LiveLog window. 

  

 

The next time the LiveLog scans that point, it will display the value of the point as it is read by the controller.  

The ¶ symbol will be removed (see point 001 in the diagram below): 
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How to change the value of a virtual point 

The value of a virtual point can be changed using the Change Point Value dialog box, in a similar way to changing the value 
of a hardware point. 

However, virtual points cannot be overridden – if conditions in a strategy change, a virtual point may change from the value 
given to it in the Change Point Value dialog. As a result, changing the value of a virtual point is usually only relevant in the 
case of setpoints, because their values are not affected by the strategy. 

 The procedure for changing the value of a setpoint is as follows: 

Open the Change Point Value Dialog (see How to open the Change Point Value dialog on page 130). 

Select the point to be overridden (see How to select a point to be changed in the Change Point Value dialog on page 131). 

Enter the new value for the virtual point. 

Note:  Because the point is a virtual point, the 
Override Duration options in the UC32 
dialog and the Turn Manual Flag… options 
in the UC dialog are ‘greyed out’ and 
cannot be selected. 

  

Click the Override button to apply the change. 

  

To close the dialog, click on the OK button 

To see the new value of the point, click Restart Scanning in the LiveLog window. 

  

The next time the LiveLog scans that point, its new value will be displayed. The LiveLog marks point values that have been 
change by displaying the symbol ¶ beside the value. 

Note:  Double-clicking a point number in the LiveLog window places an asterisk beside it allowing it to be monitored 
more effectively.  
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Changing the LiveLog's set-up 

The LiveLog feature in the Engineering Centre allows you to read the values of points in the controllers on your site (i.e. it 
reports “live” or in real-time from the site).  

As well as reading point values, the LiveLog also scans time schedules, the ARCnet network and its Fieldbusses and, if 
configured to do so, it will log those values to a text file. 

How to set up Live Log to append or overwrite its display 

Select Setup from the LiveLog menu…. 

  

…to open the IOWindow Setup dialog. 

  

In the Update section of the IOWindow Setup dialog, choose 
the update method you require: 

Append will cause the LiveLog add new scan data to the end 
of the existing list, 

 

  

Overwrite will cause the LiveLog list to be replaced each time 
a scan is completed. 
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How to set up the strategies that the LiveLog will display 

Select Setup from the LiveLog menu…. 

  

…to open the IOWindow Setup dialog. 

  

To read the point values of each strategy that you have opened, 
click the All Opened Strategies radio button.  

 

 

or 

  

To read the point values of the active strategy only, click the Active 
Strategy radio button. 

  

If you chose to scan the active strategy, enter a number between 1 
and 60 in the Scan Interval edit box. This represents the number of 
seconds the Engineering Centre will remain idle after scanning the 
strategy before it will scan the strategy again. (The LiveLog 
continuously scans the strategy until you press Cancel or Stop 
Scan.) 
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How to set up the LiveLog to store its results in a file 

Select Setup from the LiveLog menu…. 

  

…to open the IOWindow Setup dialog. 

  

If you would like the results of the LiveLog to be written to a 
text file and saved, click the Log to File checkbox. By default, 
a file path and name (\SYSTEM\iowin.log) already exists to 
which the LiveLog results will be written.  

  

To view the contents of the LiveLog text file, click View in the LiveLog menu. 
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Scanning point values 

There are three ways to scan point values – using Log from the LiveLog menu, Scan from the Communications menu, or 
dialog scanning  (opening a module dialog box after downloading the strategy). While all options will scan point values, they 
differ in functionality. The main features of each option are listed below:  

The Log menu option: 

 scans the values of all the points in the targeted controller. 

 displays the changing values in list form. 

 scans the point values in the LiveLog window. 

 

The Scan menu option: 

 scans the values of the points in an uploaded strategy. 

 displays the changing point values graphically in the module symbols 

 activates scan mode, i.e. the Engineering Centre window changes to the Scan mode window which has just two 
menu options and a red title bar. 

 

The dialog scanning option 

 scans the points attached to a single module 

 displays the value in the module's dialog box 

 

 

For further details of Scan mode, see Testing a strategy with Scan Mode page 199.   
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How to Configure a Controller’s BACnet settings 

When a Field Controller is first commissioned, its address must be set by connecting CEC directly to the controller by RS232 

link (Service Port). If points on the controller are to be exposed on a BACnet network, or if the CEC is to communicate with 
the Field Controller by BACnet Tunneling, then the Field Controller’s BACnet address (Device Instance Number) must also be set. 

These device settings, and others, can be set from the CEC as follows: 

Note:  Some parameters can be set over Ethernet connection, but Controller Address and Baud Rate can only be set 
when the Engineering PC is connected to the controller by RS232 link. 

In the Cylon Engineering Centre, select Configure BACnet Device from the Communications menu 

 

This opens the Device Properties dialog, which defines how the Controller will communicate on the BACnet network, and 

how it will communicate with Cylon Engineering Centre for configuration over BACnet. 

In this dialog, each current value and the proposed new values can both be displayed at once. Defaults can also be 
automatically generated. 
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Device Properties 

  

Note:   Only Device Name, Site Number, Comms Ctrl Number and MSTP Max Masters will be editable when the 
Engineering PC is connected over Ethernet. In order to edit the other parameters, it must be connected by 
RS232 serial link. 

The parameters that define how the Controller communicates on the BACnet system are: 

 Device Instance Number  

Enter the required BACnet address (0 – 4194303). 

Note:  The number set here in the Field Controller (when connected serially) must match the Device Instance Number set in 

the Cylon Engineering Centre. 

 Device Name 

Any descriptive text. 

 Tunneling Properties: Site Number, Comms Ctrl Number and Controller Address 

Note:  All of the Cylon controllers throughout the BACnet system must have the same Unitron “Site Number”. 
Broadcast globals will not work if this is not the case. 

In the Device Properties dialog set the Site Number and Comms Ctrl Number matching the position of this Controller in the 

Site defined in the Cylon Configuration utility (CCConfig). 
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 MSTP Max Masters 

This must be equal to or greater than the highest address used on the BACnet MS/TP fieldbus, because this controller will 
not pass data to devices with addresses higher than this. The optimum situation is that this value is set in all devices to 
exactly the value of the highest address on the fieldbus. (1 - 127) 

Note:  It is recommended that you address your controllers consecutively starting at 1, with the MAX Master value 
matching the Maximum Controller address value. For optimum efficiency there should be no gaps in the device 
addresses. 

 APDU Timeout 

(0 - 60 seconds) this value should be left at its default unless there is a problem. 

 MSTP Address (not visible by default) 

This is the BACnet address of the Field Controller on the Cylon BACnet fieldbus (0 - 127). 

It is recommended that this is set to the same value as the Controller Address, which is the Unitron address of the Field 
Controller on the fieldbus (1-255). By default these are set to the same value, 1-127, and the MSTP Address field is no 
available to be edited. However, it is possible to set a different BACnet address if required. To do this, click the Advanced… 
button, to open the BACnet Device Setting Advanced Options dialog: 

 

Tick the Allow separate Controller and MSTP addresses checkbox 

 

And click OK. The Device Properties dialog will now show the MSTP Address parameter, allow it to be edited if the 
Controller is connected by RS232 Serial Connection: 
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If this value is changed, then a warning will be displayed that the Cylon Engineering Centre must be restarted before the 
Engineering Centre will be able to communicate with the controller over IP (it is currently connected serially to make the 
change) 

 

 



 
 

 

SECTION 6 :  CREATING STRATEGIES 
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What is a strategy? 

A Cylon controller controls HVAC and other equipment by varying its outputs in response to inputs such as temperature, 
switch settings, air flow speed etc. 

The way that the controller’s outputs react in response to the controller’s inputs can be defined by the user. The definition 
is called a ‘strategy’.  

A strategy is the ‘user program’ stored in a Cylon controller, that configures the controller for a specific role in a BMS site. It 
can be described as the “implementation of a solution” to a requirement on a site.  

In the Engineering Centre, a strategy is designed graphically using the algorithmic modules available on the modules bar 
(see page 76). It is saved as a strategy file on the supervisory PC and then downloaded to the controller for which it was 
designed, where it tells the controller how to behave within the BMS site. 

The simplest of strategies is made up algorithmic modules, hardware and virtual points. Strategies are often more complex, 
however, and can also include globals (for communicating values to or between other Field Controllers on the ARCnet 
network – see page 296) time schedules (see page 376), datalogs (see page 380 and alarms (see page 388). 
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An example of a strategy 

 

The Problem 

The heating system of a building is too costly to run constantly. 

 

The Solution 

The heating system should be switched off when the outside air temperature rises above a certain point (for example 23C). 
It should not be switched on again until the outside air temperature drops below another pre-defined point (in this case, 

18C). 

 

The Strategy 

A strategy to implement this solution to the problem can be designed in the Engineering Centre and downloaded to the 
controller connected to the heating system, where it will be applied. 

The strategy shown below uses the hysteresis module to compare the outside air temperature to the two set points defined 

in the module (in this case, these are set at 18C and 23C). If the outside air temperature is greater than 23C, the H output 

is unset (off). If it is less than 18C, the H output is set (on). 

The strategy is saved and then downloaded to the UC connected to the heating system. 
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How to Create a Strategy 

To create a strategy, follow these steps: 

 Select Site, Communications Controller, and Controller (see page 152) 

 Select a modules group (see page 76) 

 Select a module from the modules bar (see page 77)  

 Place the selected module on the drawing area (see page 153) 

 Place all the required modules on the drawing area (see page 155) 

 Join the modules (see page 156) 

 Set the values of the module's inputs and outputs (see page 162) 

 Add explanatory text if necessary (see page 162) 

 Save the Strategy (see page 169) 

 Download the strategy to the controller (see page 181) 

Creating Strategies - Select Site, Communications Controller, and Field Controller 

Select from the Site List the site, Comms Controller and Field Controller 
that is to be programmed. All names given to objects (points, datalogs, 
time schedules etc.) will be saved to this controller in the Cylon 
database. 

  

When you click on the target controller, the site list closes: 

 

Note:  you can open the site list again by selecting Site List from the View menu, or by pressing F5.  
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Creating Strategies - Place the selected module on the drawing area 

When you have selected a module to insert, 

Place the mouse pointer at the part of 
the drawing are where you want to 
place the module. 

 

Click the mouse button. 

For some modules, such as inputs, outputs, or setpoints the module dialog will appear 

 

Complete the dialog, if one appears, and 
click on OK. 

 

The module is now on the drawing area. 

It can now be moved, deleted, copied, or 
linked to other modules. 
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To operate on a module, it must be 
selected, by double clicking …. 

 

..or by dragging a selection box around the 
module symbol (or symbols) 

 

 

 

 

 

 

  



 

 
 

MAN00058US rev 69 © American Auto-Matrix 155 

Once a module has been selected, it can then be: 

moved by using the mouse to drag the module to its new location; 

deleted by pressing the DELETE key on the keyboard; 

cut by pressing Ctrl and X on the keyboard or by choosing Cut from the 
Edit menu or by clicking the Cut button on the toolbar; 

copied by pressing Ctrl and C on the keyboard or by choosing Copy from the 
Edit menu or by clicking the copy button on the toolbar; 

pasted by pressing Ctrl and V on the keyboard or by choosing Paste from the 
Edit menu or by clicking the paste button on the toolbar and then 
clicking the drawing area on the place where you would like to paste 
the module. 

Note:  Pasted hardware point modules may adapt some parameters to the destination point but retain others. For 
example, an analog input configured as PT1000 when pasted to a UniPut will change to a voltage input, but 
retain the max and min limits (in the Advanced button) which for PT1000 could be min 0 and max 0, leading to 
incorrect operation of the UniPut. 

 

Creating Strategies - Place all the required modules on the drawing area 

Place other modules required to implement the strategy on the drawing area by following the procedure outlined in 
Creating Strategies - Place the selected module on the drawing area on page 153. 

 Modules must be positioned from left to right on the drawing area. Hardware inputs must go on the left side of the drawing 
area, hardware outputs on the right. Between the inputs and the outputs, organize the modules so that a signal flows from 
left to right across the strategy. 
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Creating Strategies - Join the modules 

Modules in a strategy must be joined together to allow information to flow from input to output.  

Join the modules together as required, by 
placing the mouse pointer over module 
inputs or outputs…. 

 

  

… and dragging to another modules output or 
input. 

  

The Engineering Centre displays lines 
between linked modules: 

  

If you cannot see a line connecting the two 
modules, click Module Setup from the 
Display menu.  
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This displays the Module Setup dialog box: 

  

 

On the Display Lines and Points tab, make 
sure that the Display Lines check box is 
checked: 

  

 

 

Continue joining modules until all the 
required connections have been made. 
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Automatic point selection 

When two unconnected modules are linked together, the Engineering Centre automatically selects the next available virtual 
point. This is the lowest numbered unused point. This number is entered in the two modules that are linked, as an input and 
an output, and it is also displayed at either end of the connecting line. In the example below, the number of the virtual point 
connecting the two modules is 1 and it is displayed at both ends of the connection: 

  

If you cannot see the point number at either end of a 
connection line, click Module Setup from the Display 
menu.  

  

This displays the Module Setup dialog box: 

  

On the Display Lines and Points tab, make sure the Display 
point numbers check box is checked. 

  

When the output of a module which is already connected is connected to the input of another module, the point number of 
this output will be written in the input. 
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Selecting a connection line 

To select a line connecting two modules, double-click the line with the left mouse button. Selected lines are displayed with 
black squares along the line. Selected lines can then be: 

moved by using the mouse to drag the line to its new location; 

deleted by pressing the Delete key on the keyboard. 

When a connection line is deleted, the point number in the input of the target module will be removed. 

If this connection was the only one for the output of the source module, the point number will be removed from there too. 
The point will now be available for other connections. 

Naming a point 

To give a point a name, click on the input or the output 
of the connected modules with the right mouse 
button. 

  

Enter a name into the Point Name section of the dialog 
box which appears. 

 

Click OK. 

 

 

  

The name can have no more than 24 alphanumeric characters. Spaces, commas and full stops may also be used. Each point 
in a controller must have a point name that is unique in that controller.  
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Assigning a unit to a point 

In the case of Analog points, the Units list box (which is displayed in modules dialog boxes and Points dialog boxes) contains 
a collection of text strings, one of which will be displayed together with the point value. 

To specify a type of unit for a point, click on the line or on the input or the output 
of the connected modules with the right-hand mouse button. 

  

A dialog box appears corresponding to the type of input, e.g. if the point is analog, the Analog point dialog box appears.  

 

Choose from the Units list the type of unit that corresponds to the type of input, e.g. if an analog point represents a 
temperature reading in degrees Celsius, you may choose DegC from the Units list box. The unit of an analog point is a text 
string which will be displayed with the analog value of the point. 

 

 

 

If the point is a digital point,  
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a Digital Point dialog box appears. 

 

Select the required unit in the Open circuit and Closed 
circuit list boxes. The units of a digital point are text 
strings, which are displayed instead of the digital values 0 
or 1. 

 

The list boxes in the Analog Point and Digital Point dialog boxes present different units for selection. If necessary, additional 
application specific units can be entered manually in the WN3000.ini file. For further details on how this is done, see How to 
add units of measurement to the system on page 414.  

Additional units of measurement can also be added if points are defined using the shortcut method(see A short cut to 
defining hardware points on page 105). When the tab (or comma) separated list of point definitions is prepared, units of 
measurement which are not already defined in WN3000.ini can be used. When the definitions are pasted to the Database 
Interface, the new units of measurements will be added automatically to WN3000.ini.  
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Creating Strategies - Set the values of the module's inputs and outputs 

Many modules require the setting of certain values. These appear in the modules’ dialog boxes.  

To view a particular module’s dialog box, click on the module (not on the inputs or outputs) with the right mouse button. 
For example, right-clicking on the Timer with Constant Inputs module produces this dialog box: 

  

Note:  Do not edit or delete a point number using the module dialog boxes. These should be used only for entering 
constant values in list boxes and check boxes. Point Numbers are allocated as explained in Automatic point 
selection on page 158. 

 

Creating Strategies - Add explanatory text if necessary 

Text can be added to the drawing area to label parts of the strategy to  

 explain the purpose of certain modules, or groups of modules, within the strategy,   

 give extra information about globals. 

You can add text or edit text that is already in the strategy drawing. You can also delete, cut or copy text in a strategy. 

 

How To add text to a strategy 

Click the  

  

button on the toolbar, or choose Add Text 
from the Edit menu 
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Click the drawing area at the point where you 
want the text to be displayed. 

  

 

The Insert Text dialog box will be displayed: 

  

 

Type in the Insert Text dialog box, the text that 
you would like to include in the strategy:  

 

 

  

 

To select the type of font in which the text 
should be displayed, click Font.  
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The standard Windows Font dialog box will be 
displayed in which you can choose a font, style, 
point size, etc. Once you have chosen the 
required font, click the OK button in the Font 
dialog box. 

  

 

Note:  It is recommended that you always use "True-type" fonts. When the printing is scaled, non true-type fonts do 
not scale properly. 

Click OK. 

  

 

The text will then be displayed on the drawing 
area on the point at which you clicked the 
mouse. 
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How to change text that has been placed on the drawing area 

Click on the text to be changed with the right 
mouse button.  

  

The Insert Text window appears for entering 
or editing the text 

  

Select the text that is shown in the Insert 
Text window  

  

and type the required text.  

 

 

 

Click OK. 

  

The changes appear immediately on the 
drawing area. 

  

 

 



 

 

166 © American Auto-Matrix MAN00058US rev 69 

M
A

N
0

0
0

5
8

U
S rev 6

9
 

 

How to Select text 

Double-click the text to be selected with the left mouse button. Holding down the Ctrl key while double-clicking with the left 
mouse button allows more than one text string to be selected. 

  

Selected text is displayed with a dotted line around it. 

Selected text can then be edited as follows: 

Move Use the mouse to drag the text to its new location; 

Delete Press the DELETE key on the PC’s keyboard; 

Cut Press Ctrl and X on the keyboard or choose Cut from the Edit menu or 
by clicking the cut button on the toolbar; 

Copy Press Ctrl and C on the keyboard or choose Copy from the Edit menu 
or by clicking the copy button on the toolbar; 

Paste Press Ctrl and V on the keyboard or choose Paste from the Edit menu 
or click the paste button on the toolbar and then click the drawing 
area on the place where you would like to paste the text. 
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How to reorder blocks in a Strategy 

It is possible to change the order of blocks within a Strategy, which can help to optimize the servicing process. 

From the Site List, right-click on the controller and select Strategy Operations > Re-Order Module Blocks 

 

This opens the Reorder Block dialog: 

 

The list shows modules in their “servicing order”.  

Note:  Some modules serviced based on a time schedule, not necessarily according to their ‘service order’. Any 
modules in the list that are in this category will be highlighted. 

Select a module in the list and use the buttons on the right-hand side of the dialog to change its position in the list: 

 

Move the highlighted block to the top of the list (Service number = 1) 

 

Move the highlighted block up one position in the list 

 

Move the highlighted block down one position in the list 

 

Move the highlighted block to the bottom of the list 

 

Highlight the selected block in the Strategy drawing. 

Repeat until the list is in the required order.  
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How to Upload Setpoint Values 

It is possible for all of the controller values for all setpoints in a single Strategy to be retrieved in a single operation. 

From the Site List, right-click on the controller and select Strategy Operations > Upload Setpoints 

 

This opens the Upload Setpoints dialog: 

 

Select the points to be uploaded and click the Update Selected button 
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Saving a strategy 

To save a new strategy, click on the  

  

button on the toolbar, or select Save from the File 
menu 

 

This calls the File Save As dialog box, to 
allow you to specify how the file is to be 
saved. 

 

Type a descriptive file name in the File 
Name box  

It is advisable to use a name which 
indicates the site, the Comms Controller 
number and the Field Controller number. 
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For example, the strategy for the Air Handling Unit controller, which is Field 
Controller number 1 on the rooftop UCC4 (which is Comms Controller 
number 1) on the Office Block site might be named “Office_001-01 
AHU.STG” 

  

Choose the extension _.stg in the Save File 
as Type list box. _.stg is the extension for 
strategies, while _.etm, is the extension for 
macros. (See Macros - Overview on page 
228) 

 

Press Save 

 

The new name appears in the title bar of 
the Saved Strategy 
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How to open an existing strategy: 

To open a saved strategy, press the  

  

button, or select Open from the File menu. 

 

This opens the Open File dialog: 

 

When opening a strategy, select _.stg as the file 
type.  

(The _.etm file type is used for opening macro 
files - see Macros - Overview on page 228) 
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Select the strategy you want to open 

 

And click Open 

 

 

The Engineering Centre will open the strategy in the Engineering Centre window and its name will appear on the title bar. 

  

 

Note:  When a strategy is saved, its target is also saved so that when the strategy is opened the site list will display the 
Communications Controller and Field I/O Controller to which it belongs. 
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Strategy Associations 

What is an "Associated" Strategy?  

Each of the Field Controllers in the Site List can have a Strategy Drawing file 'associated' with it, which means that the 

Engineering Centre is aware of the filename of the strategy corresponding to the Field Controller. When a Field Controller 
is selected, its associated strategy can be opened automatically from the right-click menu. 

 

The icon representing the field controller changes when Strategy File is associated with it. 

Note:   In previous versions of the Cylon Engineering Centre, strategy files had to be named according to strict 
conventions, and when opening a controller's strategy, the file had to be located through a "File Open" dialog. 
This is no longer the case. 

The relationships between controllers and strategy filenames for a particular site are stored in the file 

C:\UnitronUC32\[siteFolderName]\SYSTEM\associations.xml 
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Creating Associations 

New strategies 

When a new Strategy Drawing is created, a target controller must be selected. When that Strategy is saved for the first time, 
it is associated with the selected target controller.   

Existing strategies - manual 

 

A strategy can be associated with a field controller by right-clicking on the Field Controller and selecting "Select". A list of all 
existing strategy files that are eligible to be associated with the selected controller will be displayed. 

Existing Strategies - automatic 

For existing strategies without associations, a menu item on the right-click popup menu on each Site node in the Site List 
provides an option to automatically Create Associations.   

 

Associations will be automatically created for each Field Controller where one and only one Strategy Drawing was found 
that is eligible for that Field Controller. If no eligible file is found for a Field Controller, or if more than one eligible file is 
found, no association will be created for that controller. 

Note:  The Create Association process cannot be run for a site if associations already exist for that site. This generally 
means that the Create Association process can only be run once for each site. 

 However, if you need to scan the site for associations again, you can do so by deleting all of the associations. 
This is done by deleting the file 

 C:\UnitronUC32\[siteFolderName]\SYSTEM\associations.xml 
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Breaking Associations 

Associations can be broken using a toolbar or right-clicked popup menu option; the link between the Site Tree Field 
Controller and the Strategy Drawing is removed.   

 

If an association is broken for an opened Strategy Drawing, then the Strategy Drawing will be closed and the user will be 
prompted to save it if changes have been made. Breaking an Association allows the User to associate a different Strategy 
Drawing to the Field Controller, using a toolbar or right-click popup menu option on the Site Tree Field Controller. 
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Copying associated strategies 

From the Site List, it is possible in a single operation to create a copy of the strategy associated with any Field Controller 
node and associate that copy with another Field Controller node, as long as the target is of a compatible controller type and 
does not already have a strategy associated with it. 

Note: A Strategy cannot be copied if:  

 ●  it contains Globals – The user is informed that the Strategy contains Globals 

 ● it is open and has been modified but not saved (the user is prompted to save the Strategy so that the Strategy 

can be copied). 

To copy a strategy in the Site List interface: 

1. Right-click on the source Field Controller node  

The source Field Controller is the controller to which the existing strategy is associated. 

2. In the pop-up menu, select "Copy Strategy To" 

 

3. In the Copy Strategy dialog that appears, click on the Field Controller to which you want the copied strategy to be 
associated 

 

The Copy Strategy Dialog displays the source Site, Communications Controller and Field Controller node details as well as 
the Strategy that will be copied. 

 

To: 

The To: box contains a "tree" list of potential target Field Controllers, grouped by Site. Potential target Field Controllers are 
those that : 

 are of a Controller Type that is compatible with the source Field Controller Node 
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 do not already have an Associated Strategy 

 do not have a newly created Strategy 

The next available Field controller node is always selected on the source Site. If no Field Controllers are available on the 
source Site then no Field Controller is selected and the Site Tree is shown collapsed (closed). 

File Name 

The filename of the copied strategy cannot be the same as the original filename. In the File Name box, a unique filename 
for the Copied Strategy is automatically generated by appending the suffix _001 to the original filename. This suffix is 
incremented by one each time the strategy is copied.  

Extension 

The file extension can be omitted for the filename and if it is included will be ignored.  

Copy button 

The Copy button is enabled when a Field Controller Node is selected. Once ‘Copy’ is invoked, a new Strategy is created and 
opened with the contents of the source Strategy being copied, including the Database names and Keypad Details. The 
Copied Strategy is then Associated with the Target Field Controller node. 

 

 

Importing a Strategy 

The Copy Strategy To function applies to strategy files that reside in the current Site file structure. It is possible that files 
which were associated with a specific folder have been copied to locations outside the Site folders, and will not be found by 
the Copy Strategy To process. In that case the Import Strategy function may be used.  

To Import a strategy in the Site List interface: 

1. Right-click on the target Field Controller node  

The target Field Controller is the controller to which the Imported strategy will be associated. 

2. In the pop-up menu, select Import Strategy.  

 

The system will scan for suitable strategies for import 

 

And display a list of the results. 
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Note:  It is possible that the list will be blank, because a strategy file will only be listed if: 

  a. It does not reside in the current site. 

  b. It has the correct embedded site, comms controller address and field controller address. 

  c. It is not already associated with any controller. 

 You cannot for example import a strategy from controller no 006 on Comms Controller 5 on a remote site onto 
controller no.005 on Comms Controller 5 on the local site. Neither can you for example import a strategy from 
controller no 006 on Comms Controller 5 on a remote site  onto controller no.006 on Comms Controller 2 on 
the local site. 

 i.e. The file to be imported must have originated on the same controller on the same site. 

3. Select a strategy file and click OK. The strategy will be copied to the current site, and the copy will be associated 
with the selected controller. 
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About UC32 file formats 

The UC32 range of Field Controllers stores strategy information in its own native format, called ".s32". Files created in the 
Cylon Engineering Centre specifically for UC32 controllers are saved on the PC in the same format, with the file extension 
.s32. 

Strategies created for older UCxx Field Controllers are stored on both the PC and in the controller in a different format, 
".stg". The UC32 range can read files in this format in addition to its native .s32 format. 

The Cylon Engineering Centre can open files of either format, and send files of either format to a UC32 controller. The user 
is given the option to convert to .s32 format, but there may be reasons why they might choose not to, for instance to 
preserve the behaviour of globals on an existing site. 

In dealing with .s32 and .stg formats in the Cylon Engineering Centre and the UC32 range of controllers, it is possible for the 
following four situations to arise: 

 

An .s32 format file can be opened in the Cylon Engineering Centre,  

 it can be sent to a UC32 controller in .s32 format,  

 and later it could be uploaded back from the controller in .s32 format. 

 

An .stg format file can be opened in the Cylon Engineering Centre,  

 it can be converted to .s32 format,  

 it can be sent to a UC32 controller in .s32 format,  

 and later be uploaded back from the controller in .s32 format. 

 

 

An .stg format file can be opened in the Cylon Engineering Centre,  

 the user can choose NOT to convert it to .s32 format,  

 it can then be sent to a UC32 controller in .stg format,  

 and later be uploaded back from the controller in .stg format. 

Note: This happens automatically if the .stg file is open in the Cylon Engineering Centre when upload is initiated, and 
that is the only condition under which it happens. In all other cases upload from a UC32 controller is in .s32 
format.]   

An .stg format file can be opened in the Cylon Engineering Centre,  

 the user can choose NOT to convert it to .s32 format, 

 it can be sent it to a UC32 controller in .stg format,  

 and later be uploaded back from the controller in .s32 format - this file conversion takes place in the controller 
itself. 

If conversion is required from .stg to .s32, it can be done in the PC (option 2 above) or in the Controller (option 4 above). 
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How to convert an .stg file to .s32 on the supervisory PC 

If the 'product type' of a controller on a Cylon site is changed so that a UC32 controller replaces an older Field Controller, 
then when the Cylon Engineering Centre tries to open a strategy file for that controller, it will have to open an .stg file, even 
though the target controller is a UC32. 

The required .stg file can be opened, because in the 
Cylon Engineering Centre, when Open is selected 
from the File menu, the user is presented with a 
dialog box that permits either .s32 or .stg files to be 
opened: 

 

And if an .stg file is selected, 

 

the user is presented with a 
choice of converting the format 
of the strategy to .s32 format. 

 

If either Yes or No is selected, the strategy will be opened in the Cylon Engineering Centre and its drawing will be displayed. 
However, if Yes is selected, the file will be maintained in .s32 format from now on. If No is selected, it will remain in .stg 
format. 
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How to convert an .stg file to .s32 on the Controller, when uploading 

Conversion of .stg format strategies to .s32 format happens automatically in the UC32 controller. By default, all uploads 
from UC32 are in .s32 format, so that if a strategy is created from a blank drawing in the Cylon Engineering Centre, with a 
UC32 controller as its target, when upload is initiated the strategy is uploaded in .s32 format.  

However, if an .stg format strategy is sent to a UC32 controller the controller converts it to .s32 strategy automatically 
without interaction from the user. 

 

 

Opening multiple strategies 

The Engineering Centre allows you to have several strategies open at once. Each strategy must be opened individually as 
described above. Each strategy can be minimised, maximised and arranged in a number of ways in relation to the other 
open strategies (see Arranging open files on page 52). 

 

Downloading a strategy 

When you have created a strategy in the Engineering Centre, you must download it to the targeted controller before it will 
function. 

The Engineering Centre provides three different ways in which you can download a strategy to a controller: 

 Using Automatic Download, where the Engineering Centre automatically wipes the controller’s memory and 
sends set-up. You only have to download the strategy. 

 Using Automatic Online Downloading, where the Engineering Centre automatically downloads a module to the 
controller as soon as it is placed on the drawing area. (If the strategy is newly created, you must first wipe the 
controller’s memory, place and join the modules on the drawing area and send the set-up). 

 Downloading manually, where you must wipe the controller’s memory, send the number of blocks to be serviced 
and then download the strategy. 
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Downloading a strategy using Automatic Download 

To download a strategy to the targeted controller using Automatic Download, proceed as follows: 

1. Open the strategy  

2. Specify the controller for which the strategy has been designed  

3. Log in to the controller  

4. Enable Automatic Download  

5. Download the strategy  

Note:  When you download a Strategy to a BACnet controller from the Cylon Engineering Centre, any configuration 
that has been set by a separate B-OWS – e.g. an Alarm Recipients list – will be wiped.  You must re-download 
the Alarm Recipients list, and any other B-OWS specific configuration after the Strategy download is complete. 

 

Automatic Downloading - Open the strategy 

Ensure that the strategy you wish to download is open (see How to open an existing strategy: on page 171). If more than 
one strategy window is open, check that the strategy you wish to download is the active strategy by clicking on it once with 
the left mouse button or by choosing it from the list of open files in the Window menu. 

 

Automatic Downloading - Specify the controller for which the strategy has been designed 

Choose a controller to target from the Site List. This specifies the controller to which the strategy will be downloaded.  

 

Automatic Downloading - Log in to the controller 

Log in to the controller by choosing Login from the File menu or by clicking the login/logout button on the toolbar so that 
the gate is closed:  

  

 

 

 

 

 

 

 

Automatic Downloading - Enable Automatic Download 
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To enable automatic download, choose Communication 
setup from the Communications menu. 

  

This will produce the Options dialog box, which allows you 
to enable Automatic Download by clicking the Automatic 
Download check box in the Download Options tab. 

  

Click OK to close the Options dialog box. 
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Automatic Downloading - Download the strategy 

Download the strategy to the targeted controller either by: 

Download the strategy to the targeted controller by clicking the 

 

button, or by choosing Download from the communications menu:  

 

When you use Automatic Download, the Engineering Centre automatically deletes all previous points and strategies from 
the controller as these could conflict with the strategy being downloaded. It then downloads the strategy and sends the set-
up (i.e. it informs the controller of the number of blocks it must service in the strategy).  

 

 

 

While this is happening, the Downloading window is displayed.  

 

The progress bar at the top of the downloading window shows the progress of the download, while the status box (at the 
bottom of the window) tells which of the three stages in the download process (wiping the memory, downloading the 
strategy or sending the set-up) the Engineering Centre is currently completing.  

The Downloading window also includes a Complete box, which displays the number of the block of the strategy, analog 
point, digital point or global that is currently being downloaded. In the above example, the progress bar shows that the 
download is 79% complete, the complete box tells us that the Engineering Centre is downloading block number 251 of the 
strategy and the status box tells us that the Engineering Centre is busy downloading the strategy to the controller.  
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Downloading a strategy using Automatic Online Downloading 

Automatic Online Downloading is a feature of the Engineering Centre which causes any changes you make to a strategy to 
be sent to the controller as soon as they are made.  

Warning: Automatic Online Download is not recommended for use on live plant equipment, since downloading 
the Strategy in this manner can cause outputs to toggle. 

To use this feature, proceed as follows: 

1. Open the strategy  

2. Specify the controller for which the strategy has been designed  

3. Log in to the controller  

4. Enable Automatic Online Downloading  

5. Edit the strategy  

 

To check that the strategy has been correctly downloaded, you can test the strategy. (See Testing a strategy with Scan 
Mode on page 199) 

 

Tip: 

 If you enable both options (Automatic download and Automatic online downloading) on the Download setup 
tab, the Engineering Centre will automatically wipe the controller’s memory, download the modules as soon as 
they are placed on the drawing area and then automatically send the set-up.  

  

An example of why you would choose both options would be if you wanted to design a basic strategy, download it and then 
download any additional modules or changes you make. In that case, you would enable the first option, i.e. Automatic 
Download, create the basic strategy and download it by clicking the download button on the toolbar. The Engineering 
Centre will send the set-up automatically. Then you would enable the second option on the Download Setup tab, Automatic 
on-line downloading, so that each time you make a change to the original strategy or add another module, the changes are 
downloaded and the set-up is sent automatically. 

 

Automatic Online Downloading - Open the strategy 

Ensure that the Strategy you wish to download is open (see How to open an existing strategy: on page 171). If more than one 
strategy window is open, check that the Strategy you wish to download is the active strategy by clicking on it once with the 
left mouse button or by choosing it from the list of open files in the Window menu. 
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Automatic Online Downloading - Specify the controller  

Choose a controller to target from the Site List. This specifies the controller to which the strategy will be downloaded and 
the location in the database on the PC’s hard disk where the strategy will be stored.  

This is necessary if the target has just been created, or if you want to change the Strategy's target. The target is saved with 
the Strategy, so that under normal conditions when a Strategy is opened it will be properly targeted. 

Note:  If you want to change the Strategy's target to a controller on a different Site, you must change Site using CCView 

or the Configuration program - selecting the controller on the Engineering Centre Site List will not change 
the site. 

Automatic Online Downloading - Enable Automatic Online Downloading 

To enable automatic download, choose Communication 
setup from the Communications menu. 

  

This will produce the Options dialog box, which allows you to 
enable Automatic Download by clicking the Automatic 
online downloading check box in the Download Options tab. 

  

Click OK to close the Options dialog box. 

 

  

Note:  By opening a new Strategy you automatically deselect the Automatic Online Downloading command. Click the 

 button on the toolbar to restore option. 

 

Automatic Online Downloading - Edit the strategy 

Edit the strategy by placing and joining the required modules on the drawing area and editing their values and units. (For 
about adding strategy modules see How to Create a Strategy on page 152)  
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Each time a module is placed on the drawing area, two modules are joined or their values are edited, the Engineering 
Centre will automatically download the information to the controller. The status bar displays the following information to 
show that the modules have been downloaded to the controller: 
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How to download a strategy manually 

 

To download manually, proceed as follows: 

1. Open the strategy to be downloaded  

2. Specify the controller for which the strategy has been designed  

3. Disable Automatic download and Automatic online downloading  

4. Wipe the controller's memory  

5. Edit the strategy  

6. Download the strategy  

7. Send the set-up  

To check that the strategy has been correctly downloaded, you can test the strategy. (See Testing a strategy with Scan 
Mode on page 199 ) 

Manual Downloading - Open the strategy to be downloaded 

Ensure that the strategy you wish to download is open  (see How to open an existing strategy: on page 171). If more than 
one strategy window is open, check that the strategy you wish to download is active by clicking on it once with the left 
mouse button or by choosing it from the list of open files in the Window menu. 

Manual Downloading - Specify the controller for which the strategy has been designed 

Choose a controller to target from the Site List. This specifies the controller to which the strategy will be downloaded and 
the location in the database on the PC’s hard disk where the strategy will be stored.  

This is necessary if the target has just been created, or if you want to change the strategy's target. The target is saved with 
the strategy, so that under normal conditions when a strategy is opened it will be properly targeted. 

Note:  If you want to change the Strategy's target to a controller on a different site, you must change site using CCView 
or the UCC4 configuration program - selecting the controller on the Engineering Centre Site List will not change 
the site. 
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Manual Downloading - Disable Automatic download and Automatic online downloading 

Click Communication Setup from the Communications 
menu. 

 

On the Download Setup tab, ensure the Automatic 
Download and Automatic online downloading options are 
disabled: 

 

Click OK to close the options dialog box. 
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 Manual Downloading - Wipe the controller's memory 

Wipe the controller’s memory by choosing Wipe UC Memory from the UC menu or Wipe Controller from the UC32 menu.  

This will produce the Wipe UC Memory dialog box 

  

The Wipe UC Memory dialog box features two options: 

 Wipe UC memory – this option removes all previously downloaded points and strategies from the controller. You 
should choose this option as existing points and strategies could conflict with the strategy you are about to 
download. 

 Wipe Keypad Strategy – this option will erase any keypad strategies from the controller’s memory which may 
have been programmed into the controller. This option will not be relevant if the controller to which you are 
downloading does not feature a keypad. If it is a keypad controller, however, and you think that the keypad 
strategy may conflict with the strategy that you are about to download, then choose this option in addition to the 
first. 

Click Wipe to close the Wipe UC Memory box. 

  

The Engineering Centre will display this message to confirm that the 
controller’s memory has been wiped: 

 

 Click OK to close the message box. 
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How to check the controller type to which you are downloading 

To find the type of the controller to which you are downloading, 
log out from the controller, and click the Managers command from 
the View menu. 

 

 

This will produce the Managers dialog box, 
which displays information relating to the 
controller. 

 

Click the Controller tab.  

In the example shown, the Controller type box 
shows that the controller which has been 
selected as a target is a UC32.24 controller. 
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Manual Downloading - Edit the strategy 

Edit the strategy by placing and joining the required modules on the drawing area and editing their values and units. (For 
details of how to create a strategy see How to Create a Strategy on page 152)  

Manual Downloading - Download the strategy 

When you have completed the strategy, you must then download it. 

Log in to the controller by choosing Login from the File menu or by clicking the login/logout button on the toolbar so that 
the gate is closed:  

  

Click on the  

  

Button in the toolbar, or choose Download from the 
Communications menu 

  

This produces the Select Items to Download dialog box. The dialog that will be displayed depends on whether a UC32 or 
UC/UCU controller is targeted. 

UC32 Select Items to Download dialog: 

 
 

UC Select Items to Download dialog: 
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You can choose to download the whole strategy, by checking the checkbox 
to the left of “Strategy Blocks”. The maximum number of blocks a strategy 
can contain is 192, 255 or 1024 depending on the controller type and, by 
default, the Engineering Centre will download this many blocks, but if you 
want to download only certain blocks, click the Strategy ... button. 

 

In the Download Strategy Blocks dialog box, click on the Selected radio 
button… 

 

… and choose the range of blocks you wish to download. (For an explanation 
of blocks, see What are blocks? on page 96)  

 

 

Enter in the Download Strategy Blocks box the range of strategy blocks you 
wish to download and click OK. 

 

Click OK again to close the Select Items to Download dialog box. 
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The Downloading window will appear, to display the progress of the download.  

 

When the Engineering Centre has downloaded all the blocks that you specified, it will automatically close. 

 

Manual Downloading - Send the set-up 

Send the set-up, i.e. the number of blocks the controller must service in the strategy.  

Set-up is sent by clicking UC Setup from the UC menu. 

  

The UC Setup dialog box appears in which you must specify the number 
of blocks occupied in the strategy. (For guidelines on how to complete 
the UC setup box, see How to start a strategy (send set-up) on page 
197). 
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When the dialog is filled correctly, press send: 

 

The message Setup sent successfully is displayed if the Engineering 
Centre completed sending the set-up. 

  

If the message Attention! Error sending setup is displayed, the 
Engineering Centre has failed to send the set-up to the controller. 

  

In that case, the error is most likely a communications failure – check that the controller is connected to the 
Comms Controller on its Fieldbus and that the Comms Controller is properly connected to the Ethernet or ARCnet 
network. If these connections are all secure, check that your PC is connected to the Cylon network via RS232 cable 
or Ethernet. 

Click Close to close the UC Setup dialog box. The controller should now 
be servicing the strategy. 
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Starting a strategy 

Set-up is sent to a Field Controller when its memory has been wiped and the strategy has been downloaded to it. Sending set-
up tells the UC how many blocks are to be serviced. Sending set-up is also referred to as starting the strategy. If you are 
using Automatic download, the Engineering Centre sends the set-up automatically when you download a strategy to the 
controller. (See Downloading a strategy using Automatic Download on page 182) Otherwise, you must send the set-up as 
described below. 
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How to start a strategy (send set-up) 

When logged in, select Setup from the UC or UC32 
menu.  

  

The UC Setup or UC32 Setup dialog box will appear: 

UC32 Setup dialog: 

 

UC Setup dialog: 

 

 

Notes on completing the UC Setup dialog box: 

The number in the Number of blocks to service box, x (which is automatically entered by the Engineering Centre but can be 
changed by the user), activates the first x blocks of the strategy in the UC.  

It is important to enter a number in the Number of Blocks to service box which is greater than or equal to the number of the 
highest numbered block occupied by a part of the strategy. Otherwise, the parts of the strategy which occupy blocks with a 
higher number than the number entered in the Number of blocks to service box will not be serviced, and their point values 
will not be updated. This may cause the strategy to fail. 
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If you cannot see how many blocks you have used in the strategy, click Managers from the View menu. This lists all of the 
blocks in the targeted controller. The highest number on the strategy should be the number of blocks the controller must 
service. 

The Composed section automatically contains the current PC time and date. If the strategy is uploaded later, this time and 
date will indicate when the strategy was started.  

In the User ID section the application engineer can enter a unique identifying character. If the strategy is uploaded later, this 
character will indicate who started the strategy. In the User Name field the engineer can enter the name of the person that 
started the strategy and this can be retrieved from the controller if the strategy is uploaded. A string of up to sixteen 
characters can be entered in this field. 

In the Drawing Name field the name of a CCDraw drawing can be entered. It is recommended that the name of the drawing 
containing information relevant to the strategy is stored here. If the setup is uploaded from the controller the drawing 
name will be displayed in this field. 

The effects of sending set-up 

Sending set-up to a controller has the following effects: 

 All blocks entered in the Number of blocks to service section will be serviced, even if they are not occupied by 
modules. For example, if you entered 100 as the number of modules to be serviced, the first 100 blocks will be 
serviced by the controller. 

 A controller which is sent a set-up with blocks to be serviced, but without any strategy, will not send any output 
signals and will not read any input signals. 

Note:  If a strategy is downloaded after set-up is sent, the strategy is serviced immediately. This means the outputs will 
receive values from the strategy immediately after downloading. It is preferable to download the strategy 
before sending set-up, since untested strategies can cause problems in devices connected to the outputs if the 
output values are unstable or incorrect. 

 Output points of modules which occupy serviced blocks take their values from the module. 

 If the controller is running without a network (stand-alone), the green LED is constantly illuminated. 

 If the controller is running on a fieldbus (connected to a Comms Controller), the green LED flashes with regular 
pulses. 

 An alarm appears on the monitor of the connected PC if the alarm feature is active. 

 The keypad program, if one exists and has been downloaded to the controller, will be started. 

 Target points of globals will be updated by the Comms Controller, if the globals are configured correctly. 
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Testing a strategy with Scan Mode 

It is important to test a strategy at various stages in its creation, to check for mistakes or faults in its design. This is done by 
using Scan mode. 

Preparing to test a strategy 

To test a strategy the following conditions must be satisfied: 

 The strategy must be open (see How to open an existing strategy: on page 171). 

 The strategy must have been sent to the controller (See Downloading a strategy on page 181). 

Note:  Make sure that the downloaded strategy and the open strategy are the same. 

 The strategy must have been started (see Starting a strategy on page 196).  

 

 

How to test a strategy 

In Scan mode, the Engineering Centre allows you to view the changes in values in a strategy as the strategy is serviced in the 
controller. This is useful for testing strategies and parts of strategies for correct operation. In Scan mode, the point values of 
an uploaded strategy are read by the Engineering Centre, displayed next to their respective inputs/outputs and updated in 
real time.  

To activate scan mode: 

 Log in to the controller (as described on page  103) 

 Upload (page 205) or Open (page 171) the strategy 

 Display the strategy's point and constant values (page 199) 

 Set the Scan mode (page 201) 

 Activate scan mode (page 202) 

 

In scan mode, the variable point values of a strategy are updated in real time as they are serviced by the strategy and 
displayed clearly in the module symbols on the drawing area. In the Rescale to 0 or 100 module of the example above, the 
values of the 3 input points were changed to 10, 20 and 149.86 and its output was changed to 100 as they were serviced by 
the strategy. 

 Watch the changing values of the modules in scan mode to ensure they are being serviced correctly by the 
controller. 

 

 

 

How to Display the strategy's point and constant values 

Display the point and constant values of the strategy 
by clicking Module Setup from the Display menu. 
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The Module setup dialog appears 

  

Click on the Screen text tab 

  

Click on Display Point Values  
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If you try to activate scan mode without having these options enabled, the Engineering Centre will prompt you to enable 
them with this message: 

 

 

 

 

Setting the Scan mode 

The Engineering Centre can scan the current active strategy or all of the currently open strategies. 

Select Communications Setup from the Communications 
menu.  

  

The Communications Setup dialog will appear. 
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Open the Scan Options tabbed page. 

 

Select the appropriate scan option and then click the OK 
button to save the setting. 

 

Activate scan mode 

Begin scanning by clicking Scan from the Communications menu. 

  

The Engineering Centre Window will change to the Engineering Centre scan mode window, which has two menu options, 
Stop Scan and Window: 

  

 The Window menu option allows you to arrange any open strategies diagonally (click Cascade), horizontally (click 
Tile Horizontal), or vertically (click Tile Vertical). It also lists all open strategies. To switch to one of the listed 
strategies, simply click on it from the list in the Window menu. 

 To deactivate scan mode, i.e. to stop scanning the point values of the strategy, click Stop Scan. 
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Suggestions for testing strategies 
 If a number of modules are selected in the strategy when Scan mode is activated, then only those modules will be 

scanned. 

 The module to be tested must have been downloaded to the controller. That is, the Block number of the module 
must be within the range of modules which were downloaded to the controller (see Downloading a strategy on 
page 181) 

 A strategy should be tested in small steps during the creation process. Simple faults such as selecting the wrong 
module or joining to the wrong inputs and outputs can be difficult to correct in a finished strategy. There is also 
the danger that faults can result in other faults appearing in different parts of the strategy or in other controllers. 

 At the end of the creation of a strategy, the whole strategy should be tested again. This prevents later problems 
and time losses during the setting-up process in site. 

 The strategy should be checked module by module from left to right, starting with the hardware inputs and 
finishing with the hardware outputs. 

 Individual strategy parts can be functioning correctly themselves but cause problems when connected to other 
correctly functioning strategy parts. For example, the direction of analog values may fall in the range 0% to 100 % 
or in the range 100% to 0%. Digital values and their inversion may also cause confusion. 

 Test a strategy before copying it or using it in another controller. Otherwise, all copies of the strategy will also 
have to be tested. 

 Manually overriding hardware points allows simulation of each environmental situation to which the strategy 
would be exposed. 

 To simplify the testing process, globals used in the operation of the strategy should be disabled. Do this by logging 
in, selecting Setup from the UC32.net or UCC4 menu and, in the Network Details section, setting the number of 
globals to zero. The points controlled by globals can be changed for testing purposes. 
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Uploading a strategy 

If a strategy is recreated from an old version, it is very important to ensure that the recreated strategy is compatible with 
other parts of its application (globals, dynamic drawings, keypads, alarm strings, time schedules, etc.).  

When a strategy is uploaded to the PC from a controller, the uploaded modules are displayed on the drawing area.  

Uploaded modules do not have the same positions on the drawing area as they had before they were originally 
downloaded, and they are no longer joined. For example, if the strategy looked like this when you downloaded it: 

   

 

 

 

 

 

it might look like this when uploaded: 
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How to upload a strategy 

To upload a strategy, follow these steps: 

1. Log In to the controller 

2. Create a new strategy 

3. Upload the strategy 

4. Save the strategy: 

The uploaded strategy should be saved under a special file name. Choose Save As… from the File menu and in the File save 
as dialog box specify a drive, directory and name under which the strategy is to be saved.  

Uploading a Strategy - Log in to the controller 

Log in to the controller by choosing Login from the File menu or by clicking the Login/Logout button on the toolbar so that 

the gate is closed:  . 

 

Uploading a Strategy - Create a new strategy file 

The Engineering Centre requires an empty strategy to be open in order to display the uploaded modules. 

Create a new file by clicking the 

  

Button on the toolbar, or by selecting New from the File menu. 
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Uploading a Strategy - Upload 

Select Upload from the Communications menu or click the Upload 
button on the toolbar. 

 

When you have clicked Upload on the Communications menu, the 
Engineering Centre displays the Select Items to Upload dialog box.  

Use this box to specify which items, strategy blocks, analog or digital 
points and local or wide globals you wish to upload.  

 

To upload every part of the strategy, including possibly analog and 
digital points and globals, choose the first option – Strategy blocks: 

 

It is important to upload all the blocks in which the strategy is contained. Usually, the serviced blocks are uploaded. To 
check how many blocks are serviced in the controller, select the Setup option from the UC or UC32 menu. A guaranteed 
method of ensuring that the complete strategy is uploaded is to upload all of the blocks in the controller.  

The number of blocks that a controller is capable of holding in a strategy varies depending on the type of controller. For 
instance, a UC32 can have 1024 blocks, a UC24PG-R controller can have 255 blocks, whereas a UCU8 controller can only 
hold 190. 

You can determine the number of blocks that a particular controller can hold using the Managers dialog box, available from 
the view menu. 
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Click the Strategy… button to specify the range of blocks you want to 
upload.  

 

This will produce the Upload strategy blocks dialog box,  

 

Click the Selected radio button to enter the range of blocks to be 
uploaded. In the example shown, 1-255 has been entered as the range 
of blocks to be uploaded: 

 

Click OK to close the Upload strategy blocks box 

 

and click OK again to close the Select items to Upload box. 
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The Engineering Centre will then upload the 
requested blocks and as this is happening the 
Uploading window will be displayed. The 
Uploading window, like the Downloading 
window, shows the progress of the upload. 

 

When the Engineering Centre has finished 
uploading the strategy, it will display the message 
Upload complete in the System Status section of 
the Uploading window. In the following example, 
the Engineering Centre has finished uploading 
the strategy, which contained 255 strategy 
blocks: 

 

Click Close to close the Uploading window. 
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Securing UC32 data 

Unlike other BMS controllers, in the UC32 Strategy information can be secured against accidental loss or unauthorised 
modification by password-protecting the ability to view or edit strategy information and system information. 

The use of this feature ensures that it is difficult for information to be modified in error. 

 

 

How to password-protect UC32 information 

Specified blocks of UC32 strategy information can be protected 
against unauthorised viewing or editing by selecting 'Strategy 
Lock/Unlock' from the UC32 menu. 

 

This opens the 'Lock/Unlock' dialog. 

Access to the protected strategy blocks will be governed by a 
numerical password, which is set during the locking process. 

 

Enter a password (numbers only)  

 

And press the Lock button. 

 

The Lock Blocks dialog opens. 

 

Specify the start and end of the range of blocks that will be 
protected. 
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And click on OK. 

 

When the lock command has been received by the controller it 
returns a confirmation signal. 

 

All of the strategy blocks within the specified range are now locked, and cannot be accessed until they are unlocked using 
the password set above. 

How to access locked strategy blocks 

If a range of strategy blocks in a UC32 controller have been locked, it is only possible to access, view, and edit them by first 
unlocking them, using the password set during the locking process (see How to password-protect UC32 information on page 
209). 

To remove password protection from a locked range 
of strategy blocks, select 'Strategy Lock/Unlock' 
from the UC32 menu. 

 

Enter the required password (set during the locking 
process). 

 

And click on Unlock. 

 

When the blocks are successfully unlocked in the 
controller, a message is displayed in the Lock/Unlock 
dialog: 

 

The strategy blocks are now unprotected, and can be accessed from the Cylon Engineering Centre as normal. 
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How to  expose Points on a BACnet system 

When the Strategy for a controller that is part of a BACnet Site has been configured, the points within the controller that are 
to be available to the BACnet system must be specified by selecting “Configure BACnet Points…” from the UC32 or UC menu 
in the Cylon Engineering Centre 

The “Configure BACnet Points” dialog opens, listing all of the points used in the Strategy: 

  

Tick the checkbox beside each of the points that are to be exposed, then click on OK. 

Note: In BACnet, the point name must be unique. In the Cylon BACnet system they may not be unique, so some 
duplicate names may appear in the list. If this is the case, click the Resolve Duplicate Point Names… button. 

 This opens the Resolve Duplicate Point Names dialog, where names can be changed. 
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How to View BACnet points from A Controller 

You can view BACnet points from a Controller by selecting View BACnet Points From Controller from the Field Controller 
menu (UC32 or UCU) 

This opens the Controller BACnet Points dialog. The points are automatically uploaded so that they can be viewed, and the 
dialog shows the progress of the upload and the points that have been uploaded: 

 

 



 
 

 

SECTION 7 :  NAMING OBJECTS 
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 Why objects are named 

Objects in the Cylon system, such as controllers, points, time schedules, datalogs, etc. are given names to make them more 
identifiable. For example, it is easier to recognize a datalog named “Water Supply Temperature” than one named 
“datalog_1”, which is the default name of the first datalog used inside a controller, automatically given by the database. 

 

Rules for naming objects 

When naming an object in the system, the following rules should be remembered: 

 Names inside a controller must be unique. 

 Names can have a maximum of 24 characters. 

 All alphanumeric characters are permitted, except commas. 

 

Changing names 

When changing the name of an object, the following points must be considered: 

 Other Cylon software modules, like CCDraw, CCView, Datalogs, Keypad Compiler use the names of objects as 
references to those objects. The changing of names can cause problems in these applications. For example, 
CCView would be unable to find a point, if its name was changed since the graphic was first designed. 

 If the name of an object in a controller is changed to a name that already exists in that controller, the name of the 
original object will be deleted. 

 

Procedures for naming objects 

The following list contains some of the objects in the system that can be named: 

 Sites  

 Field Controllers and Comms Controllers  

 Points (both hardware points and virtual points) 

 Two function modules: datalog and UC time schedule  

 Comms Controller time schedules  

 

Naming sites 

To name sites you should use the Command Centre Configuration module. For further details on how to name controllers, 
please consult MAN-0041 Configuration manual. 

Naming Field Controllers and Comms Controllers 

Use the Command Centre Configuration module. For further details on how to name controllers, please consult MAN-0041 
Configuration manual. 
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Naming Points 

Types of point 

There are three main types of point in the Cylon system: 

 A hardware point is an input or output of a Field Controller. 

 A virtual point is used to save internal information for a controller. 

 A set point is a type of virtual point, but its value is constant, whereas the value of a virtual point is determined by 
the strategy. 

Hardware points, virtual points and set points can be either analog or digital.  

How to name points 

Only hardware and set points can be named in the Engineering Centre. Virtual points are identified by their block numbers. 
The procedure for naming or changing the name of a set point is the same as that for a hardware point. A brief summary of 
the procedure is presented below. (For a more detailed description of how to name a point, see Defining hardware points 
on page 101) 

 Open the strategy. 

 Right-click on the symbol of the point on the drawing area that is to be named or have its name changed. This will 
produce the module dialog box. It is important to click on the body of the symbol, and not on the joined input or 
output of the symbol. 

 Enter the name in the Point Name section of the module dialog box or edit the name that appears there already. 

 Click OK to close the dialog box. The point’s new name will appear as text directly over the point’s symbol on the 
drawing area. 

 Choose Save from the File menu to save the changes made to the strategy. 

The Unitron Command Centre's Database Interface module can be used to enter/edit/delete names of hardware points 
non-graphically. 

Virtual points which are placed in a strategy as digital set points or analog set points, are points which are controlled from 
outside the UC. The name of such a virtual point should indicate how its value is passed to it. The following table illustrates 
this: 

Setpoint name  How set point value is controlled 

Outair Temperature_LG Controlled by local global 

Room Temperature_WG Controlled by wide global 

Set point_KP Can be changed via keypad 

Gain Factor_PC Can be changed via PC (CCVIEW) 
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Naming UC time schedules 

UC time schedules are saved and serviced just like modules in a controller. Naming UC time schedules makes it easy to 
locate them for editing, either using the PC, CCView or a keypad. 

How to name a UC time schedule 

The procedure for naming or changing the name of a UC time schedule is defined below: 

Open the strategy that contains the UC time schedule. 

  

Right-click on the symbol of the time schedule that is to be named (or to have its name changed).  

  

It is important to click on the body of the symbol, and not on the joined input or output of the symbol. 



 

 
 

MAN00058US rev 69 © American Auto-Matrix 217 

This produces the Time Schedule 
dialog box. 

 

In the Name section of the dialog 
box, enter the name or edit the name 
that appears there already. 

 

It is a good idea when naming the schedule, to give an indication of the module’s function. For example, if the 
module is a time schedule for the heating system of the site, and is set for Monday to Friday only, the module might 
be named “Heating Schedule (Mon to Fri)”, as shown above. 

Click OK to close the dialog box. 
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 Note:  The name of the UC time schedule is not displayed in the drawing area: 

  

 

Choose Save from the File menu to save the changes 
made to the strategy. 
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Naming datalogs 

Datalogs are saved and serviced just like modules in a controller.  

The contents of a Datalog can be viewed and analysed using the Unitron Command Centre's Datalog Manager module. 

So that they can easily be identified by the Datalog Manager, they are automatically given the same name as the point that 
they are logging. They are given this name when the point is connected to the datalog. 

Datalogs can be linked with push buttons in CCView for quick and easy access. In the Reports program they can be 
configured, to be archived. 

How to name a datalog 

Datalogs are automatically named as soon as they are connected to a point: 

Open the strategy that contains the datalog. 

 

Join the datalog to a point by clicking on the point to be logged, and dragging to the Datalog’s input: 

 

The name of the Datalog is changed to the name of the point, and displayed above the Datalog module in the strategy.  
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 If you want to modify the name that is automatically given, you can edit it as follows: 

Right-click on the symbol of the datalog that is to be named or have its name changed.  

It is important to click on the body of the symbol, and not on the joined input or output of the symbol. 

  

 

This will produce the Datalog Definition 
dialog box. 
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In the Datalog Name section of the dialog 
box, edit the name that appears there 
already. 

 

It is a good idea to give an indication in the name of what part of the site the datalog belongs to, but it is not necessary to 
indicate in the name that the module is a datalog, as it will only appear in list boxes allowing the selection of a datalog. The 
above example shows a Datalog Definition dialog box, where the datalog name indicates that it is a temperature datalog for 
air input to and Air Handling Unit.  

Names given to speed up the copying of strategies (for example, “Temp. Channel 1”, “Temp. Channel 2”, “Temp. Channel 
3”, ...), and which save time for creating dynamic graphics, are not helpful for the end user. 

 

Click OK to close the dialog box. 

 

 

The Datalog name is displayed above the module in the drawing area. 
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Choose Save from the File menu to save the changes made to 
the strategy. 
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Naming Comms Controller time schedules 

Comms Controller time schedules are saved and serviced just like modules in a controller. They are shared via globals with 
other Field Controllers. Naming Comms Controller time schedules makes it easy for the end user to locate them for editing, 
using either the Supervisory PC, the CCView program, or a keypad. 

How to name a Comms Controller time schedule 

Open the strategy of the controller to which the values of the Comms Controller time schedule will be passed. (If the values 
are to be broadcast to all the controllers on the Fieldbus, open any one of the strategies – all procedures performed here 
will apply to all controllers). 

  

Call the globals bar by clicking on the  

  

button in the toolbar, or by selecting Globals from the 
view menu 

  

If the global is to pass a value to all controllers on its Fieldbus, choose the local time schedule global button from the 
globals bar.  

  

If it is to pass a value to all controllers on the ARCnet network, choose the wide time schedule global button from the 
globals bar. 

  

Click the drawing area of the open strategy window to place the time schedule global symbol on the drawing area.  
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This calls the Local Time Schedule dialog box, if you 
chose a local time schedule global (or the Wide Time 
Schedule dialog box, if you chose a wide time schedule 
global). 

 

In the Name box under Schedule Details enter a name for the time schedule global or edit the name that exists there 
already. 

It is not necessary to indicate within the name that the object to which it refers is a time schedule, since only time schedules 
will be displayed in list boxes from which a time schedule must be selected. 
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Complete the Local or Wide Time Schedule dialog box as 
outlined in Using Time Schedule globals in strategies on 
page 330. 

 

When the dialog box is complete, click to close the dialog 
box. 

 

The Schedule and its name are inserted on the Strategy drawing: 
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Join the schedule to other modules as required. 

  

Finally, click Save from the File menu to save the changes 
that were made to the strategy. 

 
 



 
 

 

SECTION 8 :  USING MACROS 
  



 

 

228 © American Auto-Matrix MAN00058US rev 69 

M
A

N
0

0
0

5
8

U
S rev 6

9
 

Macros - Overview 

If your work in the Engineering Centre involves creating the same or similar strategies repeatedly, you’ll find Macros useful 
for reducing the time involved in these tasks. A Macro is a set of strategy modules grouped together into a single unit.  

Macros and Macro Templates 

A Macro Template is used to create a macro within a strategy. It is a definition of module types and connections, and when it 
is inserted into a strategy a new Macro is created containing new instances of those module types connected together to 
match the Macro Template.  

Each time a Macro Template is inserted into a strategy, a new Macro is created.  

Each Macro is an instance of a Macro Template, but a strategy can contain multiple Macros that are based on a single Macro 
Template. 

Macro Templates can be stored, and copied between strategies and controllers. 

Each Macro can be configured and adjusted independently of the Macro Template used to create it. 

When a Macro Template is saved, it is assigned to a floating toolbar, so that it is as convenient to use as any Engineering 

Centre module. 

Example: An “Adder” macro. 

 An Adder/Scaler module accepts four inputs A, B, C and D, and operates according to the equation  

  Output = A*C + B*D   

 It can be made into an Adder, which operates according to the equation  

  Output = C + D  

 by ensuring that its A and B inputs are always set to 1. This can be done by connecting a Real Constant module 

to the A and B inputs as shown below.  

  

This combination of modules can be saved as a Macro Template and reused whenever an adder is required. 
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Macro structure 

Macro Templates are stored in the Engineering Centre in groups and sub-groups. A maximum of 10 Macro groups can be 
created. Each Macro group can contain 20 sub-groups and each sub-group can contain up to 100 Macro Templates. In total, 20 

000 Macro Templates can be created and stored in the Engineering Centre.  

For example, you may want to store all Macro Templates relating to heat control strategies in a group called Heat. This group 
may contain a sub-group called Boiler, which would contain Macros for boiler control strategies, such as Optimizer, Heating 
Curve, etc. 

 

Macro Description Files 

A Macro Description File is a file generated by the person who created the Macro Template, and is associated with the Macro 
Template (it is opened by right-clicking on the Macro button). It is normally used to describe the function and usage of the 
Macro Template. 

When a user right-clicks on a Macro button on the floating Macro bar the Engineering Centre opens the editable 

description file associated with that specific Macro Template. If none exists, the Engineering Centre opens a blank text file, 
which when saved will be associated with that Macro Template. This file can be used to provide documentation about how 
the Macro should be used or to record history, author or changelog details for the Macro Template. 

The program used by the Engineering Centre to open the history file, e.g., MS Wordpad, must be specified in the 
wn3000.ini file under UC16et. 
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How to Create a Macro Template 

There are a number of steps involved in creating a Macro Template: 

1. Create the strategy. 

2. Add modules to the Macro Template. 

3. Select the inputs and outputs for the Macro Template, and change their names if required. 

4. Set names for each of the points within the Macro Template if required. 

5. Choose a Macro group and sub-group, and give the Macro Template a name. 

6. Choose whether to insert the Macro Template into the active strategy as a Macro. 

7. Save the Macro Template. 

The following guide to creating a Macro uses as an example a typical strategy that you might want to save as a Macro – a 
“weather compensator” strategy. As an exercise in creating Macros, you may want to follow this guide, using the weather 
compensator as an example. 

Create the strategy 

Create the strategy or part of a strategy on which you are basing your Macro Template. (If you are forming your Macro Template 
from an existing strategy, then open that existing strategy).  

Example – Weather Compensator macro 

 For example, if you were to create a Macro Template from a weather compensator strategy, you would place two 
Real Constant modules and two Rescale to 0-100 modules on the drawing area and join them as shown below: 

 The third input of the first Rescale module (Rescale to 0-100) is to be the input of the Macro. It is marked 
Outside Air Temperature in the diagram below. 

 The output of the 2
nd

 Rescale module (Rescale from 0-100) is to be the output of the Macro. It is marked Flow 
Temperature Setpoint in the diagram below. 
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Select the modules for the macro 

The next stage in creating a Macro is to select on the drawing area the modules and any text that you want to be included in 
the Macro. Selected modules are marked by red squares around their edges. 

To select the modules for the Macro, you can drag the mouse from the top left-hand corner to the bottom right-hand corner 
of the strategy to draw a box around the entire strategy so that each module and its inputs and outputs is selected. It is not 
a problem if, when drawing the box, you included some unwanted modules – they can be easily removed at the next stage. 
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Add the selected modules to the Macro Template 

Click   on the toolbar, or select Create from the Macro menu.   

This will open the Add Modules to Macro dialog box, in which all of the modules that you selected for the Macro Template 
will be listed. 

 

Note: A Macro cannot include hardware points, so if any were included in the selection they will not be listed in the 
Add Modules to Macro dialog. 

 

Note:  If you click the macro button or macro menu without first selecting the modules for the macro, you will be 
prompted to do so with the following error message:  

   

Select the modules in the left list box that you want to include in the Macro by holding down the [Ctrl] key and clicking each 
one with the left mouse button. The selected modules will be highlighted. 

 

Note: For illustration, only the functional modules have been selected in this example. It is also possible to include 
text in a Macro Template for clarity. 

Add the selected modules to the Macro Template using the following buttons: 
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Add a selected module or several selected modules to the Macro Template 

  
Add all modules to the Macro Template 

  
Remove a selected module or several selected modules from the Macro Template 

  
Remove all modules to the Macro Template 

This Add Modules to Macro list box displays all the modules that have been added to the Macro Template. If you add a 
module or modules that you later decide you do not want, you can remove that module or modules from the Macro Template 
using the remove buttons (see above). 

 

In this example, all 4 modules of the weather compensator strategy are required for the Macro Template and so they are 
added to the list box on the right. The text has been excluded in this case, but could be included for extra information. 

Click Continue… when you have added the required modules to the Macro Template. 
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Define the Macro Inputs, Outputs, Group and Name (the Create Macro dialog box) 

Pressing Continue in the Add Modules to Macro dialog will open the Create Macro dialog box: 

 

The Create Macro dialog shows the four modules that were added in the Add Modules to Macro box, and allows you to 
edit input and output names, create Macro groups and sub-groups and create a history file to record any changes that may 
be made to the Macro Template later.  
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Define the inputs and outputs for the macro 

This step refers to the Weather Compensator example (see page 230). 

When you click on a module output, or an unconnected module input in the drawing area of the Create Macro dialog, it is 
highlighted on the drawing area, and added to the relevant Macro Inputs or Macro Outputs list at the bottom of the dialog. 

      

Note:  If you click on a connected input, an error message will be displayed: “Cannot select a module input that is 
already connected to a line.” 

 

Note:  The number beside each module input is the Node number, and does not relate to the module number.  

 

Note:  The default name for node 3 in the illustration is “Inpu”, but this can be edited - see Change input or output 
label if necessary on page 236. 

To remove an input or output that has been added to the Macro Template, click on it in the drawing area. The input/output 
will then no longer be highlighted in the drawing area, and it will be removed from the relevant Macro Inputs or Macro 
Outputs list. 

You can rearrange the order of the inputs or outputs to the Macro, by double-clicking on an entry in the relevant Macro 
Inputs or Macro Outputs list, and dragging it up or down within the list. 
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Change input or output label if necessary 

By default, the text that will be displayed on the Macro module as a label for each input will be “Inpu” and for each output 
will be  “Outp”: 

 

 but these names can easily be edited. 

To edit a Macro input or output name, select the 
input/output in the relevant list box 

 

Type a new name in the relevant Name edit box, 
and click Change. 

 

An input or output label can have no more than 4 
alphanumeric characters. 
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Name and group the Macro 

In order to use a Macro Template that you have created, you must give the Macro Template a name, and assign it to a Macro 
group so that it can be accessed from the Macro bar. 

 Macro Name 

In the Macro Name box, enter a name for the Macro Template.  

The name provided here will appear on the Macro instance when it is displayed on the drawing area. It can have no more 
than 10 alphanumeric characters.  

In this example, the name given to the Macro Template is 
“WeatherCom”. 

 

Note: The following names cannot be used when naming a macro, because they are used to indicate Inputs, Outputs, 
constants etc. internally within the Engineering Centre: 

          pi (n)  where n = a numeric value in the range 0-9 

         po (n)  where n = a numeric value in the range 0-9 

          sb     

        c (n)  where n = a numeric value in the range 0-9 

          bc     

When the Macro Template is named, choose a Macro group and sub-group for it 

 Macro Group and Sub-Group 

From the Group box, select the group to which the Macro 
you are creating will belong.  

The Macro Group chosen for this example is heating. 

If no Macro Group exists, you must create a new group (see 
How to create a new macro group and sub-group on page 
240 ) 

 
 

From the Sub Groups box, select the sub-group to which 
the Macro Template you are creating will belong.  

The sub-group chosen for this example is Boiler. 

If no sub-group exists, you must  (see How to create a new 
macro group and sub-group on page 240 ) 
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Set names for all of the points in the Macro 

When creating a Macro Template, there is a facility to edit 
the names of all of the points in the Macro in a single 
interface. An Edit Point Config button is available on the 
Create Macro dialog: 

 

Clicking the Edit Point Names button opens the Macro 
Point Configuration dialog: 

 

Simply enter text in the Name column against each 
point, and click the OK button. 

 

Note: if the modules selected when creating the Macro 
included any Setpoints, it is possible to set labels for 
specific setpoint values - see 

 

 

Note: This is different from setting the Input and Output names (labels) as described in Change input or output label if 
necessary on page 236. Those input and output names are labels displayed on the Macro module, the point 
names set here are the descriptive names stored for each of the points in the strategy. 

Note:  When adding a new instance of a Macro to a strategy, it is possible to add a prefix to these names, to avoid the 
situation where multiple points within a strategy could be assigned identical names. In this case the dialog has an 
input for the prefix but each name is fixed (not editable):             
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Choose whether to insert the macro into the active strategy 

The Insert into Strategy checkbox allows you to 
immediately insert a new Macro based on this Macro 
Template into the active strategy.  

If you want to insert the Macro into the active strategy, 
select this option before saving the Macro Template. 

 

Save the Macro Template 

To save the Macro Template, click the Save button. 

 

The Macro Template is saved to the  C:\UnitronUC32\Macros\ directory if it was created in a UCU or UC16 strategy, or 

in the C:\UnitronUC32\UC32Macros\ directory if it was created in a UC32, CBM or CBT strategy. The group and 
subgroup information is stored in the macro_database.db file in the same directory. 

If you decide not to save the Macro Template, click the Cancel button to close the Create Macro dialog box without saving. 

When you save the Macro Template, a Macro button and a Macro symbol are created: 

The Macro button is the icon that represents the Macro in the floating 
Macros bar. 

 

Note: The floating Macros bar can be opened from the button on the right of the fixed Macros Toolbar: 

  

 which is itself made visible from the View Menu> Macro bar. 

The Macro symbol is the bitmap that represents the Macro on the 
drawing area. (See Working with Macros on page 247). 
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How to create a new macro group and sub-group 

Macro Groups and Sub-Groups are defined in the Macro Manager interface. 

To open the Macro Manager dialog, press the Macro 
Manager button in the Create Macro dialog. 

Alternatively, if the Create Macro dialog is not opened, 
select Manager from the Macro menu. 

 

 

This opens the Macro Manager window 

 

To add a group, click the Add button while 
the Macros root is selected in the explorer 
pane (left hand side of the window) 

 

A new group appears in the Right-hand side 
Group pane. 

 

 Type in a name for the new group. 

 

To make a sub group in the new group, first make groups visible by clicking on the + sign to the left of the Macros root. 
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Click on the group under which you 
want to make a sub group 

 

Click on the Add button 

A new sub group appears in the right-
hand "Sub groups" pane 

 

Type in a name for the sub group 

 

You can view the subgroups under a 
group by clicking on the "+" sign to 
the left of the group in the left-hand 
explorer pane. 

 

To close the Macro Manager, click Exit.  

When a new Macro group is created, it will be listed under Macros in the View menu. When a new sub-group is created, an 
icon is also created for that sub-group and displayed in the Macro sub-group bar.  
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How to rename points in a Macro Template 

Points can be renamed from the Macro Manager interface. 

To open the Macro Manager dialog, press the Macro 
Manager button in the Create Macro dialog. 

Alternatively, if the Create Macro dialog is not opened, 
select Manager from the Macro menu. 

 

 

Clicking on a Macro Template in the left-hand-side ‘Tree 
view’ pane of the Macro Manager displays properties of 
the Macro Template in the right-hand pane. 

The Macro Name, Macro ID, User Created flag, and the list 
of point names are displayed. 

If there is no point names list, then a Create Point Names 
button will be displayed below the right-hand pane as 
shown above. 

 

If point names have already been defined, then an Edit 
Point Names button will be displayed instead: 

 

 

Clicking either button will open the Macro Point Name 
Prefix dialog as described in How to View Macro details on 
page 248. 

 

However, if this dialog is opened from the Macro Manager 
as shown here instead of from the Create Macro dialog, 
then when OK is clicked the Macro Template is changed and 
any Macro instances created afterwards will use the 
updated pointnames list. 
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How to Set Macro Setpoint Unit LaBels 

In the Macro Point Configuration dialog, it is possible to set labels for specific setpoint values, so that a user can for example 
select “Night” and “Day” for a digital setpoint, or “off”, “on,”, “trip” and “switch” for an analog point, without the need to 
know which numerical value matches each function. 

To set an enumerated list for a setpoint, right-click on the setpoint in the 
Macro Point Configuration dialog, and select Add/Edit Enumerates. 

Note:  This option is only available for setpoints. 

Note:  This option will not be available when a Macro is being added 
to a strategy, or when a Macro instance is being edited 
within a strategy – in those cases, when the Macro Point 
Configuration dialog opens the user will be allowed only to 
select from an existing enumerated list, or to type a value. 

 

This will open the Setpoint Enumerates dialog. 

 

Enter a Value and Description pair, and click the Add button. 
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The Value/Description pair will be added to the list 

 

If an entry is made in error it can be removed from the list by selecting it 
and clicking the Delete button. 

 

 

 

Now, when editing the setpoint, the user can select the required 
value from a drop-down list. 

 

The setpoint value is displayed in the list with the text description. 

 

The enumerated list is saved with the Macro template, and will be available in all instances of the Macro created 
afterwards. 
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How to transfer macros from one computer to another 

It is possible to use Macro Templates created on one PC on a different PC. They must be exported from the PC on which they 
are created, and added to the 'host' PC system (i.e. the PC on which they will be used) as follows: 

Export macros from the PC on which they were created 

Exporting Macro Templates as follows puts each Macro Template in a separate file with a user-identifiable name, so that they 
can be easily identified and moved to the 'host' PC system. 

Click on Manager in the Macro menu. 

 

Select the Macro group that contains the 
Macro Templates you wish to export, 

 

Select all of the Macro Templates within 
that group that you wish to export, 

and click the Export button.  

 

A Select Folder dialog will open. Select 
the location into which the selected 
Macros will be saved. 

 

 

Add exported Macros to the host PC system 

Once all required Macros have been exported, copy them onto the PC on which they will be used. 

Click on Manager in the Macro menu. 
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Select the group and subgroup into which you wish to 
import Macro Templates, 

 

 

 

 

and click on the Import button. 

 

In the standard Windows Open dialog. Multiple files can 
be selected by holding the [CTRL] key while clicking on 
each file.  

 

Select the Macro Templates you wish to add, and click the 
Open button. 

 

The selected Macro Templates will be imported into the 
selected group.  

If the Macro Template already exists on the host PC, an 
alert box will be displayed identifying the group and 
subgroup of any duplicates.  

If you wish to import any of the listed Macro Templates, 
tick the box beside its name before clicking the OK 
button. This will create a new Macro Template on the 
host PC, in addition to the existing duplicate. 

 

Note:  Each newly imported Macro Template will be named “X New Macro”, where X is the index of the Macro 

Template in the list.  

 To change this name, select it in the Macro Manager dialog, and click the Rename button. 

  

Once all Macro Templates have been added, they are available for use in the 'host' PC.  
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Working with Macros 

To access the Macro groups and sub groups that exist in a site, click on Macro bar in the View menu.   

The Macro bar will be displayed 
under the Toolbars 

 

How to insert a macro into a strategy 

To insert a Macro in a strategy, select 
the strategy's group on the Macro 
bar… 

 

…and its Macro Subgroup. 

 

If the floating Macro button bar is not already open, open it by pressing the Macros button on the Macro bar. 

 

This opens the floating Macro Buttons bar: 

   

Click the Macro button. It will depress 
to show that it is selected. 
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To place the Macro on the drawing 
area, click the drawing area with the 
mouse. 

 

The Macro symbol will be positioned 
with its top left-hand corner on the 
point where the mouse was clicked. 

 

The Macro symbol can be renamed through the Macro Details dialog box. 

How to View Macro details 

To view details of the Macro, right click the Macro symbol. 

This will display the Macro Details dialog box. 

 

If required, enter a name for this instance of the Macro 
(displayed in the Macro symbol on the drawing area) 
by entering a name of 10 alphanumeric characters or 
less in the New Description box. 

 Click OK to confirm the new name or click Cancel to 
close the dialog box without implementing any 
changes. 
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If required, you can edit point names in this instance of 
the Macro (but not in the Macro Template) by clicking 
on the Edit Point Names button on the Macro Details 
dialog box. 

This opens the Macro Point Name Prefix dialog, 
allowing point names to be edited for the current 
instance. 

Note:  If you would like to change the point 
names in the Macro Template, so that all 
future instances of this Macro will be 
affected, you must open the Macro Point 
Name Prefix dialog from the Macro 
Manager. See How to rename points in a 
Macro Template on page 242 for details. 

 

 

  

How to view the modules in a macro ("Expanding" a macro) 

To expand a Macro, select the Macro symbol on the drawing area by 
double-clicking it.  

Right click the selected Macro symbol. 

  

The Engineering Centre will open a new strategy for the Macro’s constituent modules. 
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 Note:  The view settings for Lines and Point Numbers are saved with the Macro. They are not inherited from the parent 

strategy. For example, if lines are not visible when a Macro is expanded , simply right-click on the strategy drawing, 
select Display Options, and specify that lines are to be shown. 

 

Note:  To distinguish between the inputs and outputs of individual modules and the inputs and outputs of the overall 
Macro module red highlighting is used to mark the connection points of the Macro module. It also provides the 
full path of the strategy file that it just created when expanding the Macro in the Window menu.  

 

Use the list of open files in the Window menu to jump between the strategy and the expanded Macro. Alternatively, choose 
Cascade, Tile Horizontal or Tile Vertical to view both the strategy and the expanded Macro simultaneously.  

 

Note:  Any changes made to a macro within a strategy will only affect the current strategy. The macro and all of its 
module blocks are saved within the active strategy. To edit the macro strategy itself you must open the *.etm 

file. 
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How to Edit a Macro 

It is not possible to edit an existing Macro Template, but it is possible re-save a modified Macro as a new Macro Template. 

To do this, double-click the Macro symbol on the drawing area to 
select it. 

  

Click on the Macro symbol with the right mouse button to view the constituent modules of the Macro: 

 Click each individual module with the right mouse button to call its dialog box. 

  

The variables associated with each module can be edited in its dialog box. 

  

To save the changes select Save As New 
Template from the Macro menu. 
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This opens the Create Macro dialog, but in this 
case Macro Inputs and Macro Outputs cannot 
be added or deleted.  

The input and output point names can be 
changed, as can the Macro Name, Group and 
Sub Group. 

 

How to customize macro buttons 

When you create a Macro, the Engineering Centre automatically creates a bitmap file with the same file name as the Macro 
with the extension .bmp (e.g. M1.bmp). 

This file is stored in one of 2 subdirectories of the CEC install directory, depending on whether the controller on which it 

was created was a UC32/CBM/CBT type controller or a legacy UC type controller: 

 [UC32/CBM/CBT] the UC32Macros subdirectory (e.g. UnitronUC32\UC32Macros) 

 [UC] the Macros subdirectory (e.g. UnitronUC32\Macros). 

In a bitmap editor (e.g Microsoft Paint), open the .bmp file that has the same name as the Macro you wish to customize. 

The Macro button will be displayed on the drawing area of the bitmap editor, e.g. 

  

You can now edit the bitmap to include a customized image and/or text, e.g. 

  

Save the modified bitmap. When the Engineering Centre is restarted, the bitmap will be displyed on the floating Macro bar. 

 



 
 

 

SECTION 9 :  COMMUNICATING 
WITH CONTROLLERS 
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Communicating with Cylon Controllers 

When you are using the Cylon Engineering Centre, you will need to communicate with the Cylon controllers on the site.  

There are two main types of controller: the Communications Controller and the Field  Input/Output controller.  

 You may need to send information to a controller such as a control strategy, a command to erase its memory, 
details of its set-up, etc. 

 You may need to get information from a controller such as its version, current set-up and details of any strategies 
it may contain. 

 You may wish to view events within a controller, such as changes in values when a strategy is being serviced. This 
can be done in Scan mode or by using the LiveLog menu option. 

Note:  If you have CCView open on the same PC that is running the Cylon Engineering Centre, make sure that 
'realtime' mode is turned OFF, as it will inhibit communication with Cylon controllers. 
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Sending information to a Communications Controller 

When implementing controls on your site, you may need to send the following information to its Communications 
Controllers: 

 Details of the number of Communications Controllers on the Ethernet or ARCnet; 

 Details of the number of Field Controllers on the Fieldbus; 

 The number of local and wide globals in a Communications Controller. 

All three can be sent to the Communications Controller by sending Set-up (see Sending set-up to a Communications 
Controller on page 257) 

Wiping a Communications Controller's memory 

If you are using Automatic Download (see page 182), it is not necessary to wipe a Communications Controller’s memory 
before downloading. If you are not using Automatic Download or if you are using the controller for the first time, its 
memory must be wiped manually as described below.  

You may wish to erase only some of the information in the Communications Controller. For example, you may wish to wipe 
all information from its memory except for that which refers to globals and time schedules. The Engineering Centre allows 
you to select the type of information to be erased from the Communications Controller. 

Note: When you wipe a Communications Controller's memory, you also wipe Alarm Strings, Modem Strings, and the 
Site ID. 
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How to wipe the memory of a Communications Controller: 
 Target the controller to be wiped by selecting the correct Communications Controller from the Site List.  

Log in by clicking the login/logout button on the toolbar so 
that the gate is closed as shown below:  

  

or by choosing Login from the File menu 

 

 

 Choose Wipe Memory from the UC32.net or UCC4 menu. A dialog box appears prompting you to select the 
information that is to be wiped from the controller. 

 Click the checkbox beside each type of information you would like to erase from the controller’s memory. In the 
following example, all information in the Communications Controller, except for that relating to globals and time 
schedules, will be erased: 

  

 Click Wipe to wipe the controller of the options chosen 

or 

 Click OK to close the dialog box without wiping the controller’s memory. 

Note:  On a UCC4-type Communications Controller, to show that the memory has been wiped the green LED on will 
pulse rapidly. If the memory has not been wiped, the green LED will light continuously without pulsing 
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Sending set-up to a Communications Controller 

Sending set-up to a Communications Controller means informing the Comms Controller of the number of Field Controllers 
on its Fieldbus, the number of Comms Controllers on its Ethernet or ARCnet and the number of local and wide globals it 
contains. If you are using Automatic Download (see page 182), you no longer need to send set-up to a Communications 
Controller after information is downloaded. However, if you are not using Automatic Download, you must send set-up to 
the Communications Controller in order for the strategy to be serviced. It is also necessary to send set-up to a 
Communications Controller before it is first used. 

How to send set-up to a Communications Controller: 
 Target the controller to which you wish to send set-up by selecting it in the Site List.  

 Log in by clicking the login/logout button on the toolbar so that the gate is closed:  or by choosing Login from 
the File menu 

 Choose Setup from the UC32.net or UCC4 menu. This calls the Setup dialog box. Complete the Setup dialog box by 
entering in the boxes provided the number of Comms Controllers on its Unet/ARCnet, the number of local and 
wide globals in the Comms Controller and the number of UCs on its Fieldbus.  

 Click the Send button to send the set-up to the Comms Controller. A message stating “Setup sent successfully” 
appears in the Current Status section of the Setup dialog box when the set-up has been sent. In addition, the 
green LED on the targeted Communications Controller no longer pulses. Instead, it lights continuously. 

 

 

 

 

Downloading globals to a Communications Controller 

Globals (see page 296) are created like modules as parts of strategies and are downloaded to the targeted Communications 
Controller when the strategies in which they are contained are downloaded to their targeted UCs.  
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Sending information to a Field Controller  

In the Engineering Centre, downloading a strategy can be completed in a single step, when you use Automatic Download (see 
page 182). When the strategy is ready to be downloaded, simply click the download button on the toolbar or choose 

Download from the Communications menu and the Engineering Centre will download the strategy and send the set-up 

automatically. Alternatively, you can use Automatic On-line Download (see page 185), where the Engineering Centre 
automatically downloads a module as soon as it is placed on the drawing area. Or finally, if you are already familiar with the 

Engineering Centre, you can download manually. 

Automatic download 

For details of how to enable Automatic Download, refer to Downloading a strategy using Automatic Download on page 182. 

Automatic on-line download 

If you use Automatic on-line download, the Engineering Centre will download to the controller the contents of the drawing 
area as soon as each module is placed on the drawing area. In other words, you do not have to press the download button 
on the toolbar or choose Download from the Communications menu. The Engineering Centre will download automatically. 
For more detail see Downloading a strategy using Automatic Online Downloading on page 185. 

The following criteria must be met for automatic on-line download to function: 

 You must wipe the controller’s memory before beginning the strategy.  

 You must be working on-line, i.e. you must be logged in to the controller. 

 You must enable automatic on-line download. 

 When the strategy is completed, you must send details of the number of blocks to service to the controller, i.e. 
send the set-up. 

Downloading tip 

If you enable both options (Automatic download and Automatic online downloading) on the Download setup tab, the 

Engineering Centre will automatically wipe the controller’s memory, download the modules as soon as they are placed on 
the drawing area and then automatically send the set-up. For example, supposing that you want to design a basic Strategy, 
download it and then download any changes that you make. In that case, you would enable the first option, i.e. Automatic 

Download, create the basic Strategy and download it by clicking the download button on the toolbar. The Engineering 

Centre will send the set-up automatically. Then you would enable the second option on the Download Setup tab, 
Automatic on-line downloading, so that each time you make a change to the original strategy or add another module, the 
changes are downloaded and the set-up is sent automatically. 
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Wiping a Field Controller's memory 

Although it is no longer necessary to wipe the Field Controller's memory before downloading if automatic download is 
enabled, it is still necessary to wipe the controller’s memory before using it for the first time. If you are not using automatic 
download, you must manually wipe the controller’s memory before downloading. 

The effect of wiping a Field Controller’s memory 

Wiping Field Controller memory has the following effect: 

 All blocks are deleted (the strategy is deleted). 

 The functions of the site (valves, pumps, dampers, etc. controlled by this Field Controller, are no longer available.) 

 The number of serviced blocks will be set to zero. Field Controller Set-up has to be sent again. 

 All virtual points are assigned the value zero. 

 All hardware points are assigned the value zero. 

 All outputs go to zero volts. 

 Inputs do not read any signals from connected devices. This is true for manually overridden points too. 

 The green LED on the Field Controller flashes rapidly. If the Field Controller is running without a network (standalone), 
the flashes are regular. If the Field Controller is running on a network (connected to a Communications Controller), the 
flashes are irregular. 

 If the alarm feature is active, an alarm appears on the monitor of the connected PC. 

 If a keypad program for that Field Controller exists, it will be deleted. 

 Target points of globals are no longer updated by the Communications Controller. 

Sending set-up to a Field Controller 

If you are using Automatic Download, it is not necessary to send set-up to the controller after downloading. Otherwise, set-
up must be sent manually as described below: 

How to send set-up to a Field Controller: 
 Target the controller to which you wish to send set-up by selecting the controller from the Site List (see Targeting 

a controller on page 46). 

 Choose UC Setup from the UC menu. This produces the UC Setup dialog box (see  How to start a strategy (send 
set-up) on page 197).  

Note: When directly connected to a Field Controller that has either been 'hardware wiped' or is in its factory state, if 
you send a setup or wipe the UC's memory you may see a message "Checksum error in UC16 Modem RAM". 
This can be solved by downloading a valid set of Modem settings to the controller. 
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Getting the Communications Controller version 

How to get the version of a Communications Controller: 
 Target the Communications Controller whose version you want to upload by selecting it from the Site List (see 

Targeting a controller on page 46). 

 Log in to the controller by choosing Login from the File menu, or clicking the Login/Logout button on the Toolbar. 
Communication is not possible unless you are logged in. 

 Choose Version from the UC32.net or UCC4 menu.  

 The Engineering Centre will get the version number from the controller and display it in a dialog box. 

 Click OK to close the Version dialog box.  

 

Getting the Communications Controller Setup 

The Setup of a Communications Controller includes details of the number of Comms Controllers on its Ethernet or ARCnet, 
the number of Field Controllers on its Fieldbus and the number of wide and local globals it may contain. 

How to get the set-up of a Communications Controller: 
 Target the Communications Controller whose set-up you want to upload by selecting it from the Site List (see 

Targeting a controller on page 46). 

 Log in to the controller by choosing Login from the File menu, or clicking the Login/Logout button on the Toolbar. 
Communication is not possible unless you are logged in. 

 Choose Setup from the UC32.net or UCC4 menu.  

 The Engineering Centre will get the set-up from the controller and display it in a dialog box. 

 Click OK to close the Setup dialog box. 
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Configuring UC32.net-type Communications Controllers 
 
 
 

Configuring the UC32.net Ports 

The communications ports on a UC32.net-type communications controller can be configured directly from the Cylon 

Engineering Centre as detailed below. The ports on a UCC4 must be configured using the UCC4 Configuration program. 

 

How to configure UC32.net ports: 

Click on Port Setup in the UC32.net menu. This opens the UC32.net Port Setup dialog. In this dialog there are up to 4 tabs:  

 Subnet port    

 Port 1  

 Port 2 (USB)   

 Port 3   

 Port 4 (Modbus)   

Note:  The Port 4 (Modbus) tab is only visible if the targeted Comms Controller is a modbus type 

 

Each tab shows the possible configurations allowed for the related port, and has a Send button and a Receive button.  

 Click on the Receive button to display the current settings for that port. Click on the Send button to change the 
port on the targeted Comms Controller to match the settings in the dialog box. 

 

At the bottom of the dialog there is a Send All button and a Close button.  

 Click the Send All button to immediately change all of the ports on the UC32.net to match the settings in the 
dialog box. 

 Click on Close to close the dialog box without applying changes. 
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The parameters for each port are explained below: 

Port  Function Parameter Purpose Possible values 

Subnet (Fieldbus) 
Port 

Fieldbus 
communications 

Baud Rate Sets the speed of 
communication with 
other controllers on the 
Fieldbus. This value must 
match the baud settings 
in all other controllers. 

1200 
9600 
19200  
38400  
76800 

Port 1 Service Port 
Printer 

Port Use Defines what the port 
will be connected to. 

PC 
Printer 

Baud Sets the speed of 
communication with the 
equipment connected to 
the port. This value must 
match the setting in the 
connected equipment 

300 
600 
1200 
2400 
4800 
9600 
14400 
19200 
38400 
57600 
115200 

Data size Data is usually sent in 8-
bit packets. However in 
some circumstances this 
can be changed. This 
value must match the 
setting in the connected 
equipment 

5 
6 
7 
8 

Stop bits Sets the number of bits 
added to the end of a 
packet of data. This 
value must match the 
setting in the connected 
equipment 

1 
2 

Parity This is used for checking 
the integrity of 
transmitted data. This 
value must match the 
setting in the connected 
equipment 

None 
Even 
Odd 
Mark 
Space 
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Port  Function Parameter  Possible values 

Port 2 (USB) 

 

Service port Baud Sets the speed of 
communication with the 
PC connected to the 
port. This value must 
match the setting in the 
connected PC for the 
'COM' port representing 
the USB connection. 

300 
600 
1200 
2400 
4800 
9600 
14400 
19200 
38400 
57600 
115200 

Port 3 Modem with 
Cylon Software  
Printer 
Service port  

Port Use Defines what the port 
will be connected to. 

PC  
Printer 
Modem  
Modem PPP 
Connection 

Baud Sets the speed of 
communication with the 
equipment connected to 
the port. This value must 
match the setting in the 
connected equipment 

300 
600 
1200 
2400 
4800 
9600 
14400 
19200 
38400 
57600 
115200 

Data size Data is usually sent in 8-
bit packets. However in 
some circumstances this 
can be changed. This 
value must match the 
setting in the connected 
equipment 

5 
6 
7 
8 

Stop bits Sets the number of bits 
added to the end of a 
packet of data. This 
value must match the 
setting in the connected 
equipment 

1 
2 

Parity This is used for checking 
the integrity of 
transmitted data. This 
value must match the 
setting in the connected 
equipment 

None 
Even 
Odd 
Mark 
Space 

Flow Control This value must match 
the setting in the 
connected equipment 

None 
CTS / RTS 
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Port  Function Parameter  Possible values 

Port 4 (Modbus) RS232 Modbus-
Master 
RS232 Modbus-
Slave 
RS485 Modbus 
Master 

Port Use Defines how the 
controller will behave 
towards connected 
Modbus equipment. 

Modbus Master Single 
Modbus Master 
Multiple 
Modbus Slave 
Modbus Slave 
Swapped 
Jbus Slave 
Jbus Slave Swapped 

Baud Sets the speed of 
communication with the 
equipment connected to 
the port. This value must 
match the setting in the 
connected equipment 

300 
600 
1200 
2400 
4800 
9600 
14400 
19200 
38400 
57600 
115200 

Data size Data is usually sent in 8-
bit packets. However in 
some circumstances this 
can be changed. This 
value must match the 
setting in the connected 
equipment 

5 
6 
7 
8 

Stop bits Sets the number of bits 
added to the end of a 
packet of data. This 
value must match the 
setting in the connected 
equipment 

1 
2 

Parity This is used for checking 
the integrity of 
transmitted data. This 
value must match the 
setting in the connected 
equipment 

None 
Even 
Odd 
Mark 
Space 

Drive This is the transmission 
protocol used for 
modbus communication. 
This value must match 
the setting in the 
connected equipment 

RS232 
RS485 
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Configuring UC32.net Web Server Access 

The configuration of a UC32.net-type communications controller can be viewed and edited with a web browser, using the 
UC32.net's embedded web server. In order to configure a UC32.net in this way, Web Access must be specifically enabled, 
and a username/password combination should be defined. 

How to configure UC32.net Web Server Access 

Click on Web Server Access... in the UC32.net menu. This opens the UC32.net Web Server Access dialog, which allows the 
following parameters to be set: 

 Enable Web Access 

If this box is ticked, then the web server will respond to configuration requests from a web browser. 

 Enter a Username and Password 

In this section you should enter a unique username to identify anyone who wishes to configure the controller from a web 
browser. A password must be entered for that user, and then must also be re-entered in the Confirm Password box to 
ensure that the correct password has been set. 

 Apply to all UC32.nets on Site 

Tick this box if each UC32.net on the site is to use the same Web Access settings. 
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Configuring UC32.net Strings 

Communications controllers hold several sets of text or "string" data in memory. These include: 

 Alarm strings, which are pieces of text that will be displayed when particular alarms arise 

 Modem Strings, which are configuration instructions sent to modems to facilitate communication 

 Print strings, which represent text that is to be printed alongside specified parts of an alarm message. 

Each of these strings types is explained in the following sections. 

 Uploading Strings from the Controller 

To view the strings already set in the Comms Controller: 

 Select a string type (tab) 

 Specify the range of strings you want to view in the Upload - Start Num and End Num boxes 

 Click on Upload. 

 Adding a new String 

To define an new string in the Comms Controller,  

 click the Add button in the relevant tab of the UC32.net Strings Setup dialog. 

 Enter the text of the string, and click OK. The string number will be assigned automatically. 

 Changing a string value 

To change the text of a string,  

 select the string in the relevant tab, and click on Change.  

 Enter the new text for the string, and click OK. 

Saving the String values 

To save all of the string values to disc, click the Save Strings button. 

Downloading Strings to the controller 

To download all string settings to the controller, click the Download All button. 

To download specific strings, click on them in the strings list, and then click the Download Selection button. 
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Alarm String Values 

It is possible to have alarms displayed on the supervisory PC with a message, for instance “The boiler in building 3 has 
overheated”. These messages are defined by strings that are stored in the Comms Controller. Each alarm in a strategy can 
have two alarm strings associated with it – a string associated with the alarm becoming active, and a string associated with 
the end of the alarm.  

When an alarm is triggered on a field controller, information about the alarm is sent to the Communications Controller. If 
the Communications Controller contains an alarm string associated with that alarm, the string will sent from the 
Communications Controller to the queue to which the alarm is assigned. 

The association between Field Controller alarms and Comms Controller strings is made in the Strategy (see Start Alarm and 
End Alarm on 394). 

Modem String Values 

In order for a UC32.net to communicate with a US Robotics 56K Fax Modem, five specific strings are required: 

String Number Description Value 

1 UC ID code  
This is the ID string for the site.  

This must identical to the UC ID code 
that is entered in the Site 
Configuration dialog in the 
Configuration program. 

2 Initialisation string 
This is used to initialise the modem 

~~~+++~~~ATH@~~~AT&F0&D0&K0
&M0S0=2S19=5&W0@ 

3 Dial out string  
This is the command to dial the supervisory PC 
when an alarm occurs. It should contain the 
modem command to dial and the telephone 
number of the central PC and the @ which 
indicates a carriage return. 

 ATDT [the phone number to which 
alarms are to be dialled out] @ 

4 Hang up string  
This hangs up the modem. 

~~~+++~~~ATH@ 

5 Connect string  
This is a piece of text that should be in the 
message sent back by the modem when a 
connection has been made. 

 CONNECT 

Note:  These strings are normally assigned using the Cylon Dialout Program (CCDial). Configuring these strings in the 
UC32.net Strings Setup dialog should only be carried out by experienced users. 
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Print String Values 

When a printer is directly connected to the Comms Controller, the controller will send specific strings with specific parts of 
the Alarm in order to make the printout more readable. These strings can be defined in the UC32.net Strings Setup dialog. 
The strings numbers must match the table below: 

String No. String Function Purpose Example values 

1 Printer Reset This is sent to reset the printer.  

2 Alarm Date Precedes the date and time of the alarm. Date and Time: 

3 Active Alarm  Indicates that the Alarm is still active. This Alarm is Current 

4 Non Active Alarm Indicates that the alarm has ended. This Alarm has ended 

5 Point Indicates the number of the point from 
which the alarm is coming. 

Point causing the alarm: 

6 Priority Indicates the priority of the alarm. Priority Number: 

7 Field Controller 
System Alarm 

Identifies a Field Controller system alarm. This is a system alarm 
from a Field I/O 
Controller 

8 Comms Controller 
System Alarm 

Identifies a Comms Controller system 
alarm. 

This is a system alarm 
from a Communications 
Controller 

9 Subnet alarm Identifies a sub-network alarm. Sub-Network Alarm  

10 ARCnet Alarm Identifies an ARCnet alarm. ARCnet Alarm  

11 Field Controller 
Alarm 

Identifies a control alarm. Control Alarm  

12 Net Empty This is sent if the Ethernet or ARCnet has 
no Comms Controller on it, or that the 
Fieldbus has no Field Controllers on it.  

No Controllers Present 

13 Net Complete This is sent if the Ethernet or ARCnet 
contains the number of Comms 
Controllers specified in the setup and that 
the fieldbus has the number of Field 
Controllers specified in the setup. 

All Controllers present 
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Sending the Site Number to a Comms Controller 

In order to respond properly to the Supervising PC and Cylon Engineering Centre software, and also so that UC32.netK 
Comms Controllers can 'see' each other on the Ethernet, the Comms Controller must be registered as being part of the 
correct site. The site number in the controller can be viewed or set as follows: 

To View the site number currently set in the controller,  

 Select Send Site Number from the UC32.net menu. This opens the UC32.net Send Site Number dialog. 

 Click on the Receive button (this is not strictly necessary, as when the dialog opens Site number is automatically 
received. However, clicking the button will re-confirm this information if required). 

 The current site number setting will be displayed in the Current Site Number box. 

To change the site number in the controller: 

Note:  The site number in the Send Site Number dialog cannot be edited directly. If the number is to be changed, it 

must be changed in the site definition in the Cylon Configuration utility  (CCConfig).  

 If this number is to be sent to all Comms Controllers at once, tick the Apply to all UC32.nets on site box. 

 Click on the Send button. 

 The new site number will be set in the controller 
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Getting Communications Controller statistics 

When you are logged in, you can upload statistical information from the Communications Controller by simply selecting 
Statistics from the UCC4 menu, or Generate Report from the UC32.net menu. 

 

 

 

UCC4 Statistics 

Selecting Statistics from the UCC4 menu will open the Statistics dialog box. The Statistics dialog box contains information 
that comes directly from the controller – this information allows you to check the status of the UCC4 and the ARCnet 
network 

The Statistics dialog box has three tabs – System Statistics, Engineering Statistics and ARCnet Statistics. 

System Statistics tab 

The System Statistics tab provides the following information: 

To find out Look at 

The time and date of the last time the UCC4 was reset Last Reset 

How many alarms are present in the UCC4 Number of alarms 

The time and date of the last time the UCC4 was powered down Last power down 

The time and date the last time power was restored to the UCC4  Last power up 
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Engineering Statistics. 

The Engineering Statistics tab provides the following information: 

Note:  A check beside each item indicates that it is functioning correctly. 

 
 
 

To find out Look at 

How many times the system has been powered up and down Number of resets 

How many Fieldbus communications errors have been detected Number of Fieldbus errors 

If the UCC4 is correctly servicing UCC4 servicing 

If the communication ports are working correctly  Ports set-up 

If the set-up information, the number of UCC4s on ARCnet, UCs on 
Fieldbus, etc., stored in the UCC4 is identical to the set-up 
information received ( Each item is individually checksummed, i.e., 
the data received from the controller is checked against the stored 
value for that item)  

Set-up checksum OK 

If local globals are functioning correctly  Local globals checksum OK 

If wide input globals are functioning correctly  Wide input globals 
checksum OK 

If wide output globals are functioning correctly Wide output globals 
checksum OK 

If the UCC4 time schedules are functioning correctly Schedules checksum OK 

If daylight saving is operating Daylight saving checksum 
OK 

If alarms are being processed correctly Alarm level checksum OK 
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ARCnet Statistics 

The ARCnet Statistics tab provides the following information: 

To find out Look at 

How many times the ARCnet has reconfigured itself. (If this 
happens regularly, the ARCnet is unstable and should be tested.) 

Number of 
reconfigurations 

How many times the targeted UCC4 has reconfigured itself. Reconfigurations for this 
UCC4 

How many requests to the UCC4 were not responded to. Excessive Nacks 

If there is an ARCnet board present in the UCC4. No ARCnet board 

If the ARCnet board is present and working.  ARCnet OK 

To find out Look at 

If there is another UCC4 with the same address as the targeted 
UCC4. 

Clash – other node with 
same address 

If there are other UCC4s on the ARCnet.  Empty – no other nodes 

If all 255 addresses on the ARCnet have been used. Full – all addresses used 
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UC32.net Statistics Report 

Selecting Generate Report from the UC32.net menu opens a dialog box in which you can select the items of information 
about the controller that you want to examine.  

When you click on the Generate button, a HTML page will be displayed, which contains details of all of the selected items. 
The report can include:  

Version & Identification Site number, address, identification and version of the 

targeted Communications Controller. 

Setup Block Details of Fieldbus and Unet nodes relating to the 
targeted Communications Controller, and numbers of 
globals in the Controller's fieldbus. 

Time & Date The time and date stored in the controller, and the 
Daylight Saving setting. 

Ports Setup The configuration of each of the controller's ports. 

TCP/IP Settings The controller's IP address, port, subnet mask and 
gateway.  

Subnet Termination Status Whether or not the Fieldbus is terminated at the targeted 
controller. 

Battery Status Battery level and voltage 

Hardware Platform Status Version of the controller's hardware 

Bootloader version Version of the controller's bootloader 

Keypad Configuration Settings Whether or not the keypad configuration program is 
enabled in the controller, and the password required to 
access it. 

Keypad information Keypad type and firmware version 

Alarm Strings Number and contents of each alarm string in the 
controller. 

Modem Strings Number and contents of each Modem string in the 
controller. 

Printer Strings Number and contents of each Printer string in the 
controller. 

Subnet Map The address and operation status of each field controller 
on the fieldbus. 

Unet Statistics Packet information for traffic over Ethernet between the 
controller and other UnitronUC32 equipment 

Ethernet Statistics Information about overall Ethernet traffic detected by the 
controller 

Ports Statistics Information on traffic through each of the controller's 
ports. 

Engineering Statistics Diagnostic information about the operation of the 
controller. 
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 Setting the Communications Controller Time and Date 

When you are logged in, you can check and set the time and date in the targeted Communications Controller, and also 
select the Daylight Saving time scheme for it, by selecting Time and Date in the UC32.net or UCC4 menu. 

In the Time and Date dialog, you can receive the time and date set 
in the targeted controller, by clicking on the Receive button (time 
and date are automatically received when you first open the 
dialog). 

 

The Time and Date can be changed by typing a new date,  

 

by scrolling, 

 

or by pressing the System Time and Date button, which sets the 
time and date to match the settings in the PC on which the 
Engineering Centre is running. 
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The daylight saving time scheme can be selected in the Time based on box on the Time and Date dialog: 

If the 'None' option is selected for Daylight Savings, then the 
controller will not automatically adjust its time to match 
conventional Summer and Winter time. 

 

If the 'EU' option is selected for Daylight Savings, then the controller 
will automatically adjust its time according to the standard European 
rules for Summer and Winter time. 

 

If the 'US' option is selected for Daylight Savings, then the controller 
will automatically adjust its time according to the standard United 
States rules for Summer and Winter time. 

 

If the time and date settings have been changed in the dialog box, they must be sent to the Communications Controller 
before they will take effect. This is done by clicking the Send button: 

 

Clicking the Close button closes the dialog box without sending or receiving further information. 
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Uploading from a Communications Controller - globals 

If you have created local or wide globals, you can upload them as follows: 

 Open a new strategy file by choosing New from the File menu or clicking the New button on the Toolbar. 

 Select the controller from which you wish to upload information when prompted by the Engineering Centre (see 
Targeting a controller on page 46). 

 Log in to the controller by choosing Login from the File menu, or clicking the Login/Logout button in the Toolbar. 
Communication is not possible unless you are logged in. 

Select Upload from the Communications menu or 
click the 

   

 button on the toolbar. 

 

When you have clicked Upload on the Communications menu, the 
Engineering Centre displays the Select Items to Upload dialog box.  

Use this box to specify which items, strategy blocks, analog or digital 
points and local or wide globals you wish to upload.  

 

To upload local globals, check the Local Globals checkbox. 
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To upload Wide Input, Wide Output, or Smart globals, check the corresponding checkbox: 

                

If you wish to upload a particular range of globals, instead of all available 
globals, click the Locals ... button or Wide ... button to the right of the 
check-boxes.  

 

The Globals dialog box now appears: 

 

You can specify which globals are to be uploaded by clicking the Selected 
radio button, and entering values. 

Local globals are in the range 1 to 255. Wide globals are in the range 1 to 64. 

 

Click OK to close the Globals dialog box. 
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Click OK to close the Select Items to Upload dialog box. 

 

The Uploading window appears to show the progress of the upload. 

  

When the upload is complete, click the Close button to close the Uploading window. 
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Getting the UC32/UC version 

How to get the version of a UC32, UC or UCU: 
 Target the controller whose version you want to upload by selecting the controller from the Site List (see 

Targeting a controller on page 46). 

 Log in to the controller by choosing Login from the File menu, or by clicking the Login/Logout button on the 
toolbar. Communication is not possible unless you are logged in. 

 Choose Version from the UC32 or UC menu. The Engineering Centre will get the version from the controller and 
display it as follows:  

  

 Click OK to close the version window.  
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Getting the controller set-up 

How to get the set-up of a UC32, UC or UCU controller: 
 Target the controller whose set-up you want to upload by selecting the controller from the Site List (see Targeting 

a controller on page 46). 

 Log in to the controller by choosing Login from the File menu, or by clicking the Login/Logout button on the 
toolbar. Communication is not possible unless you are logged in. 

 Choose Setup from the UC32 or UC menu.  

 

 The Engineering Centre will display the UC Setup dialog:: 

  

 Click Close to close the UC set-up window. 
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Getting controller statistics 

When you are logged in you can upload statistical information from the UC32, UC or UCU by clicking Statistics on the UC or 
UC32 menu. The Statistics dialog box, shown below, appears. The Statistics dialog box contains information that comes 
directly from the controller – this information allows you to check the status of the controller: 

  

The UC Statistics dialog box has four tabs – Engineering Statistics, System Statistics, UC Alarm Statistics and Serial Port 
Statistics. 

Note:  When UC or UCU controllers are targeted, the Serial Port Statistics tab is not available 
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Engineering statistics tab 

To view the information in the Engineering Statistics tab of the UC Statistics dialog box, simply click the Engineering 
Statistics tab: 

  

The information provided in the Engineering Statistics tab is outlined in following the table. 

To find out Look at 

How many times the UC has been powered up and down Number of resets 

How many crashes in the UC have been detected  Number of crash detects 

How many data errors have occurred in communications  Comm. Checksum errors 

How many bad or corrupted blocks have been in the 
strategy 

Number of bad blocks 

If the watchdog is switched on (a watchdog is a hardware 
component in the controller that checks if the controller is 
serviceable. When the watchdog is off, the controller is not 
operating) 

Watchdog on 

If a real time clock is present in the UC Real time clock present 

If a controller’s inputs have been calibrated (Testing of UCs 
includes calibration of input points. Calibration details are 
stored in the UC’s EEPROM. If a controller’s inputs have 
been calibrated, the EEPROM checkbox will be checked.) 

EEPROM 
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System statistics tab 

To view the information in the System Statistics tab of the UC Statistics dialog box, simply click the System Statistics tab. 
This tab provides information on any problems the controller may have in servicing the strategy. 

  

The information provided in the System Statistics tab is outlined in the following table: 

To find out Look at 

The date and time that the UC was last reset Last reset 

If the Set-up block (the block in the controller that 
stores details of the number of blocks in the strategy) 
is functioning  

Set-up block OK 

How many blocks are servicing in the UC  Number of blocks servicing 

To find out Look at 

How many bad or corrupted blocks are in the UC Number of bad blocks 

The number of the first of the bad blocks First bad block 

The number of the last of the bad blocks Last bad block 
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Controller alarm statistics 

To view the information in the UC alarm statistics tab of the UC Statistics dialog box, simply click the UC alarm statistics tab:  

  

Enter an alarm number and click on Receive. The details of the alarm will be shown as outlined in following the table. 

To find out Look at 

The number of the alarm that is reported in the UC alarm statistics 
tab 

Alarm number 

The priority of the reported alarm Alarm priority  

The number of the strategy block (module) defining the alarm  Module number 

How many of alarms have been reported in the UC Number of alarms  

If an alarm is currently active Alarm present 

When the alarm first occurred Alarm start 

When the alarm ended Alarm end 
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Serial Port Statistics 

The Cylon Engineering Centre can display information about messages passing through the UC32 controller's serial ports as 
follows: 

Clicking on the 'Serial Port Statistics' tab displays 
details about the numbers of each of the different 
types of messages that pass through any one of the 
serial ports on the targeted UC32 controller. 

 

The first section of this panel, Serial Port Type allows 
you to select which of the four possible serial ports 
the displayed information refers to. 

 

Pressing the Receive button causes the Cylon Engineering Centre to upload information about the selected port from the 
UC32 controller. 

Clicking on Clear causes the UC32 controller to clear its memory of port statistics referring to the selected port. 

The information displayed is the number of each of the following messages that passed through the selected serial port 
since the controller's memory was last cleared: 

 Number of Bytes received 

 Number of Bytes Sent 

 Number of Packets received 

 Number of Packets Sent 

 Number of NACKs received 

 Number of NACKs sent 

 Number of ACKs received 

 Number of ACKs sent 

 Number of Checksum errors 

 Number of Overrun errors 

 Number of Framing errors 

 Number of Parity errors 

 Number of break conditions 

This information can be used to diagnose low-level problems with the UC32's serial-port communications, and this is usually 
done in consultation with Cylon Technical Support. 
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Viewing UC32 Diagnostic information 

The Cylon Engineering Centre has a facility to display information about the operation of the UC32 controller's hardware 
system. This information, referred to as 'board diagnostics' can be of use in troubleshooting unusual and low-level problems 
on a Cylon site, and is intended for use primarily when communicating with Cylon technical support.   

Board Diagnostic information may be viewed by 
selecting Diagnostics from the UC32 menu in the 
Cylon Engineering Centre. 

 

This opens a display panel showing categories of 
information about the UC32 controller's hardware. 

Clicking on the Receive button causes the Cylon 
Engineering Centre to upload the relevant 
information from the targeted UC32 controller. 
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Viewing UC32 Configuration information 

The Cylon Engineering Centre has a facility to display the configuration of the UC32 controller. This information, can be of 
use in troubleshooting unusual and low-level problems on a Cylon site, and is intended for use primarily when 
communicating with Cylon technical support.   

Controller Configuration information may be viewed 
by selecting Configuration Info from the UC32 menu 
in the Cylon Engineering Centre. 

 

This opens a display panel showing the configuration 
of the UC32 controller's hardware. 
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Setting the Controller Time and Date 

When you are logged in, you can check and set the time and date 
in the targeted controller, and also select the Daylight Saving time 
scheme for it, by clicking on Time and Date in the UC32 or UC 
menu: 

 

This opens the Time and Date dialog: 

 

In this dialog, you can receive the time and date set in the 
targeted controller, by clicking on the Receive button (time and 
date are automatically received when you first open the dialog). 

 

The Time and Date can be changed by typing a new date,  

 

by scrolling, 

 

or by pressing the System Time and Date button, which sets the 
time and date to match the settings in the PC on which the 
Engineering Centre is running. 

 

The daylight saving time scheme can be selected in the Time based on box on the Time and Date dialog: 

If the 'None' option is selected for Daylight Savings, then the 
controller will not automatically adjust its time to match 
conventional Summer and Winter time. 
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If the 'EU' option is selected for Daylight Savings, then the controller 
will automatically adjust its time according to the standard 
European rules for Summer and Winter time. 

 

Note: US daylight saving time on a Fieldbus is governed by the Fieldbus's Communications Controller - see Setting the 
Communications Controller Time and Date on page 274) 

If the time and date settings have been changed in the dialog box, they must be sent to the controller before they will take 
effect. This is done by clicking the Send button: 

 

Clicking the Close button closes the dialog box without sending or receiving further information. 

Uploading points from a controller 

For detailed information on uploading points from a UC32, UC or UC32 controller, see Uploading strategies from a Field 
Controller  on page 116. 

 

Uploading strategies from a controller 

For a detailed step-by-step guide to uploading strategies from a UC32, UC or UC32 controller, see How to upload a strategy 
on page 205. 

 

Viewing information uploaded from a controller 

For a note on viewing information uploaded from a UC32, UC or UC32 controller, refer to Uploading a strategy on page 204. 
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Changing the address of a controller (UC32 and UCU only) 

UC32 and UCU controller addresses must be set from software, because there are no Controller Address DIP switches on 
this type of controller. 

To set a controller’s address from the Engineering Centre: 

 Make sure that the PC, running the Engineering Centre, is directly connected to the Field Controller’s service port. 

 Make sure that there is a site set up in the Engineering Centre with the PC connected to Com port: 

 

Make sure that the directly connected controller is 
targeted in the Engineering Centre’s Site List: 

 

Make sure that the Engineering Centre is Logged In 
to the controller.  

Select Change Controller Address from the 
Communications menu. 
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The Change Address dialog opens, and the address of 
the targeted controller is read: 

 

Enter the new address for the controller: 

 

And press the send button 

 

When the controller address is changed, it reports 
back to the Engineering Centre: 

 

Press Cancel to close the Change controller address 
dialog 
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Configuring the inputs on a UC16DI controller 

The UC16DI controller is a dedicated input device. It has 16 digital inputs and no outputs, and is designed specifically to 
global the values of those inputs to other controllers. 

The UC16DI's inputs can also be inverted or manually overridden. The Engineering Centre has a facility for configuring these 
'states' for each of the inputs. 

To configure UC16DI controller inputs, select DI Setup from the UC 
menu. 

 

This opens the DI Setup dialog box. 

 

Select the input that you would like to 
configure. 

 

Select whether the input should be overridden (by ticking the 
override 'Enable' box)  
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or active (by clearing the override 'Enable' box) 

 

If the input is active (override 'Enable' box is cleared) then its 
value can be inverted if required - so that the value globalled 
out to other controllers is the logical complement of the value 
at the controllers physical input. 

 

If the input is overridden (override 'Enable' box is checked) 
then the value that will be globalled out to other controllers 
will be determined by the 'State' checkbox. If this is checked, 
then the value sent to other controllers will be logical '1'. If it is 
cleared, the value sent out will be '0' 

 

When all of the required inputs have been 
configured, click on 'send' to download the 
information to the controller. 

 

  

  





 
 

 

SECTION 10 :  GLOBALS 
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Globals - an Overview 

What is a global? 

A global is a way of passing a value from one controller to another. It is an important means of communication within the Cylon 
Building Management System, as it allows the output of one strategy on one controller to be passed on to another strategy on 
another controller.  

A global can pass a point or time schedule value from: 

 one Field Controller to another on the same Fieldbus (a local global); 

 one Field Controller to all other Field Controllers on the same Fieldbus (a broadcast local global); 

 a Field Controller on one Fieldbus to a Field Controller on another Fieldbus (a wide global); 

 one Field Controller on one Fieldbus to all Field Controllers on any or all Fieldbusses (a broadcast wide global).  

If the global is used to transmit a point value, it can be either analog or digital depending on whether the point whose value is 
being transmitted is analog or digital. A global can also be used to pass a time schedule value from one controller to another.  

There is also a special type of local global that combines the values of one point in several different controllers and places a 
calculation (maximum, minimum, average or sum) of the values into a different point in one controller. These are called "Smart" 
globals, and they can simplify actions such as reporting the total airflow in many VAV units, registering the maximum temperature 
in a complete floor of a building, etc. 

Each type of global, with the exception of the broadcast globals, is presented on a floating globals bar (see page 300). Broadcast 
globals are created by checking the Broadcast checkbox that exists in each global’s dialog box. 

How do globals work? 

To pass a point value (or time schedule) from one controller to another, you need: 

 A strategy – also called the source strategy. This is where the point whose value is being transmitted 
originates. This point is called the source point; 

 An output global, which you join to the output of the source strategy; 

 Another strategy – called the target strategy. This is where the point that is receiving the value is found. 
This point is called the target point or destination; 

 An input global, which you must join to the target point. 
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UCC4/3P/Kunitron

UC24PG-Runitron UC24PG-Runitron UC24PG-Runitron UC24PG-Runitron
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controller1
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2

3

The UCC4 extracts

the temperature

from the strategy.

The UCC4 transmits the

temperature to one or all of

the UC controllers on the

sub-network.

UC Controllers
 

You could say that a global is made up of two halves – firstly, a source strategy with a source point and an output global and 
secondly, a target strategy with an input global and a target point.  

Both local and wide globals work in essentially the same way. Wide globals, however, are slightly more complex. A wide global 
needs one more constituent part other than the source and target strategies and that is a Unet or ARCnet global. This is needed to 
pass the value across the Unet or ARCnet from the Communications Controller of the source strategy to the Communications 
Controller of the target strategy. 
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The illustration below shows the source and target strategies of a local global, as they would be shown in the Engineering 
Centre. Both strategies can easily be viewed at the same time, using one of the Tile options on the Window menu. 

  

 

 

Arrangement of globals in the Engineering Centre 

Like modules, globals are represented by buttons in a globals bar.  

This is viewed either by clicking on the   button in the toolbar, or by selecting Globals from the View menu.  

The globals bar is by default docked underneath the Toolbar and Modules bar, but can be resized and moved to any part of 
the screen. 
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The globals bar 

The table below describes the buttons that are available on the floating globals bar. 

To Click 

Place an analog input local global on the drawing area  (in other words to place 
on the drawing area a symbol that represents an analog local global passing a 
value to a point on the target Field Controller.  

Place an analog output local global on the drawing area (in other words to place 
on the drawing area a symbol that represents an analog local global receiving a 
value from a point on the source Field Controller.  

Place a digital input local global on the drawing area (in other words to place on 
the drawing area a symbol that represents a digital local global passing a value to 
a point on the target Field Controller  

Place a digital output local global on the drawing area (in other words to place on 
the drawing area a symbol to represent a digital local global receiving a value 
from a point on the source Field Controller.  

Place an analog input wide global on the drawing area (in other words to place 
on the drawing area a symbol to represent an analog wide global passing a value 
from the ARCnet to a point on the target Field Controller.  

Place an analog output wide global on the drawing area (in other words to place 
on the drawing area a symbol to represent an analog wide global passing a value 
from a point on the source Field Controller to the Cylon Network (UNet).  

Place a digital input wide global on the drawing area (in other words to place on 
the drawing area a symbol to represent a digital wide input global passing a value 
from the ARCnet to a point on the target Field Controller.  

Place a digital output wide global on the drawing area (in other words to place on 
the drawing area a symbol to represent a digital wide global passing a value from 
a point on the source Field Controller to the Cylon Network (UNet).  

Place a local time schedule global on the drawing area (in other words to place 
on the drawing area a symbol to represent a local global passing a value from a 
Communications Controller time schedule to a point on a target UC on the 
Fieldbus of that Communications Controller. 

 

Place a wide time schedule global on the drawing area (in other words to place 
on the drawing area a symbol to represent a wide time schedule global passing a 
value from the ARCnet to a point on the target Field Controller.  

Place a Smart input local global on the drawing area  (in other words to place on 
the drawing area a symbol that represents a Smart global passing a value to the 
Communications Controller for processing.  

Place a Smart output local global on the drawing area (in other words to place on 
the drawing area a symbol that represents a Smart global receiving results from 
the Communications Controller.  
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Local Globals 

Local globals 

Local globals are used to transfer point values between UCs, which are connected together on the same Fieldbus of a 
Communications Controller. They are also used to transfer Time Schedule results (on or off) from a Communications 
Controller to the Field Controllers connected to the Fieldbus of this Communications Controller. There can be up to 255 
local globals on a Fieldbus. Details of all of the globals on a Fieldbus are maintained by the Communications Controller. 

Note:  Any of the points on a UC32 may be globalled, but only 255 local globals are available in total. 

Types of local global 

A local global can be one of three types: 

 An analog local global (point to point transmission): Source and target points are analog. 

 A digital local global (point to point transmission): Source and target points are digital. 

 A local time schedule global (time schedule to point transmission): The source is a Communications Controller 
Time Schedule and the target point can be analog or digital. 

 

  



 

 

302 © American Auto-Matrix MAN00058US rev 69 

M
A

N
0

0
0

5
8

U
S rev 6

9
 

How local globals transmit point and time schedule values 

The value contained by a local global may be passed in the Fieldbus in the following ways: 

One-to-one connection 

A source value (time schedule, point value) is transferred to a point in one target UC only. This is the common way of using 
local globals: 

The Source point is

in the strategy of this
controller

UCC4/3P/Kunitron

UC24PG-Runitron UC24PG-Runitron UC24PG-Runitron UC24PG-Runitron

Transmitting a point value using a

Local Global

UCC4

communications

controller

The Target point is in

the strategy of this
controller

UC Controllers

The UCC4 transmits

the point value on the

sub-network

The UCC4 extracts

the point value

from the strategy.
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One-to-N connection (Broadcast global) 

A source value (time schedule, point value) will be transferred to a point in all connected UCs on the Fieldbus (“N” 
represents the number of UCs on the Fieldbus). All strategies of the connected UCs must use the same point number for the 
shared information. This way of using local globals is effective only if the same or standardised strategies are used in all 
connected UCs on the Fieldbus. Globals that pass values in this way are called broadcast globals, as the point value is 
“broadcast” to the same point on every UC on the Fieldbus. 

The Source point

is in the strategy
of this controller

UCC4/3P/Kunitron

UC24PG-Runitron UC24PG-Runitron UC24PG-Runitron UC24PG-Runitron

Transmitting a point value using a

Local Broadcast global

UCC4

communications

controller

The Global carries

the information to

the UCC4 along

the sub-network

The point value is inserted into the strategies of

each of these controllersUC Controllers

The UCC4 transmits

the point value to a

specified point in each

of the UC controllers on

the sub-network

 

 

Note:  Points numbered 1 to 16 cannot be transferred using a broadcast global, even from a UC32 controller.   

 

Note:  Points numbered above 255 can be transmitted by Broadcast global, but will be ignored by any UCxx controllers 
on the Fieldbus. 
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Wide Globals 

Wide globals are used to transfer point values between UCs which are connected on different Fieldbusses in the Unet or 
ARCnet network. A Unet or ARCnet network can have up to 255 wide globals. 

Wide globals are also used to transfer time schedule results (on or off) from a Comms Controller to the Field Controllers 
connected to the Fieldbus of another Comms Controller. 

A Comms Controller can have up to 64 Wide Globals. 

A wide global is made up of three constituent parts; 

 a wide output global; 

 an ARCnet global; 

 a wide input global. 

The wide output global takes the value from the output of the source strategy, the Unet or ARCnet global passes the value 
on to the wide input global which then passes the value on to the input of the target strategy. 

 

Types of wide global 

A wide global can be one of three types: 

 An analog wide global (point to point transmission): Source and target points are analog. 

 A digital wide global (point to point transmission): Source and target points are digital. 

 A wide time schedule global(time schedule to point transmission): The source is a Comms Controller Time 
Schedule and the target point can be analog or digital. 
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Wide globals and the Unet / ARCnet 

A wide global is made up of three constituent parts: 

 A wide output global: A wide output global is joined to the source point in the source strategy. It takes the value 
of source point and sends it to the Unet or ARCnet. Each Comms Controller can send a maximum of 64 wide 
output globals to the Unet or ARCnet. 

 A Unet/ARCnet global: A Unet/ARCnet global takes the value from the wide output global and passes it on to the 
Comms Controller at the destination. The Unet or ARCnet can accommodate a maximum of 255 such globals. 

 A wide input globals: A wide input global is joined to the target strategy. It takes the point value from the Comms 
Controller and passes it on the target strategy. Each Comms Controller can receive a maximum of 64 wide input 
globals. 

 

Note:  When a Unet or ARCnet global is specified as the destination of a wide output global, it can only receive values 
from that wide output global. No other wide output global defined in the network can pass a value to such a 
Unet / ARCnet global. That is, the relationship between a wide output global and the Unet / ARCnet global 
which has been specified as its destination is unique. This means that although each Comms Controller in the 
network can have as many as 64 wide output globals, the total possible number of wide output globals on a 
network is 255, since that is the maximum number of Unet / ARCnet globals available. 

The relationship between a wide input global and the Unet / ARCnet global which is specified as its source does not have to 
be unique. Several wide input globals can have the same Unet / ARCnet global as their source.  
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How wide globals transmit point and time schedule values 

The value contained by a wide global may be passed across the network in the following ways: 

One-to-one connection 

A source value (time schedule, point value) can be transferred to a point in one target UC only on any Fieldbus that has an 
input global to receive it. This is the most common way of using wide globals. 
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One-to-N connection 

A source value (time schedule, point value) will be available to a point in all connected Field Controllers on any Fieldbus 
that has a wide input global set up to receive it (“N” represents the number of Field Controllers on the target Fieldbus). All 
Strategies of the connected Field Controllers must use the same point number for the shared information. This way of using 
local globals is effective only if the same or standardized strategies are used in all connected Field Controllers on the target 
Fieldbus. 

  

Note:  Points numbered 1 to 16 cannot be transferred using a broadcast global, even from a UC32 controller. 

 

Note:  Wide Globals cannot connect directly to hardware output points. 

 

Note:  Points numbered above 255 can be transmitted by Wide Broadcast global, but will be ignored by any UCxx 
controllers on the receiving Fieldbus. 
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Smart Globals 

Smart Globals are a special type of Local global, in that they operate within the Fieldbus of a single Comms Controller. The 
difference between a "Smart" global and a "Local" globals is that the Local global takes a single point value from one 
controller, and assigns its value to a single point in another controller. A Smart global, on the other hand, takes the values of 
one point number in several controllers and places the maximum, minimum, sum, and average of those values into 4 points 
in one controller. 

UCC4/3P/Kunitron

UC24PG-Runitron UC24PG-Runitron UC24PG-Runitron UC24PG-Runitron

Transmitting a point value using a

'Smart' Global

UCC4

communications

controller

UC Controllers

The UCC4 combines all of

the received values, and

places the results in the

values of 4 points in one

controller.

The UCC4 extracts the

value of the same point

in a number of strategies.

maximum

sum

average

minimum

 

The purpose of Smart globals is to simplify tasks such as  

 calculating the total airflow through a set of VAV boxes,  

 determining the total power usage in a number of meters,  

 switching on a boiler when heating demand in any Fancoil exceeds a set amount, 

 switching on all lights on a floor if any light switch is pressed 

etc. 

In the Engineering Centre, a Smart global is set up by first placing a Smart Output global module in a single strategy, and 
connecting it to a point. The point number of that connected point is the number of the point that will be read in each of a 
number of controllers, which are identified in the Smart output global module's dialog box. 

When the Smart input global module is set up, a Smart input global module can be added to any strategy on the Fieldbus, 
and connected to points within that strategy. Those points are where the results of the Smart global will be placed. 

An example of this procedure is illustrated in Using Smart Globals in strategies on page 342.  
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Including Globals in strategies 

Placing a global on the drawing area 

Like modules, to place a global on the drawing area proceed as follows: 

 Click a global button from the floating globals bar.  

 Click the drawing area.  

 In the global dialog box enter the required parameters for the global. (For a guide to defining globals, see Defining 
Globals on page 368).  

 Click OK. 

Like modules, each global is represented graphically by a symbol, which is positioned 
on the drawing area with its top left hand corner on the point where the mouse was 
clicked. The example shown is an analog input local global symbol. 

 

Joining globals to other modules 

To create a global, open the source and target strategies. Place the required global in the source strategy and join it to the 
source point in the same way as you would join two modules (see Joining modules in a strategy on page 82). Similarly, in the 
target strategy, insert the required global and join it to the target point.  

Using local globals in strategies 

A global consists essentially of two halves: 

 the source strategy, which includes the source point and the local output global that transmits the source point’s 
value to the Comms Controller 

 the target strategy, which includes the local input global that transmits the source point’s value to the target 
strategy and ultimately, the target point.  

To include a local global in a strategy, you must 

1. Create or open the source strategy (see page 310) 

2. Open the globals bar (see page 311) 

3. Choose a local output global from the floating globals bar (see page 311) 

4. Place the local output global on the drawing area (see page 311) 

5. Complete the local output global's dialog box (see page 312) 

6. Join the local output global symbol to the module (see page 316) 

7. Create or open the target strategy (see page 317) 

8. Select the target (see page 317) 

9. Choose a local input global from the floating globals bar (see page 317) 

10. Place the local input symbol on the drawing area (see page 318) 

11. Complete the local input global's dialog box (see page 319) 

12. Connect the local input global to other modules/points in the strategy (see page 320) 

When the steps above have been completed, the global is set up. Save both the source and the target strategies by clicking 
Save All from the File menu. 

Once saved, the global can then be downloaded and tested in the same way as you would any strategy. (See Downloading a 
strategy on page 181 and Testing a strategy with Scan Mode on page 199). 
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Local Global setup - Create or open the source strategy 

The first step is to create or open the strategy which will generate the value that is to be transmitted by the local global. 

If you are using an existing strategy to generate the source point, click the open button on the toolbar or click Open on the 
File menu. Then, in the Open dialog box, choose the file that you want to use as the source strategy 

If you do not have an existing file to work from, you must create the source strategy now (see How to Create a Strategy on 
page 152). 

To illustrate the use of a local global in a strategy, an example is shown below of a simple Boolean strategy. The output of 
the Boolean module is to be transmitted, via a local global, to another UC on the same Fieldbus. Since the point that is to be 
transmitted is a digital output point, a digital output local global is needed. 
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Local Global setup - Open the globals bar 

Click on the 

  

button in the toolbar, or select Globals from the view menu 

  

This opens the globals bar: 

  

 

Local Global setup - Choose a local output global from the floating globals bar. 

Choose a local global, either analog or digital depending on whether the point whose value being transmitted is analog or 
digital (in this example, a Digital Output is required) from the globals bar, as you would choose any module. 

  

 

Local Global setup - Place the local output global on the drawing area 

Place the local output global on the drawing area 
by clicking the drawing area once. 
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The local output Global’s dialog box will open: 

 

Note:  As there are two parts to every global (an output and an input global), there will also be two dialog boxes (one 
for the output and one for the input global). Both are identical except for the sections that list the Available 
Source Globals and Available Destination Globals.  

 

Local Global setup - Complete the local output global's dialog box 

Much of the information in the global’s dialog box is entered automatically by the Engineering Centre. Each section of the 
dialog box is described below, including those that are completed automatically by the Engineering Centre and those that 
you must complete yourself.  

 UCC4 

  

The Engineering Centre automatically enters in the UCC4 edit box the name and number of the targeted Comms Controller. 
In the example above, the Engineering Centre has entered the name of the Comms Controller – it is called 001-Rooftop. 

 

 Global number 

  

Each Comms Controller has a capacity to store 255 globals and each of those globals is given a unique number between 1 
and 255. This number is assigned automatically by the Engineering Centre, starting at 1, and cannot be edited. In the 
example above, the global being created is the third global in the Comms Controller, so it is given the global number 3. 

 

 Global description 
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The Engineering Centre automatically enters a name for each global – it includes the type of global and its number, e.g. the 
first local global would be called LocalGlobal_001, the first wide global would be called Global_001, etc. If you would prefer 
to use a name other than the one entered automatically by the Engineering Centre, simply select the text in the Global 
Description edit box and type in the name that you want to use. The example above shows the default name for the third 
local global in a Comms Controller, i.e. LocalGlobal_003. 

 

 Service period 

  

The Service Period (secs) is a time constant (measured in seconds) which determines how often the value of the local global 
is transmitted across the Fieldbus. The system guarantees that the global is updated no more frequently than this period, 
but it may be slower if there are many globals. Enter in the Service period (secs) edit box a value between 1 and 60. The 
service period in the example above is set at 5 seconds. 

If the Service period is set to 0, the global is updated as fast as possible by the Comms Controller, which is usually less than 1 
second. 

 

 

 

 Default global value 

  

The default global value is the value which the global will transmit to the target point if the source UC goes off-line, e.g. if 
there is a power cut or a break in the Fieldbus cable. You can specify a default global value by simply typing a value in the 
default global value edit box. This field is unavailable if the point whose value is being transmitted is a time schedule point. 
In this example, the default global value is OFF. 

 

 Current value 

  

When you are logged in, the Current value section displays the value of the source point (also the value of the target point). 
This value is entered automatically by the Engineering Centre and cannot be edited. In this example, the current global 
value is OFF. 

 

 Local Input details 

  

The Source details section displays the name and address of the UC that is the source of the global. It also displays the 
name and number of the source point. In this example, the source of the global is a UC called 001-02 AHU2, and its address 
on the Fieldbus is 2. The source point is called global target point and it is point number 17 on the UC. 
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 Local Output details 

  

The Destination details section displays the name and address of the UC that is the destination of the global. It also displays 
the name and number of the destination point. In this example, the destination of the global is a UC called 001-01 AHU1, 
and its address on the Fieldbus is 1. The source point is called global source point and it is point number 17 on the UC. 

 Available destination globals 

 

When you are creating a source global, you can choose from the list of Available destination globals an existing target 
strategy and make it the target of the global you are creating. This will only be the case if you began by creating the target 
global and then went on to create the source global (in this example the Global was not begun in that way, so the Available 
destination globals box is empty). Remember that one source global can be used for several target globals but each target 
global can have only one source global. 

The first time you create a local global on a particular Fieldbus, there will be no existing destination globals, so the Available 
destination globals list box will be empty. As you create more and more globals, any available destination globals will be 
listed here.  

When the global dialog box is complete, click OK. 

  

The output global’s symbol will be placed with its top-left hand corner on the point where the mouse was clicked. 
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Local Global setup - Join the local output global symbol to the module 

Join the local output global symbol to the output whose value the global will be transmitting. A global symbol is joined to a 
module in the same way that any 2 modules are joined (see Joining modules in a strategy on page 82). 
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Local Global setup - Create or open the target strategy 

The next step is to create or open the strategy that will receive the value transmitted by the local global. 

If you are using an existing strategy as the destination, click the open button on the toolbar or click Open on the File menu. 
Then, in the Open dialog box, choose the file that you want to use as the target strategy.  

If you do not have an existing file to work from, you must create the target strategy now. To create a new strategy, click the 
new button on the toolbar or click New from the File menu.  

 

Local Global setup – Select the target 

Select on the Site List the UC which is to be the destination of the 
global. As you are using a local global, the UC that you target will be on 
the same Fieldbus, i.e. it will be connected to the same Comms 
Controller as the source strategy. 

  

 

Local Global setup – Choose a local input global from the floating globals bar 

From the globals bar, choose a local global, analog or digital depending on whether the point whose value is being 
transmitted is analog or digital In this example a Digital input is required) by clicking its button with the mouse. In this 
example, you need a digital input local global. 
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Local Global setup - Place the local input symbol on the drawing area 

Place the local input global on the drawing area by clicking the drawing area. 

  

As it did when you created the source strategy, the Engineering Centre will open the local input global’s dialog box. 
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Local Global setup - Complete the local input global's dialog box 

Complete the local input global’s dialog box, as outlined in step 5. 

The Available source globals box lists any source globals you have created. This means that the same source global can be 
used repeatedly. Simply create a target strategy, and choose the existing source strategy from the list of available source 
globals. One source global can be used for several target globals but each target global can have only one source global.  

 

When the dialog box is complete, click OK. 

 

The local input global’s symbol will be placed with its top left-hand corner on the point where the mouse was clicked. 
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Local Global setup - Connect the local input global to other modules/points in the strategy 

If your target strategy is based on an existing strategy, there will already be modules on the drawing area. Place the global 
in a position on the drawing area where it can easily be joined to the other modules and points in the strategy. 

If the target strategy is not based on an existing strategy, i.e. it is a new strategy, you must create the target strategy by 
placing the required modules and input/output points on the drawing area and connecting them (see How to Create a 
Strategy on page 152). 

Join the local input global symbol to the point whose value the global will be setting.  

A global symbol is joined to a module in the same way that any 2 modules are joined (see Joining modules in a strategy on 
page 82). 

  

 

 

Add explanatory text if required: 
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Using Wide Globals in strategies 

A wide global is made up of three constituent parts: 

 A source strategy, which includes the source point (or time schedule) and a wide output global; 

 A Unet / ARCnet global, which passes the value of the wide output global across the Unet or ARCnet to the 
Comms Controller of the target Fieldbus; 

 A target strategy, which includes a wide input global, that passes the value from the Unet / ARCnet global to the 
target point. 

The procedure for including a wide global is the same as that for a local global. The difference lies in the completion of the 
wide output and wide input global dialog boxes. 

To include a wide global in a strategy, you must 

1. Create or open the source strategy (see page 322) 

2. Open the globals bar (see page 322) 

3. Choose a wide output global from the floating globals bar (see page 322) 

4. Place the wide output global on the drawing area (see page 323) 

5. Complete the wide output global's dialog box (see page 323) 

6. Join the Wide output global symbol to the module (see page 324) 

7. Create or open the target strategy (see page 326) 

8. Select the target (see page 326) 

9. Choose a wide input global from the floating globals bar (see page 326) 

10. Place the wide input symbol on the drawing area (see page 327) 

11. Complete the wide input global's dialog box (see page 328) 

12. Connect the wide input global to other modules/points in the strategy (see page 328) 

 

When the steps above have been completed, the global is set up. Save both the source and the target strategies by clicking 
Save All from the File menu. 

Once saved, the global can then be downloaded and tested in the same way as you would any strategy. (See Downloading a 
strategy on page 181 and Testing a strategy with Scan Mode on page 199) 
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Wide Global Setup - Create or open the source strategy 

The first step is to create or open the strategy which will generate the value that is to be transmitted by the local global. 

If you are using an existing strategy to generate the source point, click the open button on the toolbar or click Open on the 
File menu. Then, in the Open dialog box, choose the file that you want to use as the source strategy.  

If you do not have an existing file to work from, you must create the source strategy now. 

To illustrate the use of a local global in a strategy, this guide takes as an example a very simple Boolean strategy (shown 
below). The output of the Boolean module is to be transmitted, via a local global, to another UC on the same Fieldbus. Since 
the point that is to be transmitted is a digital output point, a digital output local global is needed. 

 

 

Wide Global Setup - Open the globals bar 

Click on the 

  

button in the toolbar, or select Globals from the view menu 

  

This opens the globals bar: 

  

 

 

 

 

Wide Global Setup - Choose a Wide output global from the floating globals bar. 

Choose a Wide output global, either analog or digital depending on whether the point whose value being 
transmitted is analog or digital (in this example, a Digital Output is required) from the floating globals bar, as you 
would choose any module. 
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Wide Global Setup - Place the Wide output global on the drawing area 

Place the Wide output global on the drawing area by clicking the drawing area once. 

  

The Engineering Centre will open the wide output global’s dialog box. 

 

Note:  As there are two parts to every global (an output and an input global), there will also be two dialog boxes (one 
for the output and one for the input global). Both are identical for the very last section – Connect To....  

 

Wide Global Setup - Complete the Wide output global's dialog box 

Much of the information in the wide global’s dialog box is entered automatically by the Engineering Centre. Each section of 
the dialog box is described below, including those that are completed automatically by the Engineering Centre and those 
that you must complete yourself.  

 Comms Controller Details 

Global number 

Each Comms Controller has a capacity to store 64 wide output and 64 wide input globals and each of those globals is given a 
unique number between 1 and 64. This number is assigned automatically by the Engineering Centre, starting at 1, and 
cannot be edited. In the example above, the global being created is the first global in the Comms Controller, so it is given 
the global number 001. 

Global type 

The Engineering Centre automatically enters the type of global that is being created.  

Comms Controller  

The Engineering Centre automatically enters in the Comms Controller box the name and number of the targeted Comms 
Controller.  

UC 

The Engineering Centre automatically enters the name and number of the targeted UC in the UC box.  

Point 

The Engineering Centre automatically enters in the Point box the name and number of the source point.  
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 ARCnet Details 

Number 

The ARCnet network has the capacity to store 255 globals. This number is assigned automatically by the Engineering Centre, 
starting at 1, and cannot be edited.  

Description 

The Engineering Centre automatically enters a name for each Unet/ARCnet global – it includes the type of global and its 
number, e.g. the first local global would be called LocalGlobal_001, the first wide global would be called Global_001, etc. If 
you would prefer to use a name other than the one entered automatically by the Engineering Centre, simply select the text 
in the Description edit box and type in the name that you want to use. 

Default value 

The default value is the value the ARCnet global will transfer to the target point if the source is unavailable, e.g. if there is a 
power cut or a break in the network cable. You can specify a default global value by ticking or clearing the default value 
check box. This field is unavailable if the point whose value is being transmitted is a time schedule point.  

Current value 

When you are logged in, the Current value section displays the value of the source point (also the value of the target point). 
This value is entered automatically by the Engineering Centre and cannot be edited 

Connect To... 

The Connect To... section shows all wide input globals, i.e., target globals, that have and have not been associated with a 
wide output global. If you want one of the available destinations to be the destination of the global that you are creating, 
click the Show Free Globals radio button to display the available Wide Input globals and click the required global so that it is 
highlighted in blue. If you do not want a highlighted destination to be the destination of the global that you are creating, 
click the Show Current Connections radio button and click the global in the Connect To... box to disconnect it. 

Note:  Clicking the Show all Wide Inputs (Connected and Free) radio button will display all globals, whether connected 
or not. 

When the global dialog box is complete, click OK. 

The output global’s symbol will be placed with its top-left hand corner on the point where the mouse was clicked. 

  

 

 

 

 

Wide Global Setup - Join the wide output global symbol to the module 

Join the wide output global symbol to the output whose value the global will be transmitting. A global symbol is joined to a 
module in the same way that any 2 modules are joined (see Joining modules in a strategy on page 82). 
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Wide Global Setup - Create or open the target strategy 

The next step is to create or open the strategy which will receive the value that is to be transmitted by the local global. 

If you are using an existing strategy as the destination, click the open button on the toolbar or click Open on the File menu. 
Then, in the Open dialog box, choose the file that you want to use as the target strategy.  

If you do not have an existing file to work from, you must create the target strategy now. To create a new strategy, click the 
new button on the toolbar or click New from the File menu.  

 

Wide Global Setup - Select the target 

Select on the Site List the UC which is to be the destination of the global. 
As you are using a local global, the UC that you target will be on the 
same Fieldbus, i.e. it will be connected to the same Comms Controller as 
the source strategy. 

  

 

Wide Global Setup - Choose a Wide Input Global from the floating globals bar 

From the globals bar, choose a wide global, analog or digital depending on whether the point whose value is being 
transmitted is analog or digital (in this example a Digital input is required) by clicking its button with the mouse.  
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Wide Global Setup - Place the Wide Input Global symbol on the drawing area 

Place the wide input global on the drawing area by positioning the pointer at the part of the strategy drawing where the 
Wide Input global symbol is to be inserted: 

  

And clicking the mouse button. 

As it did when you created the source strategy, the Engineering Centre will open the wide input global’s dialog box. 
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Wide Global Setup - Complete the Wide Input Global's dialog box 

The dialog box for a wide input global is the same as that for a wide output global, with the exception of the last section 
Connect To.... Complete the wide input global’s dialog box, as outlined in step 5, and follow the instructions below for 
completing the Connect To... section. 

 Connect To... 

The Connect To... section lists any wide output global, i.e., a source strategy, that has not been associated with a wide input 
global, i.e., a target strategy. If you want one of the available sources to be the source of the global that you are creating, 
click it so that it is highlighted in blue. If you do not want a highlighted source to be the source of the global that you are 
creating, click it again. 

When the dialog box is complete, click OK. 

  

The local input global’s symbol will be placed with its top left-hand corner on the point where the mouse was clicked. 

  

 

 

 

Wide Global Setup - Join the Wide Input Global to other modules/points in the strategy 

If your target strategy is based on an existing strategy, there will already be modules on the drawing area. Place the global 
in a position on the drawing area where it can easily be joined to the other modules and points in the strategy. 
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If the target strategy is not based on an existing strategy, i.e. it is a new strategy, you must create the target strategy by 
placing the required modules and input/output points on the drawing area and connecting them (see How to Create a 
Strategy on page 152). 

Join the local input global symbol to the output whose value the global will be transmitting.  

A global symbol is joined to a module in the same way that any 2 modules are joined (see Joining modules in a strategy on 
page 82). 
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Using Time Schedule globals in strategies 

In order to use a Comms Controller time schedule to send values to controllers on the Comms Controller’s Fieldbus, you 
must set up a Local Time Schedule Global in the strategies of relevant controllers in that Fieldbus. 

To broadcast the time schedule on the Comms Controller’s own Fieldbus, only local globals are needed. 

To Broadcast the time schedule to controllers on the Fieldbus of a different Comms Controller, Wide Time Schedule Globals 
are needed. 

To include a local time schedule global in a strategy, the following steps are required: 

 Create or open the source strategy (see page 330) 

 Open the target Strategy (see page 331) 

 Open the Globals bar  (see page 331) 

 Choose a global from the Globals bar  (see page 332) 

 Place the Local Time Schedule on the drawing area (see page 332) 

 Connect the local time schedule (see page 335) 

 

Local Time Schedule Globals - Create or open the source strategy 

The first step is to create or open the time schedule’s strategy. This is the strategy that will generate the value that is to be 
transmitted by the local time schedule global, i.e. the source strategy. 

If you are using an existing strategy to generate the source point, click the open button on the toolbar or click Open on the 
File menu. Then, in the Open dialog box, choose the file that you want to use as the source strategy. 

If you do not have an existing file to work from, you must create the source strategy now (see How to Create a Strategy on 
page 152). 
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Local Time Schedule Globals - Open the target strategy 

Open the strategy of the controller to which the values of the Comms Controller time schedule will be passed. (If the values 
are to be broadcast to all the controllers on the Fieldbus, open any one of the strategies – all procedures performed here 
will apply to all the other controllers). 

Open the strategy by clicking the  

  

button on the toolbar,  

or by selecting Open from the File menu. 

Either of these options will produce the generic Windows 
Open dialog box. 

  

 

Local Time Schedule Globals - Open the Globals Bar 

Click on the 

  

button in the toolbar, or select Globals from the view 
menu. 

  

This opens the globals bar: 

  

 

 

 

 



 

 

332 © American Auto-Matrix MAN00058US rev 69 

M
A

N
0

0
0

5
8

U
S rev 6

9
 

Local Time Schedule Globals - Choose a global from the floating globals bar. 

Choose a local time schedule global from the floating globals bar. In this example, a local time schedule global is needed to 
transmit the time schedule to a controller on the same Fieldbus. When the global button is clicked, it will depress, as shown 
below: 

  

 

 

Local Time Schedule Globals - Place the global on the drawing area 

Choose the local time schedule global button from the globals bar and place the pointer at the place in the drawing area 
where the local time schedule global symbol is to be placed. 

 

Press the mouse button.  

This calls the Local Time Schedule dialog box: 
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Under Global Details, you can give the time schedule 
global a number and a value. You can also specify 
whether the global is to be broadcast (see page 341) to 
the same point on all UCs on the same Fieldbus by 
checking or unchecking the Broadcast checkbox. 

  

Under Schedule Details, you can enter a name for the 
Comms Controller Time Schedule, as well as specifying 
the numbers of the points that will contain the on and 
off times for the schedule. 

 

 

  

Note:  The "On time" and "Off time" points are two analog outputs on the Time Schedule module. Their values are 
numbers in 'Decimal Time' format representing the time that the Time Schedule will next change from off to on 
("On time"), and the time when it will next change from on to off ("Off time"). 

 For example, if the time schedule will next change to 'off' at 15 minutes past 6pm, the value of the 'Off Time' 
point will be 18.25. 

The Engineering Centre automatically calculates and inserts the number of schedule blocks. 

Click the Insert Time Schedule button to call the 
Schedule Planner program,  

  

which allows you to enter on/off times and details of standard weeks and exceptions.  
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Enter details of the on/off times and exception weeks for the Comms Controller time schedule. For details of how to enter 
on/off times and exception weeks, see MAN-0054 Schedule Planner User Manual. 

When you have completed the entry of on/off times and exceptions, choose Exit from the File menu to close the Schedule 
window. You have now set-up the Comms Controller time schedule. 

  

Click OK to close the Insert Schedule Times window. The Local Time Schedule dialog box closes and the local time schedule 
global symbol appears on the drawing area. 
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Local Time Schedule Global - Connect the Local Time Schedule 

Connect the local time schedule global symbol to the point to which on/off values are to be passed. 

  

The global which will pass values from the Comms Controller time schedule to one or all of the controllers on the Fieldbus 
has now been set-up. 

The same procedure is used for setting up a Comms Controller time schedule and associated wide global. 
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In most cases, time scheduling information that affects Field Controllers on a Fieldbus is held in that Fieldbus’s Comms 
Controller. This gives a Cylon site great flexibility in terms of scheduling – for instance different floors of an office block can 
operate to different time schedules. 

However, there are times when controllers on one Fieldbus may need to follow the time schedules in the Comms Controller 
of another Fieldbus – for instance, the AHU controllers on the roof of a building might need to operate to the same schedule 
as the Boiler Room in the basement. 

In such cases, Wide Time Schedule globals are used. 

A Wide Time Schedule Global, like any other global, is a facility to pass information between controllers. It is “Wide” 
because the information it transmits can be received by any controller on any Fieldbus on the Cylon site’s ARCnet. 

A Wide Time Schedule Global (contained in the strategy) makes a local time schedule (contained in the same strategy) 
available to Field Controllers on other Fieldbusses. 

 

To set up a Wide Time Schedule global, proceed as follows: 

 Open or Create the Source strategy (see page 336) 

 Open the globals bar  (see page 337) 

 Choose Wide Schedule from the Globals bar  (see page 337) 

 Insert a Wide Time Schedule Global into the strategy  (see page 337) 

 Complete the Wide Time Schedule dialog box  (see page 338) 

 Open or Create the target strategy  (see page 338) 

 Insert and connect a Wide Digital Input Global into the target strategy  (see page 339) 

There can be more than one target strategy – any strategy containing a Wide Digital Input Global can be set up to receive 
the information transmitted by the Wide Time Schedule Global. Alternatively, on any Fieldbus a single Wide Digital Input 
Global can be used to receive the information from the time schedule, and then send it as a Broadcast Global to the same 
point every controller on that Fieldbus. 

 

Wide Time Schedule global - Open or Create the Source strategy 

The first step is to create or open the strategy which will generate the value that is to be transmitted by the local global. 

If you are using an existing strategy to generate the source point, click the open button on the toolbar or click Open on the 
File menu. Then, in the Open dialog box, choose the file that you want to use as the source strategy 

If you do not have an existing file to work from, you must create the source strategy now (see How to Create a Strategy on 
page 152). 
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Wide Time Schedule global - Open the globals bar 

Click on the 

  

button in the toolbar, or select Globals from the view menu 

  

This opens the globals bar: 

  

 

 

Wide Time Schedule global - Choose Wide Schedule from the Globals bar 

Choose a Wide Schedule global from the globals bar, as you would choose any module. 

 

 

Wide Time Schedule global - Insert a Wide Time Schedule Global into the strategy 

Place the local output global on the drawing area by clicking the drawing area once. 
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The Engineering Centre will open the Wide Time Schedule global’s dialog box: 

 

 

Wide Time Schedule global - Complete the Wide Time Schedule dialog box 
 

The Wide Time Schedule dialog box allows you to set up a global to make information from a local time schedule available 
to all Fieldbusses in the Cylon site. 

 Comms Controller details 

The wide time schedule global is first stored in the local Comms Controller to allow it access to the ARCnet for transmission 
to other Fieldbusses.  

The Comms Controller details section of the dialog lists information about how the Wide time schedule is stored. 

 ARCnet Details  

This section shows information about Wide Time schedule as it is broadcast on the ARCnet. 

 Connect to destination 

In this section, the Engineering Centre lists all the controllers containing strategies that are set up to receive information 
from the Wide Time Schedule. Engineering Centre gets this information from the site’s database, stored on the supervisory 
PC. 

From this section of the dialog box, it is possible to stop controllers from receiving the Wide Time Schedule’s information, 
by selecting the controller from the list and clicking the Disconnect button 

 

 Schedule details 

This section of the Wide Time Schedule dialog box shows details of the local time schedule that is to be transmitted by the 
Wide global. 

Wide Time Schedule global - Open or Create the target strategy 

Open the strategy of the controller to which the values of the Wide Time Schedule will be passed. This controller will be on 
a separate Fieldbus on the Cylon site. (If the values are to be broadcast to all the controllers on a Fieldbus, open any one of 
the strategies). 
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Wide Time Schedule global - Insert and connect a Wide Digital Input Global into the target strategy 

Select Wide Digital Input from the modules bar 

 

In the Target strategy (the strategy of the controller to which the values of the Wide Time Schedule will be passed), click at 
the position where the Input global is to be inserted: 

 

This opens the Wide Globals dialog box. 

Complete the Wide Input Globals dialog (see Wide Global Setup - Complete the Wide Input Global's dialog box on page 328), 
ensuring that the Unet/ARCnet details match the definition of the Wide Time Schedule that is to be received, and press OK.  

The Wide Digital Input global module appears in the drawing area: 

 

 

Join the Wide Digital Input global to the relevant point(s) in the strategy: 
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The target schedule is now ready to receive data from the Wide Time Schedule global:  
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Broadcast Globals 

In order to reduce the number of globals used on a Fieldbus, and to reduce the number of modules used in several 
controllers, it is possible to send information from a global to the same point in all controllers on the Fieldbus at once. This 
is referred to as a ‘Broadcast Global’ 

The main application for this is distributing Time Schedule information among a large number of controllers that have 
identical strategies – such as the controllers in VAV or Fan-Coil units. 

To set a global as a Broadcast global, tick the broadcast box. 

For Local Globals, this is found in the Local input Details 
part of the global’s dialog: 

 

When the broadcast box is ticked, the UC: box disappears.  

Enter the Point description and number in the remaining 
boxes. 

 

For Wide input Globals, this is found in the Local input 
Details part of the global’s dialog: 

 

When the broadcast box is ticked, the UC: box disappears.  

Enter the Point description and number in the remaining 
boxes. 

 

Information from the global will be written to every strategy on the Fieldbus, at the specified point. 

 Note:  The first time Broadcast is selected, Engineering Centre will enter 199 as the point number. Subsequent 
Broadcast Global point numbers decrement from this number. These point numbers become reserved for this 
global in all other controllers along the Fieldbus, and cannot be used in the strategies of those controllers. It is 
possible to manually select the Broadcast Global point number, but remember that the selected point number 
will then be inactive in all other controllers on the Fieldbus. 
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Using Smart Globals in strategies 

To use a Smart Global you must 

1. Create or open the source strategy (see page 342) 

2. Open the globals bar (see page 343) 

3. Choose a Smart output global from the floating globals bar (see page 343) 

4. Place the Smart output global on the drawing area (see page 343) 

5. Complete the Smart output global's dialog box (see page 344) 

6. Join the Smart output global module to a point in the strategy (see page 346) 

7. Create or open the target strategy (see page 347) 

8. Select the target (see page 347) 

9. Choose a Smart input global from the floating globals bar (see page 347) 

10. Place the Smart input symbol on the drawing area (see page 347) 

11. Complete the Smart input global's dialog box (see page 348) 

12. Connect the Smart input global module to other modules/points in the strategy (see page 349) 

When the steps above have been completed, the global is set up. Save both the source and the target strategies by clicking 
Save All from the File menu. 

Once saved, the global can then be downloaded and tested in the same way as you would any strategy. (See Downloading a 
strategy on page 181 and Testing a strategy with Scan Mode on page 199). 

 

 

 

 

Smart Global - Create or open the source strategy  

The first step is to create or open the strategy which will generate the value that is to be transmitted by the smart global. 

If you are using an existing strategy to generate the source point, click the open button on the toolbar or click Open on the 
File menu. Then, in the Open dialog box, choose the file that you want to use as the source strategy 

If you do not have an existing file to work from, you must create the source strategy now (see How to Create a Strategy on 
page 152). 
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Smart Global - Open the globals bar 

Click on the 

  

button in the toolbar, or select Globals from the view 
menu 

  

Smart Global - Choose a Smart output global from the floating globals bar 

 

Smart Global - Place the Smart output global on the drawing area 

Place the wide input global on the drawing area by positioning the pointer at the part of the strategy drawing where the 
Wide Input global symbol is to be inserted: 

  

And clicking the mouse button. 

The Engineering Centre will open the Smart output global module’s dialog box (the "Smart Source Global" dialog). 
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Smart Global - Complete the Smart output global's dialog box 

Some of the information in the global’s dialog box is entered automatically by the Engineering Centre. Each section of the 
dialog box is described below, including those that are completed automatically by the Engineering Centre and those that 
you must complete yourself.  

Choose the number of the global will collect the required 
values. This can be between 1 and 255. 

 

Set a name to be associated with that global 
number - this will help identifying the correct 
global number in the target strategy. 

 

The number, name and type of the source point whose value will 
be transmitted cannot be edited. It will be set when the Smart 
global module is graphically connected to a point in the strategy 
drawing. 

 

In the Source Details box, all of the controllers on the Comms 
Controller's Fieldbus are listed. Select those controllers whose 
points are to be used in calculating the output of the smart global.  

The values of the points in the selected controllers whose point 
numbers match the source point in the current strategy will be 
used. 

 

If the matching point in ALL controllers on the Fieldbus are to be 
used, then all of the controllers can be quickly selected by checking 
the select all controllers box beneath the controllers list. 

 

Set a Scan Interval for the smart global. This determines how often 
the Comms Controller will read the source point in each of the 
selected controllers, and is measured in seconds. 

 

Smart globals can generate a lot of network activity. The Service 
Priority setting determines how that activity interrupts other 
network activity governed by the Comms Controller.  
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A low setting for the Service Priority (slider towards the left side of its range) means that the Smart Global will be 
slowed if necessary to allow for other network activity. A high setting (slider towards the right side of its range) 
means that other network activity will be postponed until the smart global has completed its service procedure. 

 

When the Smart Output Global module's dialog (the "Smart Source Global" dialog) is complete, click on OK to save 
the settings and close the dialog. 

  

If you do not want to save the settings when the dialog closes, click Cancel. 
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Smart Global - Join the Smart output global module to a point in the strategy 

When the dialog is closed, the Smart Global module will be visible on the strategy drawing: 

 

Connect one of the module's inputs (analog or digital) to the required point in the strategy. A global symbol is joined to a 
module in the same way that any 2 modules are joined (see Joining modules in a strategy on page 82). 

 

 

When the module is joined to a point, that point will be visible in the dialog's source point settings if the dialog is opened by right-
clicking on the module: 

 

The source part of the Smart Global is now set up. 
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Smart Global - Create or open the target strategy  

The next step is to create or open the strategy that will receive the calculated result of the smart global. 

If you are using an existing strategy as the destination, click the open button on the toolbar or click Open on the File menu. 
Then, in the Open dialog box, choose the file that you want to use as the target strategy.  

If you do not have an existing file to work from, you must create the target strategy now. To create a new strategy, click the 
new button on the toolbar or click New from the File menu.  

Smart Global - Select the target 

Select on the Site List the UC which is to be the destination of the smart global. As a smart global is a type of a local global, 
the UC that you target will be on the same Fieldbus, i.e. it will be connected to the same Comms Controller as the source 
strategy. 

Smart Global - Choose a Smart input global from the floating globals bar 

 

Smart Global - Place the Smart input symbol on the drawing area  

Place the local input global on the drawing area by clicking the drawing area. 

  

As it did when you created the source strategy, the Engineering Centre will open the smart input global’s dialog box. 
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Smart Global - Complete the Smart input global's dialog box  

Select the number of the smart output global whose 
values are to be used. 

 

When you click in the name box, the name 
corresponding to the selected global number will 
appear. This shows that the correct global number 
has been selected. 

 

Select the controller into which the results of the 
smart global will be inserted. 

 

Note: If you would like the results of the smart global to be 
available in all of the controllers on the Fieldbus, tick the 
'Broadcast' box instead of selecting a controller name.  

Set default values for each of the smart global output 
points. These will be used if the smart global 
becomes unavailable for any reason. 

 

When the Smart Input global module's dialog box 
(the "Destination Details" dialog), click on OK to save 
the settings and close the dialog. 

If you do not want to save the settings when the 
dialog closes, click on Cancel. 
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Smart Global - Connect the Smart input global module to other modules/points in the strategy 

When the dialog is closed, the Smart Global module will be visible on the strategy drawing: 

 

If your target strategy is based on an existing strategy, there will already be modules on the drawing area. Place the global 
in a position on the drawing area where it can easily be joined to the other modules and points in the strategy. 

If the target strategy is not based on an existing strategy, i.e. it is a new strategy, you must create the target strategy by 
placing the required modules and input/output points on the drawing area and connecting them (see How to Create a 
Strategy on page 152). 

Join the required output of the Smart input global module (maximum, minimum, sum, or average) to the point where that 
value is required.  

A global symbol is joined to a module in the same way that any 2 modules are joined (see Joining modules in a strategy on 
page 82). 

 

 

When the module is joined to a point, that point will be visible in the dialog's output point settings if the dialog is opened by 
right-clicking on the module. 
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BACnet Globals 

Overview 

Global messages in the Cylon Unitron system, commonly called “Globals”, are a way of passing a value from one controller 
to another. A global allows a value from a Strategy on one controller to be passed on to another strategy on another 
controller. 

Cylon BACnet controllers implement Globals over BACnet for backward compatibility. However, this concept is not native to 
BACnet, and so it is recommended that where possible Strategies should be Engineered to use 3rd-party Blocks instead (see 
3rd Party point blocks – [Analog 3rd Party Analog] and [Binary 3rd Party] on page 666) 

Note:  Use of Global messages on BACnet Sites should be avoided. As a result, when BACnet Globals are added to a BACnet 
Strategy, the following warning will be displayed: 

  WARNING!  

  Globals will be deprecated in an upcoming version for BACnet strategies.  

  We advise that you use Third Party Blocks instead to communicate between controllers. 

 

There are two main types of globals used in the Cylon BACnet system: 

 Local Globals 

This type of global allows points to be passed between controllers on the same MS/TP bus. 

 Site Wide Globals  

This type of global allows points to be passed between controllers on different MS/TP bus via Ethernet connections between 
the BACnet routers above each MS/TP bus. 

 

Global Ranges 
 64 Local BACnet globals. 

 255 Fieldbus Local Globals 

 255 Site Wide Globals 
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BACnet Global Types 

 
Analog Destination 

 
Analog Source 

 
Digital Destination 

 
Digital Source 

 
Not Supported in Cylon BACnet system 

 
Not Supported in Cylon BACnet system 

 
Not Supported in Cylon BACnet system 

 
Analog Wide Broadcast Receiving 

 
Digital Wide Broadcast Receiving 
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How to add Globals to Strategies 

 Step 1: Add a BACnet Source Global 

To create a source BACnet Global, right-click the point that is to be transmitted,  and select Create New Global. 

 

This will attach a source Global block to the point. Depending on the type of point, a corresponding analog or digital type 
global will be assigned. In this example an analog BACnet Global block has been added: 

 

Note:  A “0” is displayed in the right top corner of the Global block. This is the Global number, and until the Source Global 
is linked to a destination a place holder value of 0 is assigned. 

Note:  The point itself must be exposed on BACnet or the Global will not function. By default the point will be exposed, 
but this can be disabled manually causing the Global to fail. To fix this, open Configure BACnet Points from the 
UC32 menu. 

 Step 2: Open Strategy of Destination Controller 

Open the Strategy into which the Global is to be received. Right-click on an input point of a block and select Link to Existing 
Point Global. 

 

This will open the Source Globals dialog: 
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 Step 3: Link the Source and Destination Globals 

In the Source Globals dialog you can choose to link the current destination to any Source Global that is present on the 
BACnet network. In the above example, the Source Global created in steps 1 and 2 is listed. Select this Global and click OK. 

A Destination BACnet Global block will be connected to the point: 

 

Editing the Properties of BACnet Globals 

In order to see the properties of a BACnet Global, select the BACnet Global block with a left-click and then right-click the 
block. This will open the relevant Global properties dialog: 

 

 Service Period 

The Service Period is the rate at which the Global is serviced. For example if the Global is has a service period of 10, the 
Destination Global will change to the source value every 10 seconds. If the service period is set to 0 the destination value 
will change to the source values as quickly as the controller can process this action. 

 Enable COV 

The Change of Value parameter allows the Destination Global to be updated only when the value at the source changes by 
a certain value. By default the Change in Source Value attribute is set to 1, therefore if the Enable COV checkbox is checked 
then the destination value will only change when the source changes by 1 unit. 

 Write Priority 

The Write Priority parameter can also be changed. By default it is set to 7. 

Note:  On Wide Globals, this parameter does not affect the priority at which the value is written. All Wide Globals are 
written at priority 16. 

  



 

 

354 © American Auto-Matrix MAN00058US rev 69 

M
A

N
0

0
0

5
8

U
S rev 6

9
 

Adding a Global between Different Subnets 

You can also add Globals between controllers on different subnets. However, the process is slightly different. After the Source 
Global has been added, instead of adding a Destination Global in the standard way a Wide Broadcast Receiving Global 
must be added to the Strategy on the target subnet. 

  

When the Wide Broadcast Receiving Global is added to the destination Strategy, a prompt requiring a name will be 
displayed. Enter an informative name here and click OK.  

A new block is added to the Strategy: 

 

Right-click on the block and select link. A dialog box will appear with a list of source Globals from different subnets. Select 
the required Source Global and click OK. 

 

The Global is now linked, and will start operating. 

To view details of the Global, right-click on the Destination Global block, and select Properties. The relevant Properties 
dialog will appear:  
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Note:  All Wide Globals are written at priority 16. For Wide Globals, the Write Priority parameter does not affect the 
priority at which the value is written, and is merely reflected in the Strategy module’s Pr output.  

  To avoid this issue, it is recommended that 3
rd

-party Blocks should be used instead of Globals on BACnet Sites 
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Testing globals 

Testing globals  

To test a global means to check that it is passing the values it was defined to pass. This can be done by observing the operation of 
the global in scan mode, which allows you to observe the changing values in a strategy in real-time. See How to test a global: on 
page 356. 

How to test a global: 

Log in by choosing Login from the File menu  

or by clicking the login/logout button on the toolbar so that the 
gate is closed as shown below: 

  

 

Download the strategy by choosing Download from the 
Communications menu : 

or by clicking the download button on the toolbar: 

  

 

For further details of automatic download and automatic on-line download, see Downloading a strategy on page 181 and 
Testing a strategy with Scan Mode on page 199. 

Select the Module Setup menu item from the Display menu  
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and ensure that the Display Point Values and the Display 
Constant Values check-boxes are checked. 

 

Activate scan mode by choosing Scan from the Communications 
menu : 

or by clicking the scan button on the toolbar.  

  

 

For more information on scan mode, see  Testing a strategy with Scan Mode on page 199. 

Viewing the strategy in scan mode, you will be able to see whether the global is passing the correct value to the correct 
point(s). 
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An example of testing the operation of a local global in scan mode 

In the following example, an analog local global is set-up to pass values from point 1 on UC number 1 on the Fieldbus: 

 

to point 22 on UC number 4 on the same Fieldbus: 

 

 

These strategies have been downloaded to their respective controllers. 
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How to test the operation of this global using scan mode: 

Log in by choosing Login from the File menu  

or by clicking the login/logout button on the toolbar so that the 
gate is closed as shown below: 

  

 

Open the strategy for the source controller. 

  

 

Ensure that variable and constant values are shown on the modules, by choosing 
Module Setup from the Display menu …. 
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… and checking Display Point Values in the Screen Text tab. 

  

 

Activate scan mode by choosing Scan from the 
Communications menu…. 

…or by clicking the scan button on the toolbar.  

  

  

The title bar colour changes to red, and the menus are reduced to Stop Scan and Window.  

You will see the values on screen being updated as each block in the strategy is serviced. The status bar tells you which 
block is currently being serviced.  

When all the blocks have been serviced, check that the analog output local global contains the value you wish to pass, which 
in this example is 18.00. 
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When you are certain that the analog output local global is functioning correctly, 
click Stop scan to deactivate scan mode. 

  

Open the strategy for the target controller. 
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Ensure that variable and constant values are shown on the 
modules, by choosing Module Setup from the Display 
menu …. 

  

… and checking Display Point Values in the Screen Text 
tab. 

  

 

Reactivate scan mode by choosing Scan from the 
Communications menu…. 

…or by clicking the scan button on the toolbar.  

  

 

You will see the values on screen being updated as each block in the strategy is serviced. The status bar tells you which 
block is currently being serviced.  
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When all the blocks have been serviced, check that the analog output local global contains the value you wish to pass, which 
in this example is 18.00. 

 

When you are certain that the analog input local global is functioning correctly, click 
Stop scan to cancel scan mode and to return to the Engineering Centre standard 
window.   
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Starting Globals 

Starting globals (sending set-up) 

Starting globals means configuring the Comms Controller to service the already downloaded globals. The Comms Controller 
reads the values of source points and/or source schedules and sends them to the configured target points. 

How to start globals 

To start a global operating, so that it passes information between controllers, you must: 

1. Start the strategy in the target Field Controller (see page 364) 

2. Call the Comms Controller setup dialog box  (see page 364) 

3. Complete the Comms Controller setup dialog box  (see page 365) 

4. Confirm the settings in the Comms Controller dialog box   

Starting globals - Starting the strategy in the target UC 

Log in to the Engineering Centre and start the strategy in the target UC by selecting UC Setup from the UC menu. At least 
one module in the target UC must be serviced for point values to be changed via globals in this UC. 

Starting globals - Calling the Comms Controller Setup dialog box 

Select Setup from the UC32.net or UCC4 menu to call the 
Comms Controller Setup dialog box. 
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Starting globals - Completing the Comms Controller Setup dialog box 

The following points should be remembered when completing the Comms Controller Setup dialog box: 

 All Field Controlles which are involved in the global transmission must be entered in the Comms Controller Setup. 
If a Unet or ARCnet is used for transmitting wide globals, the Comms Controllers involved must be entered in the 
Comms Controller Setup too. 

 The globals must be entered in the Comms Controller Setup to be activated. 

The Comms Controller Setup dialog box has the following sections: 

 Composed 

The current time and date from the PC will automatically be placed in the Composed section to indicate at any subsequent 
uploading when the strategy was started. 

 User ID 
In the User ID section the application engineer can enter a special character to indicate at any subsequent uploading who 
has started the strategy. 

 Network Details 
The Network Details section has subsections which must be completed to activate the globals: 

 UCs on Sub-net 
Enter the number of UCs on the Fieldbus in the UCs on Sub-net field. This will enable communication with all UCs connected 
to the Fieldbus. For example, entering “6” in the UCs on Fieldbus field enables communication with the UCs with IDs in the 
range 1 to 6. 

 Local Globals 
Enter the number of configured local globals in the Local Globals field. For example, entering “23” in the Local Globals field 
activates the local globals numbered 1 to 23. 

 Wide Input Globals 
Enter the number of configured wide input globals in the Wide Input Globals field. For example, entering “5” in the Wide 
Input Globals field activates the wide input globals numbered 1 to 5. 

 Wide Output Globals 
Enter the number configured wide output globals in the Wide Output Globals field. For example, entering “6” activates the 
wide output globals numbered 1 to 6. 

 Nodes on Unet / UCC4s on ARCnet 
Enter the highest Comms Controller ID number of the Comms Controllers connected to the Unet or ARCnet in this field. This 
will tell the target Comms Controller the maximum address of controllers on the Unet or ARCnet. For example, entering “3” 
configures it to communicate with Comms Controllers with IDs in the range 1 to 3. 

 Current Status 
This section keeps you updated about the progress of the uploading or downloading procedure. 

 Send 
Click to download set-up to the Comms Controller. 

 Receive 
Click to upload the most recently sent set-up from the Comms Controller. 

 Cancel 
Click to close the dialog box. 

 

Starting globals - Confirming the settings in the Comms Controller Set-up dialog box 

Click on Send to confirm the settings which have been entered in the Comms Controller Set-up dialog box. A message 
appears in the Current Status box to indicate whether the transmission of the Comms Controller set-up block was 
successful. The following message indicates that transmission was successful: Setup sent successfully. 
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The possibility of errors when starting globals 

The following possible sources of error exist: 

 Wrong numbers for points, UCs, Comms Controller and Unet/ARCnet globals. 

 Globals not being activated, caused by incorrect or insufficient Comms Controller set-up. 

 Strategy not being activated in the target Comms Controller, caused by incorrect or insufficient UC Set-up.  
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Managing Global Files 

Saving globals 

Globals are saved when the strategies that contain them are saved. To save a strategy, click the save button on the toolbar 
or choose Save from the File menu. For further details on saving a strategy, see Saving Files on page 62. 

 

Deleting globals 

To delete a global select it on the drawing area, in the same way that you would select a module, and press the Delete key 
on the keyboard. 

 

Downloading globals 

Globals are downloaded by downloading the strategies that contain them. If automatic download (see page 182) has been 
not been enabled, then the controller’s memory must be wiped before downloading, and set-up must be sent to the 
controller after downloading, so that the downloaded blocks will be serviced. See Sending information to a Field Controller 
on page 258 and Sending information to a Communications Controller on page 255 for further details of memory wipes and 
sending set-up. 

 

Uploading globals 

Globals are saved and implemented as parts of strategies. They can be uploaded by uploading the Strategies in which they 
are implemented, as long as they are connected to other modules in the strategy.  

For details of how to upload a global, refer to Uploading from a Communications Controller - globals on page 276. 
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Defining Globals in a strategy 

Defining globals 

Globals are defined by entering the required parameters either 

 in their individual dialog boxes (see below) or 

 in the Globals editor (see Defining Globals in the Global Editor on page 369).  

When a global is placed on the drawing area, the Engineering Centre automatically displays the dialog box for that global. 
Alternatively, right click in the global symbol on the drawing area to view its dialog box.  

If you require a broadcast global is required, that is, a global that passes a value to the same point on all UCs on a target 
Fieldbus, you can specify this in the global dialog box by checking the Broadcast checkbox. This will then reserve that point 
for receipt of values from the global on all UCs on that Fieldbus. 

Note:  When you are setting up a global broadcast you must ensure that the point on each of the target Fieldbus UCs 
to which the value will be passed is available. In other words, you must ensure that they are not already being 
used by another strategy. If any of the points to which the broadcast global value will be passed is already in use 
in a strategy, then there may be a conflict between the value of the point in its existing strategy and the value 
being passed to it by the broadcast global. One option is to create a strategy for each of the UCs on the target 
Fieldbus, place in each strategy an input global, check the Broadcast checkbox in the global dialog box and, by 
dragging the mouse, join each global symbol to the same target point in each strategy. 

How to define local output globals 

To define a local output global, you must 

 Place the local output global on the drawing area (see page 311) 

 Complete the local output global's dialog box (see page 312) 

How to define local input globals 

To define a local input global, you must 

 Place the local input symbol on the drawing area (see page 318) 

 Complete the local input global's dialog box (see page 319) 

How to define Wide Output globals 

To define a wide output global, you must  

 Place the Wide output global on the drawing area  (see page 323) 

 Complete the Wide output global's dialog box  (see page 323) 

How to define Wide Input globals 

To define a wide input global, you must 

 Place the Wide Input Global symbol on the drawing area  (see page 327) 

 Complete the Wide Input Global's dialog box  (see page 328) 
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Defining Globals in the Global Editor 

The Global Editor 

The Global Editor is a tool for managing all of the globals in a Comms Controller at once. It displays all of the globals in a 
single Comms Controller, allows them to be edited, and allows new globals to be defined. 

 

The Global Editor is displayed when 'Global Editor' is 
selected on the Engineering Centre's File menu. 

 

A 'site list' on the left-hand side of the editor allows 
you to target a Comms Controller... 
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...and the globals in that Comms 
Controller will be listed on the 
right-hand side of the editor. 

 

Some of the entries in the globals 
list may be displayed with a white 
background, 

 

While others may have a shaded 
background. 

 

The shaded background indicates that the global was originally created in a strategy drawing. Shaded globals cannot be 
edited in the Global Editor, because if they change then the strategy drawings also have to change. 
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Defining Local Globals in the editor 

To define a new global simply enter the following details in any blank line on the globals list: 

Note:  These parameters are identical to those set in the Global dialog box (see pages 312, 319, 323, and 328) 

 

Global Type: 

 

A Name for this global: 

 

If the global type is analog or 
digital, the Src Name field is used 
to select the UC containing the 
globals source point. If the 
schedule global type has been 
selected, this field is to select the 
schedule. 

 

If the global type is analog or digital 
you must specify if the source type 
is a virtual or hardware point. 
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Source point Name and Number: 

For convenience, a Src Pt Name 
column is provided. The source 
point for the global can be selected 
from a list of named globals, and its 
number will be entered in the Src 
No column. 

 

If the point name has not been 
allocated a name then the Src no 
must be entered manually. 

 

 

Note:  The source number is the most important information in the definition of the Global's source point. The point 
name is not stored in the Comms Controller, it is cross-referenced from the Cylon database. 

The Field Controller containing the 
global's destination point 

 

Destination point Name and Number: 

For convenience, a Dest Pt Name column 
is provided. The destination point for the 
global can be selected from a list of 
named globals, and its number will be 
entered in the Dest Point No column. 

 

If the point has not been allocated a name then the Dest Point no must be entered manually. 

Note:  The source number is the most important information in the definition of the Global's source point. The point 
name is not stored in the Comms Controller, it is cross-referenced from the Cylon database. 
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The Default Value for the global 

 

How often the  value of the global should be 
transmitted across the sub network: 

 

If the global is a Time Schedule, the time of day 
that the schedule will next be activated (go 
"On"),  

 

and the time of day at which it will next be 
deactivated (go "Off") are sent as decimal 
analog values.  

 

The points to which those values will be sent can be set in the global editor.  

 

Defining Wide Globals in the editor 

Clicking on the Wide Input and Wide Output tabs at the top of the Global Editor allow you to define or set up Wide globals 
in a similar manner to the Local Globals described in Defining Local Globals in the editor on page 371. 

 

The Global type, number, and name, and the source point parameters are set as in the local global list, but there are no 
destination or time schedule point parameters. 

 

 

 

 

 

 

Editing globals in the editor 

Globals can be edited in the same way that they are defined in the editor (see Defining Local Globals in the editor on page 
371), as long as they were not originally created as part of a strategy drawing (i.e. they must not be 'shaded' in the global 
list). 

Saving changes made in the editor 



 

 

374 © American Auto-Matrix MAN00058US rev 69 

M
A

N
0

0
0

5
8

U
S rev 6

9
 

To save the changes made in the Global 
Editor, select Save from the File menu. 

 

If you try to close the editor while there 
are unsaved changes the Save Globals 
dialog will open. 

This dialog gives you the option of saving 
some or all of the unsaved changes in the 
editor. 

Select the items in the field in the middle 
of the dialog and click the Yes button to 
save the information. 

 

 

 

  



 
 

 

SECTION 11 :  TIME SCHEDULES 
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Time Schedules - Overview 

Comms Controller time schedules contain on/off times for each day in a week as well as for exception periods. They are 
saved and serviced in Comms Controllers.  

Details of on/off times and exception periods for a Comms Controller time schedule are entered in the Schedule Planner 
program. For further information on the Schedule Planner program, see MAN-0054 Schedule Planner User Manual. 

Before on/off times can be entered into the Comms Controller time schedule, the time schedule must first be defined. This 
is done in the Engineering Centre. 

Comms Controller time schedules must pass on/off times to the controllers connected to the equipment to which they 
apply, so a global must be set-up to pass the time schedules values to the correct controller. In the Engineering Centre, the 
global is set-up at the same time as the time schedule. 

Note: Time schedules operate according to the time in the controller (UC32/UCU/UC or UC32.net /UCC4) clock, not 
the clock of the Supervisory PC . 

Setting up a Comms Controller time schedule 

Before you define a Comms Controller time schedule, you must first decide if it will be used to pass on/off times to one or 
all controllers on its own Fieldbus, or to one or all controllers on a different Fieldbus.  

 If the values are to be passed to one or all controllers on the Fieldbus of the Comms Controller in which the time 
schedule is being set-up, you must set-up a local time schedule global (see Using Time Schedule globals in 
strategies on page 330) to pass the values. 

 If the values are to be passed to one or all controllers on the Fieldbus of a different Comms Controller to the one 
in which the time schedule is being set-up, you must set-up a wide time schedule global to pass the values. 

The procedure for setting up either of these types of time schedule global and associated time schedule is the same.  

How to set up a Comms Controller time schedule 

For details of how to use time schedule globals in strategies, refer to Using Time Schedule globals in strategies on page 330. 

 

Downloading Comms Controller time schedules 

The Comms Controller time schedule will be downloaded to the Comms Controller for which it was defined when the strategy in 
which the global is placed is downloaded to its controller. If automatic download has been enabled (see Downloading a strategy 
using Automatic Download on page 182), it is not necessary to wipe memory before downloading, nor to send set-up after 
downloading. 
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Deleting Comms Controller time schedules 

Comms Controller time schedules may be deleted by wiping the memory of the Comms Controller to which it has been 
downloaded. For information on wiping the memory of a Comms Controller, see Wiping a Communications Controller's 
memory on page 255. 

For UCC4-type Comms Controllers, Time Schedules can be removed from the Cylon database by targeting a particular 

UCC4-type comms controller, and selecting Remove Time Schedules from the UCC4 menu. 

This opens a list of all the time schedules in the Comms 
Controller.... 

 

....from which you can select one of the files to be 
deleted. 

 

Pressing the delete button... 

 

...removes the item from the list of Schedules. 
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Starting Comms Controller time schedules 

A Comms Controller time schedule will start to pass values to the target controller as soon as the target controller begins to 
service the strategy. If Automatic Download (see  Downloading a strategy using Automatic Download on page 182) has been 
enabled, the strategy will be serviced immediately on being downloaded. For information on downloading strategies, see 
Downloading a strategy on page 181. 

Adjusting time schedules  

A Comms Controller time schedule may be edited by using the Schedule Planner program. See MAN-0054 Schedule Planner 
User Manual for details of how to use the Schedule Planner program. 

 

How UC time schedules are updated by the Comms Controller time schedule 

With the use of time schedule local globals is also possible to update UC time schedules on the Fieldbus from a Comms 
Controller time schedule. The update can either be sent to one time schedule on the Fieldbus or to all time schedules on the 
Fieldbus at the specified block number.  

UC time schedules linked to a Comms Controller time schedule by a local global are updated by the Comms Controller time 
schedule in two ways: 

 When changes made to the Comms Controller time schedule are downloaded, the UC time schedules linked to it 
are updated immediately. 

 UC time schedules are updated by the Comms Controller time schedule to which they are linked on a daily basis. 

Daily updating of UC time schedules 

The daily update takes place as follows: 

 At 00.01 each day, all local globals are examined to see if they have been defined as time schedule local globals 
and have 255 entered in both the On and Off Time fields of the Point Numbers for Next Schedule section of their 
definition. 

 When such a local global is found, the list of Comms Controller time schedules is searched for the first exception 
block (if any), of the specified time schedule, which will be active on the current day -2+7 (that is, in five days’ 
time).  

 The first such exception block found is downloaded to the linked UC time schedule(s) as both the first and second 
set of on/off times for that day.  

 If no exception block is found, the first standard week defined in the Comms Controller time schedule is searched 
for the settings for the current day -2 and these are downloaded to the corresponding day of the linked UC time 
schedule(s) as the first set of on/off times.  

 If a second standard week has been defined in the Comms Controller time schedule, the settings for the current 
day -2 are downloaded to the corresponding day of the linked UC time schedule(s) as the second set of on/off 
times. 

The two day time lag incorporated into the updating procedure ensures that this type of updating does not affect the 
performance of any Optimizers on the site. 

 



 
 

 

SECTION 12 :  DATALOGS 
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Datalogs - Overview 

Datalogs are a feature of Field Controllers, which allows point values in a controller to be recorded over a period of time. 
The recorded data can be later retrieved, displayed, and analyzed with the Datalog Manager module. 

Analysis of logged data is often useful in optimizing the effectiveness of a Cylon site’s controllers and strategies. 

 

The datalog function module 

The collection of point values in a datalog is implemented into a strategy by using the datalog function module. 

 

 

Restrictions on the use of datalogs 

The number of datalogs permitted in a strategy depends on the type of controller in which the strategy will be used. 

Some controllers, such as the UC24PG-R can have up to 16 datalogs, with a maximum of 192 entries per datalog. Other 

controllers, such as the UCU10VAV, have up to 4 datalogs, with a maximum of 102 entries in each. A UC32.24 can store up 
to 1023 entries in a standard datalog, and 512 entries in a time stamped datalog. You can determine the number of datalogs 
that a particular controller can hold using the Managers dialog box, available from the View menu. 

 

Standard Datalog sampling period 

Each standard datalog module can be configured with an individual time constant for sampling data. To make the evaluation 
of datalogs easier it is advisable to use the same time period for sampling data in all datalog modules. A sampling period of 
15 minutes is suggested. 

The period of time over which the datalog samples is equal to the product of number of entries (104 or 192) and the 
sampling frequency. For example, a datalog module on a UC16PG with a sampling frequency of 15 minutes (900 seconds) 
will take samples for (192 X 15) minutes =  48 hours. 

 

Time Stamped Datalogs 

A time stamped datalog records the time and date at which a value was recorded, along with the value. A logging interval is 
not set - instead the value of the specified point is recorded:  

 when the digital trigger point changes state 

 when a logged digital point changes state 

 or when a logged analog point changes state by more than a predefined amount from the last value that was 
logged for it.  

There are several situations when such a datalog would be particularly useful. For instance, if you log the value of a point 
with a conventional datalog and set the logging interval to 10 minutes, the value of the point may change significantly and 
return to its original value over a period of 3 minutes, and that change might occur during the 10 minutes when the datalog 
is not recording. If so, the event would not be logged at all. On the other hand, if the logging interval was 30 seconds, the 
event would be recorded - but the datalog could fill up and the event could be 'flushed' before it is viewed. If so, the event 
would also be lost. In both of these cases, a time stamped datalog could record data over the period of the event only, so 
that the necessary data is recorded without the datalog filling up. 
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The other primary use of a time stamped datalog is to log conditions that surround an event. For instance, when a window 
is opened, the temperature of the surrounding area could be logged to see how it reacts. 

 

 

Datalog sampling of digital and analog point values 

Both digital and analog point values can be sampled. The datalog module has a digital input and an analog input. 

   

   

 



 

 

382 © American Auto-Matrix MAN00058US rev 69 

M
A

N
0

0
0

5
8

U
S rev 6

9
 

How to define a datalog 

To define a datalog, proceed as follows: 

1. Place the datalog on the drawing area (see page 382) 

2. Call the Datalog Definition dialog box (see page 382) 

3. Complete the Datalog Definition dialog box (see page 383) 

4. Confirm the datalog definition (see page 383) 

Defining a datalog - Place the datalog on the drawing area 

The datalog function module can be selected from the Statistic modules bar, pasted onto the drawing area, and joined to 
other modules in the strategy in the same way as any other function module. For further details of this procedure, see 
Creating a strategy in Chapter 4 Strategies in this manual. 

Defining a datalog - Call the Datalog Definition dialog box 

Once the Datalog module has been placed on the drawing area, the datalog can be defined. To define the datalog, call the 
Datalog Definition dialog box by clicking on the symbol with right mouse button. The dialog that will be displayed depends 
on whether a UC32 or UC/UCU controller is targeted. 

UC32 Datalog Definition 
dialog: 

 

UC or UCU Datalog 
Definition dialog: 
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Defining a datalog - Complete the Datalog Definition dialog box 

The Datalog Definition dialog box has the following sections: 

Block Number 

This is the number of the block occupied by the Datalog module. This number is allocated automatically by the Engineering 
Centre. 

Datalog Number 

The Datalog Number field shows the number of the selected datalog module. Inside a UC datalogs are numbered 1 to 16. 
The datalog number is selected automatically by the Engineering Centre. 

Datalog Description (UC32)/ Datalog Name (UC and UCU) 

In Engineering Centre, a datalog is automatically given the same name as the point to which it is joined. 

The name can be edited if required, by changing the text in the Datalog Description Datalog Name field of the Datalog 
Definition dialog box. 

Log Point (UC32)/Point to Log (UC and UCU) 

The Point to log field displays the number of the point to be logged. This can be a digital or analog point and is joined 
graphically to the datalog module. 

Datalog Enable (UC32)/Enabling Point (UC and UCU) 

The Enabling Point is a digital point, connected to input E of the datalog module, which restarts the sampling process if its 
value changes from 0 to 1. If this point is not connected the datalog samples continuously. In normal applications this input 
is not used. 

Log Trigger Point (UC32) 

In Time stamped datalogs, it is possible to record data when this trigger point changes. If the trigger point is not connected, 
logging occurs according to the 'Minimum Change' parameter. 

Datalog Point Type (UC32)/ Point Type (UC or UCU) 

The type (analog or digital) of the point being sampled is shown in the Type of Point to Log. Once the Point to Log has been 
entered, this section is set automatically. 

Update Interval 

The frequency of sampling (in seconds) is entered in the Update Interval field. 

Minimum Change for Analog Input (UC32 only) 

If the datalog type is set to 'Time Stamped', and if the type of point being logged is analog, it is possible to trigger a sample 
whenever the point value changes by more than a particular amount. This field specifies that amount of change. 

Advanced Options (UC32 only) 

Clicking on this button opens the Datalog Advanced Options dialog. This allows you to set the datalog length, the number of 
decimal places that will be used when the datalog is displayed on a keypad and how the changing of a trigger point will 
affect the recording of time stamped datalogs. 

Defining a datalog - Confirm the datalog definition 

Click on OK to confirm the datalog definition as set out in the Datalog Definition dialog box. The strategy must now be 
downloaded to the controller for the datalog to take effect. 
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Steps 1 to 4 complete the procedure for defining a datalog. 

 

 

Starting a datalog 

A datalog is part of a strategy and is saved with the strategy. The example below shows a datalog module linked to a 
strategy: 

 

Datalogs are started along with the rest of the strategy in which they are contained, when the strategy has been saved (see 
page 169), downloaded (see page 181), started (see page 196) and tested (see page 199) .  

Note:  If the block on which a datalog module is placed is downloaded again to the UC, the sampled data is deleted.  
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Viewing the contents of a datalog 

This is done on a PC running Cylon software. 

The Datalog Manager program is used to view or print out datalogs, on screen or printer, as text or graphics. Clicking on the 
Datalog Manager icon in the Command Centre program group starts the program. 

  

The Datalog Manager allows data from Field Controller datalogs to be viewed in a variety of ways: 

 The data can be listed as text. 

 A datalog can be viewed as a graph. 

 Information from multiple datalogs can be superimposed on one graph. 

 The status of data points can be viewed in real-time. 

 ‘Snapshots’ can be made of data from any set of analog points in a controller strategy. 

For further details on the display and printing of datalogs, see the Datalog Manager manual. 

Archived datalogs can be statistically evaluated by using programs like Microsoft Excel. This provides valuable information 
about the operation of the site. 

 

Archiving datalogs 

 

Archiving datalogs means storing them on the PC’s hard disk. The Reports program can be used to do this automatically, 
when triggered either by time or by event.  

For further details, see MAN-0044 - Reports Module User Manual. 

 

 
 
 
 

 

  





 
 

 

SECTION 13 :  ALARMS 
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Alarms - Overview 

Alarms are used by the Cylon system to alert site supervisors/engineers to any difficulties that may occur in a site. The Cylon 
system uses the Alarm Handler program to send alarm messages.  

An alarm message can be sent in a variety of ways – the most usual is to send the message to the supervisory PC, where it 
will appear on screen in a message window like the one below. Alarms can also be sent to printers, pagers, fax machines 
and via modems.  

The example below shows that at 11:28 a.m. on the 26
th

 January 1998, the Fieldbus of a Comms Controller called cellar 
went off-line. The message also shows that there is only 1 unacknowledged alarms, i.e. the Alarm handler program has sent 
just 1 alarm message to the supervisory PC which have not yet been read. To read any other alarms, click the Acknowledge 
this alarm button – this will close the active alarm message and display the previous unread alarm message. All UC alarms 
are assigned a priority, in the range 1 to 255. You can decide how alarms of different priorities are to be handled. For 
example, you may want the most important to be sent to an engineer via a pager, others to be sent to a printer, etc. 

 

 

Types of alarms 

There are two main types of alarms: 

 System alarms: If the problem originates in the Cylon system itself, e.g. a break may occur in the ARCnet network 
or a controller may go off-line, the alarm is said to be a system alarm. System alarms do not have to be set-up by 
the user, and always have priority 1. The example above is a system alarm, as it reports a controller going off-line.  

 Control alarms: If there is a problem implementing a control, for example the temperature in a particular area of 
a site exceeds its predefined level, the alarm is said to be a control alarm. These alarms are set-up by the user and 
may be assigned a priority in the range 1 to 255. 

All Comms Controller alarms are system alarms. UCs can send both system alarms and control alarms. 
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How to enable alarms: 

For alarms to function, they must first be enabled in the Configuration module.  

Run the Cylon Configuration utility (also called CCConfig) by 
choosing Configuration from the Cylon Engineering Centre group 
on the programs menu, or clicking the Configuration icon on the 

Cylon Engineering Centre toolbar 

 

 

Click on the System menu 

 

This will open the System Configuration dialog box.  

To enable alarms, click the Alarm Scanning Enabled check box. Once checked, this option will ensure that the Alarm 

Handler will process any control and system alarms that occur on the site.  

Click Save in the System Configuration box. 

Close down and restart the Engineering Centre. 

Note:  Alarm Scanning will not be enabled until the Cylon Engineering Centre or Unitron Command Centre is 
restarted. 

 

Setting up alarms 

To set-up a UC alarm, you must use the Engineering Centre to include an alarm module in the strategy that is downloaded 
to the particular UC. Details of how to do this are provided in the guide below. 

Comms Controller alarms are system and not control alarms, i.e. do not relate to the implementation of controls. They are 
predefined, and so (unlike UC alarms) they do not need to be manually set up. 
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How to set up a control alarm 

A control alarm is set-up by including the alarm module in a UC strategy. The alarm module is joined to a digital point. When the 
digital point has the value 1, an alarm present message is generated and sent to the Alarm Handler program. If the point value 
changes back to 0, an alarm end message is generated and sent to the Alarm Handler program. Along with the status of the digital 
alarm point and the alarm text, an analog point value can be displayed in the Alarm Handler program 

An alarm event is always represented by a value of 1 in the digital point connected to the alarm module in the strategy.  

To set up this strategy, proceed as follows: 

(for illustration, this procedure uses a simple example of a pump trip switch – see page 395) 

1. Create or open the strategy (see page 390) 

2. Select a target (see page 390) 

3. Choose the Alarm module from the statistics modules bar (see page 390) 

4. Place the alarm module on the drawing area (see page 390) 

5. Join the alarm module to the point it is monitoring (see page 391) 

6. Complete the alarm record dialog box (see page 391) 

Setting up alarms - Create or open the strategy 

If you want to include an alarm in an existing strategy, open the strategy by clicking the open button on the toolbar or by 
clicking Open on the File menu and completing the Open dialog box.  

If you are including an alarm in a new strategy, click the new button on the toolbar or click New on the File menu, and then 
add any required modules to which the alarm will be connected: 

 

Setting up alarms - Select a target 

To set a target for the alarm, select a controller from the Site List. 

Setting up alarms - Choose the Alarm module from the statistics modules bar 

Select the Alarm module from the statistics module bar by clicking it. 

 

 

Setting up alarms - Place the alarm module on the drawing area 

Click the drawing area to place the alarm module in the strategy.  

If you are using an existing strategy, the strategy’s modules will be on the drawing area. If you are creating the strategy from 
scratch, you must place and join the required modules on the drawing area. 
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Position the alarm module in a place where it can easily be joined to the point that it is monitoring.  

 

 

Setting up alarms - Join the alarm module to the point it is monitoring 

Use the mouse to drag a connection line between the point that is to be monitored by the alarm and the alarm module. 
(See Joining modules in a strategy on page 82). 

 

 

Setting up alarms - Complete the alarm record dialog box 

Right click the Alarm module symbol on the drawing area to open its dialog box. 
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The Alarm Record dialog box has the following sections: 

 

Block Number 

This is the number of the block occupied by the module. It is entered automatically by the Engineering Centre and cannot be 
edited. 

 

Input Point 

The number of the joined digital point which represents the alarm event will be displayed in the Input point field. Again this 
is entered automatically when you join the trigger point and it cannot be edited. 

 

Priority (1-255) 

Alarms can be sorted into 255 priorities. Priorities are allocated to all alarms, and all alarms of the same priority are treated 
as having the same importance. You should stipulate what priority is to be given to which alarm. System Alarms are all 
priority 1. The priority allocated to the alarm being defined is entered in the Priority (1-255) field. The alarm will remain at 
this priority unless changed in this dialog box. 

To save time, it is important to define the priorities before alarms are configured. Site-orientated alarm types should be 
grouped to be handled together by Comms Controllers and PCs. 
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Some possible ways of assigning priority to alarms are given below: 

 Different priorities for different parts of buildings/sites 

 Technical priorities assigned in order of importance: 

o Alarm contacts of fire/security systems 

o Disturbances, emergency contacts 

o Switches for maintenance, automatic, manual 

o Contacts for monitoring belts (ventilators) 

o States (for example, “Temperature out of Acceptable Range”) 

o Sensor Broken 

 Different priorities for repeated alarms and first alarms for any given event 

 Different priorities for dial-out-alarms and local alarms 

 Different priorities for alarms to be transferred by pager, fax, etc. 

 

Alarm Number 

A unique ID number is assigned to the alarm being configured in the Alarm Number field. This number must be unique in 
the UC. If the number is not entered, the alarm will not be seen by the Comms Controller. This means that the alarm will not 
work. 

 

Alarm Point 

The number of the analog point, which is joined to the alarm module, is displayed in the Alarm Point field. The value of this 
analog point will be displayed together with the text string in the alarm message. Whether or not this input of the module 
should be connected depends on the situation for which the alarm is being configured. 

 

Text 

In the Text field, a string of up to 9 characters can be entered. This will be displayed as the alarm message, if no alarm text 
has been configured in or downloaded to the Comms Controller. If the alarm is linked with existing alarm text strings in the 
Comms Controller, the string in the text field will be ignored. 

Note:  This short text string is used for test reasons. In real applications on site, it should be ignored. Alarm messages 
should be defined in Comms Controllers in real applications. 
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Start Alarm and End Alarm 

The Start Alarm and End Alarm drop-down lists show all of the Alarm text strings available in the Comms Controller to 
which the UC is connected. The text selected in Start Alarm is the text string in the Comms Controller that is sent to the 
Alarm Handler program when an alarm event occurs. The text selected in the End Alarm box is the text string in the Comms 
Controller that is sent to the Alarm Handler when the alarm event ends. These text strings are usually created and 
downloaded to the Comms Controller from the UC32.net menu or UCC4 Configuration program, but can also be created by 
typing in the Start Alarm and End Alarm boxes in the Alarm Record dialog. 

Note:  When setting up Alarm strings, it is necessary to send the Site ID to all Comms Controllers on the site, using the 
UC32.net menu Send Site option or the UCC4 Configuration program. 

For time-saving reasons it is important to organise the relations between string numbers, text and alarms well. These 
relations should be clear before the alarms themselves are configured. 

 

Starting alarms 

Alarms are parts of strategies and are saved with the strategies. Examples 1, 2 and 3 show how alarm modules can be linked 
to a strategy. 

Alarms are started after the related strategies have been saved, downloaded, started and tested.   
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Examples of Strategies containing alarms 

Alarms - Example 1: Pump Trip Switch 

To illustrate the use of an alarm module in a strategy, this guide takes as an example a simple case where a digital hardware 
input represents a trip-switch contact of a pump. Joining the digital input to an alarm module means that an alarm will be 
generated if the pump goes off-line. 

 

Alarms - Example 2: Pump Trip Switch with delay 

This case joins a digital virtual point (a delay of 60 seconds on the digital hardware input) to the alarm record function 
module.  

 

Alarms - Example 3: Room Temperature Input 

In this case, an analog input (room temperature) is joined to the alarm record function module, and will cause an alarm to 
be sent to the Alarm Handler program if the input value is not within the range specified in the real constant module. 

 

 

 





 
 

 

SECTION 14 :  SIMULATION MODE 
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Introduction 

A Simulation Mode is available within the Cylon Engineering Centre, which allows the operation of a strategy to be 
simulated without the requiring a controller to be connected. This is done, in most cases, by using actual Firmware code to 
ensure the simulation is as close as possible to real controllers. 

 

To enable Simulation Mode, select Controller Simulation from the View menu:  

 

 

 

This will display the Simulation Toolbar: 

 

 

Clicking this button will start and pause the simulation for the current strategy. It is enabled only for 

CBM/CBT/UC32 strategies and if Cylon Engineering Centre is not logged into the site. When the strategy is 
paused, the current simulation state is still visible on the strategy. 

 

Clicking this button will stop the simulation and clear the simulation information from the screen. However, the 
simulation state will still be preserved, and pressing the start button will restart from where it stopped. 

 

Clicking this button will stop the simulation, clear the simulation information from the screen and clear any 
other simulation information for the strategy.  

 

Clicking this button will enable or disable logging of data. When released, no point logging will happen. When 
pushed, any point that has logging information set will have its values logged accordingly. 

 

Clicking this button opens the Simulation Configuration dialog. 
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Configuring the Simulation 

Several aspects of the Simulation can be configured by pressing the
 

button in the Simulation Toolbar. This opens 

the Simulation Configuration dialog: 

 

The Simulation Cycle 
The basic unit for a simulation is a Simulation Cycle. This corresponds to approximately 1 second of runtime on a controller. 
Some modules (Hardware, Globals, time dependent modules) will be processed a fixed number of time during a cycle. Most 
of the other modules will be processed a number of times that depends on the size of the strategy. The bigger the strategy, 
the less the modules will be processed. 

Simulation speed 
The Simulation can be run manually (“Step by Step”) where each click on the start button runs one Simulation Cycle, or 
automatically at one of 3 speeds: Slow (once cycle every 5 seconds), Normal (one cycle per second) or Fast (5 cycles per 
second). 

Display Progress As: 
The progress of the current simulation is displayed in the right-most section of the Simulation Toolbar. This progress can be 
displayed as Runtime (number of seconds since the simulation started) or Date/Time (current simulation date and time) 

Current simulation configuration Start time/date:  
When the Simulation Cycle is run, any time and date dependent modules – such as Time Schedules or Datalogs/Trendlogs - 
will use a simulated time. The value used will be the time and date set in the Current simulation configuration Start 
time/date field of the Simulation Configuration dialog, incremented by one second on each Simulation Cycle. 

This allows a Strategy to be tested for unusual behaviours at specific times such as daylight savings time, year-end, leap 
years etc. 

The value of this time and date will be displayed in the right-most section of the Simulation Toolbar if the Display Progress 
As field is set to Date/Time. 
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Running a Simulation 

When a Simulation runs, the labels at the end of lines will be updated to show the point values.  

 

A green background means that the value is calculated by the simulation.  

A red background indicates that the value has been overridden by the user. 

 

Note:  It is possible to add, update and delete modules and lines while the simulation is running. The simulation will 
take it instantly into account in its calculations. 

 

 

 

Livelog 

During a simulation the livelog will display values from a simulation run so that it is possible to view point values from 
different parts of the strategy simultaneously. 
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Point properties 

The Simulation mode has two sets of point properties: 

 one for input points that feed into the Strategy (hardware inputs and Globals’ destinations),  

 one for all the other points whose values result from the Strategy’s internal calculation. 

 

Accessing the points properties 

To open the Simulation Properties for a specific point right click on it and select Simulation properties: 

Lines 

 

Hardware Inputs and Destination Globals 

 

 

Connected nodes: 

 

 

 

 

 

 

 

 

Point value override 
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In a point’s Simulation properties dialog you can specify whether the value for the point will be calculated by the Simulation, 
or set to a fixed value: 

Analog points: 

Point calculated automatically: 

 

Point overridden and set to 18.5: 

 

Digital Points: 

Point calculated automatically: 

  

Point overridden, and set to “Off” (boolean 0) 

  

Point overridden, and set to “On” (boolean 1) 
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Input point options 

For input point, a selection of options is available to simulate different types of inputs. For Digital points there are two 
options, for Analog points there are 7: 

Digital Input point options 

 

 Fixed value 

The point will have a fixed value throughout the Simulation run. 

Value is “Off” for the whole Simulation run: 

 

Value is “On” for the whole Simulation run: 

 

 Periodic change 

This option will change the value of the digital point during the Simulation run. 

If the Random period box is unchecked, the value will change after the Basic Period specified: 

 

 

If the Random period box is checked, the value will change after a random period which is less than the specified Basic 
Period: 
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Analog Input point options: 

 

 None 

The point is not assigned a value. The value will either be the last value that the point had, or zero if no previous value 
existed. 

 

 Fixed 

The point will have a fixed value throughout the Simulation run. 

  

 

 

 

 Random value 

During each simulation cycle, the point will be assigned a random value between a given minimum and maximum.  
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 Up (down) only 

The value will change in only one direction (up or down). Use a negative step limit to go down. 

  

  

 

 Up (down) only with limit 

The value will go from a Start value to a Stop value.  
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 Up and down  

The value will go up and down continuously between two limits either by a specified step (fixed or random) with a specified 
period (specify the time to go from one limit to the other).  

  

 
 

  

 

 Values from file 

The point value will be taken from a datalog file – at each simulation cycle the next value will be read from the file.  

This allows using real data such as a datalog of outside air temperature in the simulation. It also makes it possible to repeat 
a simulation exactly if the input points from the original simulation have been logged. 
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Point logging 

 

 

Any point in the strategy can be logged to a file. This can be used to review values after the strategy has run, and analyse 
issues. It can also be used to feed back the value in another simulation (see “Input points options”). 

Note:  Logging will occur only if both 

 1. the settings in the point Simulation properties dialog are set and 

 2. the logging button
  

in the Simulation Toolbar is pressed. 

 This means that logging can be switched on or off during a simulation by clicking the logging button. 

 

 

 





 
 

 

SECTION 15 :  SITES 
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Overview 

A site is the name given to one or more controllers, connected to a PC. The following are examples of sites. 

 A standalone UC I/O controller. 

 One Comms Controller with a Fieldbus of one or more Field Controllers 

 A network of Comms Controllers, each with a Fieldbus of one or more Field Controllers, connected to each other 
via ARCnet cabling.  

Sites are configured in the Configuration program.  

Some common procedures carried out on sites include: 

 Installing a new site on the PC (see page 410) 

 Site backup (see page 411) 

 

Installing a new site on the PC 

To install a new site on a PC, the Cylon Software Suite must be installed already.  

A new site is one which has not been installed on this PC before, and for which a backup from another PC does not exist. 

 

What happens when a new site is installed 

Installing a new site involves the following events: 

 Site-specific directories are created on the hard disk. 

 Site-specific information (information about network ID, telephone number, ID code, etc.) is entered in the 
WN3000.ini file. 

 The network size (number of Comms Controllers) is specified. 

 The Comms Controllers and Field Controllers are named. 

The Configuration program performs all these steps. For further details, see MAN-0041 Configuration User Manual. 

Note:  Do not manually make entries to the WN3000.ini when installing a site on the PC. All necessary changes will be 
made to the WN3000. INI file by the Configuration program. 
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How a new site is installed on the PC 

Installing a new site on the PC involves the following procedures: 

 Naming the new site in the Configuration program. 

 Entering the size of the site (number of Comms Controllers) in the Configuration program. 

 Naming the Comms Controllers and Field Controllers in the Configuration program. 

 If the site is not a remote site, it can be configured as the default site (see MAN-0041 Configuration User Manual). 

 Restarting Microsoft Windows and the Cylon Software Suite for the changes to take effect. 

 

 

Site backup 

Making a site backup means making a copy of all site-relevant data on the PC onto removable media such as diskettes or 
tape. A site can be recreated on another PC running Cylon Software using this site backup. 

 

Making a site backup 

The following files and subdirectories must be backed up when making a site backup. 

 All the files and subdirectories of the site (for example, the \UnitronUC32\LAN\ subdirectory and its contents for 
the Local Network site). 

 All the files in the system directory (for example, \UnitronUC32\SYSTEM\). 

 All the files in the macros directory, if macros are used in strategies on the site (for. \UnitronUC32\MACROS\). 

To make a backup of the Local Network site, all files and subdirectories in the following directories must be backed up: 

C:\UnitronUC32\LAN\  

C:\UnitronUC32\MACROS\ 

C:\UnitronUC32\SYSTEM\ 

Note:  Cylon Software program files (__.EXE, ___.DLL etc.) are NOT part of the site backup. 

This backing up procedure can be carried out using the Site Backup module (CCBackup). 





 
 

 

SECTION 16 :  APPENDIX :: ADDING 
UNITS OF 
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THE SYSTEM 
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Adding units of measurement 

Additional units of measurement may be added to the existing list of units in a site to allow for a greater range of 
applications. Units must be added to the site.ini file in the UnitronUC32\(SITENAME)\SYSTEM directory 

Note:  Before changing the site.ini file, make a backup copy (for example, site.ini.bak). 

The site.ini file can be edited in a word-processing program such as Microsoft Windows Notepad, or Microsoft 

Word. If you use Word to edit the file, make sure to save the file as a "Text Only" document. 

 

 

How to add units of measurement to the system 

 Make a backup copy of site.ini. 

 Open site.ini, using a word processing program. 

 Search for the [AnalogUnits] section if adding analog units, and the [DigitalUnits] section if adding 
digital units. 

 Either  

o edit one of the entries marked “spare”  

(e.g. change UNITS61="Spare1" to something like UNITS61="m/s")  

or  

o append the new units to the list of units  

(for example, add something like UNITS74="m/s" to the end of the list of analog units).  

If you add to the list in this manner, be sure also to increment the NumberUnits parameter so that it 
matches the final number of units. Ensure the the number at the end of the units variable (e.g. 
UNITS74) has a number at the end that matches its place in the list of units. 

 Save the amended site.ini file. 

 Close and restart the Engineering Centre, to allow the changes to take effect.  The new units can then be 
selected from list boxes for point configurations. 
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Example of adding units to analog units list 

 

Note:  Units are also listed in the UnitronUC32\SYTEM\WN3000.ini. However, this file is for legacy applications 

only and applies throughout the Cylon Software system, and so must not be edited.  

 

Note:  Take care when editing site.ini not to change the section headings [AnalogUnits], [DigitalUnits] etc. in any way, 
because this can cause errors in the Cylon Software system. 

 

 





 
 

 

SECTION 17 :  APPENDIX ::  
CUSTOMIZING 

MODULE GROUPS 
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Customising Module Groups 

In order to make it easier and faster to locate a module, modules are grouped together in six categories – points, logic, 
mathematical, control, function and statistic.  

You can, however, customise the grouping of modules to suit your own preferences.  

For example, you can edit the group definitions, to arrange the modules you use most often in one group.  
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Group definitions 

Module groups, and the modules they contain, are defined in a file called UC16INT.ini. This file is located in the 
C:\UnitronIUC32 folder. Two of the group definitions from UC16INT.ini are shown below: 
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The definition of each module within the group is of the form 

Module X= Y ;Module Name,  

where X = ((number of module’s position in the group)-1); 

and Y = module number. 

For example, the definition: “Module0=1 ;Analog Input” from the Points group means that module number 1, called the 
Analog Input module, has position 1 in the Points module group. 

  



 

 
 

MAN00058US rev 69 © American Auto-Matrix 421 

Editing the group definitions 

If you wish to change the modules contained in a group, it is possible to edit the UC16INT.ini file (see page 419), by opening 
it in a text editor such as MS Notepad or MS Word. 

Using the Cut, Copy and Paste functions available in the text editor you are using, you can customise the modules groups. 
For example, you can group all the modules you use most frequently into one group. 

 

Guidelines for editing group definitions 
 Make a backup of the UC16INT.ini file before you start the editing process. 

 Each module group can contain up to 100 modules (from Module0 to Module99). These module positions must be 
kept in numerical order when edited. 

 Modules can appear in more than one module group. For example, function 82, the Wide Inverter Gate, is listed in 
both the Logic group and the Function group.  

 It is not possible to create additional module groups. All editing must be done within the six existing groups. 

 

 





 
 

 

SECTION 18 :  APPENDIX :: FILE 
MANAGEMENT 
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File Management in the Engineering Centre 

On a large site with multiple Comms Controllers where more than one engineer will be commissioning software at any one-
time file management becomes very important. 

You must insure that no one modifies the same strategies / global files that an engineer is currently commissioning. To 
guard against this, we would recommend that all files are stored on a central computer and only the files required for 
commissioning are copied onto the engineer’s laptop. We would also recommend that each engineer is allocated a single 
Comms Controller to work on at any one time. At the end of each day / commissioning period the data files for the Comms 
Controller are copied back onto the central computer. 

Wide globals must be engineered from a single computer, possibly the central supervisor. This cannot be undertaken on 
several computers.  

The data files required to commission a single LAN are as follows: 

All files under  

UnitronUC32 \[SiteName]\dbase \* 

Where * is the address of the Comms 
Controller to be commissioned. 

 

All files under  

UnitronUC32 \[SiteName]\strat5\***  

Where *** is the address of the 
Comms Controller to be 
commissioned. 

The same files should be copied back to the central computer at the end of each day / commissioning period. 

The Cylon Building Management System is made up of two main types of component: 

 Hardware - the products that monitor and control a building's environment. 

 Software - the interface which allows users to configure and monitor Cylon Hardware. 

 

 

 



 
 

 

SECTION 19 :  APPENDIX :: BACNET 
EXPLORERS 
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The Cylon Engineering Centre includes two utilities that facilitate the commissioning of BACnet Sites: the integrated 

Discovery Tool, accessible from the Site Tree, and the separate application NB-Pro. 

NB-Pro 

NB-Pro is a generic commissioning environment for BACnet controllers. Using NB-Pro, users can setup and configure 
devices to create control programs and strategies for building automation systems, including Cylon BACnet. For details see 
MAN0122 NB-Link & NB-Pro. 

Note: For NB-Pro to work with Cylon Engineering Centre, you must open the Settings menu NB-Pro and select 
Network Configuration. In the Network Configuration dialog, select the Remote IP radio button in the 

Communicate Via: section so that NB-Pro does not attach to the BACnet UDP port of the PC as this would block 

the Engineering Centre. Also, register NB-Pro as a foreign device on a CBR on the network by entering the 

CBR’s IP address in the Network Configuration dialog’s BBMD Device field. 

Discovery Tool 

The purpose of the Discovery Tool is to allow users to see all live BACnet devices, objects and properties on the network 

via the Engineering Centre. It also allows some or all of the discovered objects to be added to an existing Engineering 

Centre Site or allow a new Site to be created with the discovered objects.  

For existing sites, this tool is used to compare the site configuration with the devices that are live on the network. It is 
possible to change the present_value property of some objects. 

BACnet Explorer 

The Explorer is an extension of the Discovery Tool. It is available in the Engineering Centre by right-clicking on a BACnet 
Site in the Site Tree and selectingDiscover Site. 

  

This opens the Site Discovery dialog, which is prefilled with the selected Site’s information: 
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If the Discover Site option is selected from the context menu of the Site Tree’s root node,  

 

then the Site Discovery dialog will be blank, and can be used to create a new Site. 

  

The Site Discovery dialog has the following fields: 

Network Type 

(If an existing Site is selected, this selection cannot be changed).  

If a site is not selected, select a Network Type that will apply if you choose to create a site from the Explorer during the 
current exploration: 

 Network 1 for Serial and Modem Sites 

 Network 2 for TCP/IP or BACnet Sites 

Site Name 

(If an existing Site is selected, this field will not be editable). 

If a site is not selected, enter a new Site Name here. If you choose to create a site from the Explorer during the current 
exploration, this is the name that will be used for it. 

Site Directory 

The Site Directory is automatically generated from the Site Name, but it can also be user defined. Do not use special 
characters in the Site Directory Name. 

Site Number 

(If an existing Site is selected, this field will not be editable).  

If a site is not selected, specify a Site Number. If you choose to create a site from the Explorer during the current 
exploration, this is the Site Number that will be used for it.  
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Address Range 

This can be used to limit the Discovery process. Only BACnet addresses within this range will be tested. 

Wait Timeout (s) 

This sets the length of time that the process will listen for I-Am responses during discovery. 

Larger Sites require higher Wait Timeout(s) to explore the entire site (default 10 seconds) 

Network 

The user can choose a specific network to discover in this dialog box. If the user enters a network number, only devices on 
that network will be displayed. Leave this blank if you want to show devices on all networks.  

 

The Discover button will launch the progress dialog. 

 

A WhoIs call is made, and then the system waits for the specified timeout (default is 10 seconds) after which it reads the 
BACnet information for each Device that responded with an I-Am message. When this is complete, the results dialog opens: 
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The results dialog contains two panels: 

 The left panel contains a tree view list of the BACnet devices and objects discovered.  

 The right contains information regarding the selected device or object.  

It is possible that not all devices would be discovered during the specified Wait Timeout(s)., so if necessary you can re-scan 
the network for further devices by clicking the Rescan Network button. The Site Details dialog will open again so that the 
settings for Address Range, Wait Timeout(s) and Network number can be adjusted. Devices that have already been 
discovered will be skipped, so that further devices may be discovered even if none of the settings are changed. 

The tree view is similar to the existing site list in other applications. The site is the root node of the tree, followed by the 
routers and then devices under those. Under the device nodes there are other nodes in the Object List. Expanding this will 
show each object read in from the parent device.  

As an extension of the Site Discovery Tool, the Explorer allows devices to be added to the Site specified in the top left 
corner of the Cylon BACnet Explorer dialog (which may be an existing site or a new site that will be created when devices 
are added).  

To add devices to the selected site, check the box beside each required device in the Site Tree and click on the Add Selected 
Devices to Site button. To quickly select all of the discovered devices check the Select all devices to add to Site box beneath 
the Site Tree. Non-Cylon devices will be added as virtual controllers and have a Unitron address of 131 or above.  

When the root of the tree view is selected, the right panel contains a list of the BACnet devices found, along with: device 
name, MAC address, vendor ID, model name, IP or MSTP Address, Network and estimated Controller Type.  



 

 

430 © American Auto-Matrix MAN00058US rev 69 

M
A

N
0

0
0

5
8

U
S rev 6

9
 

 

There is also a column (No. Types) which shows the number of possible Cylon controller types this device could be.  

Cylon devices are initially set as a CBM24 controller type, but this can be changed in the Controller Properties dialog. The 
‘Type’ of a non-Cylon device cannot be changed in the Controller Properties dialog, but if they are added to the Site, they 

will appear as CBM24 in the Engineering Centre, and this can be changed in the Configuration utility (CCConfig). 

 To open the Controller Properties dialog, double-click on the device in the right-hand panel. 

        

You can then change the Name, Type, Address, and Device Instance Number before adding them to the site.  

Note: This will only change the name of the device in the database on the PC, it will not change the name on the 
device itself. 

When the device node of the tree is expanded or double-clicked, the object list of that device will be read in. As each object 
is received from the device it will be added as a child to that device node. At this stage the right-hand panel will display the 
object list with a column for object ID, object type, object name, and present value and this list will be populated as objects 
are read in.  
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When an object is selected in the tree view, the properties of that object will be read from the device and the right-hand 
panel will contain the properties and values of that object.  

From the results dialog, the user will be able to change the present value property for some of the objects.  

Note: To refresh a specific object, right-click on that object.   
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Check Against Existing Devices 

When using the BACnet Explorer on an existing site, any discovered devices must be checked against those that have 
already been configured. This is done by comparing the Device Instance Number of each discovered device against the 
Device Instance Number of any devices on the site configuration already. 

For any discovered devices that have the same Device Instance Number as a device on the PC, there will be a comparison 
made between the MAC address discovered and the Unitron address.  

 If these match, the device will be highlighted in the list in green to signify that the devices match. A matching 
device cannot be edited. 

 If they do not match, then the device in the list control will be highlighted in red to alert the user to this mismatch. 
The user will be given a choice to resolve the mismatch 

 If the Device Instance Number does not match any other ID on the PC, then this discovered device will not be 
highlighted and will be left white. Non-matching devices can be edited. 

Changing the Present_Value Property 

The present value can only be written to commandable BACnet objects. Commandable objects always have the 
‘present_value’ property and two additional properties – Priority_Array and Relinquish_Default.  

 Analog Output, Binary Output and Multi-State Output objects are always commandable.  

 Analog Value, Binary Value and MultiState Value objects can be commandable, but this is decided by the vendor.  

To change the present value of a commandable object, double-click on the present value property in the right panel. If the 
object has the required properties, this will open the Change Present Value Dialog: 

 

The table on the right-hand side of this dialog shows the current priority array of the object. To change or relinquish the 
value, you must select the checkbox beside the relevant priority index. By selecting the checkbox, you can edit the value at 
that array. To relinquish that value, clear the contents in the box or set it to “NULL”.  

When the Change Selected Values button is clicked, the value for any priorities whose checkbox is ticked will be sent to the 
BACnet object.  This will update the priority array on the device and to show this, the list items, present_value and 

priority_array, in the Explorer dialog will be updated too.   



 
 

 

SECTION 20 :  BACKING UP A BACNET 
SITE 
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The Cylon Engineering Centre software uses data files organized on the PC in a directory structure representing the 
structure of the Site. This directory structure can be archived, and installed on another PC or restored to the original PC. 

The Cylon Site Backup Utility, CCBackup, automates the archiving and the restoring process – see MAN0072 Site Backup 
Utility. However it does not include CBR configuration in those processes. 

Backing up the CBR routers 

Each CBR on a Site must be individually backed up as follows: 

Right-click on the CBR in the Cylon Engineering Centre’s Site Tree, and select Backup Router: 

 

The Router Backup dialog will open: 

 

Enter a valid BACnet Device Instance Number and the router’s password  

Note:  The router’s password is the one that is used to access the Configuration web interface of the router.  It can be 
set or changed from the router’s Configuration web interface. 

Click the Site Backup button 

 

 

The backup file for this router will be stored in Site’s RouterBackups directory: 
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How to restore a CBR router 

To restore a router from a backup,  

Right-click on the CBR in the Cylon Engineering Centre’s Site Tree, and select Restore Router. 

 

The Password dialog will open.   

Enter the Device Instance Number of the router to be restored and the router’s password  

Note:  The router’s password is the one that is used to access the Configuration web interface of the router.  It can be 
set or changed from the router’s Configuration web interface. 

The Restore Router dialog will open:  

 

Click on the Browse button and select the location of the backup that is to be restored: 

 

 

 

 

The files that comprise the backup will be displayed with their modified date: 
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Click the Start Restore button.  

 

The restore process can be cancelled if required by clicking the Abort button. 

 

When the process is complete, click the Close button. 

 

 

 

 





 
 

 

SECTION 21 :  INTRODUCTION TO 
CYLON ENGINEERING 

CENTRE MODULES 
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What is a Strategy module? 

Modules are the building blocks from which Strategies are constructed. They are represented in a Strategy drawing as 
rectangular graphics with 'input' connections on the left-hand side and 'output' connections on the right. 

When downloaded to a controller, each module uses a predefined algorithm to transform the values of the controller points 
that are associated with its inputs, and to place the resulting values in the points associated with the module's outputs. 

The 'outputs' of one module can be connected to the 'inputs' of another, allowing modules to be joined together to form 
complex algorithms. When such a module or set of joined modules connect the hardware inputs of a controller to its 
hardware outputs, a "Strategy" is formed. 

Graphical representation of modules 

Modules are represented graphically in 3 ways: 

 As a Module button in the Engineering Centre's toolbar 

 As a Module symbol on a Strategy drawing 

 As a Module dialog box when the module is being configured. 

 

Module button 

 Each module is represented by a button on the floating modules bar, 

 e.g.   
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Module symbol 

When a module has been placed on the drawing area, it is 
represented by a module symbol. 

 

Most module symbols display 

  
 

A module number, a module name, and a block number, 

As shown in the example above. 

The inputs to the module are represented by blue circles or 
squares on the left of the module symbol: 

 

and the outputs by blue circles or squares on the right of the 
module symbol: 
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Module dialog box 

The Module Dialog Box is use to configure a Strategy Module. It allows the numbers and values of the points connected to 
the module's inputs and outputs to be examined, and allows any parameters the module may contain to be set. 

Dialog Box features 
When a UC32 controller is the target of the Strategy, the vast majority of Strategy Modules are represented in a standard 
format. This format is illustrated and explained in Standard Format for Strategy Modules on page 442. 

13 of the strategy modules available in the Cylon Engineering Centre are not in the Standard Format. These are 

 Analog Input 

 Analog Output 

 Digital Input 

 Digital Output 

 Analog Setpoint 

 Digital Setpoint 

 DI module 

 Boolean Combination of Digital Inputs 

 Time Schedule module 

 Holiday Schedule module 

 Long Period Timer 

 Datalog module 

 Alarm Record module 

For details of these Module Dialog boxes, see the individual Module reference sheets 

When a UC or UCU controller is the target of the Strategy, all of the Module Dialog boxes are non-standard. For details see 
the individual Module reference sheets. 

Opening a Module's Dialog Box 

To access the module dialog box, right-click on the module symbol in the Strategy drawing. The module's dialog box will 
open, allowing you examine the Module's state, and to adjust its parameters.  

Standard Format for Strategy Modules 

If the parameters of a Strategy module are to be adjusted, this is done through the modules 'dialog box', which is opened 
when you double-click on the module in the strategy drawing. 

In the majority of cases, this dialog will be similar to that of the PID module, shown below: 

 

This is the 'Standard Format' used for most strategy modules in the Cylon Engineering Centre. The main elements of this 
format are:  
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 Inputs column 

 

 Constants column 

 

 Outputs column 

 

 Block Number 

 

 Next/previous module 
buttons 

 

 OK and Cancel buttons. 

 

Some of the fields within the dialog are editable - these are represented with a white background. The other fields display 
useful information about the points to which the module is connected. 

Note:  Some module dialogs contain a Keypad button that is used to add a module to a UC32 keypad program. For 
more information refer to MAN-0055 UC32 Keypad Manual. 

When Scan Mode is active the Inputs and Outputs columns will display the current values of the listed points. 

In the Constants column, the user can set the values 
of some of the Strategy Module's parameters. The 
exact number function of these constants depends 
on the nature of the module. 

The functions of the module constants are explained 
in the individual module reference sheets. 

 

The "Next module" and "Previous module" buttons 
allow you to move quickly between the dialog boxes  
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of the modules that have already been added to the 
current Strategy drawing.  

The Block Number box displays the number of the 
strategy block to which the current module is 
assigned.  
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The arrangement of modules in the Engineering Centre 

There are six categories of modules available in the Engineering Centre: 

Points: 

  

Logic: 

  

Mathematical: 

 

Control: 

  

 Function: 

  

Statistical: 

  

In the Engineering Centre, there are six module bars or groups available by default (as shown above), but the arrangement 
of modules within groups can be customised. 

Each group is represented by a button on the toolbar,  

       

and listed under the Modules… item in the View menu. 
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Controller type and available modules 

Different modules are available for older Field Controllers than for the UC32 range. If a Field Controller is the target of a 
controller, the following module will not be available because Field Controllers did not have UniPuts: 

    Uniput Extract (see page 483) 

If a Field Controller is selected, the following extra modules are available, as they apply to specific custom Field Controllers: 

 HOA Switch State (see 655) 

 HOA Pot Value (see 653) 

 Digital Extract DI (UC24PG Digital Input module (see page 476) 



 
 

 

 

 

 

SECTION 22 :  POINTS MODULES 
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Analog Input 

Button:  

  

Symbol: 

     

UCxx/UCUxx   UC32 

Value not shown  

  

Value shown 

Function of 
module: 

The Analog Input dialog is used to define how a selected hardware terminal, configured as an analog input, 
will be identified within a controller strategy, and how it will behave. 

An analog input module in a strategy contains a value passed from a peripheral device, such as a 
temperature sensor, attached to the controller. 

Note 1: The number of analog inputs available depends on the type of controller you are using. For example,  
A UC32 controller allows 8 Universal (i.e., analog or digital) inputs, 8 UniPuts, and 8 UniPuts+Relays,  
a UC24PG-R controller allows 8 Universal Inputs, 8 digital-only inputs, and 8 universal outputs, 
a UCU10VAV has 3 universal inputs, 1 airflow input, and 6 outputs.  
To see how many and what type of inputs/outputs are available in the controller you are using, select the 
Managers dialog box from the View menu. 

Note 2: The 'Advanced' options are designed for use only when none of the predefined sensor types are suitable, 
and should be used in consultation with Cylon Technical Support. 

Dialog box: 
The dialog for an analog input changes significantly depending on whether the targeted controller is UC32 or UC/UCU, and also on the nature of 
the input terminal (if the targeted controller is UC32) 

If UC32 is 
targeted 

AND 

point number is 
1 - 8  

(Universal Input 
terminal): 

       

If UC32 is 
targeted 

AND 

point number is 
9 - 24  

(UniPut 
terminal): 

     

If UC/UCU is 
targeted: 
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Variables 
Variable name Description Possible values 

Point Number This is the number of the hardware point to which this module 
refers 

1-24 depending on controller 
type 

(the box beside 
the point 
number-UC32 
only) 

The current value of the hardware point is displayed in a box 
beside the point number. 

Real number 

Point Name An arbitrary name assigned by the user and stored in the Cylon 
databases to identify the point. If a point number is selected for 
which a name has already been assigned, that name is 
automatically displayed here. 

Any combination of 
alphanumeric characters and 
spaces. Letters can be upper 
case or lower case. Maximum 
recommended length is 20 
characters and spaces. 

(the box beside 
the Point Name - 
UC32 only) 

Beside the Point Name input box, there is a display that shows 
the number of characters in the Point Name. This is useful 
when the point name is to be displayed in a keypad program 
(see MAN-0055 Keypad Wizard User Manual) 

Integer 

Manual Override 
Point 

This shows the number of the point to which the module's 
"Manual Override Point" is connected. The value of this point 
will be '0' when the Analog Input is active, and '1' when the 
point has been manually overridden. This allows the strategy to 
react to the fact that a point has been overridden. 

1 or 0 

(checkbox beside 
Manual Override 
Point - UC32 
only) 

Beside the Manual Override Point number display, there is a 
checkbox that indicates the value of the point. This is clear if 
the Manual Override Point is '0' and checked if the value is '1'. 

Checked or cleared 

Input Error An optional constant with the same unit as the input value. It is 
added, if required, to the input value to calibrate for errors in 
input arising from, for example, resistance of long cables or the 
positioning of sensors. 
  

Real number 

Exp. Filter 
Constant 

The Exponential Filter Constant is an individual time constant 
for the selected analog input. It acts like a damping filter, in that 
the measured input value will be averaged over the time 
specified in seconds by the Exp. Filter Constant. If the constant 
is greater than the response time of the sensor, transient 
variations of the measured value can be filtered out. 

positive integer 

Temperature 
Units (UniPut 
only) 

If the selected sensor type is a temperature sensor, it is possible 
to adjust the value outputted by the module to the rest of the 
strategy, so that the value represents either Centigrade or 
Fahrenheit degrees. This is done by selecting one of the options 
in the 'Temperature Units' section of the Analog Input dialog. 

Centigrade or Fahrenheit 

Units This field displays the units defined for the sensor selected in 
the 'Sensor Type' field. 

As associated with the selected 
Sensor Type 

Sensor Types 
(UniPut only) 

By setting this field to match the sensor connected to the input 
terminal, you are providing the strategy with all of the 
information it needs to interpret the input signal correctly. 

A predefined list of sensors is 
provided with the Engineering 
Centre 

Alarm Point 
(UC/UCU only) 

This feature is not currently implemented.  
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Advanced Options 
Variable name Description Possible values 

Module Output 
Lower Range & 
Upper Range 

The Module Output settings specify the values that will be outputted 
by this module to represent 0% and 100% of the UI Input readings. 
This is part of the setup for the selected sensor. 
This is used in conjunction with the UI Input or UniPut Input ranges. 
For example,  
a 0 V - 10 V input can be represented within the strategy by point 
values of 0 - 100  by setting  
the UI/UniPut Input Lower range to 0,  
the UI/UniPut Input Upper range to 10,  
the Module Output Lower range to 0 and 
the Module Output Upper range to 100. 

Any integer. Defaults 
to the setting in the 
sensor.ini file 

UI Input 
Lower Range & 
Upper Range 
(available if the 
terminal associated 
with the module's 
point number is a 
Universal Input) 

The UI Input settings specify the range of the input, after analog-to-
digital conversion, that will be interpreted by the strategy as 0% and 
100% of scale readings.  
This is part of the setup for the selected sensor. 
This is used in conjunction with the Module Output ranges. For 
example,  
a 0 V - 10 V input can be represented within the strategy by point 
values of 0 - 100 by setting  
the UI Input Lower range to 0,  
the UI Input Upper range to 10,  
the Module Output Lower range to 0 and 
the Module Output Upper range to 100. 

Any integer. Defaults 
to the setting in the 
sensor.ini file 

UniPut Input 
Lower Range & 
Upper Range 
(available if the 
terminal associated 
with the module's 
point number is a 
UniPut) 

The UI Input settings specify the range of the input, after analog-to-
digital conversion, that will be interpreted by the strategy as 0% and 
100% of scale readings.  
This is part of the setup for the selected sensor. 
This is used in conjunction with the Module Output ranges. For 
example,  
a 0 V - 10 V input can be represented within the strategy by point 
values of 0 - 100 by setting  
the UniPut Input Lower range to 0,  
the UniPut Input Upper range to 10,  
the Module Output Lower range to 0 and 
the Module Output Upper range to 100. 

Any integer. Defaults 
to the setting in the 
sensor.ini file 

Resolution  
(UC32 only, Points 1 - 
8 only) 

This changes the effective input resolution of the Analog Input. 10bit 
resolution is a faster reading than 14 bit (by milliseconds) but for 
most BMS  applications the difference is not significant. 

14-bit or 10-bit 
resolution 

Passive Reading 
(UC32 only, Points 1 - 
8 only) 

When measuring the value of a passive sensor, the controller outputs 
a reference voltage via a resistor. This voltage can be pulsed or 
continuous.  
A pulsed reference gives optimum accuracy by eliminating self-
heating in the sensor, and this is the default setting. 

Pulse or Continuous 

Operation mode 
(UC32 only, Points 9 
and 17 only) 

This option appears on the 'advanced' dialog box for points 9 - 24, but 
is greyed out where it is unavailable 
If the operation mode of point 9 analog input is set to '10V Ref', then 
the associated terminal will provide a 10 volt reference. 
If the operation mode of point 17 analog input is set to '13V Ref', 
then the associated terminal will provide an unregulated 13 volt (at 
150mA) power supply. 
This 13 volt supply is protected against short circuits and accidental 
24Vac connection and is intended to supply active sensors.  
The specification of 20mA  per each of 16 Analog outputs for a UC32 
no longer applies when using the 13V psu feature. 

Normal or 10 v PSU 
(point 9) 
Normal or 13 v PSU 
(point 17) 

Application 
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A sensor reading the outside air temperature passes its current value to the system via an analog input every time the point 
defined as the analog input is serviced. It is set up as a PT1000 sensor, with an Exponential Filter constant of 60 seconds. 

The Exponential Filter Constant smooths the effects of sudden changes in the input value. It is normally set to a value 
between 60 and 120 seconds. Using too low an Exponential Filter Constant will reduce the smoothing effect, while using an 
Exponential Filter Constant that is too high will slow down the input too much. 
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 Analog Input: Using non-standard sensors 

 It is often necessary to use Universal Inputs with sensors that are not pre-defined in the Cylon Engineering Centre. This is 
easily done using the scaling options in the Advanced dialog of the Analog Input module. As an example, the procedures for 

using 4 - 20 mA and 1 K - 11 K sensors are illustrated below. 

Setting a Universal Input to work with 4 - 20 mA sensor 

In order to read a current-based 
sensor, you must first select a 
similar one from the preset list in 

the Cylon Engineering Centre. 
In this case a 0 - 20 mA sensor is 
selected as a basis for the custom 
sensor. 

 

With 0-20 mA selected, click on 
the Advanced button 

 

The Advanced Analog Terminal Settings dialog that 
opens has scaling parameters for the 0 - 20 mA sensor 
as shown. The Module Output is set to minimum value 
0 (Lower Range) and maximum value 100 (Upper 
Range) which represent percentage of full-scale. The 
UI Input is shown as minimum 0 (Lower Range) and 
maximum 20 (Upper Range) which represent mA 
measured at the terminal. 

 

Change the UI input to 4 and 20 as shown, 
representing the 4 - 20 mA range required. The 
Module Output should be left as 0% - 100%. 

Click on OK. The Analog Input module will now output 
0-100% to represent 4-20 mA 
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Setting a Universal Input to work with 1 K- 11 K sensor 

In order to read a 
resistance-based 
sensor, you must first 
select a similar one 
from the preset list in 

the Cylon Engineering 

Centre. In this case a 0 

K - 10 K ('POT') 
sensor is selected as a 
basis for the custom 
sensor.  

With 'POT'  selected, 
click on the 'Advanced' 
button 

 

The Advanced Analog Terminal Settings dialog 
that opens has scaling parameters for the 0 - 

10 K sensor as shown. The Module Output is 
set to minimum value 0 ("Lower Range") and 
maximum value 100 ("Upper Range") which 
represent percentage of full-scale. The UI 
Input is shown as minimum 0 ("Lower Range") 
and maximum 10000 ("Upper Range") which 
represent resistance in Ohms measured at the 
terminal. 

 

Change the UI input to 1000 and 11000 as 

shown, representing the 1 K - 11 Krange 
required. The Module Output should be left as 
0% - 100%. 

Click on OK. The Analog Input module will now 

output of 0-100% to represent 1 K - 11 K. 
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Analog Output 

Button: 

  

Symbol: 

  
UCxx/UCUxx   UC32 

Value not shown 

  

Value shown 

Function of module: 

The Analog Output dialog is used to define how strategy information is represented on a controller hardware output 
terminal that is defined as an analog output. 

An Analog Output module in a Strategy contains a value to be passed from the controller to a peripheral device such as a 
valve. 

 

 

Note: The number of analog outputs available depends on the type of controller you are using. A UC24PG-R controller 
allows 8 universal inputs, i.e., analog or digital, 8 digital-only inputs, and 8 universal outputs. A UCU10VAV has 3 
universal inputs, 1 airflow input, and 6 outputs. To see how many and what type of inputs/outputs are available 
in the controller you are using, select the Managers dialog box from the View menu. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 

 

 

 

 

 

Variables: 
Variable name Description Possible values 
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Point Number This is the number of the hardware point to which this 
module refers 

1-24 depending on controller type 

(the box beside 
the point 
number-UC32 
only) 

The current value of the hardware point is displayed in 
a box beside the point number. 

Real number 

Point Name An arbitrary name, assigned by the user and stored in 
the Cylon databases to identify the point. If a point 
number is selected for which a name has already been 
assigned, that name is automatically displayed here. 

Any combination of alphanumeric 
characters and spaces. Letters can be 
upper case or lower case. Maximum 
recommended length is 20 characters 
and spaces. 

(the box beside 
the Point Name - 
UC32 only) 

Beside the Point Name input box, there is a display that 
shows the number of characters in the Point Name. 
This is useful when the point name is to be displayed in 
a keypad program (see MAN-0055 Keypad Wizard User 
Manual) 

Integer 

Manual Override 
Point 

This shows the number of the point to which the 
module's "Manual Override Point" is connected. The 
value of this point will be '0' when the Analog Output is 
active, and '1' when the point has been manually 
overridden. This allows the strategy to react to the fact 
that a point has been overridden. 

1 or 0 

(checkbox beside 
Manual Override 
point) 

Beside the Manual Override Point number display, 
there is a checkbox that indicates the value of the 
point. This is clear if the Manual Override Point is '0' 
and checked if the value is '1'. 

Checked or cleared 

Sequence Period This is the number of 5-second periods that must 
elapse after a controller reset, before the selected 
output becomes active again. 

0-255 

Units This field defines the units that correspond to the input 
to the analog output 

Any of the strings in the drop-down list 

Application: 

In the dialog box above, the value (0-10V) for the Boardroom Heaters is connected to point number 9, terminal numbers 17 
and 18, where 17 is the ground and 18 is the positive terminal. 

 

Note: If a 4-20mA device is being used, a 0-10Vdc to 4-20mA converter can be bought off-the-shelf. 
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Digital Input 

Button: 

  

Symbol: 

    

UCxx/UCUxx   UC32 

Value not shown 

  

Value shown 

Function of module: 

A digital input contains a digital value passed from a peripheral device, such as a pressure switch, attached to the controller. 
Digital Inputs are used to monitor the status of such devices. 

Note 1: 

 The number of digital inputs available depends on the type of controller you are using. A UC24PG-R controller 
allows 8 universal inputs, i.e., analog or digital, 8 digital-only inputs, and 8 universal outputs. A UCU10VAV has 3 
universal inputs, 1 airflow input, and 6 outputs. To see how many and what type of inputs/outputs are available 
in the controller you are using, select the Managers dialog box from the View menu. 

Note 2: 

 The 'Advanced' options are designed for use only when none of the predefined sensor types are suitable, and 
should be used in consultation with Cylon Technical Support. 

Note 3: 

 When using a Digital Input module to monitor a UniPut terminal, it is possible to detect 24 V AC in addition to 
Active (0-10 V) and Passive (volt-free) conditions. The UniPut extract module is used to do this. 
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Dialog box: 

If UC32 is 
targeted: 

         

If UC/UCU is 
targeted: 

 

 Variables    

Variable name Description Possible values 

Point Number This is the number of the hardware point to which this 
module refers 

1-24 depending on controller type 

(the box beside the 
point number - UC32 
only) 

The current value of the hardware point is displayed in a box 
beside the point number. 

Real number 

Point Name An arbitrary name assigned by the user and stored in the 
Cylon database to identify the point. If a point number is 
selected for which a name has already been assigned, that 
name is automatically displayed here. 

Any combination of alphanumeric 
characters and spaces, upper case or 
lower case. Max recommended length 
is 20 characters and spaces. 

(the box beside the 
Point Name - UC32 
only 

Beside the Point Name input box, there is a display that 
shows the number of characters in the Point Name. This is 
useful when the point name is to be displayed in a keypad 
program (see MAN-0055 Keypad Wizard User Manual) 

Integer 

Manual Override 
Point 

This shows the number of the point to which the module's 
"Manual Override Point" is connected. The value of this point 
will be '0' when the Digital Input is active, and '1' when the 
point has been manually overridden. This allows the strategy 
to react to the fact that a point has been overridden. 

1 or 0 

(checkbox beside 
Manual Override 
Point - UC32 only) 

Beside the Manual Override Point number display, there is a 
checkbox that indicates the value of the point. This is clear if 
the Manual Override Point is '0' and checked if the value is '1'. 

Checked or cleared 

Sensor Types By setting this field to match the sensor connected to the 
input terminal, you are providing the strategy with all of the 
information it needs to interpret the input signal correctly.  

Active or Passive 

Short Circuit This is a string that will be displayed by this module in the 
Unitron Command Centre when the input of this module is 
interpreted as a closed circuit. 

Any of the strings in the drop-down 
list 

Open Circuit This is a string that will be displayed by this module in the 
Unitron Command Centre when the input of this module is 
interpreted as an open circuit. 

Any of the strings in the drop-down 
list 
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Advanced options: 

Note 4:   

 These options should NOT be changed unless a very specific and clearly identified reason makes it imperative to 
do so. 

Note 5:  

 The threshold values for a digital input define the values of the signal at the controller terminal that will be 
interpreted as '1' and '0'. 

Variable name Description Possible values 

Low Threshold The Digital Input will be interpreted as "1" if the actual 
value of the signal at the controller terminal is above this 
value. 

Integer - in units of the selected 
sensor type:, 
Passive type: Ohms 
Active type: milliVolts 

High Threshold The Digital Input will be interpreted as "0" if the actual 
value of the signal at the controller terminal is below this 
value. 

Integer - in units of the selected 
sensor type:, 
Passive type: Ohms 
Active type: milliVolts 

Application: 

A digital input can carry a signal such as pump status; starter trip; boiler lockout or frost stat. 
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Digital Output 

Button:  

  

Symbol:  

   

UCxx/UCUxx   UC32 

Value not shown 

  

Value shown 

Function of 
module: 

A digital output passes a digital value from the controller to a peripheral device connected to that 
controller. Digital Outputs are used to provide on/off control for pumps, boilers etc. 

Note 1: The number of digital outputs available depends on the type of controller you are using. A UC24PG-R 
controller allows 8 universal inputs, i.e., analog or digital, 8 digital-only inputs, and 8 universal outputs. A 
UCU10VAV has 3 universal inputs, 1 airflow input, and 6 outputs. To see how many and what type of 
inputs/outputs are available in the controller you are using, select the Managers dialog box from the 
View menu. 

Note 2: The 'Advanced' options in the digital output dialog are for future use, and have not yet been 
implemented. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 
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Variable name Description Possible values 

Point Number This is the number of the hardware point to which this module refers 1-24 depending on controller type 

(the box beside 
the point 
number - UC32 
only) 

The current value of the hardware point is displayed in a box beside 
the point number. 

Real number 

Point Name An arbitrary name assigned by the user and stored in the Cylon 
databases to identify the point. If a point number is selected for 
which a name has already been assigned, that name is automatically 
displayed here. 

Any combination of alphanumeric 
characters and spaces. Letters can 
be upper case or lower case. 
Maximum recommended length is 
20 characters and spaces. 

(the box beside 
the Point Name - 
UC32 only) 

Beside the Point Name input box, there is a display that shows the 
number of characters in the Point Name. This is useful when the 
point name is to be displayed in a keypad program (see MAN-0055 
Keypad Wizard User Manual) 

Integer 

Manual Override 
Point 

This shows the number of the point to which the module's "Manual 
Override Point" is connected. The value of this point will be '0' when 
the Digital Output is active, and '1' when the point has been 
manually overridden. This allows the strategy to react to the fact that 
a point has been overridden. 

1 or 0 

(checkbox beside 
Manual Override 
point - UC32 
only) 

Beside the Manual Override Point number display, there is a 
checkbox that indicates the value of the point. This is clear if the 
Manual Override Point is '0' and checked if the value is '1'. 

Checked or cleared 

Sequence Period This is the number of 5-second periods that must elapse after a 
controller reset, before the selected output becomes active again. 

0-255 

Relay Close This defines the message that will be displayed in the strategy 
drawing when the digital output is in a high-voltage state. 

On / Off / Open / Closed / Trip / 
Normal 

Relay Open This defines the message that will be displayed in the strategy 
drawing when the digital output is in a high-voltage state. 

On / Off / Open / Closed / Trip / 
Normal 

Advanced options:   

Note 3:  These options are for future use 

Variable name Description Possible values 

Low Threshold Not used N/A 

High Threshold Not used N/A 

Application:    

Digital Outputs are used to carry the following types of signal: 

Lights ON/OFF commands, pump ON/OFF commands, boiler ON/OFF commands, S.A. Fan enable, R.A. Fan enable. 
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Analog Setpoint 

Button: 

  

Symbol: 

  

Value not shown 

  

Value shown 

Function of 
module: 

An analog setpoint can be assigned an analog value which will not be changed at any time by the 
operation of the strategy. However, analog setpoints can be changed by the user in CCView. 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 

 
        

Variables: Variable 
name 

Description Possible values 

  Point 
Number 

This is the number of the point 
to be defined as an analog 
setpoint. 

17 to 255 

  Point 
Name 

Name assigned by the user. Any combination of alphanumeric characters and 
spaces. Letters can be upper case or lower case. 
Maximum recommended length: 20 characters 
and spaces. 

  Units Units of measurement which 
correspond to type of value 
contained in the analog 
setpoint. 

A predefined selection of units is available. 
Additional units of measurement may be entered 
in the WN3000.ini file. 

  Value Analog value assigned to 
analog setpoint. This value will 
be maintained as a constant. 

Any floating point number. 

Application: An analog setpoint is used when the programmer wants the user to be able to change the value. If the 
programmer does not wish to let the user change the value, a constant module should be used. 
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Digital Setpoint 

Button: 

  

Symbol: 

  

Value not shown 

  

Value shown 

Function of 
module: 

A digital setpoint can be assigned a digital value which will not be changed at any time by the operation 
of the strategy. However, digital setpoints can be changed by the end user in CCView. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 

 
 

Variables: Variable name Description Possible values 

  Point Number This is the number of the point to 
be defined as a digital setpoint. 

17 to 255 

  Point Name Name assigned by the user. Any combination of alphanumeric 
characters and spaces. Letters can be 
upper case or lower case. Maximum 
recommended length: 20 characters 
and spaces. 

  Value Digital value assigned to digital 
setpoint. This value will be 
maintained as a constant. 

0 or 1 

  Open Circuit Message to appear when the 
digital setpoint is in an open circuit 
state. 

ON/OFF/Open/Closed/ 
Trip/Normal 

  Short Circuit Message to appear when the 
digital setpoint is in a closed circuit 
state. 

ON/OFF/Open/Closed/ 
Trip/Normal 

Application: A digital setpoint is used when the programmer wants the end user to be able to set or unset a digital 
point in the strategy, e.g., to reset an alarm, to override main plant or to go into manual mode. 

   

  



 

 
 

MAN00058US rev 69 © American Auto-Matrix 463 

Real Constant 

Button: 

  

Symbol: 

  

Values not shown 

  

Values shown 

Function of 
module: 

The Real Constant module allows the values assigned to two analog points to be specified as constant. The 
values assigned to these points can be any real number, up to two decimal places. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 

 
   

Variables: Variable name Description Possible values 

  Constants A and B The values to be maintained as constants 
at output points A and B. 

Any floating point number. 

  Output Points A and 
B 

The numbers of the points to which 
constants A and B are to be written. 

17 to 255 

    

Application: The Real Constant module is used to hold real constants with relation to another block, e.g., as the non-variable 
inputs to a Rescale to 0 and 100 module as shown: 
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Integer Constant 

Button: 

  

Symbol: 

  

Values not shown 

  

Values shown 

Function of 
module: 

The Integer Constant module allows the values assigned to four analog points to be specified as constant. 
The values assigned to these points must be integers. Any non-integer value entered will result in an error 
message requesting that an integer value be input. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 

 
       

Variables: Variable name Description Possible values 

  Constants A, B, C 
and D 

The values to be maintained 
as constants in points A, B, C 
and D. 

Integer (positive or negative) in the range 
-3.2768x104 to +3.2768x104 

  Output Points A, 
B, C and D 

The number of the analog 
points to which the constants 
A, B, C and D are to be 
written. 

17 to 255 
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Application: The Integer Constant module is used to provide constant integer values to another block. In the example 
below, the integer constant module is used to provide non-variable inputs to two Rescale to 0 - 100 
modules. 

 

  

  

  

  

  



 

 

466 © American Auto-Matrix MAN00058US rev 69 

M
A

N
0

0
0

5
8

U
S rev 6

9
 

Digital Extract 

Appearance 

Group 

  (Points) 

 

Button 

 

 

Symbol 

     
  

Dialog box 

 If UC32/BACnet-type Controller is targeted: 

 

 

 If Legacy UC type Controller is targeted: 

 

P 
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Function: 

The Digital Extract module accepts an analog input and converts its integer component to an 8 bit digital expression, which 
is the binary value of the input. 

Because the Digital Extract module converts the input value to an 8-bit digital expression, by default it outputs bits 
equivalent to analog values in the range 0 to 255. However, using the Byte Offset feature, the 8 bits that it outputs can 
represent one of 3 different ranges within larger (up to 24 bit) binary numbers. 

The Digital Extract module is used with the DI hardware module to derive the state of each input on the DI from the single 
analog value outputted from the DI. 

It can also be used in conjunction with the Digital Encode module to send eight digital globals as a single analog global which 
can then be converted back to eight digital globals on receipt. 

Example:  

Input value = 3652 

Equates to a binary value of 000000000000111001000100  

 Byte 0 Byte 1 Byte 2 

Output A 0 0 0 

Output B 0 1 0 

Output C 1 1 0 

Output D 0 1 0 

Output E 0 0 0 

Output F 0 0 0 

Output G 1 0 0 

Output H 0 0 0 

Parameters 

Inputs 

Parameter Name Description Possible values 

Input point Analog value to be converted to 8 binary values. Positive integer 

Constants 

 Only available If UC32/BACnet-type Controller is targeted: 

Parameter Name Description Possible values 

Special This should not be edited  

Byte Offset The 8 bits reflected in the Digital Extract module outputs can 
represent the lowest, highest or middle byte within a 24-bit 
digital number. This parameter sets which byte will be reflected 
in the outputs. Byte 0 returns the lowest byte, Byte 1 returns the 
middle byte and Byte 2 returns the highest byte. 

Note:  Byte Offset functionality is available only 

with Unitron Firmware version 6.2.1 or 

later, or  CBM/CBT Firmware version 7.6.8 
or later. 

 

Byte 0, Byte 1, or Byte 2 
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Outputs 

Parameter Name Description Possible values 

Output points A-H Point at which each component of the 8-bit digital 
expression is output. Significance of output bits increases 
from A to H (A is the least-significant bit) i.e., the 8-bit 
expression reads from H to A. 

set or unset 
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Digital encode 

Button: 

  

Symbol: 

  

Values not shown 

  

Values shown 

Function 
of module: 

The digital encode module accepts eight digital inputs and converts them to an analog expression which 
equals the base 10 value of the binary expression represented by the inputs. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 
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Variables: Variable name Point Value 

  Input points A to H Points at which the digital 
values are input.  

set or unset 

  Output point Point at which the resulting 
analog value is output. 

0 to 255 

        

Implementation of module: Given inputs A, B, C, D, E, F, G, H: 

Output = H*128 + G*64 + F*32 + E*16 + D*8 + C*4 + B*2 + A 

  

  Example: If A = 1; B = 1; C = 0; D = 1; E = 1; F = 0; G = 0; H = 0 

Then Output = 0*128 + 0*64 + 0*32 + 1*16 + 1*8 + 0*4 + 1*2 + 1 = 27 

    

Application: The Digital Encode Module can be used in conjunction with the Digital Extract module to 
allow the programmer to send eight digital globals as one analog global which can then be 
converted back to eight digital globals on receipt. 
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Digital Constant 

Button: 

  

Symbol: 

  

Values not shown 

  

Values shown 

Function of 
module: 

The Digital Constant module allows the values written to four digital points to be specified as constant. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 

 

       

Variables: Variable Name Description Possible values 

  Constants A, B, C 
and D 

The values to be maintained as 
constants in points A, B, C and D. 

0 or 1 

  Output Points A, B, 
C and D 

The numbers of the digital points 
to which the Constants A, B, C 
and D are to be written. 

17 to 255 

    

Application: An example of the Digital Constant module in use is with a PID loop to continually enable a plant. 
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Make Linear 

Button: 

  

Symbol: 

  

Values not shown 

  

Values shown 

Function of 
module: 

The Make Linear module allows a device with a non-linear characteristic to be used as an input. This is 
done by dividing the characteristic curve of the device into linear sections, which can be interpreted.  

This is usually used with temperature-measuring devices. The hardware point attached to the device 
should be programmed to return values in millivolts (mV).  

Note: A lookup table that contains temperatures and corresponding voltage values must be made up. 
This table is made up from the values of a series of consecutive points in the strategy. These points can 
be the outputs of 'Analog setpoint', 'integer', or 'real constant' blocks, but it is important that the point 
numbers of these outputs of must be consecutive. For each of the linear sections into which the input 
characteristic is divided, there must be a start and end value. The total number of setpoints, integers, or 
constants required is therefore one more than the number of steps. The points are defined by specifying 
the point number of the first point, and the total number of points making up the table. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 
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Variables: Variable Name Description Possible values 

  Input Point  The number of the point containing the 
current value of the non-linear input.  

1 to 8 

  Input Point Value The current value of the non-linear input.  Any real number 

  Start of Table Point The number of the point where the first value 
in the lookup 'table' is stored. 
The 'table' is made up of the values of a set of 
consecutive points. For instance, these points 
can be the outputs from a number of Analog 
Setpoint blocks. The setpoints must be given 
values that match the expected input 
characteristic, and their point numbers can be 
set to any values within the strategy but must 
be consecutive. The "Start of Table' point on 
the Make Linear block must be connected to 
the first of those consecutive points. 

17 to 255 

  Start of Table Value The first value in the lookup table. Any real number 

  Output Point  The number of the point to contain the value 
of the linear output. 

17 to 255 

  Output Point Value The current value of the linear output. Any real number 

  Number of Linear 
Steps 

This must be set to the total number of 
POINTS that make up the in the conversion 
table. 

Any integer 

  Start of Linear Range Start of range of input. Any real number 

  End of Linear Range End of range of input. Any real number 

  Negative Temp. Coeff. Set if input has a negative coefficient of 
resistance (i.e. if resistance drops as 
temperature rises). 

Set or unset 

               

Implementati
on of module 
(example): 

A temperature sensor is connected to a controller as shown below. The resistances at a range of 
temperatures are given in the datasheet supplied with the sensor and are shown in the first two 
columns of the table below.  

  

  

  

The Make Linear module requires that the input should be converted to mV and that all values of the 
input should fall in the range 0mV to 2500 mV. In order to constrain the mV values to this range, a 
resistor is placed in parallel as shown. The lookup table can be constructed as follows:  

The final resistance is calculated by means of the equation for resistors in parallel:  

R = (r1xr2)/(r1+r2).  
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For example, at a temperature of 5ºC, the final resistance = (4090x3300)/(4090+3300) = 1826.4 

 I is constant, and can be calculated as I = V/R - 5/(5100+R), where R is the final resistance. 

  

The value in mV for each temperature is given by V = IR, where I = 5/(5100+R) as shown above. 

For example, at a temperature of 5oC, the value in mV = (5/(5100+1826.4) x 1826.4 = 1.3184 volts or 
1318.4 mV. 

 

  Temperature Initial Ohms Resistor in 
parallel 

Final resistance mV 

  -5 6450 3300 2183.1 1498.7 

  0 5120 3300 2006.7 1411.8 

  5 4090 3300 1826.4 1318.4 

  10 3290 3300 1647.5 1220.8 

  15 2670 3300 1475.9 1122.2 

  20 2180 3300 1312.8 1023.6 

  25 1800 3300 1164.7 929.6 

  30 1490 3300 1026.5 837.8 

  35 1265 3300 914.5 760.2 

  40 1040 3300 790.8 671.2 

  45 890 3300 701.0 604.2 

  50 740 3300 604.5 529.8 

  55 640 3300 536.0 475.5 

  60 540 3300 464.1 417.0 
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   The number of steps (points) in the lookup table is decided by the number of divisions required to 
preserve linearity. In this case, the figures in bold in the table indicate the divisions between which 
linearity is preserved, so the lookup table, which starts at point 17 will be as follows: 

    Point Value   

    17 417.0   

    18 529.8   

    19 671.2   

    20 837.8   

    21 1023.6   

    22 1220.8   

    23 1411.8   

  Making a total of 7 points (which is entered in the "number of Linear Steps" section of the dialog box). 

 A strategy implementing this 'Make Linear' function might appear as shown: 

 
 Note: the values of the setpoints must be consecutive. These can be edited by right-clicking on each of 
the setpoint modules, which opens the Make Linear dialog box. 

The example shows Analog setpoints providing the lookup table values. It would also be possible to use 
Real Constant blocks (which would set two table values per block) or Integer blocks (which provide 4 
table values per block) 
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Digital Extract DI (UC24PG Digital Input module) 

Appearance 

Group 

  (Points) 

 

Button 

 

 

Symbol 

 

 Dialog box 

 

Function:  

The UC24 Digital Input Module is used to access the UC24PG-R’s 8 digital-only inputs. In the PG-R range, 16 strategy points 

are allocated to inputs and outputs, but the UC24PG-R’s digital-only inputs do not lie in this range. As a result, the UC24 
Digital Input Module must be used. It allows access to the digital inputs at the next available 8 consecutive points in the 
strategy. 

The controller monitors the digital inputs at 35 ms intervals and performs a vote based on the last 3 readings to determine if 
the input is open, shorted or 24 V ac. 

Note:  This module can only be placed in a strategy that is running on a UC24PG-R controller. 

 

Parameters 

P 
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Parameter Name Description Possible values 

Block Number This shows the number of the block within the UC24PG-R 
controller occupied by this module.  

any value between 17 
and 255. 

Output Point This box shows the point number assigned to each output. 
These are automatically assigned, and cannot be changed. 

17 to 255 

Output Name If a point to which an output is connected has been given a 
name, the name will be displayed here. The name cannot 
be changed in this dialog. 

Text string 

Extra Digital Inputs This setting specifies the condition detected at each of the 
UC24PG-R digital-only  inputs that will cause the module’s 
outputs to be” True” :  

 if the input is shorted to common, or 

 if 24 V ac is detected.   

The module outputs can also be set if either condition is 
detected (this is the default condition). 

A typical use for this distinction is monitoring a 24 V ac 
output connected to a lamp.  The lamp acts as a short 
circuit so that the 24 V ac status would not be detected if 
either  ‘Short Circuit Detect ‘ or ‘Both’ was selected.   

24V Ac Detect 

Short Circuit Detect 

Both 
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DI Module (UC16DI Digital Inputs) 

Button:  

  

Symbol:  

  

Value not shown 

  

Value shown 

Function 
of module: 

This module brings the inputs from a UC16DI module into a strategy in a single block. 

Note: 2 blocks and 2 local globals are used whenever this module is inserted in a strategy. 
 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 
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Variables: Variable name Description Possible values 

  DI Source address This drop-down list allows you to 
select one of the UC16DI modules 
available on the current Cylon 
Network. 

1 to 16 

  Global Details - 
Global number 

The UC16DI module sends its inputs 
to a Field Controller strategy using 
two local globals. These are brought 
into the strategy by means of 2 
analog set points. The two boxes 
marked "Global" show the numbers 
of the globals that are assigned to 
the selected UC16DI. 

The next two available global 
numbers. 

(These will be in the range 1-255) 

  Global Details - 
Point number 

The box marked "Point" beneath 
each global number shows the 
number of the setpoint through which 
that global is brought into the 
strategy. 

The next two point numbers 
available in the strategy. 

(These will be in the range 17-
255) 

  Global Details - 
Point value 

This shows the value of the setpoint 
specified in the "Global Details - 
Point number" box. 

This value should be "2000" if the 
module is functioning correctly. 

  Module details – 
Digital extract 1 

The information received by the 
globals is converted into digital 
signals by two digital extract 
modules. They are automatically 
assigned the next module numbers 
available in the strategy. The "Digital 
extract 1" and "Digital extract 2" 
boxes show the numbers that have 
been assigned. 

The next available module 
numbers 

(These will be in the range 17-
255) 

  Input (1-16) Each of the 16 input point number 
boxes shows the point number within 
the strategy to which that input has 
been connected. 

17-255 

  Value (for inputs 1-
16) 

The value box for each input shows 
the current value of that input. 

0 or 1 
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Meter 

Appearance 

Group 

  (Points) 

 

Button 

 

Symbol 

 

Dialog box 

 If UC32/BACnet-type Controller is targeted: 

 

 If Legacy UC type Controller is targeted: 

 

Function:  

The Meter module records the "pulse count" reported by an external electricity meter (which is delivered to the module as 
an analog value). The value of the "pulse count" (which is constantly changing) is only recorded when a "synchronizing 
pulse" is received at the Meter module's digital input. 

The Meter module is used for calculating electrical energy use over a specific period (e.g. daily or weekly) 

This synchronizing pulse may be provided either by the external meter or by the module itself. 

Note:  Each pulsed input from an external meter can only be connected to a single Meter module in the strategy. If for 
example, power consumption is to be measured over two time periods (e.g. hourly and monthly) 
simultaneously from the same meter, this must be calculated elsewhere in the strategy. 

 

P 
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Note:  The Meter Sync point overrides the Meter module's monitoring period, so that if a digital input is connected to 

the Meter Sync point, the Meter module will not update the 'total count', 'last count' or 'last count-1' values at 
the end of the monitoring period. The Meter Sync point is intended for use only in cases where Maximum 
Demand Tariff agreements are in place with a utility company, and the utility company provides a synchronizing 
pulse. 

   

 Parameters 

Inputs 

 If UC32/BACnet-type Controller is targeted: 

Parameter Name Description Possible values 

Meter Counter  
 
 This reflects the "pulse count" at the external meter since 

the last 'synchronizing pulse'. 
Real Number 

Meter Sync  
 
 When this is set, outputs are updated. Set or unset 

 

 If Legacy UC type Controller is targeted: 

Parameter Name Description Possible values 

Meter Count 

Point  

Number of the controller's analog input point which 
reflects the analog value ("pulse count") reported by the 
external meter. 

1 to 8 (must be controller 
analog input) 

Meter Count Value 

 

This is the current value of the input point specified above. 
It reflects the "pulse count" at the external meter since the 
last 'synchronizing pulse'.  

  

Meter Sync 

Point 

(on input side) 

Number of the controller's digital input point at which 
external meter's synchronizing pulse is received. 

1 to 8 

Meter Sync Value This is the current value of the input point specified above. 
When this is set, outputs are updated. 

Set or unset 

 

Constants 

Parameter Name Description Possible values 

Scale Value Factor for converting pulses to physical units. e.g. if 3 
pulses = 1 kWh, then Scale Value = .333. 

Positive integer (not 0) 

Period Length of time in seconds of the Monitoring Period. This 
value must be specified. 

Any integer value 

 

  

I 

S 

I 

S 
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Outputs 

 If UC32/BACnet-type Controller is targeted: 

Parameter Name Description Possible values 

Total Count This is the current value of the strategy point specified 
above. This value reflects the cumulative total of the values 
recorded at the Meter Count Point (i.e. the total amount of 
energy units used) since the strategy started servicing.  

Positive integer 

Last Count This is the current value of the strategy point specified 
above, i.e. the value of the input point when the last 
synchronising pulse was received ("Last Count" value).  

Positive integer 

Last-1 Count This is the current value of the strategy point specified 
above, i.e. the value of the "Last Count" point (c1) before 
the last synchronising pulse was received. 

Positive integer 

Sync Output  The value of this point is ‘set’ (on) for one scan cycle at the 
end of the Monitoring Period, then becomes unset again. 

Set or unset 

Max Demand 

Period Value 

(not operational) Set or unset 

 

 If Legacy UC type Controller is targeted: 

Parameter Name Description Possible values 

Total Count Point Number of strategy point at which "Total Count" value 
is held.  

9 to 255 

Total Count Value This is the current value of the strategy point specified 
above. This value reflects the cumulative total of the 
values recorded at the Meter Count Point (i.e. the total 
amount of energy units used) since the strategy started 
servicing.  

Positive integer 

Last Count Point Number of the strategy point at which "Last Count" 
value is held. 

9 to 255 

Last Count Value This is the current value of the strategy point specified 
above, i.e. the value of the input point when the last 
synchronizing pulse was received ("Last Count" value).  

Positive integer 

Last-1Count Point Number of the strategy point at which "Last-1 Count" 
value is held. 

9 to 255 

Last-1 Count Value This is the current value of the strategy point specified 
above, i.e. the value of the "Last Count" point (c1) 
before the last synchronizing pulse was received. 

Positive integer 

Sync Output Point Number of the strategy point at which Sync Output 
value is held.  

9 to 255 

Sync Output Value The value of this point is ‘set’ (on) for one scan cycle at 
the end of the Monitoring Period, then becomes unset 
again. 

Set or unset 

Max Demand Period 

Point 

(not operational) 17 to 255 

Max Demand Period 
Value 

(not operational) Set or unset 

  

T 

c1 

c2 

S 

M 

T 

c1 

c2 

S 

M 
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Uniput Extract 
  

Button: 

 

  

Symbol: 

 
Values not shown 

 
Values shown 

  

Function of 
module: 

When a UniPut is set as a 'Digital input' (see How to configure a UniPut), its value can be entered into a 
strategy using a Digital Input module. The Digital Input module can be set to read the UniPut as an Active (0-
10 V) input or as a Passive (Volt Free) input, in exactly the same way as it would read a Universal Input.  

However, Cylon's unique UniPut technology can also detect the presence or absence of 24 V AC in addition 
to 0-10 V, allowing even greater flexibility. The Digital Input module itself does not distinguish between 
these two active states, so that a 'true' ('On' or '1') signal from a Digital Input module may represent any one 
of the following three states: 

 0 - 10 Volts is present at the terminal 

 24 Vac is present at the terminal 

 There is a short circuit between the terminal and GND. 

It is possible to determine which of the above is true by combining the Digital Input module with the 'UniPut 
Extract' module. 

The UniPut Extract Module is accessed from the 'Points' toolbar - it is usually the rightmost icon on the 
toolbar. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 

Not applicable 
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Variables: Variable name Description Possible values 

 InputA This point is connected to an input point representing a 
UniPut configured as a digital input. 

1 or 0 

 A Outputs '1' if either:  
Digital Input is set to 'active' and 10 V is present at the UniPut 
terminal 
Digital Input is set to 'passive' and the UniPut terminal is 
short-circuited to GND 

1 or 0 

 B Outputs '1' if either:  
Digital Input is set to 'active' and 0 V is present at the UniPut 
terminal 
Digital Input is set to 'passive' and the UniPut terminal is an 
open-circuit 

1 or 0 

 C Outputs '1' if either:  
Digital Input is set to 'active' and 24 Vac is present at the 
UniPut terminal 
Digital Input is set to 'passive' and 24 Vac is present at the 
UniPut terminal 

1 or 0 

Implementation 
of module: 

The UniPut Extract module is used in conjunction with a digital input module: 

  
The setting of the Digital input module ("active" or "passive") and the values of the 3 output points will 
show the exact state of the UniPut input terminal. 

 Digital Input setting: Input Terminal State Module outputs  

Active  

(0-10V) 

0 V present A = 0  

B = 1 

C = 0 

 

10 V present A = 1  

B = 0 

C = 0 

 

24 Vac present A = 0 

B = 0 

C = 1 

 

Passive  

(Volt Free) 

Shorted to GND A = 1 

B = 0 

C = 0 

 

Open Circuit A =  0 

B = 1 

C = 0 

 

24 Vac present A = 0 

B = 0 

C = 1 

 

Application: For determining the type of input being received at a Digital Input terminal. 

   



 
 

 

 

 

SECTION 23 :  LOGIC MODULES  
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Edge Triggered latch 

    

Button: 

  

    

Symbol: 

  

Values not shown 

  

Values shown 

      

Function of 
module: 

The Edge Triggered Latch module is used to detect and record the change in state of a digital point. 
The term "edge triggered" means that the outputs contain a record of the input points’ changes in 
state rather than their current states. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 
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Variables: Variable name Description Possible values 

  Low to High (LTH) 
Input Point 

Number of point at which Low to High Input value is held. 
May be omitted. 

17 to 255 

  Low to High (LTH) 
Input Value 

If Low to High Input Point has been specified, each time 
this value changes from 0 to 1 the True Output value 
becomes set; otherwise ignored. 

Set or unset 

  High to Low (HTL) 
Input Point 

Number of point at which High to Low Input value is held. 
May be omitted. 

17 to 255 

  High to Low (HTL) 
Input Value 

If High to Low Input Point has been specified, each time 
this value changes from 1 to 0 the True Output value 
becomes set; otherwise ignored. 

Set or unset 

  Clear Input Point Number of point at which Clear Input value is held. May be 
omitted. 

17 to 255 

  Variable name Description Possible values 

  Clear Input Value If Clear Input Point is specified, the True Output will be 
unset if the value here is 1; otherwise ignored. Note: the 
effect of this value overrides the effect of the Enable Input 
value.  

Set or unset 

  Enable Input (Point) Number of point at which Enable Input Value is held. May 
be omitted. 

17 to 255 

  Enable Input Value If Enable Input Point is specified, this value must be set for 
the latch to function. If it is unset, the two data inputs will 
not be monitored and the outputs will remain in the states 
they were in before the Enable Input Value became unset; 
otherwise ignored. 

Set or unset 

  True Output (Point) Number of point at which True Output is held. 9 to 255 

  True Output Value Value here is set if LTH Input Value goes from 0 to 1 or if 
HTL Input Value goes from 1 to 0, provided Enable Input 
Value is set and Clear Input Value is unset 

Set or unset 

  Complement Output 
(Point) 

Number of Point at which complement of True Output 
Value is held 

9 to 255 

  Complement Output 
Value 

Complement of True Output Value Set or unset 

       

Timing 
diagram: 

  

Application: If an event happens, the plant must be held off until a manual reset button is pressed. 
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Timer with constant inputs 

    

Button: 

  

    

Symbol: 

  

Values not shown 

  

Values shown 

      

Function of 
module: 

The Timer with Constant Inputs module switches the state of a digital input point to a digital output 
taking into account up to three delay timers before the servicing of the output point. The module 
accepts two digital inputs - the point value being switched and a reset point value which can 
override the operation of the module - and produces two digital outputs which are complements of 
each other. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 
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Variables: Variable name Description Possible values 

  Trigger Point Number of point at which Trigger Point Value is 
held. 

1 to 255 

  Trigger Point Value Value on which module will operate to produce 
output. 

Set or unset 

  Reset Point Number of point at which Reset Point Value is 
held. 

1 to 255 

  Reset Point Value When this is set, True Output is set until this 
becomes unset. Overrides operation of 
module. 

Set or unset 

  ON Delay Period in seconds for which the Trigger Point 
Value must be set before the True Output Point 
is serviced. 

Positive integer 

  OFF Delay Period in seconds for which the Trigger Point 
Value must be unset before the True Output 
Point is serviced. 

Positive integer 

  Minimum ON Time Minimum period in seconds for which the True 
Output must remain set once it has become 
set. 

Positive integer 

  True Output Point Number of point at which True Output Value is 
held. 

9 to 255 

  True Output Value Will be set after the period specified in the ON 
delay if the Trigger Point Value becomes set. 
Will be unset after the period of the OFF delay 
if the Trigger Point Value becomes unset 

Set or unset 

  Complement Output 
Point 

Number of point at which the complement of 
the True Output Value is held 

9 to 255 

  Complement Output 
Value 

Complement of True Output Value Set or unset 

    

Timing diagram: 

  

    

Application: The Timer with Constant Inputs module is normally used when the time delay will never have to be 
changed by the end user. 
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Timer 

    

Button: 

  

    

Symbol: 

  

Values not shown 

  

Values shown 

      

Function of 
module: 

The Timer module enables the state of a digital input point to be switched to a digital output with 
up to three delay timers taken into account before the output point is serviced. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 
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Variables: Variable name Description Possible values 

  ON Delay Point The point number at which the ON Delay value 
is held. 

17 to 255 

  ON Delay Value The period in seconds which must elapse after 
the trigger point is set before the true output 
point is set. The trigger point must be set for 
longer than the ON delay time in order to set the 
true output point. 

Positive real number 

  OFF Delay Point  The point number at which the OFF Delay value 
is held. 

17 to 255 

  OFF Delay Value The period in seconds which must elapse after 
the trigger point is unset before the true output 
point becomes unset. The trigger point must be 
unset for longer than the OFF delay time in 
order to unset the true output point. 

Positive real number 

  Min ON Time Point Point number at which the Min ON Time value is 
held. 

17 to 255 

  Min ON Time Value Minimum period in seconds for which the true 
output point must be set.  

Positive real number 

  Trigger Point Point number at which the trigger point value is 
held. 

17 to 255 

  Trigger Point Value Value of digital input to the module. Set or unset 

  Reset Point Point number at which Reset Point value is held. 17 to 255 

  Reset Point Value When this is set, true output point is unset and 
vice versa, and all the times are put back to 
zero. 

Set or unset 

  True Output Point Point number at which True Output Point value 
is held. 

9 to 255 

  True Output Value Set when trigger point is set, after any ON 
delays have expired. Unset when trigger point 
becomes unset if trigger point remains unset for 
longer than the specified OFF delay. 

Set or unset 

  Complement Output 
Point 

Point number at which complement of True 
Output Point value is held. 

9 to 255 

  Complement Output 
Value 

Complement of True Output Point value. Set or unset 

Timing diagram: 

  

Application: If a boiler switches off at the end of occupancy, then the pump must remain on for one hour after 
that time. This is implemented as follows: 
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Timer with minimum off time 

Appearance 

Group 

 
  (Logic) 

 

Button 

 

 

Symbol 

     

  

Dialog box 

 If UC32/BACnet-type Controller is targeted: 

 

 If Legacy UC type Controller is targeted: 

 

Function:  

The Timer with Minimum Off Time module outputs a digital value based on an inputted digital value but taking into 
account up to four delay timers. The module accepts two digital inputs - the value being passed through and a reset point 
value which can override the operation of the module. It produces two digital outputs which are complements of each 
other. 

This can be used, for example, to control fans which cannot be switched on for a certain period once they have been 
switched off. 

It also includes “one-shot” functionality, in which the input point is automatically reset as soon as the output is triggered. 

  

L 
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Parameters 

Inputs 

 If UC32/BACnet-type Controller is targeted: 

Parameter Name Description Possible values 

Trigger Point  Value which module will operate on to produce output. Set or unset 

Reset Point  When this is set, True Output is set until this becomes 
unset. Overrides operation of module. 

Set or unset 

 If Legacy UC type Controller is targeted: 

Parameter Name Description Possible values 

Trigger Point Number of point at which Trigger Point Value is held. 1 to 255 

Trigger Point Value Value which module will operate on to produce output. Set or unset 

Reset Point Number of point at which Reset Point Value is held. 1 to 255 

Reset Point Value When this is set, True Output is set until this becomes 
unset. Overrides operation of module. 

Set or unset 

Constants 

 If UC32/BACnet-type Controller is targeted: 

Parameter Name Description Possible values 

ON Delay Period in seconds for which the Trigger Point Value must 
be set before the True Output Point is serviced. 

Positive integer 

OFF Delay Period in seconds for which the Trigger Point Value must 
be unset before the True Output Point is serviced. 

Positive integer 

Minimum ON Time Minimum period in seconds for which the True Output 
must remain set once it has become set. 

Positive integer 

Minimum OFF Time Minimum period in seconds for which the True Output 
must remain unset once it has become unset. 

Positive integer 

One-Shot If this is enabled then the Trigger point will be reset as 
soon as the True output becomes set – i.e. after the ON 
delay has expired. This means that the OFF delay and 
Minimum ON Time are triggered immediately. 

Note:  One-shot functionality is available only 

with Unitron Firmware version 6.2.1 or 

later, or CBM/CBT Firmware version 7.6.8 

or later. 

Enable / Disable 

 If Legacy UC type Controller is targeted: 

Parameter Name Description Possible values 

ON Delay Period in seconds for which the Trigger Point Value must 
be set before the True Output Point is serviced. 

Positive integer 

OFF Delay Period in seconds for which the Trigger Point Value must 
be unset before the True Output Point is serviced. 

Positive integer 

Minimum ON Time Minimum period in seconds for which the True Output 
must remain set once it has become set. 

Positive integer 

Minimum OFF Time Minimum period in seconds for which the True Output 
must remain unset once it has become unset. 

Positive integer 
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 Timing diagrams 

UC32/CBM with one-shot parameter unset  and Legacy controllers: 

 

    Output      Input  ON delay   OFF delay     Minimum OFF time    Minimum ON time 

 

If the one-shot parameter is set (UC32/CBM only), then when the output goes ON, the input is reset to OFF 

 

    Output      Input  ON delay   OFF delay   

 

Outputs 

 If UC32/BACnet-type Controller is targeted: 

Parameter Name Description Possible values 

True Output  Will be set after the period specified in the ON delay if the 
Trigger Point Value becomes set. Will be unset after the 
period of the OFF delay if the Trigger Point Value becomes 
unset. 

Set or unset 

Complement Output  Complement of True Output Value. Set or unset 

 If Legacy UC type Controller is targeted: 

Parameter Name Description Possible values 

True Output Point Number of point at which True Output Value is held. 9 to 255 

True Output Value Will be set after the period specified in the ON delay if the 
Trigger Point Value becomes set. Will be unset after the 
period of the OFF delay if the Trigger Point Value becomes 
unset. 

Set or unset 

Complement Output 
Point 

Number of point at which the complement of the True 
Output Value is held. 

9 to 255 

Complement Output 
Value 

Complement of True Output Value. Set or unset 

 
 

a b c d c d 

a b c d 
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Boolean (combination of digital inputs) 

Button: 

 

  

      

Symbol: 

  

Values not shown 

  

Values shown 

      

Function of 
module: 

The Boolean module allows the user to perform Boolean algebraic operations on up to four digital inputs. 
AND, NAND, OR, NOR and NOT operations can be performed using this module. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 
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Variables: Variable name Description Possible values 

 InputA  
InputB  
InputC  
InputD 

The point numbers and current values of the 4 
possible input points are displayed in these fields  

0 or 1 

 True Output Displays the point number and value of the 'true' 
output. 
This point will have a value of "1" if the expression 
represented in the "Constants" column is TRUE. 

0 or 1 

 Compliment Displays the point number and value of the 
'compliment' output. 
This is the 'compliment' of OutputA, i.e. will have a 
value of "1" if the expression represented in the 
"Constants" column is FALSE. 

0 or 1 

    

Constants: 
(UC32 only) 

The "constants" column in the Boolean Combination of Digital Inputs lists 'actions' rather than ordinary 
constants. 
There are 4 columns of checkboxes. Each column represents an "AND" action, and the results of each 
column are combined by "OR" to give the overall result, which is outputted from the module. 
To include an input in one of the 4 "AND" operations, click on the box that is in line with that input in the 
required column. The box cycles through three states each time you click on it. The three states are: 

 Include the value of the input   

 Ignore the value of the input   

 Include the inverse of the input value   
 

  

Example:  In the following illustration the output of the module will be  

[(A) AND not(B)]  

OR  

[not(A) AND not(B) AND C AND D]  

OR  

[B AND C] 
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Wide OR gate 

    

Button: 

  

      

Symbol: 

  

Values not shown 

  

Values shown 

    

Function of 
module: 

The Wide OR Gate module performs the Boolean OR operation on up to 11 digital inputs.  

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 

 

 

       

Variables: Variable name Description Possible values 
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  Input Points A to K Numbers of points at which digital Input 
Point Values A to K are held. Any Input 
Point without a number will be ignored in the 
operation of the module. 

1 to 255 

  True Output Point Number of point at which True Output Value 
is held. 

9 to 255 

  True Output Value Value returned when Boolean OR operation 
is performed on Input Point Values. 

Set or unset 

  Complement Output 
Point 

Number of point at which complement of 
True Output Value is held. 

9 to 255 

  Complement Output 
Value 

Complement of True Output Value. Set or unset 

    

Implementat
ion of 
module: 

The Wide OR Gate module performs the Boolean OR algebraic operation on up to 11 digital inputs. This 
means that A OR B OR C OR D OR E OR F OR G OR H OR I OR J OR K (also written as 
A+B+C+D+E+F+G+H+I+J+K) = set if any one of the inputs is set 

  For example, If A = unset, B = unset, C = unset, D = unset, E = unset, F = unset, G = set, H = unset, I = unset, 
J = unset, K = unset, then  

A + B + C + D + E + F + G + H + I + J + K = set, because G = set 

    

Application: 1) The Wide OR Gate can be used to parallel up seven time schedule modules so that the user has a full 
week. 

2) The Wide OR Gate can also be used as a common alarm - i.e. ring a bell if any of X events happens. 
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Wide AND gate 

Button: 

  

Symbol: 

  

Values not shown 

  

Values shown 

 Function of 

module: 
The Wide AND Gate module performs the Boolean AND operation on up to 11 digital inputs. 

  

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 
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Variable Variable name Description Possible values 

  Input Points A to K Numbers of points at which digital Input 
Point Values A to K are held. Any Input 
Point without a number will be ignored 
in the operation of the module. 

1 to 255 

  Input Point Values A to K Values of inputs to the module. Any 
Input Point Value with no Input Point 
defined will be ignored in the operation 
of the module. 

Set or unset 

  True Output Point Number of point at which True Output 
Value is held. 

9 to 255 

  True Output Value Value returned when Boolean AND 
operation is performed on Input Point 
Values. 

Set or unset 

  Complement Output Point Number of point at which complement 
of True Output Value is held. 

9 to 255 

  Complement Output Value Complement of True Output Value. Set or unset 

    

Implementatio
n of module: 

The Wide AND Gate module performs the Boolean AND algebraic operation on up to 11 digital inputs. 
This means that A AND B AND C AND D AND E AND F AND G AND H AND I AND J AND K (also written as 
ABCDEFGHIJK) = unset, if any one of the inputs is unset. 

  For example, If A = set, B = set, C = set, D = unset, E = set, F = set, G = set, H = set, I = set, J = set, K = set, 
then  

A AND B AND C AND D AND E AND F AND G AND H AND I AND J AND K (also written as ABCDEFGHIJK) = 
unset, because D = unset 

    

Example: The Wide AND Gate can be used if a certain number of events must happen before you can turn on 
another device. 
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Wide Inverter 

Button: 

  

Symbol: 

  

Values not shown 

  

Values shown 

      

Function of 
module: 

The Wide Inverter Gate module performs the Boolean INVERT operation on up to 6 digital inputs. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 
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Variables: Variable name Description Possible values 

  Input Points A to F Numbers of points at which digital Input 
Point Values A to F are held. Any Input 
Point without a number will be ignored in 
the operation of the module. 

1 to 255 

  Input Point Values A 
to F 

Values of inputs to the module. Any Input 
Point Value with no Input Point defined will 
be ignored in the operation of the module. 

Set or unset 

  Output Points A to F Numbers of points at which Output Point 
Values are held. 

9 to 255 

  Output Point Values 
A to F 

Inverse of Input Point Values A to F Set or unset 

    

Implementation of 
module: 

Given inputs A, B, C, D, E, F: Output A= 
Inverse (Input A) etc. 

  

    

Application: The Wide Inverter Gate is normally used when the output of another module needs to be inverted. 
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Time Schedule 

    

Button: 

  

    

Symbol: 

  

Values not shown 

  

Values shown 

      

Function 
of module: 

The Time Schedule module allows the user to set, for each day of the week, two start times and two stop 
times. If the module is enabled, then when the controller's clock registers a time between each start and 
stop time, on any selected day, the output of the module will be "1", and outside of those times it will be 
"0". This module accepts one input, which enables the operation of the module, and produces two outputs 
that are complements of each other. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 
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Variables: Variable name Description Possible values 

 Time Schedule Name This is a string that will be used 
by the Cylon system to identify 
the Time Schedule defined by 
this dialog. 

Any string. 

 Enabling Point  

 

The point number and current 
values of the enabling point for 
this module are displayed here. 
When the value of this point is 
"1", the module becomes active. 

0 or 1 

 True Output This point will have a value of 
"1" if the current controller time 
is between either of the start 
and end times on any day. 

0 or 1 

 Compliment This is the 'compliment' of 
OutputA, i.e. will have a value of 
"0" if the current controller time 
is between either of the start 
and end times on any day. 

0 or 1 

    

Constants The "constants" column in Time Schedule dialog lists times and days rather than ordinary constants. 

In this section it is possible to set two separate periods of time, during a day, at which the output of 
this module is to be "On" ("1"). These two times can apply on any or all days of the week. 

 

 Variable name Description Possible values 

 Times  

 

The four times entered here 
govern the start and end of two 
periods in a day during which 
the output of the time schedule 
will be "On" 

00:00 - 23:59 

 Days Checkboxes are provided here 
for each of the 7 days of the 
week. Any day or group of days 
can be selected or deselected 
here, and on those days that are 
selected the time schedule times 
defined above will apply.  

selected or unselected 

  

Application: In the dialog box above, the time schedule module is being used to turn the boilers on site on and off 
on in the morning and afternoon,  Monday to Friday only. 

Seven of these are usually used in parallel so that each day may have different on and off times.  

 

Another use of the Time Schedule module is to reset certain parameters automatically in the middle of 
the night - e.g. set all the remote temperature keypad setpoints to 21

o 
C. 
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Holiday schedule 

    

Button: 

  

    

Symbol: 

  

Values not shown 

  

Values shown 

    

Function 
of module: 

The Holiday Schedule module is intended to allow a 'holiday' period to be programmed into the controller. 
If the module is enabled, then when the controller's clock registers a time between the specified start time 
and date and the specified stop time and date, the output of the module will be "1", and outside of those 
times it will be "0". 'Holiday' Schedules are intended to set a building environment differently on certain 
days, e.g. disabling the boiler for an office block during a public holiday. This module accepts one input, 
which enables the operation of the module, and produces two outputs that are complements of each 
other. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 
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Variables: Variable name Description Possible values 

 Time Schedule Name This is a string that will be used by the 
Cylon system to identify the Time 
Schedule defined by this dialog. 

Any string. 

 Enabling Point  

 

The point number and current values of 
the enabling point for this module are 
displayed here. When the value of this 
point is "1", the module becomes active. 

0 or 1 

 True Output This point will have a value of "1" if the 
current controller time is between the 
start time & date, and end time & date. 

0 or 1 

 Compliment This is the 'compliment' of OutputA, i.e. 
will have a value of "0" if the current 
controller time is between the start time 
& date, and end time & date. 

0 or 1 

    

Constants The "constants" column in Holiday Schedule dialog lists times and days rather than ordinary constants. 

In this section it is possible to set a start time and date, and an end time and date, between which the 
output of this module is to be "On" ("1"). The module output will be "Off" ("0") outside those times. 

Note:  The dates 
must be entered in dd/mm/yy format 

 

  

Application: Given the settings in the dialog box above, the True Output Value could be used to switch on the alarm 
system while the Complement Output Value could be used as the Enabling Point Value for a time 
schedule module controlling the heating system. This would mean that the alarm system would by 
switched on during the holiday period and the heating system would be switched off. 

This is normally used on a UC16 Keypad, or the user can override for holiday periods. 
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Long Period Timer 

    

Button: 

  

    

Symbol: 

  

Values not shown 

  

Values shown 

      

Function of 
module: 

The Long Period Timer module allows the user to set a digital point for a specified time, which may vary 
from one second to several years in length. When the controller's clock registers a time between the 
specified start time & date and the specified stop time & date, the output of the module will be "1", and 
outside of those times it will be "0". This module has no inputs, and produces two outputs that are 
complements of each other. This is the same as the Holiday Schedule module, with the exception that 
there is no enabling point. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 
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Variables: Variable name Description Possible values 

 True Output This point will have a value of "1" if the 
current controller time is between the 
start time & date, and end time & date. 

0 or 1 

 Compliment This is the 'compliment' of OutputA, i.e. 
will have a value of "0" if the current 
controller time is between the start time 
& date, and end time & date. 

0 or 1 

    

Constants: The "constants" column in the Long Period Timer dialog lists times and days rather than ordinary 
constants. 

In this section it is possible to set a start time and date, and an end time and date, between which the 
output of this module is to be "On" ("1"). The module output will be "Off" ("0") outside those times. 

Note:  The dates must 
be entered in dd/mm/yy format 

 

    

  

Application: The dialog box above shows a long period timer which is set from 25 May 2000 to 15 April 2001. The True 
Output Point of this module could be used as the enabling point for a time schedule module controlling 
the switching on and off of the heating system on a site, so that heating is only switched on during the 
months October to April. 
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Adjust Schedule 

    

Button: 

  

    

Symbol: 

  

Values not shown 

  

Values shown 

    

Function of 
module: 

This module acts as a time schedule in a Field Controller, but is tied to a Comms Controller Time Schedule. 
This allows controllers to act at different times in response to a master schedule. 

    

Note: The Time values used in the Adjust Schedule module are held in decimal format, e.g. "8.50" means 8:30 
am, 15.75 means 3:45pm. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 

 
   

Application: A building’s facilities include Heating (Air Conditioning), lighting, and Extract Fans. 
The Building is occupied from 9:00am to 5:30pm. This occupancy is set in the main Comms Controller time 
schedule. 
The heating is to be turned on 2 hours earlier, in order to bring the temperature throughout the building 
up to its setpoint for the start of occupancy (9:00). The lighting must be turned on at the time of 
occupancy, and the Extract fans 15 minutes after occupancy begins. 
In this example, the Lighting could be switched directly by the Comms Controller time schedule, the Fans 
would be switched by an "adjust schedule" module set to 0.25hours, and the heating could be set by an 
"adjust schedule" module set to –-2.00 hours 
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Variables: Variable name Description Possible values 

  On Time per 
UCC4 - Point 

A Comms Controller schedule can be sent by means of a "Time Schedule 
Global" to a Field Controller.  

That global is received through a "Comms Controller Schedule" module, 
which gives the current on/off value, the next on time, and the next off time 
for the schedule. 

The "On Time per UCC4" point in the "Adjust schedule" module should be 
connected to the "Next On" point in the "Comms Controller Schedule" 
module. 

  

  On Time per 
UCC4 - Value 

This box shows the current value of the point shown in the "On Time per 
UCC4 – Point" box. 

  

  Off Time per 
UCC4 - Point 

The "Off Time per UCC4" point in the "Adjust schedule" module should be 
connected to the "Next Off" point in the "UCC4 Schedule" module. (see 
"On Time per UCC4 - Point" above) 

  

  Off Time per 
UCC4 - Value 

This box shows the current value of the point shown in the "Off Time per 
UCC4 – Point" box. 

  

  On time adjust - 
point 

The Adjust Schedule module will change the time schedule’s "on time" by 
a particular value. 

That value is set using a separate strategy block such as a "real constant", 
or "analog setpoint". 

That value is brought into the "Adjust Schedule" block by connecting the 
separate block to the "on-time adjust" point. 

  

  On time adjust - 
value 

This box shows the current value of the point shown in the "On time adjust 
- point" box, i.e. the amount by which the "On time per UCC4" will be 
adjusted.  

This value may be positive or negative, and is specified as hours, in 
decimal format. 

  

  Off time adjust - 
point 

The Adjust Schedule module will change the time schedule’s off time by a 
particular value. 

That value is set using a separate strategy block such as a "real constant", 
or "analog setpoint". 

That value is brought into the "Adjust Schedule" block by connecting the 
separate block to the "off-time adjust" point. 

  

  Off time adjust - 
value 

This box shows the current value of the point shown in the "Off time adjust 
- point" box, i.e. the amount by which the "Off time per UCC4" will be 
adjusted.  

This value may be positive or negative, and is specified as hours, in 
decimal format. 

  

  New On Time – 
Point 

The adjusted time at which the schedule is to start (become active) is 
calculated from "On Time per UCC4" added to "On time adjust".  

This value is available at a point in the strategy, which is listed in the "New 
On Time box". 

  

  New On Time – 
Value 

This box shows the current value of the point shown in the "New On Time 
– Point" box. 

  

  New Off Time – 
Point 

The adjusted time at which the schedule is to start (become active) is 
calculated from "Off Time per UCC4" added to "Off time adjust".  

This value is available at a point in the strategy, which is listed in the "New 
Off Time box". 

  

  New Off Time – 
Value 

This box shows the current value of the point shown in the "New Off Time 
– Point" box. 

  

  New Active - point The value of this point is set to ON when the adjusted schedule is ‘active’, 
and OFF when the schedule is ‘inactive’ 

  

  New Active - 
value 

This box shows the current value of the point shown in the "New Active – 
point" box. 

  

  New Active low - 
point 

This point is the complement of New Active – it is OFF when the time 
schedule is ‘active’ and ON when the schedule is ‘inactive’. 

  

  New Active low - 
value 

This box shows the current value of the point shown in the "New Active 
Low – point" box. 
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Real Time Clock 

    

Button: 

  

    

Symbol: 

  

Values not shown 

  

Values shown 

    

Function of 
module: 

The Output Real Time Clock module produces eight outputs which contain the current year, month, day, 
hour, minute, second, decimal time and normal time according to the UC16 clock. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 
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Variables: Variable name Description Possible values 

  Year Point Number of point at which Year Value is held. 9 to 255 

  Year Value Current decade and year (e.g., 1995 is written 
as 95). 

Positive integer 

  Month Point Number of point at which Month Value is held. 9 to 255 

  Month Value Current month in numerical form. 1 to 12 

  Day Point Number of point at which Day Value is held. 9 to 255 

  Day Value Current day of the month. 1 to 31 

  Hour Point Number of point at which Hour Value is held. 9 to 255 

  Hour Value Current hour of day on 24 hour clock. 0 to 23 

  Minute Point Number of point at which Minute Value is held. 9 to 255 

  Minute Value Current minute of the hour. 0 to 59 

  Second Point Number of point at which Second Value is 
held. 

9 to 255 

  Second Value Current second of the minute. 0 to 59 

  Decimal Time Point Number of point at which Decimal Time Value 
is held. 

9 to 255 

  Decimal Time Value Current hour and minutes in decimal form 
(e.g., 15.45 is written as 15.75). 

0.00 to 23.99 

  Normal Time Point Number of point at which Normal Time Value 
is held. 

9 to 255 

  Normal Time Value Current hour and minutes. 0.00 to 23.59 

    

Application: The Real Time clock function module is used whenever the current time is needed to implement a 
control, e.g., to set fans to be activated a ½ hour before the building is occupied. 

  

 

 



 
 

 

 

 

SECTION 24 :  MATHEMATICAL 
MODULES 
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Adder/Scaler 

    

Button: 

  

    

Symbol: 

  

Values not shown 

  

Values shown 

      

Function of 
module: 

The Adder/Scaler module adds either: two inputs or the ratio of two inputs. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 
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Variables: Variable name Description Possible values 

  Input Points A and B Numbers of points at which values A and B 
are held. 

1 to 255 

  Input Values A and B Inputs which will be added or the ratios of 
which will be added. 

Real number 

  Input Points C and D Numbers of points at which values C and D 
are held.  

1 to 255 

  Input Values C and D Inputs by which inputs A and B are 
multiplied before adding. If no input points 
are specified, the default value for inputs C 
and D is 1. 

Real number 

  Output Point Number of point at which output value is 
held. 

9 to 255 

  Output Value Result of operation (A*C) + (B*D). Real number 

    

Implementation 
of module: 

Given inputs A, B, C and D:  

Output = (A*C) + (B*D) 

Note: because of the multiplication aspect in this module, 
unconnected inputs are assumed to have a value of "1". This 
can lead to unexpected results if only two inputs are 
connected - for example A=1, C=0.25, B and C unconnected. 

The result is not 1*0.25 as might be expected, but 
(1*0.25)+(1*1) = 1.25, because unconnected inputs B and C 
are each assumed to have a value of 1. 
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Minimum (of 8 inputs) with Minimum Indicator 

    

Button: 

  

    

Symbol: 

  

Values not shown 

  

Values shown 

      

Function of 
module: 

This module accepts up to eight analog inputs. It returns two analog outputs - the value of the smallest 
input, and the input (1 to 8 corresponding to inputs A to H) at which the smallest input is held. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 
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Variables: Variable name Description Possible values 

  Input Points A to H Numbers of points at which input values A to H are 
located. 

1 to 255 

  Input Values A to H Analog values which will be compared by the module 
to determine which is the smallest. 

Real number 

  Minimum Point Number of point at which Minimum Value is held. 9 to 255 

  Minimum Value Value of smallest input. Real number 

  Position Point Number of point at which Position Value is held. 9 to 255 

  Position Value Input channel of smallest input value. 1 to 8 

    

Implementation 
of module: 

Given Inputs A, B, C, D, E, F, G, H: 

Minimum Value = Min (A, B, C, D, E, F, G, H) 

Position Value = Input channel of (Min (A, B, C, D, E, F, G, H)). 
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Minimum (of 8 inputs) 

    

Button: 

  

    

Symbol: 

  

Values not shown 

  

Values shown 

      

Function of 
module: 

The Minimum of 8 Inputs module compares up to eight inputs and returns as output the value of the smallest 
input. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 
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Variables: Variable name Description Possible values 

  Input Points A to H Numbers of points at which input values 
A to H are held. May be omitted. If 
omitted, that input will not be considered 
by the module. 

1 to 255 

  Input Values A to H Values on which module operates to 
produce output. 

Positive real number 

  Output Point Number of point at which output value is 
held. 

2 to 255 

  Output Value Value of smallest input. Positive real number 
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Maximum (of 8 inputs) with Maximum Indicator 

    

Button: 

  

    

Symbol: 

  

Values not shown 

  

Values shown 

      

Function of 
module: 

This module accepts up to eight analog inputs. It produces two analog outputs - the value of the largest 
input, and the number of the input (1 to 8, corresponding to A to H) at which the maximum value is 
located. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 
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Variables: Variable name Description Possible values 

  Input Points A to H Numbers of points at which input values A to 
H are located 

1 to 255 

  Input Values A to H Analog values which will be compared by the 
module to determine which is the largest 

Real number 

  Maximum Point Number of point at which Maximum Value is 
held 

9 to 255 

  Maximum Value Value of largest input Real number 

  Position Point Number of point at which Position Value is 
held 

9 to 255 

  Position Value Input channel of largest input value 1 to 8 

    

Implementation 
of module: 

Given Inputs A, B, C, D, E, F, G, H: 

Maximum Value = Max (A, B, C, D, E, F, G, H) Position Value = Input channel of (Max (A, B, C, D, E, F, 
G, H)). 
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Maximum (of 8 inputs) 

    

Button: 

  

    

Symbol: 

  

Values not shown 

  

Values shown 

      

Function of 
module: 

The Maximum of 8 Inputs module compares up to eight inputs and returns as output the value of the 
largest input. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 
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Variables: Variable name Description Possible values 

  Input Points A to H Numbers of points at which input 
values A to H are held. May be 
omitted. If omitted, that input will not 
be considered by the module. 

1 to 255 

  Input Values A to H Values on which module operates to 
produce output. 

Positive real number 

  Output Point Number of point at which output 
value is held. 

9 to 255 

  Output Value Value of largest input. Positive real number 
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Average (of 8 inputs) 

    

Button: 

  

    

Symbol: 

  

Values not shown 

  

Values shown 

      

Function of 
module: 

The Average of 8 Inputs module accepts up to eight inputs and returns as output the average value 
of the inputs. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 
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Variables: Variable name Description Possible values 

  Input Points A to H Numbers of points at which input 
values A to H are held. May be 
omitted. If omitted, that input will not be 
considered by the module. 

1 to 255 

  Input Values A to H Values on which module operates to 
produce output. 

Positive real number 

  Output Point Number of point at which output value 
is held. 

9 to 255 

  Output Value Average value of inputs. Positive real number 

    

    

Implementation 
of module: 

Given 8 inputs A, B, C, D, E, F, G and H: 

Output = Average of A, B, C, D, E, F, G and H = (A+B+C+D+E+F+G+H)/8 
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Sum (of 8 inputs) 

    

Button: 

  

    

Symbol: 

  

Values not shown 

  

Values shown 

      

Function of 
module: 

This module accepts up to eight analog inputs and adds them together. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 
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Variables: Variable name Description Possible values 

  Input Points A to H Numbers of points at which Input 
Values A to H are held. 

1 to 255 

  Input Values A to H Inputs to be added by module. Real number 

  Output Point Number of point at which Output 
Value is held. 

9 to 255 

  Output Value Value produced by summing inputs. Real number 

        

Implementation 
of module: 

Given analog inputs A, B, C, D, E, F, G, H: Output = A+B+C+D+E+F+G+H 
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Multiplier/Scaler 

    

Button: 

  

    

Symbol: 

  

Values not shown 

  

Values shown 

      

Function of 
module: 

The Multiplier/Scaler module multiplies at least two, and no more than three, analog input values 
and returns the result as an output. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 
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Variables: Variable name Description Possible values 

  Input Points A, B 
and C 

Numbers of points at which values of inputs A, 
B and C are held. 

1 to 255 

  Input Point Values 
A, B and C 

Values on which module operates to produce 
output. 

Real numbers 

  Output Point Number of point at which value of output is held. 9 to 255 

  Output Point 
Value 

Value produced by multiplication of inputs. Real number 

    

    

Implementation 
of module: 

Given inputs A, B, C:  

Output = A*B*C 
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Divider/Scaler 

    

Button: 

  

    

Symbol: 

  

Values not shown 

  

Values shown 

      

Function of 
module: 

The Divider/Scaler module divides one input by another and multiplies the result by the third input. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 
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Variables: Variable name Description Possible values 

  Input Points A, B and 
C 

Numbers of points at which Input 
Values A, B and C are held. 

1 to 255 

  Input Values A, B and 
C 

Values on which the module operates 
to produce the output. 

Real numbers 

  Output Point Number of point at which Output Value 
is held. 

9 to 255 

  Output Value Value produced by the module’s 
operation on the inputs. 

Real number 

    

Implementation of 
module: 

Given inputs A, B and C:  

Output = (C/A)*B 
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Accumulator 

    

Button: 

  

    

Symbol: 

  

Values not shown 

  

Values shown 

      

Function of 
module: 

The Accumulator module is a form of counter. The module accepts two analog inputs and two digital 
inputs. It produces a single analog output.  

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 
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Variables: Variable name Description Possible values 

  Input Value Point Number of point at which Input Value is held. 1 to 255 

  Input Value Analog input which is multiplied by the 
Scaler Value to produce output. 

Real number 

  Scaler Value Point Number of point at which Scaler Value is 
held. 

1 to 255 

  Scaler Value Analog input which scales the Input Value by 
multiplication. 

Real number 

  Add Now Control 
Point 

Number of point at which Add Now Control 
Value is held. 

1 to 255 

  Add Now Control 
Value 

Digital input which indicates when Total 
Output Value is to be incremented. 

Set or unset 

  Clear Input Point Number of point at which Clear Input Value 
is held. 

1 to 255 

  Clear Input Value Digital input which causes the Total Output 
Value to be set to zero when it is set. 

Set or unset 

  Total Value Output 
Point 

Number of point at which Total Output Value 
is held. 

9 to 255 

  Total Value Output Final value returned when module has acted 
on inputs. 

Real number 

    

    

Implementation 
of module: 

Given analog inputs Input Value and Scalar Value, and digital inputs Add Now Control and Clear 
Input: 

Output = (Input Value)*(Scalar Value) if Add Now Control = set and Clear Input = unset. 

Output = 0 if Clear Input = set 
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Absolute Value 

Button: 

  

Symbol: 

  

Values not shown 

  

Values shown 

Function of 
module: 

The Absolute Value module accepts an analog input and returns its absolute value. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 

 
        

Variables: Variable name Description Possible values 

  Input Point A Number of point at which Input Value A is held. 1 to 255 

  Input Value A Value on which module operates to get output. Real number 

  Output Point Number of point at which Output Value is held. 9 to 255 

  Output Value Value produced by getting absolute value of 
Input Value A. 

Positive real 
number 

        

Implementation 
of module: 

Given Input A: 

Output = ABS (A) 
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Log of Input 

    

Button: 

  

    

Symbol: 

  

Values not shown 

  

Values shown 

      

Function of 
module: 

The Log of Input module calculates the log (base 10) of one input and multiplies it by the other input. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 
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Variables: Variable name Description Possible values 

  Input Points A and B Numbers of points at which Input Values A 
and B are held.  

1 to 255 

  Input Values A and B Values on which module is to operate 
according to the formula: 

Output = A*Log B 

If no Input Point number is specified for 
Input B, the Input Value for B is assumed to 
be 1. 

Real number 

  Output Point Number of point at which Output Value is 
held. 

9 to 255 

  Output Value A*Log B Real number 

    

    

Implementation 
of module: 

Given inputs A, B:  

Output = A*Log B 
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Antilog Input 

    

Button: 

  

    

Symbol: 

  

Values not shown 

  

Values shown 

      

Function of 
module: 

The Antilog of Input module accepts two inputs, and multiplies one by the antilog of the other to 
produce the output. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 
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Variables: Variable name Description Possible values 

  Input Points A and B Numbers of points at which Input Values A 
and B are held. 

1 to 255 

  Input Values A and B Values on which module operates to 
produce output. Input Value A will be 
multiplied by the Antilog of Input Value B. 

Real number 

  Output Point Number of point at which Output Value is 
held. 

9 to 255 

  Output Value Value produced by multiplying Input A by the 
Antilog of Input B. 

Real number 

    

Implementation 
of module: 

Given inputs A, B: 

Output = A*Antilog B 
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Log (base e) of input 

    

Button: 

  

    

Symbol: 

  

Values not shown 

  

Values shown 

    

Function of 
module: 

The Log (base e) module accepts two analog inputs and multiplies one by the Log (base e) of the 
other. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 
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Variables: Variable name Description Possible values 

  Input Points A, B Numbers of points at which Input Values A, B 
are held. 

1 to 255 

  Input Values A, B Values on which the module operates to 
produce the output. 

Real number 

  Output Point Number of point at which Output Value is held. 9 to 255 

  Output Value Value produced when Input A is multiplied by 
the Log (base e) of Input B. 

Real number 

        

        

Implementation 
of module: 

Given inputs A, B:  

Output = A * ln (B) 
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Antilog (base e) of input 

    

Button: 

  

    

Symbol: 

  

Values not shown 

  

Values shown 

      

Function of 
module: 

The Antilog (base e) module accepts two analog inputs and multiplies one by the Antilog (base e) of 
the other. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 

 

 

       



 

 

542 © American Auto-Matrix MAN00058US rev 69 

M
A

N
0

0
0

5
8

U
S rev 6

9
 

  

Variables: Variable name Description Possible values 

  Input Points A, B Numbers of points at which input values A, B 
are held. 

1 to 255 

  Input Values A, B Values on which module operates to produce 
output. 

Real number 

  Output Point Number of point at which Output Value is held. 9 to 255 

  Output Value Value produced by multiplying Input Value A 
by Antilog (base e) of Input Value B. 

Real number 

    

    

Implementation 
of module: 

Given inputs A, B: 

Output = A* Antiln (B) 
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Square Root 

    

Button: 

  

    

Symbol: 

  

Values not shown 

  

Values shown 

    

Function of 
module: 

The Square Root module accepts two inputs and multiplies one by the square root of the other. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 
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Variables: Variable name Description Possible values 

  Inputs Points A, B Numbers of points at which 
Input Values A, B are held. 

1 to 255 

  Input Values A, B Values on which module 
operates to produce output. 

Positive real 
numbers 

  Output Point Number of point at which 
Output Value is held. 

9 to 255 

  Output Value Value produced when Input 
Value A is multiplied by the 
square root of Input Value B. 

Positive real 
number 

    

Implementation 
of module: 

Given inputs A, B: 
Output = A* (B)1/2 

  

  

  

  

  

  

  
  

  



 

 
 

MAN00058US rev 69 © American Auto-Matrix 545 

Rounding Module 

Appearance 

Group 

 (Mathematical) 

 

Button 

 

 

Symbol 

 

Dialog box 

 If UC32/BACnet-type Controller is targeted: 

 

 

 If Legacy UC type Controller is targeted: 

 

  

  

  

M 
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Function 

The Rounding module changes its input to one of the following, depending on the option: (note – in the table below the 
term ‘whole number’ is used to refer to digit in the required decimal place). 

 Option 0 : the nearest whole number 

Input Output  Input Output 

4.8 5.0  -6.9 -7.0 

4.2 4.0  -6.3 -6.0 

3.6 4.0  -5.7 -6.0 

Option 1 : the nearest whole number above 

Input Output  Input Output 

4.8 5.0  -6.9 -6.0 

4.2 5.0  -6.3 -6.0 

3.6 4.0  -5.7 -5.0 

Option 2 : the nearest whole number below. 

Input Output  Input Output 

4.8 4.0  -6.9 -7.0 

4.2 4.0  -6.3 -7.0 

3.6 3.0  -5.7 -6.0 

Option 3 : the nearest whole number away form 0  

Input Output  Input Output 

4.8 5.0  -6.9 -7.0 

4.2 5.0  -6.3 -7.0 

3.6 4.0  -5.7 -6.0 

Option 4 : the nearest whole number towards 0  

Input Output  Input Output 

4.8 4.0  -6.9 -6.0 

4.2 4.0  -6.3 -6.0 

3.6 3.0  -5.7 -5.0 

Parameters 
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Inputs 

 If UC32/BACnet-type Controller is targeted: 

Parameter Name Description Possible values 

Input  The value to be rounded Real number 

 

 If Legacy UC type Controller is targeted: 

Parameter Name Description Possible values 

Input 1 Point Numbers of the point at which the value to be rounded is held. 1 to 255 

Input 1 Value The value of point 1 Real Number 

 

 

Constants 

 If UC32/BACnet-type Controller is targeted: 

Parameter Name Description Possible values 

Decimal Places The number of decimal places for the value at the output point. 0-7 

Rounding Type The number of the rounding option to be used (see Function 
section on page 546) 

0-4 

 If Legacy UC type Controller is targeted: 

Parameter Name Description Possible values 

Number of Decimal 
Places 

The number of decimal places for the value at 
the output point. 

0-7 

Rounding Options The rounding option to be used (see Function 
section on page 546) 

 Round to whole number 

 Round UP to whole number 

 Round DOWN to whole number 

 Round to infinity 

 Round to zero 

 

Outputs  

 If UC32/BACnet-type Controller is targeted: 

Parameter Name Description Possible values 

Output The rounded value generated by the module. Integer 

   

 If Legacy UC type Controller is targeted: 

Parameter Name Description Possible values 

Output 1 Point Number of point at which Output Value is held. 9 to 255 

Output 1 Value Value produced by the module’s operation on the input. Integer 

  

  



 

 

548 © American Auto-Matrix MAN00058US rev 69 

M
A

N
0

0
0

5
8

U
S rev 6

9
 

Subtract Module 

Appearance 

Group 

 
(Mathematical) 

 

Button 

 

  

Symbol 

 

  

Dialog box 

 

Function:  

This module allows the subtraction of 3 values from a value. 

 =  –  -  -  

 

Note:  The Rescale Custom Module is available only with Unitron Firmware version 6.2.1 or later, or CBM/CBT 
Firmware version 7.6.8 or later. 

 

  

M 

O A B C D 
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Parameters 

Inputs 

Parameter Name Description Possible values 

Input A  Value from which the subtraction occurs. Real number 

Input B  1
st

 subtraction value. Real number 

Input C  2
nd

 subtraction value. Real number 

Input D  3
rd

 subtraction value. Real number 

Outputs  

Parameter Name Description Possible values 

Output  Value resulting from the subtraction. Real number 

A 

B 

C 

D 

O 





 
 

 

 

 

SECTION 25 :  CONTROL MODULES 
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Forward PID 

 Appearance 

Group 

  (Control) 

 

Button 

 

Symbol 

 
  

Dialog box 

 If UC32/BACnet-type Controller is targeted: 

 

 If Legacy UC type Controller is targeted: 

 

Function:  

The Forward PID module uses a PID (Proportional, Integral, Derivative) loop to react to the behaviour of the system under 
control. Depending on how the observed process variable changes over time, the output is boosted or cut in order to speed 
up or slow the rate of change.  

The user has the option of using proportional control alone, proportional and integral control or proportional, integral and 
derivative control.  

The term “Forward” PID denotes the fact that the output is directly (rather than inversely) proportional to the input. This 

means the error is defined as the amount that the process variable is above the setpoint, and  output is proportional to that 
error. Forward PID is used in cooling processes, where the module output drives the process variable downwards e.g. in Air 
Handling Units, FCUs, VAVs, etc.  

C 



 

 
 

MAN00058US rev 69 © American Auto-Matrix 553 

Note: If the plant item that is being controlled includes a heating element, a reverse PID must also be used. 

For a detailed explanation of the options in PID control, see section PID Control Options on page 562, in the Custom PID 
module description. 

Parameters 

Inputs 

Parameter Name Description Possible values 

Setpoint Desired value for Process Variable. Real number 

Process Variable Measured value of the parameter to be controlled. Real number 

Gain Point Proportional gain value for the loop. Real number 

Enable Point If set (true), enables function of module 
If unset (false), module is disabled and returns value 0. 

boolean 

Constants 

Parameter Name Description Possible values 

Integration time Period over which difference between the Setpoint value 

and the Process Variable value is integrated. To disable 

Integration, set this constant to zero. 

Positive integer 

Derivative time Period over which difference between Setpoint Value and 
Process Variable Value is derived. To disable, set to zero. 

Positive integer 

Service time Period of sampling loop output. 

Note:  Service time must be greater than 0, 
otherwise Integration and Differentiation will 
not work. 

Positive integer > 
0 

Outputs  

Parameter Name Description Possible values 

Output Value of the loop output - between 0 and 100%. Positive real 
number 
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Tuneable forward PID 

 Appearance 

Group 

  (Control) 

 

Button 

 

Symbol 

 
  

Dialog box 

 If UC32/BACnet-type Controller is targeted: 

 

 If Legacy UC type Controller is targeted: 

 

Function:  

The Tuneable Forward PID module uses a PID (Proportional, Integral, Derivative) loop to react to the behaviour of the system 
under control. Depending on how the observed process variable changes over time, the output is boosted or cut in order to 
speed up or slow the rate of change.  

The user has the option of using proportional control alone, proportional and integral control or proportional, integral and 
derivative control.  

C 



 

 
 

MAN00058US rev 69 © American Auto-Matrix 555 

The term “Forward” PID denotes the fact that the output is directly (rather than inversely) proportional to the input. This 

means the error is defined as the amount that the process variable is above the setpoint, and  output is proportional to that 
error. Forward PID is used in cooling processes, where the module output drives the process variable downwards e.g. in Air 
Handling Units, FCUs, VAVs, etc.  

Note: If the plant item that is being controlled includes a heating element, a reverse PID must also be used. 

The term “Tuneable” indicates that Integration Time and Derivative Time can be set using Constants, but these can be 
overridden dynamically by the strategy using optional inputs.  

For a detailed explanation of the options in PID control, see section PID Control Options on page 562, in the Custom PID 
module description. 

Parameters 

Inputs 

Parameter Name Description Possible values 

Setpoint Desired value for Process Variable. Real number 

Process Variable Measured value of the parameter to be controlled. Real number 

Gain Point Proportional gain value for the loop. Real number 

Integration Time If this point is connected, then its value overrides the 

Integration Time constant 

Positive integer 

Derivative Time If this point is connected, then its value overrides the 

Derivative Time constant 

Positive integer 

Enable Point If set (true), enables function of module 
If unset (false), module is disabled and returns value 0. 

Boolean 

Constants 

Parameter Name Description Possible values 

Integration time Period over which difference between the Setpoint value 

and the Process Variable value is integrated. To disable 

Integration, set this constant to zero. 

Positive integer 

Derivative time Period over which difference between Setpoint Value and 
Process Variable Value is derived. To disable, set to zero. 

Positive integer 

Service time Period of sampling loop output. 

Note:  Service time must be greater than 0, 
otherwise Integration and Differentiation will 
not work. 

Positive integer > 
0 

Outputs  

Parameter Name Description Possible values 

Output Value of the loop output - between 0 and 100%. Positive real 
number 
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Reverse PID 

Appearance 

Group 

  (Control) 

 

Button 

 

 

Symbol 

 

  

Dialog box 

 If UC32/BACnet-type Controller is targeted: 

 

 If Legacy UC type Controller is targeted: 

 

Function:  

The Reverse PID module uses a PID (Proportional, Integral, Derivative) loop to react to the behaviour of the system under 
control. Depending on how the observed process variable changes over time, the output is boosted or cut in order to speed 
up or slow the rate of change.  

The user has the option of using proportional control alone, proportional and integral control or proportional, integral and 
derivative control.  

For a detailed explanation of the options in PID control, see section PID Control Options on page 562, in the Custom PID 
module description. 

 

C 
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Parameters 

Inputs 

Parameter Name Description Possible values 

Setpoint Desired value for Process Variable. Real number 

Process Variable Measured value of the parameter to be controlled. Real number 

Gain Point Proportional gain value for the loop. Real number 

Enable Point If set (true), enables function of module 
If unset (false), module is disabled and returns value 0. 

Boolean 

Constants 

Parameter Name Description Possible values 

Integration time Period over which the difference between the Setpoint value 
and the Process Variable value is integrated. To disable 
Integration, set this constant to zero. 

Positive integer 

Derivative time Period over which the difference between Setpoint Value and 
Process Variable value is differentiated. To disable, set to zero. 

Positive integer 

Service time Period of sampling loop output. 

Note:  Service time must be greater than 0, 
otherwise Integration and Differentiation will 
not work. 

Positive integer > 0 

Outputs  

Parameter Name Description Possible values 

Output Value of the loop output - between 0 and 100%. Positive real number 
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Tuneable Reverse PID 

Appearance 

Group 

  (Control) 

 

Button 

 

 

Symbol 

 
  

Dialog box 

 If UC32/BACnet-type Controller is targeted: 

 

 If Legacy UC type Controller is targeted: 

 

Function:  

The Tuneable Reverse PID module uses a PID (Proportional, Integral, Derivative) loop to react to the behaviour of the system 
under control. Depending on how the observed process variable changes over time, the output is boosted or cut in order to 
speed up or slow the rate of change.  

The user has the option of using proportional control alone, proportional and integral control or proportional, integral and 
derivative control.  

The term “Reverse” PID denotes the fact that the output is inversely proportional to the input. This means the error is 

defined as the amount that the process variable is below the setpoint, and output is proportional to that error. Reverse PID 
is used in heating processes, where the module output drives the process variable upwards e.g. Air Handling Units, pressure 
control, boiler control, FCUs, VAVs, etc.  

Note: If the plant item that is being controlled includes a cooling element, a forward PID must also be used. 

The term “Tuneable” indicates that Integration Time and Derivative Time can be set using Constants, but these can be 
overridden dynamically by the strategy using optional inputs. 

C 
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For a detailed explanation of the options in PID control, see section PID Control Options on page 562, in the Custom PID 
module description. 

Parameters 

Inputs 

Parameter Name Description Possible values 

Setpoint Desired value for Process Variable. Real number 

Process Variable Measured value of the parameter to be controlled. Real number 

Gain Point Proportional gain value for the loop. Real number 

Integration Time If this point is connected, then its value overrides the 
Integration Time constant 

Positive integer 

Derivative Time If this point is connected, then its value overrides the Derivative 
Time constant 

Positive integer 

Enable Point If set (true), enables function of module 
If unset (false), module is disabled and returns value 0. 

Boolean 

Constants 

Parameter Name Description Possible values 

Integration time Period over which the difference between the Setpoint value 
and the Process Variable value is integrated. To disable 
Integration, set this constant to zero. 

Positive integer 

Derivative time Period over which the difference between Setpoint Value and 
Process Variable value is differentiated. To disable, set to zero. 

Positive integer 

Service time Period of sampling loop output. 

Note:  Service time must be greater than 0, 
otherwise Integration and Differentiation 
will not work. 

Positive integer > 0 

Outputs  

Parameter Name Description Possible values 

Output Value of the loop output - between 0 and 100%. Positive real number 
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Custom PID 

Appearance 

Group 

  (Control) 

 

Button 

 

 

 

Symbol 

 
  

Dialog box 

  

Function:  

This module uses a PID (Proportional, Integral, Derivative) loop to react to the behaviour of the system under control. 
Depending on how the observed process variable changes over time, the output is boosted or cut in order to minimise the 
error and attain the most efficient rate of change.  

The user has the option of using proportional control alone, proportional and integral control or proportional, integral and 
derivative control.  

This module differs from other PID modules in that the ‘direction’ of operation “Forward” or “Reverse” can be set dynamically 
from within the strategy. 

A “Deadband” range can be defined (unlike other PID modules). Also, the output can be offset by a variable amount 
determined by the strategy – allowing the module to be used for heating and cooling at the same time. 

Note:  The Custom PID Module is available only with Unitron Firmware version 6.2.1 or later, or CBM/CBT Firmware 
version 7.6.8 or later.  

C 
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The term “Forward” PID denotes the fact that the output is directly (rather than inversely) proportional to the process 

variable – i.e. the error is defined as the amount that the process variable is above the setpoint, and output is proportional 
to that error. Forward PID is used in cooling processes, where the module output drives the process variable downwards 
e.g. in Air Handling Units, FCUs, VAVs, etc.  

Note: If the plant item that is being controlled includes a heating element, a reverse PID must also be used. 

The term “Reverse” PID denotes the fact that the output is inversely proportional to the process variable – i.e. the error is 

defined as the amount that the process variable is below the setpoint, and output is proportional to that error. Reverse PID 
is used in heating processes, where the module output drives the process variable upwards e.g. Air Handling Units, pressure 
control, boiler control, FCUs, VAVs, etc.  

Note: If the plant item that is being controlled includes a cooling element, a forward PID must also be used. 

The term “Tuneable” indicates that although Integration Time and Derivative Time can be set within the module using 
Constants, these can be overridden dynamically by the strategy using optional inputs. 
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PID Control Options 

Proportional control only (i.e.  Enabling point is set (true) but Integration time and Derivative time are both set to 0) 

In this case, the difference between the Setpoint and the Process Variable is calculated at set intervals (Service Time) and the 
output  is set to a multiple of that difference in order to try to reduce the difference to zero.  

Forward action: Output = (Process Variable - Setpoint) * Gain  

Reverse action:  Output = (Setpoint - Process Variable) * Gain  

Note:  The output of the module is limited to between 0 and 100. If the error at any time is less than 0, the output of 
the module will be 0, and if the error multiplied by the gain gives any value greater than 100, the output of the 
module will be 100. 

If the gain is too low, response is sluggish and the setpoint will not be reached: 

 Forward action 

 

Reverse action 

 

If the gain is too high, the system may become unstable: 

Forward action 

 

Reverse action 

 

With the correct gain, a stable state can be achieved promptly and error is minimised: 

Forward action 

 

Reverse action 

 

 Value axis  Time Axis   Setpoint   Process Variable   Output    Service Time    Steady-state error 

However, using proportional control alone, the steady state will never match the setpoint - there will always be an error as shown 
above. To overcome this Integral control can be included. 

Note:  Proportional control reacts to the magnitude of the error. 

a b c d e f i 
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 Integral control adjusts the output based on the persistence of an error. It takes the duration of the error into 
account, in addition to the magnitude of the error. The rate at which the integration element is applied is based 
on the Integration Time parameter set in the PID module. 

 

Proportional and Integral Control (i.e.  Enabling point is set (true) and a value is specified for Integration time but no 
value is specified for Derivative time): 

In this case, the difference between the Setpoint and the Process Variable (the error) is monitored over a period of time (the 
Integration Time), and the duration of the error is used to adjust the loop output until the setpoint is achieved. The larger 
the Integration Time, the smaller the effect of the integral element - so that the use of a larger Integration Time can lead to 
more stable control and a smaller Integration Time can give more responsive control.  

Forward action 

 

Reverse action 

 

 Value axis  Time Axis   Setpoint   Process Variable   Output    Service Time   Integration action 

 

However, if the Integration Time is too small there is a danger that the output will be unstable. 

  

a b c d e f g 
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Proportional, Integral and Derivative Control (i.e. all values specified): 

Note:  Derivative control asesses the rate of change of the error. 

 It is used for very fast reaction times – which is rarely required in HVAC applications. 

In this case a derivative term is added to the loop output to reduce the response time. The rate of change of the "error" 
signal is noted, and the module output is modified in line with this rate of change. 

 

Forward action 

 

Reverse action 

 

 Value axis   Time Axis   Setpoint   Process Variable   Output   Service Time   Derivative action  

 

 

Note:  The use of the different types of control depends on the Proportional Band of the PID loop. 

  Proportional Band = 100 / Gain 

  Proportional Area = Setpoint ± (Proportional Band / 2) 

 If the Process Variable is outside the Proportional Area, only the proportional term is used. 

 If the Process Variable is within the Proportional Area, the integral and (optionally) derivative terms are used also. 

 

  

a b c d e f h 
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Parameters 

Inputs 

Parameter Name Description Possible values 

  Setpoint Desired value for Process Variable. Real number 

  Process Variable Measured value of the parameter to be controlled. Real number 

  Gain Proportional gain value for the loop. Real number 

  Enable If set, enables function of module; if unset, module is 
disabled and returns value 0. 

On or Off 

  Integration Time If this point is connected, then its value overrides the 
Integration Time constant 

Positive integer 

 Derivative Time If this point is connected, then its value overrides the 
Derivative Time constant 

Positive integer 

  Deadband Defines a deadband range as the Setpoint plus or minus 
this integer value. If the Process variable is within this 
range, then the PID output will stop calculating and remain 
at the previously calculated value. 

Positive integer 

  Reverse Changes the mode of the PID block between Forward and 
Reverse action.  

If unset (0) the module will use Forward action 

If set (1) the module will use Reverse action 

On (1) or Off (0) 

  Offset This value is added to the output 0 % - 100 % 

Constants 

Parameter Name Description Possible values 

Integration time Period over which the difference between the Setpoint 
value and the Process Variable value is integrated. To 
disable Integration, set this constant to zero. 

Positive integer 

Derivative time Period over which the difference between Setpoint Value 
and Process Variable value is differentiated. To disable, 
set to zero. 

Positive integer 

Service time Period of sampling loop output. 

Note:  Service time must be greater than 0, 
otherwise Integration and 
Differentiation will not work. 

Positive integer > 0 

Gain If the Gain point   is not connected, this value is used 

as the Proportional gain value for the loop. 

Real number 

Outputs 

Parameter Name Description Possible values 

 Output Value of the loop output - between 0 and 100%. 0% – 100% 

 

S 
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Hysteresis 

Appearance 

Group 

  (Control) 

 

Button 

 

 

 

Symbol 

 

Dialog box 

 If UC32/BACnet-type Controller is targeted: 

 

 If Legacy UC type Controller is targeted: 

 

  

C 
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Function 

The Hysteresis module accepts one analog input and compares it to two analog constants setting a digital point when the 
analog value rises above the first constant but not unsetting it until the value falls below the second. 

The Hysteresis module is used in frost control. For example, if the outside air temperature falls below 2°, the pump must be 
activated and not deactivated until the outside air temperature rises above 4°. 

Given input value = IV, Hysteresis On Level = On Level and Hysteresis Off Level = Off Level: 

 If IV < On Level: Active High Output = set (On) 

 If IV > Off Level: Active High Output = unset (Off) 

 If On Level < IV < Off Level: Active High Output depends on the direction of IV as shown below: 

 

On Level

Off Level
On

Off

Active High OutputInput

On

Off

 

Note: On Level must always be less than Off Level. 

 

Parameters 

Inputs 

 If UC32/BACnet-type Controller is targeted: 

Parameter Name Description Possible values 

Input  Analog point value which is compared to the Hysteresis On Level 
and the Hysteresis Off Level to determine the value of the Active 
High Output. 

Real number 

 

 

 If Legacy UC type Controller is targeted: 

Parameter Name Description Possible values 

Input Point Number of point at which the Input Value is held. 1 to 255 

Input Value The value which is compared to the Hysteresis On Level and the 
Hysteresis Off Level to determine the value of the Active High 
Output. 

Real number 
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Constants 

 If UC32/BACnet-type Controller is targeted: 

Parameter Name Description Possible values 

On Level Defines the level for the Input Value below which the Active 
High Output will be set. 

Real number 

Off Level Defines the level for the Input Value above which the Active 
High Output will be unset. 

Real number, 
greater than 
Hysteresis On Level 

 

 If Legacy UC type Controller is targeted: 

Parameter Name Description Possible values 

Hysteresis On Level Defines the level for the Input Value below which the Active 
High Output will be set. 

Real number 

Hysteresis Off Level Defines the level for the Input Value above which the Active 
High Output will be unset. 

Real number, 
greater than 
Hysteresis On Level 

 

 

 

 

 

Outputs  

 If UC32/BACnet-type Controller is targeted: 

Parameter Name Description Possible values 

Active High  A digital value that is set from the time the input value rises 
above the On level until it falls below the Off value. 

Set or Unset 

Active Low  Complement of the Active High Output Value Set or unset 

  

  

 If Legacy UC type Controller is targeted: 

Parameter Name Description Possible values 

Active High Output 
Point 

Number of point at which the Active High Output Value is held. 9 to 255 

Active High Output 
Value 

Value produced by the relation between the Input Value and the 
Hysteresis On and Off Levels. 

Set or Unset 

Active Low Output 
Point 

Number of point at which complement of Active High Output is 
held 

9 to 255 

Active Low Output 
Value 

Complement of the Active High Output Value Set or unset 
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Tuneable Hysteresis 

Appearance 

Group 

  (Control) 

 

Button 

 

 

Symbol 

 

Dialog box 

 If UC32/BACnet-type Controller is targeted: 

 

 If Legacy UC type Controller is targeted: 

 

 

  

  

C 
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Function 

The Tuneable Hysteresis module accepts accepts three analog inputs and compares one of them (Input Value) to either the 
other two inputs or two analog constants, setting a digital point when the analog value rises above the first (constant or 
input) but not unsetting it until the value falls below the second. 

This module operates as a fixed Hysteresis module when the On and Off level inputs are not connected. However it is 
“Tuneable” because by connecting those points, the on and off levels can be varied in response to other elements within 
the Controller Strategy,  

The Tuneable Hysteresis module is used in frost control. For example, if the outside air temperature falls below 2°, the 
pump must be activated and not deactivated until the outside air temperature rises above 4°. 

Given  

1. input value = IV,  

2. Hysteresis On Level (Variable input, or constant if input point not specified) = On Level  

3. Hysteresis Off Level (Variable input, or constant if input point not specified)  = Off Level  

then 

 If IV < On Level: Active High Output = set (On) 

 If IV > Off Level: Active High Output = unset (Off) 

 If On Level < IV < Off Level: Active High Output depends on the direction of IV as shown below: 

 

On Level

Off Level
On

Off

Active High OutputInput

On

Off

 

Note: On Level must always be less than Off Level. 
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Parameters 

Inputs 

 If UC32/BACnet-type Controller is targeted: 

Parameter Name Description Possible values 

Input  Analog point value which is compared to the Hysteresis On Level 
and the Hysteresis Off Level to determine the value of the Active 
High Output. 

Real number 

On Level The value of the point connected to the Input labelled H. Real number 

Offlevel The value of the point connected to the Input labelled L. Real number 

 

 If Legacy UC type Controller is targeted: 

Parameter Name Description Possible values 

Input Value Point Number of point at which Input Value is held. 1 to 255 

Input Value Value to be compared to Hysteresis On Level and Hysteresis Off 
Level to determine the Active High Output. 

Real number 

Hysteresis On Level 
Point 

Number of point at which Hysteresis On Level Value is held. May 
be omitted. Used if it is required that the On level be tuneable. 

1 to 255 

Hysteresis On Level 
Value 

Value to which Input Value is compared if Hysteresis On Level 
Point is specified. If the Input Value is less than the Hysteresis 
On Level Value, the Active High Output will be set. 

Real number 

Hysteresis Off Level 
Point 

Number of point at which Hysteresis Off Level Value is held. May 
be omitted. Used if it is required that the Off level be tuneable. 

1 to 255 

Hysteresis Off Level 
Value 

Value to which Input Value is compared if Hysteresis Off Level 
Point is specified. If the Input Value is greater than the 
Hysteresis Off Level Value, the Active High Output will be unset. 

Real number, 
greater than 
Hysteresis On Level 

 

 

Constants 

 If UC32/BACnet-type Controller is targeted: 

Parameter Name Description Possible values 

On Level Defines the level for the Input Value below which the Active 
High Output will be set. 

Real number 

Off Level Defines the level for the Input Value above which the Active 
High Output will be unset. 

Real number, 
greater than 
Hysteresis On Level 

 

 If Legacy UC type Controller is targeted: 

Parameter Name Description Possible values 

Hysteresis On Level Defines the level for the Input Value below which the Active 
High Output will be set. 

Real number 

Hysteresis Off Level Defines the level for the Input Value above which the Active 
High Output will be unset. 

Real number, 
greater than 
Hysteresis On Level 
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Outputs  

 If UC32/BACnet-type Controller is targeted: 

Parameter Name Description Possible values 

Active High  A digital value that is set from the time the input value rises 
above the On level until it falls below the Off value. 

Set or Unset 

Active Low  Complement of the Active High Output Value Set or unset 

  

  

 If Legacy UC type Controller is targeted: 

Parameter Name Description Possible values 

Active High Output 
Point 

Number of point at which the Active High Output Value is held. 9 to 255 

Active High Output 
Value 

Value produced by the relation between the Input Value and the 
Hysteresis On and Off Levels. 

Set or Unset 

Active Low Output 
Point 

Number of point at which complement of Active High Output is 
held 

9 to 255 

Active Low Output 
Value 

Complement of the Active High Output Value Set or unset 
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Time Proportional driver 

    

Button: 

  

    

Symbol: 

  

Values not shown 

  

Values shown 

    

Function of 
module: 

The Time Proportional Driver module is used to simulate valve action by modulating a pump, which, 
unlike a split phase valve, is either fully on or fully off. The module produces a digital output which has 
a Duty Cycle dependent on the analog input value. There is a second digital output, which is the 
complement of the first. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 
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Variables: Variable name Description Possible values 

  Input Point Number of point at which input value is held. 1 to 255 

  Input Value The percentage of the Travel Time for which 
the True Output Value is set (e.g. an Input 
Value of 70 means the True Output Value 
should be set for 70% of the Travel Time. 

0 to 100 

  Travel Time The time taken for one period of the digital 
output to elapse. 

Positive integer 

  Minimum On Time The step time for the True Output, i.e. the 
minimum time for which the True Output must 
be set once it becomes set. If the Input Value is 
a shorter time period than the Minimum On 
Time, then the True Output will be set for the 
Minimum On Time. If the Input Value is for a 
longer period, then the Minimum On Time is 
automatically satisfied, and the True Output is 
set for the period specified in the Input Value.  

Positive integer 

  True Output Point Number of point at which True Output Value is 
held. 

9 to 255 

  True Output Value This is set for the calculated On time of the 
duty cycle. 

Set or unset 

  Complement 
Output Point 

Number of point at which complement of True 
Output Value is held. 

9 to 255 

  Complement 
Output Value 

Complement of True Output Value. Set or unset 

    

Implementation 
of module: 

Given travel time = T; minimum on time = M and input point I then Duty Cycle is as follows: 

True Output Value = SET for (I*T)/100 seconds and UNSET for T -((I*T)/100)  

if (I*T)/100 > M 

Otherwise: 

True Output Value = SET for M seconds and UNSET for T-M seconds 

    

Application: Used with a control valve with wax heating coil. 
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Raise/Lower driver 

Appearance 

Group 

  (Control) 

 

Button 

 

 

Symbol 

 

Dialog box 

 If UC32/BACnet-type Controller is targeted: 

 

If an analog output 
is connected, the 
Outputs column 
changes: 

 

 If Legacy UC type Controller is targeted: 

 

Function 

The Raise/Lower Driver module is used to drive a split phase motor or valve. It accepts as input the percentage opening 
required for the valve and produces two digital outputs that control whether the valve is opening or closing. 

Given Input Value  , Current Value CV, Travel Time T: 

Open Output    = set if  > CV 

Close Output   = set if  < CV 

Output will remain set for abs(CV -
 

) * (T / 100) 

C 

I 

O I 

ō I 

I 
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 Example:  If the current valve position is 20% open, the Travel Time is 100 seconds and the Input Value   is 

40%, the Open Output  will be set and the time taken to reach 40% from 20% is calculated as follows:  

  Travel Time = 100 seconds => 1 second per %  

   The valve must open by (40-20)%, which will take 20 seconds). 

Parameters 

Inputs 

 If UC32/BACnet-type Controller is targeted: 

Parameter Name Description Possible values 

 Input Point The required level of opening of the valve in percentage terms 
(e.g. an Input Point value of 51 means the valve is required to be 
open to 51% . This is compared to the current position of the 
valve, the required output (Open or Close) is set and the length 
of time for which the output will remain set is calculated. 

0 to 100 % 

 Travel time 

input 

This input allows the Travel Time constant to be overwritten by 
a value generated by the strategy. 

Positive integer 

 Min on time 

input 

This input allows the Minimum On Time constant to be 
overwritten by a value generated by the strategy. 

Positive integer 

 If Legacy UC type Controller is targeted: 

Parameter Name Description Possible values 

 Input Point The number of the point at which the Input Value is held. 1 to 255 

Input Value The required level of opening of the valve in percentage terms 
(e.g. an Input Value of 51 means the valve is required to be 
open to 51%. This is compared to the current position of the 
valve, the required output (Open or Close) is set and the length 
of time for which the output will remain set is calculated. 

0 to 100 % 

Constants 

 If UC32/BACnet-type Controller is targeted: 

Parameter Name Description Possible values 

Travel Time Time taken (in seconds) for the valve to open from 0% to 100% Positive integer 

Minimum On Time Step time for the valve (i.e. if Travel Time is 120 seconds and 
Minimum On Time is 10 seconds, there are 12 equal steps 
between 0 and 100% for the valve). 

Positive integer 

Overdrive flag If this value is set to 0, then if a value of 100% is entered as the 
Input Point value, the Open output will stay on indefinitely, and if 
a value of 0% is entered, the Close output will stay on indefinitely.  

This could be undesirable – for example if a valve motor is 
connected to the output, it would continue to drive even after the 
valve has reached the end of its travel, which could cause 
mechanical damage.  

By setting the Overdrive flag to 1, the output value will stop after a 

0: Overdrive is 
enabled 

1: Overdrive is 
disabled 

I 

O 

I 

T 

M 

I 
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period of time, which is calculated as follows:  

1) if a value of 100.0% is set on the R/L module Input, 
"True Output" will remain ON for a period T: 

T = ( (100 - X) / 100 + 1) * Tr 

where: 

Tr  =  Travel Time. 

X   =  Current Position at the time 

the new position (100.0%) is sent. 

2) if a value of 0.0% is set on the R/L module Input, the 
"Complement Output" will remain ON for a period T: 

T = ( X / 100 + 1) * Tr 

where: 

Tr  =  Travel Time. 

X   =  Current Position at the time 

the new position (0.0%) is sent. 

 If Legacy UC type Controller is targeted: 

Parameter Name Description Possible values 

Travel Time Time taken (in seconds) for the valve to open from 0% to 100% Positive integer 

Minimum On Time Step time for the valve (i.e. if Travel Time is 120 seconds and 
Minimum On Time is 10 seconds, there are 12 equal steps 
between 0 and 100% for the valve). 

Positive integer 

Disable Continuous 
Overdrive 

Continuous overdrive is set ON by default. Continuous Overdrive means 
that if a value of 100% is entered as the Input value, the Open  
output will stay on indefinitely, and if a value of 0% is entered, the 
Close output will stay on indefinitely. This could be undesirable – 
for instance if a valve motor is connected to the output, it would 
continue to drive even after the valve has reached the end of its 
travel, which could cause mechanical damage. By setting the 
Disable Continuous Overdrive box, the output value will stop 
after a period of time, calculated as follows:  

1) if a value of 100.0% is set on the R/L module Input, 
"True Output" will remain ON for a period T: 

T = ( (100 - X) / 100 + 1) * Tr 

where: 

Tr  =  Travel Time. 

X   =  Current Position at the time 

the new position (100.0%) is sent. 

2) if a value of 0.0% is set on the R/L module Input, the 
"Complement Output" will remain ON for a period T: 

T = ( X / 100 + 1) * Tr 

where: 

Set or unset 
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Tr  =  Travel Time. 

X   =  Current Position at the time 

the new position (0.0%) is sent. 

NOTE:  The Disable Continuous Overdrive box should NOT 
be set for older controllers (with ROM versions 
before 5.5.0). Disabling Continuous Overdrive is 
not supported in such controllers, and setting 
this box will cause the outputs to behave in an 
unpredictable manner. 

Outputs  

 If UC32/BACnet-type Controller is targeted: 

Parameter Name Description Possible values 

 Three Step 

Driver output 

The value of this analog output point determines the state of the 
raise/lower valve. 

Note:  if this point is connected, then the digital 
open/close outputs cannot be used. 

0, 50 or 100.  

(0, 5 or 10 volts 
expressed as 
percentages.) 

 Open Output  When this is set, the valve is driven towards the open position. 

Note:  if the digital open/close outputs are 
connected, then the Three Step Driver 
output cannot be used. 

Set or unset 

 Close Output When this is set, the valve is driven towards the closed position. 

Note:  if the digital open/close outputs are 
connected, then the Three Step Driver 
output cannot be used. 

Set or unset 

  

  

 If Legacy UC type Controller is targeted: 

Parameter Name Description Possible values 

  Open Output 

Point 

Number of point at which Open Output Value is held. 9 to 255 

Open Output Value When this is set, the valve is driven towards the open position. Set or unset 

  Close Output 

Point 

Number of point at which Close Output Value is held. 9 to 255 

T 

O 

ō 

O 

ō 
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Close Output Value When this is set, the valve is driven towards the closed position. Set or unset 

 Three Step 

Driver Point 

Number of the analog point that drives the raise/lower valve. 1-255 

Three Step Driver 
Value 

The value of this analog output point determines the state of the 
raise/lower valve. (See also UC16 R/L2 Raise/Lower Relay 
Module Datasheet.) 

0, 50 or 100. (0, 5 or 
10 volts expressed 
as percentages.) 

   

T 
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Heating Curve 

    

Button: 

  

    

Symbol: 

  

Values not shown 

  

Values shown 

      

Function of 
module: 

The Heating Curve module accepts seven inputs and produces as output a temperature setpoint. This 
module is used to calculate temperature setpoints for boilers and heating devices. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 
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Variables: Variable name Description Possible 
values 

  Outside Air Temp 
Point 

Number of point at which Outside Air Temp value is held. 1 to 255 

  Outside Air Temp 
Value 

Measured value of outside air temperature.  

Note: If this is not less than the Room Temp value, the 

module assumes it is a negative temperature, since the 
operation of the module is invalid otherwise. 

o
C 

  Room Temp 
Point 

Number of point at which Room Temp setpoint value is 
held. 

1 to 255 

  Room Temp 
Value 

Measured value of room temperature. 
o
C 

  Slope Point Number of point at which Slope value is held. 1 to 255 

  Slope Value Value of slope of the characteristic curve of the heating 
system for which the temperature setpoint is being 
calculated. 

  

  Variable name Description Possible 
values 

  Fixpoint Point Number of point at which Fixpoint value is held. 1 to 255 

  Fixpoint Value Value of desired temperature setting. 
o
C 

  Exponent Point Number of point at which Exponent value is held. 1 to 255 

  Exponent Value Value of exponent of characteristic curve.   

  Min Output Point Number of point at which Min Output value is held. 1 to 255 

  Min Output Value Specified minimum output value. 
o
C 

  Max Output Point Number of point at which Max Output value is held. 1 to 255 

  Max Output 
Value 

Specified maximum output value. 
o
C 

  Setpoint Number of point at which Setpoint value is held. 9 to 255 

  Setpoint Value Calculated value of temperature setpoint. 
o
C 

    

Implementation of module: Given the following inputs – Outside Temp, Room Temp, Slope, Fixpoint, 
Exponent, Min Output, Max Output: 

Setpoint = (Slope*(Room Temp - Outside Temp))^(1/exponent) + fixpoint 

if Min Output < Setpoint < Max Output 

  

    

Application: The Heating Curve module is used a weather compensator with room influence. 
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Ring Counter 

    

Button: 

  

    

Symbol: 

  

Values not shown 

  

Values shown 

      

Function of 
module: 

The Ring Counter module accepts two digital inputs and produces up to eight digital outputs which are 
determined by the state of the digital inputs. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 
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Variables: Variable name Description Possible values 

  Point to Monitor Point Number of point at which Point to Monitor 
Value is held. 

1 to 255 

  Point to Monitor Value The state of this value determines the value 
of the output. 

Set or unset 

  Reset Point Number of point at which Reset Value is 
held. 

1 to 255 

  Reset Point Value When the Reset Point Value is set, Output 
Value A is set and remains so while Reset 
Point Value remains unchanged. 

Set or unset 

  Output Points A to H Numbers of points at which Output Values A 
to H are held. 

9 to 255 

  Output Values A to H Values determined by the changes of state 
of Point to Monitor Value. 

Set or unset 

 

Implementatio
n of module: 

When this module is serviced, the status of the Point to Monitor Value and the Reset Point Value are 
examined. If the Reset Point Value has become set, Output Value A becomes set and remains so while 
this condition persists. If the Point to Monitor Value has changed state since the last time the module 
was serviced, the currently set Output Value will become unset and the next Output Value will become 
set. If the digital point assigned to Output Channel 8 (i.e. Output Value H) is currently set, the next 
change of state of the Point to Monitor Value will result in Output Value A becoming set and Output 
Value H becoming unset. Any point numbers set to zero will be ignored.  

    

Application: The Ring Counter module is used in a weekly changeover of more than two plant items, e.g., pumps, 
boilers, chillers, etc. 
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Damping 

    

Button: 

  

    

Symbol: 

  

Values not shown 

  

Values shown 

    

Function of 
module: 

The Damping modules accepts two inputs, a signal input and a threshold input, and produces one output. 
The output is equal to the change in the value of the signal input between one service of the module and 
the next if the change is greater than the value of the threshold input. Otherwise, the output remains 
unchanged from its previous value. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 
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Variables: Variable name Description Possible values 

  Signal Point Number of point at which Signal Value is 
held. 

1 to 255 

  Signal Value Value which will have its changes compared 
to the Threshold Value or Threshold 
Constant to produce the output. 

Real number 

  Threshold - Constant Constant value against which the Signal 
Value is compared if a Threshold Point is 
not specified. 

Positive real 
number 

  Threshold Point Number of point at which Threshold Value is 
held. May be omitted. 

1 to 255 

  Threshold Value If Threshold Point is specified, this is the 
value against which Signal Value is 
compared. 

Positive real 
number 

  Output Point Number of point at which Output Value is 
held. 

9 to 255 

  Output Value Value returned by the module after acting 
on inputs. 

Real number 

    

Implementatio
n of module: 

Given t = service period of module and given inputs A, B,  

where A = A1 at time t and A=A2 at time 2t  

Output = A if abs(A2-A1) > B 

  

    

Application: For use in filtering inputs.  
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HX Diagram 

 Appearance 

Group 

  (Control) 

 

Button 

 

 

Symbol 

 

Dialog box 

 If UC32/BACnet-type Controller is targeted: 

 

 If Legacy UC type Controller is targeted: 

 

Function 

The Hx Diagram module takes three analog inputs: 

 Temperature , Relative Humidity   and Static Air Pressure    

and produces four analog outputs: 

Enthalpy , Absolute humidity , Saturated Absolute humidity   and Dewpoint . 

This module is intended for use in humidity control with dewpoint applications.  

C 

T rh P 

E A S D 
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The following parameters are involved in the calculation of the outputs: 

Parameter Symbol Unit 

Saturated Water Pressure (Standard or Measured) Ps Pascal (Pa) 

Air Temperature t °C 

Saturated Absolute Humidity (rh = 100%) Xs g/Kg 

Absolute Humidity Xt g/Kg 

Enthalpy h Kjoules/Kg 

Dewpoint P  °C 

Relative Humidity rh % 

    

Saturated Water Pressure (Ps) is calculated as follows: 

Where 0
o
C< t < 100

o
C:  

𝑃𝑠 = 611 × 𝑒(7.257×10−2)𝑡 − (2.937×10−4)𝑡2 +(9.81×10−7)𝑡3 −(1.901×10−9)𝑡4   

Where -20
o
C< t < 0

o
C: 

𝑃𝑠 = 611 × 𝑒(8.203575×10−2)𝑡 − (5.268726×10−4)𝑡2 +(2.066472×10−5)𝑡3 −(5.88887×10−7)𝑡4   

The outputs are calculated as follows: 

Saturated Absolute Humidity (Xs):  

𝑋𝑠 =
6.22 × 𝑃𝑠

100 − 𝑃𝑠
 

Absolute Humidity (Xt):  

𝑋𝑡 =  
𝑟ℎ

100 × 𝑋𝑠

 

Enthalpy (h):   

ℎ = 1.01𝑡 + 𝑋𝑡(1.86𝑡 + 2501) 

Dewpoint (P): Calculation depends on value of saturated water pressure (Ps) 

Where 611 Pa < Ps < 101330 Pa : 

𝑃 =  −24.576 ln(𝑃𝑠) + 6.2152 (ln(𝑃𝑠))2 −  0.47549 (ln(𝑃𝑠))3 +  0.016186 (ln(𝑃𝑠))4  +  0.01  

Where Ps < 611Pa : 

𝑃 =  −36.954 ln(𝑃𝑠) + 12.3323 (ln(𝑃𝑠))2 −  1.44599 (ln(𝑃𝑠))3 +  0.0165712 (ln(𝑃𝑠))4  

 

Note:  The calculations used for Enthalpy in this module are not identical to those used in the Enthalpy module (see 
page  589). 
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Parameters 

Inputs 

 If UC32/BACnet-type Controller is targeted: 

Parameter Name Description Possible values 

Relative Humidity  Analog value representing the % Relative Humidity of the air 0 to 100 

Temperature  Analog value representing air temperature in °C. Real Number 

Pressure   Analog value representing static air pressure. If this is not 
connected, a value of 0 will be used.  

Real Number 

 If Legacy UC type Controller is targeted: 

Parameter Name Description Possible values 

Relative Humidity Point Number of point at which Relative Humidity Value is held. 1 to 255 

Relative Humidity Value Measured value of current relative humidity (%). 0 to 100 

Temperature Point Number of point at which Temperature Value is held. 1 to 255 

Temperature Value Measured value of current temperature in °C. -20 to 100 

Constants 

 If UC32/BACnet-type Controller is targeted: 

Parameter Name Description Possible values 

Mode Selection This sets the calculation method: Cylon Metric calculations (Legacy) or  

ASHRAE metric calculations (ASHRAE) 

 Legacy 

 ASHRAE 

 If Legacy UC type Controller is targeted: 
The legacy version of this module has no constants. 

Outputs 

 If UC32/BACnet-type Controller is targeted: 

Parameter Name Description Possible values 

Enthalpy  Analog value representing Enthalpy (h) in kJ/kg Real Number 

Humidity Ratio  Analog value representing Absolute Humidity (Xt) in g/Kg Real Number 

Saturated Humidity  Analog value representing Saturated Humidity (Xs) in g/Kg Real Number 

Dew Point  Analog value representing the Dew Point (P) in °C Real Number 

 If Legacy UC type Controller is targeted: 

Parameter Name Description Possible values 

Enthalpy Point Number of point at which Enthalpy Value is held. 9 to 255 

Enthalpy Value Calculated value of enthalpy using input values. Real number 

Absolute Humidity Point Number of point at which Absolute Humidity Value is held. 9 to 255 

Absolute Humidity Value Calculated value of absolute humidity using input values. Positive real number 

Saturated Absolute 
Humidity Point 

Number of point at which Saturated Absolute Humidity 
Point is held. 

9 to 255 

Saturated Absolute 
Humidity Value 

Calculated Value of saturated absolute humidity using input 
values. 

Positive real number 

Dew Point Number of point at which dew point value is held. 9 to 255 

Dew Point Value Calculated value of dew point using input values. Real number 

 

rh 

T 

P 

E 

A 

S 

D 
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Enthalpy 

Appearance 

Group 

  (Control) 

 

Button 

 

 

 

Symbol 

 

Dialog box 

 If UC32/BACnet-type Controller is targeted: 

 

 If Legacy UC type Controller is targeted: 

 

Function 

The Enthalpy module calculates the Enthalpy in a system, for use in Humidity Control. 

Note:  The calculations used for Enthalpy in this module (see Outputs section) are not identical to those used in the HX 
Diagram module (see page 586).  

C 
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Parameters 

Inputs 

 If UC32/BACnet-type Controller is targeted: 

Parameter Name Description Possible values 

Relative Humidity  Analog value representing the % Relative Humidity of the air 0 to 100 

Temperature  Analog value representing air temperature in °C. Real Number 

Pressure   Analog value representing air pressure  Real Number  

 If Legacy UC type Controller is targeted: 

Parameter Name Description Possible values 

Input Points A, B Numbers of points at which Input Values A and B are held. 1 to 255 

Input Values A Analog value representing the % Relative Humidity of the air 0 to 100 

Input Values B Analog value representing air temperature in °C. Real Number 

Constants 

 If UC32/BACnet-type Controller is targeted: 

Parameter Name Description Possible values 

Mode Selection This sets the units for the Pressure input.  

If it is set to ASHRAE, the Pressure input will be interpreted as 
Pascals (Pa) and if it is set to Legacy, then the Pressure input will 
be interpreted as Pounds per square inch (psi). 

 Legacy 

 ASHRAE 

 If Legacy UC type Controller is targeted: 

Parameter Name Description Possible values 

Calculation Modes This sets the units for the Pressure input.  Existing Mode 

 Imperial 

 Metric 

Outputs 

 If UC32/BACnet-type Controller is targeted: 

Parameter Name Description Possible values 

Enthalpy Analog value representing Enthalpy in kJ/kg 

If the Mode Selection constant is set to “Legacy” this is 
calculated from: 

[Relative Humidity] * (10 (0.0275* [Temperature]) - 1) + [Temperature] 

If the Mode Selection constant is set to “ASHRAE” this is 
calculated by: 

0.24 *  [Temperature] + W * (1061.0 + 0.444 *  [Temperature]) 

Where W is specific humidity, calculated from [Pressure] and 
[Relative Humidity] 

Real Number 

 If Legacy UC type Controller is targeted: 

Parameter Name Description Possible values 

Output Point Number of point at which Output Value is held. 9 to 255 

Output Value Value of (Input A) * 10
((0.0275* Input B) - 1) 

+ Input B. Real Number 

 

rh 

T 

P 
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Optimizer Block A (Legacy) 

Note:  This block should not be used in a new strategy. It remains in the Engineering Tool only to support exiting 
Strategies. Use the Heating and Cooling Optimizer Blocks instead as described in SECTION 29 : Appendix :: How 
to add Energy Optimization to a  Strategy on page 673. 

 

Note: To create an Optimizer strategy, use the Optimizer macro, which is available on the macro bar of the 
Engineering Centre. The Optimizer macro includes all the modules necessary for correct implementation of an 
Optimizer strategy. The following section describes 1 of those modules - Optimizer Block A. 

Button:  

  

Symbol: 

  

Values not shown  
  

Values shown 

Function of 
module: 

The Optimizer Block A function module is used together with Optimizer Block B, 7 time schedules and 2 comment 
blocks to create an Optimizer strategy that regulates heating and cooling processes to optimum efficiency. 

  

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 
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Variables: Variable name Description Typical 
values 

  Setpoint Point The number of the setpoint that stores the target temperature 
for the building while it is occupied. (During occupancy). 

1-255 

  Setpoint Value The target temperature for the building while it is occupied. 20
 o

C  

  Cooldown Point The number of the setpoint that stores the minimum desired 
temperature for the building while it is unoccupied. 

1-255 

  Cooldown Value The minimum desired temperature for the building while it is 
occupied. 

19 

  Outside temperature Point The number of the point that contains a reading of the 
temperature outside the building. 

1-255 

  Outside temperature Value The level of the temperature outside the building. 11
 o

C 

  Internal temperature Point The number of the point that contains a reading of the 
temperature inside the building. 

1-255 

  Internal temperature Value The level of the temperature inside the building. 20.6
 o

C 

  Flow temperature Point The number of the point that contains a reading of the 
temperature of the heating medium. 

1-255 

  Flow temperature Value The level of the temperature of the heating medium. 48
 o

C 

  Minimum temperature for 
condensation protection Point 

The number of the analog point that specifies the lowest level to 
which the internal temperature can drop before condensation 
protection is activated. 

1-255 

  Minimum temperature for 
condensation protection Value 

The lowest level to which the internal temperature can drop 
before condensation protection is activated. 

10
 o

C 

  Maximum temperature for 
condensation protection Point 

The number of the input point that specifies the level the internal 
temperature must reach for condensation protection to cease. 

1-255 

  Maximum temperature for 
condensation protection Val 

The level the internal temperature must reach for condensation 
protection to cease. 

12
 o

C 

  Minimum flow temperature for 
adaptation Point 

The number of the first of the two points used by the Optimizer 
module to decide whether the heating characteristics for that day 
are to be "learned". "Learning" the heating characteristics means 
that the module examines the performance of the heating and 
cooling processes that were implemented on that day and, if 
necessary, adapts them the next day for greater efficiency. The 
following criteria must be met if adaptation (i.e. learning the 
heating characteristics) is to take place: 

 Flow temp > min flow temp for adaptation 

 Max flow temp during preheat < max flow temp for 
adaptation 

 Condensation protection was not active during preheat. 

1-255 

  Minimum flow temperature for 
adaptation Value 

The minimum temperature the heating medium can have if 
adaptation is to take place. (See above.) 

25
 o

C 

  Maximum flow temperature for 
adaptation Point 

The number of the second of the two points used by the 
Optimizer module to decide whether adaptation is to take place. 
(See "Minimum flow temperature for adaptation" above.) 

1-255 

  Maximum flow temperature for 
adaptation Value 

The maximum temperature the heating medium can have if 
adaptation is to take place. 

45
 o

C 

  Minimum internal temperature 
for preheat Point 

Minimum internal temperature for preheat refers to the lowest 
temperature the interior of the building can be if it is to reach the 
target temperature after the maximum preheat period. Specify 
here the number of the analog point that contains the minimum 
internal temperature for preheat. 

1-255 

  Minimum internal temperature 
for preheat Value 

The lowest temperature the interior of the building can be if it is 
to reach the target temperature after the maximum preheat 
period. 

12
 o

C 

  Maximum preheat period Point The number of the analog point that contains the maximum 
number of minutes to be spent on preheat. 

1-255 
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  Maximum preheat period Value The maximum number of minutes to be spent on preheat. 180 

  Maximum cooldown period 
Point  

The number of the analog point that contains the maximum 
number of minutes to be spent on cooldown. 

1-255 

  Maximum cooldown period 
Value 

The maximum number of minutes to be spent on cooldown 180 

  Dead time Point The number of the analog point that contains the length of time 
from when preheat begins that there is a response in internal 
temperature. 

1-255 

  Dead time Value The length of time from when preheat begins that there is a 
response in internal temperature. (Expressed in minutes.) 

3 

  Overlap period Point Overlap period refers to the maximum number of minutes that 
preheat is allowed to continue into the occupancy period if the 
internal temperature has not reached the target temperature by 
the start of occupancy. Specify here the number of the analog 
point that contains the value of the overlap period. 

1-255 

  Overlap period Value The maximum number of minutes that preheat is allowed to 
continue into the occupancy period if the internal temperature 
has not reached the target temperature by the start of occupancy 

30 

   

Implementation of 
Module: 

The Optimizer has 2 main stages of operation. 

1.The first stage takes place when the learning factor (See Optimizer Block B) is 5 or below. This 
equation is based on the initial building constants. This stage uses a straight line formula. 

  

P = A(X-Y) +B 

where: 

P =Preheat Time 

X is the target temperature. 

Y is the current internal temperature. 

A and B are the initial building constants. 

  

2.The second stage is when the learning factor is over 5 and this equation is based on the calculated 
building constants. The equation is a second order equation. 

  

 

Example: This example shows a building that is to be occupied from 8.am and 5.pm. The Optimizer is required to 
have heated the building to a Target Temperature of 20 DegC by 8 am. and to have the heat on no longer 
than is necessary for the temperature to remain at the Target Temperature for Cooldown at 17:00. This is 
generally about 1 DegC below the Daytime Target Temperature. It has to calculate therefore when to 
switch the heat on and when to turn it off again. 
At 04:00 the building is at 16 DegC. The System Off flag is operational, showing that the heating system is 
switched off. At 07:00 the flag is switched off and the building is placed in the preheat period. The pump is 
switched on. There is a short Dead time period which is the period between when the heating is switched 
on and the building begins to heat up. The Maximum Preheat period that is allowed is 3 hours. At 08:00 
the building is heated to the required temperature and Day Control takes over. There is an Overlap period 
of 1 hour. Day Control is unrelated to the Optimizer itself, i.e., it is a separate control.  
At 16:00, Day Control ends and the Optimizer becomes operational again as the System Off Flag is 
switched On. Cooldown is about to begin. The aim is to have the temperature remaining at the Cooldown 
Target Temperature until 17:00, but for no longer after that than is absolutely necessary. There is, 
however, a Maximum Cooldown Period of 2 hours before which the Optimizer cannot start the cooldown 
process. This means that, as the building is going to become unoccupied at 17:00, cooldown cannot be 

started before 15:00. By 18:00 the building has reached the minimum unoccupied temperature of 16 C. 

Outputs 

 4:00 6:00 8:00 10:00 12:00 14:00 16:00 18:00 20:00 

Cooldown Mode 0 0 0 0 0 1 1 1 0 
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System Off Flag 1 1 0 0 0 0 0 1 1 

In Preheat Period 0 1 1 0 0 0 0 0 0 

Day Control 0 0 1 1 1 1 0 0 0 

Pump Status(Optimum On/ Off Flag) 0 1 1 1 1 1 1 1 0 

   

Application: The Optimizer block A function module is used only when creating an Optimizer strategy, i.e., a 
control strategy that allows the heating and cooling processes in a plant to be self-adapting for 
optimum efficiency.  
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Optimizer Block B (Legacy) 

Note:  This block should not be used in a new strategy. It remains in the Engineering Tool only to support exiting 
Strategies. Use the Heating and Cooling Optimizer Blocks instead as described in SECTION 29 : Appendix :: How 
to add Energy Optimization to a  Strategy  on page 673. 

 

Note: To create an Optimizer strategy, use the Optimizer macro, which is available on the macro bar of the 
Engineering Centre. The Optimizer macro includes all the modules necessary for correct implementation of an 
Optimizer strategy. The following section describes 1 of those modules - Optimizer Block B. 

 

Button: 

  

Symbol: 

  

Value not shown 

  

Value shown 

Function of 
module: 

The Optimizer Block B function module is used together with Optimizer Block A, 7 time schedules and 2 
comment blocks to create an Optimizer strategy that regulates heating and cooling processes to optimum 
efficiency. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 

 

 

 

Variables: Variable name Description Possible values 
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  Enable Point The number of the digital point which, if set, will 
enable the Optimizer. 

1-255 

  Enable Value If set, this value will enable the Optimizer. If unset, 
the Optimizer will not be enabled. 

Set or unset. 

  Input A Point The number of the first of the 2 constants that are 
used by the Optimizer module to learn the heating 
characteristics of the site.  

1-255 

  Input A Value The value of the first constant that is used to learn 
the heating characteristics of the site. The value 
should be such that the building always reaches its 
target temperature before occupancy. 

25 

  Input B Point The number of the second constant that is used by 
the Optimizer module to learn the heating 
characteristics of the site. 

1-255 

  Input B Value The value of the second constant that is used to learn 
the heating characteristics of the site. The value 
should be such that the building always reaches its 
target temperature before occupancy. 

26 

  Optimum 
Start/Stop Flag 
Point 

The number of the digital output point which 
becomes set once the optimum start/stop time has 
been decided. 

1-255 

  Optimum 
Start/Stop Flag 
Value 

This digital point becomes set when the Optimizer 
module has calculated an optimum start/stop time. 
Setting this flag switches on a pump. 

Set or unset 

  In Max Preheat 
Period Point 

The number of the digital output point that becomes 
set when the Optimizer strategy is within the preheat 
period.  

1-255 

  In Max Preheat 
Period Value 

The digital output point that becomes set when the 
Optimizer strategy is within the preheat period. At 
this point, the optimum preheat period is being 
calculated. 

Set or unset 

  Day Control Point The number of the digital output point which 
becomes Set when the plant is in Day Control mode. 

1-255 

  Day Control Value This point is set when the plant is in Day Control 
mode, otherwise it is unset. 

Set or Unset 

  Condensation 
Protection Point 

The number of the digital output point which, when 
set, activates condensation protection. 

1-255 

  Condensation 
Protection Value 

When condensation protection is activated, this point 
becomes set. 

Set or unset. 

  Boost Flag Point The number of the digital output point which 
becomes set when the plant is in Preheat. 

1-255 

  Boost Flag Value When the controller time equals the predicted 
preheat time, this value becomes set and the plant 
switches to preheat. 

Set or unset. 

  System Off Point The number of the digital output point which 
becomes set when the heating system is turned off. 

1-255 

  System Off Value When the heating system is turned off, this value is 
set. 
 
 

Set or unset 

  Optimizer Fault 
Point 

The number of the digital output point which 
becomes set when an error occurs in the Optimizer 
strategy. 

1-255 

  Optimizer Fault When an error occurs in the Optimizer strategy, this Set or unset. 
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Value value is set, in which case the Optimizer will not 
service. 

  Predicted Preheat 
Time Point 

The number of the analog point which specifies the 
time that the Optimizer module predicts preheat will 
occur. 

1-255 

  Predicted Preheat 
Time Value 

The time predicted by the Optimizer module that 
preheat will occur. The time is expressed in the 24-
hour clock, i.e., 00.01-24.00. 

07.15 

  Learning Factor 
Point 

The number of the analog point that specifies 
whether the Optimizer module is "learning" the 
heating characteristic. 

1-255 

  Learning Factor 
Value 

The value of the analog point that specifies whether 
the Optimizer module is "learning" the heating 
characteristic. Each time the Optimizer strategy 
controls the heating & cooling process in the plant to 
optimum efficiency, this value is incremented by 1. 

1-255 

  Predicted 
Cooldown Point 

The number of the analog point that contains the 
predicted time for cooldown. 

1-255 

  Predicted 
Cooldown Value 

The value of the analog point that contains the 
predicted time for cooldown.  

18.45 

  In Optimum Stop 
Period Point 

The number of the digital output point that becomes 
set when the Optimizer is in cooldown mode. 

1-255 

  In Optimum Stop 
Period Value 

This point becomes set at the predicted cooldown 
time and remains set for 3 hours during which time 
the cooldown process is monitored. 

Set or unset. 
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Implementation of module: Learning Factor: "Learning" the heating characteristics means that the module examines 
the performance of the heating and cooling processes that were implemented on that day 
and, if necessary, adapts them the next day for greater efficiency. Each time the Optimizer 
strategy functions correctly by reaching the target temperature and fulfilling the plant 
requirements, the Learning Factor point is incremented by 1 until it reaches 255. It then 
stops incrementing even though the Optimizer continues to learn the heating 
characteristics of the plant. 

  

  

Initial Value A and B: These building constants are used during the first 4 days of operation 
of the Optimizer. The Optimizer assumes that it takes at least 4 days of correct operation 
before any of the learnt data is reliable. During this period a linear equation is used to 
calculate the Start time for preheat: 

    P = A(X-Y) +B 

where 

X is the target temperature. 

Y is the current internal temperature. 

A and B are the building constants. 

  The values selected for A and B should be such that the building should always reach Target temperature 
before occupancy. The values A and B are no longer used after 4 days of correct operation. 

  

  

Day Control: Day control comes into operation under any of the following conditions: 

1. Internal Temperature > Target Temperature. 

2. Current Time > (Occupancy Time + Overlap period) 

3. If the internal temperature drops below the cooldown target temperature during cooldown. In this case, 
Day Control comes on and remains on until the end of occupancy. 

  

  

System Off: The digital output point System Off is SET when the heating system is turned off. This mode is 
in operation under any of the following conditions: 

  Current Time > Unoccupancy Time. 

Current Time > Optimum Stop Time. 

  

    

Application: The Optimizer Block B function module is used when creating an Optimizer strategy, i.e., a control strategy 
that allows the heating and cooling processes in a plant to be self-adapting for optimum efficiency. To 
create an Optimizer strategy, simply use the Optimizer macro from the macro bar or, alternatively, connect 
the following function modules: 7 time schedules, 2 comment blocks, an Optimizer block A and an 
Optimizer block B. 
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Cooling Optimizer Block A (Cool-OpA) 

Appearance 

Group 

  
(Control) 

 

Button 

 

 

Symbol 

 
 

Dialog box 
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Function:  

The Cooling Optimizer Block A (Cool-OpA) function module is used together with Heating Optimizer Block A, Heating 
Optimizer Block B, Cooling Optimizer Block B and 7 time schedules to create an Optimizer strategy that regulates heating 
and cooling processes to optimum efficiency.  

See SECTION 29 : Appendix :: How to add Energy Optimization to a  Strategy on page 673 for details. 

 

Note:  The Optimizer Modules are available only with Unitron Firmware version 6.2.1 or later, or CBM/CBT Firmware 
version 7.6.8 or later. 

Parameters 

Inputs 

Parameter Name Description Possible values 

Startup Target Tem Target Start Temperature (TST) 

The temperature that must be reached at the start of 
Occupancy.  

Real Number 

Shutdown Target T Allowable End Temperature (AET) 

The temperature that must be maintained until the end of 
Occupancy. 

Real Number 

OAT Outside Air Temp (OAT)  

Current temperature of the ambient air outside the building. 

Real Number 

IAT Inside Air Temperature (IAT)  

Current inside air temperature. 

Real Number 

Flow Temp Flow Temp  (FT)  

Current temperature of the Conditioning medium (Heating or 
Cooling). While it is recommended that this be used, if the 
medium Flow Temperature is not available, this input can 
remain disconnected. (if this is the case, then the ‘Sanity 
Check’ condition described on page 681 will be ignored) 

Real Number 

Enable Enable  

Input signal to enable or disable Optimizer operation. Does 
not disable Fabric Protection operation. If not connected 
then assumed to be enabled 

Binary 

Min Flow Adapt Tem Values can be either fixed as Constants within the module 
or set from external values within control strategy, usually 
setpoints. 

If these points are not attached, then the values set in the 
Constants section will be used. 

Real Number 

Max Flow Adapt Tem 

Min Startup Temp Real Number 

Max Startup Time Integer (minutes) 

Max Shutdown Time Integer (minutes) 

Dead Time Integer (minutes) 

Max Overlap Time Integer (minutes) 

Model A Value  

Model B Value  
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Constants  

Parameter Name Description Possible values 

Min Flow Adapt Tem Flow Min Temp (FTmin) / Flow Max Temp (FTmax)  

FTmin and FTmax define a range outside which the 

temperature of the  conditioning medium must be before 
the start of Boost. FTmin is the bottom of this range, and 
FTmax is the top of this range. 

In Heating Optimization, the flow temperature must be 
below the minimum temperature in the range, (i.e. below 
the value of FTmin) at the start, and must rise past the 
maximum temperature (FTmax) during the boost period. 

In Cooling Optimization, the flow temperature must be 
above the temperature range before Boost, (i.e. above the 
value of FTmax) at the start, and must fall below the 
minimum temperature (FTmin) during the boost period. 

If the flow temperature does not meet these conditions 
before the start of Boost, the Learning process will not take 
place in the Optimizer (see page 681). 

Real Number 

Max Flow Adapt Tem  

Min Startup Temp Startup Temp (IATstart) 

If there is no historical data available (i.e. when algorithm is 
initialized) this value is used as the limit value (minimum for 
heating, maximum for cooling) of the IAT at the start of the 
maximum Boost. (This value is only used once, to initialize 
the adaptive Model at start of Learning )   

Real Number 

Max Startup Time Boost Max Period  

The maximum time in minutes of the Startup (“Boost”) 
period  

Integer (minutes) 

Max Shutdown Time Falloffdown Max Period 

The maximum time in minutes of the Shutdown (“Falloff”) 
period  

Integer (minutes) 

Dead Time Deadtime (DT)  

The Optimizer will add this period of time to the Startup 
(“Boost”) time that it has calculated, in order to determine 
the actual Boost time that it will use. 

If there is no historical data available (i.e. when algorithm is 
initialized), this value (in minutes) is used as an estimate of 
the time between the start of heating or cooling action, and 
any corresponding change in temperature inputs. (This 
value is used once to initialize the adaptive Model at start 
of Learning, and in Fabric Protection )  

Integer (minutes) 

Max Overlap Time Overlap Period  

If target temperature is not met by the start of Occupancy, 
this is the number of minutes for which Boost will continue 
to operate after the start of Occupancy to try and reach the 
target. 

Integer (minutes) 

Initial Linear Model A Linear Model A Value (A) / Linear Model B Value (B) 

Linear Model parameters used initially by the Optimizer 
module to estimate Boost start time.  

 

Initial Linear Model E  
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Outputs  

Parameter Name Description Possible values 

Demand Demand  

This is the Optimized output - it indicates whether or not the 
conditioning plant should be active. 

Binary 

Startup Status Boost 

This indicates that conditioning plant should be operating at full 
capacity to achieve target temperature in the optimum time. This 
bypasses weather compensation etc. 

Binary 

Day Control Status Day Control Status  

Indicates whether or not the Optimizer is in “Day Control” mode. 

Binary 

Shurtdown Status Cooldown Status  

Indicates whether or not the Optimizer is in Cooldown 
(“Shutdown”) mode. This output remains on for 3 hours, during 
which the Optimizer continues to monitor the Internal temperature 
falloff, to ensure the optimal falloff time is used. 

Binary 

Time Sch. Active Time Schedule Status (Occupancy times) 

This output is intended to show when there is an ON signal from 
any of the Optimizer Time Schedule blocks. However, it is not 
enabled by default, in order to use it you must connect all of the 
Time Schedule Module outputs to the inputs on Optimizer Block B. 

Binary 

System Off Status System Off Flag 

This value is ON when neither the Optimizer nor Occupancy is in 
force. 

Binary 

Optimiser Status Optimizer Status  

This shows when the Optimizer is in Startup mode – i.e. Maximum 
Boost time plus overlap. 

Binary 

Error Status Error Status  

Error indication.  This value is ON if the sequence of Time 
Schedule and Optimizer blocks is not correct. When this 
value is ON, Optimizer operation is disabled, but Fabric 
Protection operation will still operate. 

Binary 

Learning Factor Learning Factor 

This outputs the current value of the Learning Factor.  

Real Number 
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Cooling Optimizer Block B (Cool-OpB) 

Appearance 

Group 

  ( Control) 

 

Button 

 

 

Symbol 

 
 

Dialog box 

 

  

C 
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Function:  

The Cooling Optimizer Block B (Cool-OpB) function module is used together with Heating Optimizer Block A, Heating 
Optimizer Block B, Cooling Optimizer Block A and 7 time schedules to create an Optimizer strategy that regulates heating 
and cooling processes to optimum efficiency.  

See SECTION 29 : Appendix :: How to add Energy Optimization to a  Strategy on page 673 for details.  

Note:  The Optimizer Modules are available only with Unitron Firmware version 6.2.1 or later, or CBM/CBT Firmware 
version 7.6.8 or later. 

Parameters 
Inputs 

Parameter Name Description Possible values 

Mon Time Sch State 
Tue Time Sch State 
Wed Time Sch State 
Thurs Time Sch State 
Fri Time Sch State 
Sat Time Sch State 
Sun Time Sch State 

Occupancy 

A set of 7 on/off times, one for each day of the week, defining 
the times during which the building is occupied, i.e. the times 
during which the Building conditions are to be controlled. 

Field Controller 
Schedule output 

DT Dead Time (not used) (not used) 

Outputs  

Parameter Name Description Possible values 

Predicted Startup T Predicated Boost Start Time  

The value of this point is a “Decimal Time” representation of the 
time at which Boost will start. (e.g. 9.3 represents 9:30 am). 

Note: this value is only updated when Optimizer Status is ON.  

Digital Time (0-24) 

Predicted Shutdown Predicated Cooldown Start Time   

The value of this point is a “Decimal Time” representation of the 
time at which Cooldown will start. (e.g. 15.15 represents 3:15 
pm)  

Note: this value is only updated when Falloff Status is ON. 

Digital Time (0-24) 

Time Until occupied Time until Occupancy Start 

This a “Decimal Time” representation of the time remaining 
until the start of Occupancy (e.g. 1.5 means 1 hour and 50 
minutes remaining).  

Digital Time (0-24) 

Time Until Unoccupied Time until Occupancy End 

This a “Decimal Time” representation of the time remaining 
until the end of Occupancy (e.g. 7.35 means 7 hours and 35 
minutes remaining).  

Digital Time (0-24) 

Mon On Time 
Mon Off Time 
Tues On Time 
Tues Off Time 
Wed On Time 
Wed Off Time 
Thurs On Time 
Thurs Off Time 
Fri On Time 
Fri Off Time 
Sat On Time 
Sat Off Time 
Sun On Time 
Sun Off Time 

Time Schedule Content outputs 

On Optimizer block B there are a number of outputs that 
provide useful information about Time Schedule settings. 
There is one pair for each of the Optimizer Time Schedule 
modules, showing the on time and off time for each schedule 
module, in “Decimal Time” (14.25 = 2:25 pm) 

Digital Time (0-24) 
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Heating Optimizer Block A (Heat-OpA) 

Appearance 

Group 

 
  (Control) 

 

Button 
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Function:  

The Heating Optimizer Block A (Heat-OpA) function module is used together with Heating Optimizer Block B, Cooling 
Optimizer Block A, Cooling Optimizer Block B and 7 time schedules to create an Optimizer strategy that regulates heating 
and cooling processes to optimum efficiency.  

See SECTION 29 : Appendix :: How to add Energy Optimization to a  Strategy on page 673 for details.  

Note:  The Optimizer Modules are available only with Unitron Firmware version 6.2.1 or later, or CBM/CBT Firmware 
version 7.6.8 or later. 

Parameters 

Inputs 

Parameter Name Description Possible values 

Startup Target Tem Target Start Temperature (TST) 

The temperature that must be reached at the start of 
Occupancy.  

Real Number 

Shutdown Target T Allowable End Temperature (AET) 

The temperature that must be maintained until the end 
of Occupancy. 

Real Number 

OAT Outside Air Temp (OAT)  

Current temperature of the ambient air outside the 
building. 

Real Number 

IAT Inside Air Temperature (IAT)  

Current inside air temperature. 

Real Number 

Flow Temp Flow Temp  (FT)  

Current temperature of the Conditioning medium 
(Heating or Cooling). While it is recommended that 
this be used, if the medium Flow Temperature is not 
available, this input can remain disconnected. (if this is 
the case, then the ‘Sanity Check’ condition described 
on page 681 will be ignored) 

Real Number 

Enable Enable  

Input signal to enable or disable Optimizer operation. 
Does not disable Fabric Protection operation. If not 
connected then assumed to be enabled 

Binary 

Min Flow Adapt Tem Values can be either fixed as Constants within the 
module or set from external values within control 
strategy, usually setpoints. 

If these points are not attached, then the values set in 
the Constants section will be used. 

Real Number 

Max Flow Adapt Tem 

Min Startup Temp Real Number 

Max Startup Time Integer (minutes) 

Max Shutdown Time Integer (minutes) 

Dead Time Integer (minutes) 

Max Overlap Time Integer (minutes) 

Model A Value  

Model B Value  
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Constants  

Parameter Name Description Possible values 

Min Flow Adapt Tem Flow Min Temp (FTmin) / Flow Max Temp (FTmax)  

FTmin and FTmax define a range outside which the 

temperature of the  conditioning medium must be 
before the start of Boost. FTmin is the bottom of this 
range, and FTmax is the top of this range. 

In Heating Optimization, the flow temperature must be 
below the minimum temperature in the range, (i.e. 
below the value of FTmin) at the start, and must rise 
past the maximum temperature (FTmax) during the 
boost period. 

In Cooling Optimization, the flow temperature must be 
above the temperature range before Boost, (i.e. 
above the value of FTmax) at the start, and must fall 
below the minimum temperature (FTmin) during the 
boost period. 

If the flow temperature does not meet these 
conditions before the start of Boost, the Learning 
process will not take place in the Optimizer (see page 
681). 

Real Number 

Max Flow Adapt Tem  

Min Startup Temp Startup Temp (IATstart) 

If there is no historical data available (i.e. when 
algorithm is initialised) this value is used as the limit 
value (minimum for heating, maximum for cooling) of 
the IAT at the start of the maximum Boost. (This value 
is only used once, to initialise the adaptive Model at 
start of Learning )   

Real Number 

Max Startup Time Boost Max Period  

The maximum time in minutes of the Startup (“Boost”) 
period  

Integer (minutes) 

Max Shutdown Time Cooldown Max Period 

The maximum time in minutes of the Shutdown 
(“Cooldown” or “Falloff”) period  

Integer (minutes) 

Dead Time Deadtime (DT)  

If there is no historical data available (i.e. when 
algorithm is initialised), this value (in minutes) is used 
as an estimate of the time between the start of 
heating or cooling action, and any corresponding 
change in  temperature inputs. (This value is used 
once to initialise the adaptive Model at start of 
Learning, and in Fabric Protection )  

Integer (minutes) 

Max Overlap Time Overlap Period  

If target temperature is not met by the start of 
Occupancy, this is the number of minutes for which 
Boost will continue to operate after the start of 
Occupancy to try and reach the target. 

Integer (minutes) 

Initial Linear Model A Linear Model A Value (A) / Linear Model B Value (B) 

Linear Model parameters used initially by the 
Optimizer module to estimate Boost start time.  

 

Initial Linear Model E  
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Outputs 

Parameter Name Description Possible values 

Demand Demand  

This output indicates whether or not the 
conditioning plant should be active. 

Binary 

Startup Status Boost 

This indicates that conditioning plant should be 
operating at full capacity to achieve target 
temperature in the optimum time. This bypasses 
weather compensation etc. 

Binary 

Day Control Status Day Control Status  

Indicates whether or not the Optimizer is in “Day 
Control” mode. 

Binary 

Shurtdown Status Falloff Status  

Indicates whether or not the Optimizer is in 
Falloff (“Shutdown”) mode. This output remains 
on for 3 hours, during which the Optimizer 
continues to monitor the Internal temperature 
falloff, to ensure the optimal falloff time is used. 

Binary 

Time Sch. Active Time Schedule Status 

This output is intended to show when there is an 
ON signal from any of the Optimizer Time 
Schedule blocks. However, it is not enabled by 
default, in order to use it you must connect all of 
the Time Schedule Module outputs to the inputs 
on Optimizer Block B. 

Binary 

System Off Status System Off Flag 

This value is ON when neither the Optimizer nor 
Occupancy is in force. 

Binary 

Optimiser Status Optimizer Status  

This shows when the Optimizer is in Startup 
mode – i.e. Maximum Boost time plus overlap. 

Binary 

Error Status Error Status  

Error indication.  This value is ON if the 
sequence of Time Schedule and Optimizer 
blocks is not correct. When this value is ON, 
Optimizer operation is disabled, but Fabric 
Protection operation will still operate. 

Binary 

Learning Factor Learning Factor 

This outputs the current value of the Learning 
Factor.  

Real Number 
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Heating Optimizer Block B (Heat-OpB) 

Appearance 

Group 

 
  (Control) 

 

Button 

 

 

Symbol 

 
 

Dialog box 

 
 

C 
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Function: 

The Heating Optimizer Block B (Heat-OpB) function module is used together with Heating Optimizer Block A, Cooling 
Optimizer Block A, Cooling Optimizer Block B and 7 time schedules to create an Optimizer strategy that regulates heating 
and cooling processes to optimum efficiency.  

See SECTION 29 : Appendix :: How to add Energy Optimization to a  Strategy on page 673 for details. 

 

Note:  The Optimizer Modules are available only with Unitron Firmware version 6.2.1 or later, or CBM/CBT Firmware 
version 7.6.8 or later. 

 

Parameters 

Inputs 

Parameter Name Description Possible values 

Mon Time Sch State Occupancy 

A set of 7 on/off times, one for each day of the week, 
defining the times during which the building is 
occupied, i.e. the times during which the Building 
conditions are to be controlled. 

Field Controller Schedule 
output 

Tue Time Sch State 

Wed Time Sch State 

Thurs Time Sch State 

Fri Time Sch State 

Sat Time Sch State 

Sun Time Sch State 

DT Dead Time (not used) (not used) 

Min Fabric Protection Overrides for the Fabric Protection constants Real Number 

Max Fabric 
Protection 

Real Number 

 

 

 

Constants  

Parameter Name Description Possible values 

Min Fabric Protection Fabric Protection Min Temp (FPTmin) 

Fabric Protection Max Temp (FPTmax) 

 “Fabric Protection”  activates when temperature 
drops below FPTmin and continues to operate until 
temperature reaches FPTmax.  

Real Number 

Max Fabric 
Protection 

Real Number 
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Outputs  

Parameter Name Description Possible values 

Predicted Startup T Predicated Boost Start Time  

The value of this point is a “Decimal Time” 
representation of the time at which Boost will 
start. (e.g. 9.3 represents 9:30 am). 

Note: this value is only updated when Optimizer 
Status is ON.  

 

Digital Time (0-24) 

Predicted Shutdown Predicated Cooldown Start Time   

The value of this point is a “Decimal Time” 
representation of the time at which Cooldown 
will start. (e.g. 15.15 represents 3:15 pm)  

Note: this value is only updated when Falloff 
Status is ON. 

 

Digital Time (0-24) 

Time Until occupied Time until Occupancy Start 

This a “Decimal Time” representation of the time 
remaining until the start of Occupancy (e.g. 1.5 
means 1 hour and 50 minutes remaining).  

Digital Time (0-24) 

Time Until Unoccupied Time until Occupancy End 

This a “Decimal Time” representation of the time 
remaining until the end of Occupancy (e.g. 7.35 
means 7 hours and 35 minutes remaining).  

 

Digital Time (0-24) 

Mon On Time Time Schedule Content outputs 

On Optimizer block B there are a number of 
outputs that provide useful information about 
Time Schedule settings. There is one pair for 
each of the Optimizer Time Schedule modules, 
showing the on time and off time for each 
schedule module, in “Decimal Time” (14.25 = 
2:25 pm) 

Digital Time (0-24) 

Mon Off Time 

Tues On Time 

Tues Off Time 

Wed On Time 

Wed Off Time 

Thurs On Time 

Thurs Off Time 

Fri On Time 

Fri Off Time 

Sat On Time 

Sat Off Time 

Sun On Time 

Sun Off Time 

Fabric Protection S Fabric Protection Status   

Indicates whether or not the Optimizer is in 
“Fabric Protection” mode. (Heating Block B only) 

Binary 
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CBT Stat Module 

Appearance 

Group 

  (Control) 

 

Button 

 

 

Symbol 

 
  

Note: This button is only visible if targeted controller is CBT12iVAV type. 

Dialog box 

 

Function:  

This module brings allows operation of the CBT-STAT keypad device to be customized. 

Parameters 

C 
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Inputs 

Parameter Name Description Possible values 

Heating Symbol The status of the “Heating” symbol on the CBT-STAT 
display. 

On or Off 

Cooling Symbol The status of the “Cooling” symbol on the CBT-STAT 
display. 

On or Off 

Occupied Symbol The status of the “Occupied” symbol on the CBT-STAT 
display. 

On or Off 

House Symbol The status of the “House” symbol on the CBT-STAT display. On or Off 

Override Symbol The status of the “Override” symbol on the CBT-STAT 
display. 

On or Off 

Alarm Symbol The status of the “Alarm” symbol on the CBT-STAT display. On or Off 

Fan Symbol The status of the “Fan” symbol on the CBT-STAT display. On or Off 

Program Symbol The status of the “Program” symbol on the CBT-STAT 
display. 

On or Off 

Allow Set Temp 
Mods 

If enabled, the user will be able to modify Temperature 
setpoint from the CBT-STAT. 

On or Off 

Heating SP The value that will be used as the Heating setpoint unless 
overridden by the user on the CBT-STAT. 

Any real number 

Cooling SP The value that will be used as the Cooling setpoint unless 
overridden by the user on the CBT-STAT. 

Any real number 

Temp SP Step Size The value by which the setpoint changes for each keypress 
on the CBT-STAT. 

Any real number. 

Default is 0.1 

Temp SP Span The range within which the user can adjust the setpoint on 
the CBT-STAT keypad. 

Any real number.  

Default is 2.0 

(i.e. setpoint can be 
adjusted by  ± 2.0 
degrees) 

 

Constants  

Parameter Name Description Possible values 

Line 1 Display The value that will be displayed on the first line of the CBT-
STAT display. 

Current Temperature or 
Current Set Point 

Line 2 Display The value that will be displayed on the second line of the 
CBT-STAT display. 

Current Humidity or 
Current Set Point 

Units The units in which temperature values will be displayed on 
the CBT-STAT. 

Farenheit or Celcius 

Menu Timeout The period of inactivity after which the CBT-STAT will exit 
Engineering mode and return to its default display. 

1 - 30 

Password A password to be entered on the CBT-STAT in order to 
enter Engineering mode. 

0 - 9999 
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Outputs  

Parameter Name Description Possible values 

Stat Temperature The temperature reading from the CBT-STAT’s inbuilt 
temperature sensor is reflected here. 

Any real number 

Stat Humidity The temperature reading from the CBT-STAT’s inbuilt 
humidity sensor (if present) is reflected here. 

Any real number 

Heating SP The value of the point connected to Heating SP input 
is reflected here unless the user is permitted to 
override it, in which case this output will give the 
value set on the CBT-STAT. 

Any real number 

Cooling SP The value of the point connected to Cooling SP input 
is reflected here unless the user is permitted to 
override it, in which case this output will give the 
value set on the CBT-STAT. 

Any real number 

Stat Operational Indicates if the CBT-STAT communications is 
operational. 

On or Off 

User Mode Key Press Indicates that a CBT-STAT button has been pressed 
and identifies which one. 

0  – no button is pressed 

1– Up key is pressed 

2– Down key is pressed 

4– Left key is pressed 

8– Right key is pressed 

16– Abort key is pressed 

Has Humidity Sensor Indicates if the CBT-STAT has an in-built humidity 
sensor. 
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Deadband Variable module 

Appearance 

Group 

 
  (Control) 

 

Button 

 

 

 

Symbol 

 

 

Dialog box 

 
 

Function: 

A “deadband” is a tolerance applied to a setpoint, such that if the measured temperature is outside that band the control 
algorithms are applied, but if the measured temperature is within the band control is not applied (control is ‘dead’). 

The Deadband Variable module is a dual-channel module, in that it comprises two identical functions – allowing it to 
provide a deadband for heating and a deadband for cooling in a single module. 

The “deadband” tolerance can be applied above the nominal value, straddling the nominal value or below the nominal 
value. 

Each ‘channel’ of the Deadband module has a nominal value input , a Deadband input   (which overrides the 

internal ‘Deadband constant) and a High   and Low   output  

Note:  The Deadband Variable Module is available only with Unitron Firmware version 6.2.1 or later, or CBM/CBT 
Firmware version 7.6.8 or later. 

C 

I D 

H L 
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Parameters 

Inputs 

Parameter Name Description Possible values 

Input 1 Value to which deadband will be applied for channel 1 Real Number 

Deadband 1 If connected, this value is used as the deadband for 
channel 1 

Real Number 

Input 2 Value to which deadband will be applied for channel 2 Real Number 

Deadband 2 If connected, this value is used as the deadband for 
channel 2 

Real Number 

 

Constants 

Parameter Name Description Possible values 

Type 1 The Deadband Type may be above , straddling 
orbelow the nominal value). 

 

deadband low

deadband high

deadband value

D
e

a
d

b
a

n
d

T
e

m
p

e
ra

tu
re

Setpoint
(nominal value)

(deadband value)/2

deadband low

deadband high

deadband value

D
e

a
d

b
a

n
d

T
e

m
p

e
ra

tu
re

Setpoint
(nominal value)

deadband low

deadband high

deadband value

D
e

a
d

b
a

n
d

T
e

m
p

e
ra

tu
re

Setpoint
(nominal value)

Type 2 :: Deadband straddling the setpoint

Type 1 :: Deadband above the setpoint

Type 3 :: Deadband below the setpoint
 

 1 (above the nominal value),  

 2 (straddling the nominal value) 

 3 (below the nominal value). 
Type 2 

DB 1 If the Deadband 1 input is not connected, then this 
constant  is used as the deadband for channel 1 

Real Number 

DB 2 If the Deadband 2 input is not connected, then this 
constant  is used as the deadband for channel 2 

Real Number 
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Outputs 

Parameter 
Name 

Description Possible values 

High 1 If type = “above” (type 1) then this  is input 1 plus deadband 1 

(H= I + DB) 

 

If type = “straddle” (type 2) then this is input 1 plus half of deadband 1 

(H = 1 + DB/2) 

 

If type=”below” (type 3) then this is the same value as input 1 

(H = I) 

Real Number 

Low 1 If type = “above” (type 1) then this is the same value as input 1 

(L= I) 

 

If type = “straddle” (type 2) then this is input 1 less half of deadband 1 

(L = 1 - DB/2) 

 

If type=”below” (type 3) then this is input 1 less deadband 1 

(L = I - DB) 

Real Number 

High 2 If type = “above” (type 1) then this  is input 2 plus deadband 2 

(H= I + DB) 

 

If type = “straddle” (type 2) then this is input 2 plus half of deadband 2 

(H = 1 + DB/2) 

 

If type=”below” (type 3) then this is the same value as input 2 

(H = I) 

Real Number 

Low 2 If type = “above” (type 1) then this is the same value as input 2 

(L= I) 

 

If type = “straddle” (type 2) then this is input 2 less half of deadband 2 

(L = 1 - DB/2) 

 

If type=”below” (type 3) then this is input 2 less deadband 2 

(L = I - DB) 

Real Number 

 

 

 

 





 
 

 

 

 

SECTION 26 :  FUNCTION MODULES  
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Rescale from 0 - 100 

    

Button: 

  

    

Symbol: 

  

Values not shown 

  

Values shown 

    

Function of 
module: 

The Rescale from 0 to 100 module rescales a value between 0 and 100 according to programmable 
limits. The module requires three analog inputs and produces one analog output. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 

 

 

  



 

 
 

MAN00058US rev 69 © American Auto-Matrix 621 

       

Variables: Variable name Description Possible values 

  Input Points A, B, C Numbers of points at which Input 
Values A, B, C are held. 

1 to 255 

  Input Values A, B, C Input Value A = lower limit for 
rescale 

Input Value B = upper limit for 
rescale 

Input Value C = variable to be 
rescaled 

Positive integers up to 100 

  Output Point Number of point at which Output 
Value is held. 

9 to 255 

  Output Value Value produced by acting on Input 
Values according the following 
equation: 

Output = A+((C*(B-A))/100) 

Positive integer up to 100 

    

Implementation 
of module: 

Given lower limit = A, upper limit = B and variable to be rescaled = C: Output = 
A+((C*(B-A))/100) 

  

    

Application: Rescaling active inputs, e.g., light sensor or lux sensor. 0 = 0 Lux, 100 = 20 000 Lux. 
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Rescale to 0 - 100 

    

Button: 

  

    

Symbol: 

  

Values not shown 

  

Values shown 

      

Function of 
modules: 

The Rescale to 0 and 100 module expresses in percentage terms an input that is within programmable 
limits. The module requires three analog inputs and produces a single analog output. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 
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Variables: Variable name Description Possible values 

  Input Points A, B, C Numbers of points at which Input 
Values A, B, C are held. 

1 to 255 

  Input Values A, B, C Input Value A = lower limit of rescale 

Input Value B = upper limit of rescale 

Input Value C = Variable to be 
rescaled 

Positive integers up to 100 

  Output Point Number of point at which Output 
Value is held. 

9 to 255 

  Output Value Value produced from inputs 
according to the equation: Output = 
100*(C-A)(B-A). 

Positive integer up to 100 

    

Implementation of module: Given lower limit = A, upper limit = B and variable to be rescaled = C: 
Output = 100*((C-A)/(B-A)) 
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Limit at Minimum and Maximum 
    

Button: 

  
    

Symbol: 

 Values not shown  Values shown 
      

Function of 
module: 

The Limit at Min and Max module limits an analog input between programmable maximum and 
minimum values. The module accepts three analog inputs and produces one analog output. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 

 
 
       

Variables: Variable name Description Possible values 

  Input Points A, 
B, C 

Numbers of points at which Input Values A, B, C are held. 1 to 255 

  Input Values A, 
B, C 

Input Value A = Minimum allowable output 
Input Value B = Maximum allowable output 
Input Value C = Variable to be limited between max and min 
values. 

Real numbers 

  Output Point Number of point at which Output Value is held. 9 to 255 

  Output Value Value produced by comparing Input C with inputs A and B. Real number 
    

Implementation 
of module: 

Given Input A = Min Value, Input B = Max Value and Input C = variable to be limited: 
Output = A, if C < A 
Output = B, if C > B 
Output = C, if A ≤ C ≤ B 

      

Application: AHU dampers for minimum fresh air, e.g., 20%. 
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Analog Gate 

    

Button: 

  
    

Symbol: 

 Values not shown  Values shown 
      

Function of 
module: 

The Analog Gate module allows the selection of one of two analog inputs, based on the state of the 
digital input. The selected analog value is returned as the output. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 

 
       

Variables: Variable name Description Possible values 

  Input Points A, B, C Numbers of points at which Input Values A, B, C 
are held. 

1 to 255 

  Input Values A, B One of these two analog values will be returned as 
the Output Value, depending on the value of Input 
Value C. 

Real numbers 

  Input Value C Value that determines which of Input Values A and 
B is returned as the Output Value. 

Set or unset 

  Output Point Number of point at which Output Value is held. 9 to 255 

  Output Value Value of Input Value A or Input Value B, depending 
on the value of Input Value C. 

Real number 

    

Implementation 
of module: 

Given two analog inputs A, B and a digital input C: 
Output = A, if C = set 
Output = B, if C = unset 

  

    

Application: To force an output because of an event , e.g., to open an AHU heating valve to 100% if frost is ON. 
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Comparator 

    

Button: 

  
    

Symbol: 

 Values not shown  Values shown 
    

Function of 
module: 

The Comparator module accepts two analog inputs and compares them. If Input A is greater than Input 
B, the True Output Value is set. Otherwise it is unset.  

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 

 
        

Variables: Variable name Description Possible values 

  Input Points A, B, Numbers of points at which Input Values A, B, 
are held. 

1 to 255 

  Input Values A, B Analog values which will be compared to 
produce Output Value. 

Real numbers 

  True Output Point Number of point at which True Output Value is 
held. 

9 to2 55 

  True Output Value Value produced by comparison between Input 
Values A and B according to the equation 
Output = True if A > B. 

Set or unset 

  Complement Output 
Point 

Number of point at which complement of True 
Output Value is held. 

9 to 255 

  Complement Output 
Value 

Complement of True Output Value. Set or unset 

    

Implementation of 
module: 

Given Input Values A, B 
Output = set, if A > B; Output = unset if A ≤ B 

  

 



 

 
 

MAN00058US rev 69 © American Auto-Matrix 627 

Window Comparator 

    

Button: 

  

    

Symbol: 

  

Values not shown 

  

Values shown 

      

Function of 
module: 

The Window Comparator module compares one analog input with two others, and sets the True 
Output Value if the compared value is less than the lower value or greater than the higher value. If the 
compared value falls between the other two values, or equals either of them, the True Output Value is 
unset. The module accepts three analog inputs and produces two digital outputs which are 
complements of each other. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 
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Variables: Variable name Description Possible values 

  Input Points A, B, C Numbers of points at which Input Values A, 
B, C are held. 

1 to 255 

  Input Value A If Input Value C is less than this value, the 
True Input Value will be set. 

Real number 

  Input Value B If Input Value C is greater than this value, the 
True Input Value will be set. 

Real number 

  Input Value C This value is compared to Input Values A and 
B to produce the True Output Value. 

Real number 

  True Output Point Number of point at which True Output Value 
is held. 

9 to 255 

  True Output Value Value determined by relation between Input 
Value C and Input Values A and B. 

Set or unset 

  Complement Output 
Point 

Number of point at which complement of True 
Output Value is held. 

9 to 255 

  Complement Output 
Value 

Complement of True Output Value. Set or unset 

Implementatio
n of module: 

Given analog inputs A, B, C: 

Output = set, if C < A OR C> B 

Output = unset if A ≤ C ≤ B 

  

Application: To monitor the level of liquid in a tank. The module will cause an alarm if the level is not within the higher 
and lower limits. 
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Limit to 0 or 100 

    

Button: 

  

    

Symbol: 

  

Values not shown 

  

Values shown 

      

Function of 
module: 

The Limit to 0 or 100 module compares an analog input to two programmable limits. If it falls below the 
minimum limit, a value of 0 is returned as output. If it is above the maximum limit, a value of 100 is 
returned. If the input falls between the two limits, the input value is returned as the output. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 
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Variables: Variable name Description Possible values 

  Input Points A, B, 
C 

Numbers of points at which Input Values A, B, 
C are held. 

1 to 255 

  Input Values A, B, 
C 

Input Value A = lower limit 

Input Value B = upper limit 

Input Value C = variable to be compared. 

Real numbers less 
than 100 

  Output Point Number of point at which Output Value is held. 9 to 255 

  Output Value Value produced by the relation between Input 
Value C and Input Values A and B. 

Real number less 
than 100 

    

Implementation of 
module: 

Given Input Value A = lower limit, Input Value B = upper limit 
and Input Value C = variable to be compared: 

Output = 0, if C < A 

Output = 100, if C > B 

Output = C, if A ≤ C ≤ B 

  

    

Application: To limit signal output. 
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Rescale Custom Module 

Appearance 

Group 

  (Function) 

 

Button 

 

 

 

Symbol 

 

Dialog box 

 

Function:  

This module takes a value that varies between two limits, and generates a new value that varies in the same proportion 
between two different limits. 

Input Value  is scaled from range [  -> ] to range  [  ->  ] and the result is outputted on  

𝑀 = ((𝐸 − 𝐴) ∗
(𝐷 − 𝐶)

(𝐵 − 𝐴)
 ) + 𝐶 

If limiting enabled (  == 1 ) then 

If (  < ) then  becomes set to  

If (  > ) then  becomes set to  

 

Note:  The Rescale Custom Module is available only with Unitron Firmware version 6.2.1 or later, or CBM/CBT 
Firmware version 7.6.8 or later. 

 

F 

E A B C D M 

F 
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Parameters 

Inputs 

Parameter Name Description Possible values 

FROM Lower  Lower limit of rescale FROM. Real number 

FROM Upper  Upper limit of rescale FROM. Real number 

TO lower  Lower limit of rescale TO. Real number 

TO Upper  Upper limit of rescale TO. Real number 

Input  Value   Value that is going to rescaled from its original range to a 
new range. 

Positive integer 

Limit Enable   If limiting is enabled then the output will be limited 
between the lower rescale TO limit and the upper rescale 
TO limit.  

If disabled the output can be outside limits but will follow 
the slope of the limits. 

Boolean On or Off 

 

Outputs  

Parameter Name Description Possible values 

Output (M) The scaled Value. Real number 

 

 

  

A 

B 

C 

D 

E 

F 



 
 

 

 

SECTION 27 :  STATISTICAL MODULES 
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Datalog 

    

Button: 

  

    

Symbol: 

  

 

      

Function of 
module: 

The Datalog module logs the values of a given analog or digital point over a period of time. For example, a 
datalog on an output point could monitor valve positions, or a datalog on an input could log Room 
Temperature. The number of datalogs that can be used and the number of samples each datalog can 
store is dependent on the type of controller for which the strategy is being created. Consult the controller 
datasheet for further information. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 
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Variables: Variable name Description Possible values 

 Datalog Description (UC32) 
Datalog Name (UC/UCU) 

A name assigned by the user to identify the 
datalog within the Cylon system. 

Any string 

 Log Point (UC32) 
Point to Log (UC/UCU) 

The point number and value of the point 
being logged is displayed in this field, if the 
logged point is analog. 

Real number 

 Datalog Enable (UC32) 
Enabling Point (UC/UCU) 

The point number and current values of the 
enabling point for this module are displayed 
here. Whenever the value of this point is 
"1", the "Log Point" will be logged. 

1 or 0 

 Log Trigger point In Time stamped datalogs, it is possible to 
record data when this trigger point changes. 
If the trigger point is not connected, logging 
occurs according to the 'minimum change' 
parameter below. 

1 or 0 

 Digital Log Point The point number and value of the point 
being logged is displayed in this field, if the 
logged point is digital. 

1 or 0 

    

Constants The "constants" column in the Datalog module dialog various options rather than ordinary constants. In 
this section it is possible to read or set the following values, and options: 

 Variable name Description Possible values 

 Datalog Number This field displays the number used by the 
Unitron Command Centre Datalog Manager 
to access the data collected by this module. 

Depends on 
controller type 

 Datalog Point Type (UC32) 
Point Type (UC/UCU) 

This field displays the type of point that this 
module is logging. 

Analog or Digital 

 Log at fixed intervals of (UC32) 
Update Interval (UC/UCU) 

The length of time (in seconds) between 
logged values, if the datalog is a regularly 
sampled ('normal') type. 

Integer 

 Datalog Types - Type Selects the type of sampling method used 
by the module, with values logged either at 
regular intervals ('normal') or when 
specified conditions arise ('Time Stamped'). 

"Normal" or "Time 
Stamped". 

 Log when the value changes 
by 

If the datalog type is set to 'Time Stamped' 
(see Advanced Options), and if the type of 
point being logged is analog, it is possible to 
trigger a sample whenever the point value 
changes by more than a particular amount. 
This field specifies that amount of change. 

Real Number 
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Advanced 
Options: 

If the 'Advanced Options' button is pressed, the following parameters become available: 

 Variable name Description Possible values 

 Datalog Length This field displays the length of the datalog based 
on current datalog type and storage format 
settings. 

512, 585, 582, 
819, or 1024. 

 Link Datalog This links datalogs for use in cascading datalogs 
(not yet implemented) 

none 

 Storage Format (this feature is not yet implemented) none 

 Advanced Format Ids (this feature is not yet implemented) 
If this box is ticked, then the drop-down list of 
storage formats will contain extra sub-divisions of 
the main formats, giving extra flexibility. 

Checked or 
cleared 

 Number of decimal places 
for keypad display 

This parameter is passed to a keypad program if 
one is created that displays this datalog. The value 
of this parameter sets the number of decimal 
places that will be shown on the keypad screen 
for each value in the datalog. 

Any integer 

 Log Trigger options Time stamped datalogs can be set to record the 
value of a point when the value of a separate 
'Trigger Point' changes. This parameter defines 
whether this change is from 0 to 1 (rising edge), 
from 1 to 0 (falling edge) or any change (any 
edge). 
The any edge option is the default setting for this 
parameter. 

Any Edge, Rising 
Edge, or Falling 
Edge 

  

Implementation 
of module: 

If the Enabling Point Value is set, the datalog module is active. The module samples the Point to Log Value 
at intervals as specified by the Update Interval for a normal datalog, or according to the criteria specified 
for a time stamped datalog. The number of samples which can be stored in a datalog is either 102 or 192, 
or up to 1024, depending on the controller type. Details can be found on the controller’s datasheet. When 
all possible samples have been taken, the data can be processed by the Datalog application and displayed 
graphically or in tabular form. 

  

Application: To monitor a plant item over a period of time.  
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Alarm Record 

    

Button: 

  

    

Symbol: 

  

Values not shown 

  

Values shown 

      

Function of 
module: 

The Alarm Record module monitors the state of a digital point and generates an alarm if the point 
becomes set. The Alarm application handles such alarms and may be programmed to display or print 
alarm messages for certain levels of alarm. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 
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Variables: Variable name Description Possible values 

 Alarm Description 
(UC32) 
Text (UC/UCU) 

A name assigned by the user to identify the alarm 
record within the Cylon system. This string is used 
when an alarm is displayed on the keypad. 

Any string 

 Input Point This is a digital point, that when its value is "1", the 
current alarm record becomes active. 

1 or 0 

 Alarm Point This is an analog point, associated with the alarm 
condition triggering the current alarm record. The 
value of this point will be reported to Unitron 
Command Centre when the alarm record becomes 
active. 

Any integer 

 Output This feature is not yet implemented  

    

Constants: The "constants" column in the Alarm Record module dialog holds various options rather than ordinary 
constants. In this section it is possible to read or set the following values, and options: 

 Variable name Description Possible values 

 Alarm Number This field displays the number used by the Cylon 
system to access statistics for this module. 

Any integer 

 Alarm Priority (UC32) 
Priority (UC/UCU) 

A 'priority' number may be assigned to the alarm 
here, which can be used by the Cylon system to 
identify the appropriate reaction to an occurrence of 
this alarm. 

An integer 
between 1 and 
255. 

 Start String (UC32) 
Start Alarm (UC/UCU) 

This field shows the text of the alarm string that is to 
be displayed in Unitron Command Centre when the 
alarm record governed by this module becomes 
active. 

Any of the Comms 
Controller strings 
that are currently 
set up in the Cylon 
database. 

 Start String : 
insert button 

Pressing this button opens the Comms Controller 
Alarm String dialog, so that a 'Start String' can be set 
for the current Alarm Record module. 

N\A 

 Start String : 
delete button 

Pressing this button clears the "Start String" display 
box. 

N\A 

 Stop String (UC32)  
End Alarm (UC/UCU) 

This field shows the text of the alarm string that is to 
be displayed in Unitron Command Centre when the 
alarm record governed by this module becomes 
inactive. 

Any of the Comms 
Controller strings 
that are currently 
set up in the Cylon 
database. 

 Stop String : 
Insert button 

Pressing this button opens the Comms Controller 
Alarm String dialog, so that a 'Start String' can be set 
for the current Alarm Record module. 

N\A 

 Stop String : 
Delete button 

Pressing this button clears the "Start String" display 
box. 

N\A 

  

Implementation 
of module: 

When the Alarm Records module is serviced, the state of the Input Point is examined. If it is set, the 
specified alarm are generated and passed to the Alarm Handler and the statistics associated with this 
module are updated. 

  

Application: To alert the engineer of any plant item that is malfunctioning, e.g., a pump trip, boiler lockout, etc. 
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Control Flags 

    

Button: 

  

    

Symbol: 

  

Values not shown 

  

Values shown 

    

Function of 
module: 

The Control Flag module produces 11 digital output signals which depend on the UC16’s real-time clock 
settings.  

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 
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Variables: Variable name Description Possible values 

  Monday to Sunday 
(Points) 

Numbers of points at which Monday to 
Sunday Values are held. 

17 to 255 

  Monday to Sunday 
(Values) 

One of these digital point values is set when 
the UC16’s real time clock indicates that the 
current day of the week corresponds with that 
point. For example, the Monday variable will 
be set from 00:00:00hrs until 23:59:59hrs on 
Monday. 

Set or unset 

  Every Minute Point Number of point at which Every Minute Value 
is held. 

17 to 255 

  Every Minute Value This digital point value will change state each 
time the minute count on the UC16’s real-time 
clock is incremented. 

Set or unset 

  Every Hour Point Number of point at which Every Hour Value is 
held. 

17 to 255 

  Every Hour Value This digital point value will change state each 
time the hour count on the UC16’s real-time 
clock is incremented. 

Set or unset 

  Every Day Point Number of point at which Every Day Value is 
held. 

17 to 255 

  Every Day Value This digital point value will change state each 
time the UC16’s real-time clock changes from 
23:59:59 to 00:00:00. 

Set or unset 

  Every Week Point Number of point at which Every Week Value is 
held. 

17 to 255 

  Every Week Value This digital point value will change state each 
time the UC16’s real time clock changes from 
23:59:59 on a Sunday to 00:00:00 on a 
Monday. 

Set or unset 

    

Implementation 
of module: 

When this module is serviced, the variables change state according to the changes in value of the 
UC16’s real-time clock. 

    

Application: This module can be used for Duty/Standby selection of plant items. 
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Run Time 

 Appearance 

Group 

 
  (Statistical) 

 

Button 

 

Symbol 

 

Dialog box 

 If UC32/BACnet-type Controller is targeted: 

 

 If Legacy UC type Controller is targeted: 

 

Function 

The Run Time module records the total length of time for which a plant item has been in operation. It also determines 
whether or not the plant item has been in use for a greater length of time than the pre-specified Max Runtime.  It can be 
used to indicate when a plant item needs to be serviced. 

If   Point to Monitor this is set,  Total Runtime Value is incremented each time a time unit (defined by the  Count 

Units constant) elapses. If  Total Runtime Value exceeds   Max Runtime Value, the  Runtime>= Max Runtime 

is set and  Runtime < Max Runtime is unset. Otherwise, the reverse is the case. 

S 

I T 

T M H 

L 
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Parameters 

Inputs 

 If UC32/BACnet-type Controller is targeted: 

Parameter Name Description Possible values 

 Point to Monitor Indicates whether plant item is in use or not. Set or unset 

 Reset If this is set,  Total Run Time value is reset to 0. Set or unset 

  Max Runtime This value overrides the Max Runtime constant, and 
represents the maximum length of time for which plant item 
should be run.  

Positive real number 

 

 If Legacy UC type Controller is targeted: 

Parameter Name Description Possible values 

 Point to Monitor Number of point at which Point to Monitor value is held. 1 to 255 

 Point to Monitor 
Value 

Indicates whether plant item is in use or not. Set or unset 

 Reset Point Number of point at which Reset value is held. 1 to 255 

 Reset Value If this is set, the Total Run Time value is reset to 0. Set or unset 

  Max Runtime 

Point 

Number of point at which Max Runtime value is held. 17 to 255 

 Max Runtime 
Value 

This value overrides the Max Runtime constant, and 
represents the maximum length of time for which plant item 
should be run.  

Positive real number 

Constants 

 If UC32/BACnet-type Controller is targeted: 

Parameter Name Description Possible values 

Max Runtime Maximum length of time for which plant item should be run, if 

  Max Runtime input is not connected.  

Positive real number 

Count Units Choice of units for  Total Runtime count. 0:  seconds 

1: minutes 

2: hours 

3: days 

4: 100 milliseconds 

 

 If Legacy UC type Controller is targeted: 

Parameter Name Description Possible values 

Max Runtime - 
Constant 

Maximum length of time for which plant item should be run, if 

  Max Runtime input is not connected.  

Positive real number 

Count Units Choice of units for  Total Runtime count. Seconds / minutes / 
hours / days 

I 

R T 

M 

I 

R 

M 

M 

T 

M 

T 
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Outputs 

 If UC32/BACnet-type Controller is targeted: 

Parameter Name Description Possible values 

  Total Runtime Number of Count Units periods of time during which   

Point to Monitor value has been set. 

Positive real number 

 Runtime > = Max 

Runtime  

This is set if   Total Run Time value is greater than or 

equal to   Max Runtime value, otherwise unset. 

Set or unset 

 Runtime < Max 

Runtime 

This is set if   Total Run Time value is less than   Max 

Runtime value, otherwise unset. 

Set or unset 

 

 If Legacy UC type Controller is targeted: 

Parameter Name Description Possible values 

  Total Runtime 

Point 

Number of point at which Total Runtime value is held. 17 to 255 

 Total Runtime 
Value 

Number of Count Units periods of time during which   

Point to Monitor value has been set. 

Positive real number 

 Runtime > = Max 

Runtime Point 

Number of point at which Runtime > = Max Runtime value is 
held. 

17 to 255 

 Runtime > = Max 
Runtime Value 

This is set if   Total Run Time value is greater than or 

equal to   Max Runtime value, otherwise unset. 

Set or unset 

 Runtime < Max 

Runtime Point 

Number of point at which Runtime < Max Runtime value is 
held. 

17 to 255 

 Runtime < Max 
Runtime Value 

This is set if   Total Run Time value is less than   Max 

Runtime value, otherwise unset. 

Set or unset 

 

 

T I 
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System Flags 

    

Button: 

  

    

Symbol: 

  

Values not shown 

  

Values shown 

      

Function of 
module: 

The System Flags module gives information about how long the UC16 is taking to fully service the 
control strategy and also indicates the status of the UC16 within the system. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 
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Variables: Variable name Description Possible values 

  Reset Point Number of point at which Reset value is held. 17 to 255 

  Reset Value This value is set when the UC16 is reset. 
Remains set for one service period. 

Set or unset 

  Offline Point Number of point at which offline value is held. 17 to 255 

  Offline Value This value is set if the UC16 has not received 
any communication from the Comms 
Controller in the previous 60 seconds. 

Set or unset 

  Current Service 
Time Point 

Number of point at which Current Service 
Time value is held. 

17 to 255 

  Current Service 
Time Value 

Time taken (in seconds) for the UC16 to fully 
complete one service of the control strategy. 

Positive integer 

    

Implementation of 
module: 

When the module is serviced, the variables are reset according to the state of the UC16. 
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Seconds Run 

    

Button: 

  

      

Symbol: 

  

Values not shown 

  

Values shown 

    

Function of 
module: 

The Seconds Run module counts the number of seconds up to four digital values have been set.  

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 
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Variables: Variable name Description Possible values 

  Points to Record A, B, 
C, D 

Numbers of points at which digital values A, 
B, C, D are stored. Any point number set to 
zero is ignored. 

1 to 255 

  Points to Record 
(Values) A, B, C, D 

Values of digital points A, B, C, D which the 
module will time when set. 

Set or unset 

  Clear Count Points A, 
B, C, D 

Numbers of points at which Clear Count 
Values A, B, C, D are held. 

1 to 255 

  Clear Count Values A, 
B, C, D, 

When this value is set, the Total Run Time 
Value is set to 0. 

Set or unset 

  Total Run Time Points 
A, B, C, D 

Number of point at which Total Run Time 
Value is held. 

9 to 255 

  Total Run Time 
Values A, B, C, D 

Value of count in seconds of length of time 
Point to Record Value has been set. 

Positive integer 

    

Implementation 
of module: 

Given Point X to Record: 

If Clear Count X Value is unset and Point X to Record Value is set,  

Total Run Time X = time in seconds that Point X Value is set 
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Counter 

    

Button: 

  

    

Symbol: 

  

  

Values not shown 

  

  

Values shown 

      

Function of 
module: 

The Counter module counts the number of times a specified digital value changes state.  

 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 
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Variables: Variable name Description Possible values 

  Counter Input Point Number of point at which Counter Input Value is 
held. 

1 to 255 

  Counter Input Value The number of changes of state of this value will be 
counted by the module. 

Set or unset 

  Enable Input Point Number of point at which Enable Input Value is 
held. May be omitted. 

1 to 255 

  Enable Input Value If Enable Input Point is specified, this value must be 
set for the Output Value to be incremented. 

Set or unset 

  Clear Input Point Number of point at which Clear Input Value is held. 
May be omitted. 

1 to 255 

  Clear Input Value If Clear Input Point is specified, the Output Value 
will be set to 0 each time the Clear Input Value 
moves from unset to set. 

Set or unset 

  Preload Enable Point Number of point at which Preload Enable Value is 
held. 

1 to 255 

 Preload Enable Value This works with the Preload Data Input Value to 
allow the Output Value to be preloaded with a 
programmable analog figure. 

Set or unset 

 Preload Data Input Point Number of point at which Preload Data Input Value 
is held. 

1 to 255 

 Preload Data Input Value This works with the Preload Enable Value to allow 
the Output Value to be preloaded with a 
programmable analog figure. 

Real number 

 Output Point Number of point at which Output Value is held. 9 to 255 

 Output Value Value produced by action of module on inputs. Integer 

      

Implementation of 
module: 

When this module is serviced, if the Preload Enable Value is set and the Enable Input Point Value is set, the 
Preload Data Input Value will be written as the Output Value. When the Preload Enable Value becomes 
unset, the Output Value will be incremented each time the Counter Input Value changes from unset to set. If 
the Clear Input Value goes from unset to set at any time, the Output Value is immediately set to 0.  

    

Application: For metering energy and water flow. 
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Number of Active Digital Inputs 

    

Button: 

  

    

Symbol: 

  

Values not shown 

  

Values shown 

      

Function of 
module: 

The Number of Active Digital Inputs module accepts up to 12 digital inputs. It counts the number of inputs 
which are set, and returns this analog value as its output. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 

 

 

       

Variables: Variable name Description Possible values 
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  Input Points A to L Numbers of points at which Input Values A to 
L are held. 

1 to 255 

  Input Values A to L Digital values. The module counts the 
number of these values which are set and 
returns the value as its output. 

Set or unset 

  Number of Inputs which = 
1 (Point) 

Number of point at which Number of Inputs 
which = 1 Value is held. 

9 to 255 

  Number of Inputs which = 
1 (Value) 

Number of inputs which = 1. 0 to 12 (Integer) 

 

Implementation of 
module: 

Given inputs A to L: 

Output = No of inputs which are set 

  

    

Application: To calculate the number of areas in the site that require heating. 
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Comment Block 

    

Button: 

  

    

Symbol: 

  

Values not shown 

  

Values shown 

      

Function of 
module: 

The Comment module can contain up to 14 alphanumeric characters, which are usually descriptions of 
hardware points or modules. The comment module is referenced in the described module’s dialog box. 

 

Dialog box: 

If UC32 is 
targeted: 

 

If UC/UCU is 
targeted: 

 

 

       

Variable: Variable name Description Possible values 

  Text String Up to 14 alphanumeric characters. 
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HOA Pot Value 

    

Note: This module is a service module for use ONLY with UC16s which have been fitted with a HOA board. 

    

Button: 

  

    

Symbol: 

 
Values not shown 

  

Values shown 

Function of module: 

The HOA Pot Value module allows the user to view the eight pot values on the HOA board. These pot values represent the 
hardware outputs 9 to 16 if the HOA switches are set to Hand or Off. The hardware output values are not represented if the 
HOA switches are set to Auto. 

Dialog box: 

If UC32 is 
targeted: 

Not applicable 

If UC/UCU is 
targeted: 

 

Variables: 
Variable name Description Possible values 

Pot Values Points 1 to 8 Numbers of points at which Pot Values 1 to 8 are held 17 to 255 

Pot Values 1 to 8 = 0 if HOA switch is set to Off 

= 0 if HOA switch is set to Auto 

= value of corresponding hardware point if HOA switch is 
set to Hand 

0 to 100 

Implementation of module: 
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When the HOA Pot Value module is viewed, it is possible to tell if the HOA switches are set to Hand or not. If they are set to 
Hand, the Pot Values 1 to 8 will be the same as the values of the hardware output points 9 to 16. If they are set to Off or 
Auto, the Pot Values 1 to 8 will be set to zero. To find out whether the HOA switches are set to Off or Auto, this module 
must be used in conjunction with the HOA switch state module. 

    

Application:  

For commissioning and servicing plant items. 
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HOA Switch State 

    

Note: This module is a service module for use ONLY with UC16s which have been fitted with a HOA board. 

    

Button: 

  

    

Symbol: 

  

Values not shown 

  

Values shown 

    

Function of module: 

The HOA Switch State module allows the user to view the switch state of the eight switches on the HOA board. This module 
is used in combination with the HOA Pot value module to verify the values of hardware output points 9 to 16. 

 

Dialog box: 

If UC32 is 
targeted: 

Not applicable 

If UC/UCU is 
targeted: 

 

 

 





 
 

 

SECTION 28 :  BACNET MODULES 
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BACnet Time Schedule  

Appearance 

Group 

  
  (Logic) 

 

Button 

  

 

 

Symbol 

 

Dialog box 

  

 

Function 

The BACnet Time Schedule block allows the user to pre-load a single start time and a single stop time for each day of the 
week to be used in a locally-hosted BACnet weekly schedule.  

If the module is enabled, then when the controller's clock registers a time between the start and stop time on each day, the 
output of the module will be "1", and outside of those times it will be "0".  

This module accepts one input, which enables/disables the operation of the module, but leaving this input unattached will 
allow the schedule to run normally. 

The module produces tree outputs: the present value of the schedule, the inverse of the present value and the number of 
seconds until the next scheduled change. 

 

 

 

 

  

L 
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Parameters 

Time Schedule Name 

User defined name for the BACnet schedule object. 

 

Inputs 

Parameter Name Description 

Enabling Point 

 

Displays the number of the digital point that is connected to the enabling input 
(“E”) of the block. If the digital point is true the time schedule is enabled and will 
output accordingly, if the point is false then the block will output false. 

 

 

Constants  

Parameter Name Description 

Write Priority The priority at which the BACnet time schedule block will write at. By default 
this is set to 16. 

Times The days of the week and times between which the schedule will start and 
stop. 

 

 

Outputs  

Parameter Name Description 

True Output The current status of the schedule. 

Compliment The inverse of the current schedule status. 

Secs to change The number of seconds remaining until the output will change. 
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BACnet Alarm 

Note:  This strategy-based method of generating binary alarms has been made redundant by the alarming functionality 
now native in all Inputs, Values and Outputs.  This block has been left in place to support existing strategies that 
use this block, but should not be used in a new Strategy. 

Appearance 

Group 

  (Statistic) 

 

Button 

 

 

Symbol 

 

Dialog box 

 

Function 

Alarms are used in a BMS system to alert site supervisors/engineers to any difficulties that may occur in a site. The Cylon 
BACnet range support BACnet alarm objects which can be made available to BACnet supervisors. 

The alarm module is joined to a digital point. When the digital point has the value 1, the alarm module is activated. The 
digital value may indicate if an error condition, for example a sensor going out of normal range or a fire alarm being 
activated.  

  

S 
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Parameters 

Alarm Name 

A name assigned by the user to identify the BACnet Alarm object. 

 

 

Inputs 

Parameter Name Description 

Alarm Point This displays the digital point number that is connected to the input of the block. 

 

 

Constants 

Parameter Name Description 

Notification Class 

 

The alarm can be assigned a number through this parameter. This can be useful when 
grouping alarms. 

 

Time Delay 

 

The time delay that the block waits before making the alarm active or inactive. 

 

Active Text 

 

The text that is displayed on the supervisor software when the alarm is active. 

 

Inactive Text 

 

The text that is displayed on the supervisor software when the alarm is inactive. 

 

Generate Alarm On 

 

This option can be set to high value or low value by the user. If set to high value the 
alarm will be active when the input is true and if set to low value the alarm will be 
active when the input is false. 

 

Notify Type 

 

The Alarm notify type can be set to Alarm or an Event type. 
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BACnet Trendlog block 

Appearance 

Group 

 
  (Statistic) 

 

Button 

 

 

Symbol 

 

Dialog box 

 

Function 

BACnet Trend Logs, similar to Unitron Datalogs, allow point values in a Controller to be recorded over a period of time. For 
example, a Trend Log on an output point could monitor valve positions, or a Trend Log on an input could log outside air 
temperature. 

The input point value can be logged either at regular intervals or when the value changes by a defined amount.  

The recorded data can be later retrieved, displayed and analyzed with the Datalog Manager application. 

The number of Trend Logs that can be added to a Strategy depends on the Controller on which the Strategy runs. For example a 

CBM24 can have up to 32 Trend Logs and a CBT12iVAV can have up to 4.  

Note: To find out the maximum number of Trend Log that a Strategy can support, open the Strategy, select View> 
Managers and open the Resources tab in the Managers dialog. 

Parameters 

Datalog Description 

A name assigned by the user to identify the BACnet Trend Log object. 

S 
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Inputs 

Parameter Name Description Possible Values 

Analog Log Point The point number and value of the point being logged if the  
module’s Analog input is connected to an analog point.  

Note: Only one of the input points can be connected, so only the 
connected one is displayed in the dialog’s input column. 

Real number  

Digital Log Point The point number and value of the point being logged if the 
module’s Digital input is connected to a digital point.  

Note: Only one of the input points can be connected, so only the 
connected one is displayed in the dialog’s input column. 

Boooelan 

Trendlog Enable The point number and current values of the enabling point for this 
module. When the value of this point is "1", the "Log Point" will be 
logged. 

1 or 0 

Log Trigger Point Data is recorded when this trigger point changes. If the trigger 
point is not connected, logging occurs according to the ' When to 
log the value ' parameters below. 

1 or 0 

Constants 

Parameter Name Description Possible Values 

Trendlog Number This field displays the number used by the Datalog Manager 
application to access the data collected by this module. 

Depends on controller type 

Trendlog Point 
Type 

This field displays the type of point that this module is logging. “Analog” or “Digital” 

When to log the 
value: Log at 
fixed intervals of 

When this option is selected the seconds input  box becomes 
editable, and  the value of the Log Point will be recorded at 
regular intervals.  

Integer (number of seconds) 

When to log the 
value: Log when 
value changes by 

When this option is selected the units input  box becomes 
editable, and  the value of the Log Point will be whenever that 
Log Point value changes by an amount greater than the 
number of units specified. 

Integer (number of units) 

Advanced 
Options 

The Advanced Options button becomes available when the 
module’s Log Trigger Point input (the “T” input) is connected 
to a digital point. This digital point can be, for example, an 
alarm arising, a switch being thrown, a window opening etc. 
When this input is connected, the Trend Log will log when the 
state of this input changes. Clicking on the Advanced Options 
button opens the Datalog Advanced Options dialog box: 

 
 

Any Edge, i.e.  every time the 
trigger point changes state. 

Rising Edge, i.e. when the value 
of the trigger point changes from 
0 to 1. 

Falling Edge, i.e. when the values 
of the trigger point changes from 
1 to 0. 
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How to set up a BACnet Trendlog 

In the case of the Strategy below a BACnet Trend Log block has been attached to a hardware point that measures 
temperature. The hardware point has been named “Room Temperature” and so the BACnet Trend Log block has taken the 
same name. 

 

Right-clicking on the block opens the properties dialog box.  

 

Trendlog Read Performance 

It is possible to optimize the way BACnet Trend Log data is read by the front-end Workstation.  

For example, altering the number of records that are accessed per request changes the number of records the Controller can 
return each time it obtains the network token. A request for up to 20 records at a time is optimal for loading an MS/TP 
packet. 

Front-end Workstations can also be configured to request only new records from the Controller, which can improve the 
performance of the system. 
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Strategy ID Block 

Appearance 

Group 

  (Statistic) 

 

Button 

 

 

Symbol 

 

Dialog box 

 

 

Function 

The Strategy ID block allows a unique ID to be sent to a controller for use by third-party applications. 

 

 

 

Parameters 

Strategy ID 

This is an arbitrary integer that can be used by other applications to identify the Strategy. 

 

S 
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3rd Party point blocks – [Analog 3rd Party Analog] and [Binary 3rd Party] 

Appearance 

Group 

 
  (Points) 

 

Button 

   

  

 

Symbol 

    

Dialog box 

     

 

Function 

The 3
rd

 party point blocks provide a mechanism for reading and writing values from and to a third party device directly in a 
Strategy. The same mechanism can be used to also be used to access BACnet objects within the local Strategy if required. 

There are two separate “3
rd

 Party point” blocks – one that is used to move data to and from analog Strategy block 
connections and one that is used to move data to and from binary Strategy block connections.   

Both types of 3
rd

 party blocks can access the same BACnet data, which is automatically converted to the appropriate data 
type as the data is pulled from or pushed to the network.   

  

P 
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Parameters 

Inputs 

Parameter Name Description 

Value in This is the value that will be written to the 3rd party device. If the analog 3rd 
party block is being used then an analog point must be linked to this input and if 
the digital 3rd party block is being used then a digital point linked to this input. 

Write Control  

 

This is a digital input which when set to ‘On’ allows the value of the Value In 

input to be written to the 3rd party object, subject to the settings in the 
Constants > Writing section of the dialog. 

 

 

Constants 

 Point Addressing Info 

Parameter Name Description 

Local/Remote This defines whether the ‘3
rd

-party’ object to which this block refers is actually in 
the same strategy as the block (i.e. in the “Local” device) or in a different device 
(“Remote”). If the block is copy and pasted into a different strategy, it will remain 
connected to the same point if this parameter is set to “Remote”. If this 
parameter is set to “Local” the pasted block will try to access a point within its 
new Strategy that matches the Object Type and Object Instance settings. 

Device Instance 
Number 

This is the Device Instance Number of the third-party device that will be read or 
written to. It is only available if Local/Remote is set to “Remote”. 

Note: You can type any number in 

this input, but a Site Tree is available 

by clicking the 
  

button to the 

right of the input field: 

 

 

Object Type 

 

Any BACnet Object Type can be entered in this field. It is used together with 
Object Instance to specify the object which will be read or written. 

Note: You can type any number in this input, but a list of common Object Types 

is available by clicking the 
  

button to the right of the input field. 

Object instance This is the instance number within the selected Object Type that specifies the 

object which is to be read or written. 

Property This is the BACnet property of the specified object that is to be read or written. 
Defaults to 85-present-value.  

Note: You can type any number in this input, but a list of common BACnet 

Properties is available by clicking the 
  

button to the right of the input field. 
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 Constants -Writing 

These constants determine when the input value will be written to the third-party device, and the priority in that devices 
priority array to which the value will be written. 

If the block is writing to but not reading from the third-party device, then only the input needs to be connected. 

 

Parameter Name Description 

Write Priority 

 

This is the element in the third-party device’s Priority Array to which the input 
value will be written. By default the value is priority 16, but it can be set in the 
range 1-16. 

Relinquish on 
High to Low 

 

If this box is checked, the controller will relinquish the Priority Array element set 
in the Write Array constant (i.e. set it to null) when the Write Control input goes 
from high to low. 

COV Value 

 

If this constant is set, then writing will only take place if the Value In value 
changes by the amount specified here during the time period specified in Min. 
COV Time. 

Min. COV Time 

 

In order to avoid a continuously-changing Value In value generating too much 

traffic on the BACnet system, you can limit how often the value is sent to the 
third-party object by setting a minimum time between send here. This value is 
the number of seconds between sends. 

COV Once High If this box is checked, the controller will write to the third-party device only if the 
Write Control is set to ON and the Value In changes by the COV value. 

One Shot Write 
Low to High 

If this box is checked, the controller will write the current Value In value to the 
third-party device when the Write Control changes from OFF to ON. 

Time Once High 

 

If the check box in this parameter is checked, the controller will write the Value 
In value to the third-party device repeatedly at the frequency set in the 
parameter’s value box. By default this is set to 5 seconds. 

 

 

 

 Constants – Reading 

These constants determine how often the Present Value of the third-party object will be read and sent to the block’s 
output. 

If the block is reading from but not writing to the third-party device, then only the output needs to be connected. 

 

Parameter Name Description 

Read Frequency This is the number of seconds between reads. By default this is set to 5 
seconds. 

Default Value 

 

If the check box in this parameter is checked and if the third-party device 
cannot be read, the output of the block will set to the value in this parameter’s 
value box. 

The value box for Binary third-party points is a checkbox. If it is checked the 
output will be set to “On”, if not the output will be set to “Off”. 
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Outputs  

Parameter Name Description 

Present Value 

 
The present value of the BACnet object is written to this output.   

If the present value cannot be read, and the Constants > Default Value is 

enabled, this output is set to the Default value.  

If the present value cannot be read, and the Constants > Default Value is 

disabled, then this output remains at its previous value.  

Status Flag 

 
This is an analog value that represents a 5 bit array, which contains 
information about the status of communications with the third-party device. 

 Function Value = 0 Value = 1 

Bit 0  Problem No problem 
detected. 

A problem has been 
detected. 

Bit 1 
 

Failure to 
send write  

Data written to 3
rd

 
party device ok. 

Write to 3
rd

 party device  
failed 

Bit 2 
 

Failure to RX 
write ACK 

Acknowledgement 
received ok 

No acknowledgement 
when writing to 3

rd
 party 

Bit 3 
 

Failure to 
send read. 

Read request sent 
ok 

Failed to send read 
request 

Bit 4 
 

Failure to RX 
read. 

Data read from 3
rd

 
party device ok 

No data received from 
3

rd
 party device 
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Priority Array Blocks – [Anlg PA] and [Bnry PA] 

Note:  This strategy-based method for generating Priority Arrays has been made redundant by the Priority Array 
functionality now native in all Value and Output objects.  This block has been left in place to support existing 
strategies that use this block, but should not be used in a new Strategy. 

Appearance 

Group 

 
  (Points) 

 

Button 

  

 

Symbol 

    

Dialog box 

     

P 
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Function 

BACnet value objects and BACnet output objects use a Priority Array to determine their value. Each element in the array will 
either have a value or be set to null. The ‘present value’ of the object is set to match the the highest priority element in 
the array that has a valid value. 

The priority array blocks provide a method of assigning a value to an element in the Priority Array of a specific BACnet object.  

There are two priority array blocks in the Cylon Engineering Centre:  

 Priority Array Analog Object for setting a value in the array of an Analog Value, or an Analog Output. 

 Priority Array Digital Object for setting a value in the array of a Binary Value, or a Binary Output. 

If a point is connected to the block’s Input Point (A) then the block will show the Priority Array of that point.  

If the block’s Input Point (A) is unattached then the block will show the Priority Array of the point connected to the Present 
Value output (Pv).  

Note:  If neither point is connected the block will not function, and a warning message will be displayed:  

 Strategy Warning - Analog Priority Block is inoperable as it is not attached to any BACnet points. 

The value of a single element of the array is set to match the value of the Value In (B) input when permitted to do so by the 
Write Control (C) input. The element to be set is defined by the Write Priority constant.  

If the BACnet object to be affected is a BACnet Output object, the input of that object’s module in the Strategy drawing must 
be connected to the output of the priority array block that matches the Write Priority setting.  

If the object to be affected is a BACnet Value object, then the output of that object’s module in the Strategy drawing must be 
connected to the Input Point (A). 

The main use of the Priority Array block is to quickly and easily conditionally override outputs or values.   

 

 

Parameters 

Inputs 

Parameter Name Description 

Input Point This is the point representing the BACnet object whose Priority Array will be 
affected by the Priority Array block. 

Value In This is the value to which the selected priority element in the Priority Array will be 
set. 

Write Control This is a digital input which when set to ‘On’ allows the value of the Value In 
input to be written to the Write Priority element, subject to the settings in the 
Constants section of the dialog. 
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Constants 

Parameter Name Description 

Write Priority This is the Priority number of the element in the Priority Array that will be set. By 
default the value is priority 15 however it can be set in the range 1-16.  

COV Value If the COV Once High property is set, then the relevant element in the Priority 
Array will be set if the Value In input changes by more than the value set here in 
the COV Value property. 

One Shot Write 
Low to High 

If this box is checked then the relevant element in the Priority Array will be set to 
match the Value In input when the write control input goes from low to high. 

COV Once High 

 

If this box is checked the relevant element in the Priority Array will be set to 
match the Value In input when than value changes by more than the amount set 
in the COV Value property. 

Relinquish on 
High to Low 

If this box is checked then the relevant element in the Priority Array will be set to 
Null when the Write Control input goes from high to low. 

 

 

Outputs 

Parameter Name Description 

Present Value 

 

This output matches the ‘Present Value’ of the BACnet object associated with 
the Input Point. 

PA Bitmap 

 

This an analog value that represents a 16 bit array, each bit representing the 
override status of each element in the priority array. If a specific priority has been 
overwritten, the bit in the PA bitmap corresponding to that element will be set to 
1. 

Status Bitmap This output is not currently used. 

Priority 1-16 

 

These outputs give access to the values at each priority for the BACnet object. 
These outputs could be connected to a strategy that contains logic to address 
control situations that depend on BACnet priorities. 

Note:  If a priority becomes set to a “null” value through BACnet, then the 
related output will remain set to the last non-null value of that 
priority. 

 

 



 
 

 

SECTION 29 :  APPENDIX :: HOW TO 
ADD ENERGY 

OPTIMIZATION TO A  
STRATEGY 
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A CBM, CBT or UC32 Field Controller can be configured to monitor environmental parameters over a period of time, and 
learn from them the optimum times for switching plant in order to minimize energy usage. 

The elements of the Strategy working together to achieve this are collectively referred to as an “Optimizer”. An Optimizer 
can be set up to govern Heating, Cooling, or a combination of both. 

There are 4 separate blocks provided in the Engineering Tool for energy Optimization. It is recommended that they be used 
together as below.   

In order to set up the Optimizer as described in this document, you will need the following product versions: 

  CBM, CBT or UC32 Firmware version 6.1.7 
or later 

  Cylon Engineering Centre Software 
version ETv6.60 build 6 or later 
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What is an Optimizer? 

An Optimizer is an element within a Field Controller Strategy that acts to minimize energy consumption by observing 
environmental conditions over a period of time, and learning from those observations the optimum times for switching 
plant in order to achieve the required conditions during occupancy. 

 

Plant Room

Controlled Area

Optimiser

Chiller

Boiler
Pumps

Fan-Coil

Wall Control

Temperature

Sensor

Temperature

Sensor

PID Control
heating

control

boost

PID Control
cooling

control

boost

OAT IAT

Room Setpoint

FTcooling

FTheating

Heating Demand

Cooling Demand

OAT

Room

Setpoint

IAT

FTcooling

FTheating
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How does an Optimizer operate? 

Heating Optimization 

To optimize heating, the heating system should start operation before occupancy starts at the latest time that would allow 
the required temperature to be reached just as occupancy begins.  

Energy can also be saved by turning off the heating system before the end of occupancy, if this can be done without the 
temperature falling below acceptable levels until after the end of occupancy. 
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Cooling Optimization 

Similarly, when optimizing the energy usage during cooling, the cooling system should start to operate at the latest time 
before occupancy that will allow the required temperature to be reached just as occupancy begins, and stop operating at 
the latest time that would allow the temperature to rise to no more than the maximum acceptable level before occupancy 
ends. 

Temperature Setpoint

Cooling Optimisation
(e.g. Summer)
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Setting up an Optimizer in a Field Controller Strategy 

The magnitude of the Preconditioning and Falloff (“Cooldown”) times – and hence the Optimized Start and End times - are 
determined by analysis of historical data, carried out by the partial strategy described below. 

 

The Optimizer modules are available on the “Control” module bar: 

 

Note:  Legacy Optimizer modules are still available in the “Control” module bar. 

 New Optimizer Modules:    
(these modules are the ones used in this section) 

 Legacy Optimizer Modules:  
(These are required for compatibility with existing Strategies only) 

 

It is recommended that an Optimizer is set to monitor both heating and cooling. To set up such an Optimizer, the following 
blocks must be in sequence, so they must be added to the Strategy in the order shown here: 

1. Optional BACnet Time Schedule – only if the Strategy is on a BACnet Site – see Linking to a BACnet  on page 
691. 

2. Field Controller Time Schedule (Monday) 

3. Field Controller Time Schedule (Tuesday) 

4. Field Controller Time Schedule (Wednesday) 

5. Field Controller Time Schedule (Thursday) 

6. Field Controller Time Schedule (Friday) 

7. Field Controller Time Schedule (Saturday) 

8. Field Controller Time Schedule (Sunday) 

9. Optimizer block A (Part 1 of 2) for Heating 

10. Optimizer block B (Part 2 of 2) for Heating 

11. Optimizer block A (Part 1 of 2) for Cooling 

12. Optimizer block B (Part 2 of 2) for Cooling 

13. Other Strategy modules as required. 

Note:  If only Heating Optimization is required, 11 and 12 above should not be added to the Strategy. If only Cooling 
Optimization is required, 9 and 10 above should not be added to the Strategy. 
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The inputs on Optimizer block A (in both Heating and Cooling) must be connected as shown above. The outputs can then be 
connected to the Demand and Boost points as shown. 
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Operation of the Optimizer 

Linear Model 

A Linear Model is used initially by the Optimizer to estimate the Boost start time, when no historical data is available. 

The Startup period is calculated as follows: 

 Heating 

Boost Period = A(TST – IAT) + B 

 Cooling 

Boost Period = A(IAT - TST) + B 

Where: 

A and B are user-adjustable constants (linear predictor values) 

TST is Target Startup Temperature 

IAT is Internal Air Temperature 

Note: It is recommended that B be greater than 20 (minutes) 

 

 

Learning Factor 

Each time the Target Temperature is reached during the Boost period (Startup), “Learning” occurs, and the Learning Factor 
is incremented. 

Once the Learning Factor reaches 6 or more, the Adaptive (Learned) model is used (to calculate the start time of the Boost 
period) instead of the Linear model. 

There are a number of conditions that must be met before Learning can take place. 

1. If Flow Temperature is being monitored, then in order to verify that plant is operating (Sanity Check) while the 
Optimizer is attempting to learn, the Flow Temperature must be outside the FTmin – FT max range as described 
below: 

Boost Boost

T
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Time

FTmin (heating)

Flow

temperature

FTmax (heating)

FTmin (cooling)

FTmax (cooling)

Flow
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Time
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In Heating Optimization, the flow temperature must be below the minimum temperature in the range, (i.e. below 
the value of FTmin) at the start, and must rise past the maximum temperature (FTmax) during the boost period. 

In Cooling Optimization, the flow temperature must be above the temperature range before Boost, (i.e. above the 
value of FTmax) at the start, and must fall below the minimum temperature (FTmin) during the boost period. 

If the flow temperature does not meet these conditions before the start of Boost,  the Learning process will not take 
place in the Optimizer. 

2. Boost (Startup) period must be at least 20 minutes. 

 

 

Fabric Protection 

“Fabric Protection” is a behavior that can be enabled in the Optimizer, which prevents damage to fabric and other contents 
in the building by keeping the temperature above a specified minimum at all times. 

Note:  Fabric Protection only applies to Heating Optimization.  
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Inputs and outputs required for Optimizer 

A connected group of Strategy modules configured to act as an Optimizer monitors the following parameters, which are 
either set as constants or provided by other elements within the overall strategy: 

 

Inputs 

The following points values must be provided by points in the Strategy outside of the Optimizer section: 

Parameter Name 

parameter description 

Nature 

Connector diagram 

Target Start Temperature (TST) 

The temperature that must be reached at the start of Occupancy.  

[Analog Setpoint] 

 

Allowable End Temperature (AET) 

The target temperature for the end of Occupancy. The Optimizer will calculate 
how long cooldown should take to achieve this temperature, and disable plant 
that length of time before the end of occupancy. 

[Analog Setpoint] 

 

Outside Air Temp (OAT)  

Current temperature of the ambient air outside the building. 

[Analog Point] 

 

Inside Air Temperature (IAT)  

Current inside air temperature. 

[Analog Point] 

 

Flow Temp  (FT)  

Current temperature of the Conditioning medium (Heating or Cooling). While it 
is recommended that this be used, if the medium Flow Temperature is not 
available, this input can remain disconnected. (if this is the case, then the 
‘Sanity Check’ condition described on page 681 will be ignored) 

[Analog Point] 

 

Enable  

Input signal to enable or disable Optimizer operation. Does not disable Fabric 
Protection operation. If not connected then assumed to be enabled 

[Digital Point] 

 

 

Note:  Target Start Temperature (TST) and Allowable End Temperature (AET) can be derived from the Room Setpoint 
using the new Deadband module: 

  

 The Deadband module is a dual-channel module, in that it comprises two identical functions – allowing it to 
provide a deadband for heating and a deadband for cooling in a single module. 

 A “deadband” is a tolerance applied to a setpoint, such that if the measured temperature is outside that band 
the control algorithms are applied, but if the measured temperature is within the band control is not applied 
(control is ‘dead’). 
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 The “deadband” tolerance can be applied above the nominal value, straddling the nominal value or below the 
nominal value. 

 Each ‘channel’ of the Deadband module has a nominal value input , a Deadband input  (which 

overrides the internal ‘Deadband constant) and a High  and Low  output 

  

 The module dialog (opened by right-clicking on the module in the Strategy) shows the values of these 
parameters, as well as allowing Deadband type and Deadband value constants to be set for each “channel”. 

(The Deadband Value constant is overridden by the Deadband input , if the input is connected). 

  

 The Deadband Type value may be 1 (above the nominal value), 2 (straddling the nominal value) or 3 (below the 
nominal value).  
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Fixed Settings 

The following parameters are set within the Optimizer blocks themselves (right click on the module in the Strategy Drawing 
in the Engineering Tool to edit them). However, they can be overridden by external point values if required, by joining them 
to points in the Strategy drawing 

Parameter Name 

parameter description 
Nature 

Connector diagram 

Occupancy 

A set of 7 on/off times, one for each day of the week, defining the times 
during which the building is occupied, i.e. the times during which the Building 
conditions are to be controlled. 

Field Controller Schedule x7 

 

Flow Min Temp (FTmin)  

 

Flow Max Temp (FTmax)  

  

FTmin and FTmax define a range outside which the temperature of the  
conditioning medium must be before the start of Boost. FTmin is the bottom 
of this range, and FTmax is the top of this range. 

In Heating Optimization, the flow temperature must be below the minimum 
temperature in the range, (i.e. below the value of FTmin) at the start, and 
must rise past the maximum temperature (FTmax) during the boost period. 

In Cooling Optimization, the flow temperature must be above the temperature 
range before Boost, (i.e. above the value of FTmax) at the start, and must 
fall below the minimum temperature (FTmin) during the boost period. 

If the flow temperature does not meet these conditions before the start of 
Boost, the Learning process will not take place in the Optimizer (see page 
681). 

[Analog Setpoint] 

 
[Analog Setpoint] 

 

Startup Temp (IATstart) 

If there is no historical data available (i.e. when algorithm is initialised) this 
value is used as the limit value (minimum for heating, maximum for cooling) 
of the IAT at the start of the maximum Boost. (This value is only used once, 
to initialise the adaptive Model at start of Learning )   

[Analog Setpoint] 

 

Boost Max Period  

The maximum time in minutes of the Startup (“Boost”) period  

[Analog Setpoint] 

 

Falloffdown Max Period 

The maximum time in minutes of the Shutdown (“Falloff”) period  

[Analog Setpoint] 

 

Deadtime (DT)  

If there is no historical data available (i.e. when algorithm is initialised), this 
value (in minutes) is used as an estimate of the time between the start of 
heating or cooling action, and any corresponding change in  temperature 
inputs. (This value is used once to initialise the adaptive Model at start of 
Learning, and in Fabric Protection )  

[Analog Setpoint] 

 

Overlap Period  

If target temperature is not met by the start of Occupancy, this is the number 
of minutes for which Boost will continue to operate after the start of 
Occupancy to try and reach the target. 

[Analog Setpoint] 

 
 

Linear Model A Value (A) 

 

Linear Model B Value (B)  

Linear Model parameters used initially by the Optimizer module to estimate 
Boost start time.  

[Analog Setpoint] 

 
[Analog Setpoint] 

 

Fabric Protection Min Temp (FPTmin) 

Fabric Protection Max Temp (FPTmax) 

 “Fabric Protection”  activates when temperature drops below FPTmin and 

[Analog Setpoint]  

[Analog Setpoint]  
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continues to operate until temperature reaches FPTmax.   (Heating Block B 
only) 

 
 
 

Outputs 

The following values are generated by the Optimizer section of the Strategy: 

Parameter Name 

parameter description 
Nature 

Connector diagram 

Demand  

This output indicates whether or not the conditioning plant should be active. 

 

[Digital Point] 

 

Boost 

This indicates that conditioning plant should be operating at full capacity to 
achieve target temperature in the optimum time. This bypasses weather 
compensation etc. 

 

[Digital Point]  

 

Day Control Status  

Indicates whether or not the Optimizer is in “Day Control” mode. 

 

[Digital Point] 

 

Falloff Status  

Indicates whether or not the Optimizer is in Falloff (“Shutdown”) mode. This 
output remains on for 3 hours, during which the Optimizer continues to monitor 
the Internal temperature falloff, to ensure the optimal falloff time is used. 

 

[Digital Point] 

 

Time Schedule Status 

This output is intended to show when there is an ON signal from any of the 
Optimizer Time Schedule blocks. However, it is not enabled by default, in 
order to use it you must connect all of the Time Schedule Module outputs to 
the inputs on Optimizer Block B. 

 

[Digital Point] 

 

System Off Flag 

This value is ON when neither the Optimizer nor Occupancy is in force. 

 

[Digital Point] 

 

Optimizer Status  

This shows when the Optimizer is in Startup mode – i.e. Maximum Boost time 
plus overlap. 

 

[Digital Point] 

 

Error Status  

Error indication.  This value is ON if the sequence of Time Schedule and 
Optimizer blocks is not correct. When this value is ON, Optimizer operation is 
disabled, but Fabric Protection operation will still operate. 

 

[Digital Point] 

 

Learning Factor 

This outputs the current value of the Learning Factor.  

 

[Analog Point] 

 

Predicated Boost Start Time  

The value of this point is a “Decimal Time” representation of the time at which 
Boost will start. (e.g. 9.3 represents 9:30 am). 

Note: this value is only updated when Optimizer Status is ON.  

 

[Analog Point] 

 

Predicated Falloff Start Time   [Analog Point] 
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The value of this point is a “Decimal Time” representation of the time at which 
Falloff will start. (e.g. 15.15 represents 3:15 pm)  

Note: this value is only updated when Falloff Status is ON. 

 

 

Time until Occupancy Start 

This a “Decimal Time” representation of the time remaining until the start of 
Occupancy (e.g. 1.5 means 1 hour and 50 minutes remaining).  

[Analog Point] 

 

Time until Occupancy End 

This a “Decimal Time” representation of the time remaining until the end of 
Occupancy (e.g. 7.35 means 7 hours and 35 minutes remaining).  

 

[Analog Point] 

 

Time Schedule Content outputs 

On Optimizer block B there are a number of outputs that provide useful 
information about Time Schedule settings. There is one pair for each of the 
Optimizer Time Schedule modules, showing the on time and off time for each 
schedule module, in “Decimal Time” (14.25 = 2:25 pm) 

[Analog Points] 

 

Fabric Protection Status   

Indicates whether or not the Optimizer is in “Fabric Protection” mode. (Heating 
Block B only) 

 

[Digital Point] 
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Output sequence 
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(fixed)Cooling Falloff
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Automatic Updating of Optimizer times – linking to a Comms Controller Schedule 
or BACnet Schedule 

The 7 Time Schedule blocks in the Optimizer can be updated manually using the Cylon Engineering Centre. However, it is 
normally better to link them to the main building schedule, so that the Optimizer will respond to changes made by the End 
User. 

This can be done either by  

 (Unitron systems) inserting a Comms Controller Time Schedule Global in the Strategy and linking it to the 7 
consecutive Time Schedule blocks (see Linking to a Comms Controller Schedule below) 

 {BACnet Systems) inserting a BACnet Schedule immediately before the first Optimizer Time Schedule (see Linking 
to a BACnet  on page 691) 

Linking to a Comms Controller Schedule 

Right click on the Comms schedule GLOBAL, and the following context menu will be displayed: 

 

The ‘Configure Optimizer Schedule’ item will be available if the module has no connecting lines AND one of the following is 
true: 

 The GLOBAL has been previously been configured for use with an Optimizer  

 There are seven consecutive Field Controller time schedule blocks in the target strategy that are not 
being used by another Optimizer. 

 If this GLOBAL has never been set to “broadcast” 

If the ‘Configure Optimizer Schedule’ item in the context menu is selected, the following dialog is displayed 

 

The ‘Enable Optimizer Schedule’ check box sets whether or not this local schedule GLOBAL will link to Optimizer Schedules. 
When this is un-checked, the schedule list will be disabled. 

When the dialog is first displayed, if the ‘Enable Optimizer Schedule’ box is ticked, and the current target schedule block for 
the Optimizer can  be selected from the schedule block list.  

The ‘OK’ button on the dialog will be disabled if the ‘Enable Optimizer’ checkbox is ticked but there is no schedule block 
selected in the list – i.e. it will be impossible to link the Time Schedule Global to Optimizer Schedules without selecting a 
schedule block from the list. 
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Because an Optimizer must have its Time Schedules in consecutive blocks, the schedule block list will be populated with the 
first Field Controller time schedule from each group of 7 consecutive Field Controller time schedules. For example, if there 
are 7 consecutive Field Controller schedule blocks from block numbers 10 to 16, and another 7 from block numbers 28 to 
34, then the first Field Controller schedule block from each group (block numbers 10 and 28) will appear in the list.  

Once a local schedule GLOBAL module has been set to link to Optimizer Schedules, it will not be possible to link it to an 
individual point, i.e. It will not be possible to connect any lines to any of the module nodes. 

Numbers of On/Off times in the Comms Controller Schedule 

A Comms Controller Time Schedule may contain many sets of on/off times per day.  

A Field Controller Time Schedule module has two on/off times per day.  

When a GLOBAL links a Comms Controller Schedule to a set of Field Controller schedules,  

 the first set of on/off times in the Comms Controller schedule is written to the first on/off time in the 
corresponding Field Controller Schedule within the linked group.  

 The second set of on/off times in the Comms Controller Schedule is written to the second on/off time in the 
relevant Field Controller Schedule. If the Comms Controller Schedule only has one set of times, the second 
on/off time in each Field Controller schedule will be zeroed.  

 Any subsequent set of on/off times in the Comms Controller schedule are ignored. 

Similarly, if an exception is in operation in the Comms Controller schedule, then the first exception on/off times will be 
written to the first on/off time in the relevant Field Controller schedule. If there is a second exception on/off time set then 
this is written to the second on/off time in the relevant Field Controller schedule, if not the second set of Field Controller 
on/off times is zeroed. Subsequent exception on/off times are ignored. 

In a typical setup, the Optimizer reads the first on/off time in the Field Controller Schedules, which is updated by the first 
set of on/off times in the Comms Controller schedule. 

As a result, only the first set of on/off times in the Comms Controller schedule are relevant to the Optimizer.  

Update Process 

A linked Field Controller time schedule is updated daily from a Comms Controller time schedule. This is done with a two day 
lag so as not to affect the Optimizer performance. If a Comms Controller schedule which is associated with a Field Controller 
time schedule is downloaded (changed or not) an immediate update is carried out.  

 Normal Delayed Updating 

At 00:01 each day all local GLOBALs are examined to see if they are Optimizer-linked Time Schedule GLOBALs.  

When such a GLOBAL is found, then the Comms Controller looks ahead to see if any exceptions will be coming into force 
over the following 5 days. If so, it loads the exception times into the relevant linked Field Controller Schedules immediately. 

If an exception ceases to be in force, then the Standard times are re-loaded into the relevant Field Controller Schedules 2 
days in arrears.  

Handling exceptions in this way (loading 5 days in advance, and resetting 2 days in arrears) prevents interference with 
Optimizer operation running over midnight, and results in a week lag in the exception times taking effect. 

As a consequence, for Comms Controller Schedules that are linked to an Optimizer by an Optimizer-linked Time Schedule 
GLOBAL it is necessary to always enter exceptions at least 5 days in advance. 

Note:  If a Field Controller due for updating is off-line at 00:01, then it will be updated as soon as it comes back on-line 
- updating will not wait 24 hrs. 

 Immediate Change Updating 

If a Comms Controller time schedule that is associated with a Field Controller Optimizer Schedule is changed, then a full 
week of the new standard times or the downloaded exception days are immediately sent to the linked Field Controller 
schedules - possibly altering its performance.  
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For an 'exception' schedule, if any exception day will be active within the next 7 days (including the current day), it will be 
downloaded immediately. This allows the week lag (see Normal Delayed Updating above) to be overridden. Any 
downloading of the Comms Controller Time Schedule is viewed as a change even if the actual times are not changed. 

An ‘immediate’ update takes place on the next local global service after a delay of 1 min following the download. But if the 
local global is not “set up” the update will not be done. 

 

Linking to a BACnet Schedule 

In a BACnet Site, an additional BACnet Schedule block is required. 

It must be added immediately before the 7 weekday schedules – i.e. it must be the last block added to the strategy before 
the Optimizer blocks (or Optimizer macro) are added, so that the block numbers of the blocks in the Optimizer directly 
follow the block number of the BACnet Schedule (This is because of assumptions built into the way the external BACnet 
Schedule writes to the schedule blocks inside the Optimizer). 

1 x  BACnet Schedule block

7 x  Time Schedule blocks

 

Each of the day values in this BACnet Time Schedule will be automatically copied to the relevant Time Schedule block. 





 
 

 

SECTION 30 :  APPENDIX :: 
PROPRIETARY BACNET 

PROPERTIES 
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The following proprietary properties are available in Cylon BACnet Field Controllers: 

On CBT only: 

Object Class: Device 

Property 

Number Property Description 

Read/ 

Write Valid values Datatype 

50771 (FS) Flash Status This variable indicates if the CBT is 
currently backing up its data to flash. 

Read Only 
 “Flash is idle” 

 “Points flash in process” 

 “Full strategy flash in process” 

Character 
String 

 

 

On both CBM and BT controllers: 

Object Class: Analog Values 
Property 

Number Property Description 
Read/ 

Write Valid values Datatype 

49492 (AT) Auto-Clear Time to 
Live 

The Auto-Clear Function is an option whereby a temporary 
override value – i.e. a value written via the front end at a 
specified priority - has a certain “time to live” before the 
value at that priority is automatically reset to null. 
This property sets the time after which the override value will 
be set to null. 
If set to 0, this functionality is inactive 

R/W Not 
Bounded 

Unsigned 

49488 (AP) Auto-Clear Priority This is the priority array index of the value that has a time to 
live when using the auto-clear functionality. 

R/W 1-16 Enumerated 

49475 (AC) Auto-Clear 
Countdown 

This property states the current number of seconds until the 
override is cleared.  

Read Only  Unsigned 

54096 (SP) Save Priority Array 
Data Across Reboots 

When set this will make the priority array save itself to flash 
any time there is a change to it.   
It is left off (set to 0) by default as most strategies will 
consider priority array entries to be transient data.  In the 
event that someone has chosen to pack data in the array that 
won’t re-establish itself naturally after a boot, then this 
switch can be turned on to force flash saves. 

R/W 0/1 Boolean 

 

Object Class: Binary Values 
Property 

Number Property Description 
Read/ 

Write Valid values Datatype 

49492 (AT) Auto-Clear Time to 
Live 

The Auto-Clear Function is an option whereby a temporary 
override value – i.e. a value written via the front end at a 
specified priority - has a certain “time to live” before the 
value at that priority is automatically reset to null. 
This property sets the time after which the override value will 
be set to null. 

R/W Not 
Bounded 

Unsigned 

49488 (AP) Auto-Clear Priority This is the priority array index of the value that has a time to 
live when using the auto-clear functionality. 

R/W 1-5, 6-16 Enumerated 

49475 (AC) Auto-Clear 
Countdown 

This property states the current number of seconds until the 
override is cleared.  

Read Only  Unsigned 

54096 (SP) Save Priority Array 
Data Across Reboots 

When set this will make the priority array save itself to flash 
any time there is a change to it.   
It is left off (set to 0) by default as most Strategies will consider 
priority array entries to be transient data.  In the event that 
someone has chosen to pack data in the array that won’t re-
establish itself naturally after a boot, then this switch can be 
turned on to force flash saves. 

R/W 0/1 Boolean 
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Object Class: Calendars 
Property 

Number Property Description 
Read/ 

Write Valid values Datatype 

50004 (CT) Current Time These are provided for the SI’s convenience.  It is the same 
data as the actual date and time values in the Device object 
but being mirrored in the schedules and calendars allows 
them to more easily troubleshoot their scheduling. 

Read 
Only 

 Time 

49988 (CD) Current Date These are provided for the SI’s convenience.  It is the same 
data as the actual date and time values in the Device object 
but being mirrored in the schedules and calendars allows 
them to more easily troubleshoot their scheduling. 

Read 
Only 

 Date 

 

Object Class: Device 
Property 

Number Property Description 
Read/ 

Write Valid values Datatype 

54094 (SN) Serial Number This text string is the serial number for the controller as set in 
the factory. 

Read 
Only 

 Character 
String 

54089 (SI) Strategy Index Number When the “Strategy ID” module is added to a Strategy in the 

Cylon Engineering Centre, its stored number will be 
displayed in this field, allowing the OWS to load pre-
configured templates used for that particular Strategy. 

Read 
Only 

  

51524 (ID) Unit Number (MSTP) This is the MSTP address of the Device.   
Writing to it will cause the device to immediately drop out of 
the token loop and reappear in the new address specified. 

R/W 0-127 Unsigned 

54606 (UN) Unitron Number  This is the Unitron ID.  It is advised that it be set to the same 
as the BACnet ID, but if required it can be written to freely via 
this property. 

R/W 0-127 Unsigned 

54612 (UT) System Up-Time 
(Seconds) 

This is the number of seconds since the last boot. Read 
Only 

 Unsigned 

54081 (SA) Save All Data to Flash On the CBT this will force all data to be saved to flash.  On 

the battery backed CBM it is actually of no value. 

R/W 1 Unsigned 

53843 (RS) Reset/Reboot the 
Controller 

This will cause the controller to reboot after a 300ms delay.   R/W 1 Unsigned 

49491 (AS) Auto-Delete Schedule 
& Calendar Entries 

When set, any date-specific entries will be deleted after the 
end of the day on which they are viable.  This is intended to 
clear out the scheduling data for non-recurring events. 

R/W 0/1 Boolean 

50754 (FB) Feedback Text This is the Engineering Centre feedback text field.  When 
downloading a Strategy, any errors in the Strategy will be 
catalogued in this text variable.  Writing to it clears it out, as 
does starting a new Strategy download. 

R/W Any write will 
clear out this 

variable 

Character 
String 

 

Object Class: Notification 
Property 

Number Property Description 
Read/ 

Write Valid values Datatype 

49457 (A1) Recipient 1 Active? Cylon supports up to 5 different recipients per notification class 
object.  These read-only feedback variables aid in debugging 
any Alarm issues by indicating if any recipients are currently 
marked as active. 

Read 
Only 

 

 Boolean 
 

49458 (A2) Recipient 2 Active? 

49459 (A3) Recipient 3 Active? 

49460 (A4) Recipient 4 Active? 

49461 (A5) Recipient 5 Active? 

 

Object Class: Manufacturer Debug 
Property 

Number Property Description 
Read/ 

Write Valid values Datatype 

49748 (BT) MSTP Token Round 
Trip in Seconds 

This variable indicates the average speed of the BACnet 
network.  It is used for determining the relative load of the 
BACnet network.   

Read 
Only 

 Real 

49747 (BS) Strategy Blocks 
Currently Servicing 

This Unitron variable indicates the number of blocks currently 
servicing in the strategy  

Read 
Only 

 Integer 

54100 (ST) Strategy Service Time 
in Seconds 

This Unitron variable indicates the number of blocks currently 
servicing in the strategy 

Read 
Only 

 Real 
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Object Class: Schedules 
Propert

y 

Number Property Description 
Read/ 

Write Valid values Datatype 

50260 (DT) Schedule's Default 
Data Type 

Writing to this variable using any of the datatypes listed 
to the right will cause the schedule default (and thus the 
schedule as a whole) to change to that datatype.   

R/W Any 
 Boolean 

 Unsigned 

 Integer 

 Real 

 Enumerated 

 Date 

 Time 

 ObjectID 

54100 (ST) Whole Seconds Until 
Next Transition 

This feedback variable is used for Schedule 
troubleshooting. 

Read 
Only 

 Integer 

52564 (MT) Whole Minutes Until 
Next Transition 

This feedback variable is used for Schedule 
troubleshooting. 

Read 
Only 

 Integer 

51284 (HT) Whole Hours Until 
Next Transition 

This feedback variable is used for Schedule 
troubleshooting. 

Read 
Only 

 Integer 

52819 (NS) Next Transition State The next time the schedule changes, this is the value 
that will become the present value. 

  Varies - based on 

Schedule Datatype 

50004 (CT) Current Time These are provided for the SI’s convenience.  It is the 
same data as the actual date and time values in the 
Device object but being mirrored in the schedules and 
calendars allows them to more easily troubleshoot their 
scheduling. 

Read 
Only 

 Time 

49988 (CD) Current Date These are provided for the SI’s convenience.  It is the 
same data as the actual date and time values in the 
Device object but being mirrored in the schedules and 
calendars allows them to more easily troubleshoot their 
scheduling. 

Read 
Only 

 Date 

50754 (FB) Feedback Text This provides information regarding the driving force 
behind the current present value.  Messages are 
tailored by datatype to include the present value as well 
making this value suitable for OWS mirroring. 

Read 
Only 

 Default 

 Daily 

 Exception 

 Eff. Period 

 Stat Exception 

 Out Of Service 
* All of the above 
are also followed by 
data 

Character String 

 

Object Class: Unitron Schedules 
Property 

Number Property Description 
Read/ 

Write Valid values Datatype 

49476 (AD) Active Days This feedback variable indicates on which days of the 
week the schedule object is active. 

Read 
Only 

Bit 0 = 
Monday 

Bitstring 

54065 (S1) Start Time 1 Occupied Time 1 R/W Any valid time 
value 

Time 

50481 (E1) End Time 1 Unoccupied Time 1 R/W Any valid time 
value 

Time 

54066 (S2) Start Time 2 Occupied Time 2 R/W Any valid time 
value 

Time 

50482 (E2) End Time 2 Unoccupied Time 2 R/W Any valid time 
value 

Time 

 

 

 



 
 

 

SECTION 31 :  APPENDIX :: CEC MACRO 
LIBRARY 
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Introduction 

What are CEC Macros? 

A macro is a combination of modules used in the Engineering Centre that can be saved and subsequently inserted into 
another strategy when required.  

If there are parts of a strategy that you use frequently or if you have a special strategy which involves a lot of repetition, then 
it is quicker to use a macro than to continuously rewrite one piece of strategy.  

What is the CEC Macro Library? 

This Macro Library consists of macros representing standard strategy applications. Each represents a piece of strategy that 
controls a particular piece of equipment, or causes specific behaviour within a set of equipment. The following macros are 
included: 

Macro Name Page 
Single Plant Control 699 
Twin Plant Control 704 
Enthalpy Difference 710 
Heating Cooling and Free Energy Control 711 
Heating Cooling and Free Energy Control WITH PID 714 
HWS Control 717 
OAT Reset with room offset 720 
Reset 722 
Sensor Alarm and Log 723 
Sequence Control 725 
Sequence Module 735 
Damping 741 
Frost Stages 1, 2 and 3 742 
Meter 745 
Optimizer 747 
Seven Day Clock 749 

DISCLAIMER: The Cylon Controls/American Auto-Matrix sample applications and macros are provided by Cylon Controls/American Auto-Matrix "as is" without warranties or 
conditions of any kind for sole use in programming the Cylon/American Auto-Matrix products for HVAC applications. Cylon Controls/American Auto-Matrix reserves the 
right to make changes to the software without notification. Every effort has been made to provide accurate functionality however no representations or warranties of 
any kind are made concerning the safety, suitability, lack of viruses, inaccuracies, typographical errors, or other harmful components of the sample applications and 
macros. There are inherent dangers in the use of any software, and you are solely responsible for determining whether the Cylon Controls/American Auto-Matrix sample 
applications and macros are compatible with your equipment and other software installed on your equipment. You assume the entire responsibility for quality and 
performance of the applications and are solely responsible for the protection of your equipment and backup of your data.  Cylon Controls/American Auto-Matrix will not 
be liable for any damages you may suffer in connection with using, modifying, or distributing the Cylon Controls/American Auto-Matrix sample applications and macros.   

 

Accessing the Macro library 

The Macro Library is installed as part of the main CEC install. 

The macros can be easily accessed by selecting the button representing the macro required from the Macro bar at the 

bottom of the Engineering Tool screen and then clicking over the part of the canvas where the macro is to be placed. To 
view the function components of the macro click inside it with the right hand mouse button. 

Information about each macro is also available within the Engineering Tool. To access this double-click the button of the 
desired macro on the bar at the bottom of the screen. This will open a text file with explanations and an example for the 
macro. 

Real constants, Digital constants and Integers can be changed inside the macro, as can function-block variables, such as 
integration time in a PID loop. However, point numbers should not be changed or adjusted as the macro always takes the 
next available point and block numbers automatically.  
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Single Plant Control 

System overview 

This macro will control any single plant* such as a pump or fan, while the optional inputs of flow, trip and pressure will 
generate a fault condition. This macro can be set to alarm on any fault, and/or on a maintenance runtime event.  

The plant can be set to stop, run or retry when a fault is registered. It also has a “start delay” and a “run on time”, and will 
allow both user and emergency overrides. 

Inputs Internal Outputs 

 

Flow Flw 

Trip Trp 

Pressure PR 

Pressure SP PRSP 

Reset RS 

Maintenance RS MRS 

Override OR 

Demand OR Value DMOR 

Emergency OR EOR 

Enable En 

   

Values 

Plant Status 0 … 15 

Run Time Hours 

Settings 

StopOnFault   
(Stop On Alarm) 

0 … 2 

StartDelay  
(Plant Start Delay) 

0 … 120 s 

DPSFaultMonitor 0 … 1 

MinSpeed 
(Minimum Demand) 

0% … Max Demand 

MaxSpeed 
(Maximum Demand) 

Min Demand  … 100% 

FaultDelay 2 … 60 s 

FaultMonitorDelay 2 … 300 s 

MaintenanceLimit 0 … 10,000  hrs 

MinOffDelay 
(Min Off Time) 

0 … 120 s 

RunOnTime 0 … 900 s 

OffSet  

SoftStartDelay 0 … 120 s 

FaultSelect 0 … 7 

Gain (PI Gain) 0.01 … 10 

Integral (PI Integral) 0 … 900 s 

MaxPressureError 
(Pressure Mismatch)  

0 … 500 pa 

EMOverrideState  
(Emergency State) 

 Off : On 

Alarms 

Trip Trip : Normal 

DPS Fault Flow Fail : Normal 

Pressure Mismatch Failed : Normal 

Maintenance Limit : Normal 
 

Number of Blocks 64 
   

 

En Enable 

Dmd Demand 

CF  Common Fault 
 

*The term “Plant” refers to a piece of HVAC equipment 
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Examples 
The diagrams below illustrate some scenarios in which the Single Plant Control Macro could be used: 
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System object description 

Hardware inputs 

Object Comments Object options 

Flow Flw  Status of a DPS monitoring the flow of the system.  0. Not used 

1. Monitor flow only 

2. Monitor flow and no flow 

Trip Trip   Trip status of the starter for the plant. 0. Not used 

1. Monitor 

Pressure PR  Measurement of the static pressure in the system. 0. Not used 

1. Monitor 

Pressure SP PRSP  The demand of the system will be modulated to 
achieve this setpoint.  

0. Not Required 

1. Required. 

Reset RS  Set to Hi to clear any active alarms. Required if Fault Select is not 0 

Maintenance reset 

MRS  

Set to Hi to clear an active Maintenance alarm. Required if a maintenance alarm is 
required. 

Override OR  Operator override. 

Options 0 and 4 the system will follow the enable 
input.  

Options 2 and 6 the system will operate 24/7 but stop 
if set to when in alarm.  

Options 3 and 7 the system will run 24/7 and will 
ignore all alarms.  

Options 0-3 the demand will be in automatic control.  

Options 4-7 the demand will be set by the operator 
and the mismatch alarm will be disabled. 

0. Auto 

1. System always off  

2. System always on (Except if Alarm) 

3. System always on (Ignore Alarms) 

4. Auto with Demand override 

5. System always Off 

6. System always on with demand 
override (Except if Alarm) 

7. System always on (Ignore Alarms) 
with demand override. 

Demand Override 

Value DMOR  

This is the value the demand will be set to when it is 
overridden and the plant is enabled. 

0 … 100% 

Emergency OR 

EOR  

Emergency Override 

If set to 3 the plant will be in the state set by EORS. 
This will take precedence over all other demands. 

0. Auto 

1. Off 

2. On 

3. Set to value of EORS 

Enable EN  When active (on) the plant will run if no alarms or 
overrides are active. 

1. Required 

Outputs 

Object Comments Object options 

Enable EN  Set active to run the plant 1. Required 

Demand DM  Set to the required demand to meet the pressure 
setpoint.  

0. Not required. 

1. Required. 

Common Fault CF  Will be set if any fault either a DPS, Trip or pressure 
fault is active. 

0. Not Used 

1. Used 
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Internal Settings 

 Comments Object options (Default) 

StartDelay  
(Plant Start Delay) 

When the system calls for the plant to run, startup will 
be delayed for this amount of time. Used for load 
sequencing.  

0 … 60 Seconds (10) 

FaultDelay If flow is monitored and a mismatch between the plant 
enable and flow status is detected, then a Flow 

Failed alarm will be raised. 

If pressure is monitored and a mismatch is detected 

between PR  and PRSP  ± MaxPressureError then a 

Pressure Mismatch alarm will be raised. 

0 … 60 Seconds (10) 

FaultMonitorDelay When the plant starts all faults will be ignored for this 
time. 

0 … 300 Seconds (20) 

MaintenanceLimit When the plant has run for this number of hours, a 
maintenance alarm is raised. 

0 … 10,000 Hours (5,000) 

MinOffDelay 
(Min Off Time) 

Time delay between the plant stopping and being 
allowed to run again.  

0 … 120 Seconds (30) 

RunOnTime Time in seconds the plant will run for after the enable 
signal has gone to Off 

0 … 1200 Seconds (120) 

SoftStartDelay The minimum time taken for the demand to reach 
maximum if required when the system starts. 

0 … 120 Seconds (30) 

MinSpeed 
(Minimum Demand) 

The minimum demand for the plant item to be allowed 
to run. 

0% … Max Demand 

MaxSpeed 
(Maximum Demand) 

The maximum demand for the plant item to be 
allowed to run. 

Min Demand … 100% 

MaxPressureError 

(Pressure Mismatch)  

The amount the pressure has to deviate from the 
setpoint for an alarm to be raised. 

50 … 200 Pa (100) 

0.007 … 0.03 psi (0.01) 

EMOverrideState  

(Emergency State) 

The state to which the plant will be set when an 
emergency state of 3 is set. 

(Off): On 

DPSFaultMonitor Used to select if the flow is monitored for fault when 
the plant is in standby. 

(0. Run Only) 

1. Run and Standby 

FaultSelect Used to select which inputs are used to control plant 
changeover on fault.  

0. None 

(1. DPS Only) 

2. Trip Only 

3. DPS + Trip 

4. Pressure Mismatch 

5. DPS + Pressure Mismatch 

6. Trip + Pressure Mismatch 

7. DPS + Trip + Pressure Mismatch 

StopOnFault   
(Stop On Alarm) 

Selects if a plant item should stop if in fault. (0. Yes) 

1. No-Standby plant continues to run 

2. No–Plant is continuous retried. 

Gain (PI Gain) The gain for demand PI loop 0.01 … 10 (0.1) 

Integral (PI Integral) The integral for the demand PI loop 0 … 900 Seconds (0) 

Offset  (PI Loop 
Offset) 

The output of the PID loop when Process Variable PV  

is equal to the Setpoint SP . 

0-100 (50) 
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Internal Values 

Object Comments Object options 

Status  This will indicate the status of plant item. With a 
controlled override the plant will still follow the fault 
criteria.  With a permanent override the plant will 
ignore the fault criteria and remain in the selected 
state. 

 

0. Auto - Off 

1. Auto - On 

2. Auto – Off – Fault 

3. Auto – On – Fault 

4. Controlled Override – Off 

5. Controlled Override – On 

6. Controlled Override – Off – Fault 

7. Controlled Override – On – Fault 

8. Permanent Override – Off 

9. Permanent Override – On 

10. Permanent Override – Off – Fault 

11, Permanent Override – On – Fault 

16. Auto – Off With Demand OR 

17. Auto – On With Demand OR 

18. Contrl OR – Off With Demand OR. 

19. Contrl OR – On With Demand OR. 

18. Contrl OR – Off Demand OR - Fault. 

19. Contrl OR – On Demand OR - Fault. 

20. Permt OR – Off With Demand OR. 

21. Permt OR – On With Demand OR. 

22. Permt OR – Off Demand OR - Fault. 

23. Permt OR – On Demand OR - Fault. 

Runtime (RT) Time the plant has run since last maintenance reset. 0….xxxx Hours 

 

 

Alarms 

Object Comments Object options 

DPS Fault Will alarm if DPS Fault is selected via the fault select 
and there is a mismatch between the run status and 
the DPS. 

0. Not Used 

1. Used 

Trip Will alarm if Trip is selected via the fault select and the 
trip input goes high. 

0. Not Used 

1. Used 

Pressure Mismatch Will alarm if Pressure Fault is selected via the fault 
select and there is a mismatch between required 
pressure and the pressure sensor. 

0. Not Used 

1. Used 

Maintenance Alarm  Active when the plant runtime has exceeded the 
maintenance limit. 

0. Not Used 

1. Used 
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Twin Plant Control 

System overview 
This module can be used to control any twin plant* set such as a pump set or twin fans while the optional inputs of flow, 
trip and pressure will generate a fault condition. This macro can be set to alarm on any fault, and/or on a maintenance 
runtime event. 

The plant can be set to stop, run or retry when a fault is registered. It also has a “start delay” and a “run on time”, and will 
allow both user and emergency overrides. 

The lead plant can be changed either automatically or manually selected.  

Inputs Internal Outputs 

 

Flow 1 Flw1 

Trip 1 Trp1 

Flow 2 Flw2 

Trip 2 Trp2 

Pressure PR 

Pressure SP PRSP 

Reset RS 

Maintenance RS 1 MRS1 

Maintenance RS 2 MRS2 

Lead Lead 

Override OR 

Demand OR Value DMOR 

Emergency OR EOR 

Enable En 

   

Values 

Plant Status 1 0 … 15 

Run Time 1 Hours 

Plant Status 2 0 … 15 
Run Time 2 Hours 

Settings 

SoftStartDelay 0 … 120 s 

MaxPressureError  0 … 500 pa 
0 … 0.07 psi 

StopOnFault  0 … 2 
ChangeoverHour 0 … 23 hrs 

FaultSelect 0 … 7  
FaultDelay 2 … 60 s 

Integer  0 … 900 s 
ChangoverMode  0 … 3 
DPSFaultMonitor  0 … 1 

OffSet 0-100% 
MinSpeed  0% … Max Speed 

FaultMonitorDelay 2 … 300 s 
Gain  0.01 … 10 

StartDelay 0 … 120 s 
MinOffDelay 0 … 120 s 

MaintenanceLimit  0 … 10,000  hrs 
RunHourChange…  0 … 10000 hrs 

MaxSpeed Min Speed… 100% 
EmergencyState Off : On 

Monday  … Sunday ON/OFF 
Run On Time 0 … 900 s 

Changeover Time 0 … 120 s 

Alarms 

Trip 1 Trip : Normal 

DPS Fault 1 Flow Fail : Normal 

Pressure Mismatch 1 Failed : Normal 

Maintenance 1 Limit : Normal 

Trip 2 Trip : Normal 

DPS Fault 2 Flow Fail : Normal 

Pressure Mismatch 2 Failed : Normal 

Maintenance 2 Limit : Normal 
 

Number of Blocks 154 
    

 

En1 Enable 1 

Dmd1 Demand 1 

En2 Enable 2 

Dmd2 Demand 2 

CF1 Common Fault 1 

CF2 Common Fault 2 
 

 

*The term “Plant” refers to a piece of HVAC equipment  
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Examples 

 

The diagrams below illustrate some scenarios in which the Twin Plant Control Macro could be used: 
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System object description 

Inputs 

Object Comments Object options 

Flow 1 Flw1  Status of a DPS monitoring the flow of plant 
item 1.  

0. Not used 
1. Monitor flow only 
2. Monitor flow and no flow 

Trip 1 Trp1  Trip status of the starter for plant item 1. 0. Not used 
1. Monitor 

Flow 2 Flw2  Status of a DPS monitoring the flow of plant 
item 2.  

0. Not used 
1. Monitor flow only 
2. Monitor flow and no flow 

Trip 2 Trp2  Trip status of the starter for plant item 2. 0. Not used 
1. Monitor 

Pressure PR  Measurement of the static pressure in the 
system. 

0. Not used 
1. Monitor 

Pressure SP PRSP  The demand of the system will be 
modulated to achieve this setpoint.  

0. Not Required 

1. Required. 

Reset RS  Set to Hi to clear any active alarms. Required if Fault Select is not 0 

Maintenance reset 

MRS1  

Set to Hi to clear an active maintenance 
alarm. 

Required if a maintenance alarm is required. 

Maintenance reset 

MRS2  

Set to Hi to clear an active maintenance 
alarm. 

Required if a maintenance alarm is required. 

Lead  LC Lead  0 will automatically select the lead plant.  

1 or 2 selects the lead plant but the plant 
will still operate as a duty/standby system.  

3 or 4 only the selected plant will run. 

0. Auto 

1. Item 1 lead 

2. Item 2 lead 

3. Item 1 only 

4. Item 2 only 

Override OR  Operator override.  

0 and 4 the system will follow the enable 
input.  

2 and 6 the system will operate 24/7 but 
stop if set to when in alarm.  

3 and 7 the system will run 24/7 and will 
ignore all alarms.  

0-3  the demand will be in automatic 
control. 

4-7  the demand will be set by the 
operator and the mismatch alarm 
will be disabled. 

0. Auto 

1. System always off  

2. System always on (Except if Alarm) 

3. System always on (Ignore Alarms) 

4. Auto with Demand override 

5. System always Off 

6. System always on with demand override (Except 
if Alarm) 

7. System always on (Ignore Alarms) with demand 
override. 

Demand Override 

Value DMOR  

This is the value to which the demand will 
be set when it is overridden and the plant 
is enabled. 

Not Required 

Emergency OR 

EOR  

Emergency Override 

If set to 3 the plant will be in the state set 
by the EmergencyState. This will take 
precedence over all other demands. 

0. Auto 

1. Off 

2. On 

3. Set to value of EORS 

Enable En  When active (on) the plant will run if no 
alarms or overrides are active. 

Required 
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Outputs 

Object Comments Object options 

Enable 1 EN1  Set active to run plant item 1 Required 

Demand 1 DM1  Set to the demand required for plant item 1 to meet 
the pressure setpoint.  

0: Not required. 

1: Required. 

Enable 2 EN2  Set active to run plant item 2 Required 

Demand 2 DM2  Set to the required demand of plant item 2 to meet 

the pressure setpoint PRSP .  

0: Not required. 

1: Required. 

Common Fault 1 CF1  Will be set if any fault either a DPS, Trip or pressure 
fault is active. 

0: Not Used 

1: Used 

Common Fault 2 CF2  Will be set if any fault either a DPS, Trip or pressure 
fault is active. 

0: Not Used 

1: Used 

 

Internal settings 

 Comments Object options 

Start Delay When the system is called to run, the plant will be 
delayed by this time. Used for load sequencing.  

0 …  60 s (5) 

FaultDelay If flow is monitored and a mismatch between the 
plant enable and flow status, then a flow failed 
alarm will be raised. 

If pressure is monitored and a mismatch between 
the pressure and pressure setpoint ± the “Pressure 
Mismatch Deviation” then a pressure mismatch 
alarm will be raised. 

0 …  60 s (10) 

FaultMonitorDelay When the plant starts, all faults will be ignored for 
this time. 

0 …  300 s (20) 

MaintenanceLimit  When the plant has run for this number of hours, a 
maintenance alarm is raised. 

0 …  10,000 hrs (5000) 

MinOffDelay 

(Min Stop Time) 

Delay between the time the plant stops and the time 
is allowed to run again.  

0 …  120 s (120) 

Run On Time Time in seconds for which the plant will run after the 
enable signal has gone to Off 

0 …  1200 s (120) 

SoftStartDelay The minimum time taken for the demand to rise to 
maximum, if required when the system starts. 

0 …  120 s (30) 

MinSpeed  

(Minimum Demand) 

The minimum demand the plant item to be allowed 
to run. 

0% …  Max Demand (0) 

MaxSpeed 

(Maximum Demand) 

The maximum demand the plant item to be allowed 
to run. 

Min Demand …  100% (100) 

MaxPressureError 

(Pressure Mismatch)  

The amount by which the pressure must deviate 

from the setpoint PRSP  for an alarm to be raised. 

50 … 200 Pa (100) 

0.007 … 0.03 psi (0.01) 

EmergencyState The state to which the plant will be set when an 

emergency state  EOR  of 3 is set. 

(Off): On 

DPSFaultMonitor (Fault 
Monitor) 

Used to select if the flow is monitored for fault when 
the plant is in standby. 

(0. Run Only) 

1. Run and Standby 
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 Comments Object options 

FaultSelect Used to select which inputs are used to control plant 
changeover on fault.  

0. None 

(1. DPS Only) 

2. Trip Only 

3. DPS + Trip 

4. Pressure Mismatch 

5. DPS + Pressure Mismatch 

6. Trip + Pressure Mismatch 

7. DPS + Trip + Pressure Mismatch 

StopOnFault (Stop On 
Alarm) 

Selects if a plant item should run if in alarm. (0. Yes) 

1. No-Standby plant continues to run 

2. No–Plant is continuous retried. 

Gain (PI Gain) The gain for demand PI loop 0.01 …  10 (0.1) 

Integer (PI Integral) The integral for the demand PI loop 0 …  900 s (120) 

Offset  (PI Loop Offset) The output of the PID loop when Process Variable 

PV  is equal to the Setpoint SP . 

0 … 100 (50) 

SystemStartDelay 

(Plant Start Delay) 

This specifies the delay before the lead plant will 
start when the system is first started. 

0 … 120 s (10) 

ChangoverMode 

(Lead Changeover)  

 

This specifies whether the lead plant should be 
changed on “Time Of Day” or “Hours Run”.  

0 and 1 the plant lead will change immediately 
whether the plant is running or not.  

2 and 3 the system will not change the lead plant 
until next system start or reset. 

(0. Time Of Day – Immediate) 

1. Hours Run - Immediate 

2. Time Of Day – Next Start 

3. Hours Hour – Next Start 

ChangeoverHour 

(Time Of Day Change 
Hour) 

If ChangeoverMode is set to “Time Of Day”, then 
ChangeoverHour  specifies the hour of day at which 
the plant will be automatically rotated. 

0 …  23 hrs (2) 

RunHourChange…  

(Hours Run 
Changeover) 

If ChangeoverMode is set to “Hours Run”, then 
RunHourChange specifies the time for which the lead 
plant will run before it is automatically rotated. 

0 …  1000 hrs (100) 

Monday  “Time Of Day Change Day” 

If ChangeoverMode is set to “Time Of Day”, then these 
seven setpoints are used to select the day of the 
week on which the plant will be automatically 
rotated.  

ON/(OFF) 

Tuesday  ON/(OFF) 

Wednesday  ON/(OFF) 

Thursday  ON/(OFF) 

Friday  ON/(OFF) 

Saturday  ON/(OFF) 

Sunday  (ON)/OFF 

 

  



 

 
 

MAN00058US rev 69 © American Auto-Matrix 709 

Internal Values 

Object Comments Object options 

Status Item 1 

Status Item 2 

These will indicate the status of each plant item.  

With a controlled override, the plant will still follow 
the fault criteria.   

With a permanent override the plant will ignore the 
fault criteria, and remain in the selected state. 

 

0: Auto - Off 

1: Auto - On 

2: Auto – Off - Fault 

3: Auto – On - Fault 

4: Controlled Override – Off 

5: Controlled Override – On 

6: Controlled Override – Off – Fault 

7: Controlled Override – On – Fault 

8: Permanent Override – Off 

9: Permanent Override – On 

10: Permanent Override – Off – Fault 

11: Permanent Override – On – Fault 

16: Auto – Off With Demand OR 

17: Auto – On With Demand OR 

18: Contrl OR – Off With Demand OR. 

19: Contrl OR – On With Demand OR. 

18: Contrl OR – Off Demand OR – Fault. 

19: Contrl OR – On Demand OR – Fault. 

20: Permt OR – Off With Demand OR. 

21: Permt OR – On With Demand OR. 

22: Permt OR – Off Demand OR – Fault. 

23: Permt OR – On Demand OR – Fault. 

Runtime 1  (RT 1) 

Runtime 2  (RT 2) 

Time for which the plant item has run since last 
maintenance reset. 

0: Not Used 

1: Used 

Minimum off Time Delay between the time that the plant stops and 
the time at which it is allowed to run again.  

0 … 120 s 

Alarms 

Object Comments Object options 

DPS Fault 1 Raise an alarm if DPS Fault is selected via the fault select and there is 
a mismatch between the run status and the DPS. 

0: Not Used 

1: Used 

Trip 1 Raise an alarm if Trip is selected via the fault select and the trip 

input Trp1  goes high. 

0: Not Used 

1: Used 

Pressure Mismatch 1 Raise an alarm if Pressure Fault is selected via the fault select and 
there is a mismatch between required pressure and the pressure 
sensor. 

0: Not Used 

1: Used 

Maintenance Alarm 1 Active when the plant runtime has exceeded the MaintenanceLimit 
parameter. 

0: Not Used 

1: Used 

DPS Fault 2 Raise an alarm if DPS Fault is selected via the FaultSelect parameter 
and there is a mismatch between the run status and the DPS. 

0: Not Used 

1: Used 

Trip 2 Raise an alarm if Trip is selected via the FaultSelect parameter and the 

trip input Trp2  goes high. 

0: Not Used 

1: Used 

Pressure Mismatch 2 Raise an alarm if Pressure Fault is selected via the FaultSelect 
parameter and there is a mismatch between required pressure and 
the pressure sensor. 

0: Not Used 

1: Used 

Maintenance Alarm 2 Active when the plant runtime has exceeded the MaintenanceLimit 
parameter. 

0: Not Used 

1: Used 
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Enthalpy Difference 

System overview 

This module will indicate if the enthalpy or temperature is greater for the input or the output. It can be used to select the 
damper/thermal wheel direction on an AHU. 
 

Inputs Internal Outputs 

 

Temperature In TIn 

Humidity In HIn 

Pressure In PIn 

Temperature Out TOut 

Humidity Out HOut 

Pressure Out POut 

   

Values 

(none) 

Settings 

(none) 

Alarms 

(none) 

 

Number of Blocks 8 

    

 

I>O Input > Out 
 

System object description 

Inputs 

Object Comments Object options 

Temperature In TIn  System Input Enthalpy (temperature sensor input). Required 

Humidity In HIn  System humidity sensor input.  

Not used is if only temperature difference is required. 

Not required 

Pressure In PIn  System pressure sensor input.  

Used only if there is a significant difference between the Pressure 

Input PIn  and Pressure Output POut . 

Not required 

Temperature Out TOut  System Output Enthalpy (temperature sensor output). Required 

Humidity Out HOut  System humidity sensor out.  

Not used if only temperature difference is required. 

Not required 

Pressure Out POut  System pressure sensor out.  

Used only if there is a significant difference between the Pressure 

Input PIn  and Pressure Output POut . 

Not required 

Outputs 

Object Comments Object options 

Input greater than output 

I > O  
The output will go High if the system input enthalpy TIn  goes 

higher than the system out enthalpy TOut  for 60 seconds.  

It will go Low if the system input enthalpy TIn  goes lower than the 

system output enthalpy TOut  for 60 seconds 

Required 
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Heating Cooling and Free Energy Control 

System overview 

This module will sequence heating, cooling and free energy sources. Any stage can be disabled by setting its range to 0. The 
cooling stage can be overridden via an RH demand. If enabled in the settings, the free stage can be overridden via a CO2 
demand. If enabled in the settings, the stages can be forced into one of 3 modes:  

0. Frost Stat (Freezestat) - a device normally fitted across a heater battery that “trips” when the temperature is too cold. 

1. Frost stage 1 or 2. 

2. Warmup.   

 

Inputs Internal Outputs 

 

Demand Dmd 

Free Direction FDir 

CO2 Override COOR 

RH Override RHOR 

Frost Stat FSta 

Frost Stage 1_2 F1_2 

Warm up WmUp 

Enable En 
   

Values 

Plant Status 0 … 4 

Settings 

FreeRange 
(Free Range) 

0 … 100% 

HtgRange   
(Heating Range)  

0 … 100% 

ClgRange   
(Cooling Range) 

0 … 100% 

DamperMinPos  
(Damper Minimum Position)   

0 … 100% 

HtgFrostStatPos  
(Heat Frost Stat  Position) 

0 … 100% 

FreeFrostStatPos  
(Free Frost Stat  Position) 

0 … 100% 

ClgFrostStatPos  
(Cool Frost Stat  Position) 

0 … 100% 

HtgFrost1_2Pos  
(Heat Frost 1 2  Position) 

0 … 100% 

FreeFrost1_2Pos 
(Free Frost 1 2  Position) 

0 … 100% 

ClgFrost1_2Pos 
(Cool Frost 1 2  Position) 

0 … 100% 

HtgWarmUpPos 
(Heat Warmup  Position) 

0 … 100% 

FreeWarmUpPos 
(Free Warmup  Position) 

0 … 100% 

ClgWarmUpPos 
(Cool Warmup  Position) 

0 … 100% 

Alarms 

(none) 

 

Number of Blocks 15 

   

 

Htg Heating 

Free Free Energy 

Clg Cooling 
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System object description 

Inputs 

Object Comments Object options 

Demand Dmd  This will be from a PI loop or other source determining the 
required demand. 

Required 

Free Direction FDir  The direction of the free energy source. Use reverse action for 
heating and forward action for cooling. 

Off:  Reverse 

On:  Forward 

CO2 Override COOR  The Free Energy (Dampers) output Free  will be set to the 

maximum value of the calculated demand for the Free Energy 
plus this input. 

0 … 100% 

RH Override RHOR  The cooling output Clg  will be set to the maximum value of 

the calculated demand for the cooling plus this input. 

0 … 100% 

Frost Stat Fsta  When Active, the outputs will be set to the positions 
defined in the internal settings. This will override all other 
states. 

Not Required 

Frost Stage 1_2 F1_2  When Active, the outputs will be set to the positions 
defined in the internal settings. 

Not Required 

Warmup WmUp  When this is Active and the enable input En  is Off, the 

outputs will be set to the positions defined in the internal 
settings. 

Not Required 

Enable En  When Off, all outputs will be Off unless overridden by a 
frost or warmup condition.  

When On the output positions will be determined by the 
required demand or the frost. 

Off: Control disabled 

On: Control enabled 

 

Outputs 

Object Comments Object options 

Heating Htg  Heating demand.   

Free Energy Free  Source for free energy dampers, heat wheel etc.   

Cooling Clg  Cooling demand.  
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Internal Settings 

Object Comments Object options (default) 

HtgRange   
(Heating Range)  

The proportion of the demand that the heating 

output Htg  will take. The total of the heating, 

cooling and free must not exceed 100%. 

0 … 100%  (40%) 

FreeRange 
(Free Range) 

The proportion of the demand that the free 

energy output Free  will take. The total of the 

heating, cooling and free must not exceed 100%. 

0 … 100% (20%) 

ClgRange   
(Cooling Range) 

The proportion of the demand that the cooling 

output Clg  will take. The total of the heating, 

cooling and free must not exceed 100%. 

0 … 100% (40%) 

DamperMinPos  
(Damper Minimum 

Position)   

The minimum allowed position for the free 

energy output Free  when connected to 

dampers. This will only apply when Control is 
active. 

0 … 50% (10%) 

HtgFrostStatPos  
(Heat Frost Stat  Position) 

The position to which the heating output Htg  

will go when the frost stat input is active. 

0 … 100% (100%) 

FreeFrostStatPos  
(Free Frost Stat  Position) 

The position to which the free energy output 

Free  will go when the frost stat input is active. 

0 … 100% (0%) 

ClgFrostStatPos  
(Cool Frost Stat  Position) 

The position to which the cooling output Clg  will 

go when the frost stat input is active. 

0 … 100% (0%) 

HtgFrost1_2Pos  
(Heat Frost 1 2  Position) 

The position to which the heating output Htg  

will go when the frost 1_2 input is active. 

0 … 100% (100%) 

FreeFrost1_2Pos 
(Free Frost 1 2  Position) 

The position to which the free energy output 

Free  will go when the frost 1_2 input is active. 

0 … 100% (0%) 

ClgFrost1_2Pos 
(Cool Frost 1 2  Position) 

The position to which the cooling output Clg  will 

go when the frost 1_2 input is active. 

0 … 100% (0%) 

HtgWarmUpPos 
(Heat Warmup  Position) 

The position to which the heating output Htg  

will go when the warmup input is active. 

0 … 100% (100%) 

FreeWarmUpPos 
(Free Warmup  Position) 

The position to which the free energy output 

Free  will go when the warmup input is active. 

0 … 100% (0%) 

ClgWarmUpPos 
(Cool Warmup  Position) 

The position to which the cooling output Clg  will 

go when the warmup input is active. 

0 … 100% (0%) 

 
 

Internal Values 

Object Comments Object options 

Status  This will indicate the status of Control 

 

0: Off 

1: On 

2: Warmup 

3: Frost 1_2 

4: Frost Stat 
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Heating Cooling and Free Energy Control WITH PID 

System overview 

This module will sequence heating, cooling and free energy sources. Any stage can be removed from the sequence by setting 
its range to 0. The cooling stage can be overridden via an RH demand. If enabled in the settings, the free stage can be 
overridden via a CO2 demand. If enabled in the settings, the stages can be forced into one of 3 modes:  

0. Frost Stat (Freezestat) - a device normally fitted across a heater battery that “trips” when the temperature is too cold. 

1. Frost stage 1 or 2. 

2. Warmup.   

Inputs Internal Outputs 

 

Process Variable PV 

Set Point SP 

Deadband DB 

Demand Dmd 

Free Direction FDir 

CO2 Override COOR 

RH Override RHOR 

Frost Stat FSta 

Frost Stage 1_2 F1_2 

Warm up WmUp 

Enable En 
   

Values 

Plant Status 0 … 4 

Settings 

HtgGain 
(Heating Gain) 

0 … 20 °C 
(32 … 68 °F) 

FreeGain   
(Free Gain)  

0 … 20 °C 
(32 … 68 °F) 

CClgGain   
(Cooling Gain) 

0 … 20 °C 
(32 … 68 °F) 

HtgIntegral 
(Heating Integral) 

0 … 900Secs 

FreeIntegral   
(Free Integral)  

0 … 900Secs 

ClgIntegral   
(Cooling Integral) 

0 … 900Secs 

DamperMinPos  
(Damper Minimum Position)   

0 … 100% 

HtgFrostStatPos  
(Heat Frost Stat  Position) 

0 … 100% 

FreeFrostStatPos  
(Free Frost Stat  Position) 

0 … 100% 

ClgFrostStatPos  
(Cool Frost Stat  Position) 

0 … 100% 

HtgFrost1_2Pos  
(Heat Frost 1 2  Position) 

0 … 100% 

FreeFrost1_2Pos 
(Free Frost 1 2  Position) 

0 … 100% 

ClgFrost1_2Pos 
(Cool Frost 1 2  Position) 

0 … 100% 

HtgWarmUpPos 
(Heat Warmup  Position) 

0 … 100% 

FreeWarmUpPos 
(Free Warmup  Position) 

0 … 100% 

ClgWarmUpPos 
(Cool Warmup  Position) 

0 … 100% 

Alarms 

(none) 

 

Number of Blocks 32 
        

 

Htg Heating 

Free Free Energy 

Clg Cooling 
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System object description 

Inputs 

Object Comments Object options 

Process variable PV  Sensor measuring the variable to be controlled Required 

Setpoint SP  The target temperature  16 … 28 °C 

(61 … 82 °F) 

Deadband DB  The deviation from setpoint that the heating and cooling loops 
will control to.  

The heating loop will control to SP  – ½ DB .  

The cooling loop will control to SP  + ½ DB . 

1 … 4 °C 

(2 … 7 °F) 

Demand Dmd  This will be from a PI loop or other source determining the 
required demand. 

Required 

Free Direction FDir  The direction of the free energy source. Use reverse action for 
heating and forward action for cooling. 

Off:  Reverse 

On:  Forward 

CO2 Override COOR  The Free Energy (Dampers) output Free  will be set to the 

maximum value of the calculated demand for the Free Energy 
plus this input. 

0 … 100% 

RH Override RHOR  The cooling output Clg  will be set to the maximum value of 

the calculated demand for the cooling plus this input. 

0 … 100% 

Frost Stat Fsta  When Active, the outputs will be set to the positions 
defined in the internal settings. This will override all other 
states. 

Not Required 

Frost Stage 1_2 F1_2  When Active, the outputs will be set to the positions 
defined in the internal settings. 

Not Required 

Warmup WmUp  When this is Active and the enable input En  is Off, the 

outputs will be set to the positions defined in the internal 
settings. 

Not Required 

Enable En  When Off, all outputs will be Off unless overridden by a 
frost or warmup condition.  

When On the output positions will be determined by the 
required demand or the frost. 

Off: Control disabled 

On: Control enabled 

 

Outputs 

Object Comments Object options 

Heating Htg  Heating demand.   

Free Energy Free  Source for free energy dampers, heat wheel etc.   

Cooling Clg  Cooling demand.  
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Internal Settings 

Object Comments Object options (default) 

HtgRange   
(Heating Range)  

The proportion of the demand that the heating 

output Htg  will take. The total of the heating, 

cooling and free must not exceed 100%. 

0 … 100% (40%) 

FreeRange 
(Free Range) 

The proportion of the demand that the free 

energy output Free  will take. The total of the 

heating, cooling and free must not exceed 100%. 

0 … 100% (20%) 

ClgRange   
(Cooling Range) 

The proportion of the demand that the cooling 

output Clg  will take. The total of the heating, 

cooling and free must not exceed 100%. 

0 … 100% (40%) 

DamperMinPos  
(Damper Minimum 

Position)   

The minimum allowed position for the free 

energy output Free  when connected to 

dampers. This will only apply when Control is 
active. 

0 … 50% (10%) 

HtgFrostStatPos  
(Heat Frost Stat  Position) 

The position to which the heating output Htg  

will go when the frost stat input is active. 

0 … 100% (100%) 

FreeFrostStatPos  
(Free Frost Stat  Position) 

The position to which the free energy output 

Free  will go when the frost stat input is active. 

0 … 100% (0%) 

ClgFrostStatPos  
(Cool Frost Stat  Position) 

The position to which the cooling output Clg  will 

go when the frost stat input is active. 

0 … 100% (0%) 

HtgFrost1_2Pos  
(Heat Frost 1 2  Position) 

The position to which the heating output Htg  

will go when the frost 1_2 input is active. 

0 … 100% (100%) 

FreeFrost1_2Pos 
(Free Frost 1 2  Position) 

The position to which the free energy output 

Free  will go when the frost 1_2 input is active. 

0 … 100% (0%) 

ClgFrost1_2Pos 
(Cool Frost 1 2  Position) 

The position to which the cooling output Clg  will 

go when the frost 1_2 input is active. 

0 … 100% (0%) 

HtgWarmUpPos 
(Heat Warmup  Position) 

The position to which the heating output Htg  

will go when the warmup input is active. 

0 … 100% (100%) 

FreeWarmUpPos 
(Free Warmup  Position) 

The position to which the free energy output 

Free  will go when the warmup input is active. 

0 … 100% (0%) 

ClgWarmUpPos 
(Cool Warmup  Position) 

The position to which the cooling output Clg  will 

go when the warmup input is active. 

0 … 100% (0%) 

 

Internal Values 

Object Comments Object options 

Status  This will indicate the status of Control 

 

0: Off 

1: On 

2: Warmup 

3: Frost 1_2 

4: Frost Stat 
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HWS Control 

System overview 
This module will control a HWS Tank (Hot Water System storage tank / hot water generator). This macro can be set up to use 
up to 3 different process variables (temperature or pressure sensors), and a de-stratification pump as well as analogue and 
digital valves. It also has the ability to run a legionella* (Pathogen control) cycle. 

*U.S. Center of Disease Control defines Legionella as: Legionella is is a respiratory disease caused by Legionella bacteria. Sometimes the bacteria cause a serious type of pneumonia 
(lung infection) called Legionnaires’ disease. The bacteria can also cause a less serious infection called Pontiac fever that has symptoms similar to a mild case of the flu. 

Inputs Internal Outputs 

 

High Level Temp HTmp 

Mid-Level Temp MTmp 

Low Level Temp LTmp 

High Limit Stat HiLS 

Setpoint SP 

Deadband DB 

Destrat Deadband DSDB 

Legionella Start LStr 

Legionella Stop LStp 

Enable En 

   

Values 

(none) 

Settings 

OffSet  

LegionellaRunTi..  

(Legionella run time) 
 0 … 120 mins 

LoopGain 

(Loop “P”) 
2° … 10°  

LoopInt  

(Loop “I”) 
0 … 300 s 

LegionellaSP 

(Legionella Setpoint) 
70 … 90 °C 

Alarms 

High Limit High Normal 

Legionella Failed Failed Normal 
 

Number of Blocks 33 
  

 

AVlv Analogue Valve 

DVlv Digital Valve 

DPmp Destrat Pump 
 

Examples 
The diagrams below illustrate some scenarios in which the HWS Control Macro could be used: 
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System object description 

Inputs 

Object Comments Object options 

High Level Temp 

HTmp  

HWS tank High-level temperature.  This input must be connected to 
a temperature sensor. If not 
present, then it should be 
connected to the low or mid 
sensor. 

Mid-Level Temp 

MTmp  

HWS tank Mid-level temperature.  This input must be connected to 
a temperature sensor. If not 
present, then it should be 
connected to the low or high 
sensor. 

Low Level Temp LTmp  HWS tank Low-level temperature.  This input must be connected to 
a temperature sensor. If not 
present, then it should be 
connected to the high or mid 
sensor. 

Hi Limit stat HiLS  High limit thermostat.  

This will close the heating valve if active. 

Not required. 

Setpoint SP  The required temperature of the hot water. Required 

Deadband DB  The deadband that is allowed for the hot water to deviate 
from the setpoint.  

0 °C … 5 °C 

(32 °F … 41 °F) 

Destrat deadband 

DSDB  

The difference in temperature allowed between any of the 
temperature sensors before the destrat pump will be enabled.  

2 °C … 5 °C 

(36 °F … 41 °F) 

Legionella Start LStr  Pulsed to start the Legionella cycle.  

This will only start if the system enable signal En  is Off.  

The cycle will be stopped when the legionella cycle is 

complete, or when the system enable signal En  goes On. 

Not required. 

Legionella Stop LStp  Pulsed to stop the Legionella cycle.  Not required. 

Enable En  Enable HWS control. Required. 

 

Outputs 

Object Comments Object options 

Analogue valve AVlv  The demand for an analogue valve.  Not required. 

Digital valve DVlv  The demand for a digital valve.  Not required 

Destrat pump Pmp  Enable signal for a de-stratification pump. Not required. 
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Internal settings 

Object Comments Object options (default) 

LegionellaSP 

(Legionella Setpoint) 

The setpoint for the Legionella control.  

The water in the calorifier will be maintained at this 
temperature for the time defined by the Legionella run time.  

60 … 80 °C (80) 

140 … 176 °F (176) 

LegionellaRunTi..  

(Legionella run time) 

The time for which the HWS will be maintained at the 
Legionella setpoint. 

0 … 120 mins (60) 

LoopGain 

(Loop “P”) 

PI Loop proportional value Required (4) 

LoopInt  

(Loop “I”) 

PI Loop integral value Not Required (120) 

OffSet The dead band for the demand PI loop 0 … 200 

 

Alarms 

Object Comments Object options 

High Limit An alarm will be raised if the high limit input HiLS  goes 

High. 

0: Not Used 

1: Used 

Legionella Failed An alarm will be raised if the legionella cycle fails. 0: Not Used 

1: Used 
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OAT Reset with room offset 

System overview 

This module can be used to calculate the required flow temperature setpoint based on outside air and an optional room 
temperature. 

Inputs Internal Outputs 

 

Outside Air Temp OAT 

Room Temp RT 

Room temp Setpoint RTSP 

Boost BST 

   

Values 

(none) 

Settings 

MaxFlow  

(Flow Max) 

30 °C … 80 °C 

(86 °F  … 176 °F)  

MaxOffSet  

 (Room Offset Max) 

0 °C … 10 °C 

(32 °F … 50 °F) 

MinOAT 

(OAT Min) 

-5 °C  … 10 °C 

(23 °F … 50 °F) 

MinFlow  

(Flow Min) 

15 °C … 25 °C 

(59 °F … 77 °F) 

MaxOAT 

(OAT Max) 

15 °C … 25 °C 

(59 °F … 77 °F) 

Scaling  

(Room Offset Scale) 

0 … 5 

Alarms 

(none) 
 

Number of Blocks 10 
    

 

CSP   Calculated Setpoint 
 

System object description 

Inputs 

Object Comments Object options 

OAT OAT  Outside Air Temperature.  Required 

Room Temp RT  Room Temperature. 0: Not used 

1: Monitor 

Room Temp SP RTSP  Room Temperature Setpoint. 0: Not Used 

1: Monitor 

Boost BST  When set to On the calculated setpoint CSP  

will be set to the MaxFlow parameter 

Not Required 

Outputs 

Object Comments Object options 

Calculated Setpoint CSP  Calculated Setpoint Required 
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Internal Settings 

Object Comments Object options 
(default) 

MaxOAT 

(OAT Max) 
Maximum outside air temperature value for compensation. If OAT  is 

above this value, then this value will be used for the calculation. 

15 °C … 25 °C (20)  

59 °F … 77 °F (68) 

MinOAT 

(OAT Min) 
Minimum outside air temperature value for compensation. If OAT  is 

below this value, then this value will be used for the calculation. 

-5 °C … 10 °C (0) 

23 °F … 50 °F (32) 

MaxFlow  

(Flow Max) 

Maximum flow temperature value for compensation. If the Calculated 

flow temperature setpoint CSP  is above this value, then the setpoint 

will be set to this value. 

30 °C … 80 °C (80)  

86 °F …  176 °F (176) 

MinFlow  

(Flow Min) 

Minimum flow temperature value for compensation. If the Calculated 

flow temperature setpoint CSP  is below this value, then the setpoint 

will be set to this value. 

15 °C … 25 °C (20)  

59 °F … 77 °F  (68) 

MaxOffSet  

(Room Offset Max) 

The maximum amount by which the room temperature can affect the 
calculated flow setpoint. 

0 °C … 10 °C (5) 

32 °F … 50 °F (41) 

Scaling  

(Room Offset 
Scale) 

Factor by which the difference between the room temperature and the 
setpoint is multiplied before it is added to the calculated flow setpoint. 

0 … 5 (0.5) 

The following formula is used calculate the flow setpoint: 

 

OATCal = Maximum (MinOAT (Minimum( OAT , MaxOAT)) 

FlowCal = MaxFlow – (MaxFlow – MinFlow) * (MaxOAT – MinOAT)/ (OATCal – MinOAT) 

RMoffSet = Minimum (MaxOffSet, Maximum (-MaxOffSet, (( RT  – RTSP ) * Scaling))) 

 

FlowTempSP = Maximum (MinFlow, Min (Minimum(FlowCal + RMOffSet, MaxFlow)) 
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Reset 

System overview 

This module will supply a 10 second pulse from Off-On-Off for resetting plant*. When the setpoint is set to Reset (On), it will 
remain on for 10 seconds and then will be automatically set to Off. 

 

Inputs Internal Outputs 

 

(none) 

   

Values 

(none) 

Settings 

(none) 

Alarms 

(none) 

 

Number of Blocks 2 

    

 

RS   Reset 
 

 

*The term “Plant” refers to a piece of HVAC equipment 

 

System object description 

Outputs 

Object Comments Object options 

Reset Will go High for 10 seconds when set.   

 

Internal Settings 

Object Comments Object options 

Reset Set to On to generate a reset pulse.   
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Sensor Alarm and Log 

System overview 

This macro will take the Process Variable and in either a Heating or a Cooling application, drive any number of Sequence 
Modules. The Sequence Modules are set up for individual plants which can include Chillers, Boilers and DX units. 

This macro will monitor the process variable sensor, and if required generate an out of limits alarm and/or a sensor failed alarm. 
It will also log the sensor values. 

Inputs Internal Outputs 

 

Sensor SIn 

Out Of Limits SP OLSP 

Out Of Limits DB OLDB 

Enable Out Of Limits EnOL 

Enable Failed EnF 

   

Values 

(none) 

Settings 

OutOfLimitsOnDe… 

(Out of limits delay on time) 
0 … 600 s 

OutOfLimitsOffDe… 

(Out of limits delay off time) 
0 … 600 s 

FailOnDelayA 

(Fail delay on time) 
0 … 600 s 

FailOffDelayA 

(Fail delay off time) 
0 … 600 s 

FailLoSPA 

(Fail Low SP) 

Unit dependent 

FailHiSPA 

(Fail Hi SP) 

Unit dependent 

Alarms 

Out of Limits Alarm : Normal 

Failed Fail : Normal 
 

Number of Blocks 10 
   

 

(none) 
 

System object description 

Inputs 

Object Comments Object options 

Sensor Sin  Sensor to be monitored.  Required 

Setpoint OLSP  If the EnOL  is active and the sensor value goes outside  

OLSP  ± OLDB  

for the time set in Internal Setting Out Of Limits Delay On Time 

then an Out Of Limits alarm will be generated.  

Not Required 

Deadband OLDB  The deadband for the Out Of Limits alarm. Not Required 

Enable sensor out of limits 

EnOL  

Set high (ON) to enable Out Of Limits alarm. Off: Alarm disabled 

On:  Alarm enable 

Enable sensor failed alarm EnF  Set high (ON) to enable Sensor Failed alarm. Off:  Alarm disabled 

On:  Alarm enable 
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Internal Settings 

Object Comments Object options (default) 

OutOfLimitsOnDelay 

(Out of limits delay on 
time) 

The delay before an out of limits alarm will be generated.  Not Required (120) 

OutOfLimitsOffDelay 

(Out of limits delay off 
time) 

The delay before an out of limits alarm will be cleared.  Not Required (120) 

FailOnDelay 

(Fail delay on time) 

The delay before a Sensor Failed alarm will be generated.  Not Required (10) 

FailOffDelay 

(Fail delay off time) 

The delay before a Sensor Failed alarm will be cleared.  Not Required (10) 

FailLoSP 

(Fail Low SP) 

The value below which the sensor must go before it is 
deemed as failed. 

Not Required (-20) 

FailHiSP 

(Fail Hi SP) 

The value above which the sensor must gobefore it is 
deemed as failed. 

Not Required (130) 

 

Alarms 

Object Comments Object options 

Out of Limits An alarm will be raised if the sensor is outside OLSP  ± 

OLDB  for the time set in Out Of Limits Delay On Time. 

0: Not Used 

1: Used 

Failed An alarm will be raised if the sensor is either below the 
FailLoSP or above the FailHiSP  for the time specified in 
FailOnDelay. 

0: Not Used 

1: Used 
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Sequence Control 

System Overview 

This macro can be used to sequence any number of modules. These modules can be boilers, chillers and DX (Direct 
Expansion) units. It requires the module sequence macro. The macro includes lockout and runtime alarms. 

Inputs Internal Outputs 

 

SCD2 SCD2 

Process Variable PV 

Setpoint SP 

Deadband DB 

PI Direction PDIR 

Auto Lead Select ALS 

Auto Demand Select  ADS 

Auto Module Select  AMS 

Boost BST 

Enable En 

   

Values 

Plant Status 0 … 15 

Settings 

Gain (PI Loop Gain) 1 … 20 

HourOfDay (Time Of Day (Hour)) 0 … 23 Hours 

Stage1On * 10 … 30 % 

Stage1Off * 5 … 20 % 

MinOnTime (Minimum On Time)  0 … 600 s 

StageOn* 10 … 110 % 

TypeSelect * 0 … 3 

Integral (PI Loop Integral) 0 … 600 s 

StageOff * 5 … 90 % 

HoursRunTime 5000 Hours 

Offset (PI Loop Offset) 0 … 100 % 

MinOffTime (Minimum Off Time) 0 … 600 s 

NextStageOnTime  
(Next Stage On Delay) 

0 … 600 s 

NextStageOffTime  
(Next Stage Off Delay) 

0 … 600 s 

Monday On/Off 

Tuesday On/Off 
… … … … … … … … 

Saturday On/Off 

Sunday On/Off 

(Changeover  Mode) 0 … 1 

(PI Loop Hold) 0 … 3 

Alarms 

(none) 

 

Number of Blocks 153 

    

 

SCD2 SCD2 

SCD3 SCD3 
 

* There are four modes of operation for this sequencer: two cascade modes and two parallel modes.  

 The cascade modes will sequence each stage individually with all enabled stage demands set to 100% except the last 
one enabled which will be modulated to achieve setpoint.  

 The parallel modes will sequence all enabled stage demands to the same value. This balances the load across the 
boilers and allows them to run cooler, which is more efficient for condensing boilers. 

Each mode is described on the following pages. 
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Cascade 1 

This mode will: 

 Enable the current stage when the calculated demand for the current stage is greater than StageOn. 

 Disable the current stage when the calculated demand for the previous stage is less than StageOff.  

 Disable Stage 1 when the demand for Stage 1 falls below Stage1Off.  
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Cascade 2 

This mode will: 

 Enable the current stage when the calculated demand for the current stage is greater than StageOn. 

 Disable the current stage when the calculated demand for the current stage is less than StageOff.  
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Parallel 1 
This mode will: 

  Enable the next stage when the calculated output for the current stage is greater than StageOn.  

 Disable the current stage when the calculated demand for the current stage is less than StageOff  

 Enable Stage 1 when the output for stage 1 is above the “Stage1On”.  

 Disable Stage 1 when the output for stage 1 falls below the “Stage1Off”. 
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Parallel 2 

This mode will: 

  Enable the next stage when the calculated output for the next stage is greater than StageOn.  

 Disable the current stage when the calculated demand for the current stage is less than StageOff. 
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The diagram below illustrates one scenario in which the Sequence Control Macro could be used, and the Strategy extracts 
which follow illustrate how one type of scenario might be adapted to add another item of equipment: 
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Boiler Sequence with 2 boilers (2 sequence modules): 

 

 

 Macros 

1. Add a sequence control macro 
with the prefix name 
“Boilers”. 

2. Add a sequence module macro 
with the prefix name 
“Boiler1”  

3. Add a sequence module macro 
with the prefix name 
“Boiler2”  

4. Add a Reset macro with the 
prefix name “Boiler1”  

5. Add a Reset macro with the 
prefix name “Boiler”2 

 I/O 

1. Add Analogue input named BoilerFlow. 

2. Add Analogue Setpoint named 
BoilerFlowSP. 

3. Add Digital Input named Boiler1Lockout. 

4. Add Digital Input named Boiler2Lockout. 

5. Add Digital Output named Boiler1Enable. 

6. Add Digital Output named Boiler2Enable. 

 Connections 

1. Connect SCD1  from Boilers to Boiler1 

2. Connect SCD2  from Boilers to Boiler1 

3. Connect SCD1  from Boiler1 to Boiler2 

4. Connect SCD2  from Boiler1 to Boiler2 

5. Connect SCD3  from Boiler1 to Boiler2 

6. Connect SMD  from Boiler1 to Boiler2 

7. Connect SMD  from Boiler2 to Boiler1 

8. Connect SCD2  from Boiler2 to Boilers 

9. Connect O  from BoilerFlow to PV  Boilers 

10. Connect O  from BoilerFlowSP to SP  Boilers  

11. Connect RS  from Boiler1 (Reset) to Boiler1 LORS   

12. Connect RS  from Boiler2 (Reset) to Boiler2 LORS   

13. Connect O  from Boiler1Lockout to LO  Boiler1  

14. Connect O  from Boiler2Lockout to LO  Boiler2  

15. Connect EnLo  from Boiler1 to I  Boiler1Enable  

16. Connect EnLo  from Boiler2 to I  Boiler2Enable 

 

Sequence 
Control 
Macro 
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Remove connections SCD2  and SMD  to add another boiler: 

 

 Macros 

--- 

 I/O 

--- 

 Connections 

1. Delete Line from Boiler2 SCD2  to Boiler1 SCD2   

2. Delete Line from Boiler2 SMD  to Boiler1 SMD  

Boiler Sequence with 3rd boiler added (3 sequence modules): 

 

 Macros 

1. Add a Sequence module 
macro with the prefix name 
“Boiler3”  

2. Add a Reset macro with the 
prefix name “Boiler3” 

 I/O 

1. Add Digital Input named 
Boiler3Lockout. 

2. Add Digital Output named 
Boiler3Enable. 

 Connections 
1. Connect SCD1  from Boiler2 to Boiler3 

2. Connect SCD2  from Boiler2 to Boiler3 

3. Connect SCD3  from Boiler2 to Boiler3 

4. Connect SMD  from Boiler2 to Boiler3 

5. Connect SMD  from Boiler3 to Boiler1 

6. Connect SCD2  from Boiler3 to Boilers 

7. Connect RS  from Boiler3 (Reset) to Boiler3 LORS   

8. Connect O  from Boiler3Lockout to LO  Boiler3  

9. Connect EnLo  from Boiler3 to  I  Boiler3Enable 
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System object description 

Inputs 

Object Comments Object options 

System Control Data 2 

SCD2  

Used internally to control modules. This should be 
connected to the output of the last module that is 
being controlled.  

Required 

Process Variable PV  The temperature sensor used to sequence the boiler 
modules. 

Required 

Setpoint SP  The setpoint to which the boiler module sequence 
will control.  

Required 

Deadband DB  When the Process Variable PV  reaches the setpoint 

SP , the control loop will remain fixed until PV  goes 

outside SP  ± DB .  

Not Required 

PI Direction PDIR  Selects the direction of the PI loop 0: Reverse (Heating) 

1: Forward (Cooling) 

Boost BST  Overrides the “delay on timer”  allowing more than 
one stage to come on together. 

Off:  On 

On: Override 

Auto Lead Select ALS  Used to fix the lead module.  

0 will enable automatic lead selection. 

0: Auto 

1: Module 1 

2: Module 2. 

Auto Demand Select 

ADS  

Used to override the demand calculation.  

0 will enable automatic demand. 

0: Auto Demand 

1 … 100 : % Demand 

Auto Module Select 

AMS  

Used to fix the number of modules enabled.  

0 will enable automatic module selection. 

0: Auto 

> 1:  value specifies the number of  
Modules 

Enable En  Set this to On for the sequencer to operate. Off: Sequencer Off 

On: Sequencer On 

 

Outputs 

Object Comments Object options 

System Control Data 2 

SCD2  

Used internally to control the modules. This output 
must be connected to the first module being 
controlled. 

Required 

System Control Data 3 

SCD3  

Used internally to control the modules. This output 
must be connected the first module being 
controlled. 

Required 
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Internal Settings 

Object Comments Object options 
(default) 

TypeSelect * Specifies the type of control for the boilers - 
either cascade or parallel 

0 = Cascade 1 

1 = Cascade 2 

2 = Parallel 1 

3 = Parallel 2 

Stage On* Output value for next stage to be enabled. 10 % … 110 % 

StageOff * Output value for current stage to be disabled. 5% … 100 % 

Stage1On * Output value for stage 1 to be enabled. 5% … 20 % 

Stage1Off * Output value for stage 1 to be disabled. 5% … 20 % 

MinOnTime  (Minimum On Time)  Minimum time for which a stage is enabled 
before it can be disabled.   

0 … 600 s 

MinOffTime (Minimum Off Time) Minimum time for which a stage is disabled 
before it can be enabled. 

0 … 600 s 

NextStageOnTime (Next Stage On Delay) Minimum time after one stage is enabled 
before the next stage can be enabled (if it is 
required that the next stage be enabled) 

0 … 600 s 

NextStageOffTime (Next Stage Off Delay) Minimum time after one stage is disabled 
before the next stage can be disabled (if it is 
required that the next stage be disabled). 

0 … 600 s 

Gain  (PI Loop Gain) Sets the gain for the PI Loop 1 … 10 

Integral (PI Loop Integral) Sets the integral for the PI Loop 0 … 600 s 

Offset  (PI Loop Offset) The output of the PID loop when Process 

Variable PV  is equal to the Setpoint SP . 

0 … 100 (50) 

HoursRunTime Specifies whether auto changeover should 
change to the next module in the sequence, or 
to the module with the minimum run time.    

0 = Hours Run 

1 = Time 

HourOfDay  (Time Of Day (Hour)) This specifies the hour of day which the plant 
will be automatically rotated. 

0 … 23 (2) 

Monday These seven set points are used to select the 
day of the week to which the plant will be 
automatically rotated. 

On/Off 

Tuesday On/Off 

Wednesday On/Off 

Thursday On/Off 

Friday On/Off 

Saturday On/Off 

Sunday On/Off 
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Sequence Module 

System overview 

This macro is used in conjunction with the sequence control module to control a number of plant items such as boilers and 
chillers. The macro includes lockout and runtime alarms. 

Inputs Internal Outputs 

 

SCD1 SCD1 

SCD2 SCD2 

SCD3 SCD3 

SMD  SMD 

Lockout  LO 

Disable DIS 

Lockout Reset LOSR 

Maintenance Reset  MRS 

Total Runtime Reset TRRS 

   

Values 

Plant Status 0 … 15 

Run Time Hours 

Settings 

HiLo 1, 0 

MaintenanceLimit 100 … 10000 hrs 

Alarms 

Maintenance Limit : Normal 

 

Number of Blocks 65 
 

 

SCD1 SCD1 

SCD2 SCD2 

SCD3 SCD3 

SMD SMD 

EnHi Enable High  

EnLo Enable Low 

Dmd Demand 
 

 

*The term “Plant” refers to a piece of HVAC equipment 
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Examples 

The diagram below illustrates one scenario in which the Sequence Module Macro could be used, and the Strategy extracts 
which follow illustrate how one type of scenario might be adapted to add another item of equipment: 
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Boiler Sequence with 2 boilers (2 sequence modules): 

 

 Macros 

1. Add a sequence control macro 
with the prefix name 
“Boilers”. 

2. Add a sequence module macro 
with the prefix name 
“Boiler1”  

3. Add a sequence module macro 
with the prefix name 
“Boiler2”  

4. Add a Reset macro with the 
prefix name “Boiler1”  

5. Add a Reset macro with the 
prefix name “Boiler”2 

 I/O 

1. Add Analogue input named 
BoilerFlow. 

2. Add Analogue Setpoint named 
BoilerFlowSP. 

3. Add Digital Input named 
Boiler1Lockout. 

4. Add Digital Input named 
Boiler2Lockout. 

5. Add Digital Output named 
Boiler1Enable. 

6. Add Digital Output named 
Boiler2Enable. 

 Connections 

1. Connect SCD1  from Boilers to Boiler1 

2. Connect SCD2  from Boilers to Boiler1 

3. Connect SCD1  from Boiler1 to Boiler2 

4. Connect SCD2  from Boiler1 to Boiler2 

5. Connect SCD3  from Boiler1 to Boiler2 

6. Connect SMD  from Boiler1 to Boiler2 

7. Connect SMD  from Boiler2 to Boiler1 

8. Connect SCD2  from Boiler2 to Boilers 

9. Connect O  from BoilerFlow to PV  Boilers 

10. Connect O  from BoilerFlowSP to SP  Boilers  

11. Connect RS  from Boiler1 (Reset) to Boiler1 LORS   

12. Connect RS  from Boiler2 (Reset) to Boiler2 LORS   

13. Connect O  from Boiler1Lockout to LO  Boiler1  

14. Connect O  from Boiler2Lockout to LO  Boiler2  

15. Connect EnLo  from Boiler1 to I  Boiler1Enable  

16. Connect EnLo  from Boiler2 to I  Boiler2Enable 

 

Sequence 
Module 1 

Sequence 
Module 2 
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Remove connections SCD2  and SMD  to add another boiler: 

 

 Macros 

--- 

 I/O 

--- 

 Connections 

1. Delete Line from Boiler2 SCD2  to Boiler1 SCD2   

2. Delete Line from Boiler2 SMD  to Boiler1 SMD  

Boiler Sequence with 3rd boiler added (3 sequence modules): 
 

 

 Macros 

1. Add a Sequence module 
macro with the prefix name 
“Boiler3”  

2. Add a Reset macro with the 
prefix name “Boiler3” 

 I/O 

1. Add Digital Input named Boiler3Lockout. 

2. Add Digital Output named Boiler3Enable. 

 Connections 
1. Connect SCD1  from Boiler2 to Boiler3 

2. Connect SCD2  from Boiler2 to Boiler3 

3. Connect SCD3  from Boiler2 to Boiler3 

4. Connect SMD  from Boiler2 to Boiler3 

5. Connect SMD  from Boiler3 to Boiler1 

6. Connect SCD2  from Boiler3 to Boilers 

7. Connect RS  from Boiler3 (Reset) to Boiler3 LORS   

8. Connect O  from Boiler3Lockout to LO  Boiler3  

9. Connect EnLo  from Boiler3 to  I  Boiler3Enable 

 

Sequence 
Module 2 

Sequence 
Module 1 

Sequence 
Module 3 
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System object description 

Inputs 

Object Comments Object options 

System Control Data 1 

SCD1  

Used internally to control the module. The input of the first module 
must be connected to the Sequence controller. The input of each 
subsequent module should be connected to the previous module.  

Required 

System Control Data 2 

SCD2  

Used internally to control the module. The input of the first module 
must be connected to the Sequence controller. The input of each 
subsequent module should be connected to the previous module. 

Required 

System Control Data 3 

SCD3  

Used internally to control the module. The input of the first module 
must not be connected. The input of each subsequent module 
should be connected to the previous module. 

Required 

System Module Data SMD  Used internally to control the module. The input of the first module 
must be connected to the output of the last module. The input of 
other modules should be connected to the previous module. 

Required 

Lockout LO  Plant lockout or fault. Not Required 

Disable DIS  Set to High to remove the module for the sequence and disable the 
outputs. 

Not Required 

Lockout Reset LOSR  Set to High to clear a lockout fault. Not Required 

Maintenance Reset MRS  Set to High to clear an active maintenance alarm. Not Required 

Total RunTime Reset TRRS  Set to High to clear the RunTime record. Not Required 

 

Outputs 

Object Comments Object options 

System Control Data 1 

SCD1  

Used internally to control the module. The output of the last module 
must not be connected. The output of other modules should be 
connected to the next module.  

Required 

System Control Data 2 

SCD2  

Used internally to control the module. The output of the last module 
must be connected to the sequence module. The output of other 
modules should be connected to the next module. 

Required 

System Control Data 3 

SCD3  

Used internally to control the module. The output of the last module 
must not be connected. The output of other modules should be 
connected to the next module.  

Required 

System Module Data 

SMD  

Used internally to control the module. The output of the last module 
must be connected to the input of the first module. The output of 
other modules should be connected to the next module. 

Required 

Enable High EnHi  Active state to enable the boiler high fire to run Not Required 

Enable Low EnLo  Active state to enable the boiler low fire to run Not Required 

Demand Dmd  This is a 0 … 100% output used to control modulating boilers Not Required 
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Internal Settings 

Object Comments Object options (default) 

HiLo This sets the macro to control a signal fire boiler or a Hi-Lo fire. (0: On-Off) 

1: Hi-Lo  

MaintenanceLimit  This is the length of time the plant can run before a maintenance alarm 
is raised. 

100 … 10000  (5000) 

 

Internal Values 

Object Comments Object options 

Status  This will indicate the status of module. 

 

0: Auto – Off 

1: Auto On 

2: Lockout 

3: Disabled 

Runtime Time the plant has run since last maintenance reset. 0: Not Used 

1: Used 

 

Alarms 

Object Comments Object options 

Maintenance Alarm  Active when the plant runtime has exceeded the MaintenanceLimit. 0: Not Used 

1: Used 
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Damping 

System overview 

This module will dampen the rate of change of an analogue value. 

Inputs Internal Outputs 

 

Input In 

Disable Dis 

   

Values 

(none) 

Settings 

Maximum Change 0 … 200 

Alarms 

(none) 

 

Number of Blocks 13 
 

 

Out Output 
 

System object description 

Inputs 

Object Comments Object options 

Input In  The analogue value to be damped.  Required 

Disable Dis  When this input is set, damping is NOT applied to the output.  Not Required 

 

Outputs 

Object Comments Object options 

Output Out  The damped output. Required. 

 

Internal Values 

Object Comments Object options 

MaxChnage  The maximum amount of change the output is allowed per second. 0 … 200 (0.5) 
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Frost Stages 1, 2 and 3 

System overview 

This module will generate demands for 3 frost stages based on outside, flow and room temperatures.  

 Stage 1 : Outside Air Temperature is just above freezing – start the circulation pumps to prevent the water 
freezing in the pipes. 

 Stage 2 : Boiler flow temperature is low – enable the boilers and circulation pumps until the boiler flow 
temperature is above the low limit setpoint and deadband. 

 Stage 3 : Fabric Protection (Space Temperature is low) – enable the boilers, circulation pumps and sace 
control until the Space Temperature is above the low-limit setpoint and deadband. 

It will also raise alarms for each frost level if enabled. 

Inputs Internal Outputs 

 

Outside Temp OAT 

Flow Temp FT 

Room Temp RT 

   

Values 

Plant Status 0 … 7 

Settings 

Stage1SP 
(Frost Stage 1 Setpoint) 

1 °C … 5 °C 
(34 °F … 41 °F) 

Stage1DB 
 (Frost Stage 1 Deadband) 

1 °C … 4 °C 
(34 °F … 39 °F) 

Stage1AlarmEn 
(Frost Stage 1 Alarm Enable) 

On : Off 

Stage2SP 
(Frost Stage 2 Setpoint) 

10 °C … 20 °C 
(50 °F … 36 °F) 

Stage2DB 
(Frost Stage 2 Deadband ) 

1 °C … 4 °C 
(34 °F … 39 °F) 

Stage2AlarmEn 
(Frost Stage 2 Alarm Enable) 

On : Off 

Stage3SP 
(Frost Stage 3 Setpoint) 

10 °C … 16 °C 
(50 °F … 61 °F) 

Stage3DB 
(Frost Stage 3 Deadband) 

1 °C … 4 °C 
(34 °F … 39 °F) 

Stage3AlarmEn 
(Frost Stage 3 Alarm Enable) 

On : Off 

Alarms 

Frost Stage 1  

Frost Stage 2  

Frost Stage 3  

 

Number of Blocks 11 
 

 

FS1 Frost Stage 1 

FS2 Frost Stage 2 

FS3 Frost Stage 3 
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System object description 

Inputs 

Object Comments Object options 

Outside Temp OAT  Sensor measuring the outside air temperature Required 

Flow Temp FT  Sensor measuring the boiler flow temperature. Not Required 

Room Temp RT  Sensor measuring the room temperature. Not Required 

 

Outputs 

Object Comments Object options 

Frost Stage 1 FS1  On when frost stage 1 is calculated.   

Frost Stage 2 FS2  On when frost stage 2 is calculated.  

Frost Stage 3 FS3  On when frost stage 3 is calculated.  

 

Internal Settings 

Object Comments Object options (default) 

Stage1SP  When the outside air temperature falls below this value  FS1  

will be set. 

1 °C … 5 °C (2)  
34 °F … 41 °F (36) 

Stage1DB 

 

When the outside air temperature rises above Stage1SP + 

Stage1DB, then FS1  will be cleared. 

1 °C … 4 °C (2)  
34 °F … 39 °F (36) 

Stage1AlarmEn  If this is active, then a Frost Stage 1 alarm will be raised when 

FS1  is set. 

Off : On (Off) 

Stage2SP  When the outside air temperature falls below this value  FS2  

will be set. 

10 °C … 20 °C (15)  
50 °F … 68 °F (59) 

Stage2DB 

 

When the outside air temperature rises above Stage2SP + 

Stage2DB, then FS2  will be cleared. 

1 °C … 4 °C (2)  
34 °F … 39 °F (36) 

Stage2AlarmEn  If this is active, then a Frost Stage 2 alarm will be raised when 

FS2  is set. 

Off : On(Off) 

Stage3SP  When the outside air temperature falls below this value  FS3  

will be set. 

10 °C … 15 °C (12)  
50 °F … 59 °F (54) 

Stage3DB 

 

When the outside air temperature rises above Stage3SP + 

Stage3DB, then FS3  will be cleared. 

1 °C … 4 °C (2)  
34 °F … 39 °F (36) 

Stage3AlarmEn  If this is active, then a Frost Stage 3 alarm will be raised when 

FS3  is set. 

Off : On (Off) 

 

  



 

 

744 © American Auto-Matrix MAN00058US rev 69 

M
A

N
0

0
0

5
8

U
S rev 6

9
 

 

Internal Values 

Object Comments Object options 

Status  This will indicate the status of Control 

 

0. Off 

1. Frost Stage 1 

2. Frost Stage 2 

3. Frost Stage 1 and 2 

4. Frost Stage 3 

5. Frost Stage 1 and 3 

6. Frost Stage 2 and 3 

7. Frost Stage 1,2 and 3 

 

 

Alarms 

Object Comments Object options 

Frost Stage 1 An alarm will be raised if Frost Stage 1 is active. 0. Not Used 

1. Used 

Frost Stage 2 An alarm will be raised if Frost Stage 2 is active. 0. Not Used 

1. Used 

Frost Stage 3 An alarm will be raised if Frost Stage 3 is active. 0. Not Used 

1. Used 
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Meter 

System overview 

This module will monitor a pulsed or analogue meter and produce the following data. 

1. Total value 

2. 15-minute total log 

3. 1-hour log 

4. Last hour value 

5. Daily log 

6. Yesterday value 

7. Weekly value (With external point to log) 

8. Last week value 

9. Monthly value (With external point to log) 

10. Last month value. 

Inputs Internal Outputs 

 

Pulsed Input PIn 

Analogue In AIn 

   

Values 

(none) 

 

Settings 

Pulse Meter Set 0 … 10000 

 

Alarms 

(none) 

 

Number of Blocks 30 

   

 

WLV Weekly Log Value 

WLT Weekly Log Trigger 

MLV Monthly Log Valve 

MLT   Monthly Log Trigger 
 

System object description 

Inputs 

Object Comments Object options 

Pulsed Input PIn  Pulse meter input. The must be a universal input with the type set to Pulse(V/F)  

Only one input must be connected, either Pin  or AIn . 

Not Required 

Analogue Input 

AIn  

 Must be an analogue input, typically from a Modbus meter.  

Only one input must be connected, either Pin  or AIn . 

Not Required 
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Outputs 

Object Comments Object options 

Weekly Log Value 

WLV  
If a weekly data log is required, then connect this output to the Log Point (  or  

of a datalog module. 

The data log must be set to Falling edge trigger only. (Advanced options). 

Not Required. 

Weekly Log Trigger 

WLT  
If a weekly data log is required, then connect this output to the Log Trigger 

 
 of a 

datalog module. 

Not required. 

 

Monthly Log Value 

WLV  
If a Monthly datalog is required, then connect this output to the Log Point  or   

of a data log. 

Data log must be set to Falling edge trigger only. (Advanced options). 

Not Required. 

Monthly Log 

Trigger WLT  
If a Monthly datalog is required, then connect this output to the Log Trigger of a 

datalog module. 

Not required. 

 

Internal Settings 

Object Comments Object options (Default) 

Pulsed Meter Set (0) The meter output will be set to this value. 0-xxxxx. (0) 

  

I I 

T 

I I 

T 
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Optimizer 

System overview 

This module can be used for heating and cooling optimization. If this is used in a Unitron strategy, then a Global schedule will 
be required to be placed on the strategy immediately before you place the optimizer on the strategy.  

Inputs Internal Outputs 

 

Outside Air Temp OAT 

Room Temp RT 

Room Temp Setpoint RTSP 

Heat Deadband HDB 

Cool Deadband CDB 

   

Values 

(none) 

Settings 

Frost SP 8 °C … 14 °C 
(46 °F … 57 °F) 

Frost DB 1 °C … 4 °C 
(34 °F … 39 °F) 

HMaxStart  
(Max Heat Start) 

0 … 180 mins 

HMaxStop  
(Max Heat Stop) 

0 … 180 mins 

CMaxStart  
(Max Cool Start) 

0 … 180 mins 

CMaxStop  
(Max Cool Stop)  

0 … 180 mins 

Monday  On: Off Times 

Tuesday On: Off Times 

Wednesday On: Off Times 

Thursday On: Off Times 

Friday On: Off Times 

Saturday On: Off Times 

Sunday On: Off Times 

Alarms 

(none) 
 

Number of Blocks 18 
 

 

HDmd Heat Demand 

HBst Heat Boost 

HDay Heat Day 

HFst Heat Frost 

CDmd Cool Demand 

CBst Cool Boost 

CDay Cool Day 

Sch Schedule 
 

System object description 
Inputs 

Object Comments Object options 

Outside Air Temp OAT Outside Air Temperature.  Required 

Room Temp RT Room Temperature. Required 

Room Temp Setpoint RTSP Room Temperature Setpoint. Required 

Heat Deadband HDB The maximum temperature by which the room temperature RT  is 

allowed to fall below the setpoint RTSP during an optimum stop.  

If exceeded, the demand HDmd will be turned on. 

Required for 
heating optimizer. 

Cool Deadband HDB The maximum temperature by which the room temperature RT is 

allowed to rise above the setpoint RTSP during an optimum stop.  

If exceeded, the demand HDmd will be turned on. 

Required for 
cooling optimizer. 
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Outputs 

Object Comments Object options (Default) 

Heat Demand HDmd Heating demand. On when heat is required. Required for heating 
optimizer. 

Heat Boost HBst Heating Boost. On during a heating optimum start.  Not required. 

Heat Day HDay Heating Day. On from end of boost to start of optimum stop.  Not required. 

 

Heat Frost HFst On if the room temperature RT falls below the frost setpoint.  

Off if the room temperature RT is above FrostSP + FrostDB. 

Not required 

Cool Demand CDmd Cooling demand. On when cooling is required. Required for cooling 
optimizer. 

Cool Boost CBst Cooling Boost. On during a cooling optimum start.  Not required. 

 

Cool Day  HDay Cooling Day. On from end of boost to start of optimum stop.  Not required. 

Schedule  Sch On if the optimizer time schedule is active. Not required. 

 

Internal Settings 

Object Comments Object options 

FrostSP  Frost setpoint.  8 °C … 14 °C (12) 

46 °F … 57 °F (54) 

FrostDB  Used to select if the flow is monitored for fault when the plant is 
in standby. 

1 °C … 4 °C (2) 

34 °F … 39 °F (36) 

HMaxStart Maximum time allowed for a heating optimum start. 0 … 180 Minutes (120) 

HMaxStop Maximum time allowed for a heating optimum stop. 0 … 180 Minutes (60) 

CMaxStart Maximum time allowed for a cooling optimum start. 0 … 180 Minutes (120) 

CMaxStop Maximum time allowed for a cooling optimum stop. 0 … 180 Minutes (60) 

Monday Contains two Off:On times for Monday.   

Tuesday Contains two Off:On times for Tuesday.   

Wednesday Contains two Off:On times for Wednesday.   

Thursday Contains two Off:On times for Thursday.   

Friday Contains two Off:On times for Friday.   

Saturday Contains two Off:On times for Saturday.   

Sunday Contains two Off:On times for Sunday.   
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Seven Day Clock 

System overview 

This module gives seven local time schedules, one for each day of the week.  

Inputs Internal Outputs 

 

(none) 

   

Alarms 

(none) 

Settings 

Monday  On: Off Times 

Tuesday On: Off Times 

Wednesday On: Off Times 

Thursday On: Off Times 

Friday On: Off Times 

Saturday On: Off Times 

Sunday On: Off Times 

Alarms 

(none) 

 

Number of Blocks 8 
 

 

True Output 

Comp Complement 
 

System object description 

Outputs 

Object Comments Object options 

Out True  Will go high when any clock is on.   

Compliment Comp  Will go low when any clock is on.  

 

Internal Settings 

Object Comments Object options 

Monday Contains two Off:On times for Monday.   

Tuesday Contains two Off:On times for Tuesday.   

Wednesday Contains two Off:On times for Wednesday.   

Thursday Contains two Off:On times for Thursday.   

Friday Contains two Off:On times for Friday.   

Saturday Contains two Off:On times for Saturday.   

Sunday Contains two Off:On times for Sunday.   
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Legacy Macro Library 

The Macros used in CEC 6.76 and earlier versions are still shipped with CEC 7.00 and later for legacy support. However, their 
use should be avoided, as the main Macro Library covers all of their functionality. 

Legacy Macros - General 

G01 Duty standby with changeover from pressure or flow switch 

 Application 

Pump or fan duty cycling. 

 
 

 Function of module 

This module provides duty sharing between two outputs. Typical outputs include fans and pumps. The duty output changes 
when the changeover input changes state. When the value is 0 the duty output is R1 and when value is 1 duty output is R2. 
The two outputs share a common status point. In the event of duty output failing as detected by the status, then the 
standby output is selected. An alarm is generated indicating duty output failure. In the event of standby output failure as 
indicated by the status, an additional alarm is generated. The alarms are generated after 30 second time delay. The module 
operation is activated by an enable point. When both outputs fail they are turned off after the time delays have elapsed. To 
change this, the Boolean blocks for each output need to be set as follows: 

Output 1: acD+aBCD Output 2: acD+aBcD (Both off) 

Output 1: cD+aBCD Output 2: aCD+BcD (Both on) 

Output 1: acD+BCD Output 2: aCD+BcD (Duty off and standby on) 

Note:  The alarms are cleared by either the reset input or the enable point being set first low, then high. 

 Number of Blocks 

9 

 Symbol 

 

 
 Variables 

Variable type Variable name Description Default values 
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Digital Inputs Flow Status (ST) Provides status on both Run 1 and Run 
2.  

 

Duty Select (DS) Off (0): Run 1 is duty output and Run 2 
is standby output. On (1): Run 2 is  duty 
output and Run 1 is standby output.  

 

Reset (RE) When Reset is on (1) both outputs 
alarm 1 and alarm 2 are set to off (0).  

 

Enable (EN) This input must be set to on (1) for the 
module to function. 

 

Digital Outputs Run 1 When Run 1 is desired output, this 
value is on (1). Else value is off (0).  

 

Run 2 When Run 2 is desired output, this 
value is on (1). Else value is off (0).  

 

Alarm 1 On (1) when Run 1 is on (1) and Flow 
Switch is off (0). Else value is off (0).  

 

Alarm 2 On (1) when Run 2 is on (1) and Flow 
Switch is off (0). Else value is off (0). 

 

Parameters Alarm Delay 1 Time that Run 1 is on (1) and Flow 
Switch is off (0) before Alarm 1 is set to 
on (1).  

30 seconds 

Alarm Delay 2 Time that Run 2 is on (1) and Flow 
Switch is off (0) before Alarm 2 is set to 
on (1).  

30 seconds 

 

 Example 

 

 

 

 

 

G02 Duty standby with changeover from starter trip 

 Application 

Pump or fan duty cycling. 
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 Function of module 

This module provides duty sharing between two outputs. Typical outputs include fans and pumps. The duty output changes 
when the changeover input changes state. When the value is 0 the duty output is R1 and when value is 1 duty output is R2. 
In the event of duty output failing as detected by starter trip, then the standby output is selected. An alarm is generated 
indicating duty output failure. In the event of standby output failure as indicated by the status, an additional alarm is 
generated. The alarms are generated after 2 second time delay. The module operation is activated by an enable point. 
When both outputs fail they are turned off after the time delays have elapsed. To change this the Boolean blocks for each 
output need to set as follows: 

Output 1: acD+aBCD Output 2: acD+aBcD (Both off) 

Output 1: cD+aBCD Output 2: aCD+BcD (Both on) 

Output 1: acD+BCD Output 2: aCD+BcD (Duty off and standby on) 

Note: The alarm is reset by either the reset bit or the enable flag being set off. 

 Number of Blocks 

8 

 Symbol 
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 Variables 

Variable type Variable name Description Default values 

Digital Inputs Starter Trip (T1) Provides starter trip status on Run 1.  

Starter Trip (T2) Provides starter trip status on Run 2.  

Duty Select (DS) Off (0): Run 1 is  duty output and Run 2 
is standby output. On (1): Run 2 is  duty 
output and Run 1 is standby output.  

 

Reset (RE) When Reset is on (1) both outputs 
alarm 1 and alarm 2 are set to off (0).  

 

Enable (EN) This input must be set to on (1) for the 
module to function.  

 

Digital Outputs Run 1 When Run 1 is desired output, this 
value is on (1). Else value is off (0).  

 

Run 2 When Run 2 is desired output, this 
value is on (1). Else value is off (0).  

 

Alarm 1 On (1) when Run 1 is on (1) and Starter 
Trip 1 is on (1). Else value is off (0).  

 

Alarm 2 On (1) when Run 2 is on (1) and Starter 
Trip 2 is on(1). Else value is off (0). 

 

Parameters Alarm Delay 1 Time that Run 1 is on (1) and starter trip 
1 is on (1) before Alarm 1 is set to on 
(1).  

2 seconds 

Alarm Delay 2 Time that Run 2 is on (1) and starter trip 
2 is on (1) before Alarm 2 is set to on 
(1).  

2 seconds 

 Example 
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G03 Duty standby with changeover from starter status mis-match or flow switches 

 Application 

Pump or fan duty cycling. 

 

 Function of module 

This module provides duty sharing between two outputs. Typical outputs include fans and pumps. The duty output changes 
when the changeover input changes state. When the value is 0 the duty output is R1 and when value is 1 duty output is R2. 
In the event of duty output failing as detected by starter status mis-match, or flow switch, then the standby output is 
selected. An alarm is generated indicating duty output failure. In the event of standby output failure, an additional alarm is 
generated. The alarms are generated after 30 second time delay. The module operation is activated by an enable point. 
When both outputs fail they are turned off after the time delays have elapsed. To change this the Boolean blocks for each 
output need to set as follows: 

Output 1: acD+aBCD Output 2: acD+aBcD (Both off) 

Output 1: cD+aBCD Output 2: aCD+BcD (Both on) 

Output 1: acD+BCD Output 2: aCD+BcD (Duty off and standby on) 

Note: The alarm is reset via the reset bit or when the plant enable is set off. 

 Number of Blocks 

8 

 Symbol 
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Variables 

Variable type Variable name Description Default values 

Digital Inputs Starter Status (S1) Provides status on Run 1.  

Starter Status (S2) Provides status on Run 2.  

Duty Select (DS) Off (0): Run 1 is  duty output and Run 2 
is standby output. On (1): Run 2 is  duty 
output and Run 1 is standby output.  

 

Reset (RE) When Reset is on (1) both outputs 
alarm 1 and alarm 2 are set to off (0).  

 

Enable (EN) This input must be set to on (1) for the 
module to function.  

 

Digital Outputs Run 1 When Run 1 is desired output, this 
value is on (1). Else value is off (0).  

 

Run 2 When Run 2 is desired output, this 
value is on (1). Else value is off (0).  

 

Alarm 1 On (1) when Run 1 is on (1) and Starter  
Status is off (0). Else value is off (0).  

 

Alarm 2 On (1) when Run 2 is on (1) and Starter 
Status is off (0). Else value is off (0). 

 

Parameters Alarm Delay 1 Time that Run 1 is on (1) and starter 
status 1 is off (1) before Alarm 1 is set 
to on (1).  

30 seconds 

Alarm Delay 2 Time that Run 2 is on (1) and starter 
status 2 is off (1) before Alarm 2 is set 
to on (1).  

30 seconds 

 
 Example  

  

 

 

 

G04 Status alarm with time delay 

 Application 

Flow alarm on supply fan. 
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 Function of module 

This macro provides for a status alarm. The macro has two inputs: enable and status. If enable is on and status is off for the 
on delay time period an alarm is generated and the alarm output is on. The alarm stays on for the minimum on time period. 
The priority and alarm number both have to be set in the alarm module.  

 Number of Blocks 

3 

 Symbol 

 

 Variables 

Variable type Variable name Description Default values 

Digital Inputs Enable (EN) If this is on (1) then the Alarm State at 
the Status point (ST) will be passed 
through after the specified On Delay 
time (if ST remains on for that time)  

 

Status (ST) The Alarm condition that is monitored 
when Enable is on (1). 

0 = alarm state 

1 = healthy state 

 

Digital Outputs Alarm (AL) On (1) if Enable is on (1) and Status off 
(0) for on delay.  

 

Parameters On Delay Time that Enable is on (1) and Status is 
off (1) before Alarm is set to on (1).  

30 seconds 

Off Delay Time that alarm state has returned to 
normal before Alarm is set to off (0).  

0 seconds 

Minimum Off Time Minimum Time that  Alarm is on (1).  20 seconds 
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 Example 
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G05 Binary driver 

 Application 

Control of two digital output points through one analog point. 

 

 Function of module 

This macro allows control of two digital outputs through one output on a UC16, UC12 or UC8. The macro is used with the 
raise lower module R/L 4. The input on the R/L 4 is set to binary mode through the jumper switch. The raise lower module 
takes the macro output and selects the correct digital output configuration. The following is the macro output:  

1. A=0, B=0, O=0%  

2. A=1, B=0, O=40%  

3. A=0, B=1, O=100%  

4. A=1, B=1, O=70%.  

 Number of Blocks 

7 

 Symbol 

 

 Variables 

Variable type Variable name Description Default values 

Digital Inputs Input A (A) Shows state of  input point A.   

Input B (B) Shows state of  input point B.   

Analog Outputs Output to Raise Lower in binary 
mode (O) 

A=0, B=0, O=0%   

A=1, B=0, O= 40%  

A=0, B=1, O=100%  

A=1, B=1, O=70% 

0% 
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 Example 
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G06 Raise Lower 

 Application 

Control of raise lower valve through one analog point. 

 

 Function of module 

This macro allows control of a raise lower valve through one output on a uc16, uc12 or uc8. The macro is used with the raise 
lower module R/L 4. The input on the R/L 4 is set to raise lower mode through the jumper switch. The raise lower module 
takes the macro output and selects the correct digital output configuration. The following is the macro output:  

5. R=0, L=0, O=40%  

6. R=1, L=0, O=70%  

7. R=0, L=1, O=0%  

8. A=1, B=1, O=70%.  

If both raise and lower are on then raise takes precedence.  

 Number of Blocks 

3 

 Symbol 

 

 Variables 

Variable type Variable name Description Default values 

Digital Inputs Raise (R) Shows state of  input point Raise.   

Lower (L) Shows state of  input point Lower.   

Analog Outputs Output to Raise Lower in binary 
mode (O) 

R=0, L=0, O=40%  R=1, L=0, O= 70%  

R=0, L=1, O=0% R=1, L=1, O=70% 

0% 

 Example 
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G07 Sensor out of range alarm 

 Application 

Room temperature alarm. 

 

 Function of module 

This module provides an alarm indicating that the sensor is out of range with time delays and minimum on time. The sensor 
alarm limits are set through the lower and upper inputs. When the sensor input goes out of this range an alarm is generated 
after the associated time delays. The sensor has an on delay, off delay, minimum on time and alarm timer reset. The alarm 
priority and alarm number must be set before the alarm will function properly. Each alarm should have a unique alarm 
number in the controller. 

 Number of Blocks 

4 

 Symbol 
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 Variables 

Variable type Variable name Description Default values 

Analog Inputs Sensor Input (SE) Analog value from sensor.  

Lower Limit (LL) When sensor input is less than this 
value alarm output is set after time 
delays. 

 

Upper Limit (UL) When sensor input is greater than this 
value alarm output is set after time 
delays. 

 

On Delay (ON) Sensor input must be outside of range 
set by upper and lower limits for this 
time before alarm is generated. 

 

Off Delay (OF) Sensor input returns to range set by 
upper and lower limits for this time 
before alarm is condition is cleared. 

 

Minimum On Time (MI) Minimum time that alarm exists.  

Digital Input. Reset (RE) This input resets the alarm timer.  

Digital Outputs Alarm (AL) When module is in alarm condition., 
this value is set to on (1). Else value is 
off (0).  

Off (0) 

 

 Example 
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G08 Hysteresis with plus deadband 

 Application 

Heating enable based on room temperature. 

 

 Function of module 

This module provides a hysteresis loop with a plus deadband. When the sensor input falls below the setpoint the enable 
output is on. The enable output remains on until the sensor input rises by 2°C (default deadband value) above the setpoint. 
The enable then remains off until the sensor input falls below the setpoint value. 

 Number of Blocks 

4 

 Symbol 

 

 Variables 

Variable type Variable name Description Default values 

Analog Inputs Sensor Input (SE) Analog value from sensor.  

Sensor Setpoint (SP) Setpoint for sensor.  

Digital Outputs Enable (EN) When sensor input is less than setpoint 
enable turns on. Remains on until 
sensor is greater than the setpoint plus 
deadband.  

 

Parameters Plus Deadband  Sensor input must rise by this value 
above the setpoint before enable is set 
to off (this can be amended). 

2°C 
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 Example 
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G09 Hysteresis with minus deadband 

 Application 

Heating enable based on room temperature. 

 

 Function of module 

This module provides a hysteresis loop with a minus deadband. When the sensor input falls below the setpoint by 2°C 
(default deadband) the enable output is on. The enable output remains on until the sensor input rises above the setpoint. 
The enable then remains off until the sensor input falls below the setpoint minus deadband value. 

 

 Number of Blocks 

4 

 Symbol 

 

 Variables 

Variable type Variable name Description Default values 

Analog Inputs Sensor Input (SE) Analog value from sensor.  

Sensor Setpoint (SP) Setpoint for sensor.  

Digital Outputs Enable (EN) When sensor input is less than setpoint 
minus deadband enable turns on. 
Remains on until sensor is greater than 
the setpoint.  

 

Parameters Minus Deadband Sensor input must fall by this value 
below the setpoint before enable is set 
to on (this can be amended).  

2°C 
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 Example 
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G10 Hysteresis with plus and minus deadband 

 Application 

Heating enable based on room temperature. 

 

 Function of module 

This module provides a hysteresis loop with plus and minus deadbands. When the sensor input falls below the setpoint by 
1°C (default minus deadband) the enable output is on. The enable output remains on until the sensor input rises by 1°C 
(default plus deadband) above the setpoint. The enable then remains off until the sensor input falls below the setpoint 
minus deadband value. 

 Number of Blocks 

5 

 Symbol 

 

 Variables 

Variable type Variable name Description Default values 

Analog Inputs Sensor Input (SE) Analog value from sensor.  

Sensor Setpoint (SP) Setpoint for sensor.  

Digital Outputs Enable (EN) When sensor input is less than setpoint 
minus deadband enable turns on. Remains 
on until sensor is greater than the setpoint.  

 

Parameters Plus Deadband  Sensor input must rise by this value above 
the setpoint before enable is set to off.  

1°C 

Minus Deadband Sensor input must fall by this value below 
the setpoint before enable is set to on. This 
can be amended. 

1°C 
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 Example 
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G11 Heating enable optimum start/stop 

 Application 

Optimum start/stop of central plant equipment.  

 

 Function of module 

This module provides the optimum start/stop based on internal and external temperatures and building characteristics. The 
optimizer has two stages of operation. The first occurs when the learning factor is 5 or below. This equation is based on the 
initial building constants and is: 

 P=A(X-Y)+B  

where P is preheat time, X is target temperature, Y is current internal temperature, and A and B are building constants.  

The second stage uses a second order equation. Optimizer enable input defaults to on if the input is not attached to a point 
otherwise the optimizer only operates when the attached point is on. The module contains a time schedule block for each 
day. The time schedule set the building occupancy. All seven analog inputs must be connected for correct operation. The 
main output from this module is the optimum start or pump status point (PS). This point should be attached to the plant 
equipment that needs to be controlled. In addition to the other outputs which are explained in the variables section there is 
a time schedule (TS) point that connects to each time schedule block. This point is on during occupancy time.  

 Number of Blocks 

16 
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 Symbol 

 

 Variables 

Variable type Variable name Description Default 
values 

Analog Inputs Target Temperature (TT) Internal temp that should be reached at 
occupancy time. 

 

Target Cooldown Temp (TC) Minimum permissible internal temp when 
occupancy period ends. 

 

Outside Temp (OT) Measured value of the outside temperature.  

Internal Temp (IT) Measured value of the internal temperature.  

Flow Temp (FT) Measured value of the heating medium 
temperature.  

 

Condensation Setpoint (CP) The internal temperature at which 
condensation is expected. 

 

Max Preheat Period  (MP) Maximum permissible preheat period. A 
typical value is 80 minutes. 

 

Max Cooldown Period (MC) Maximum permissible cooldown period. A 
typical value is 80 minutes. 

 

Dead Time (DT) The length of time from start of heating until a 
response in Internal Temperature will be 
registered (minutes) 

 

Overlap Period(OP) The max. number of minutes that preheat is 
allowed to continue into the occupancy period, 
if the target temperature has not been reached 
by the start of occupancy (minutes) 

 

Digital Inputs Optimizer Enable (EN) Enables optimizer operation. defaults to on if 
point not connected otherwise point must be 
set on for operation. 

 

Analog Outputs Predicted Preheat Time (PT) Value predicted for preheat by module. 0 Minutes 

Learning Factor (LF) Each time the optimizer is reaches target temp 
and initial plant conditions are valid this point 
is incremented. Max = 255. 

0 

Predicted Cooldown Period (CT) Value predicted for cooldown by module. 0 Minutes 

Digital Outputs Optimum Start (PS) This point is SET after the optimum start/stop 
has been decided by the optimizer. 

0ff (0) 

Status Value (SV) This point is SET optimizer is within maximum 0ff (0) 
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Variable type Variable name Description Default 
values 

preheat period. 

Day Control (DC) This point is SET optimizer reverts to day 
control. Day control occurs when internal 
temperature exceeds target temp, current 
time > (occupancy time+ overlap period) and 
internal temp < cooldown target temp during 
cooldown. 

0ff (0) 

Condensation Protection (CP) Point becomes set when condensation 
protection is in operation. 

0ff (0) 

Preheat Period (PP) Point becomes set when optimizer switches to 
preheat mode. 

0ff (0) 

System Off (SO) Point becomes set when heating system is 
turned off. 

0ff (0) 

Error (ER) Point becomes set when the optimizer macro 
is not set up correctly. 

0ff (0) 

Time Clock (TS) This is used to provide the Heating Optimizer 
with seven Field Controller time schedules, 
which may be updated with a Comms 
Controller time schedule.  

 

Parameters Max. temp. for condensation 
protection 

Module will remain in condensation protection 
mode until internal temp. rises above this 
value. 

120 °C 

Min. temp. for condensation 
protection 

If plant is off and internal temp. falls below this 
value condensation protection mode until 
start. 

100 °C 

Min. Flow Temp. for adaptation The optimizer will only learn today’s heating 
characteristics if flow temp<this value at start 
of preheat, max. flow temp during 
preheat>max> flow temp for adaptation and 
condensation protection not in force. 

250 °C 

Max. Flow Temp. for adaptation See Min. flow temp for adaptation. 400 °C 

Max. Internal Temp. for preheat Internal temp. corresponding to that requiring 
maximum preheat period. 

120 °C 

Dead Time Time between start of preheat and change in 
internal temperature. Typical value is 9. 

0 Minutes 

Overlap Period Maximum time that preheat allowed to 
continue if internal temp has not reached 
target at start of occupancy. Typical value is 30. 

0 Minutes 

Initial Value A This building constant is used for first 4 good 
starts.  

50 

Initial Value B This building constant is used for first 4 good 
starts.  

50 

Time Clock (TS) This is used to provide the Heating Optimizer 
with seven Field Controller time schedules, 
which may be updated with a Comms 
Controller time schedule.  
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 Example 
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G13 Holiday Schedule 

 Application 

Holiday Schedules for UC16 time schedules. 

 

 Function of module 

This macro contains five holiday schedule blocks. If any of these are on then the output is also on. The macro may be used 
to make holiday programming easier. There are two outputs: the true output and the inverse of the true output  

 Number of Blocks 

6 

 Symbol 

 

 Variables 

Variable type Variable name Description Default values 

Digital Outputs Holiday On (0) On if any of the holiday outputs are on. Off (0) 

 Holiday Off (inv 0) Off when all of the holiday outputs are off. On (1) 

 Example 
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G14 Seven day schedule 

 Application 

Seven day time schedules. 

 

 Function of module 

This macro contains seven Field Controller Time Schedule blocks. If any of these are on then the output is also on. The macro 
may be used to make time schedule programming easier. There are two outputs: the true output and the inverse of the true 

output. The default “on“ times are Monday to Friday 08:00 … 17:00 and Saturday to Sunday 00:00 … 00:00.  

 Number of Blocks 

8 

 Symbol 

 

 Variables 

Variable type Variable name Description Default values 

Digital Outputs Time Schedule (0) On if any of the seven day schedules are 
on. 

 

 Time Schedule Off (inv 0) Off when all of the seven day outputs 
are off. 

On (1) 

 Example 
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G15 Pulse metering 

 

 Application 

Monitoring and logging electricity usage on daily and hourly basis. 

 

 Function of module 

This macro monitors and datalogs pulse meter values on both a daily and an hourly basis. The two macro inputs are; scalar 
and pulse input. The scalar is the multiplier used to convert the pulses into real units such as KWH. The hourly and daily 
totals update every five minutes. The outputs from this macro are the total number of pulses since servicing began and the 
last count value. This macro will typically be used for logging electricity or other pulse output meters.   

 Number of Blocks 

11 

 Symbol 

 

 Variables 

Variable type Variable name Description Default values 

Analog Inputs Scalar (SC) Converts pulse into real value.  

Pulse (PU) Pulse input from meter.  

Analog Outputs Total Count (TO) Total pulse count since macro started 
servicing. 

 

Last Count (LC) Pulse count for last period.  

Parameters Pulse period Time interval over which pulses are 
counted. 

300 Seconds 

Pulse Scalar Scalar applied to pulse by meter 
module. This value should not be 
changed. 

1 

 Example 
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Legacy Macros - Air Systems 

A01 Heating and cooling demand with deadband 

 Application 

Heating and cooling load calculation for air handling unit. 

 

  

 

 Function of module 

This macro calculates the combined heating and cooling load based on the process variable. The combined heating and 
cooling load is determined by subtracting the cooling load from the heating load. The output range is -100 to +100. The 
heating load is found by comparing the process variable with the heating setpoint using a PID loop. The cooling load is found 
by comparing the process variable with the cooling setpoint using a PID loop. The cooling setpoint is calculated by adding 
the deadband to the heating setpoint. The enable point must be set “on” for the macro to function, otherwise, the output 
will be 0. This macro may be used with A04 Heating valve, cooling valve and damper control from demand.  

 Number of Blocks 

9 

 

 Symbol 
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 Variables 

Variable type Variable name Description Default values 

Analog Inputs Process Variable (PV) Input point that is monitored. 0 °C 

Heating Setpoint (SP) The heating setpoint for the process 
variable. 

0 °C 

Deadband (DB) 0 C above heating setpoint when there 
is no cooling. 

0 °C 

Digital Inputs Enable (EN) Input must be on (1) for macro to 
calculate combined load.  

 

Analog Outputs Combined Heating and Cooling 
load (HC) 

Calculated combined heating and 
cooling load. Output range:     

 -100  full cooling    

 0  no heating or cooling  

 +100 full heating 

 

Parameters 

  

Heating Integral Time Integration time applied to heating. 0 seconds 

Heating Derivative Time Derivative time applied to heating. 0 seconds 

Cooling Gain Proportional Gain applied to cooling. 8 

Cooling Integral Time Integration time applied to cooling. 0 seconds 

Cooling Derivative Time Derivative time applied to cooling. 0 seconds 

Heating Gain Proportional gain applied to heating. 8 

 Example 
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A02 Heating demand  

 Application 

AHU with single stage heating. 

 

 

 Function of module 

This macro calculates the heating load based on the process variable. The output range is 0 to +100. The heating load is 
found by comparing the process variable with the heating setpoint using a PID loop. The heating PID gain is set at 8. The 
heating PID is enabled through the enable input. When the override input is on (1) the output is set at the override value of 
100%. The override replaces the PID loop output with the override value. The PID does not have to be enabled for this point 
to work. The override may be used for heating boost or frost protection. 

 Number of Blocks: 

3 

 

 

 Symbol 
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 Variables 

Variable type Variable name Description Default values 

Analog Inputs Process Variable (PV) Input point that is monitored. 0 °C 

Heating Setpoint (SP) The setpoint for the process variable. 0 °C 

Digital Inputs Override (OV) When override is on (1) the heating load 
output is 100% otherwise heating load 
takes the PID output. 

Off (0) 

Enable (EN) Input must be on (1) for macro to 
calculate heating load.  

Off (0) 

Analog Outputs Heating Valve (HV) Output value varies between 0% 
(closed) to 100% (open). 

0% 

Parameters Heating Gain Proportional gain applied to the heating 
valve. 

8 

Heating Integral Time Integration time applied to the heating 
valve. 

0 seconds 

Heating Derivative Time Derivative time applied to the heating 
valve. 

0 seconds 

Cooling Gain Proportional gain applied to the cooling 
valve. 

8 

Cooling Integral Time Integration time applied to the cooling 
valve. 

0 seconds 

Cooling Derivative Time Derivative time applied to the cooling 
valve. 

0 seconds 

 Example 
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A03 Cooling Demand 
 

 Application 

AHU single stage cooling. 

 

 Function of module 

This module provides PID control of a cooling valve based on the process variable. When the enable input point is off the 
cooling valve is closed. When the enable input is on and the override input is off the cooling valve is modulated to maintain 
the supply temperature setpoint. When the override input is on the cooling valve goes to the override position which 
defaults to open.  

 Number of Blocks: 

3 

 Symbol 

 

 Variables 

Variable type Variable name Description Default values 

Analog Inputs Process Variable (PV) Input point that is monitored. 0 C 

Cooling Setpoint (SP) The setpoint for the process variable. 0 C 

Digital Inputs Override (OV) If input is on (1) cooling valve is open 
(100%). 

Off (0) 

Enable (EN) This input must be on (1) for the 
module to work.  

Off (0) 

Analog Outputs Cooling Valve (CV) Output value varies from 0% (closed) to 
100% (open). 

0% 

Parameters Cooling Proportional Gain Proportional gain applied to the cooling 
valve. 

8 

Cooling Integral Time Integration time applied to the cooling 
valve. 

0 seconds 

Cooling Derivative Time Derivative time applied to the cooling 
valve. 

0 seconds 
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 Example 
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A04 Heating valve, cooling valve and damper control from demand 

 Application 

Dampers, heating and cooling valves for air handling unit. 

 

 Function of module 

This macro takes the heating-cooling load output from, for example, macro A01 Heating and cooling demand with 
deadband, and stages the heating valve, damper and cooling valve. The valid input range is from -100 to +100. All outputs 
are linear. The heating valve operating range is set from +30 (0% open) to +100 (100% open). The damper operating range is 
set from +30 (0% open) to -30 (100% open). The cooling valve operating range is set from -30 (0% open) to -100 (100% 
open). These values may be changed in the macro if desired. The heating valve is set to 100% when the heating override is 
enabled. The damper is set to 0% when the damper override is enabled. The cooling valve is set to 100% when the cooling 
override is enabled. The damper has a minimum position set through the minimum position input. When the minimum 
position is set to a value greater than 0% the input from the heating cooling load macro is rescaled to the range between 
this value and 100%. If the input is 0% and the minimum position is 15% the output to the dampers is 57.5% which is 50% of 

the 15 … 100 range. 

 Number of Blocks: 

13 

 Symbol 
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 Variables 

Variable type Variable name Description Default values 

Analog Inputs Heating Cooling load (HC) Calculated heating cooling load. Range 
is -100 to +100. 

0 

Minimum Damper Position (MD) Minimum output to the damper. 0 

Digital Inputs Heating Override (OH) When this value is set to on (1) heating 
valve is set at override position. 

Off (0) 

Cooling Override (OC) When this value is set to on (1) heating 
valve is set at 100%. 

Off (0) 

Damper Override (OD) When this value is set to on (1) damper 
is set at 0%. 

Off (0) 

Analog Outputs Heating Valve (HV) Heating valve output. Range is 0% 
(closed) to 100% (open). 

0% 

Cooling Valve (HV) Cooling valve output. Range is 0% 
(closed) to 100% (open). 

0% 

Damper (DA) Damper output. Range is 0% (closed) to 
100% (open). 

0% 

Parameters Heating Override Position When heating override (OH) is on (1) 
100% Heating Value (HV) is set to this 
position. 

100% 

Cooling Override Position When Cooling Override (OC) is on (1) 
Cooling Value (CV) is set to this position. 

100% 

Damper Override Position When Damper Override (OD) is on (1) 
damper (DA) is set to this position. 

0% 

 Example 
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A05 Heating and cooling valve control from demand 

 Application 

Heating and cooling valves for air handling unit. 

 

 Function of module 

This macro takes the heating-cooling load output from macro A01.0, for example, and stages the heating and cooling valves. 
The valid input range is from -100 to +100. All outputs are linear. The heating valve operating range is set from +1 (0% open) 
to +100 (100% open). The cooling valve operating range is set from 0 (0% open) to -100 (100% open). These values may be 
changed in the macro if desired. The heating valve is set to 100% when the heating override is enabled. The cooling valve is 
set to 100% when the cooling override is enabled, (these override values can be amended in the macro). 

 Number of Blocks 

8 

 Symbol 

 

 Variables 

Variable type Variable name Description Default values 

Analog Inputs Heating Cooling load (HC) Calculated heating cooling load. Range 
is -100 to +100. 

 

Digital Inputs Heating Override (HO) When this value is set to on (1) heating 
valve is set to override position. 

 

Cooling Override (CO) When this value is set to on (1) cooling 
valve is set to override position. 

 

Analog Outputs Heating Valve (HV) Heating valve output. Range is 0% 
(closed) to 100% (open). 

 

Cooling Valve (HV) Cooling valve output. Range is 0% 
(closed) to 100% (open). 

 

Parameters Heating Override Position When Heating Override (OH) is on (1) 
Heating Valve (HV) is set to this 
position. 

100% 

Cooling Override Position When Cooling Override (OC) is on (1) 
Cooling Valve (CV) is set to this position. 

100% 
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 Example 
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A06 Humidity control from one control sensor 

 Application 

Humidifier control. 

 

 

 Function of module 

This macro determines the humidifier load based on the control sensor humidity. The output range is 0 to +100. The 
humidity load is found by comparing the supply humidity with the humidity setpoint using a PID loop. The humidifier PID 
gain is set at 8. The integration time is set at 600 seconds. The humidifier is enabled when the supply humidity is less than 
the humidity setpoint and both E1 and E2 inputs are on (1). E1 and E2 may be tied to a time schedule and the supply fan 
status respectively. The macro provides a humidifier demand and humidifier enable. 

 Number of Blocks 

8 

 Symbol 

 

 Variables 

Variable type Variable name Description Default values 

Analog Inputs Supply Air Humidity (HU) Humidity of the supply air. % RH 

Supply Air Humidity Setpoint 
(HS) 

Humidity setpoint of the supply air. % RH 

Digital Inputs Enable 1 (E1) Both E1 and E2 must be on (1) to enable 
humidifier and PID.  

Off (0) 

Enable 2 (E2) Both E1 and E2 must be on (1) to enable 
humidifier and PID.  

Off (0) 

Analog Outputs Humidifier Valve (H) Humidifier valve output. Range is 0% 
(closed) to 100% (open). 

0% 

Digital Outputs Humidifier Enable (EN) – 
(optional) 

Output is on (1) when E1 and E2 are on 
and supply humidity is less than 
humidity setpoint. 

 

Parameters Humidifier Gain Gain of humidity PID. 8 

Humidifier Integration  Integration time of humidity PID. 600 seconds 

Humidifier Derivative  Derivative time of humidity PID. 0 seconds 

Humidifier on Timer Delay Humidifier enable on delay. 0 seconds 
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 Example 
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A07 Humidity control on return or room air with supply air limits 

 Application 

Humidifier control. 

 

 Function of module 

This macro finds the humidifier load based on the return humidity. The output range is 0 to +100. The supply humidity 
setpoint is calculated by comparing the return humidity with the room humidity setpoint using a PID loop. Upper and lower 
limits are applied to the calculated supply humidity setpoint. The resulting setpoint is then used to find the humidifier load. 
Both gains are set at 8. The integration times are set at 600 seconds. The humidifier is enabled when the supply humidity is 
less than the humidity setpoint and both E1 and E2 inputs are on (1). E1 and E2 may be tied to a time schedule and the 
supply fan status respectively. 

 Number of Blocks 

10 

 Symbol 
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 Variables 

Variable type Variable name Description Default values 

Analog Inputs Return Air Humidity Setpoint 
(HS) 

Humidity setpoint of the return air.  

Supply Air Humidity Low Limit 
(LL) 

Lowest setpoint for supply air humidity.  

Supply Air Humidity High Limit 
(HL) 

Highest setpoint for supply air humidity.  

Supply Air Humidity (SH) Humidity of the supply air.  

Return Air Humidity (RH) Humidity of the return air.  

Digital Inputs Enable 1 (E1) Both E1 and E2 must be on (1) to enable 
humidifier and PID. Should be tied to 
time schedule. 

 

Enable 2 (E2) Both E1 and E2 must be on (1) to enable 
humidifier and PID. Should be tied to 
time schedule. 

 

Analog Outputs Humidifier Valve (H) Humidifier valve output. Range is 0% 
(closed) to 100% (open). 

 

Digital Outputs Humidifier Enable (EN) Output is on (1) when E1 and E2 are on 
and supply humidity is less than 
humidity setpoint. 

 

Parameters 

  

Return Humidity Gain Gain of return humidity PID. 8 

Return Humidity Integration  Integration time of return humidity PID. 600 seconds 

Return Humidity Derivative  Derivative time of return humidity PID. 0 seconds 

Humidifier Gain Gain of humidity PID. 8 

Humidifier Integration  Integration time of humidity PID. 600 seconds 

Humidifier Derivative  Derivative time of humidity PID. 0 seconds 

Parameters Timer Enable Humidifier 

On delay – 0 seconds 

Off delay – 0 seconds 

 

 

 Example 
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A08 Humidity and dehumidification control on return or room air with supply air limits 

 Application 

Humidifier and dehumidifier control. 

 

 Function of module 

The supply humidity setpoint is calculated by comparing the return or room humidity with the humidity setpoint. The 
calculated supply humidifier setpoint has an upper limit. This high limit setpoint is used to control humidity output. The 
deadband is added to humidification setpoint to determine the dehumidification setpoint. The dehumidification demand is 
used as minimum output to cooling valve. The cooling load input should be calculated based on temperature. The macro 
A03 Cooling Demand may be used to find this value. All of the gains are set at 8. Integration times are 600 seconds. 
Humidification is enabled when the supply humidity is less than the humidity setpoint and both E1 and E2 are on. 

 Number of Blocks 

19 

 Symbol 
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 Variables 

Variable type Variable name Description Default values 

Analog Inputs Cooling Load (CL) Cooling requirement based on 
temperature. 

% 

Return Air Humidity Setpoint 
(HS) 

Humidity setpoint of the return air.  

Supply Air Humidity High Limit 
(HL) 

Highest setpoint for supply air humidity.  

Humidity Deadband (DB) Added to return air humidity setpoint to 
get dehumidification setpoint.  

 

Supply Air Humidity (SH) Humidity of the supply air.  

Return Air Humidity (RH) Humidity of the return air.  

Digital Inputs Enable 1 (E1) Both E1 and E2 must be on (1) to enable 
humidifier and PID. Should be tied to 
time schedule. 

 

Enable 2 (E2) Both E1 and E2 must be on (1) to enable 
humidifier and PID. Should be tied to 
time schedule. 

 

Analog Outputs Cooling Valve (CV) Output to cooling valve (0 … 100).  

Humidifier Valve (HV) Humidifier valve output. Range is 0% 
(closed) to 100% (open). 

 

Digital Outputs Humidifier Enable (EN) Output is on (1) when E1 and E2 are on 
and supply humidity is less than 
humidity setpoint. 

 

Parameters 

  

Return Humidity Gain Gain of return humidity PID. 8 

Return Humidity Integration  Integration time of return humidity PID. 600 seconds 

Return Humidity Derivative  Derivative time of return humidity PID. 0 seconds 

Dehumidification Gain Gain of Dehumidification PID. 8 

Dehumidification Integration  Integration time of Dehumidification 
PID. 

600 seconds 

Dehumidification Derivative  Derivative time of Dehumidification PID. 0 seconds 

Humidifier Gain Gain of humidity PID. 8 

Humidifier Integration  Integration time of humidity PID. 600 seconds 

Humidifier Derivative  Derivative time of humidity PID. 0 seconds 
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 Example    
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Legacy Macros - Wet Systems 

W01 Weather compensator with space influence 

 

 Application 

Heating reset from outside air temperature with space influence. 

 

 Function of module 

This module provides PID control of compensated heating valve. The valve compensation is reset on outside air 

temperature. The flow temperature setpoint(F1) is the flow setpoint when the outdoor air temperature is 20C. The flow 

temperature setpoint(F2) is the flow setpoint at 0C. The space influence is found by multiplying the difference between the 
space temperature and the space setpoint by the space influence gain. The space influence is added to both flow setpoints. 
The compensation setpoint limits are set in the macro. The PID is enabled through the enable input point. 

 Number of Blocks 

10 

 Symbol 
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 Variables 

Variable type Variable name Description Default values 

Analog Inputs Flow Temperature (FT) The temperature of the water supplied 
to the space. 

 

Flow  Setpoint at 20C (F1) The setpoint of the heating medium at 

20C Outdoor Temperature. 

 

Flow  Setpoint at 0C (F2) The setpoint of the heating medium at 

0C Outdoor Temperature. 

 

Outdoor Air Temperature (OT) The temperature of the outdoor air.  

Room Setpoint (SP) The setpoint of the space air 
temperature. 

 

Room Temperature (RT) The air temperature of the space.  

Digital Inputs Enable (En) This input must be set to on (1) for the 
module to function.  

 

Analog Outputs Compensated Valve (HV) The output to the compensated valve. 
Valid range is between 0 and 100%.  

 

Compensated Setpoint (CS) The calculated compensated setpoint.  

Parameters Minimum Compensated Setpoint Minimum value for the compensated 
setpoint. 

20C 

Maximum Compensated 
Setpoint 

Maximum value for the compensated 
setpoint. 

82C 

Room Influence Gain Gain value for room influence. 5 

Integration Time Integration time for PID loop. 600 seconds 

Derivative Time Derivative time for PID loop. 0 seconds 

Gain Gain value for PID loop. 8 

 Example 

 

 

 

W02 Weather compensator with space influence and night setback 

 Application 

Heating reset from outside air temperature with space influence and night setback. 
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 Function of module 

This module provides PID control of compensated heating valve. The valve compensation is reset on outside air 

temperature. The flow temperature setpoint (F1) is the flow setpoint when the outdoor air temperature is 20C. The flow 

temperature setpoint (F2) is the flow setpoint at 0C. The space influence is found by multiplying the difference between 
the space temperature and the space setpoint by the space influence gain. The space influence is added to both flow 
setpoints. The compensation setpoint limits are set in the macro. The PID is enabled through the enable input point. When 
the night setback input is on the macro uses the setback setpoint instead of the room setpoint. 

 Number of Blocks 

11 

 Symbol 
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 Variables 

Variable type Variable name Description Default values 

Analog Inputs Flow  Temperature (FT) The temperature of the water supplied 
to the space. 

 

Flow  Setpoint at 20C (F1) The setpoint of the heating medium at 

20C Outdoor Temperature. 

 

Flow Setpoint at 0C (F2) The setpoint of the heating medium at 

0C Outdoor Temperature. 

 

Outdoor Air Temperature (OT) The temperature of the outdoor air.  

Setback (SB) The setpoint of the space air 
temperature when night setback is on. 

 

Room Setpoint (SP) The setpoint of the space air 
temperature when night setback is off. 

 

Room Temperature (RT) The air temperature of the space.  

Digital Inputs Night Setback (NS) When set to on macro uses setback 
input as the room setpoint else 
occupied setpoint is used. 

 

Enable (En) This input must be set to on (1) for the 
module to function.  

 

Analog Outputs Compensated Valve (HV) The output to the compensated valve. 
Valid range is between 0 and 100%.  

 

Compensated Setpoint (CS) The calculated compensated setpoint.  

Parameters Minimum Compensated Setpoint Minimum value for the compensated 
setpoint. 

20C 

Maximum Compensated 
Setpoint 

Maximum value for the compensated 
setpoint. 

82C 

Room Influence Gain Gain value for room influence. 5 

Integration Time Integration time for PID loop. 600 seconds 

Derivative Time Derivative time for PID loop. 0 seconds 

Gain Gain value for PID loop. 8 

 Example 
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W03 First and second stage frost logic 

 

 Application 

Frost protection of plant equipment and condensation protection. 

 

 

 Function of module 

This macro provides first and second stage frost logic protection for heating circuits. When the outdoor air temperature is 
less than the setpoint stage 1 is enabled. The output remains enabled until the outdoor air temperature rises above the 

setpoint by 2C. The second stage frost is only enabled when the first stage has been enabled and the boiler return 

temperature falls below 15C. The second stage turns off when the boiler return temperature rises above 30C.  

 Number of Blocks 

5 

 Symbol 
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 Variables 

Variable type Variable name Description Default values 

Analog Inputs Outdoor Air Temperature (OT) The temperature of the outdoor air.  

Stage One On Temperature (O1) The point below which first stage 
enable will occur. 

 

Boiler Return Temperature (RT) The temperature of the water returning 
to the boiler. 

 

Stage Two On Setpoint (R1) The temperature at which the second 
stage enable will occur. 

 

Digital Outputs First Stage Enable (S1) When module selects First Stage Enable 
as desired output, this value is set to on. 
Otherwise value is off.  

Off (0) 

Second Stage Enable (S2) When module selects Second Stage 
Enable as desired output, this value is 
set to on. Otherwise value is off. First 
stage must be enabled before second 
stage will be enabled. 

Off (0) 

Parameters Outdoor air deadband The first stage output turns on when 
the outdoor air temperature is less than 
this value and module is enabled. 

2C 

Boiler Return deadband The second stage output turns on when 
first stage is on and boiler return 
temperature is less than this value. 

10C 

 Example 
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W04 Two-Boiler sequence with weekly rotation 

 

 Application 

Boiler sequencing and control. 

 

 Function of module 

This macro provides control of two boilers with duty sharing. The lead boiler is rotated every week. The macro finds the 
heating load based on the supply setpoint when the PID is enabled. If the heating load is greater than 25% then the lead 
boiler is selected. The setting for the lag boiler is 99%. The boilers have an on delay of 60 seconds. 

 Number of Blocks 

27 

 Symbol 
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 Variables 

Variable type Variable name Description Default values 

Analog Inputs Boiler Sequence Setpoint (SP) Setpoint of the boilers.  

 Boiler Sequence Temperature 
(PV) 

Temperature of the boiler.  

Digital Inputs Changeover (CO) Weekly flag allowing lead and lag 
boilers to be rotated. 

0 

 Enable (EN) Should be joined to time schedule. 
Boilers and pumps are disabled when 
value is 0ff 

Off (0) 

Digital Outputs Boiler 1 (B1) Output is on (1) when boiler 1 is 
selected as desired output. 

Off (0) 

 Boiler 2 (B2) Output is on (1) when boiler 2 is 
selected as desired output. 

Off (0) 

Parameters Lead enable  Heating load >  value to enable lead 
boiler. 

25 

 Lag enable  Heating load >  value to enable lag 
boiler. 

99 

 Boiler 1 on delay Time delay before boiler 1 is set on. 60 seconds 

 Boiler 2 on delay Time delay before boiler 2 is set on. 60 seconds 

 Example 
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W05 Two-Boiler sequence with high/low fire and weekly rotation 

 Application 

Boiler sequencing and control. 

 

 Function of module 

This macro provides control of two boilers with duty sharing. The lead boiler is rotated every week. The macro finds the 
heating load based on the supply setpoint when the PID is enabled. The lead boiler is selected when the load is less than 

50%. When the load reaches 25% of the 0 … 50% range i.e. 12.5% the low fire setting on the lead is enabled. When the load 

reaches 99% of the 0 … 50% range the high fire setting on the lead is enabled. The lag boiler is selected when the load is 

greater than 50%. When the load reaches 25% of the 50 … 100% range the low fire setting on the lag is enabled. When the 

load reaches 99% of the 50 … 100% range the high fire setting on the lag is enabled. The boilers have an on delay of 60 
seconds. 

 Number of Blocks 

34 

 Symbol 
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 Variables 

Variable type Variable name Description Default values 

Analog Inputs Boiler Sequence Setpoint (SP) Setpoint of the boilers.  

Boiler Sequence Temperature 
(PV) 

Temperature of the boilers.  

Digital Inputs Changeover (CO) Weekly flag allowing lead and lag 
boilers to be rotated. 

0 

Enable (EN) Should be joined to time schedule. 
Boilers and pumps are disabled when 
value is 0ff 

Off (0). 

Digital Outputs Boiler 1 Low Fire (L1) Output is on (1) when boiler 1 low fire is 
selected as desired output. 

Off (0). 

Boiler 1 High Fire (H1) Output is on (1) when boiler 1 high fire 
is selected as desired output. 

Off (0). 

Boiler 2 Low Fire (L2) Output is on (1) when boiler 2 low fire is 
selected as desired output. 

Off (0). 

Boiler 2 High Fire (H2) Output is on (1) when boiler 2 high fire 
is selected as desired output. 

Off (0). 

Parameters Lead enable  Heating load > value to enable lead 
boiler. 

25 

Lag enable  Heating load > value to enable lag 
boiler. 

99 

Boiler 1 low fire on delay Time delay before boiler 1 low fire is set 
on. 

30 seconds 

Boiler 1 high fire on delay Time delay before boiler 1 high fire is 
set on. 

60 seconds 

Boiler 2 low fire on delay Time delay before boiler 2 low fire is set 
on. 

30 seconds 

Boiler 2 high fire on delay Time delay before boiler 2 high fire is 
set on. 

60 seconds 

 Example 

 

W06 Three-Boiler sequence with weekly rotation 
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 Application 

Boiler sequencing and control. 

 

 

 Function of module 

This macro provides control of three boilers with duty sharing. The lead boiler is rotated every week. The macro finds the 
heating load based on the supply setpoint when the PID is enabled. If the heating load is greater than 33% then the lead 
boiler is selected. The setting for the lag boiler is 66%. The setting for the lag-lag boiler is 99%. The boiler sequence is 1-2-3, 
2-3-1, 3-1-2. The boilers have an on delay of 60 seconds. 

 Number of Blocks 

 

35 

 Symbol 
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 Variables 

Variable type Variable name Description Default values 

Analog Inputs Boiler Sequence Setpoint (SP) Setpoint of the boilers.  

Boiler Sequence Temperature 
(RT) 

Temperature of the boilers.  

Digital Inputs Changeover (CO) Weekly flag allowing lead and lag 
boilers to be rotated. 

0 

Enable (EN) Should be joined to time schedule. 
Boilers and pumps are disabled when 
value is 0ff 

Off (0) 

Digital Outputs Boiler 1 (B1) Output is on (1) when boiler 1 is 
selected as desired output. 

Off (0) 

Boiler 2 (B2) Output is on (1) when boiler 2 is 
selected as desired output. 

Off (0) 

Boiler 3 (B3) Output is on (1) when boiler 3 is 
selected as desired output. 

Off (0) 

Parameters Lead enable  Heating load >  value to enable lead 
boiler. 

33 

Lag enable Heating load >  value to enable lag 
boiler. 

66 

Lag-Lag enable  Heating load >  value to enable lag-lag 
boiler. 

99 

Boiler 1 on delay Time delay before boiler 1 is set on. 60 seconds 

Boiler 2 on delay Time delay before boiler 2 is set on. 60 seconds 

Boiler 3 on delay Time delay before boiler 3 is set on. 60 seconds 

 Example 
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W07 First, second and third stage frost logic 

 Application 

 

 Function of module 

This macro provides first, second and third stage frost logic protection for heating circuits. When the outdoor air 
temperature is less than the setpoint stage 1 is enabled. The output remains enabled until the outdoor air temperature rises 

2C above the setpoint. The second stage frost is only enabled when the first stage has been enabled and the boiler return 

temperature falls below 15C. The second stage turns off when the boiler return temperature rises above 30C. When any 

of the room temperatures falls below 10C the third stage is enabled. The third stage operates independently from stages 1 
and 2. 

 

 

 Number of Blocks 

11 

 Symbol 
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Variables 

Variable type Variable name Description Default values 

Analog Inputs Outdoor Air Temperature (OT) The temperature of the outdoor air.  

Stage One Setpoint (O1) Setpoint which, when passed, enables 
first stage. 

 

Boiler Return  Temperature (RT) The temperature of the water returning 
to the boiler. 

 

Stage Two On Setpoint (R1) Setpoint which, when passed, enables 
second stage. 

 

Room Temperature (ST) The temperature of the room.  

Stage Three On Setpoint (S1) Setpoint which, when passed, enables 
third stage. 

 

Digital Outputs First Stage Enable (S1) When module selects First Stage Enable 
as desired output, this value is set to on. 
Otherwise value is off.  

Off (0) 

Second Stage Enable (S2) When module selects Second Stage 
Enable as desired output, this value is 
set to on. Otherwise value is off.   

Off (0) 

Third Stage Enable (S3) When module selects Third Stage 
Enable as desired output, this value is 
set to on. Otherwise value is off.   

Off (0) 

Parameters Outdoor air temperature ON 
value 

The first stage output turns on when 
the outdoor air temperature is less than 
this value and module is enabled. 

2C 

Boiler Return temperature ON 
value 

The second stage output turns on when 
first stage is on and boiler return 
temperature is less than this value. 

15C 

Room temperature ON value The third stage Output turns on when 
minimum room temperature is less than 
this value. 

10C 

 Example 

 

 



 
 

 

SECTION 32 :  APPENDIX :: SAMPLE 
APPLICATIONS 
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Introduction 

What is the Sample Applications Library? 
Cylon provides a library of pre-written Sample Applications that can be used to build a Site with the minimum effort. This 

Sample Application Library consists of pre-made strategies representing standard real-world use cases. Each Sample 
Application can be used as it is, by copying its content into a controller or controllers on your site. The documentation in this 
index can then be copied verbatim to create user documentation for the site. The following Sample Applications are included: 

Sample Application Page 

Wet Systems 
1.1.1.1 Single pump weekly changeover with DPS monitoring 811 
1.1.1.2 Single Pump Weekly Changeover with Trip Monitoring 813 
1.1.1.3 Single Pump Weekly Changeover with Pressure Control 815 
1.1.1.4 Twin Pump Weekly Changeover with DPS Monitoring 818 
1.1.1.5 Twin Pump Weekly Changeover with Trip Monitoring 821 
1.1.1.6 Twin pump weekly changeover with pressure control 824 
1.1.2.1 VT Single pump weekly changeover with DPS monitoring 827 
1.1.2.2 VT Single pump weekly changeover with trip monitoring 830 
1.1.2.3 VT Single pump weekly changeover with pressure control 833 
1.1.2.4 VT Twin pump weekly changeover with DPS monitoring 836 
1.1.2.5 VT Twin pump Weekly Changeover with Trip Monitoring 839 
1.1.2.6 VT Twin pump Weekly Changeover with Pressure Control 842 
1.1.3.1 Four-Boiler On/Off Sequence Control 845 
1.1.3.2 Four-Boiler Modulating Sequence Control 847 
1.1.3.3 Two-Boiler High/Low Fire 849 
1.1.3.4 Four-Boiler On/Off Sequence Control with External shunt pump 851 
1.1.3.5 Four-Boiler Modulating Sequence Control with External shunt pump 854 
1.1.3.6 Four-Boiler Hi/Lo Sequence Control with External Shunt Pump 857 
1.1.3.7 Four-Boiler Modulating Parallel Control 860 
1.1.4.1 HWS with On-Off control 862 
1.1.4.2 HWS control with circulation pump 864 
1.1.4.3 HWS control with circulation and de-stratification pump 867 
1.1.4.4 HWS control with circulation pump and Legionella prevention 870 
1.1.5.1 Two-Chiller On/Off Sequence Control 873 
1.1.5.2 Two-Chiller Modulating Sequence Control 875 
1.1.5.3 Two-Chiller On/Off Sequence Control with Shunt pump 877 
1.1.5.4 Two-Chiller Modulating Control with shunt pump 880 
1.1.6.1 Four Stage DX Cool Only Sequence Control 883 
1.1.6.2 Four Stage DX Cool Heat Sequence Control 885 

AHU 
2.1.1.1 AHU with Heating, Cooling and Full Fresh Air 887 
2.1.1.2 AHU with Heating, Cooling and Dampers 890 
2.1.1.3 AHU with Heating, Cooling and Thermal Wheel 893 
2.1.1.4 AHU with Heating, Cooling, Full Fresh Air and Humidity 896 
2.1.1.5 AHU with Frost, Heating, Cooling and Full Fresh Air 899 
2.1.1.6 AHU with Frost, Heating, Cooling and Dampers 902 
2.1.1.7 AHU with Frost, Heating, Cooling and Thermal Wheel 905 
2.1.1.8 AHU with Frost, Heating, Cooling, Full Fresh Air and Humidity 908 
2.1.1.9 AHU with Frost, Heating, Cooling and Dampers 912 

 

DISCLAIMER: The Cylon Controls/American Auto-Matrix sample applications and macros are provided by Cylon Controls/American Auto-Matrix "as is" without warranties or 
conditions of any kind for sole use in programming the Cylon/American Auto-Matrix products for HVAC applications. Cylon Controls/American Auto-Matrix reserves the 
right to make changes to the software without notification. Every effort has been made to provide accurate functionality however no representations or warranties of 
any kind are made concerning the safety, suitability, lack of viruses, inaccuracies, typographical errors, or other harmful components of the sample applications and 
macros. There are inherent dangers in the use of any software, and you are solely responsible for determining whether the Cylon Controls/American Auto-Matrix sample 
applications and macros are compatible with your equipment and other software installed on your equipment. You assume the entire responsibility for quality and 
performance of the applications and are solely responsible for the protection of your equipment and backup of your data.  Cylon Controls/American Auto-Matrix will not 
be liable for any damages you may suffer in connection with using, modifying, or distributing the Cylon Controls/American Auto-Matrix sample applications and macros.   

Note:  Each of the Sample Applications has certain points that are exposed on the BACnet system. In some Sample 
Applications, there are additional points that are available to be exposed manually if required for specific 
implementations. 

  



 

 
 

MAN00058US rev 69 © American Auto-Matrix 809 

Strategy vs Macro vs Application 

 

The Cylon Engineering Centre allows any custom strategy to be created by connecting modules. 

 

However, to save time it is possible to group elements of a strategy into a Macro so that their combined functionality can be 
easily reused: 

 

When strategy modules – and, if appropriate, macros- are combined, they provide the functionality required for a real-
world Application such as AHU control, or Twin Pump with weekly changeover.  
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How to use CEC Sample Applications 

The Sample Applications can be found in the CEC Site Tree, where there is a pre-installed site containing a controller for each 
Sample Application. 

Each Sample Application is a pre-engineered strategy, based around one or more Macros whose internal settings can be 
adjusted for specific installations. The strategies can be copied as required to controllers on the user’s site, and adjusted if 
required for the specific needs of that site. This document also contains boilerplate text specific to each Sample Application 
that can be copied into user documentation. 

There is a section in this document for each Sample Application, and each section is in two parts:  

1. The first part gives a summary of the Sample Application, lists any Macros used and shows the preset values 

of the each Macro’s internal settings. 

2. The second part is a generic description of the Sample Application that can be copied into customer-facing 

documentation. 

 

If one of the Sample Applications described in this appendix provides functionality that matches or is close to the required 
functionality for a controller on your Site: 

1. Find the corresponding Controller on the preinstalled Sample Applications Site in the CEC.  

2. Copy the Strategy from the Controller into the Controller you are configuring on your own Site. 

3. Adjust the Sample Application if required, by changing the options in any Macros listed in the corresponding 

subsection of this appendix. 

4. Copy the text of the subsection (excluding the first page) into the site description document for your 

own Site, if required. 
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Wet Systems  

1.1.1.1 Single pump weekly changeover with DPS monitoring 

Summary 

This Sample Application will control a single pump, using a DPS (Differential Pressure Switch) to monitor the flow. If no flow is 
detected an alarm will be raised at the Supervisor but the pump will remain enabled. When the pump has run for 5,000 hours 
a Maintenance alarm will be raised at the supervisor.  

An override is available with 2 modes: enable and system override.  

 The enable override will override the system enable and leave all safely actions enabled.  

 The system override will override the system enable and ignore all safety interlocks.  

It is recommended that the End User has access only to the enable override.  

 

Number of Strategy blocks used   70 

 

 

This Sample Application uses the following macros: 

 Macro: SINGLE PLANT CONTROL 

Option Value Comment 

Fault Select 1 DPS 

DPS Fault Monitor 0 Run Only 

Stop on Fault 1 No - Run 

Fault Monitor Delay 20 Seconds 

Fault Delay 10 Seconds 

Maintenance  Limit 5000 Hours 

Run on time 600 Seconds 

A System Description for any system based on this Sample Application is given on the following page. 
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Single pump weekly changeover with DPS monitoring 

 System overview 

The pump system consists of the following plant: 

 Single pump with DOL (Direct On Line) starter. 

 DPS (Differential Pressure Switch) across the pump. 

The pump will be enabled on demand. 

 System control 

The system will be enabled when any plant requiring CT (Constant Temperature) water calls for it.  

The system will be disabled when no plant requires CT water. 
When the system is enabled any faults will be reset and the pump will be enabled. 

 When the system is disabled the pump control will be disabled. 

 Pump System Control 

When the system is enabled any faults will be reset and the pump will be started.  

After the pump has run for 20 seconds the system will monitor the differential pressure across the pump and if no flow is 
detected for a period of 10 seconds the pump will be deemed to be in fault.  

This fault will be latched until reset by either the operator or a system restart.  

A general alarm will then be raised, indicating that the pump is in fault.  

When the system is disabled the pump will continue to run for 10 minutes to dissipate any residual heat left in the system, 
and then the pump will be stopped. 

 System reset 

The system can be reset via the supervisor. This will clear all latched faults. If the system is enabled and is in fault, the system 
will be restarted as described in System Control.  

 Pump frost protection 

If the pump is not enabled and either a Frost Level 1 or a Frost Level 2 is initiated, then the pump control will be enabled. This 
will remain enabled until all frost states are cleared. 

 Hours run 

The system will log the ‘hours run’ for the pump. When the pump has a logged run time of 5,000 hours (user adjustable) a 
Maintenance alarm will be raised. After the pump has been serviced, the alarm can be reset via the supervisor. 

 Override  

The system can be overridden Off or On via the supervisor. If overridden Off the system will ignore all demands to run. If 
overridden On the system will run, but any safety interlocks will remain active. 

 Fire 

If a Fire alarm is detected, the pump will be stopped. When the Fire alarm has cleared the pump will then restart as per the 
system run, if required.  
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1.1.1.2 Single Pump Weekly Changeover with Trip Monitoring 

Summary 

This Sample Application will control a single pump. The system will monitor the Trip of the pump starter and if a Trip is 
detected, an alarm will be raised at the Supervisor and the pump will be disabled. The pump will remain disabled until the 
alarm is reset by the operator at the Supervisor or the Enable signal goes off. When the pump has run for 5,000 hours a 
Maintenance alarm will be raised at the Supervisor.  

An override is available with 2 modes: enable and system override.  

 The enable override will override the system enable and leave all safely actions enabled.  

 The system override will override the system enable and ignore all safety interlocks.  

It is recommended that the End User only has access to the enable override.  

 

Number of Strategy blocks used   70 

 

This Sample Application uses the following macros: 

 Macro: SINGLE PLANT CONTROL 

Option Value Comment 

Fault Select 2 Trip 

DPS Fault Monitor 0 Run Only 

Stop on Fault 0 Yes 

Fault Monitor Delay 20 Seconds 

Fault Delay 10 Seconds 

Maintenance Limit 5000 Hours 

Run on time 600 Seconds 

 
 

 

 

A System Description for any system based on this Sample Application is given on the following page. 
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Single Pump Weekly Changeover with Trip Monitoring 

 System overview 

The pump system consists of the following plant: 

 Single pump with DOL (Direct On Line) starter with trip contact. 

The pump will be enabled on demand. 

 System control 

The system will be enabled when any plant requiring CT (Constant Temperature) water calls for it.  

The system will be disabled when no plant requires CT water. 
When the system is enabled any faults will be reset and the pump will be enabled. 

 When the system is disabled the pump control will be disabled. 

 Pump System Control 

When the system is enabled any faults will be reset and the pump will be started.  

After the pump has run for 20 seconds the system will monitor the differential pressure across the pump and if no flow is 
detected for a period of 10 seconds the pump will be deemed to be in fault.  

This fault will be latched until reset by either the operator or a system restart.  

A general alarm will then be raised, indicating that the pump is in fault.  

When the system is disabled the pump will continue to run for 10 minutes to dissipate any residual heat left in the system, 
and then the pump will be stopped. 

 Pump reset 

The pump can be reset via the supervisor. This will clear all latched faults. If the system is enabled and is in fault, the system 
will be restarted as described in System Control.  

 Pump frost protection 

If the pump is not enabled and either a Frost Level 1 or a Frost Level 2 is initiated, then the pump control will be enabled. This 
will remain enabled until all frost states are cleared. 

 Hours run 

The system will log the ‘hours run’ for the pump. When the pump has a logged run time of 5,000 hours (user adjustable) a 
Maintenance alarm will be raised. After the pump has been serviced, the alarm can be reset via the supervisor. 

 Override  

The system can be overridden Off or On via the supervisor. If overridden Off the system will ignore all demands to run. If 

overridden On the system will run, but any safety interlocks will remain active. 

 Fire 

If a Fire alarm is detected, the pump will be stopped. When the Fire alarm has cleared the pump will then restart as per the 
system run, if required.  
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1.1.1.3 Single Pump Weekly Changeover with Pressure Control 

Summary 

This Sample Application will control a single pump with a pressure control. If the pressure deviates from the setpoint by 10% 
while the system is running, then an alarm will be raised at the supervisor and the pump will remain disabled.  

When the pump has run for 5,000 hours a Maintenance alarm will be raised at the Supervisor.  

An override is available with 2 modes: enable and system override.  

 The enable override will override the system enable and leave all safely actions enabled.  

 The system override will override the system enable and ignore all safety interlocks.  

It is recommended that the End User only has access to the enable override.  

 

Number of Strategy blocks used   71 

 

This Sample Application uses the following macros: 

 Macro: SINGLE PLANT CONTROL 

Option Value Comment 

Fault Select 4 Pressure Mismatch 

DPS Fault Monitor 0 Run Only 

Stop on Fault 0 Yes  

Fault Monitor Delay 20 Seconds 

Fault Delay 10 Seconds 

Max Pressure Error 100 Pa 

 0.01 psi 

Start Delay 10 Seconds 

Maintenance Limit 5000 Hours 

Run On Time 600 Seconds 

 
 

 

 

A System Description for any system based on this Sample Application is given on the following page. 
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Fixed Speed Weekly changeover with Pressure Control 

 System overview 

The pump system consists of the following plant: 

 Single pump with DOL (Direct On Line) starter. 

 Pressure sensor across the flow and return. 

The pump will be enabled on demand. 

 

 System control 

The system will be enabled when any plant requiring CT (Constant Temperature) water calls for it.  

The system will be disabled when no plant requires CT water. 
When the system is enabled any faults will be reset and the pump will be enabled. 

 When the system is disabled the pump control will be disabled. 

 

 Pump System Control 

When the system is enabled any faults will be reset and the pump will be started.  

After the pump has run for 20 seconds the system will monitor the differential pressure across the pump and if no flow is 
detected for a period of 10 seconds the pump will be deemed to be in fault.  

This fault will be latched until reset by either the operator or a system restart.  

A general alarm will then be raised, indicating that the pump is in fault.  

When the system is disabled the pump will continue to run for 10 minutes to dissipate any residual heat left in the system, 
and then the pump will be stopped. 

 

 Pressure control 

When the pressure control is enabled it will ramp up the speed of the pump to achieve the required system pressure. The 
rate of change of the output will be limited to 3.3 % per second for the initial 30 seconds of start-up. The pressure control 
will then modulate the speed of the pump to maintain the required system pressure.  

If the pressure sensor deviates from the required pressure setpoint by ±100pa for 10 seconds, then the pump will be 
deemed as failed and a pressure field alarm will be raised at the supervisor. 

 

 System reset 

The system can be reset via the supervisor. This will clear all latched faults. If the system is enabled and is in fault, the system 
will be restarted as described in System Control.  

 

 Pump frost protection 

If the pump is not enabled and either a Frost Level 1 or a Frost Level 2 is initiated, then the pump control will be enabled. This 
will remain enabled until all frost states are cleared. 

 

 Hours run 

The system will log the ‘hours run’ for the pump. When the pump has a logged run time of 5,000 hours (user adjustable) a 
Maintenance alarm will be raised. After the pump has been serviced, the alarm can be reset via the supervisor. 
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 Override  

The system can be overridden Off or On via the supervisor. If overridden Off the system will ignore all demands to run. If 

overridden On the system will run, but any safety interlocks will remain active. 

 

 Fire 

If a Fire alarm is detected, the pump will be stopped. When the Fire alarm has cleared the pump will then restart as per the 
system run, if required.  
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1.1.1.4 Twin Pump Weekly Changeover with DPS Monitoring 

Summary 

This Sample Application will control a twin pump set with a DPS to monitor the flow. It is suitable for either common DPS 
(Differential Pressure Switch) monitoring the two pumps or a DPS across each pump. If a common DPS is used, it must be 

connected to both DP1  and DP2  of the Macro.  

If no flow is detected, an alarm will be raised at the supervisor and then the standby pump will be started. If no flow is 
detected when the standby pump is enabled, a system failed alarm will be raised at the supervisor and the standby pump will 
remain enabled.  

When a pump has run for 5,000 hours a Maintenance alarm will be raised at the supervisor.  

An override is available with 2 modes: enable and system override.  

 The enable override will override the system enable and leave all safely actions enabled.  

 The system override will override the system enable and ignore all safety interlocks.  

It is recommended that the End User only has access to the enable override.  

The designation of “lead” pump and “standby” pump will be changed at 2:00am on Sunday.  

 

Number of Strategy blocks used   162 

 

This Sample Application uses the following macros: 

 Macro: TWIN PLANT CONTROL 

Option Value Comment 

Fault Select 1 DPS 

DPS Fault Monitor 0 Run Only 

Stop on Fault 1 No – Standby Run 

Fault Monitor Delay 20 Seconds 

Fault Delay 5 Seconds 

Start Delay 10 Seconds 

Runtime Limit 5000 Hours 

Run on time 600 Seconds 

Lead Pump Changeover 0 Time of Day 

TimeOfDay (Day) 

(Hour) 

Sun 

2 

Only Sunday checked 

Hours 

Hours Run Changeover 0 Hours 

Min Off Delay 120 Seconds 

 
A System Description for any system based on this Sample Application is given on the following pages. 
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Twin Pump Weekly Changeover with DPS Monitoring 

 System overview 

The pump system consists of the following plant: 

 Two pumps with DOL (Direct On Line) starters. 

 Two DPS (Differential Pressure Switches) one across each pump. 

The pumps will be enabled on demand. 

The pumps will operate in a duty-standby sequence with the lead pump changing each week.  

 

 System control 

The system will be enabled when any plant requiring CT (Constant Temperature) water calls for it.  

The system will be disabled when no plant requires CT water. 
When the system is enabled any faults will be reset and the pump will be enabled. 

 When the system is disabled the pump control will be disabled. 

 

 Pump System Control 

When the system is enabled any faults will be reset and the pump will be started.  

After the pump has run for 20 seconds the system will monitor the differential pressure across the pump and if no flow is 
detected for a period of 10 seconds the pump will be deemed to be in fault.  

This fault will be latched until reset by either the operator or a system restart.  

A general alarm will then be raised, indicating that the pump is in fault.  

When the system is disabled the pump will continue to run for 10 minutes to dissipate any residual heat left in the system, 
and then the pump will be stopped. 

 

 Pump rotation 

The lead pump will be automatically rotated at 2:00am on Sunday morning. The operator will also have the following 
options via the supervisor: 

1. To fix the lead pump disabling the automatic rotation. 

2. To fix the running pump and disable the other pump. 

 

 System reset 

The system can be reset via the supervisor. This will clear all latched faults. If the system is enabled and is in fault, the system 
will be restarted as described in System Control.  

 

 Pump frost protection 

If the pump is not enabled and either a Frost Level 1 or a Frost Level 2 is initiated, then the pump control will be enabled. This 
will remain enabled until all frost states are cleared. 

 

 Hours run 

The system will log the ‘hours run’ for the pump. When the pump has a logged run time of 5,000 hours (user adjustable) a 
Maintenance alarm will be raised. After the pump has been serviced, the alarm can be reset via the supervisor. 
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 Override  

The system can be overridden Off or On via the supervisor. If overridden Off the system will ignore all demands to run. If 

overridden On the system will run, but any safety interlocks will remain active. 

 

 Fire 

If a Fire alarm is detected, the pump will be stopped. When the Fire alarm has cleared the pump will then restart as per the 
system run, if required.  
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1.1.1.5 Twin Pump Weekly Changeover with Trip Monitoring 

Summary 

This Sample Application will control a twin pump set monitoring the pump trips.  

If a trip is detected on the lead an alarm will be raised at the Supervisor, the lead pump with be stopped and the standby 
pump will be started. 

If a trip is detected when the standby pump is enabled, a system failed alarm will be raised at the supervisor and the standby 
pump will be disabled. When a pump has run for 5,000 hours a Maintenance alarm will be raised at the supervisor.  

An override is available with 2 modes: enable and system override.  

 The enable override will override the system enable and leave all safely actions enabled.  

 The system override will override the system enable and ignore all safety interlocks.  

It is recommended that the End User only has access to the enable override.  

The designation of “lead” pump and “standby” pump will be changed at 2:00am on Sunday.  

 

Number of Strategy blocks used   162 

 

This Sample Application uses the following macros: 

 Macro: TWIN PLANT CONTROL 

Option Value Comment 

Fault Select 2 DPS 

DPS Fault Monitor 0 Run Only 

Stop on Fault 0 No – Standby Run 

Fault Monitor Delay 20 Seconds 

Fault Delay 5 Seconds 

Start Delay 10 Seconds 

Runtime Limit 5000 Hours 

Run on time 600 Seconds 

Lead Pump Changeover 0 Time of Day 

TimeOfDay (Day) 

(Hour) 

Sun 

2 

Only Sunday checked 

Hours 

Hours Run Changeover 0 Hours 

 
 

A System Description for any system based on this Sample Application is given on the following pages. 
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Twin Pump Weekly Changeover with Trip Monitoring 

 System overview 

The pump system consists of the following plant: 

 Two pumps with DOL (Direct On Line) starters with trip contacts. 

 The pumps will be enabled on demand. 

The pumps will operate in a duty-standby sequence with the lead pump changing each week.  

 

 System control 

The system will be enabled when any plant requiring CT (Constant Temperature) water calls for it.  

The system will be disabled when no plant requires CT water. 
When the system is enabled any faults will be reset and the pump will be enabled. 

 When the system is disabled the pump control will be disabled. 

 

 Pump System Control 

When the system is enabled any faults will be reset and the pump will be started.  

After the pump has run for 20 seconds the system will monitor the differential pressure across the pump and if no flow is 
detected for a period of 10 seconds the pump will be deemed to be in fault.  

This fault will be latched until reset by either the operator or a system restart.  

A general alarm will then be raised, indicating that the pump is in fault.  

When the system is disabled the pump will continue to run for 10 minutes to dissipate any residual heat left in the system, 
and then the pump will be stopped. 

 

 Pump rotation 

The lead pump will be automatically rotated at 2:00am on Sunday morning. The operator will also have the following 
options via the supervisor. 

1. To fix the lead pump disabling the automatic rotation. 

2. To fix the running pump and disable the other pump. 

 

 System reset 

The system can be reset via the supervisor. This will clear all latched faults. If the system is enabled and is in fault, the system 
will be restarted as described in System Control.  

 

 Pump frost protection 

If the pump is not enabled and either a Frost Level 1 or a Frost Level 2 is initiated, then the pump control will be enabled. This 
will remain enabled until all frost states are cleared. 

 

 Hours run 

The system will log the ‘hours run’ for the pump. When the pump has a logged run time of 5,000 hours (user adjustable) a 
maintenance alarm will be raised. After the pump has been serviced, the alarm can be reset via the supervisor. 
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 Override  

The system can be overridden Off or On via the supervisor. If overridden Off the system will ignore all demands to run. If 

overridden On the system will run, but any safety interlocks will remain active. 

 

 Fire 

If a Fire alarm is detected, the pump will be stopped. When the Fire alarm has cleared the pump will then restart as per the 
system run, if required. 
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1.1.1.6 Twin pump weekly changeover with pressure control 

Summary 

This Sample Application will control a twin pump set with a static pressure sensor to monitor the flow.  

If a pressure mismatch is detected on the lead, an alarm will be raised at the Supervisor, the lead pump will be stopped and 
the standby pump will be started. 

If a pressure mismatch is detected when the standby pump is enabled, a system failed alarm will be raised at the supervisor and 
the standby pump will be disabled.  

When a pump has run for 5,000 hours a Maintenance alarm will be raised at the supervisor.  

An override is available with 2 modes: enable and system override.  

 The enable override will override the system enable and leave all safely actions enabled.  

 The system override will override the system enable and ignore all safety interlocks.  

It is recommended that the End User only has access to the enable override.  

The designation of “lead” pump and “standby” pump will be changed at 2:00am on Sunday.  

 

Number of Strategy blocks used   163 

 

 This Sample Application uses the following macros: 

 Macro: TWIN PLANT CONTROL 

Option Value Comment 

Fault Select 4 Pressure 

DPS Fault Monitor 0 Run Only 

Stop on Fault 0 No – Standby Run 

Fault Monitor Delay 20 Seconds 

Fault Delay 10 Seconds 

Max Pressure Error 100 Pa 

0.01 psi 

Start Delay 10 Seconds 

Runtime Limit 5000 Hours 

Run on time 600 Seconds 

Lead Pump Changeover 0 Time of Day 

TimeOfDay (Day) 

(Hour) 

Sun 

2 

Only Sunday checked 

Hours 

Hours Run Changeover 0 Hours 

 

 

A System Description for any system based on this Sample Application is given on the following pages. 
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Twin pump weekly changeover with pressure control 

 System overview 

The system consists of the following plant: 

 Two pumps with inverters. 

 One pressure sensor common to both pumps. 

The pump system will be enabled on demand. 

The pumps will operate in a duty-standby sequence with the lead pump changing each week.  

The running pump’s speed will be varied to maintain the required system pressure. 

 

 System control 

The system will be enabled when any plant requiring CT (Constant Temperature) water calls for it.  

The system will be disabled when no plant requires CT water. 
When the system is enabled any faults will be reset and the pump will be enabled. 

 When the system is disabled the pump control will be disabled. 

 

 Pump System Control 

When the system is enabled any faults will be reset and the pump will be started.  

After the pump has run for 20 seconds the system will monitor the differential pressure across the pump and if no flow is 
detected for a period of 10 seconds the pump will be deemed to be in fault.  

This fault will be latched until reset by either the operator or a system restart.  

A general alarm will then be raised, indicating that the pump is in fault.  

When the system is disabled the pump will continue to run for 10 minutes to dissipate any residual heat left in the system, 
and then the pump will be stopped. 

 

 Pressure control 

When the pressure control is enabled it will ramp up the speed of the pump to achieve the required system pressure.  

The rate of change of the output will be limited to 3.3 % per second for the initial 30 seconds of start-up. The pressure 
control will then modulate the speed of the pump to maintain the required system pressure.  

If the pressure sensor deviates from the required pressure setpoint by ±100 Pa (±0.01 psi) for 10 seconds, then the pump 
will be deemed as failed and a pressure field alarm will be raised at the supervisor. 

 

 Pump rotation 

The lead pump will be automatically rotated at 2:00am on Sunday morning. The operator will also have the following 
options via the supervisor. 

1. To rotate the lead pump. The lead pump will still be changed automatically.  

2. To fix the lead pump disabling the automatic rotation. 

 System reset 

The system can be reset via the supervisor. This will clear all latched faults. If the system is enabled and is in fault, the system 
will be restarted as described in System Control.  
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 Pump frost protection 

If the pump is not enabled and either a Frost Level 1 or a Frost Level 2 is initiated, then the pump control will be enabled. This 
will remain enabled until all frost states are cleared. 

 

 Hours run 

The system will log the ‘hours run’ for the pump. When the pump has a logged run time of 5,000 hours (user adjustable) a 
Maintenance alarm will be raised. After the pump has been serviced, the alarm can be reset via the supervisor. 

 

 Override  

The system can be overridden Off or On via the supervisor. If overridden Off the system will ignore all demands to run. If 

overridden On the system will run, but any safety interlocks will remain active. 

 

 Fire 

If a Fire alarm is detected, the pump will be stopped. When the Fire alarm has cleared the pump will then restart as per the 
system run, if required. 
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1.1.2.1 VT Single pump weekly changeover with DPS monitoring 

Summary 

This Sample Application will control a single pump with a DPS (Differential Pressure Switch) to monitor the flow and the flow 
temperature (VT = Variable Temperature).  

If no flow is detected, an alarm will be raised at the supervisor but the pump will remain enabled. When the pump has run for 
5,000 hours a maintenance alarm will be raised at the supervisor.   

The flow temperature setpoint will be reset based on the outside air temperature.  

An override is available with 2 modes: enable and system override.  

 The enable override will override the system enable and leave all safely actions enabled.  

 The system override will override the system enable and ignore all safety interlocks.  

It is recommended that the End User only has access to the enable override.  

 

Number of Strategy blocks used   104 

 

This Sample Application uses the following macros: 

 Macro: SINGLE PLANT CONTROL 

Option Value Comment 

Fault Select 1 DPS 

DPS Fault Monitor 0 Run Only 

Stop on Fault 1 No - Run 

Fault Monitor Delay 20 Seconds 

Fault Delay 10 Seconds 

Maintenance  Limit 5000 Hours 

Run on time 600 Seconds 

 

A System Description for any system based on this Sample Application is given on the following pages. 
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VT Single pump weekly changeover with DPS monitoring 

 System overview 

The pump system consists of the following plant: 

 Single pump with DOL (Direct On Line) starter. 

 DPS (Differential Pressure Switch) across the pump. 

The pump will be enabled on demand.  

 VT (Variable Temperature) Valve control. 

 VT flow sensor. 

 

 System control 

The system will be enabled when any plant requiring VT water calls for it.  

The system will be disabled when no plant requires VT water. 
When the system is enabled, any faults will be reset and both the pump and the VT control will be enabled.  

When the system is disabled the VT control will be disabled. 

 

 Pump System Control 

When the system is enabled any faults will be reset and the pump will be started. 

After the pump has run for 20 seconds the system will monitor the differential pressure across the pump and if no flow is 
detected for a period of 10 seconds the pump will be deemed to be in fault.  

This fault will be latched until reset by either the operator or a system restart.  

A general alarm will then be raised, indicating that the pump is in fault.  

When the system is disabled the pump will continue to run for 10 minutes to dissipate any residual heat left in the system, 
and then the pump will be stopped. 

 

 VT Control  

When enabled, this will modulate the heating valve to achieve the calculated setpoint. The setpoint will be calculated based 
on the outside air temperature. When the outside air temperature is 2 °C (36 °F) or below, the calculated flow temperature 
will be 80 °C (176 °F) and when the outside air temperature is 20 °C (68 °F) or above, the calculated flow temperature will be 
20 °C (68 °F).  

If the flow temperature deviates from the calculated setpoint by ±2 °C (±4 °F) for 2 minutes, then an out of limits alarm will be 
raised at the supervisor.  

 

 System reset 

The system can be reset via the supervisor. This will clear all latched faults. If the system is enabled and is in fault, the system 
will be restarted as described in System Control.  

 

 Pump frost protection 

If the pump is not enabled and either a Frost Level 1 or a Frost Level 2 is initiated, then the pump control will be enabled. This 
will remain enabled until all frost states are cleared. 

 Hours run 

The system will log the ‘hours run’ for the pump. When the pump has a logged run time of 5,000 hours (user adjustable) a 
Maintenance alarm will be raised. After the pump has been serviced, the alarm can be reset via the supervisor. 
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 Override  

The system can be overridden Off or On via the supervisor. If overridden Off the system will ignore all demands to run. If 

overridden On the system will run, but any safety interlocks will remain active. 

 

 Fire 

If a Fire alarm is detected, the pump will be stopped. When the Fire alarm has cleared the pump will then restart as per the 
system run, if required.  

 

 

 

 

 

  



 

 

830 © American Auto-Matrix MAN00058US rev 69 

M
A

N
0

0
0

5
8

U
S rev 6

9
 

1.1.2.2 VT Single pump weekly changeover with trip monitoring 

Summary 

This Sample Application will control a single pump and the flow temperature (VT = Variable Temperature).  

The system will monitor the Trip of the pump starter. If a Trip is detected, an alarm will be raised at the supervisor and the 
pump will be disabled. The pump will remain disabled until the alarm is reset by the operator at the Supervisor or the Enable 
signal goes off.  

When the pump has run for 5,000 hours a Maintenance alarm will be raised at the Supervisor. The flow temperature setpoint 
will be reset based on the outside air temperature. 

An override is available with 2 modes: enable and system override.  

 The enable override will override the system enable and leave all safely actions enabled.  

 The system override will override the system enable and ignore all safety interlocks.  

It is recommended that the End User only has access to the enable override.  

 

Number of Strategy blocks used   104 

 

This Sample Application uses the following macros: 

 Macro: SINGLE PLANT CONTROL 

Option Value Comment 

Fault Select 2 Trip 

DPS Fault Monitor 0 Run Only 

Stop on Fault 0 Yes 

Fault Monitor Delay 20 Seconds 

Fault Delay 10 Seconds 

Maintenance Limit 5000 Hours 

Run on time 600 Seconds 

 
 

 

 

A System Description for any system based on this Sample Application is given on the following pages. 
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VT Single pump weekly changeover with trip monitoring 

 System overview 

The pump system consists of the following plant: 

 Single pump with DOL (Direct On Line) starter with trip contact. 

The pump will be enabled on demand.  

 VT (Variable Temperature) Valve control. 

 VT flow sensor. 

 

 System control 

The system will be enabled when any plant requiring VT (Variable Temperature) water calls for it.  

The system will be disabled when no plant requires VT water. 
When the system is enabled, any faults will be reset and both the pump and the VT control will be enabled.  

When the system is disabled the VT control will be disabled. 

 

 Pump System Control 

When the system is enabled any faults will be reset and the pump will be started. 

After the pump has run for 20 seconds the system will monitor the differential pressure across the pump and if no flow is 
detected for a period of 5 seconds the pump will be deemed to be in fault.  

This fault will be latched until reset by either the operator or a system restart.  

A general alarm will then be raised, indicating that the pump is in fault.  

When the system is disabled the pump will continue to run for 10 minutes to dissipate any residual heat left in the system, 
and then the pump will be stopped. 

 

 VT Control  

When enabled, this will modulate the heating valve to achieve the calculated setpoint. The setpoint will be calculated based 
on the outside air temperature. When the outside air temperature is 2 °C (36 °F) or below, the calculated flow temperature 
will be 80 °C (176 °F) and when the outside air temperature is 20 °C (68 °F) or above, the calculated flow temperature will be 
20 °C (68 °F). If the flow temperature deviates from the calculated setpoint by ±2 °C (±4 °F) for 2 minutes, then an out of limits 
alarm will be raised at the supervisor.  

 

 System reset 

The system can be reset via the supervisor. This will clear all latched faults. If the system is enabled and is in fault, the system 
will be restarted as described in System Control.  

 

 Pump frost protection 

If the pump is not enabled and either a Frost Level 1 or a Frost Level 2 is initiated, then the pump control will be enabled. This 
will remain enabled until all frost states are cleared. 

 

 Hours run 

The system will log the ‘hours run’ for the pump. When the pump has a logged run time of 5,000 hours (user adjustable) a 
Maintenance alarm will be raised. After the pump has been serviced, the alarm can be reset via the supervisor. 
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 Override  

The system can be overridden Off or On via the supervisor. If overridden Off the system will ignore all demands to run. If 

overridden On the system will run, but any safety interlocks will remain active. 

 

 Fire 

If a Fire alarm is detected, the pump will be stopped. When the Fire alarm has cleared the pump will then restart as per the 
system run, if required.  
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1.1.2.3 VT Single pump weekly changeover with pressure control 

Summary 

This Sample Application will control a single pump with pressure control and the flow temperature (VT = Variable 
Temperature).  

If the pressure deviates from the setpoint by 10% while the system is running, then an alarm will be raised at the supervisor 
and the pump will remain disabled. When the pump has run for 5,000 hours a maintenance alarm will be raised at the 
supervisor.  

The flow temperature setpoint will be reset based on the outside air temperature. 

An override is available with 2 modes: enable and system override.  

 The enable override will override the system enable and leave all safely actions enabled.  

 The system override will override the system enable and ignore all safety interlocks.  

It is recommended that the End User only has access to the enable override.  

 

Number of Strategy blocks used   105 

 

This Sample Application uses the following macros: 

 Macro: SINGLE PLANT CONTROL 

Option Value Comment 

Fault Select 4 Pressure Mismatch 

DPS Fault Monitor 0 Run Only 

Stop on Fault 0 Yes  

Fault Monitor Delay 20 Seconds 

Fault Delay 10 Seconds 

Max Pressure Error 100 

0.01 

Pa 

psi 

Start Delay 10 Seconds 

Maintenance Limit 5000 Hours 

Run On Time 600 Seconds 

Fault Select 4 Pressure Mismatch 

 
 

 

 

A System Description for any system based on this Sample Application is given on the following pages. 
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VT Single pump weekly changeover with pressure control 

 System overview 

The pump system consists of the following plant: 

 Single pump with DOL (Direct On Line) starter. 

 Pressure sensor across the flow and return. 

The pump will be enabled on demand.  

 VT (Variable Temperature) Valve control. 

 VT flow sensor. 

 

 System control 

The system will be enabled when any plant requiring VT (Variable Temperature) water calls for it.  

The system will be disabled when no plant requires VT water. 
When the system is enabled, any faults will be reset and both the pump and the VT control will be enabled.  

When the system is disabled the VT control will be disabled. 

 

 Pump System Control 

When the system is enabled any faults will be reset and the pump will be started. 

After the pump has run for 20 seconds the system will monitor the differential pressure across the pump and if no flow is 
detected for a period of 5 seconds the pump will be deemed to be in fault.  

This fault will be latched until reset by either the operator or a system restart.  

A general alarm will then be raised, indicating that the pump is in fault.  

When the system is disabled the pump will continue to run for 10 minutes to dissipate any residual heat left in the system, 
and then the pump will be stopped. 

 

 Pressure control 

When the pressure control is enabled it will ramp up the speed of the pump to achieve the required system pressure.  

The rate of change of the output will be limited to 3.3 % per second for the initial 30 seconds of start-up. The pressure 
control will then modulate the speed of the pump to maintain the required system pressure.  

If the pressure sensor deviates from the required pressure Setpoint by ±100 Pa (±0.01 psi) for 10 seconds, then the pump 
will be deemed as failed and a pressure field alarm will be raised at the supervisor. 

 

 VT Control  

When enabled, this will modulate the heating valve to achieve the calculated setpoint. The setpoint will be calculated based 
on the outside air temperature. When the outside air temperature is 2 °C (36 °F) or below, the calculated flow temperature 
will be 80 °C (176 °F) and when the outside air temperature is 20 °C (68 °F) or above, the calculated flow temperature will be 
20 °C (68 °F). If the flow temperature deviates from the calculated setpoint by ±2 °C (±4 °F) for 2 minutes, then an out of 
limits alarm will be raised at the supervisor.  

 

 System reset 

The system can be reset via the supervisor. This will clear all latched faults. If the system is enabled and is in fault, the system 
will be restarted as described in System Control.  
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 Pump frost protection 

If the pump is not enabled and either a Frost Level 1 or a Frost Level 2 is initiated, then the pump control will be enabled. This 
will remain enabled until all frost states are cleared. 

 

 Hours run 

The system will log the ‘hours run’ for the pump. When the pump has a logged run time of 5,000 hours (user adjustable) a 
Maintenance alarm will be raised. After the pump has been serviced, the alarm can be reset via the supervisor. 

 

 Override  

The system can be overridden Off or On via the supervisor. If overridden Off the system will ignore all demands to run. If 

overridden On the system will run, but any safety interlocks will remain active. 

 

 Fire 

If a Fire alarm is detected, the pump will be stopped. When the Fire alarm has cleared the pump will then restart as per the 
system run, if required. 
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1.1.2.4 VT Twin pump weekly changeover with DPS monitoring 

Summary 

This Sample Application will control a twin pump set with a DPS (Differential Pressure Switch) to monitor the flow and the flow 
temperature (VT = Variable Temperature).  

It is suitable for either common DPS (Differential Pressure Switch) monitoring the two pumps or a DPS across each pump. If a 

common DPS is used, it must be connected to DP1  and DP2  of the Macro.  

If no flow is detected an alarm will be raised at the Supervisor then the standby pump will be started, and if no flow is 
detected when the standby pump is enabled a system failed alarm will be raised at the supervisor and the standby pump will 
remain enabled.  

When a pump has run for 5,000 hours a maintenance alarm will be raised at the supervisor. The flow temperature setpoint will 
be reset based on the outside air temperature. 

An override is available with 2 modes: enable and system override.  

 The enable override will override the system enable and leave all safely actions enabled.  

 The system override will override the system enable and ignore all safety interlocks.  

It is recommended that the End User only has access to the enable override.  

The designation of “lead” pump and “standby” pump will be changed at 2:00am on Sunday.  

When the system is disabled the VT control will be disabled and the pump will continue to run for 10 minutes to dissipate 
any residual heat left in the system. 

 

Number of Strategy blocks used   197 

 

This Sample Application uses the following macros: 

 Macro: TWIN PLANT CONTROL 

Option Value Comment 

Fault Select 1 DPS 

DPS Fault Monitor 0 Run Only 

Stop on Fault 1 No – Standby Run 

Fault Monitor Delay 20 Seconds 

Fault Delay 5 Seconds 

Start Delay 10 Seconds 

Runtime Limit 5000 Hours 

Run on time 600 Seconds 

Lead Pump Changeover 0 Time of Day 

TimeOfDay (Day) 

(Hour) 

Sun 

2 

Only Sunday checked 

Hours 

Hours Run Changeover 0 Hours 

 

A System Description for any system based on this Sample Application is given on the following pages. 
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VT Twin pump weekly changeover with DPS monitoring 

 System overview 

The pump system consists of the following plant: 

 Two pumps with DOL (Direct On Line) starters. 

 Two DPS (Differential Pressure Switch) one across each pump. 

The pumps will be enabled on demand. 

The pumps will operate in a duty-standby sequence with the lead pump changing each week.  

 

 System control 

The system will be enabled when any plant requiring VT (Variable Temperature) water calls for it.  

The system will be disabled when no plant requires VT water. 
When the system is enabled, any faults will be reset and both the pump and the VT control will be enabled.  

When the system is disabled the VT control will be disabled. 

 

 Pump System Control 

When the system is enabled any faults will be reset and the pump will be started. 

After the pump has run for 20 seconds the system will monitor the differential pressure across the pump and if no flow is 
detected for a period of 5 seconds the pump will be deemed to be in fault.  

This fault will be latched until reset by either the operator or a system restart.  

A general alarm will then be raised, indicating that the pump is in fault.  

When the system is disabled the pump will continue to run for 10 minutes to dissipate any residual heat left in the system, 
and then the pump will be stopped. 

 

 VT Control  

When enabled, this will modulate the heating valve to achieve the calculated setpoint. The setpoint will be calculated based 
on the outside air temperature. When the outside air temperature is 2 °C (36 °F) or below, the calculated flow temperature 
will be 80 °C (176 °F) and when the outside air temperature is 20 °C (68 °F) or above, the calculated flow temperature will be 
20 °C (68 °F).  

If the flow temperature deviates from the calculated setpoint by ±2 °C (±4 °F) for 2 minutes, then an out of limits alarm will be 
raised at the supervisor.  

 

 Pump rotation 

The lead pump will be automatically rotated at 2:00am on Sunday morning. The operator will also have the following 
options via the supervisor: 

1. To fix the lead pump disabling the automatic rotation. 

2. To fix the running pump and disable the other pump. 

 

 System reset 

The system can be reset via the supervisor. This will clear all latched faults. If the system is enabled and is in fault, the system 
will be restarted as described in System Control.  
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 Pump frost protection 

If the pump is not enabled and either a Frost Level 1 or a Frost Level 2 is initiated, then the pump control will be enabled. This 
will remain enabled until all frost states are cleared. 

 

 Hours run 

The system will log the ‘hours run’ for the pump. When the pump has a logged run time of 5,000 hours (user adjustable) a 
Maintenance alarm will be raised. After the pump has been serviced, the alarm can be reset via the supervisor. 

 

 Override  

The system can be overridden Off or On via the supervisor. If overridden Off the system will ignore all demands to run. If 

overridden On the system will run, but any safety interlocks will remain active. 

 

 Fire 

If a Fire alarm is detected, the pump will be stopped. When the Fire alarm has cleared the pump will then restart as per the 
system run, if required.  
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1.1.2.5 VT Twin pump Weekly Changeover with Trip Monitoring 

Summary 

This Sample Application will control a twin pump set monitoring the pump trips and the flow temperature (VT = Variable 
Temperature).  

If a trip is detected on the lead an alarm will be raised at the supervisor then the lead pump with be stopped and the standby 
pump will be started. If a trip is detected when the standby pump is enabled, a system failed alarm will be raised at the 
supervisor and the standby pump will be disabled.  

When a pump has run for 5,000 hours a maintenance alarm will be raised at the supervisor. The flow temperature setpoint will 
be reset based on the outside air temperature. 

An override is available with 2 modes: enable and system override.  

 The enable override will override the system enable and leave all safely actions enabled.  

 The system override will override the system enable and ignore all safety interlocks.  

It is recommended that the End User only has access to the enable override.  

The designation of “lead” pump and “standby” pump will be changed at 2:00am on Sunday.  

When the system is disabled the VT control will be disabled and the pump will continue to run for 10 minutes to dissipate 
any residual heat left in the system. 

 

Number of Strategy blocks used   197 

 

This Sample Application uses the following macros: 

 Macro: TWIN PLANT CONTROL 

Option Value Comment 

Fault Select 2 DPS 

DPS Fault Monitor 0 Run Only 

Stop on Fault 0 No – Standby Run 

Fault Monitor Delay 20 Seconds 

Fault Delay 5 Seconds 

Start Delay 10 Seconds 

Runtime Limit 5000 Hours 

Run on time 600 Seconds 

Lead Pump Changeover 0 Time of Day 

TimeOfDay (Day) 

(Hour) 

Sun 

2 

Only Sunday checked 

Hours 

Hours Run Changeover 0 Hours 

 
 

A System Description for any system based on this Sample Application is given on the following pages. 
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VT Twin pump Weekly Changeover with Trip Monitoring 

 

 System overview 

The pump system consists of the following plant: 

 Two pumps with DOL (Direct On Line) starters and trip contacts. 

 One pressure transducer across the flow and return. 

The pumps will be enabled on demand. 

The pumps will operate in a duty-standby sequence with the lead pump changing each week.  

 

 System control 

The system will be enabled when any plant requiring VT (Variable Temperature) water calls for it.  

The system will be disabled when no plant requires VT water. 
When the system is enabled, any faults will be reset and both the pump and the VT control will be enabled.  

When the system is disabled the VT control will be disabled. 

 

 Pump System Control 

When the system is enabled any faults will be reset and the pump will be started. 

After the pump has run for 20 seconds the system will monitor the differential pressure across the pump and if no flow is 
detected for a period of 5 seconds the pump will be deemed to be in fault.  

This fault will be latched until reset by either the operator or a system restart.  

A general alarm will then be raised, indicating that the pump is in fault.  

When the system is disabled the pump will continue to run for 10 minutes to dissipate any residual heat left in the system, 
and then the pump will be stopped. 

 

 VT Control  

When enabled, this will modulate the heating valve to achieve the calculated setpoint. The setpoint will be calculated based 
on the outside air temperature. When the outside air temperature is 2 °C (36 °F) or below, the calculated flow temperature 
will be 80 °C (176 °F) and when the outside air temperature is 20 °C (68 °F) or above, the calculated flow temperature will be 
20 °C (68 °F).  

If the flow temperature deviates from the calculated setpoint by ±2 °C (±4 °F) for 2 minutes, then an out of limits alarm will 
be raised at the supervisor.  

 

 Pump rotation 

The lead pump will be automatically rotated at 2:00am on Sunday morning. The operator will also have the following 
options via the supervisor. 

1. To fix the lead pump disabling the automatic rotation. 

2. To fix the running pump and disable the other pump. 

 System reset 

The system can be reset via the supervisor. This will clear all latched faults. If the system is enabled and is in fault, the system 
will be restarted as described in System Control.  
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 Pump frost protection 

If the pump is not enabled and either a Frost Level 1 or a Frost Level 2 is initiated, then the pump control will be enabled. This 
will remain enabled until all frost states are cleared. 

 

 Hours run 

The system will log the ‘hours run’ for the pump. When the pump has a logged run time of 5,000 hours (user adjustable) a 
Maintenance alarm will be raised. After the pump has been serviced, the alarm can be reset via the supervisor. 

 

 Override  

The system can be overridden Off or On via the supervisor. If overridden Off the system will ignore all demands to run. If 

overridden On the system will run, but any safety interlocks will remain active. 

 

 Fire 

If a Fire alarm is detected, the pump will be stopped. When the Fire alarm has cleared the pump will then restart as per the 
system run, if required. 
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1.1.2.6 VT Twin pump Weekly Changeover with Pressure Control 

Summary 

This Sample Application will control a twin pump set with a static pressure sensor to monitor the flow and the flow 
temperature (VT = Variable Temperature).  

If a pressure mismatch is detected on the lead, an alarm will be raised at the supervisor, the lead pump will be stopped and 
the standby pump will be started.  

If a pressure mismatch is detected when the standby pump is enabled a system failed alarm will be raised at the supervisor 
and the standby pump will be disabled.  

When a pump has run for 5,000 hours a Maintenance alarm will be raised at the supervisor.  

The flow temperature setpoint will be reset based on the outside air temperature. 

An override is available with 2 modes: enable and system override.  

 The enable override will override the system enable and leave all safely actions enabled.  

 The system override will override the system enable and ignore all safety interlocks.  

It is recommended that the End User only has access to the enable override.  

The designation of “lead” pump and “standby” pump will be changed at 2:00am on Sunday.  

When the system is disabled the VT control will be disabled and the pump will continue to run for 10 minutes to dissipate 
any residual heat left in the system.  

 

Number of Strategy blocks used   198 

 

 This Sample Application uses the following macros: 

 Macro: TWIN PLANT CONTROL 

Option Value Comment 

Fault Select 4 Pressure 

DPS Fault Monitor 0 Run Only 

Stop on Fault 0 No – Standby Run 

Fault Monitor Delay 20 Seconds 

Fault Delay 10 Seconds 

Max Pressure Error 100 

0.01 

Pa 

psi 

Start Delay 10 Seconds 

Runtime Limit 5000 Hours 

Run on time 600 Seconds 

Lead Pump Changeover 0 Time of Day 

TimeOfDay (Day) 

(Hour) 

Sun 

2 

Only Sunday checked 

Hours 

 

A System Description for any system based on this Sample Application is given on the following pages.  
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VT Twin pump Weekly Changeover with Pressure Control 

 System overview 

The system consists of the following plant: 

 Two pumps with inverters. 

 One pressure sensor common to both pumps. 

The pump system will be enabled on demand. 

The pumps will operate in a duty-standby sequence with the lead pump changing each week.  

The running pump’s speed will be varied to maintain the required system pressure. 

 

 System control 

The system will be enabled when any plant requiring VT (Variable Temperature) water calls for it.  

The system will be disabled when no plant requires VT water. 
When the system is enabled, any faults will be reset and both the pump and the VT control will be enabled.  

When the system is disabled the VT control will be disabled. 

 

 Pump System Control 

When the system is enabled any faults will be reset and the pump will be started. 

After the pump has run for 20 seconds the system will monitor the differential pressure across the pump and if no flow is 
detected for a period of 5 seconds the pump will be deemed to be in fault.  

This fault will be latched until reset by either the operator or a system restart.  

A general alarm will then be raised, indicating that the pump is in fault.  

When the system is disabled the pump will continue to run for 10 minutes to dissipate any residual heat left in the system, 
and then the pump will be stopped. 

 

 Pressure control 

When the pressure control is enabled it will ramp up the speed of the pump to achieve the required system pressure.  

The rate of change of the output will be limited to 3.3 % per second for the initial 30 seconds of start-up. The pressure 
control will then modulate the speed of the pump to maintain the required system pressure.  

If the pressure sensor deviates from the required pressure setpoint by ±100 Pa (±0.01 psi) for 10 seconds, then the pump 
will be deemed as failed and a pressure field alarm will be raised at the supervisor. 

 

 VT Control  

When enabled, this will modulate the heating valve to achieve the calculated setpoint. The setpoint will be calculated based 
on the outside air temperature. When the outside air temperature is 2 °C (36 °F) or below, the calculated flow temperature 
will be 80 °C (176 °F) and when the outside air temperature is 20 °C (68 °F) or above, the calculated flow temperature will be 
20 °C (68 °F).  

If the flow temperature deviates from the calculated setpoint by ±2 °C (±4 °F) for 2 minutes, then an out of limits alarm will be 
raised at the supervisor.  
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 Pump rotation 

The lead pump will be automatically rotated at 2:00am on Sunday morning. The operator will also have the following 
options via the supervisor. 

1. To rotate the lead pump. The lead pump will still be changed automatically.  

2. To fix the lead pump disabling the automatic rotation. 

 

 System reset 

The system can be reset via the supervisor. This will clear all latched faults. If the system is enabled and is in fault, the system 
will be restarted as described in System Control.  

 

 Pump frost protection 

If the pump is not enabled and either a Frost Level 1 or a Frost Level 2 is initiated, then the pump control will be enabled. This 
will remain enabled until all frost states are cleared. 

 

 Hours run 

The system will log the ‘hours run’ for the pump. When the pump has a logged run time of 5,000 hours (user adjustable) a 
maintenance alarm will be raised. After the pump has been serviced, the alarm can be reset via the supervisor. 

 

 Override  

The system can be overridden Off or On via the supervisor. If overridden Off the system will ignore all demands to run. If 

overridden On the system will run, but any safety interlocks will remain active. 

 

 Fire 

If a Fire alarm is detected, the pump will be stopped. When the Fire alarm has cleared the pump will then restart as per the 
system run, if required. 
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1.1.3.1 Four-Boiler On/Off Sequence Control 

Summary 

This Sample Application will control 4 boilers with on-off control.  

The lead boiler will be changed at 2:00am on Sunday. On failure of a boiler it will be taken out of the sequence until reset. 

 

Number of Strategy blocks used   452 

 

 This Sample Application uses the following macros:  

 Macro: SEQUENCE CONTROL 

Option Value Comment 

Type Select 0 Cascade 1 

HoursRunTime 0 Time 

Time Of Day (Day) 

Time Of Day (Hour) 

Sun 

2 

Only Sunday checked 

Hours 

Setpoint SP  78 

(172 

°C 

°F) 

Deadband DB  2 

(4 

°C 

°F) 

PI Loop Gain 8  

PI Loop Integral 600 seconds 

Min On Time 0 seconds 

Min Off Time 0 seconds 

Next Stage On Time 60 seconds 

Next Stage Off Time 60 seconds 

Stage 1 On 0 % 

Stage 1 Off 5 % 

Stage On 10 % 

Stage Off 90 % 

 

 Macro: SEQUENCE MODULE 

Option Value Comment 

Hi-Lo 0 Lo 

 
 

A System Description for any system based on this Sample Application is given on the following page. 
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Four-Boiler On/Off Sequence Control 
 System overview. 

The boiler system consists of the following plant: 

 4 Boilers with integral shunt pumps and lockout indication. 

 1 Return temperature sensor. 

The boilers will operate on demand with the lead boiler changing each week.  

 

 System Control 

The system will be enabled when any plant requiring hot water calls for it. The system will be disabled when no plant 
requires hot water. 

When the system is enabled the boiler control will be enabled. 

When the system is disabled the boiler control will be disabled. 

 

 Boiler Control 

When the system is enabled the system will determine how many boilers are required to meet the system demand and will 
adjust the enabled boilers as required.  

If a boiler fails, then a Boiler Lockout alarm will be raised at the supervisor and it will be taken out of the sequence until the 
alarm has been reset by the supervisor.   

When the required return temperature is achieved, the boiler control will remain static until the return temperature either 
rises 2 °C (4 °F) above or falls 2 °C (4 °F) below the required temperature.  

 

 Boiler rotation 

The lead boiler will be automatically rotated at 2:00am on Sunday morning. The operator will also have the following 
options via the supervisor. 

1. To fix the lead boiler disabling the automatic rotation. 

2. To fix the number of boilers in the sequence. 

 

 System reset 

Each boiler has a reset for a lockout alarm. When active this alarm must be reset before the boiler can be made available to 
the boiler sequencer.   

 

 Hours run 

The system will log the hours run for each boiler. When a boiler has a logged run time of 5,000 Hours (user adjustable) a 
maintenance alarm will be raised. After the boiler has been serviced, the alarm can be reset via the supervisor. 
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1.1.3.2 Four-Boiler Modulating Sequence Control 

Summary 

This Sample Application will control 4 boilers with modulating control.  

The lead boiler will be changed at 2:00am on Sunday. On failure of a boiler it will be taken out of the sequence until reset. 

 

Number of Strategy blocks used   452 

 

 This Sample Application uses the following macros:  

 Macro: SEQUENCE CONTROL 

Option Value Comment 

Type Select 0 Cascade 1 

HoursRunTime 0 Time 

Time Of Day (Day) 

Time Of Day (Hour) 

Sun 

2 

Only Sunday checked 

Hours 

Setpoint SP  78 

(172 

°C 

°F) 

Deadband DB  2 

(4 

°C 

°F) 

PI Loop Gain 8  

PI Loop Integral 600 seconds 

Min On Time 0 seconds 

Min Off Time 0 seconds 

Next Stage On Time 60 seconds 

Next Stage Off Time 60 seconds 

Stage 1 On 0 % 

Stage 1 Off 5 % 

Stage On 10 % 

Stage Off 90 % 

 

 Macro: SEQUENCE MODULE 

Option Value Comment 

Hi-Lo 0 Lo 

 
 

A System Description for any system based on this Sample Application is given on the following page. 
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Four-Boiler Modulating Sequence Control 
 System overview. 

The boiler system consists of the following plant: 

 4 Modulating Boilers with integral shunt pumps and lockout indication. 

 1 Return temperature sensor. 

The boilers will operate on demand with the lead boiler changing each week.  

 

 System Control 

The system will be enabled when any plant requiring hot water calls for it. The system will be disabled when no plant 
requires hot water. 

When the system is enabled the boiler control will be enabled. 

When the system is disabled the boiler control will be disabled. 

 

 Boiler Control 

When the system is enabled the system will determine how many boilers are required to meet the system demand and will 
adjust the enabled boilers and modulation as required.  

When another boiler is sequenced on, the total required demand will be sequenced between all the enabled boilers, with 

the lead boilers being set to 100% demand. Therefore, if the total demand is 120% and two boilers are on, the lead boiler 
demand will be set to 100% and the demand for the lag boilers will be set to 20%. 

If a boiler fails, then a Boiler Lockout alarm will be raised at the supervisor and it will be taken out of the sequence until the 
alarm has been reset by the supervisor.   

When the required return temperature is achieved, the boiler control will remain static until the return temperature either 
rises 2 °C (4 °F) above or falls 2 °C (4 °F) below the required temperature.  

 

 Boiler rotation 

The lead boiler will be automatically rotated at 2:00am on Sunday morning. The operator will also have the following 
options via the supervisor. 

1. To fix the lead boiler disabling the automatic rotation. 

2. To fix the number of boilers in the sequence. 

3. To fix the demand output of the last boiler in the sequence. 

 

 System reset 

Each boiler has a reset for a lockout alarm. When active this alarm must be reset before the boiler can be made available to 
the boiler sequencer.   

 

 Hours run 

The system will log the hours run for each boiler. When a boiler has a logged run time of 15,000 Hours (user adjustable) a 
maintenance alarm will be raised. After the boiler has been serviced, the alarm can be reset via the supervisor. 
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1.1.3.3 Two-Boiler High/Low Fire 

Summary 

This Sample Application will control 2 boilers with Hi/Lo fire control.  

The lead boiler will be changed at 2:00am on Sunday. On failure of a boiler it will be taken out of the sequence until reset. 

 

Number of Strategy blocks used   310 

 

 This Sample Application uses the following macros:  

 Macro: SEQUENCE CONTROL 

Option Value Comment 

Type Select 0 Cascade 1 

HoursRunTime 0 Time 

Time Of Day (Day) 

Time Of Day (Hour) 

Sun 

2 

Only Sunday checked 

Hours 

Setpoint SP  78 

(172 

°C 

°F) 

Deadband DB  2 

(4 

°C 

°F) 

PI Loop Gain 8  

PI Loop Integral 600 seconds 

Min On Time 0 seconds 

Min Off Time 0 seconds 

Next Stage On Time 60 seconds 

Next Stage Off Time 60 seconds 

Stage 1 On 0 % 

Stage 1 Off 5 % 

Stage On 10 % 

Stage Off 90 % 

 

 Macro: SEQUENCE MODULE 

Option Value Comment 

Hi-Lo 1 Lo 

 

 

A System Description for any system based on this Sample Application is given on the following page. 
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Two-Boiler High/Low Fire 
 System overview 

The boiler system consists of the following plant: 

 2 Hi/Lo fire boilers with integral shunt pumps and lockout indication. 

 1 Return temperature sensor. 

The boilers will operate on demand with the lead boiler changing each week.  

 

 System Control 

The system will be enabled when any plant requiring hot water calls for it. The system will be disabled when no plant 
requires hot water. 

When the system is enabled the boiler control will be enabled. 

When the system is disabled the boiler control will be disabled. 

 

 Boiler Control 

When the system is enabled the system will determine how many boilers are required to meet the system demand and will 
adjust the enabled boilers as required.  

If a boiler fails, then a Boiler Lockout alarm will be raised at the supervisor and it will be taken out of the sequence until the 
alarm has been reset by the supervisor.   

When the required return temperature is achieved, the boiler control will remain static until the return temperature either 
rises 2 °C (4 °F) above or falls 2 °C (4 °F) below the required temperature.  

 

 Boiler rotation 

The lead boiler will be automatically rotated at 2:00am on Sunday morning. The operator will also have the following 
options via the supervisor. 

1. To fix the lead boiler disabling the automatic rotation. 

2. To fix the number of boilers in the sequence. 

 

 System reset 

Each boiler has a reset for a lockout alarm. When active this alarm must be reset before the boiler can be made available to 
the boiler sequencer.   

 

 Hours run 

The system will log the hours run for each boiler. When a boiler has a logged run time of 5,000 Hours (user adjustable) a 
Maintenance alarm will be raised. After the boiler has been serviced, the alarm can be reset via the supervisor. 
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1.1.3.4 Four-Boiler On/Off Sequence Control with External shunt pump 

Summary 

This Sample Application will control 4 boilers with on-off control and the associated pumps.  

The lead boiler will be changed at 2:00am on Sunday. On failure of a boiler or associated pump it will be taken out of the 
sequence until reset. 

 

Number of Strategy blocks used   708 

 

 This Sample Application uses the following macros:  

 Macro: SEQUENCE CONTROL 

Option Value Comment 

Type Select 0 Cascade 1 

HoursRunTime 0 Time 

Time Of Day (Day) 

Time Of Day (Hour) 

Sun 

2 

Only Sunday checked 

Hours 

Setpoint SP  
78 

(172 
°C 
°F) 

Deadband DB  
2 

(4 
°C 
°F) 

PI Loop Gain 8  

PI Loop Integral 600 seconds 

Min On Time 0 seconds 

Min Off Time 0 seconds 

Next Stage On Time 60 seconds 

Next Stage Off Time 60 seconds 

Stage 1 On 0 % 

Stage 1 Off 5 % 

Stage On 10 % 

Stage Off 90 % 

 Macro: SEQUENCE MODULE 

Option Value Comment 

Hi-Lo 0 Lo 

 Macro: SINGLE PLANT CONTROL 

Option Value Comment 

Fault Select 1 DPS 

DPS Fault Monitor 0 Run Only 

Stop on Fault 0 Yes 

Fault Monitor Delay 20 Seconds 

Fault Delay 10 Seconds 

Maintenance  Limit 5000 Hours 

Run on time 600 Seconds 

A System Description for any system based on this Sample Application is given on the following pages. 
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Four-Boiler On/Off Sequence Control with External Shunt Pump 

 System overview 

The boiler system consists of the following plant: 

 4 Modulating Boilers lockout indication. 

 4 Shunt pumps 

 1 Return temperature sensor. 

The boilers will operate on demand with the lead boiler changing each week.  

 

 System Control 

The system will be enabled when any plant requiring hot water calls for it. The system will be disabled when no plant 
requires hot water. 

When the system is enabled the pump control will be enabled and when the DPS (Differential Pressure Switch) across the 
pump has proved flow for 30 seconds the boiler control will be enabled. 

When the system is disabled the boiler control will be disabled and the pump will continue to run for 10 minutes to 
dissipate any residual heat left in the system and then the pump will be stopped. 

 

 Boiler Control 

When the system is enabled the system will determine how many boilers are required to meet the system demand and will 
adjust the enabled boilers as required.  

If a boiler fails, then a Boiler Lockout alarm will be raised at the supervisor and it will be taken out of the sequence until the 
alarm has been reset by the supervisor.   

When the required return temperature is achieved, the boiler control will remain static until the return temperature either 
rises 2 °C (4 °F) above or falls 2 °C (4 °F) below the required temperature.  

 

 Boiler rotation 

The lead boiler will be automatically rotated at 2:00am on Sunday morning. The operator will also have the following 
options via the supervisor. 

1. To fix the lead boiler disabling the automatic rotation. 

2. To fix the number of boilers in the sequence. 

 

 Boiler System reset 

Each boiler has a reset for a lockout alarm. When active this alarm must be reset before the boiler can be made available to 
the boiler sequencer.   

 

 Boiler Hours run 

The system will log the hours run for each boiler. When a boiler has a logged run time of 5,000 Hours (user adjustable) a 
Maintenance alarm will be raised. After the boiler has been serviced, the alarm can be reset via the supervisor. 

 

 Pump System control 

The system will be enabled when any plant requiring CT (Constant Temperature) water calls for it. The system will be 
disabled when no plant requires CT water. 
When the system is enabled any faults will be reset and the pump will be started.  
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After the pump has run for 20 seconds the system will monitor the differential pressure across the pump and if no flow is 
detected for a period of 10 seconds the pump will be deemed to be in fault.  

This fault will be latched until reset by either the operator or a system restart.  

A general alarm will then be raised indicating that the pump is in fault. The pump will be disabled.  

When the system is disabled the pump will continue to run for 10 minutes to dissipate any residual heat left in the system, 
and then the pump will be stopped. 

 

 Pump System reset 

The system can be reset via the supervisor. This will clear all latched faults. If the system is enabled and is in fault, the system 
will be restarted as described in System Control. 

 

 Pump frost protection 

If the pump is not enabled and either a Frost Level 1 or a Frost Level 2 is initiated, then the pump control will be enabled. This 
will remain enabled until all frost states are cleared. 

 

 Pump Hours run 

The system will log the ‘hours run’ for the pump. When the pump has a logged run time of 5,000 hours (user adjustable) a 
Maintenance alarm will be raised. After the pump has been serviced, the alarm can be reset via the supervisor. 

 

 Pump Override  

The system can be overridden Off or On via the supervisor. If overridden Off the system will ignore all demands to run. If 
overridden On the system will run, but any safety interlocks will remain active. 

 

 Fire 

If a Fire alarm is detected, the pump will be stopped. When the Fire alarm has cleared the pump will then restart as per the 
system run, if required. 
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1.1.3.5 Four-Boiler Modulating Sequence Control with External shunt pump 

Summary 

This Sample Application will control 4 boilers with modulating control including the associated pumps.  

The lead boiler will be changed at 2:00am on Sunday. On failure of a boiler or associated pump it will be taken out of the 
sequence until reset. 

 

Number of Strategy blocks used   708 

 

 This Sample Application uses the following macros:  

 Macro: SEQUENCE CONTROL 

Option Value Comment 

Type Select 0 Cascade 1 

HoursRunTime 0 Time 

Time Of Day (Day) 

Time Of Day (Hour) 

Sun 

2 

Only Sunday checked 

Hours 

Setpoint SP  
78 

(172 
°C 
°F) 

Deadband DB  
2 

(4 
°C 
°F) 

PI Loop Gain 8  

PI Loop Integral 600 seconds 

Min On Time 0 seconds 

Min Off Time 0 seconds 

Next Stage On Time 60 seconds 

Next Stage Off Time 60 seconds 

Stage 1 On 0 % 

Stage 1 Off 5 % 

Stage On 10 % 

Stage Off 90 % 

 Macro: SEQUENCE MODULE 

Option Value Comment 

Hi-Lo 0 Lo 

 Macro: SINGLE PLANT CONTROL 

Option Value Comment 

Fault Select 1 DPS 

DPS Fault Monitor 0 Run Only 

Stop on Fault 0 Yes 

Fault Monitor Delay 20 Seconds 

Fault Delay 10 Seconds 

Maintenance  Limit 5000 Hours 

Run on time 600 Seconds 

A System Description for any system based on this Sample Application is given on the following pages. 
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Four-Boiler Modulating Sequence Control with External Shunt Pump 

 System overview 

The boiler system consists of the following plant: 

 4 Modulating Boilers lockout indication. 

 4 Shunt pumps 

 1 Return temperature sensor. 

The boilers will operate on demand with the lead boiler changing each week.  

 

 System Control 

The system will be enabled when any plant requiring hot water calls for it. The system will be disabled when no plant 
requires hot water. 

When the system is enabled the pump control will be enabled and when the DPS (Differential Pressure Switch) across the 
pump has proved flow for 30 seconds the boiler control will be enabled. 

When the system is disabled the boiler control will be disabled and the pump will continue to run for 10 minutes to 
dissipate any residual heat left in the system and then the pump will be stopped. 

 

 Boiler Control 

When the system is enabled the system will determine how many boilers are required to meet the system demand and will 
adjust the enabled boilers and modulation as required.  

If a boiler fails, then a Boiler Lockout alarm will be raised at the supervisor and it will be taken out of the sequence until the 
alarm has been reset by the supervisor.   

When the required return temperature is achieved, the boiler control will remain static until the return temperature either 
rises 2 °C (4 °F) above or falls 2 °C (4 °F) below the required temperature.  

 

 Boiler rotation 

The lead boiler will be automatically rotated at 2:00am on Sunday morning. The operator will also have the following 
options via the supervisor. 

1. To fix the lead boiler disabling the automatic rotation. 

2. To fix the number of boilers in the sequence. 

 

 Boiler System reset 

Each boiler has a reset for a lockout alarm. When active this alarm must be reset before the boiler can be made available to 
the boiler sequencer.   

 

 Boiler Hours run 

The system will log the hours run for each boiler. When a boiler has a logged run time of 5,000 Hours (user adjustable) a 
Maintenance alarm will be raised. After the boiler has been serviced, the alarm can be reset via the supervisor. 

 

 Pump System control 

The system will be enabled when any plant requiring hot water calls for it. The system will be disabled when no plant 
requires hot water. 
When the system is enabled any faults will be reset and the pump will be started.  
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After the pump has run for 20 seconds the system will monitor the differential pressure across the pump and if no flow is 
detected for a period of 10 seconds the pump will be deemed to be in fault.  

This fault will be latched until reset by either the operator or a system restart.  

A general alarm will then be raised indicating that the pump is in fault. The pump will be disabled.  

When the system is disabled the pump will continue to run for 10 minutes to dissipate any residual heat left in the system, 
and then the pump will be stopped. 

 

 Pump System reset 

The system can be reset via the supervisor. This will clear all latched faults. If the system is enabled and is in fault, the system 
will be restarted as described in System Control.  

 

 Pump frost protection 

If the pump is not enabled and either a Frost Level 1 or a Frost Level 2 is initiated, then the pump control will be enabled. This 
will remain enabled until all frost states are cleared. 

 

 Pump Hours run 

The system will log the ‘hours run’ for the pump. When the pump has a logged run time of 5,000 hours (user adjustable) a 
Maintenance alarm will be raised. After the pump has been serviced, the alarm can be reset via the supervisor. 

 

 Pump Override  

The system can be overridden Off or On via the supervisor. If overridden Off the system will ignore all demands to run. If 
overridden On the system will run, but any safety interlocks will remain active. 

 

 Fire 

If a Fire alarm is detected, the pump will be stopped. When the Fire alarm has cleared the pump will then restart as per the 
system run, if required. 
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1.1.3.6 Four-Boiler Hi/Lo Sequence Control with External Shunt Pump 

Summary 

This Sample Application will control 2 boilers with Hi-Lo control and the associated pumps.  

The lead boiler will be changed at 2:00am on Sunday. On failure of a boiler or associated pump it will be taken out of the 
sequence until reset. 

 

Number of Strategy blocks used   356 

 

 This Sample Application uses the following macros:  

 Macro: SEQUENCE CONTROL 

Option Value Comment 

Type Select 0 Cascade 1 

HoursRunTime 0 Time 

Time Of Day (Day) 

Time Of Day (Hour) 

Sun 

2 

Only Sunday checked 

Hours 

Setpoint SP  
78 

(172 
°C 
°F) 

Deadband DB  
2 

(4 
°C 
°F) 

PI Loop Gain 8  

PI Loop Integral 600 seconds 

Min On Time 0 seconds 

Min Off Time 0 seconds 

Next Stage On Time 60 seconds 

Next Stage Off Time 60 seconds 

Stage 1 On 0 % 

Stage 1 Off 5 % 

Stage On 10 % 

Stage Off 90 % 

 Macro: SEQUENCE MODULE 

Option Value Comment 

Hi-Lo 1 Hi 

 Macro: SINGLE PLANT CONTROL 

Option Value Comment 

Fault Select 1 DPS 

DPS Fault Monitor 0 Run Only 

Stop on Fault 0 Yes 

Fault Monitor Delay 20 Seconds 

Fault Delay 10 Seconds 

Maintenance  Limit 5000 Hours 

Run on time 600 Seconds 

A System Description for any system based on this Sample Application is given on the following pages.  
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Four-Boiler Hi/Lo Sequence Control with External Shunt Pump 

 System overview 

The boiler system consists of the following plant: 

 2 Hi-Lo Fire Boilers lockout indication. 

 2 Shunt pumps 

 1 Return temperature sensor. 

The boilers will operate on demand with the lead boiler changing each week.  

 

 System Control 

The system will be enabled when any plant requiring hot water calls for it. The system will be disabled when no plant 
requires hot water. 

When the system is enabled the pump control will be enabled and when the DPS (Differential Pressure Switch) across the 
pump has proved flow the boiler control will be enabled. 

When the system is disabled the boiler control will be disabled and the pump will continue to run for 10 minutes to 
dissipate any residual heat left in the system and then the pump will be stopped. 

 

 Boiler Control 

When the system is enabled the system will determine how many boilers are required to meet the system demand and will 
adjust the enabled boilers and modulation as required.  

If a boiler fails, then a Boiler Lockout alarm will be raised at the supervisor and it will be taken out of the sequence until the 
alarm has been reset by the supervisor.   

When the required return temperature is achieved, the boiler control will remain static until the return temperature either 
rises 2 °C (4 °F) above or falls 2 °C (4 °F) below the required temperature.  

 

 Boiler rotation 

The lead boiler will be automatically rotated at 2:00am on Sunday morning. The operator will also have the following 
options via the supervisor. 

1. To fix the lead boiler disabling the automatic rotation. 

2. To fix the number of boilers in the sequence. 

 

 Boiler System reset 

Each boiler has a reset for a lockout alarm. When active this alarm must be reset before the boiler can be made available to 
the boiler sequencer.   

 

 Boiler Hours run 

The system will log the hours run for each boiler. When a boiler has a logged run time of 5,000 Hours (user adjustable) a 
Maintenance alarm will be raised. After the boiler has been serviced, the alarm can be reset via the supervisor. 

 

 Pump System control 

The system will be enabled when any plant requiring CT (Constant Temperature) water calls for it. The system will be 
disabled when no plant requires CT water. 
When the system is enabled any faults will be reset and the pump will be started.  
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When the system is enabled any faults will be reset and the pump will be started. After the pump has run for 20 seconds the 
system will monitor the differential pressure across the pump and if no flow is detected for a period of 10 seconds the 
pump will be deemed as in fault.  

This fault will be latched until reset by either the operator or a system restart.  

A general alarm will then be raised indicating that the pump is in fault. The pump will be disabled.  

When the system is disabled the pump will continue to run for 10 minutes to dissipate any residual heat left in the system, 
and then the pump will be stopped. 

 

 Pump System reset 

The system can be reset via the supervisor. This will clear all latched faults. If the system is enabled and is in fault, the system 
will be restarted as described in System Control.  

 

 Pump frost protection 

If the pump is not enabled and either a Frost Level 1 or a Frost Level 2 is initiated, then the pump control will be enabled. This 
will remain enabled until all frost states are cleared. 

 

 Pump Hours run 

The system will log the ‘hours run’ for the pump. When the pump has a logged run time of 5,000 hours (user adjustable) a 
Maintenance alarm will be raised. After the pump has been serviced, the alarm can be reset via the supervisor. 

 

 Pump Override  

The system can be overridden Off or On via the supervisor. If overridden Off the system will ignore all demands to run. If 

overridden On the system will run, but any safety interlocks will remain active. 

 

 Fire 

If a Fire alarm is detected, the pump will be stopped. When the Fire alarm has cleared the pump will then restart as per the 
system run, if required. 
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1.1.3.7 Four-Boiler Modulating Parallel Control 

Summary 

This Sample Application will control 4 boilers with modulating control in parallel.  

The lead boiler will be changed at 2:00am on Sunday. On failure of a boiler it will be taken out of the sequence until reset. 

 

Number of Strategy blocks used   452 

 

 This Sample Application uses the following macros:  

 Macro: SEQUENCE CONTROL 

Option Value Comment 

Type Select 2 Parallel 1 

HoursRunTime 0 Time 

Time Of Day (Day) 

Time Of Day (Hour) 

Sun 

2 

Only Sunday checked 

Hours 

Setpoint SP  78 

(172 

°C 

°F) 

Deadband DB  2 

(4 

°C 

°F) 

PI Loop Gain 8  

PI Loop Integral 600 seconds 

Min On Time 0 seconds 

Min Off Time 0 seconds 

Next Stage On Time 60 seconds 

Next Stage Off Time 60 seconds 

Stage 1 On 30 % 

Stage 1 Off 10 % 

Stage On 90 % 

Stage Off 20 % 

 

 Macro: SEQUENCE MODULE 

Option Value Comment 

Hi-Lo 0 Lo 

 
 

A System Description for any system based on this Sample Application is given on the following page. 
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Four-Boiler Modulating Parallel Control 
 System overview. 

The boiler system consists of the following plant: 

 4 Modulating Boilers with integral shunt pumps and lockout indication. 

 1 Return temperature sensor. 

The boilers will operate on demand with the lead boiler changing each week.  

 System Control 

The system will be enabled when any plant requiring hot water calls for it. The system will be disabled when no plant 
requires hot water. 

When the system is enabled the boiler control will be enabled. 

When the system is disabled the boiler control will be disabled. 

 Boiler Control 

When the system is enabled the system will determine how many boilers are required to meet the system demand and will 
adjust the enabled boilers and modulation as required.  

When another boiler is sequenced on, the total required demand will be shared equally between all the enabled boilers. 
Therefore, if the total demand is 120% and two boilers are on, each boiler will have its demand set to 60%. 

If a boiler fails, then a Boiler Lockout alarm will be raised at the supervisor and it will be taken out of the sequence until the 
alarm has been reset by the supervisor.   

When the required return temperature is achieved, the boiler control will remain static until the return temperature either 
rises 2 °C (4 °F) above or falls 2 °C (4 °F) below the required temperature.  

 Boiler rotation 

The lead boiler will be automatically rotated at 2:00am on Sunday morning. The operator will also have the following 
options via the supervisor. 

1. To fix the lead boiler disabling the automatic rotation. 

2. To fix the number of boilers in the sequence. 

3. To fix the demand output of the last boiler in the sequence. 
 

 System reset 

Each boiler has a reset for a lockout alarm. When active this alarm must be reset before the boiler can be made available to 
the boiler sequencer.   

 Hours run 

The system will log the hours run for each boiler. When a boiler has a logged run time of 5,000 Hours (user adjustable) a 
Maintenance alarm will be raised. After the boiler has been serviced, the alarm can be reset via the supervisor. 
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1.1.4.1 HWS with On-Off control 

Summary 

This Sample Application will control an HWS (Hot Water System) calorifer with On-Off valve control.  

It will generate alarms on temperature out of limits and high limit.   

 

Number of Strategy blocks used   44 

 

 This Sample Application uses the following macros:  

 

 Macro: HWS CONTROL 

Option Value Comment 

Setpoint SP  60 

(140 

°C 

°F) 

Deadband DB  2 

(4 

°C 

°F) 

 

 Macro: SENSOR ALARM AND LOG 

(no settings required) 

 

 

A System Description for any system based on this Sample Application is given on the following page. 
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HWS with On-Off control 

 System overview 

The HWS (Hot Water System) consists of the following plant:  

 HWS calorifer. 

 HWS Valve On-Off. 

The system will be enabled by a time schedule. 

  

 System control 

The system will be enabled via a user adjustable schedule initially set to 7:00 – 18:00 for Monday to Friday.  

When enabled, the system will enable the temperature control.  

When disabled the system will disable the temperature control. 

 

 Temperature control. 

The temperature control will enable-disable the valve to achieve a temperature of 60 °C (140 °F) in the calorifer. If the high 
limit stat is activated, then the system will close the valve. 
If the temperature deviates from this temperature for 5 minutes, then an alarm will be raised at the supervisor indicating 
that the HWS system has failed. 

 

 High Limit. 

The calorifer is protected by a hard wired thermostat that will close an isolating valve. This thermostat will require a manual 
reset. When active, it will raise an alarm at the supervisor. 
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1.1.4.2 HWS control with circulation pump 

Summary 

This Sample Application will control an HWS (Hot Water System) calorifer with On-Off valve control valve and circulation 
pump.  

It will generate alarms on temperature out of limits and high limit. 

 

Number of Strategy blocks used   116 

 

 This Sample Application uses the following macros:  

 Macro: HWS CONTROL 

Option Value Comment 

Setpoint SP  60 

(140 

°C 

°F) 

Deadband DB  2 

(4 

°C 

°F) 

 

 Macro: SENSOR ALARM AND LOG 

(no settings required) 

 

 Macro: SINGLE PLANT CONTROL 

Option Value  

Fault Select 1 DPS 

DPS Fault Monitor 0 Run Only 

Stop on Fault 1 No -Run 

Fault Monitor Delay 20 Seconds 

Fault Delay 10 Seconds 

Maintenance  Limit 5000 Hours 

Run on time 600 Seconds 

 
 
 
 

 

A System Description for any system based on this Sample Application is given on the following pages. 
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HWS control with circulation pump 

 System overview 

The HWS (Hot Water System) consists of the following plant:  

 HWS calorifer. 

 HWS Valve On-Off. 

 Circulation pump with DOL (Direct On Line) starter. 

 DPS (Differential Pressure Sensor) across the pump. 

The system will be enabled by a time schedule. 

  

 System control 

The system will be enabled via a user adjustable schedule initially set to 7:00 – 18:00 for Monday to Friday.  

When enabled, the system will enable the temperature control.  

When disabled the system will disable the temperature control and after 5 minutes disable the pump control. 

 

 Temperature control. 

The temperature control will modulate the valve to achieve a temperature of 60 °C (140 °F) in the calorifer. If the high limit 
stat is activated, then the system will close the valve. 
If the temperature deviates from this temperature for 5 minutes, then an alarm will be raised at the supervisor indicating 
that the HWS system has failed. 

 

 High Limit. 

The calorifer is protected by a hard-wired thermostat that will close an isolating valve. This thermostat will require a manual 
reset. When active it will raise an alarm at the supervisor. 

 

 Pump control. 

When the pump control is enabled any faults will be reset and the pump will be started. After the pump has run for 20 
seconds the system will monitor the differential pressure across the pump, and if no flow is detected for a period of 10 
seconds the pump will be deemed as in fault.  

This fault will be latched until reset by either the operator or a system restart. A general alarm will then be raised indicating 
that the pump is in fault.  

The pump will still remain enabled until the system is disabled.  

When the system is disabled the pump will continue to run for 5 minutes to dissipate any residual heat left in the system 
and then the pump will be stopped. 

 

 Pump reset. 

The system can be reset via the supervisor. This will clear all latched faults. If the system is enabled and is in fault, the system 
will be restarted as described in System Control.  

 

 Pump frost protection 

If the pump is not enabled and either a frost level 1 or 2 is initiated, then the pump control will be enabled. This will remain 
enabled until all frost states are cleared. 
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 Hours run 

The system will log the hours run for the pump. When the pump has a logged run time of 5,000 Hours (User adjustable) a 
maintenance alarm will be raised. After the pump has been serviced the alarm can be reset via the supervisor. 

 

 Override 

The system can be overridden off or on via the supervisor. If overridden off the system will ignore any demands to run. If 

overridden on the system will run but any safety interlocks will remain active. 

 

 Fire 

If a fire alarm is detected the pump will be stopped. When the fire alarm has cleared the pump will then restart as per the 
system run if required.  
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1.1.4.3 HWS control with circulation and de-stratification pump 

Summary 

This Sample Application will control an HWS (Hot Water System) calorifer with an analogue valve and circulation pump.  

It will generate alarms on temperature out of limits and high limit. 

 

Number of Strategy blocks used   182 

 

 

 This Sample Application uses the following macros:  

 

 Macro: HWS CONTROL 

Option Value Comment 

Setpoint SP  60 

(140 

°C 

°F) 

Deadband DB  2 

(4 

°C 

°F) 

Legionella SP 80 Seconds 

Legionella Run time 60 Minutes 

 

 Macro: SENSOR ALARM AND LOG 

(no settings required) 

 

 Macro: SINGLE PLANT CONTROL (Circulation and Destrat Pumps) 

Option Value  

Fault Select 1 DPS 

DPS Fault Monitor 0 Run Only 

Stop on Fault 1 No -Run 

Fault Monitor Delay 20 Seconds 

Fault Delay 10 Seconds 

Maintenance  Limit 5000 Hours 

Run on time 600 Seconds 

 
 
 

A System Description for any system based on this Sample Application is given on the following pages. 
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HWS control with circulation and de-stratification pump 

 System overview 

The HWS (Hot Water System) consists of the following plant:  

 HWS calorifer. 

 HWS Valve 0-10V.  

 Circulation pump with DOL (Direct On Line) starter. 

 DPS (Differential Pressure Switch) across the Circulation pump. 

 De-stratification pump with DOL starter. 

 DPS across the De-stratification pump. 

The system will be enabled by a time schedule. 

 

 System control 

The system will be enabled via a user adjustable schedule initially set to 7:00 – 18:00 for Monday to Friday.  

When enabled, the system will enable the temperature control.  

When disabled the system will disable the temperature control and after 5 minutes disable the pump control. 

 

 Temperature control 

The temperature control will modulate the valve to achieve a temperature of 60 °C (140 °F) in the calorifer. If the high limit 
stat is activated, then the system will close the valve. 
If the temperature deviates from this temperature for 5 minutes, then an alarm will be raised at the supervisor indicating 
that the HWS system has failed. 

 

 High Limit 

The calorifer is protected by a hard wired thermostat that will close an isolating valve. This thermostat will require a manual 
reset. When active it will raise an alarm at the supervisor. 

 

 De-stratification Pump control 

When the de-stratification pump control is enabled it will monitor the high and low temperature sensors in the calorifer and 
if the difference is greater than 5 °C (9 °F) for 60 seconds it will enable the pump until the difference is less than 5 °C (9 °F) 
for 60 seconds.  

After the pump has been enabled and run for 20 seconds, the system will monitor the differential pressure across the 
pump, and if no flow is detected for a period of 10 seconds the pump will be deemed as in fault.  

This fault will be latched until reset by either the operator or a system restart. A general alarm will be then raised indicating 
that the pump is in fault.  

The pump will still remain enabled until the system is disabled.  

 

 De-stratification Pump reset 

The system can be reset via the supervisor. This will clear all latched faults. If the system is enabled and is in fault, the system 
will be restarted as described in System Control.  

 De-stratification Hours run 

The system will log the hours run for the pump. When the pump has a logged run time of 5,000 Hours (User adjustable) a 
maintenance alarm will be raised. After the pump has been serviced the alarm can be rest via the supervisor. 
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 De-stratification Fire 

If a fire alarm is detected the pump will be stopped. When the fire alarm has cleared the pump will then restart as per the 
system run if required.  

 

 Circulation Pump control 

When the circulation pump control is enabled any faults will be reset and the pump will be started. After the pump has run 
for 20 seconds the system will monitor the differential pressure across the pump, and if no flow is detected for a period of 
10 seconds the pump will be deemed as in fault.  

This fault will be latched until reset by either the operator or a system restart. A general alarm will be then raised indicating 
that the pump is in fault.  

The pump will still remain enabled until the system is disabled.  

When the system is disabled the pump will continue to run for 5 minutes to dissipate any residual heat left in the system 
and then the pump will be stopped. 

 

 Circulation Pump reset 

The system can be reset via the supervisor. This will clear all latched faults. If the system is enabled and is in fault, the system 
will be restarted as described in System Control.  

 

 Circulation Pump frost protection 

If the pump is not enabled and either a frost level 1 or 2 is initiated, then the pump control will be enabled. This will remain 
enabled until all frost states are cleared. 

 

 Circulation Hours run 

The system will log the hours run for the pump. When the pump has a logged run time of 5,000 hours (User adjustable) a 
maintenance alarm will be raised. After the pump has been serviced the alarm can be rest via the supervisor. 

 

 Circulation Override 

The system can be overridden off or on via the supervisor. If overridden off the system will ignore any demands to run. If 

overridden on the system will run but any safety interlocks will remain active. 

 

 Circulation Fire 

If a fire alarm is detected the pump will be stopped. When the fire alarm has cleared the pump will then restart as per the 
system run if required.   
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1.1.4.4 HWS control with circulation pump and Legionella prevention 

Summary 

This Sample Application will control an HWS (Hot Water System) calorifer with an analogue valve and circulation pump.  

It will generate alarms on temperature out of limits and high limit. 

 

 

Number of Strategy blocks used   119 

 

 This Sample Application uses the following macros:  

 

 Macro: HWS CONTROL 

Option Value Comment 

Setpoint SP  60 

(140 

°C 

°F) 

Deadband DB  2 

(4 

°C 

°F) 

Legionella SP 80 Seconds 

Legionella Run time 60 Minutes 

 

 Macro: SENSOR ALARM AND LOG 

(no settings required) 

 

 Macro: SINGLE PLANT CONTROL 

Option Value  

Fault Select 1 DPS 

DPS Fault Monitor 0 Run Only 

Stop on Fault 1 No -Run 

Fault Monitor Delay 20 Seconds 

Fault Delay 10 Seconds 

Maintenance  Limit 5000 Hours 

Run on time 600 Seconds 

 
 
 

A System Description for any system based on this Sample Application is given on the following pages. 
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HWS control with circulation pump and Legionella prevention 

 System overview 

The HWS (Hot Water System) consists of the following plant:  

 HWS calorifer. 

 HWS Valve On-Off.  

 Circulation pump with DOL (Direct On Line) starter. 

 DPS (Differential Pressure Switch) across the pump. 

The system will be enabled by a time schedule. 

 

 System control 

The system will be enabled via a user adjustable schedule initially set to 7:00 – 18:00 for Monday to Friday.  

When enabled, the system will enable the temperature control.  

When disabled the system will disable the temperature control and after 5 minutes disable the pump control. 

 

 Temperature control. 

The temperature control will enable-disable the valve to achieve a temperature of 60 °C (140 °F) in the calorifer. If the high 
limit stat is activated, then the system will close the valve. 
If the temperature deviates from this temperature for 5 minutes, then an alarm will be raised at the supervisor indicating 
that the HWS system has failed.  

 

 Legionella control. 

The legionella temperature control will be activated at midnight every Saturday and run until the calorifer temperature has 
been at 80 °C (176 °F) for 1 hour.  

If this is not achieved before the next start time a Legionella fail alarm will be raised at the supervisor and normal temperature 
control will be resumed.  

If the high limit stat is activated, then the system will close the valve. 

If the temperature deviates from this temperature for 5 minutes, then an alarm will be raised at the supervisor indicating 
that the HWS system has failed. 

 

 High Limit. 

The calorifer is protected by a hard wired thermostat that will close an isolating valve. This thermostat will require a manual 
reset. When active it will raise an alarm at the supervisor. 
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 Pump control. 

When the pump control is enabled any faults will be reset and the pump will be started. After the pump has run for 20 
seconds the system will monitor the differential pressure across the pump, and if no flow is detected for a period of 10 
seconds the pump will be deemed as in fault.  

This fault will be latched until reset by either the operator or a system restart. A general alarm will be then raised indicating 
that the pump is in fault.  

The pump will still remain enabled until the system is disabled.  

When the system is disabled the pump will continue to run for 5 minutes to dissipate any residual heat left in the system 
and then the pump will be stopped. 

 

 Pump reset. 

The system can be reset via the supervisor. This will clear all latched faults. If the system is enabled and is in fault, the system 
will be restarted as described in System Control.  

 

 Pump frost protection 

If the pump is not enabled and either a frost level 1 or 2 is initiated, then the pump control will be enabled. This will remain 
enabled until all frost states are cleared. 

 

 Hours run 

The system will log the hours run for the pump. When the pump has a logged run time of 5,000 hours (User adjustable) a 
maintenance alarm will be raised. After the pump has been serviced the alarm can be rest via the supervisor. 

 

 Override 

The system can be overridden off or on via the supervisor. If overridden off the system will ignore any demands to run. If 

overridden on the system will run but any safety interlocks will remain active. 

 

 Fire 

If a fire alarm is detected the pump will be stopped. When the fire alarm has cleared the pump will then restart as per the 
system run if required.  
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1.1.5.1 Two-Chiller On/Off Sequence Control 

Summary 

This Sample Application will control 2 chillers with on-off control.  

The lead chiller will be changed at 2:00am on Sunday.  

On failure of a chiller it will be taken out of the sequence until reset. 

 

Number of Strategy blocks used   303 

 

 This Sample Application uses the following macros:  

 

 Macro: SEQUENCE CONTROL 

Option Value  

Type Select 0 Cascade 1 

HoursRunTime 0 Time 

Time Of Day (Day) 

Time Of Day (Hour) 

Sun 

2 

Only Sunday checked 

Hours 

Setpoint SP  
78 

(172 
°C 
°F) 

Deadband DB  
2 

(4 
°C 
°F) 

PI Loop Gain 12 
(22 

°C 
°F) 

PI Loop Integral 600 seconds 

PI Offset 10 % 

Min On Time 0 seconds 

Min Off Time 0 seconds 

Next Stage On Time 60 seconds 

Next Stage Off Time 60 seconds 

Stage 1 On 30 % 

Stage 1 Off 10 % 

Stage On 90 % 

Stage Off 10 % 

 

 Macro: SEQUENCE MODULE 

Option Value  

HiLo Select 0 Low 

 

 
A System Description for any system based on this Sample Application is given on the following page. 
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Two Chiller On/Off Sequence Control 

 System overview 

The chiller system consists of the following plant:  

 2 Chillers with integral shunt pumps and fault indication. 

 1 Return Temperature sensor. 

The chiller will operate on demand with lead chiller changing each week. 

 

 System Control 

The system will be enabled when any plant requiring chilled water calls for it. The system will be disabled when no plant 
requires chilled water. 

When the system is enabled the chiller control will be enabled. 

When the system is disabled the chiller control will be disabled. 

 

 Chiller Control 

When the system is enabled the system determines how many chillers are required to meet the system demand and adjusts 
the enabled chillers as required.  

If a chiller fails, then a chiller failed alarm will be raised at the supervisor and it will be taken out of the sequence until the 
alarm has been reset by the supervisor.   

When the required return temperature is achieved the chiller control will remain static until the return temperature either 
rises beyond 1 °C (2 °F) above or falls beyond 1 °C (2 °F) below the required temperature.  

 

 Chiller rotation 

The lead chiller will be automatically rotated at 2:00am on Sunday morning.  

The operator will also have the following options via the supervisor: 

 To fix the lead chiller, disabling the automatic rotation. 

 To fix the number of chillers in the sequence. 

 

 System reset 

Each chiller has a reset for a failed alarm. When active, this alarm must be reset before the chiller can be made available to 
the chiller sequencer.   

 

 Hours run 

The system will log the hours run for each chiller. When a chiller has a logged run time of 5,000 Hours (User adjustable) a 
maintenance alarm will be raised. After the chiller has been serviced the alarm can be rest via the supervisor. 
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1.1.5.2 Two-Chiller Modulating Sequence Control 

Summary 

This Sample Application will control 2 chillers with modulating control.  

The lead chiller will be changed at 2:00am on Sunday.  

On failure of a chiller it will be taken out of the sequence until reset. 

 

Number of Strategy blocks used   303 

 

 This Sample Application uses the following macros:  

 

 Macro: SEQUENCE CONTROL 

Option Value  

Type Select 0 Cascade 1 

HoursRunTime 0 Time 

Time Of Day (Day) 

Time Of Day (Hour) 

Sun 

2 

Only Sunday checked 

Hours 

Setpoint SP  
78 

(172 
°C 
°F) 

Deadband DB  
2 

(4 
°C 
°F) 

PI Loop Gain 12 
(22 

°C 
°F) 

PI Loop Integral 600 seconds 

PI Offset 10 % 

Min On Time 0 seconds 

Min Off Time 0 seconds 

Min On Time 0 seconds 

Next Stage On Time 60 seconds 

Next Stage Off Time 60 seconds 

Stage 1 On 30 % 

Stage 1 Off 10 % 

Stage On 90 % 

Stage Off 10 % 

 

 

 Macro: SEQUENCE MODULE 

Option Value  

HiLo Select 0 Low 

 
A System Description for any system based on this Sample Application is given on the following page. 
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Two Chiller Modulating Sequence Control 

 System overview 

The chiller system consists of the following plant:  

 2 Modulating Chillers with integral shunt pumps and fault indication. 

 1 Return temperature sensor. 

The chiller will operate on demand with lead chiller changing each week. 

 

 System Control 

The system will be enabled when any plant requiring chilled water calls for it. The system will be disabled when no plant 
requires chilled water. 

When the system is enabled the chiller control will be enabled. 

When the system is disabled the chiller control will be disabled. 

 

 Chiller Control 

When the system is enabled the system will determine how many chillers are required to meet the system demand and will 
adjust the enabled boilers and modulation as required.  

When another chiller is sequenced on, the total required demand will be shared equally between all the enabled chillers. 
Therefore, if the total demand is 120% and two chillers are on, each chiller will have its demand set to 60%. 

If a chiller fails, then a chiller failed alarm will be raised at the supervisor and it will be taken out of the sequence until the alarm 
has been reset by the supervisor.   

When the required return temperature is achieved, the chiller control will remain static until the return temperature either 
rises 1 °C (2 °F) above or falls 1 °C (2 °F) below the required temperature.  

 

 Chiller rotation 

The lead chiller will be automatically rotated at 2:00am on Sunday morning.  

The operator will also have the following options via the supervisor: 

 To fix the lead chiller disabling the automatic rotation. 

 To fix the number of chillers in the sequence.  

 To fix the demand output of the last chiller in the sequence. 

 

 System reset 

Each chiller has a reset for a fault alarm. When active, this alarm must be reset before the chiller can be made available to 
the chiller sequencer.   

 

 Hours run 

The system will log the hours run for each chiller. When a chiller has a logged run time of 5,000 Hours (User adjustable) a 
maintenance alarm will be raised. After the chiller has been serviced the alarm can be rest via the supervisor. 
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1.1.5.3 Two-Chiller On/Off Sequence Control with Shunt pump 
Summary 

This Sample Application will control 2 chillers with on-off control and the associated shunt pumps.  

The lead chiller will be changed at 2:00am on Sunday.  

On failure of a chiller it will be taken out of the sequence until reset. 

 

Number of Strategy blocks used   438 

 This Sample Application uses the following macros:  

 Macro: SEQUENCE CONTROL 

Option Value  

Type Select 0 Cascade 1 

HoursRunTime 0 Time 

Time Of Day (Day) 

Time Of Day (Hour) 

Sun 

2 

Only Sunday checked 

Hours 

Setpoint SP  
78 

(172 
°C 
°F) 

Deadband DB  
2 

(4 
°C 
°F) 

PI Loop Gain 12 
(22 

°C 
°F) 

PI Loop Integral 600 seconds 

PI Offset 10 % 

Min On Time 0 seconds 

Min Off Time 0 seconds 

Next Stage On Time 60 seconds 

Next Stage Off Time 60 seconds 

Stage 1 On 30 % 

Stage 1 Off 10 % 

Stage On 90 % 

Stage Off 10 % 

 Macro: SEQUENCE MODULE 

Option Value  

HiLo Select 0 Low 

 Macro: SINGLE PLANT CONTROL 

Option Value  

Fault Select 1 DPS 

DPS Fault Monitor 0 Run Only 

Stop on Fault 0 Yes 

Fault Monitor Delay 20 Seconds 

Fault Delay 10 Seconds 

Maintenance  Limit 5000 Hours 

Run on time 600 Seconds 

A System Description for any system based on this Sample Application is given on the following pages. 
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Two Chiller On/Off Sequence Control with Shunt Pump 

 System overview 

The chiller system consists of the following plant:  

 2 Chillers with fault indication. 

 2 Shunt pumps. 

 1 Return temperature sensor.  

The chiller will operate on demand with lead chiller changing each week. 

 

 System Control 

The system will be enabled when any plant requiring chilled water calls for it. The system will be disabled when no plant 
requires chilled water. 

When the system is enabled the pump control will be enabled and when the DPS (differential Pressure) across the pump has 
proved flow the Chiller control will be enabled. 

When the system is disabled the Chiller control will be disabled and the pump will continue to run for 10 minutes to 
dissipate any residual heat left in the system and then the pump will be stopped. 

 

 Chiller Control 

When the system is enabled the system determines how many chillers are required to meet the system demand and adjusts 
the enabled chillers as required.  

If a chiller fails, then a chiller failed alarm will be raised at the supervisor and it will be taken out of the sequence until the 
alarm has been reset by the supervisor.   

When the required return temperature is achieved the chiller control will remain static until the return temperature either 
rises beyond 1 °C (2 °F) above or falls beyond 1 °C (2 °F) below the required temperature.  

 

 Chiller rotation 

The lead chiller will be automatically rotated at 2:00am on Sunday morning.  

The operator will also have the following options via the supervisor: 

 To fix the lead chiller disabling the automatic rotation. 

 To fix the number of chillers in the sequence. 

 

 Chiller System reset 

Each chiller has a reset for a failed alarm. When active, this alarm must be reset before the chiller can be made available to 
the chiller sequencer.   

 

 Chiller Hours run 

The system will log the hours run for each chiller. When a chiller has a logged run time of 5,000 Hours (User adjustable) a 
maintenance alarm will be raised. After the chiller has been serviced the alarm can be rest via the supervisor. 

 Pump system control 

The system will be enabled when any plant requiring chilled water calls for it. The system will be disabled when no plant 
requires chilled water. 
When the system is enabled any faults will be reset and the pump will be started.  
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After the pump has run for 20 seconds the system will monitor the differential pressure across the pump and if no flow is 
detected for a period of 10 seconds the pump will be deemed to be in fault.  

This fault will be latched until reset by either the operator or a system restart.  

A general alarm will then be raised indicating that the pump is in fault. The pump will be disabled.  

When the system is disabled the pump will continue to run for 10 minutes to dissipate any residual heat left in the system, 
and then the pump will be stopped. 

 

 Pump System reset 

The system can be reset via the supervisor. This will clear all latched faults. If the system is enabled and is in fault, the system 
will be restarted as described in System Control.  

 

 Pump frost protection 

If the pump is not enabled and either a Frost Level 1 or a Frost Level 2 is initiated, then the pump control will be enabled. This 
will remain enabled until all frost states are cleared. 

 

 Pump Hours run 

The system will log the hours run for the pump. When the pump has a logged run time of 5,000 Hours (user adjustable) a 
maintenance alarm will be raised. After the pump has been serviced, the alarm can be reset via the supervisor. 

 

 Pump Override 

The system can be overridden off or on via the supervisor. If overridden off the system will ignore all demands to run. If 
overridden on the system will run but any safety interlocks will remain active. 

 

 Fire 

If a fire alarm is detected the Chiller and pump and Chiller control will be stopped. When the fire alarm has cleared the Chiller 
and pump will then restart as per the system control if required. 
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1.1.5.4 Two-Chiller Modulating Control with shunt pump 
Summary 

This Sample Application will control 4 Chillers with on-off control and the associated shunt pumps.  

The lead Chiller will be changed at 2:00am on Sunday.  

On failure of a Chiller it will be taken out of the sequence until reset. 

 

Number of Strategy blocks used   438 

This Sample Application uses the following macros:  

 Macro: SEQUENCE CONTROL 

Option Value  

Type Select 0 Cascade 1 

HoursRunTime 0 Time 

Time Of Day (Day) 

Time Of Day (Hour) 

Sun 

2 

Only Sunday checked 

Hours 

Setpoint SP  
78 

(172 
°C 
°F) 

Deadband DB  
2 

(4 
°C 
°F) 

PI Loop Gain 12 
(22 

°C 
°F) 

PI Loop Integral 600 seconds 

PI Offset 10 % 

Min On Time 0 seconds 

Min Off Time 0 seconds 

Next Stage On Time 60 seconds 

Next Stage Off Time 60 seconds 

Stage 1 On 30 % 

Stage 1 Off 10 % 

Stage On 90 % 

Stage Off 10 % 

 Macro: SEQUENCE MODULE 

Option Value  

HiLo Select 0 Low 

 Macro: SINGLE PLANT CONTROL 

Option Value  

Fault Select 1 DPS 

DPS Fault Monitor 0 Run Only 

Stop on Fault 0 Yes 

Fault Monitor Delay 20 Seconds 

Fault Delay 10 Seconds 

Maintenance  Limit 5000 Hours 

Run on time 600 Seconds 

A System Description for any system based on this Sample Application is given on the following pages. 
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Two-Chiller Modulating Control with Shunt Pump 

 System overview 

The chiller system consists of the following plant:  

 2 Chillers with fault indication. 

 2 Shunt pumps. 

 1 Return temperature sensor.  

The chiller will operate on demand with lead chiller changing each week. 

 

 System Control 

The system will be enabled when any plant requiring chilled water calls for it. The system will be disabled when no plant 
requires chilled water. 

When the system is enabled the pump control will be enabled and when the DPS (Differential Pressure Switch) across the 
pump has proved flow the Chiller control will be enabled. 

When the system is disabled the Chiller control will be disabled and the pump will continue to run for 10 minutes to 
dissipate any residual heat left in the system and then the pump will be stopped. 

 

 Chiller Control 

When the system is enabled the system will determine how many chillers are required to meet the system demand and will 
adjust the enabled boilers and modulation as required.  

When another chiller is sequenced on, the total required demand will be shared equally between all the enabled chillers. 
Therefore, if the total demand is 120% and two chillers are on, each chiller will have its demand set to 60%. 

If a chiller fails, then a chiller failed alarm will be raised at the supervisor and it will be taken out of the sequence until the alarm 
has been reset by the supervisor.   

When the required return temperature is achieved, the chiller control will remain static until the return temperature either 
rises 1 °C (2 °F) above or falls 1 °C (2 °F) below the required temperature.  

 

 Chiller rotation 

The lead chiller will be automatically rotated at 2:00am on Sunday morning.  

The operator will also have the following options via the supervisor: 

 To fix the lead chiller disabling the automatic rotation. 

 To fix the number of chillers in the sequence. 

 

 Chiller System reset 

Each chiller has a reset for a failed alarm. When active, this alarm must be reset before the chiller can be made available to 
the chiller sequencer.   

 

 Chiller Hours run 

The system will log the hours run for each chiller. When a chiller has a logged run time of 5,000 hours (user adjustable) a 
maintenance alarm will be raised. After the chiller has been serviced the alarm can be rest via the supervisor. 
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 Pump system control 

The system will be enabled when any plant requiring chilled water calls for it. The system will be disabled when no plant 
requires chilled water. 
When the system is enabled any faults will be reset and the pump will be started.  

After the pump has run for 20 seconds the system will monitor the differential pressure across the pump and if no flow is 
detected for a period of 10 seconds the pump will be deemed to be in fault.  

This fault will be latched until reset by either the operator or a system restart.  

A general alarm will then be raised indicating that the pump is in fault. The pump will be disabled.  

When the system is disabled the pump will continue to run for 10 minutes to dissipate any residual heat left in the system, 
and then the pump will be stopped. 

 

 Pump System reset. 

The system can be reset via the supervisor. This will clear all latched faults. If the system is enabled and is in fault, the system 
will be restarted as described in System Control.  

 

 Pump frost protection 

If the pump is not enabled and either a Frost Level 1 or a Frost Level 2 is initiated, then the pump control will be enabled. This 
will remain enabled until all frost states are cleared. 

 

 Pump Hours run 

The system will log the hours run for the pump. When the pump has a logged run time of 5,000 Hours (user adjustable) a 
maintenance alarm will be raised. After the pump has been serviced, the alarm can be reset via the supervisor. 

 

 Pump Override 

The system can be overridden off or on via the supervisor. If overridden off the system will ignore all demands to run. If 

overridden on the system will run but any safety interlocks will remain active. 

 

 Fire 

If a fire alarm is detected the Chiller and pump and Chiller control will be stopped. When the fire alarm has cleared the Chiller 
and pump will then restart as per the system control if required. 
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1.1.6.1 Four Stage DX Cool Only Sequence Control 

Summary 

This Sample Application will control 4 stage DX (Direct Expansion) cooling control. The lead DX will be changed at 2:00am on 
Sunday. On failure of a DX stage it will be taken out of the sequence until reset. 

 

Number of Strategy blocks used   458 

 

 This Sample Application uses the following macros:  

 

 Macro: SEQUENCE CONTROL 

 

Option Value  

Type Select 0 Cascade 1 

HoursRunTime 0 Time 

Time Of Day (Day) 

Time Of Day (Hour) 

Sun 

2 

Only Sunday checked 

Hours 

Setpoint SP  78 

(172 

°C 

°F) 

Deadband DB  2 

(4 

°C 

°F) 

PI Loop Gain 12 

(22 

°C 

°F) 

PI Loop Integral 600 seconds 

PI Offset 30 % 

Min On Time 0 seconds 

Min Off Time 0 seconds 

Next Stage On Time 60 seconds 

Next Stage Off Time 60 seconds 

Stage 1 On 0 % 

Stage 1 Off 5 % 

Stage On 10 % 

Stage Off 90 % 

 

 Macro: SEQUENCE MODULE 

 

Option Value  

HiLo Select 0 Low 

 

 

A System Description for any system based on this Sample Application is given on the following page. 
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Four Stage DX Cool Only Sequence Control 

 System overview 

The DX (Direct Expansion) system consists of the following plant: 

 4 Stage DX unit. 

 1 Return temperature sensor. 

The DX will operate on demand with lead DX unit changing each week. 

 

 System Control 

The system will be enabled when the plant requires chilled air. The system will be disabled when the plant no longer 
requires chilled air. 

When the system is enabled the DX control will be enabled. 

When the system is disabled the DX control will be disabled. 

 

DX Control. 

When the system is enabled, the system determines how many DX units are required to meet the system demand and 
adjusts the enabled DXs as required.  

The sequencer will only enable or disable one DX unit at any given time.  

Once a DX unit is enabled or disabled the sequencer will not enable or disable another unit for at least 2 minutes.  

If a DX unit fails, then a DX unit failed alarm will be raised at the supervisor and it will be taken out of the sequence until the 
alarm has been reset by the supervisor.   

When the required return temperature is achieved, the DX control will remain static until the return temperature either 
rises beyond 2 °C (4 °F) above or falls beyond 2 °C (4 °F) below the required temperature.  

 

 DX rotation 

The lead DX unit will be automatically rotated at 2:00am on Sunday morning. The operator will also have the following 
options via the supervisor. 

1. To fix the lead DX unit disabling the automatic rotation. 

2. To fix the number of DX units in the sequence. 

 

 System reset 

Each DX unit has a reset for a failed alarm. When active, this alarm must be reset before the DX unit can be made available to 
the sequencer.   

 

 Hours run 

The system will log the hours run for each DX unit. When a DX unit has a logged run time of 5,000 hours (user adjustable) a 
maintenance alarm will be raised. After the DX unit has been serviced the alarm can be reset via the supervisor. 
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1.1.6.2 Four Stage DX Cool Heat Sequence Control 

Summary 

This Sample Application will control 4 stage DX (Direct Expansion) cooling and heating control. The lead DX will be changed at 
2:00am on Sunday. On failure of a DX stage it will be taken out of the sequence until reset. 

 

Number of Strategy blocks used   464 

 

 This Sample Application uses the following macros:  

 

 Macro: SEQUENCE CONTROL 

 

Option Value  

Type Select 0 Cascade 1 

HoursRunTime 0 Time 

Time Of Day (Day) 

Time Of Day (Hour) 

Sun 

2 

Only Sunday checked 

Hours 

Setpoint SP  78 

(172 

°C 

°F) 

Deadband DB  2 

(4 

°C 

°F) 

PI Loop Gain 12 

(22 

°C 

°F) 

PI Loop Integral 600 seconds 

PI Offset 30 % 

Min On Time 0 seconds 

Min Off Time 0 seconds 

Next Stage On Time 60 seconds 

Next Stage Off Time 60 seconds 

Stage 1 On 0 % 

Stage 1 Off 5 % 

Stage On 10 % 

Stage Off 90 % 

 

 Macro: SEQUENCE MODULE 

 

Option Value  

HiLo Select 0 Low 

 

 

A System Description for any system based on this Sample Application is given on the following page. 
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Four Stage DX Cool Heat Sequence Control 

 System overview 

The DX (Direct Expansion) system consists of the following plant: 

 4 Stage DX unit. 

 1 Return temperature sensor. 

The DX will operate on demand with lead DX unit changing each week. 

 

 System Control 

The system will be enabled when the plant requires either chilled or heated air. The system will be disabled when the plant 
no longer requires chilled or heated air. 

When the system is enabled the DX control will be enabled. 

When the system is disabled the DX control will be disabled. 

 

DX Control. 

When the system is enabled, the system determines how many DX units are required to meet the system demand and 
adjusts the enabled DX as required.  

The sequencer will only enable or disable one DX unit at any given time.  

Once a DX unit is enabled or disabled the sequencer will not enable or disable another unit for at least 2 minutes.  

The sequence control will determine if chilled or heated air is required, and will switch the DX units to the relevant mode. 
When a change of mode is required, the sequencer will wait until no DX units are enabled before sending a mode change to 
the DX units. 

If a DX unit fails, then a DX unit failed alarm will be raised at the supervisor and it will be taken out of the sequence until the 
alarm has been reset by the supervisor.   

When the required return temperature is achieved, the DX control will remain static until the return temperature either 
rises beyond 2 °C (4 °F) above or falls beyond 2 °C (4 °F) below the required temperature.  

 

 DX rotation 

The lead DX unit will be automatically rotated at 2:00am on Sunday morning. The operator will also have the following 
options via the supervisor. 

1. To fix the lead DX unit disabling the automatic rotation.  

2. To fix the number of DX units in the sequence. 

 

 System reset 

Each DX unit has a reset for a failed alarm. When active, this alarm must be reset before the DX unit can be made available to 
the sequencer.   

 

 Hours run 

The system will log the hours run for each DX unit. When a DX unit has a logged run time of 5,000 hours (user adjustable) a 
maintenance alarm will be raised. After the DX unit has been serviced the alarm can be reset via the supervisor. 
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AHU 

2.1.1.1 AHU with Heating, Cooling and Full Fresh Air 

Summary 

This Sample Application will control an AHU with full fresh air dampers, heating and cooling valves.  

On failure of either the supply or extract fans the AHU with be disabled until reset. 

 

Number of Strategy blocks used   209 

 This Sample Application uses the following macros:  

 Macro: HEATING COOLING AND FREE ENERGY CONTROL WITH PID 

Option Value  

Htg Gain   8 
(14 

°C 
°F) 

Free Gain   12 
(22 

°C 
°F) 

Clg Gain   8 
(14 

°C 
°F) 

Htg Integral   300 Seconds 

Free Integral   300 Seconds 

Clg Integral   300 Seconds 

Damper Min Pos  10 % 

Htg Frost Stat Pos  100 % 

Free Frost Stat Pos  0 % 

Clg Frost Stat Pos  0 % 

Htg Frost 1_2 Pos  100 % 

Free Frost 1_2 Pos 0 % 

Clg Frost 1_2 Pos 0 % 

Htg Warm Up Pos 100 % 

Free Warm Up Pos 0 % 

Clg Warm Up Pos 0 % 

 Macro: SINGLE PLANT CONTROL (Supply and Extract Fans) 

Option Value Comment 

Fault Select 1 DPS 

DPS Fault Monitor 0 Run Only 

Stop on Fault 0 Yes 

Fault Monitor Delay 20 Seconds 

Fault Delay 10 Seconds 

Maintenance  Limit 5000 Hours 

Run on time 5 Seconds 

A System Description for any system based on this Sample Application is given on the following pages. 
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AHU with Heating, Cooling and Full Fresh Air 

 

 System overview 

This Sample Application will control AHU system with the following plant: 

 Single speed supply fan with DPS (Differential Pressure Switch). 

 Single speed extract fan with DPS.  

 Heating Valve. 

 Cooling Valve. 

 Dampers full fresh air. 

 Damper End Switch. 

 Frost Stat. 

 Space temperature sensor. 

 

 System Start up 

When the AHU is enabled via the schedule, the temperature control will be enabled.  

Ten seconds after the temperature control is enabled the dampers will open.  

Five seconds after the dampers are fully opened the supply fan control will be enabled.  

Five seconds after the supply fan is proved running the extract fan control will be enabled.  

 

 System Control 

When enabled, the system will maintain a space temperature between SP  ±( DB  / 2) within the space.  

If the extract fan or supply fan indicates a fault the system will be disabled, stopping the supply and extract fans, closing the 
damper and stopping the temperature control.  

 

 System Shut Down 

When the schedule has ended, the extract and supply fans will be disabled.  

Ten seconds after the fans have been disabled the dampers will be closed.  

Thirty seconds after the dampers have been closed the temperature control will be disabled. 

 

 Supply Fan Control 

When the supply fan control is enabled the supply fan will be enabled.  

After the supply fan has been enabled for 20 seconds the system will monitor the DPS and if the DPS status is “no flow” for 
10 seconds the supply fan will be deemed as failed and will be disabled.  

The system will raise an alarm at the supervisor indicating that the supply fan has failed. This will require a system reset from 
the supervisor.  
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 Extract Fan Control 

When the extract fan control is enabled the extract fan will be enabled. 

After the extract fan has been enabled for 20 seconds, the system will monitor the DPS, and if the DPS status is “no flow” for 
10 seconds the extract fan will be deemed as failed and will be disabled.  

The system will raise an alarm at the supervisor indicating that the extract fan has failed. This will require a system reset from 
the supervisor.  

 

 Temperature Control 

The required space temperature is set via the space temperature setpoint ( SP ) from the supervisor. This can be adjusted 

between 18 °C (64 °F) and 23 °C (73 °F).  

When the AHU is enabled, the heating and cooling valves will be modulated in sequence to maintain the required space 
temperature.  

The temperature control has a deadband ( DB ) of 2 °C (4 °F). The heating valve will be modulated to maintain the space 

temperature to SP  – ( DB  /2). The cooling valve will be modulated to maintain the space temperature to SP  + ( DB  /2). 

When the temperature is between these limits both the heating and cooling valves will be closed. 

 

 Frost level 1 and 2 protection 

If the AHU is not enabled, and either a frost level 1 or 2 is initiated, then the heating valve will be opened to 100%. This will 
remain enabled until all frost states are cleared or the AHU is enabled. 

 

 Heating coil frost protection 

The heating coil has a frost stat fitted across it, set to activate at 2 °C (36 °F). The stat will auto reset when the temperature 
rises to 5 °C (41 °F). If this stat is activated an alarm will be raised via the supervisor, the fans will be stopped, the heating 
valve opened to 100% and the cooling valve closed. 

 

 Hours run 

The system will log the hours run for both the supply and extract fans. When a fan has a logged run time of 5,000 hours (user 
adjustable) a maintenance alarm will be raised. After the fan has been serviced the alarm can be reset via the supervisor. 

 

 Fire 

If a fire alarm is detected the AHU fans are hard wired to stop. The control software will also disable the fans to stop any false 
alarms.  

 

 AHU reset 

The AHU fans can be reset via a common reset on the supervisor.  
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2.1.1.2 AHU with Heating, Cooling and Dampers 

Summary 

This Sample Application will control an AHU with modulating air dampers, heating and cooling valves. On failure of either the 
supply or extract fans the AHU with be disabled until reset. 

 

Number of Strategy blocks used   234 

 

 This Sample Application uses the following macros:  

 

 Macro: HEATING COOLING AND FREE ENERGY CONTROL WITH PID 

Option Value  

Htg Gain   8 
(14 

°C 
°F) 

Free Gain   12 
(22 

°C 
°F) 

Clg Gain   8 
(14 

°C 
°F) 

Htg Integral   300 Seconds 

Free Integral   300 Seconds 

Clg Integral   300 Seconds 

Damper Min Pos  10 % 

Htg Frost Stat Pos  100 % 

Free Frost Stat Pos  0 % 

Clg Frost Stat Pos  0 % 

Htg Frost 1_2 Pos  100 % 

Free Frost 1_2 Pos 0 % 

Clg Frost 1_2 Pos 0 % 

Htg Warm Up Pos 100 % 

Free Warm Up Pos 0 % 

Clg Warm Up Pos 0 % 

 Macro: SINGLE PLANT CONTROL (Supply and Extract Fans) 

Option Value Comment 

Fault Select 1 DPS 

DPS Fault Monitor 0 Run Only 

Stop on Fault 0 Yes 

Fault Monitor Delay 20 Seconds 

Fault Delay 10 Seconds 

Maintenance  Limit 5000 Hours 

Run on time 5 Seconds 

A System Description for any system based on this Sample Application is given on the following pages. 
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AHU with Heating, Cooling and Dampers. 
 

 System overview 

This Sample Application will control AHU system with the following plant: 

 Single speed supply fan with DPS (Differential Pressure Switch). 

 Single speed extract fan with DPS.  

 Heating Valve. 

 Cooling Valve. 

 Dampers modulating. 

 Frost Stat. 

 Space temperature sensor.  

 Outside air temperature sensor. 

 Return air temperature sensor. 
 

 System Start up 

When the AHU is enabled via the schedule, the supply fan control will be enabled.  

When the supply fan is proved running the temperature control will be enabled with the dampers remaining in the fully 
recirculation position for 2 minutes. 

Five seconds after the supply fan is proved running the extract fan control will be enabled.  

Ten seconds after the temperature control is enabled the dampers will open.  
 

 System Control 

When enabled, the system will maintain a space temperature of 21 °C (69.8 °F) within the space.  

If the extract fan or supply fan indicates a fault the system will be disabled, stopping the supply and extract fans, fully 
closing the damper and stopping the temperature control.  

 

 System Shut Down 

When the schedule has ended, the extract and supply fans will be disabled.  

Ten seconds after the fans have been disabled the temperature control will be disabled fully closing the dampers. 

 

 Supply Fan Control 

When the supply fan control is enabled the supply fan will be enabled.  

After the supply fan has been enabled for 20 seconds the system will monitor the DPS and if the DPS status is “no flow” for 
10 seconds the supply fan will be deemed as failed and will be disabled.  

The system will raise an alarm at the supervisor indicating that the supply fan has failed. This will require a system reset from 
the supervisor.  

 

 Extract Fan Control 

When the extract fan control is enabled the extract fan will be enabled. 

After the extract fan has been enabled for 20 seconds the system will monitor the DPS, and if the DPS status is “no flow” for 
10 seconds the extract fan will be deemed as failed and will be disabled.  

The system will raise an alarm at the supervisor indicating that the extract fan has failed. This will require a system reset from 
the supervisor.  

 Temperature Control 

The required space temperature is set via the space temperature setpoint ( SP ) from the supervisor. This can be adjusted 

between 18 °C (64 °F) and 23 °C (73 °F).  
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When the AHU is enabled, the heating valve dampers and cooling valve will be modulated in sequence to maintain the 
required space temperature.  

The temperature control has a deadband ( DB ) of 2 °C (4 °F). The heating valve will be modulated to maintain the space 

temperature to SP  – ( DB  /2). The cooling valve will be modulated to maintain the space temperature to SP  + ( DB  /2). 

The dampers will be modulated to maintain SP . When the temperature is between these limits both the heating and 

cooling valves will be closed. 

 

 Damper Control. 

The dampers will be modulated between their minimum position of 10% (user adjustable) and fully open position.  

The direction of the dampers be determined on the return temperature and the outside air temperature.  

If the outside air temperature is less that the return temperature, then the dampers will modulate open when cooling is 
required.  

If the outside air temperature is greater that the return temperature, then the dampers will modulate close when cooling 
is required. 

 

 Frost level 1 and 2 protection 

If the AHU is not enabled, and either a frost level 1 or 2 is initiated, then the heating valve will be opened to 100%. This will 
remain enabled until all frost states are cleared or the AHU is enabled. 

 

 Heating coil frost protection 

The heating coil has a frost stat fitted across it, set to activate at 2 °C (36 °F). The stat will auto reset when the temperature 
rises to 5 °C (41 °F). If this stat is activated, an alarm will be raised via the supervisor, the fans will be stopped, the heating 
valve opened to 100% and cooling valves closed. 

 

 Hours run 

The system will log the hours run for both the supply and extract fans. When a fan has a logged run time of 5,000 hours (user 
adjustable) a maintenance alarm will be raised. After the fan has been serviced the alarm can be reset via the supervisor. 

 Fire 

If a fire alarm is detected the AHU fans are hard wired to stop. The control software will also disable the fans to stop any false 
alarms.  

 

 AHU reset 

The AHU fans can be reset via a common reset on the supervisor. 
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2.1.1.3 AHU with Heating, Cooling and Thermal Wheel 

Summary 

This Sample Application will control an AHU with full fresh air dampers, Thermal wheel, heating and cooling valves. On failure 
of either the supply or extract fans the AHU with be disabled until reset. 

 

Number of Strategy blocks used   239 

 

 This Sample Application uses the following macros:  

 Macro: HEATING COOLING AND FREE ENERGY CONTROL WITH PID 

Option Value  

Htg Gain   8 
(14 

°C 
°F) 

Free Gain   12 
(22 

°C 
°F) 

Clg Gain   8 
(14 

°C 
°F) 

Htg Integral   300 Seconds 

Free Integral   300 Seconds 

Clg Integral   300 Seconds 

Damper Min Pos  0 % 

Htg Frost Stat Pos  100 % 

Free Frost Stat Pos  0 % 

Clg Frost Stat Pos  0 % 

Htg Frost 1_2 Pos  100 % 

Free Frost 1_2 Pos 0 % 

Clg Frost 1_2 Pos 0 % 

Htg Warm Up Pos 100 % 

Free Warm Up Pos 0 % 

Clg Warm Up Pos 0 % 

 

 Macro: SINGLE PLANT CONTROL (Supply and Extract Fans) 

Option Value Comment 

Fault Select 1 DPS 

DPS Fault Monitor 0 Run Only 

Stop on Fault 0 Yes 

Fault Monitor Delay 20 Seconds 

Fault Delay 10 Seconds 

Maintenance  Limit 5000 Hours 

Run on time 5 Seconds 

 

A System Description for any system based on this Sample Application is given on the following pages. 
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AHU with Heating, Cooling and Thermal Wheel 
 

 System overview 

This Sample Application will control AHU system with the following plant: 

 Single speed supply fan with DPS (Differential Pressure Switch). 

 Single speed extract fan with DPS.  

 Heating Valve. 

 Cooling Valve. 

 Dampers full fresh air. 

 Thermal Wheel. 

 Frost Stat. 

 Space temperature sensor. 

 

 

 System Start up 

When the AHU is enabled via the schedule, the supply fan control will be enabled.  

When the supply fan is proved running, the temperature control will be enabled with the dampers remaining in the fully 
recirculation position for 2 minutes. 

Five seconds after the supply fan is proved running the extract fan control will be enabled.  

Ten seconds after the temperature control is enabled the dampers will open.  

 
 

 System Control 

When enabled, the system will maintain a space temperature of 21 °C (69.8 °F) within the space.  

If the extract fan or supply fan indicates a fault the system will be disabled, stopping the supply and extract fans, closing the 
damper and stopping the temperature control.  

 

 System Shut Down 

When the schedule has ended, the extract and supply fans will be disabled.  

Ten seconds after the fans have been disabled the dampers will be closed.  

Thirty seconds after the dampers have been closed the temperature control will be disabled. 

 

 Supply Fan Control 

When the supply fan control is enabled the supply fan will be enabled.  

After the supply fan has been enabled for 20 seconds the system will monitor the DPS and if the DPS status is “no flow” for 
10 seconds the supply fan will be deemed as failed and will be disabled.  

The system will raise an alarm at the supervisor indicating that the supply fan has failed. This will require a system reset 
from the supervisor.  
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 Extract Fan Control 

When the extract fan control is enabled the extract fan will be enabled. 

After the extract fan has been enabled for 20 seconds the system will monitor the DPS, and if the DPS status is “no flow” for 
10 seconds the extract fan will be deemed as failed and will be disabled.  

The system will raise an alarm at the supervisor indicating that the extract fan has failed. This will require a system reset from 
the supervisor.  

 Temperature Control 

The required space temperature is set via the space temperature setpoint ( SP ) from the supervisor. This can be 

adjusted between 18 °C (64 °F) and 23 °C (73 °F).  

When the AHU is enabled, the heating valve, thermal wheel and cooling valve will be modulated in sequence to 
maintain the required space temperature.  

The temperature control has a deadband ( DB ) of 2 °C (4 °F). The heating valve will be modulated to maintain 

the space temperature to SP  – ( DB  /2). The cooling valve will be modulated to maintain the space 

temperature to SP  + ( DB  /2). The thermal wheel will be modulated to maintain SP . When the temperature is 

between these limits both the heating and cooling valves will be closed. 

 Thermal Wheel Control. 

The thermal wheel speed will be modulated between its minimum and maximum speed to achieve the required space 
temperature.  

If the outside air temperature is less than the return temperature, then the thermal wheel will speed will be increased when 
heating is required.  

If the outside air temperature is greater that the return temperature, then the thermal wheel will speed will be increased 
when cooling is required. 

 Frost level 1 and 2 protection 

If the AHU is not enabled, and either a frost level 1 or 2 is initiated, then the heating valve will be opened to 100%. This will 
remain enabled until all frost states are cleared or the AHU is enabled. 

 Heating coil frost protection 

The heating coil has a frost stat fitted across it, set to activate at 2 °C (36 °F). The stat will auto reset when the temperature 
rises to 5 °C (41 °F). If this stat is activated, an alarm will be raised via the supervisor, the fans will be stopped, the heating 
valve opened to 100% and the cooling valve closed. 

 Hours run 

The system will log the hours run for both the supply and extract fans. When a fan has a logged run time of 5,000 hours (user 
adjustable) a maintenance alarm will be raised. After the fan has been serviced the alarm can be reset via the supervisor. 

 Fire 

If a fire alarm is detected the AHU fans are hard wired to stop. The control software will also disable the fans to stop any false 
alarms.  

 AHU reset 

The AHU fans can be reset via a common reset on the supervisor.  
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2.1.1.4 AHU with Heating, Cooling, Full Fresh Air and Humidity 

Summary 

This Sample Application will control an AHU with Humidity control, modulating air dampers, heating and cooling valves. On 
failure of either the supply or extract fans the AHU with be disabled until reset. 

 

Number of Strategy blocks used   241 

 This Sample Application uses the following macros:  

 Macro: HEATING COOLING AND FREE ENERGY CONTROL WITH PID 

Option Value  

Htg Gain   8 
(14 

°C 
°F) 

Free Gain   12 
(22 

°C 
°F) 

Clg Gain   8 
(14 

°C 
°F) 

Htg Integral   300 Seconds 

Free Integral   300 Seconds 

Clg Integral   300 Seconds 

Damper Min Pos  10 % 

Htg Frost Stat Pos  100 % 

Free Frost Stat Pos  0 % 

Clg Frost Stat Pos  0 % 

Htg Frost 1_2 Pos  100 % 

Free Frost 1_2 Pos 0 % 

Clg Frost 1_2 Pos 0 % 

Htg Warm Up Pos 100 % 

Free Warm Up Pos 0 % 

Clg Warm Up Pos 0 % 

 Macro: SINGLE PLANT CONTROL (Supply and Extract Fans) 

Option Value Comment 

Fault Select 1 DPS 

DPS Fault Monitor 0 Run Only 

Stop on Fault 0 Yes 

Fault Monitor Delay 20 Seconds 

Fault Delay 10 Seconds 

Maintenance  Limit 5000 Hours 

Run on time 5 Seconds 

 

A System Description for any system based on this Sample Application is given on the following pages. 
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AHU with Heating, Cooling, Full Fresh Air and Humidity 
 

 System overview 

This Sample Application will control AHU system with the following plant: 

 Single speed supply fan with DPS (Differential Pressure Switch). 

 Single speed extract fan with DPS.  

 Heating Valve. 

 Cooling Valve. 

 Dampers full fresh air. 

 Frost Stat. 

 Humidifier with 0 – 10 V control. 

 Space temperature sensor. 

 

 System Start up 

When the AHU is enabled via the schedule, the temperature control will be enabled.  

Ten seconds after the temperature control is enabled the dampers will open.  

Five seconds after the dampers are fully opened the supply fan control will be enabled.  

Five seconds after the supply fan is proved running the extract fan control will be enabled.  

Ten seconds after the extract fan is proved running, the humidity control will be enabled. 

 

 System Control 

When enabled, the system will maintain a space temperature between SP  ±( DB  / 2)  within the space.  

If the extract fan or supply fan indicates a fault the system will be disabled, stopping the supply and extract fans, closing the 
damper and stopping the temperature control.  

 

 System Shut Down 

When the schedule has ended, the humidity control, extract and supply fans will be disabled.  

Ten seconds after the fans have been disabled the dampers will be closed.  

Thirty seconds after the dampers have been closed the temperature control will be disabled. 

 

 Supply Fan Control 

When the supply fan control is enabled the supply fan will be enabled.  

After the supply fan has been enabled for 20 seconds the system will monitor the DPS and if the DPS status is “no flow” for 
10 seconds the supply fan will be deemed as failed and will be disabled.  

The system will raise an alarm at the supervisor indicating that the supply fan has failed. This will require a system reset from 
the supervisor.  

 

 Extract Fan Control 

When the extract fan control is enabled the extract fan will be enabled. 

After the extract fan has been enabled for 20 seconds the system will monitor the DPS, and if the DPS status is “no flow” for 
10 seconds the extract fan will be deemed as failed and will be disabled.  

The system will raise an alarm at the supervisor indicating that the extract fan has failed. This will require a system reset from 
the supervisor.  
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 Temperature Control 

The required space temperature is set via the space temperature setpoint ( SP ) from the supervisor. This can be adjusted 

between 18 °C (64 °F) and 23 °C (73 °F).  

When the AHU is enabled, the heating and cooling valves will be modulated in sequence to maintain the required space 
temperature.  

The temperature control has a deadband ( DB ) of 2 °C (4 °F). The heating valve will be modulated to maintain the space 

temperature to SP  – ( DB  /2). The cooling valve will be modulated to maintain the space temperature to SP  + ( DB  /2). 

When the temperature is between these limits both the heating and cooling valves will be closed.  

 
 

 Humidity Control 

When enabled the humidity control will modulate the humidifier to maintain a supply relative humidity of 50%. 

When disabled the humidity control will remain at 0%. 

 

 Frost level 1 and 2 protection 

If the AHU is not enabled, and either a frost level 1 or 2 is initiated, then the heating valve will be opened to 100%. This will 
remain enabled until all frost states are cleared or the AHU is enabled. 

 

 Heating coil frost protection 

The heating coil has a frost stat fitted across it, set to activate at 2 °C (36 °F). The stat will auto reset when the temperature 
rises to 5 °C (41 °F). If this stat is activated, an alarm will be raised via the supervisor, the fans will be stopped, the heating 
valve opened to 100% and the cooling valve closed. 

 

 Hours run 

The system will log the hours run for both the supply and extract fans. When a fan has a logged run time of 5,000 hours (user 
adjustable) a maintenance alarm will be raised. After the fan has been serviced the alarm can be reset via the supervisor. 

 

 Fire 

If a fire alarm is detected the AHU fans are hard wired to stop. The control software will also disable the fans to stop any false 
alarms.  

 

 AHU reset 

The AHU fans can be reset via a common reset on the supervisor. 
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2.1.1.5 AHU with Frost, Heating, Cooling and Full Fresh Air 

Summary 

This Sample Application will control an AHU with a frost heater battery, full fresh air dampers, heating and cooling valves. On 
failure of either the supply or extract fans the AHU with be disabled until reset. 

 

Number of Strategy blocks used   224 

 

 This Sample Application uses the following macros:  

 

 Macro: HEATING COOLING AND FREE ENERGY CONTROL WITH PID 

Option Value  

Htg Gain   8 
(14 

°C 
°F) 

Free Gain   12 
(22 

°C 
°F) 

Clg Gain   8 
(14 

°C 
°F) 

Htg Integral   300 Seconds 

Free Integral   300 Seconds 

Clg Integral   300 Seconds 

Damper Min Pos  10 % 

Htg Frost Stat Pos  100 % 

Free Frost Stat Pos  0 % 

Clg Frost Stat Pos  0 % 

Htg Frost 1_2 Pos  100 % 

Free Frost 1_2 Pos 0 % 

Clg Frost 1_2 Pos 0 % 

Htg Warm Up Pos 100 % 

Free Warm Up Pos 0 % 

Clg Warm Up Pos 0 % 

 Macro: SINGLE PLANT CONTROL (Supply and Extract Fans) 

Option Value Comment 

Fault Select 1 DPS 

DPS Fault Monitor 0 Run Only 

Stop on Fault 0 Yes 

Fault Monitor Delay 20 Seconds 

Fault Delay 10 Seconds 

Maintenance  Limit 5000 Hours 

Run on time 5 Seconds 

A System Description for any system based on this Sample Application is given on the following pages.  
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AHU with Frost, Heating, Cooling and Full Fresh Air 

 

 System overview 

This Sample Application will control AHU system with the following plant: 

 Single speed supply fan with DPS (Differential Pressure Switch).  

 Single speed extract fan with DPS.  

 Frost Off Coil Temperature sensor. 

 Frost Valve. 

 Heating Valve. 

 Cooling Valve. 

 Dampers full fresh air. 

 Frost Stat. 

 Space temperature sensor. 

 

 System Start up 

When the AHU is enabled via the schedule, the temperature and frost control will be enabled.  

Ten seconds after the temperature control is enabled the dampers will open.  

Five seconds after the dampers are fully opened the supply fan control will be enabled.  

Five seconds after the supply fan is proved running the extract fan control will be enabled.  

 

 System Control 

When enabled, the system will maintain a space temperature between SP  ±( DB  / 2)  within the space.  

If the extract fan or supply fan indicates a fault the system will be disabled, stopping the supply and extract fans and 
stopping the temperature control.  

 

 System Shut Down 

When the schedule has ended, the extract and supply fans will be disabled.  

Ten seconds after the fans have been disabled the dampers will be closed.  

Thirty seconds after the dampers have been closed the frost and temperature control will be disabled. 

 

 Supply Fan Control 

When the supply fan control is enabled the supply fan will be enabled.  

After the supply fan has been enabled for 10 seconds the system will monitor the DPS and if the DPS status is “no flow” for 
10 seconds the supply fan will be deemed as failed and will be disabled.  

The system will raise an alarm at the supervisor indicating that the supply fan has failed. This will require a system reset from 
the supervisor.  
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 Extract Fan Control 

When the extract fan control is enabled the extract fan will be enabled. 

After the extract fan has been enabled for 10 seconds the system will monitor the DPS, and if the DPS status is “no flow” for 
10 seconds the extract fan will be deemed as failed and will be disabled.  

The system will raise an alarm at the supervisor indicating that the extract fan has failed. This will require a system reset from 
the supervisor.  

 

 Temperature Control 

The required space temperature is set via the space temperature setpoint ( SP ) from the supervisor. This can be adjusted 

between 18 °C (64 °F) and 23 °C (73 °F).  

When the AHU is enabled, the heating and cooling valves will be modulated in sequence to maintain the required space 
temperature.  

The temperature control has a deadband ( DB ) of 2 °C (4 °F). The heating valve will be modulated to maintain the space 

temperature to SP  – ( DB  /2). The cooling valve will be modulated to maintain the space temperature to SP  + ( DB  /2). 

When the temperature is between these limits both the heating and cooling valves will be closed. 

 

 Frost level 1 and 2 protection 

If the AHU is not enabled, and either a frost level 1 or 2 is initiated, then the heating valve will be opened to 100%. This will 
remain enabled until all frost states are cleared or the AHU is enabled. 

 

 Heating coil frost protection 

The heating coil has a frost stat fitted across it, set to activate at 2 °C (36 °F). The stat will auto reset when the temperature 
rises to 5 °C (41 °F). If this stat is activated, an alarm will be raised via the supervisor, the fans will be stopped, the heating 
valve opened to 100% and the cooling valve closed. 

 

 Hours run 

The system will log the hours run for both the supply and extract fans. When a fan has a logged run time of 5,000 hours (user 
adjustable) a maintenance alarm will be raised. After the fan has been serviced the alarm can be reset via the supervisor. 

 

 Fire 

If a fire alarm is detected the AHU fans are hard wired to stop. The control software will also disable the fans to stop any false 
alarms.  

 

 AHU reset 

The AHU fans can be reset via a common reset on the supervisor. 
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2.1.1.6 AHU with Frost, Heating, Cooling and Dampers 

Summary 

This Sample Application will control an AHU with a frost heater battery, modulating air dampers, heating and cooling valves. 
On failure of either the supply or extract fans the AHU with be disabled until reset. 

 

Number of Strategy blocks used   249 

 This Sample Application uses the following macros:  

 

 Macro: HEATING COOLING AND FREE ENERGY CONTROL WITH PID 

Option Value  

Htg Gain   8 

(14 

°C 

°F) 

Free Gain   12 

(22 

°C 

°F) 

Clg Gain   8 

(14 

°C 

°F) 

Htg Integral   300 Seconds 

Free Integral   300 Seconds 

Clg Integral   300 Seconds 

Damper Min Pos  10 % 

Htg Frost Stat Pos  100 % 

Free Frost Stat Pos  0 % 

Clg Frost Stat Pos  0 % 

Htg Frost 1_2 Pos  100 % 

Free Frost 1_2 Pos 0 % 

Clg Frost 1_2 Pos 0 % 

Htg Warm Up Pos 100 % 

Free Warm Up Pos 0 % 

Clg Warm Up Pos 0 % 

 Macro: SINGLE PLANT CONTROL (Supply and Extract Fans) 

Option Value Comment 

Fault Select 1 DPS 

DPS Fault Monitor 0 Run Only 

Stop on Fault 0 Yes 

Fault Monitor Delay 20 Seconds 

Fault Delay 10 Seconds 

Maintenance  Limit 5000 Hours 

Run on time 5 Seconds 

A System Description for any system based on this Sample Application is given on the following pages. 
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AHU with Frost, Heating, Cooling and Dampers 

 System overview 

This Sample Application will control AHU system with the following plant: 

 Single speed supply fan with DPS (Differential Pressure Switch). 

 Single speed extract fan with DPS.  

 Frost Off Coil Temperature sensor. 

 Frost Valve. 

 Heating Valve. 

 Cooling Valve. 

 Dampers modulating. 

 Frost Stat. 

 Space temperature sensor.  

 Outside air temperature sensor. 

 Return air temperature sensor. 
 

 System Start up 

When the AHU is enabled via the schedule, the supply fan control will be enabled.  

When the supply fan is proved running the temperature control will be enabled with the dampers remaining in the fully 
recirculation position for 2 minutes. 

Five seconds after the supply fan is proved running the extract fan control will be enabled.  

Ten seconds after the temperature control is enabled the dampers will open.  
 

 System Control 

When enabled, the system will maintain a space temperature between SP  ±( DB  / 2)  within the space.  

If the extract fan or supply fan indicates a fault the system will be disabled, stopping the supply and extract fans, fully 
closing the damper and stopping the temperature control 
 

 System Shut Down 

When the schedule has ended, the extract and supply fans will be disabled.  

Ten seconds after the fans have been disabled the temperature control will be disabled fully closing the dampers.  

 

 Supply Fan Control 

When the supply fan control is enabled the supply fan will be enabled.  

After the supply fan has been enabled for 20 seconds the system will monitor the DPS and if the DPS status is “no flow” for 
10 seconds the supply fan will be deemed as failed and will be disabled.  

The system will raise an alarm at the supervisor indicating that the supply fan has failed. This will require a system reset from 
the supervisor.  

 

 Extract Fan Control 

When the extract fan control is enabled the extract fan will be enabled. 

After the extract fan has been enabled for 20 seconds the system will monitor the DPS, and if the DPS status is “no flow” for 
10 seconds the extract fan will be deemed as failed and will be disabled.  

The system will raise an alarm at the supervisor indicating that the extract fan has failed. This will require a system reset from 
the supervisor.  
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 Temperature Control 

The required space temperature is set via the space temperature setpoint ( SP ) from the supervisor. This can be adjusted 

between 18 °C (64 °F) and 23 °C (73 °F).  

When the AHU is enabled, the heating valve dampers and cooling valve will be modulated in sequence to maintain the 
required space temperature.  

The temperature control has a deadband ( DB ) of 2 °C (4 °F). The heating valve will be modulated to maintain the space 

temperature to SP  – ( DB  /2). The cooling valve will be modulated to maintain the space temperature to SP  + ( DB  /2). 

The dampers will be modulated to maintain SP . When the temperature is between these limits both the heating and 

cooling valves will be closed. 

 

 Damper Control. 

The dampers will be modulated between their minimum position of 10% (user adjustable) and fully open position.  

The direction of the dampers be determined on the return temperature and the outside air temperature.  

If the outside air temperature is less that the return temperature, then the dampers will modulate open when cooling is 
required.  

If the outside air temperature is greater that the return temperature, then the dampers will modulate close when cooling 
is required. 

 

 Frost level 1 and 2 protection 

If the AHU is not enabled, and either a frost level 1 or 2 is initiated, then the heating and frost valves will be opened to 100%. 
This will remain enabled until all frost states are cleared or the AHU is enabled. 
 

 Frost Coil Control. 

When the frost coil control is active the frost valve will be modulated to maintain an off coil temperature of 10 °C (50 °F). 
When the frost coil is inactive the frost valve will be closed. 

 

 Frost coil frost protection 

The heating coil has a frost stat fitted across it, set to activate at 2 °C (36 °F). The stat will auto reset when the temperature 
rises to 5 °C (41 °F). If this stat is activated, an alarm will be raised via the supervisor, the fans will be stopped, the frost valve 
opened to 100% and the heating and cooling valves closed. 

 

 Hours run 

The system will log the hours run for both the supply and extract fans. When a fan has a logged run time of 5,000 hours (user 
adjustable) a maintenance alarm will be raised. After the fan has been serviced the alarm can be reset via the supervisor. 
 

 Fire 

If a fire alarm is detected the AHU fans are hard wired to stop. The control software will also disable the fans to stop any false 
alarms.  
 

 AHU reset 

The AHU fans can be reset via a common reset on the supervisor. 
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2.1.1.7 AHU with Frost, Heating, Cooling and Thermal Wheel 

Summary 

This Sample Application will control an AHU with a frost heater battery, full fresh air dampers, Thermal wheel, heating and 
cooling valves. On failure of either the supply or extract fans the AHU with be disabled until reset. 

 

Number of Strategy blocks used   253 

 This Sample Application uses the following macros:  

 

 Macro: HEATING COOLING AND FREE ENERGY CONTROL WITH PID 

Option Value  

Htg Gain   8 
(14 

°C 
°F) 

Free Gain   12 
(22 

°C 
°F) 

Clg Gain   8 
(14 

°C 
°F) 

Htg Integral   300 Seconds 

Free Integral   300 Seconds 

Clg Integral   300 Seconds 

Damper Min Pos  0 % 

Htg Frost Stat Pos  100 % 

Free Frost Stat Pos  0 % 

Clg Frost Stat Pos  0 % 

Htg Frost 1_2 Pos  100 % 

Free Frost 1_2 Pos 0 % 

Clg Frost 1_2 Pos 0 % 

Htg Warm Up Pos 100 % 

Free Warm Up Pos 0 % 

Clg Warm Up Pos 0 % 

 Macro: SINGLE PLANT CONTROL (Supply and Extract Fans) 

Option Value Comment 

Fault Select 1 DPS 

DPS Fault Monitor 0 Run Only 

Stop on Fault 0 Yes 

Fault Monitor Delay 20 Seconds 

Fault Delay 10 Seconds 

Maintenance  Limit 5000 Hours 

Run on time 5 Seconds 

A System Description for any system based on this Sample Application is given on the following pages. 
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AHU with Frost, Heating, Cooling and Thermal Wheel 
 

 System overview 

This Sample Application will control AHU system with the following plant: 

 Single speed supply fan with DPS (Differential Pressure Switch). 

 Single speed extract fan with DPS.  

 Frost Off Coil Temperature sensor. 

 Frost Valve. 

 Heating Valve. 

 Cooling Valve. 

 Dampers full fresh air. 

 Thermal Wheel. 

 Frost Stat. 

 Space temperature sensor. 

 

 System Start up 

When the AHU is enabled via the schedule, the supply fan control will be enabled.  

When the supply fan is proved running the temperature control will be enabled with the dampers remaining in the fully 
recirculation position for 2 minutes. 

Five seconds after the supply fan is proved running the extract fan control will be enabled.  

Ten seconds after the temperature control is enabled the dampers will open.  

 

 System Control 

When enabled, the system will maintain a space temperature of 21 °C (69.8 °F) within the space.  

If the extract fan or supply fan indicates a fault the system will be disabled, stopping the supply, extract and fans, closing the 
damper and stopping the temperature control.  

 

 System Shut Down 

When the schedule has ended, the extract and supply fans will be disabled.  

Ten seconds after the fans have been disabled the dampers will be closed.  

Thirty seconds after the dampers have been closed the frost and temperature control will be disabled. 

 

 Supply Fan Control 

When the supply fan control is enabled the supply fan will be enabled.  

After the supply fan has been enabled for 20 seconds the system will monitor the DPS and if the DPS status is “no flow” for 
10 seconds the supply fan will be deemed as failed and will be disabled.  

The system will raise an alarm at the supervisor indicating that the supply fan has failed. This will require a system reset 
from the supervisor.  

 

 Extract Fan Control 

When the extract fan control is enabled the extract fan will be enabled. 

After the extract fan has been enabled for 20 seconds the system will monitor the DPS, and if the DPS status is “no flow” for 
10 seconds the extract fan will be deemed as failed and will be disabled.  

The system will raise an alarm at the supervisor indicating that the extract fan has failed. This will require a system reset from 
the supervisor. 
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 Temperature Control 

The required space temperature is set via the space temperature setpoint ( SP ) from the supervisor. This can be 

adjusted between 18 °C (64 °F) and 23 °C (73 °F).  

When the AHU is enabled, the heating valve, thermal wheel and cooling valve will be modulated in sequence to 
maintain the required space temperature.  

The temperature control has a deadband ( DB ) of 2 °C (4 °F). The heating valve will be modulated to maintain 

the space temperature to SP  – ( DB  /2). The cooling valve will be modulated to maintain the space 

temperature to SP  + ( DB  /2). The thermal wheel will be modulated to maintain SP . When the temperature is 

between these limits both the heating and cooling valves will be closed. 
 

 Thermal Wheel Control. 

The thermal wheel speed will be modulated between its minimum and maximum speed to achieve the required space 
temperature.  

If the outside air temperature is less than the return temperature, then the thermal wheel will speed will be increased when 
heating is required.  

If the outside air temperature is greater that the return temperature, then the thermal wheel will speed will be increased 
when cooling is required. 

 

 Frost level 1 and 2 protection 

If the AHU is not enabled, and either a frost level 1 or 2 is initiated, then the frost and heating valves will be opened to 100%. 
These will remain enabled until all frost states are cleared or the AHU is enabled. 

 

 Frost Coil Control. 

When the frost coil control is active the frost valve will be modulated to maintain an off coil temperature of 10 °C (50 °F). 
When the frost coil is inactive the frost valve will be closed. 

 

 Frost coil frost protection 

The frost coil has a frost stat fitted across it set to activate at 2 °C (36 °F). The stat will auto reset when the temperature rises to 
5 °C (41 °F). If this stat is activated, an alarm will be raised via the supervisor, the fans will be stopped, the frost valve opened 
to 100% and the heating and cooling valves closed. 

 

 Hours run 

The system will log the hours run for both the supply and extract fans. When a fan has a logged run time of 5,000 hours (user 
adjustable) a maintenance alarm will be raised. After the fan has been serviced the alarm can be reset via the supervisor. 

 

 Fire 

If a fire alarm is detected the AHU fans are hard wired to stop. The control software will also disable the fans to stop any false 
alarms.  

 

 AHU reset 

The AHU fans can be reset via a common reset on the supervisor. 
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2.1.1.8 AHU with Frost, Heating, Cooling, Full Fresh Air and Humidity 

Summary 

This Sample Application will control an AHU with a frost heater battery, humidity control, modulating air dampers, heating and 
cooling valves. On failure of either the supply or extract fans the AHU will be disabled until reset. 

 

Number of Strategy blocks used   254 

 This Sample Application uses the following macros:  

 Macro: HEATING COOLING AND FREE ENERGY CONTROL WITH PID 

Option Value  

Htg Gain   8 
(14 

°C 
°F) 

Free Gain   12 
(22 

°C 
°F) 

Clg Gain   8 
(14 

°C 
°F) 

Htg Integral   300 Seconds 

Free Integral   300 Seconds 

Clg Integral   300 Seconds 

Damper Min Pos  10 % 

Htg Frost Stat Pos  100 % 

Free Frost Stat Pos  0 % 

Clg Frost Stat Pos  0 % 

Htg Frost 1_2 Pos  100 % 

Free Frost 1_2 Pos 0 % 

Clg Frost 1_2 Pos 0 % 

Htg Warm Up Pos 100 % 

Free Warm Up Pos 0 % 

Clg Warm Up Pos 0 % 

 Macro: SINGLE PLANT CONTROL (Supply and Extract Fans) 

Option Value Comment 

Fault Select 1 DPS 

DPS Fault Monitor 0 Run Only 

Stop on Fault 0 Yes 

Fault Monitor Delay 20 Seconds 

Fault Delay 10 Seconds 

Maintenance  Limit 5000 Hours 

Run on time 5 Seconds 

 

A System Description for any system based on this Sample Application is given on the following pages. 
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AHU with Frost, Heating, Cooling, Full Fresh Air and Humidity 
 

 System overview 

This Sample Application will control AHU system with the following plant: 

 Single speed supply fan with DPS (Differential Pressure Switch). 

 Single speed extract fan with DPS.  

 Frost Off Coil Temperature sensor. 

 Frost Valve.   

 Heating Valve. 

 Cooling Valve. 

 Dampers full fresh air. 

 Frost Stat. 

 Humidifier with 0 – 10 V control. 

 Space temperature sensor. 

 

 System Start up 

When the AHU is enabled via the schedule, the frost and temperature control will be enabled.  

Ten seconds after the temperature control is enabled the dampers will open.  

Five seconds after the dampers are fully opened the supply fan control will be enabled.  

Five seconds after the supply fan is proved running the extract fan control will be enabled.  

Ten seconds after the extract fan is proved running, the humidity control will be enabled. 

 

 System Control 

When enabled, the system will maintain a space temperature between SP ±
DB

2
  within the space.   

If the extract fan or supply fan indicates a fault the system will be disabled, stopping the supply, extract and temperature 
control.  

Ten seconds after the extract fan is proved running, the humidity control will be enabled. 

 

 System Shut Down 

When the schedule has ended, the humidity control, extract and supply fans will be disabled.  

Ten seconds after the fans have been disabled the dampers will be closed.  

Thirty seconds after the dampers have been closed the frost and temperature control will be disabled. 

 

 Supply Fan Control 

When the supply fan control is enabled the supply fan will be enabled.  

After the supply fan has been enabled for 20 seconds the system will monitor the DPS and if the DPS status is “no flow” for 
10 seconds the supply fan will be deemed as failed and will be disabled.  

The system will raise an alarm at the supervisor indicating that the supply fan has failed. This will require a system reset 
from the supervisor.  
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 Extract Fan Control 

When the extract fan control is enabled the extract fan will be enabled. 

After the extract fan has been enabled for 20 seconds the system will monitor the DPS, and if the DPS status is “no flow” for 
10 seconds the extract fan will be deemed as failed and will be disabled.  

The system will raise an alarm at the supervisor indicating that the extract fan has failed. This will require a system reset from 
the supervisor 

 

 Temperature Control 

The required space temperature is set via the space temperature setpoint ( SP ) from the supervisor. This can be adjusted 

between 18 °C (64 °F) and 23 °C (73 °F).  

When the AHU is enabled, the heating and cooling valves will be modulated in sequence to maintain the required space 
temperature.  

The temperature control has a deadband ( DB ) of 2 °C (4 °F). The heating valve will be modulated to maintain the space 

temperature to SP  – ( DB  /2). The cooling valve will be modulated to maintain the space temperature to SP  + ( DB  /2). 

When the temperature is between these limits both the heating and cooling valves will be closed. 

 

 Humidity Control 

When enabled the humidity control will modulate the humidifier to maintain a supply relative humidity of 50%. 

When disabled the humidity control will remain at 0% 

 

 Frost level 1 and 2 protection 

If the AHU is not enabled, and either a frost level 1 or 2 is initiated, then the frost and heating valves will be opened to 100%. 
These will remain enabled until all frost states are cleared or the AHU is enabled. 

 

 Frost Coil Control. 

When the frost coil control is active the frost valve will be modulated to maintain an off coil temperature of 10 °C (50 °F). 
When the frost coil is inactive the frost valve will be closed. 

 

 Frost coil frost protection 

The frost coil has a frost stat fitted across it set to activate at 2 °C (36 °F). The stat will auto reset when the temperature rises to 
5 °C (41 °F). If this stat is activated, an alarm will be raised via the supervisor, the fans will be stopped, the frost valve opened 
to 100% and the heating and cooling valves closed. 

 

 Hours run 

The system will log the hours run for both the supply and extract fans. When a fan has a logged run time of 5,000 hours (user 
adjustable) a maintenance alarm will be raised. After the fan has been serviced the alarm can be reset via the supervisor. 
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 Fire 

If a fire alarm is detected the AHU fans are hard wired to stop. The control software will also disable the fans to stop any false 
alarms.  

 

 AHU reset 

The AHU fans can be reset via a common reset on the supervisor. 
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2.1.1.9 AHU with Frost, Heating, Cooling and Dampers 

Summary 

This Sample Application will control an AHU with a modulating air dampers, and heating and cooling valves. On failure of either 
the supply or extract fans the AHU will be disabled until reset. 

 

Number of Strategy blocks used   234 

 This Sample Application uses the following macros:  

 Macro: HEATING COOLING AND FREE ENERGY CONTROL WITH PID 

Option Value  

Htg Gain   8 
(14 

°C 
°F) 

Free Gain   12 
(22 

°C 
°F) 

Clg Gain   8 
(14 

°C 
°F) 

Htg Integral   300 Seconds 

Free Integral   300 Seconds 

Clg Integral   300 Seconds 

Damper Min Pos  10 % 

Htg Frost Stat Pos  100 % 

Free Frost Stat Pos  0 % 

Clg Frost Stat Pos  0 % 

Htg Frost 1_2 Pos  100 % 

Free Frost 1_2 Pos 0 % 

Clg Frost 1_2 Pos 0 % 

Htg Warm Up Pos 100 % 

Free Warm Up Pos 0 % 

Clg Warm Up Pos 0 % 

 Macro: SINGLE PLANT CONTROL (Supply and Extract Fans) 

Option Value Comment 

Fault Select 1 DPS 

DPS Fault Monitor 0 Run Only 

Stop on Fault 0 Yes 

Fault Monitor Delay 20 Seconds 

Fault Delay 10 Seconds 

Maintenance  Limit 5000 Hours 

Run on time 5 Seconds 

 

A System Description for any system based on this Sample Application is given on the following pages. 
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AHU with Frost, Heating, Cooling, Full Fresh Air and Humidity 
 

 System overview 

This Sample Application will control AHU system with the following plant: 

 Single speed supply fan. 

 Single speed extract fan.  

 Pressure sensor mounted in supply fan duct. 

 Pressure sensor mounted in extract fan duct.   

 Heating Valve. 

 Cooling Valve. 

 Dampers modulating. 

 Frost Stat. 

 Space temperature sensor.  

 Outside air temperature sensor. 

 Return air temperature sensor. 

 

 System Start up 

When the AHU is enabled via the schedule, the temperature control will be enabled.  

Ten seconds after the temperature control is enabled the supply fan control will be enabled.  

Five seconds after the supply fan is proved running the extract fan control will be enabled.  

 

 System Control 

When enabled, the system will maintain a space temperature of 21 °C (69.8 °F)  within the space.   

If the extract fan or supply fan indicates a fault the system will be disabled, stopping the supply, extract and temperature 
control.  

 

 System Shut Down 

When the schedule has ended, the humidity control, extract and supply fans will be disabled.  

Thirty seconds after the fans have been disabled the frost and temperature control will be disabled. 

 

 Supply Fan Control 

When the supply fan control is enabled the supply fan and pressure control will be enabled.  

The pressure control will modulate the supply fan to maintain the required supply pressure setpoint. 

After the supply fan has been enabled for 20 seconds the system will monitor the supply fan pressure and if the pressure is 
outside the supply fan pressure setpoint ±100 Pa (0.01 psi) for 10 seconds the supply fan will be deemed as failed and will 
be disabled.  

The system will raise an alarm at the supervisor indicating that the supply fan has failed. This will require a system reset from 
the supervisor.  
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 Extract Fan Control 

When the extract fan control is enabled the extract fan and pressure control will be enabled.  

The pressure control will modulate the extract fan to maintain the required extract pressure setpoint. 

After the extract fan has been enabled for 20 seconds the system will monitor the extract fan pressure and if the pressure is 
outside the extract fan pressure setpoint ±100 Pa (0.01 psi) for 10 seconds the extract fan will be deemed as failed and will 
be disabled.  

The system will raise an alarm at the supervisor indicating that the extract fan has failed. This will require a system reset from 
the supervisor 

 

 Temperature Control 

The required space temperature is set via the space temperature setpoint ( SP ) from the supervisor. This can be adjusted 

between 18 °C (64 °F) and 23 °C (73 °F).  

When the AHU is enabled, the heating, dampers and cooling valves will be modulated in sequence to maintain the required 
space temperature.  

The temperature control has a deadband ( DB ) of 2 °C (4 °F), if the space temperature is within the SP  – ( DB  /2) and SP  

+ ( DB  /2), the PID loop output will be held holding the cooling and heating valves at their current positions. 

 

 Damper Control 

The dampers remain fully closed for 2 minutes after being enabled. The dampers will be modulated between their minimum 
position and fully open position. The direction of the dampers be determined on the return temperature and the outside air 
temperature. If the outside air temperature is less that the return temperature, then the dampers will modulate open when 
cooling is required. If the outside air temperature is greater that the return temperature, then the dampers will modulate 
close when cooling is required. 

 Frost level 1 and 2 protection 

If the AHU is not enabled, and either a frost level 1 or 2 is initiated, then the frost and heating valves will be opened to 100%. 
These will remain enabled until all frost states are cleared or the AHU is enabled. 

 

 Frost level 1 and 2 protection. 

If the AHU is not enabled and either a frost level 1 or 2 is initiated, then the heating valve will be opened to 100%. This will 
remain enabled until all frost states are cleared or the AHU is enabled. 

 

 Heating coil frost protection. 

The heating coil has a frost thermostat fitted across it set to activate at 2 °C (36 °F).  

The thermostat will auto-reset when the temperature rises to 5 °C (41 °F).  

If this thermostat is activated, an alarm will be raised via the supervisor, the fans will be stopped, the heating valve opened to 
100% and the cooling valve closed. 

 

 Hours run. 

The system will log the hours run for both the supply and extract fans.  

When a fan as a logged run time of 5,000 Hours (user adjustable), a maintenance alarm will be raised.  

After the fan has been serviced the alarm can be rest via the supervisor. 
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 Fire.  

If a fire alarm is detected the AHU fans are hard-wired to stop. The control software will also disable the fans to stop any false 
alarms.  

 

 AHU reset. 

The AHU fans can be reset via a common reset on the supervisor.  
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	Summary
	 Macro: SINGLE PLANT CONTROL
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	 System overview
	 System control
	 Pump System Control
	 Pump reset
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	 Hours run
	 Override
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	Summary
	 Macro: SINGLE PLANT CONTROL
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	 System overview
	 System control
	 Pump System Control
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	 Override
	 Fire
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	Summary
	 Macro: SINGLE PLANT CONTROL
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	 System control
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	Summary
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	1.1.2.5 VT Twin pump Weekly Changeover with Trip Monitoring
	Summary
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	 System overview
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	 Pump System Control
	 VT Control
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	 System reset
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	 Hours run
	 Override
	 Fire
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	Summary
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	 System overview
	 System control
	 Pump System Control
	 Pressure control
	 VT Control
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	 Hours run
	 Override
	 Fire
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	Summary
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	 Macro: SEQUENCE MODULE
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	 System Control
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	 Boiler rotation
	 System reset
	 Hours run
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	Summary
	 Macro: SEQUENCE CONTROL
	 Macro: SEQUENCE MODULE
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	 System overview.
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	 System reset
	 Hours run


	1.1.3.3 Two-Boiler High/Low Fire
	Summary
	 Macro: SEQUENCE CONTROL
	 Macro: SEQUENCE MODULE
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	 System overview
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	 Boiler Control
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	 Macro: SEQUENCE MODULE
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	 System overview
	 System Control
	 Boiler Control
	 Boiler rotation
	 Boiler System reset
	 Boiler Hours run
	 Pump System control
	 Pump System reset
	 Pump frost protection
	 Pump Hours run
	 Pump Override
	 Fire
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	Summary
	 Macro: SEQUENCE CONTROL
	 Macro: SEQUENCE MODULE
	 Macro: SINGLE PLANT CONTROL

	Four-Boiler Modulating Sequence Control with External Shunt Pump
	 System overview
	 System Control
	 Boiler Control
	 Boiler rotation
	 Boiler System reset
	 Boiler Hours run
	 Pump System control
	 Pump System reset
	 Pump frost protection
	 Pump Hours run
	 Pump Override
	 Fire


	1.1.3.6 Four-Boiler Hi/Lo Sequence Control with External Shunt Pump
	Summary
	 Macro: SEQUENCE CONTROL
	 Macro: SEQUENCE MODULE
	 Macro: SINGLE PLANT CONTROL

	Four-Boiler Hi/Lo Sequence Control with External Shunt Pump
	 System overview
	 System Control
	 Boiler Control
	 Boiler rotation
	 Boiler System reset
	 Boiler Hours run
	 Pump System control
	 Pump System reset
	 Pump frost protection
	 Pump Hours run
	 Pump Override
	 Fire


	1.1.3.7 Four-Boiler Modulating Parallel Control
	Summary
	 Macro: SEQUENCE CONTROL
	 Macro: SEQUENCE MODULE

	Four-Boiler Modulating Parallel Control
	 System overview.
	 System Control
	 Boiler Control
	 Boiler rotation
	 System reset
	 Hours run
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	 System overview
	 System control
	 Temperature control.
	 High Limit.
	 Pump control.
	 Pump reset.
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	 Hours run
	 Override
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	 Macro: HWS CONTROL
	 Macro: SENSOR ALARM AND LOG
	 Macro: SINGLE PLANT CONTROL (Circulation and Destrat Pumps)

	HWS control with circulation and de-stratification pump
	 System overview
	 System control
	 Temperature control
	 High Limit
	 De-stratification Pump control
	 De-stratification Pump reset
	 De-stratification Hours run
	 De-stratification Fire
	 Circulation Pump control
	 Circulation Pump reset
	 Circulation Pump frost protection
	 Circulation Hours run
	 Circulation Override
	 Circulation Fire
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	Summary
	 Macro: HWS CONTROL
	 Macro: SENSOR ALARM AND LOG
	 Macro: SINGLE PLANT CONTROL

	HWS control with circulation pump and Legionella prevention
	 System overview
	 System control
	 Temperature control.
	 Legionella control.
	 High Limit.
	 Pump control.
	 Pump reset.
	 Pump frost protection
	 Hours run
	 Override
	 Fire
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	 Macro: SEQUENCE CONTROL
	 Macro: SEQUENCE MODULE

	Two Chiller On/Off Sequence Control
	 System overview
	 System Control
	 Chiller Control
	 Chiller rotation
	 System reset
	 Hours run


	1.1.5.2 Two-Chiller Modulating Sequence Control
	Summary
	 Macro: SEQUENCE CONTROL
	 Macro: SEQUENCE MODULE

	Two Chiller Modulating Sequence Control
	 System overview
	 System Control
	 Chiller Control
	 Chiller rotation
	 System reset
	 Hours run


	1.1.5.3 Two-Chiller On/Off Sequence Control with Shunt pump
	Summary
	 Macro: SEQUENCE CONTROL
	 Macro: SEQUENCE MODULE
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